DATAcad LICENSE AGREEMENT
This is a legal agreement between you (either an individual or an entity), the end user, and DATAcad LLC ("DATAcad"). If you do not agree to the terms of this Agreement, promptly return the distribution media and the accompanying items (including written materials or other containers) to DATAcad.

DATAcad SOFTWARE LICENSE
GRANT OF LICENSE
This DATAcad software program ("the software") is licensed not sold. DATAcad grants you a license for the software only in the country where you acquired the software. You obtain no rights other than those granted to you under this license. DATAcad grants to you the right to use one copy of the enclosed software on a single computer. The software is in "use" on a computer when it is loaded into temporary memory (i.e. RAM) or installed into permanent memory (e.g. hard disk or other storage device) of that computer. Installation of the software on a network server for the sole purpose of distribution to one or more other computers is not permitted under this license. A separate license is required for each copy of the software in a network installation.

COPYRIGHT
The software is owned by DATAcad or licensed from its owners and is protected by United States copyright laws and international treaty provisions. Therefore, you must treat the software like any other legally copyrighted material with the following exceptions. You may either make one copy of the software solely for backup or archival purposes or transfer the software to a single hard disk provided that you keep the original solely for backup or archival purposes. You may NOT copy the printed materials ("documentation") accompanying the software.

OTHER RESTRICTIONS
You may not rent, lease or assign the software. You may transfer the software and documentation on a permanent basis provided that you retain no copies and the recipient agrees to the terms of this Agreement. You may not reverse engineer, decompile, or disassemble the software. If the software is an upgrade, any transfer must include the most recent upgrade and all prior versions. Additional licenses are not transferable. You may not distribute, sublicense, or modify the software.

EXPORT RESTRICTIONS
You agree that neither you nor your customers intend to or will, directly or indirectly, export or transmit: 1) the software or related documentation and technical data; or 2) your software product as described in this license or any part thereof, or process, or service that is the direct product of the software, to any country to which such export or transmission is restricted by any applicable U.S. regulation or statute, without the prior written consent, if required, of the Bureau of Export Administration of the U.S. Department of Commerce, or such other governmental entity as may have jurisdiction over such export or transmission.

LIMITED WARRANTY
DATAcad warrants that the software will perform substantially in accordance with the accompanying printed materials for a period of ninety (90) days from the date of receipt. Any implied warranties on the software are limited to ninety (90) days. DATAcad does not warrant that the functions contained in the software will meet your requirements or that the operation of the software will be uninterrupted or error-free or that any software defects will be corrected. Some states/jurisdictions do not allow limitations on the duration of an implied warranty, so the above limitation may not apply to you.
Customer Remedies

DATACAD's and its suppliers' entire liability and your exclusive remedy shall be, at DATACAD's option, either 1) return of the price paid less shipping and handling charges if applicable or 2) repair or replacement of the software that does not meet DATACAD’s Limited Warranty and which is returned to DATACAD with a copy of your receipt. This Limited Warranty is void if failure of the software has resulted from accident, abuse or misapplication. Any replacement software will be warranted for the remainder of the original warranty period or thirty (30) days, whichever is longer. Outside the United States of America, neither these remedies nor any product support services offered by DATACAD are available without proof of purchase from an authorized non-U.S. source.

No other warranties. To the maximum extent permitted by law, DATACAD and its suppliers disclaim all other warranties, either express or implied, including but not limited to, implied warranties of merchantability and fitness for a particular purpose, with regard to the software or the accompanying documentation. This limited warranty gives you specific legal rights. You may have other rights which vary between different states/jurisdictions.

No liability for consequential damages. In no event shall DATACAD or its suppliers be liable for any damages whatsoever (including, without limitation, damages for loss of business profits, business interruption, loss of business information, or any other pecuniary loss) arising out of the use of or inability to use this DATACAD product, even if DATACAD has been advised of the possibility of such damages. Because some states/jurisdictions do not allow the exclusion or limitation of liability for consequential or incidental damages, the above limitation may not apply to you.

**Federal Government**

The software and documentation are provided with Restricted Rights. Use, duplication or disclosure by the Government is subject to restriction as set forth in subparagraph (c)(1)(ii) of The Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 or subparagraphs (c)(1) and (2) of the Commercial Computer Software - Restricted Rights at 48 CFR 52.227-19, as applicable. Manufacturer is DATACAD LLC, 20 Tower Lane, Avon, CT 06001.

If you acquired this product in the United States of America, this Agreement is governed by the laws of the State of Connecticut. Should you have any questions concerning this Agreement, or if you desire to contact DATACAD for any reason:

Tel: (860) 677-4004
Fax: (860) 677-2610
E-mail: info@datacad.com
Write: DATACAD LLC, Product Development, 20 Tower Lane, Avon, CT 06001.
# Table of Contents

**Up & Running** ............................................................................................................................ 17

How to Use This Manual .................................................................................................................. 18

Getting Help in DataCAD LT ........................................................................................................ 18

Installing DataCAD LT .................................................................................................................... 18

- System Requirements .............................................................................................................. 18
- Before You Begin ....................................................................................................................... 19
- New Directory Structure .......................................................................................................... 19
- Drawing Files ............................................................................................................................. 20
- Symbols ....................................................................................................................................... 20
- Support Files ............................................................................................................................... 20
- Text Fonts .................................................................................................................................... 22
- DCAL Macros ............................................................................................................................... 22
- Pre-installation Checklist .......................................................................................................... 22
- Running the Setup Program ....................................................................................................... 23

**The Drawing Board** .................................................................................................................... 25

Opening a Drawing .......................................................................................................................... 26

- Opening an Existing Drawing .................................................................................................. 26
- Creating a New Drawing ............................................................................................................ 28
- Importing a DWG or DXF Drawing File .................................................................................... 28
- Using Windows Explorer to Open Files ...................................................................................... 31

A Brief Tour ........................................................................................................................................ 31

- The Menu Bar ........................................................................................................................... 31
- Toolbars ....................................................................................................................................... 32
- Dialog Boxes ............................................................................................................................... 40
- The Menu Window ....................................................................................................................... 40
- The Drawing Area ....................................................................................................................... 43

Customizing DataCAD LT .............................................................................................................. 44

- Customizing Pathnames ........................................................................................................... 44
- Customizing DataCAD LT's Interface ......................................................................................... 45
- Customizing File Translation ...................................................................................................... 54
- Customizing the Macros Menu ................................................................................................... 58
- Customizing Miscellaneous Settings ........................................................................................ 59

Common Menus in DataCAD LT .................................................................................................... 61

- Selection Menus ....................................................................................................................... 61
- Value Menus .............................................................................................................................. 63
- Color Menus .............................................................................................................................. 65

Working with Dual Monitors ......................................................................................................... 66

Planning Your Project ..................................................................................................................... 67

- Gathering Project Information ............................................................................................... 67
- Planning Layers .......................................................................................................................... 67
- Prioritizing Drawing Tasks ........................................................................................................ 69
- Drawing Efficiently .................................................................................................................... 69
- Sample Project ........................................................................................................................... 69

Basic Drawing and Editing ............................................................................................................. 72

- Drawing Using the Mouse .......................................................................................................... 72
- Drawing Using Coordinate Entry ............................................................................................... 72
- Drawing with Line Types ........................................................................................................... 74
- Basic Editing Tools ..................................................................................................................... 77
Referencing Drawings ........................................................................................................................................... 79
Inserting Images Directly into Drawings ............................................................................................................... 80
Viewing Drawings.......................................................................................................................................................
  Zooming In and Out 82
  Changing Your View Using the Keyboard 84
  Changing Your View Using the Navigation Toolbar 84
Saving Drawings....................................................................................................................................................... 84
  More About Working with Files 86
  Backing Up and Recovering Files 89
  Exporting Files 91
Launching External Applications.................................................................................................................................. 93

Tutorial: Drawing a Schoolhouse .......................................................................................................................... 95
Setting Up a New Drawing......................................................................................................................................... 96
  Setting the Snap Grid for the Tutorial 96
  Creating New Layers for the Tutorial 96
  Naming Layers for the Tutorial 96
  Moving Between Layers in the Tutorial 97
  Assigning Colors to Layers in the Tutorial 97
Drawing Walls, Windows, and Doors..................................................................................................................... 98
  Drawing the Schoolhouse Walls 98
  Drawing the Schoolhouse’s Doors and Windows 112

Tutorial: Adding Dimensions, Notes, Symbols, and Hatching ............................................................................. 125
Adding Text to the Schoolhouse Drawing............................................................................................................... 126
  Drawing Text Arrows in the Schoolhouse Drawing 129
  Editing Text in the Schoolhouse Drawing 130
Dimensioning the Schoolhouse Drawing.................................................................................................................. 131
  Drawing a String of Dimensions: 132
  Automatic Dimensioning 134
  Stretching Dimensions 135
Hatching the Schoolhouse Drawing.......................................................................................................................... 137
Adding Symbols to the Schoolhouse........................................................................................................................ 140
  Opening a Symbol Folder 140
  Selecting and Placing Symbols 141
  Selecting Another Symbol File 143
  Copying Symbols 144
Drawing a Title Block and Border.............................................................................................................................. 145
  Moving the Border 146
  Drawing a Title Block 147

Tutorial: Printing a Drawing........................................................................................................................................ 151
Printing the Schoolhouse Drawing.......................................................................................................................... 152
  Printing Options 154

Tutorial: Modeling..................................................................................................................................................... 157
Modeling the Schoolhouse......................................................................................................................................... 158
  Adding Windows 158
  Adding 3D Doors 159
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Viewing the 3D Model</td>
<td>161</td>
</tr>
<tr>
<td>Adding a 3D Roof</td>
<td>161</td>
</tr>
<tr>
<td>Finishing the Schoolhouse Drawing</td>
<td>162</td>
</tr>
<tr>
<td>Viewing Your Drawing in 3D</td>
<td>164</td>
</tr>
<tr>
<td>Advanced 3D Viewing</td>
<td>164</td>
</tr>
<tr>
<td>Creating Elevations</td>
<td>167</td>
</tr>
<tr>
<td>Before You Draw</td>
<td>171</td>
</tr>
<tr>
<td>Managing Your Project</td>
<td>172</td>
</tr>
<tr>
<td>Setting Up Your Drawing Grids</td>
<td>172</td>
</tr>
<tr>
<td>Using the Snap Grid</td>
<td>173</td>
</tr>
<tr>
<td>Using the Display Grids</td>
<td>173</td>
</tr>
<tr>
<td>Changing Grid Size</td>
<td>173</td>
</tr>
<tr>
<td>Changing Display Grid Color</td>
<td>174</td>
</tr>
<tr>
<td>Setting the Snap Angle</td>
<td>175</td>
</tr>
<tr>
<td>Setting the Grid Angle</td>
<td>175</td>
</tr>
<tr>
<td>Setting the Grid Origin</td>
<td>176</td>
</tr>
<tr>
<td>Working With Layers</td>
<td>176</td>
</tr>
<tr>
<td>Creating Layers</td>
<td>177</td>
</tr>
<tr>
<td>Setting the Active Layer</td>
<td>178</td>
</tr>
<tr>
<td>Displaying Layers</td>
<td>178</td>
</tr>
<tr>
<td>Locking Layers</td>
<td>179</td>
</tr>
<tr>
<td>Renaming Layers</td>
<td>180</td>
</tr>
<tr>
<td>Changing Layer Color</td>
<td>180</td>
</tr>
<tr>
<td>Viewing a Layer</td>
<td>181</td>
</tr>
<tr>
<td>Deleting Layers and Their Contents</td>
<td>181</td>
</tr>
<tr>
<td>Selecting Layers Without Using Layer Names</td>
<td>182</td>
</tr>
<tr>
<td>Searching for Layers</td>
<td>183</td>
</tr>
<tr>
<td>Saving and Loading Layers</td>
<td>184</td>
</tr>
<tr>
<td>Using Layer Sets</td>
<td>185</td>
</tr>
<tr>
<td>Assigning Materials for a Layer</td>
<td>187</td>
</tr>
<tr>
<td>Setting Z-Base and Z-Height for a Layer</td>
<td>188</td>
</tr>
<tr>
<td>Using the Layer Manager</td>
<td>188</td>
</tr>
<tr>
<td>Accessing Layer Manager</td>
<td>188</td>
</tr>
<tr>
<td>Changing a Layer's Number</td>
<td>189</td>
</tr>
<tr>
<td>Sorting the Layers</td>
<td>189</td>
</tr>
<tr>
<td>Changing Layer Settings</td>
<td>190</td>
</tr>
<tr>
<td>Using Other Layer Functions</td>
<td>194</td>
</tr>
<tr>
<td>Changing an Incorrect Layer Setting</td>
<td>197</td>
</tr>
<tr>
<td>Exiting from the Layer Manager</td>
<td>198</td>
</tr>
<tr>
<td>Customizing Drawing Settings</td>
<td>198</td>
</tr>
<tr>
<td>Setting a Password</td>
<td>198</td>
</tr>
<tr>
<td>Setting Scale and Angle Types</td>
<td>199</td>
</tr>
<tr>
<td>Editing Scale, Angle, and Distance Lists</td>
<td>201</td>
</tr>
<tr>
<td>Setting Cursor Accuracy</td>
<td>203</td>
</tr>
<tr>
<td>Setting Display Options</td>
<td>204</td>
</tr>
<tr>
<td>Setting the Panning Distance</td>
<td>204</td>
</tr>
<tr>
<td>Automatically Saving Your Drawing</td>
<td>205</td>
</tr>
<tr>
<td>Synchronizing the Distance Display</td>
<td>205</td>
</tr>
<tr>
<td>Customizing Display</td>
<td>205</td>
</tr>
<tr>
<td>Customizing Colors</td>
<td>207</td>
</tr>
<tr>
<td>Drawing Walls, Windows, &amp; Doors .................................................................................................................. 211</td>
<td></td>
</tr>
<tr>
<td>---</td>
<td></td>
</tr>
<tr>
<td>Drawing Walls .................................................................................................................................................... 212</td>
<td></td>
</tr>
<tr>
<td>Using Wall Styles ............................................................................................................................................... 215</td>
<td></td>
</tr>
<tr>
<td>Cutting Walls ..................................................................................................................................................... 217</td>
<td></td>
</tr>
<tr>
<td>Drawing Doors ............................................................................................................................................... 218</td>
<td></td>
</tr>
<tr>
<td>Removing a Door ............................................................................................................................................... 222</td>
<td></td>
</tr>
<tr>
<td>Drawing Windows ............................................................................................................................................. 222</td>
<td></td>
</tr>
<tr>
<td>Removing a Window ............................................................................................................................................ 225</td>
<td></td>
</tr>
<tr>
<td>Drawing Other Geometry ................................................................................................................................... 227</td>
<td></td>
</tr>
<tr>
<td>Drawing Polygons ............................................................................................................................................... 228</td>
<td></td>
</tr>
<tr>
<td>Drawing Rectangles .......................................................................................................................................... 229</td>
<td></td>
</tr>
<tr>
<td>Drawing Curves ................................................................................................................................................ 230</td>
<td></td>
</tr>
<tr>
<td>Drawing 2-Point Arcs ...................................................................................................................................... 230</td>
<td></td>
</tr>
<tr>
<td>Drawing 3-Point Arcs ...................................................................................................................................... 231</td>
<td></td>
</tr>
<tr>
<td>Drawing Arcs By Center Angle .......................................................................................................................... 232</td>
<td></td>
</tr>
<tr>
<td>Drawing Arcs By Arc Length ............................................................................................................................. 232</td>
<td></td>
</tr>
<tr>
<td>Drawing Arcs By Chord Length .......................................................................................................................... 233</td>
<td></td>
</tr>
<tr>
<td>Drawing Arcs By Radius .................................................................................................................................... 234</td>
<td></td>
</tr>
<tr>
<td>Drawing Arcs By Included Angle ....................................................................................................................... 234</td>
<td></td>
</tr>
<tr>
<td>Drawing Arcs Using a Tangent Line .................................................................................................................... 235</td>
<td></td>
</tr>
<tr>
<td>Drawing Tangent Arcs ....................................................................................................................................... 236</td>
<td></td>
</tr>
<tr>
<td>Drawing Circles By Radius ............................................................................................................................... 236</td>
<td></td>
</tr>
<tr>
<td>Drawing Circles By Diameter ............................................................................................................................ 237</td>
<td></td>
</tr>
<tr>
<td>Drawing Circles By Points ................................................................................................................................. 238</td>
<td></td>
</tr>
<tr>
<td>Drawing Ellipses ................................................................................................................................................ 238</td>
<td></td>
</tr>
<tr>
<td>Drawing Curves Using Control Points ............................................................................................................... 239</td>
<td></td>
</tr>
<tr>
<td>Drawing Curves Using Surveyor's Data ............................................................................................................. 240</td>
<td></td>
</tr>
<tr>
<td>Drawing Polylines ............................................................................................................................................... 241</td>
<td></td>
</tr>
<tr>
<td>Voids in Polylines .............................................................................................................................................. 244</td>
<td></td>
</tr>
<tr>
<td>Other Ways to Draw ........................................................................................................................................... 247</td>
<td></td>
</tr>
<tr>
<td>Copying Entities .................................................................................................................................................. 248</td>
<td></td>
</tr>
<tr>
<td>Copying Entities a Specified Distance and Angle ............................................................................................ 248</td>
<td></td>
</tr>
<tr>
<td>Copying Entities by Dragging ............................................................................................................................. 249</td>
<td></td>
</tr>
<tr>
<td>Copying Entities at the Perpendicular ............................................................................................................... 250</td>
<td></td>
</tr>
<tr>
<td>Copying to Another Layer .................................................................................................................................. 250</td>
<td></td>
</tr>
<tr>
<td>Copying Using Arrays ....................................................................................................................................... 252</td>
<td></td>
</tr>
<tr>
<td>Mirroring Entities ............................................................................................................................................... 257</td>
<td></td>
</tr>
<tr>
<td>Freehand Sketching .......................................................................................................................................... 258</td>
<td></td>
</tr>
<tr>
<td>Drawing Tools .................................................................................................................................................... 261</td>
<td></td>
</tr>
<tr>
<td>Setting Reference Points ................................................................................................................................. 262</td>
<td></td>
</tr>
<tr>
<td>Object Snapping ................................................................................................................................................. 264</td>
<td></td>
</tr>
<tr>
<td>Snapping to the Nearest Point ........................................................................................................................... 265</td>
<td></td>
</tr>
<tr>
<td>Snapping to Dividing Points .............................................................................................................................. 266</td>
<td></td>
</tr>
<tr>
<td>Snapping to End Points ...................................................................................................................................... 266</td>
<td></td>
</tr>
<tr>
<td>Snapping to the Midpoint of a Line .................................................................................................................... 266</td>
<td></td>
</tr>
<tr>
<td>Snapping to Arc and Circle Centers .................................................................................................................. 267</td>
<td></td>
</tr>
<tr>
<td>Snapping to Quadrant Points .............................................................................................................................. 267</td>
<td></td>
</tr>
</tbody>
</table>
Snapping to Intersections ................................................................. 268
Snapping to a Perpendicular ......................................................... 268
Snapping to Tangents ........................................................................ 269
Using Get-Snap .................................................................................. 269
Using Virtual Snapping ....................................................................... 271

Identifying Entities ............................................................................ 271

Measuring Entities .............................................................................. 272
  Measuring Lengths and Angles .......................................................... 272
  Measuring the Total Length of Lines .................................................. 275
  Measuring Areas, Perimeters, and Volumes ........................................ 275

Working with Entities ......................................................................... 278
  Dividing Entities ................................................................................ 278
  Marking Line Intersections ................................................................. 280
  Matching the Snap Grid to an Entity .................................................. 280

Editing Drawings ................................................................................. 283

Trimming, Welding, and Cleaning ..................................................... 284
  Trimming Corners ............................................................................... 284
  Trimming Entities .............................................................................. 286
  Welding Lines and Walls ................................................................... 287
  Cleaning Wall Intersections .............................................................. 288

Changing Entities ............................................................................... 291
  Changing Entity Attributes .............................................................. 291
  Changing Text Attributes ................................................................. 292

Moving Entities .................................................................................... 294
  Moving Entities to Absolute Zero ....................................................... 294
  Moving Entities by Specific Distance and Angle ................................ 295
  Moving Entities by Dragging ............................................................... 296
  Moving Entities to Another Layer ..................................................... 297
  Moving SPB-Filled Entities ............................................................... 298

Rotating Entities ................................................................................... 300

Stretching Entities ............................................................................... 302

Enlarging Entities ............................................................................... 303

Erasing Entities .................................................................................... 304

Editing Multiple Entities ..................................................................... 305
  Grouping Entities Together ............................................................... 305

Clipping and Cropping .......................................................................... 306

Text, Notes, and Labels ....................................................................... 309

Drawing Text ......................................................................................... 310
  Justifying Text .................................................................................... 312
  Aligning Text ...................................................................................... 312
  Fitting Text into Defined Areas .......................................................... 313
  Importing and Exporting Text ........................................................... 314
  Using Text Styles ............................................................................... 315
  Drawing Text Arrows ......................................................................... 316

Using TrueType Fonts Instead of SHX Fonts ...................................... 318

Using Text Attributes for Symbols .................................................... 320
  Adding Text Attributes for Symbols .................................................. 320
  Editing Text Attributes for Symbols .................................................. 322
## Dimensions

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drawing Linear Dimensions</td>
<td>326</td>
</tr>
<tr>
<td>Editing Linear Dimensions</td>
<td>332</td>
</tr>
<tr>
<td>Exploding Linear Dimensions</td>
<td>333</td>
</tr>
<tr>
<td>Drawing Dimensions for Angles and Curves</td>
<td>334</td>
</tr>
</tbody>
</table>

## Hatch

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drawing Hatch Patterns</td>
<td>338</td>
</tr>
<tr>
<td>Drawing Standard Hatch</td>
<td>338</td>
</tr>
<tr>
<td>Using the Hatch Pattern Manager</td>
<td>339</td>
</tr>
<tr>
<td>Defining the Hatch Boundary</td>
<td>341</td>
</tr>
<tr>
<td>Using SPB Fills Instead of Standard Hatch Patterns</td>
<td>343</td>
</tr>
<tr>
<td>Drawing Associative Hatch</td>
<td>345</td>
</tr>
</tbody>
</table>

## Symbols, Images, and Objects

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using the Symbol Browser</td>
<td>348</td>
</tr>
<tr>
<td>Positioning the Symbol Browser on your DataCAD LT Desktop</td>
<td>348</td>
</tr>
<tr>
<td>Inserting Stamps</td>
<td>359</td>
</tr>
<tr>
<td>Inserting o2c Objects</td>
<td>359</td>
</tr>
<tr>
<td>Importing BMP, JPEG, and Other Image Files</td>
<td>359</td>
</tr>
<tr>
<td>Calibrating Enlargements</td>
<td>360</td>
</tr>
</tbody>
</table>

## Elevations and Sections

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drawing Exterior Elevations</td>
<td>364</td>
</tr>
<tr>
<td>Drawing Door Elevations</td>
<td>366</td>
</tr>
<tr>
<td>Drawing Window Elevations</td>
<td>369</td>
</tr>
<tr>
<td>Drawing Cabinet Elevations</td>
<td>371</td>
</tr>
<tr>
<td>Drawing Sections</td>
<td>373</td>
</tr>
</tbody>
</table>

## Printing Your Drawing

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printing Basics</td>
<td>376</td>
</tr>
<tr>
<td>More About Previewing Your Plot</td>
<td>380</td>
</tr>
<tr>
<td>Printing a Check Plot</td>
<td>380</td>
</tr>
<tr>
<td>Using Pen Tables</td>
<td>381</td>
</tr>
<tr>
<td>More About Using Pen Tables</td>
<td>382</td>
</tr>
<tr>
<td>Saving and Using Pen Table Settings</td>
<td>382</td>
</tr>
<tr>
<td>Laying Out Your Drawing</td>
<td>383</td>
</tr>
<tr>
<td>Using Quick Layout</td>
<td>383</td>
</tr>
</tbody>
</table>

## Modeling Basics

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Z-Base and Z-Height</td>
<td>386</td>
</tr>
<tr>
<td>Z By Layer</td>
<td>386</td>
</tr>
<tr>
<td>The Zero Plane</td>
<td>386</td>
</tr>
<tr>
<td>Changing 3D Settings</td>
<td>388</td>
</tr>
<tr>
<td>3D Settings Toggles</td>
<td>388</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Setting Primary and Secondary Divisions</td>
<td>389</td>
</tr>
<tr>
<td>Setting Z-Elevations</td>
<td>389</td>
</tr>
<tr>
<td>Drawing 3D Lines</td>
<td>389</td>
</tr>
<tr>
<td>All about 3D Snapping</td>
<td>390</td>
</tr>
<tr>
<td>Using Markers</td>
<td>393</td>
</tr>
<tr>
<td><strong>Modeling with 3D Polygons, Slabs, and Blocks</strong></td>
<td>395</td>
</tr>
<tr>
<td>Drawing Rectangular 3D Polygons and Slabs</td>
<td>396</td>
</tr>
<tr>
<td>Drawing Horizontal 3D Polygons and Slabs</td>
<td>396</td>
</tr>
<tr>
<td>Drawing Vertical 3D Polygons and Slabs</td>
<td>398</td>
</tr>
<tr>
<td>Drawing Inclined 3D Polygons and Slabs</td>
<td>400</td>
</tr>
<tr>
<td>Adding Voids to Polygons and Slabs</td>
<td>404</td>
</tr>
<tr>
<td>Editing 3D Polygons and Slabs</td>
<td>405</td>
</tr>
<tr>
<td>Drawing Blocks</td>
<td>408</td>
</tr>
<tr>
<td><strong>Drawing Single-Curved Entities</strong></td>
<td>411</td>
</tr>
<tr>
<td>Drawing 3D Arcs</td>
<td>412</td>
</tr>
<tr>
<td>Drawing Vertical Cylinders</td>
<td>414</td>
</tr>
<tr>
<td>Drawing Horizontal Cylinders</td>
<td>415</td>
</tr>
<tr>
<td>Drawing Cones and Truncated Cones</td>
<td>418</td>
</tr>
<tr>
<td><strong>Drawing Double-Curved Entities</strong></td>
<td>421</td>
</tr>
<tr>
<td>Drawing Spheres and Domes</td>
<td>422</td>
</tr>
<tr>
<td>Drawing Tori</td>
<td>424</td>
</tr>
<tr>
<td>Drawing Surfaces of Revolution</td>
<td>425</td>
</tr>
<tr>
<td>Drawing Mesh Surfaces</td>
<td>428</td>
</tr>
<tr>
<td><strong>Site Modeling</strong></td>
<td>433</td>
</tr>
<tr>
<td>Site Modeling with Drop Mesh</td>
<td>434</td>
</tr>
<tr>
<td>Drawing Topographical Maps with Contours</td>
<td>441</td>
</tr>
<tr>
<td><strong>Editing 3D Entities</strong></td>
<td>443</td>
</tr>
<tr>
<td>Rules for Editing 3D Entities</td>
<td>444</td>
</tr>
<tr>
<td>Moving 3D Entities</td>
<td>444</td>
</tr>
<tr>
<td>Copying 3D Entities</td>
<td>446</td>
</tr>
<tr>
<td>Rotating 3D Entities</td>
<td>448</td>
</tr>
<tr>
<td>Mirroring 3D Entities</td>
<td>448</td>
</tr>
<tr>
<td>Stretching 3D Entities</td>
<td>449</td>
</tr>
<tr>
<td>Enlarging 3D Entities</td>
<td>450</td>
</tr>
<tr>
<td>Exploding 3D Entities</td>
<td>450</td>
</tr>
<tr>
<td>Changing 3D Entities</td>
<td>451</td>
</tr>
<tr>
<td><strong>Viewing Your Model</strong></td>
<td>453</td>
</tr>
<tr>
<td>Creating Parallel Views</td>
<td>455</td>
</tr>
</tbody>
</table>
Creating an Isometric View ......................................................................................................................... 459
Creating Elevations ........................................................................................................................................ 459

Creating Perspective Views........................................................................................................................................................................... 461
   Establishing Perspective Settings ................................................................................................................................. 462
   Creating a One-Point Perspective .............................................................................................................................. 463
   Creating a Two-Point Perspective .............................................................................................................................. 464
   Creating a Three-Point Perspective .............................................................................................................................. 464
   Perspective Navigation Controls ............................................................................................................................. 465

Creating Oblique Views.................................................................................................................................................. 465
   Establishing Oblique Settings ........................................................................................................................................ 465
   Creating an Elevation Oblique View .......................................................................................................................... 465
   Creating a Plan Oblique View ...................................................................................................................................... 465

Creating a Hidden Line Removal............................................................................................................................................... 466
   Tips on Maximizing Performance .................................................................................................................................. 467
   Saving the Hide Image .................................................................................................................................................. 467
   Increasing Hide Speed ................................................................................................................................................... 468
   Hide Options .............................................................................................................................................................. 469

Creating a Shaded Image................................................................................................................................................................. 471
   Saving and Using Shader Settings ................................................................................................................................. 474
   Saving Your Shaded Image ....................................................................................................................................... 475

Viewing Selected Entities in Your Model ............................................................................................................................ 475

Saving a View................................................................................................................................................................. 477
   GoTo View .................................................................................................................................................................. 477

Walking Through Your Model ........................................................................................................................................... 479

Using the o2c-based Object Viewer............................................................................................................................................... 481

Rendering Settings............................................................................................................................................................... 484

Framing Your Model ........................................................................................................................................................................... 489
   Framing Floors.......................................................................................................................................................... 490
   Framing Walls.......................................................................................................................................................... 491
   Framing Roofs .......................................................................................................................................................... 493
       Defining the Roof Boundary ..................................................................................................................................... 496
       Joining Roofs ........................................................................................................................................................ 498
       Settings Options .................................................................................................................................................. 499
   Saving and Using Framing Settings ............................................................................................................................. 501

Modeling Concrete Forms...................................................................................................................................................... 505
   Drawing Columns.................................................................................................................................................. 506
   Drawing Inverted, Single and Double Tee Forms ........................................................................................................ 506
   Drawing Standard Beam Forms ................................................................................................................................... 508
   Drawing I-Beam Forms ............................................................................................................................................... 508

Modeling Stairs ............................................................................................................................................................................. 511
   Drawing 3D Stairs.................................................................................................................................................. 512
   Customizing Stair Settings ........................................................................................................................................ 515
       Stair Form ...................................................................................................................................................... 525
       Saving and Using Stair Settings ........................................................................................................................... 525
Appendix .................................................................................................................................. 527

INI Settings .......................................................................................................................................................... 528

DWG/DXF Translation Tables ................................................................................................................................... 530
  Importing ......................................................................................................................................................... 530
  Exporting ......................................................................................................................................................... 533

Creating Custom Toolbars .................................................................................................................................... 535
  Standard Line types ........................................................................................................................................... 538

Standard Hatch Patterns ......................................................................................................................................... 539
  Standard Keyboard Shortcuts .......................................................................................................................... 543
  Creating Keyboard Shortcuts for Pull-down Menu Options ............................................................................... 545

Standard Fonts ..................................................................................................................................................... 547

Extended characters .................................................................................................................................................. 547

Inserting Symbols in Drawings without the Symbol Browser .................................................................................. 548
  Finding and Using Older Template and Symbol Files ....................................................................................... 550

Creating and Editing Templates .................................................................................................................................. 551
  Editing Templates .................................................................................................................................................. 552

Creating and Editing Symbols .................................................................................................................................... 553
  Editing Symbols ................................................................................................................................................... 554
  Editing Information Fields ................................................................................................................................. 555
  Replacing Symbols in Your Drawing .................................................................................................................. 555
  Deleting Symbols ................................................................................................................................................. 556

Glossary ................................................................................................................................................................. 559

Index ........................................................................................................................................................................ 567
Up & Running

Getting DataCAD LT up and running is a simple matter with its flexible and interactive setup program. Use the "System Requirements" and "Pre-Installation Checklist" in this chapter to make sure you're ready to begin installing the program. The setup instructions that follow take you step-by-step through the installation process.

To get the most from this manual, please refer to “How to Use This Manual” in this chapter.

DATACAD LLC offers 45 days of free technical support on the current version of DataCAD LT. If you have any questions about installing DataCAD LT, you can contact DATACAD LLC Technical Support Monday through Friday, 8:30 a.m. – 5:00 p.m. eastern time, except during normally observed holidays, via phone at +1 (860) 677-2829, fax +1 (860) 677-2883, or e-mail techsupport@datacad.com.
How to Use This Manual
This manual begins with two chapters introducing DataCAD LT to you. “The Drawing Board” chapter covers such topics as opening and saving drawings, using coordinate entry, and common menus in the program.

Following this introduction, four additional chapters guide you through a basic tutorial, designed to quickly teach you how to use DataCAD LT’s basic functions to produce a plan drawing. All of these exercises focus on a single project.

The remainder of the manual gives detailed explanations as well as step-by-step instructions on how to use each DataCAD LT function and menu to complete drawing tasks. These instructions may include typing words or characters, using keyboard shortcuts, selecting entities, and choosing menu options.

Words or characters to be typed are printed in bold; type them exactly as they appear. Keys to be pressed are shown just as they appear on your keyboard, with parentheses around the character(s), as shown below:

Press (Enter).
Press (Ctrl) + (M).

Combinations like the second example above should be executed by pressing and holding down the first key, pressing the second key, then releasing both simultaneously.

Some instructions ask you to “click” or “right-click” on a button or icon. To click on a button, move your mouse until your cursor arrow is over the button and then press the left mouse button once. To right-click, press the right mouse button once. Right-clicking generally doesn’t require specific placement of the cursor arrow; it must, however, be somewhere over the DataCAD LT window.

Getting Help in DataCAD LT
DataCAD LT includes online help, accessible by pressing (Ctrl) + (F1) or using the Help Menu in DataCAD LT. The online help contains the Reference Manual in .PDF format. To use the Reference Manual, you need the Adobe Reader. If you do not have the Adobe Reader on your computer, you can download a free copy from the Adobe website at www.adobe.com.

You can also access the online help from outside of DataCAD LT. Use Windows Explorer to open the DataCAD LT\Help folder and then double-click on DataCAD LT 12_Manual.pdf.

Installing DataCAD LT
To install DataCAD LT on your computer, first review the “System Requirements” and “Pre-Installation Checklist” sections below to make sure you have everything you need to install the program. Then follow the instructions in “Running the Setup Program” on the next page.

Information in this section requires you to be familiar with your computer hardware and your computer’s operating system (Microsoft Windows 2000/XP/Vista).

To check available free hard disk space prior to installation, double-click on the My Computer icon on your Windows desktop. Right-click on the drive you want to install DataCAD LT on, and select Properties. The hard disk space already in use will be displayed as well as the amount that is still free.

System Requirements
Make sure you have the following minimum requirements to install and run DataCAD LT for Windows:
Before You Begin

DataCAD LT 12 includes significant enhancements. In particular, the addition of intelligent objects such as walls, doors, and windows. If you are upgrading from a version of DataCAD LT prior to 11, you will also need to be aware of changes to the drawing file format, directory structure, file and folder names, and program default settings. The Whats New? file on your DataCAD LT 12 CD-ROM has more details about new features and enhancements. Due to the fundamental nature of these changes, DataCAD LT 12 must be installed into a new program folder. The installation program will not allow DataCAD LT 12 to be installed in the same folder as DataCAD LT 11 and prior versions.

If you are installing DataCAD LT 12 on a computer with a DataCAD LT 11 or prior version, you may have existing program preferences and customized support files like hatch patterns and line types. During installation, you can choose to copy some of your settings and files to your DataCAD LT 12 program folder automatically. You will need to copy other support files manually. Customizable files (such as drawings, symbols, and templates) are not automatically copied into your DataCAD LT 12 program folder during installation. You need to decide which of these files, if any, you will copy into your DataCAD LT 12 program folder.

These instructions will help you update your DataCAD LT software to version 12. We recommend that you make a complete backup of your program data and support files before you install this upgrade and before you modify, copy, or convert any data or support files. If you don’t make a backup, you may not be able to recover from an error or program failure.

New Directory Structure

Versions of DataCAD LT prior to 11 were installed in a folder named DCADLT. The folders shown in the Older Versions column have been replaced by the folders shown in the Version 12 column.

<table>
<thead>
<tr>
<th>Older Version</th>
<th>Version 12</th>
</tr>
</thead>
<tbody>
<tr>
<td>\BMP</td>
<td>\Bitmaps</td>
</tr>
<tr>
<td>\Default</td>
<td>\Default Drawings</td>
</tr>
<tr>
<td>\DWG</td>
<td>\Drawings</td>
</tr>
<tr>
<td>\CHR</td>
<td>\Fonts</td>
</tr>
<tr>
<td>\Help</td>
<td>\Help</td>
</tr>
<tr>
<td>\LYR</td>
<td>\Layer Files</td>
</tr>
</tbody>
</table>
### Drawing Files

DataCAD LT drawing files have a new file format. This is primarily due to the enhancement to a double-precision database. All existing DataCAD LT drawing files (DC5) are automatically converted to the new format when you open them with DataCAD LT 12. When you close the drawing files, they are saved in the new format with the AEC extension (the original DC5 is not overwritten). Once you have converted your drawings, all future edits should be performed in the AEC file.

You can convert several drawing files at once by selecting multiple DC5 files in the File\Open dialog. Once they are open, select File\Close All. The resultant AEC files will automatically be saved at the same location as the DC5 files. DataCAD LT 12 will convert DC5 files to AEC files, but it will not convert AEC files to DC5 files.

### Symbols

DataCAD LT 12 has a powerful new feature called the Symbol Browser. This toolbar lets you view and use all of your symbol folders without cumbersome template files. By taking advantage of the Symbol Browser toolbar, you will probably find that you no longer need your existing template files. In addition, the symbol libraries that are included with DataCAD LT have been reorganized into a logical directory structure, making symbols easier to find.

DataCAD LT 12 symbol files have a new file format and use the file extension DSF. DataCAD LT 12 can read existing symbol files (with the SM3 extension) as well as the new DSF file format. You can access your existing symbol libraries with the Symbol Browser, simply set the path to your existing symbol folder. DataCAD LT 12 automatically creates DSF files when you save symbols.

### Support Files

DataCAD LT has a variety of support files used for different purposes; you can customize many of these files. You may have modified some of your DataCAD LT support files in a previous version or installed add-on products for DataCAD LT which updated them.

The DataCAD LT 12 installation program allows you copy your existing program preferences and customized files into DataCAD LT 12. If you chose to copy these files, they will be copied into your C:\DataCAD LT 12\ folder during installation.

<table>
<thead>
<tr>
<th>Files copied from DataCAD LT 9 - 10</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Support File Type</strong></td>
</tr>
<tr>
<td>Fonts</td>
</tr>
<tr>
<td>Report Forms</td>
</tr>
<tr>
<td>Toolbox Macros</td>
</tr>
<tr>
<td>Category</td>
</tr>
<tr>
<td>---------------------------------------</td>
</tr>
<tr>
<td>Hatch Pattern Definition File</td>
</tr>
<tr>
<td>Hatch Pattern Preview Settings File</td>
</tr>
<tr>
<td>Keyboard Macro File</td>
</tr>
<tr>
<td>Line Type Definition File</td>
</tr>
<tr>
<td>Command Line Alias File</td>
</tr>
<tr>
<td>Dimension Style Files</td>
</tr>
<tr>
<td>Palette Files</td>
</tr>
<tr>
<td>o2c Rendering Settings Files</td>
</tr>
<tr>
<td>Text Style File</td>
</tr>
<tr>
<td>Wall Style File</td>
</tr>
<tr>
<td>DWG Translator Color Mapping Files</td>
</tr>
<tr>
<td>DWG Translator Settings Files</td>
</tr>
<tr>
<td>Shader Light Settings Files</td>
</tr>
<tr>
<td>Default Angles</td>
</tr>
<tr>
<td>Default Decimals</td>
</tr>
<tr>
<td>Default Distances</td>
</tr>
<tr>
<td>Default Scales</td>
</tr>
<tr>
<td>Toolbar Files</td>
</tr>
<tr>
<td>Plotter Pen Settings Files</td>
</tr>
<tr>
<td>Default Drawings</td>
</tr>
</tbody>
</table>
### Text Fonts

DataCAD LT 12 provides direct support for SHX fonts and TrueType fonts (TTF). DataCAD LT CHR fonts are no longer used. However, your existing DataCAD LT fonts are automatically converted to SHX format. If you have additional CHR fonts, you can copy them to your `\DataCAD LT 12\Fonts\` folder for use with DataCAD LT 12. If you are using TrueType fonts in DataCAD LT, you don’t need to copy those font files since Windows manages your TrueType fonts from a central location on your computer.

### DCAL Macros

If you have additional DCAL Macros installed with your previous DataCAD LT version, you can copy those files into your `\DataCAD LT 12\Macros\` folder. DCAL Macros have the file extension DCX. Some macros may have additional support files or settings files that need to be copied along with them. In versions of DataCAD LT prior to 11, macros resided in the `\DCADLT\DCX\` folder.

The following macros are no longer included with DataCAD and should not be used with DataCAD 12:

- LyrUtil (Layer Utility)
- SymExp (Symbol Explode)

Functionality from LyrUtil and SymExp is built into Layers, LayerSets and 3D Explode menus respectively. Do not copy LyrUtil or SymExp macros into the new `\DataCAD LT 12\Macros\` folder.

### Pre-installation Checklist

- Do you have the minimum [system requirements](#) for DataCAD LT?
• Have you made a copy of your DataCAD LT folder to back up all your files? This is simply a precaution against losing any of your drawing files or customized settings.

**Running the Setup Program**
The DataCAD LT setup program guides you step-by-step through installing DataCAD LT. Please exit all Windows applications completely before running the DataCAD LT setup program. You must have Administrative Privileges to run this setup program. (This means you must be logged on as the Administrator.)

1. Place the DataCAD LT CD-ROM in your CD-ROM drive; the setup program should start automatically. If it doesn’t, click on Run in the Start menu. In the Open input box, type `e:\setup`, where “e” is the letter of your CD-ROM drive. Press (Enter) or click on OK. To cancel the installation at any time, press (Esc) or click Cancel.

2. The setup program begins. Simply follow the instructions on the screen. This version of DataCAD LT must be installed in a new program folder. Because of the many changes, you cannot install it in the same folder as a previous version of DataCAD LT.

3. Once setup is complete, you can view the ReadMe file, which contains important information about DataCAD LT that is not documented anywhere else. Click Finish to complete the setup program and open the ReadMe file.

The setup program will ask you to enter your serial number. Your serial number is printed on the back of the CD case and looks similar to LT12W12345.
The Drawing Board

A user-oriented menu system makes DataCAD LT easy to learn and convenient to use. Because it was developed by architects for architecture, the program focuses on design, not computer technology. Even draftsmen and designers with no previous computer experience can learn DataCAD LT quickly.

DataCAD LT’s dual menu system combines familiar Windows menus in the Menu Bar with a comprehensive, nested menu structure in the Menu Window. This unique system, along with toolbars and numerous keyboard shortcuts, allows constant access to the tools you use to draw, instead of covering your drawing area with menus that are only temporarily visible.

From your initial design work, massing studies, and interior perspectives to your final set of construction drawings, DataCAD LT provides you with the tools you need to produce quality work quickly, accurately, and with greater flexibility than ever before.

In this chapter:
- Creating drawings
- Opening drawings
- Importing and exporting drawings
- The DataCAD LT screen
- Common menus found throughout DataCAD LT
- Planning your drawing project
- Basic drawing and editing
- Viewing your project
- Naming and saving files
Opening a Drawing

DataCAD LT 12 drawings have an AEC file extension. When you create a new drawing, DataCAD LT adds the AEC extension automatically. When you open a DC3 or DC5 file in DataCAD LT 12 for the first time, it is automatically converted to an AEC file. This conversion process takes a few moments longer than usual. In the process, the drawing file is cleaned up and purged of unused entities and the database is converted from single-precision to double-precision.

DataCAD LT 12 uses double-precision floating point math to calculate and store values in the drawing database. Prior versions of DataCAD LT had an effective accuracy of 7 decimal places. DataCAD LT 12 has an effective accuracy of ~14 decimal places. That means DataCAD LT 12 is now as accurate as AutoCAD® and you can work on much larger projects without running into rounding issues, especially when importing large drawings.

DataCAD LT has five options for opening a drawing:

- opening an existing DataCAD LT drawing
- creating a new DataCAD LT drawing
- importing a DWG or DXF drawing file
- double-clicking on DataCAD LT drawing files in Windows Explorer

If DataCAD LT does not start, review Chapter 1 to make sure you meet all system requirements. See the first page of Chapter 1 for details on how to contact technical support.

If someone on your network is still using the file that you want to open, DataCAD LT can determine whether it is “in-use.” Every time you open a drawing, DataCAD LT records the date, time, username, and workstation name in a corresponding user (.USR) file. If you try to open a drawing file that is “in-use,” DataCAD LT will only allow you to open a copy of the file.

If you exit a file abnormally, DataCAD LT will automatically try to recover the most recent version of your file without prompting you with unnecessary warnings and options.

For more information about file formats, see “More About Working with Files” near the end of this chapter. For more information about recovery files, see “Backing Up and Recovering Files” near the end of this chapter.

Opening an Existing Drawing

You can open a DataCAD LT drawing when you first start DataCAD LT, while you’re working on another DataCAD LT drawing, or after you exit all drawings on your screen.

⇒ To open an existing DataCAD LT drawing:

1. Start DataCAD LT. If DataCAD LT is already running, click Open in the File pull-down menu. A dialog box opens, listing all files in the current folder.

   **Shortcut:** Press (Ctrl) + (O) to open an existing drawing file.

2. Select the type of file you want to open from the Files of Type drop-down box. You can open any DataCAD LT (DC5, AEC), DataCAD Plus (DC+), backup (DBK), or autorecover (ARF) files.
3. Click on the drawing you want to open to highlight it. If the Show Preview option is checked, a bitmap version of this drawing will be displayed in the preview window on the right side of the dialog box. If you don't want to see a preview of an existing drawing, simply click in the Show Preview box to remove the checkmark.

![Image of preview window](image)

**Figure 2.1:** The preview window displays a bitmap version of the drawing

4. Click on Open or press (Enter) on your keyboard. The drawing is opened. If a message displays alerting you to orphaned reference files, see the “Referencing Drawings” section in this chapter for instructions on resolving these orphaned files.

**Working with Folders in DataCAD LT’s Save and Open Dialog Boxes**

You’ll probably want to store your DataCAD LT drawings for each project in separate folders. If you have two projects, you might, for example, create two folders named PROJECT1 and PROJECT2 in DataCAD LT’s \Drawings folder.

➢ To create a new folder in DataCAD LT:
   1. Start DataCAD LT or click on New in the File pull-down menu.
   2. Click on the Create New Folder icon in the **Enter name of drawing file to edit** dialog box. The Create New Folder icon is at the top of the dialog box. A new folder appears in the dialog box.
   3. Type the name of the folder and press (Enter).

Obviously, a new folder has nothing in it when you create it. Only after you save drawings to that folder will the drawing filenames appear in the dialog box.

You’ll also want to save files to - or open files in - a different folder than what’s displayed in the dialog box. To do this, you’ll first have to change folders.

➢ To change folders in a dialog box:
   - Click on the arrow for the “Look in:” drop-down box and select a new folder; or
   - Click on the Up One Level icon and select a new folder from the list; or
• Double-click on a folder to open it.

Creating a New Drawing
You must name your new drawing before DataCAD LT will open it.

To create a new drawing:

1. Start DataCAD LT; if DataCAD LT is already running, click on New in the File pull-down menu. A dialog box appears with the title Enter name of drawing file to create.  
   **Shortcut:** Press (Ctrl) + (N) or press (Alt) + (N) to start a new drawing.

2. Type a name for your new drawing in the Filename input box. The drawing name can consist of letters, numbers, spaces, and any other characters except the following reserved characters: < > : " / \ | ? *

3. Click on Create or press (Enter). The new drawing is opened.

Importing a DWG or DXF Drawing File
DataCAD LT’s drawing translator can import DWG and DXF files compatible with AutoCAD R12-R14, R2000-R2002, R2004-2006, and R2007-R2009. You can choose an automatic translation or an interactive one, where you can decide how each line type and font should be translated and displayed in DataCAD LT.

Symbol Attributes appear as Block Attributes when you open a DWG file.

To import a DWG or DXF file and open it in DataCAD LT:

1. Select Open from the File pull-down menu. The Enter name of drawing file to open dialog box appears.

2. Select DWG or DXF from the Files of type drop-down box. Choose DWG to display all DWG files or select DXF to display all DXF files.
3. Select a file to import from the list or type the name of the file to import in the File name input box. By default, DataCAD LT looks for DXF and DWG files in your DataCAD LT\Transfer folder. If your DXF or DWG files are in a different folder, change to that folder and then click on the file you want to import.

You can open multiple files at the same time. Just highlight the first file, then press (Ctrl), and continue highlighting other files you want to open. DataCAD LT adds all the files you selected to the Filename field and will open all of them when you click on Open or press (Enter).

4. Click Open. The DWG Import Entity Assignments dialog box appears if the Import section of the DXF/DWG tab of the Configure DataCAD LT Settings dialog shows that “Interactively assign . . .” is toggled on. The options in the DWG Import Entity Assignments dialog box allow you to choose how DataCAD LT will translate line types and fonts.

5. Look at the options in the Line Type Assignments box; this lists each AutoCAD line type used in the file and suggests a DataCAD LT equivalent. To change any of these assignments, click on the line type to change. The line type you selected appears immediately below the Assignment list box with the translation line type in a drop-down box. Choose a new line type from the drop-down box; your selection appears in the preview window. When you click on the line type in the list box again, the name of the line type changes to reflect your choice.

6. Repeat step 5 for the Font Assignments. You can specify DataCAD LT-supplied or TrueType fonts.

7. Click on OK to close the dialog box and begin importing the file. Progress is noted in the Message toolbar. Or click on Cancel to stop the import process and close the dialog box.
CHAPTER 2: THE DRAWING BOARD

Figure 2.3: The DWG Import Entity Assignments dialog box

More About Importing Files Into DataCAD LT

The settings and assignments that are displayed in the DWG Import Entity Assignments dialog box are contained in a file called TRANSFER.INI in your DataCAD LT\Support Files folder. If you change any of the settings in the DWG Import Entity Assignments dialog box, you have the option to save those settings in a new .INI file to use when translating other files. This new .INI file is saved in the \Support Files folder. You can affect how importing files and the DWG Import Entity Assignments dialog box work through settings on the DXF/DWG tab in the Tools/Program Preferences Configure DataCAD LT Settings dialog box.

This could be useful if you normally exchange files with several different offices. If you change the settings and save a separate .INI file for each office, then you can easily switch between .INI files without having to go through entity assignments over and over again.

To save entity assignments:

1. Change settings and assignments in the DWG Import Entity Assignments dialog box as described in the step-by-step instructions on importing DWG files.
2. Click on Save As. The Save Settings As dialog box appears.
3. Type a filename for the new .INI file and click on Save. Or click on Cancel to stop the save. When you save the .INI file, the setting for the Translator Settings File on the DXF/DWG tab of the Configure DataCAD LT Settings dialog box is changed to that file.
4. Continue with step 7 in the instructions for importing a DWG or DXF file and opening it in DataCAD LT.

Using Windows Explorer to Open Files
When DataCAD LT is running, you can launch drawings from the Windows Explorer file browser. Just double-click on the drawing file you want to use and DataCAD LT will open it.

A Brief Tour

Figure 2.4: The DataCAD LT screen

The Menu Bar
The Menu Bar is located along the top of the DataCAD LT screen and contains the File, Edit, View, Insert, Create, Tools, Toolbox, Window, and Help pull-down menus. These menus give you quick access to standard Windows functions as well as many of DataCAD LT’s most used features.

Notice that some menu options have keyboard shortcuts associated with them. For instance, the Open option in the File menu has (Ctrl) + (O). Instead of using the mouse to choose a menu option, you can simply press the keyboard shortcut to quickly do the same thing.

➔ To choose an option from the Menu Bar:
1. Click on the menu name in the Menu Bar. The menu will drop down, displaying all the options in it.
2. Move your mouse down the menu to the option you want. Notice that each option highlights as your mouse passes over it.

3. Click on the option you want to select.

We’ve added hints for pull-down menu options in the MNU file. Hints appear on the Coordinates/Hints Toolbar when you highlight a pull-down menu item.

You can create keyboard shortcuts for any of the 250+ pull-down menu selections by editing the DCADWIN.MNU file. Refer to the Appendix for further information on creating keyboard shortcuts for the DataCAD LT menu items.

**Toolbars**

Toolbars surround the DataCAD LT Drawing Window. They give you quick access to a variety of DataCAD LT functions, no matter where you are in the program. In addition to the standard DataCAD LT toolbars, you can also use context-sensitive toolbars that appear when you perform various functions.

Icons, representing various DataCAD LT options, make up the toolbars. If you move your cursor over an icon, a description or ToolTip pops up nearby. The description is also displayed in the Coordinates/Hints toolbar.

DataCAD LT’s toolbars can be moved to a different screen position; you can even put them on your desktop to give you a larger Drawing Window. You can also reposition the DataCAD LT Menu Window.

**Using Toolbar Icons to Access Menu Functions**

You can click on an icon in any of the toolbars to quickly perform many drawing and editing tasks. For example, the ![Architect Icon](image)

![Architect Icon](image) that contains popular tools to help you draw walls, doors, and windows. Clicking on the door icon opens a further context-sensitive toolbar

![Door Swing Icon](image) that offers door swing alternatives.

Notice that as you click on different icons, the menu for that function appears in the Menu Window. Accessing menus using the toolbars instead of the Menu Window reduces the number of steps to get to a menu and, thus, saves you time.

For more information on how to turn off display of the toolbars or how to choose which toolbar appears, see **Toolbars Dialog** and “**Customizing DataCAD LT**” in this chapter. There are even icons in some toolbars that let you switch to a new toolbar.

**Toolbars Dialog**

The Toolbars dialog box appears when you select Toolbars from the View pull-down menu. This lets you select the toolbars you want to display. Toolbars you don’t want to display have no checkmark in the box.
**A BRIEF TOUR | 33**

**Figure 2.5:** The Toolbars dialog box

**Standard Toolbar**

The Standard Toolbar provides direct access to common Windows-based functions and to some frequently used DataCAD LT ones.

**Figure 2.6:** The Standard Toolbar

Going from left to right, the Standard Toolbar icons give quick access to these functions: create a new file; open an existing file; save changes to the current file; output your drawings to printer or plotter; check file for spelling errors; select entities to cut, copy, or paste; cut selected entities; copy selected entities to the clipboard; paste entities from the clipboard; undo utility; redo; reference DataCAD LT files; reference bitmaps; hyperlink a web URL, file, or go-to-view; change the order of entities; and open the reference manual.
Figure 2.7: You can change the order of entities in your drawing from the Standard Toolbar.

You can add the following entry to the [KeyFile] section of the DCADLT.INI file to automatically append the toolbar (.DTB) of your choice to the DataCAD LT Standard toolbar.

```
[KeyFile]
Standard=My_Toolbar.DTB
```

**Navigation Pad Toolbar**

The Navigation Pad Toolbar helps you quickly move about in your Drawing Window. It provides an easy way to view your model and access the Identify and Zoom menus. You can display this toolbar lengthwise or in the traditional square format. Traditionally, the second configuration is used so that the arrows are more ergonomically correct.

The icons in this toolbar (from left to right on the lengthwise version) do the following: zoom view in; pan view up; identify (accesses the Identify menu so that you can display the properties of an entity); pan view to left; zoom view to drawing extents; pan view to right; zoom view out; pan view down; and zoom to area (accesses the Zoom menu).

Figure 2.8: The Navigation Pad Toolbar

You can also use the keyboard arrow keys in the same way you use the Navigation Pad Toolbar arrows. The pan distance, or how much the display shifts each time you use one of the arrow keys, can be set to any value by selecting Scroll Dist. in the Settings menu. See “Setting the Panning Distance” in the “Settings” section of the “Before You Draw” chapter.

**Projection (view) Toolbar**

The nine icons in the Projection Pad Toolbar control the type of view that appears in your Drawing Window. The functions these icons initiate are also available from the View pull-down menu. You can display this toolbar lengthwise or in the traditional square format. The icons in this toolbar (from left to right on the lengthwise version) display the following types of views: parallel; front elevation; perspective; left elevation; plan; right elevation; isometric; back elevation; and oblique (axonometric).
**Figure 2.9:** The Projection Pad Toolbar

**View-sensitive Viewer Toolbar**

The Viewer Toolbar changes based on the type of view you select in the Projection Pad.

If you are displaying the plan or oblique (axonometric) view of your drawing, the Viewer Toolbar contains the following icons (from left to right): refresh display; display model in object viewer; display shaded view of model; remove hidden lines from 3D view; save current view; update selected view based on current view; set a new clip cube; and enable (on) or disable (off) clip cube.

**Figure 2.10:** Viewer Toolbar for plan or oblique (axonometric) view

If you display the parallel, elevation (front, back, right, left), or isometric view of the model, the Viewer Toolbar adds several rotation icons to the basic eight: rotate $+X$; rotate $-X$; rotate $+Y$; rotate $-Y$; rotate $+Z$; and rotate $-Z$.

**Figure 2.11:** Viewer Toolbar for parallel, elevation, or isometric view

If you display the perspective view of the model, the basic options remain, but the clip cube and rotational options are replaced by others with different functions (from left to right following the basic options): walk forward; walk backward; step left; step right; step up; step down; look up; look down; turn left; and turn right.

**Figure 2.12:** Viewer Toolbar for perspective views of your model

**Context-sensitive Toolbar**

Context-sensitive Toolbars appear when you perform various functions. To determine what function each icon performs, place your cursor on it for a few seconds to display a tool tip.
Cleanup options:

Architect options:

Door swing options:

Window options:

Polygon options:

Polyline options:

Modeling options:

Figure 2.13: Options shown as icons in context-sensitive toolbars perform the same functions as those in the traditional left-hand menu

**Status Panel Toolbar**

The Status Panel Toolbar provides quick access to color, layer, line type, scale, go-to-views, and input mode. An icon located to the left of each drop-down list accesses the related menu (i.e., the Layer Manager icon appears next to the layer list). If you click on the icon, the appropriate dialog box or left menu appears so that you can make your selection. Pull-down arrows on the right offer other options for each icon (e.g., the input modes are displayed on the pull-down menu in the example).

When you are working on a drawing, this toolbar provides information on the current settings. See *Customizing Display* in the “Before You Draw” chapter for more information on Display menu options.

You can set the number of pixels to add (positive value) to or subtract (negative value) from the status toolbar. In the DCADLT.INI, you can adjust the drop-down width:

```
[StatusArea]
DropDownWidth=
```

Current Layer
Current color
Current line type
Current display scale
Last Go To View selected
Figure 2.14: The Status Panel Toolbar

**Hotspots**

The Status Panel Toolbar gives you one-click access to the Layer Manager, Color Palette, Line Type, and Go To View menus. In the Status Panel Toolbar, just left-click on the item (text, color swatch, or square) you want to change. DataCAD LT instantly takes you to the appropriate menu or dialog box so you can make your new selection. For example, if you click on the active layer’s name, the Layer Manager dialog box appears. Clicking on a hotspot in the Status Panel Toolbar has the following results:

- Active layer’s color swatch – the Color Palette appears
- Active layer’s icon – the Layer Manager appears
- Current line type – the Line Type menu appears

**Changing the Active Layer**

In a drawing with multiple layers, pressing (Tab) changes the active layer by scrolling through all the layers that are on. You’ll see the active layer name in the Status Panel Toolbar change each time you press (Tab). Press (Shift) + (Tab) to scroll backward through your drawing’s layers.

**Toggling Layer Search On or Off**

You can click on the layer search toggle in the Status Panel Toolbar to quickly toggle layer search on or off. If the toggle is depressed, layer search is on; if the toggle button is raised, layer search is off. The Attention Toolbar lets you know if layer search is on or off. We’ll discuss DataCAD LT’s layer search option in "Selection Menus” later in this chapter.

**Shortcut:** Press the apostrophe key (’) to toggle the layer search option on or off.

**SWOTHLUDFB Toolbar**


Figure 2.15: Toggles that are off appear as lower-case letters
Coordinates/Hints, Attention, and Message Toolbars

The Attention, Message, and Coordinates/Hints Toolbars supply you with helpful warnings, input requirements and fields, and coordinate information. The information that appears in each toolbar depends on the function you are currently performing and the location of your cursor. If your cursor is on a symbol in the Symbol Browser, the Coordinates/Hints Toolbar displays information about the location of the symbol file. The Coordinates/Hints Toolbar can be resized when you dock it.

![Coordinates / Hints](image)

**Figure 2.16:** Helpful information and hints appear in these toolbars

The Pause Hint Toolbar appears to remind you of information you need to supply or displays the appropriate left menu.

![Attention](image)

**Figure 2.17:** DataCAD LT reminds you to supply information when you use a macro

MultiView Windows (a.k.a. MVTOTB™ MultiView Tear-Off Toolbars) in toolbar

The visual Go To View Windows can be displayed in a toolbar that is turned on or off from the View/MultiView pull-down menu.

**Shortcut:** Press (Ctrl) + (W) to turn the MultiView Windows toolbar on and off.

> To use MultiView Windows:

1. Create and name several Go To Views.
2. Set the number of MultiView windows you want by selecting Toolbars from the View pull-down menu and checking the appropriate number of Window boxes.
3. Select MultiView from the View pull-down menu.
4. Right-click within a window, select Go To View, and choose a view that you created in step 1. The view appears in the window.
Figure 2.18: Docked MultiView Windows Toolbars

5. Close the windows that do not display Go To Views.

You can display up to 10 Go To View windows plus undock and resize them to meet your needs. Once displayed, right click on the Go To View window for options. These windows may be torn off, re-sized, and repositioned. When docked, they return to their original size.

Figure 2.19: Undocked MultiView Windows

Classic Desktop

If you prefer the way your screen looked in DataCAD LT versions 10 and prior, you can use the Classic Desktop portion of the Toolbars dialog box in conjunction with a few other changes to recreate that traditional combined menu window, navigation pad, projection pad, and status area. For detailed information, see “Going Back to the Traditional Menu Window Setup” later in this chapter.
CHAPTER 2: THE DRAWING BOARD

Dialog Boxes

Many times when you select a menu option or click on a toolbar icon, an associated dialog box will appear on your screen. Some dialog boxes are informational and just require you to click OK to verify that you saw the message. Other dialog boxes ask for more input (such as color selection, layer names, or file names) before DataCAD LT performs a specific function.

If you want all dialog boxes to be centered, you can add an entry (CenterDialogBoxes=TRUE) to the DCADLT.INI file. By default, dialog boxes are not centered.

To center dialog boxes within an application:

1. Open the DCADLT.INI file. This document contains instructions for various aspects of the DataCAD LT software.
3. Add the following line at the end of the [General] section:
   
   CenterDialogBoxes=TRUE

4. Select Save from the File pull-down menu or press (Ctrl) + (S).
5. Close DCADLT.INI by selecting Exit from the File pull-down menu. The dialog boxes will be centered within the DataCAD LT applications.

If you later decide that you do not want dialog boxes to be centered, just change that line in the DCADLT.INI file to read:

CenterDialogBoxes=FALSE

The Menu Window

While DataCAD LT’s pull-down Menu Bar has menus that contain shortcuts to many of DataCAD LT’s most used functions as well as basic Window options, the majority of DataCAD LT’s menus are displayed in the Menu Window.

There are two main menus in the Menu Window: the Edit menu and the Utility menu. To switch between these two menus, click on the menu option in the Menu Window or simply right-click anywhere in the DataCAD LT window. Open a drawing in DataCAD LT and try right-clicking a few times; notice the menu selection changes between the Edit and Utility menus.

Both 2D and 3D menus are displayed in the Menu Window, but these menus are not interchangeable. For example, the Move command in the Edit menu should not be confused with the Move option in the 3D Menus.

Menus in the Menu Window are nested; there are many submenus available from the Edit and Utility menus. Each of these submenus may, in turn, contain additional submenus and menu options. When a submenu is being displayed, right-clicking exits the submenu and displays the previous menu in the Menu Window.

Shortcut: Press (PgUp) and (PgDn) to scroll forward and backward through menu lists. This only works when you’re in a menu with Scroll Fwrd and Scroll Back options. At all other times, these shortcuts are used to change your drawing display scale.

The Menu Window lists the options in the currently selected menu. If a menu contains more items than can be shown in a single list, a scroll forward option (Scroll Fwrd) appears at the bottom of the menu and will be available until you reach the end of the list. Once you scroll forward in a list, a scroll back option (Scroll Back) will also be available. As you move through DataCAD LT’s menu structure, the selections in the Menu Window change to reflect the different commands associated with each option.
Some DataCAD LT menu options are *toggles*, switches that can be turned on or off. When a toggle is on, the button appears depressed. When a toggle is off, the button appears raised. To make it more obvious that a toggle is on or off, you can select Program Preferences from the Tools pull-down menu, click on the Interface Settings tab in the Configure DataCAD LT Settings dialog box, and change the colors in the Toggle On Button and Toggle Off Button areas.

![Diagram of DataCAD LT menu options]

**Figure 2.20**: The Edit (left) and Utility menus

### 12-Character Menu Option Labels and Tool Tips

The menu option labels use up to 12 characters. DataCAD LT versions prior to 11 had an 8-character limit. Menus such as Architect and Dimension now read Architect and Dimension, respectively. The logic used to calculate the default width and height of menu buttons has been adjusted to make them more compact. A “Classic” option has been provided so you can restore the 8-character labels if you wish. For information on restoring the 8-character labels, go to the “Customizing DataCAD LT” section in this chapter.

Tool tips for each menu item have been added to help you use each option. Just resting your cursor briefly on a menu item displays the tool tip. The same tip also appears in the Coordinates/Hints toolbar. Menu items in macros do not have tool tips.

### Choosing Menu Options

There are four ways to choose a menu option:

- click on it using your mouse
- press the corresponding function key
- use a keyboard shortcut or command line alias
- click on an icon in one of the toolbars (described earlier in the “Toolbars” section of this chapter)
Many of the most productive DataCAD LT users employ keyboard shortcuts to enter values and choose menu options while using the mouse to draw and enter other drawing information. With one hand on the keyboard and the other on the mouse, you can draw in DataCAD LT very efficiently and quickly.

➔ To choose a menu option using the mouse:

1. Move the cursor over the option in the Menu Window that you’d like to use. The menu option highlights as the mouse cursor passes over it.
2. Click the left mouse button.
3. Right-click (click the right mouse button) when you are finished using the function; this lets you exit the menu.

Notice that immediately to the left of each menu option in the Menu Window is a label corresponding to the function keys on your keyboard. Function keys are usually located across the top or on the left side of your keyboard and are labeled as “F1,” “F2,” “F3,” etc. To choose a menu option, simply press the corresponding function key. If a menu option’s function key label is S1 through S0, press (Shift) + (F1) through (Shift) + (F10).

**Using Keyboard Shortcuts to Access Menu Options**

Keyboard shortcuts let you access a variety of functions quickly just by pressing one or two keys. For example, you can press (A) on the keyboard to open the Architect menu *from anywhere in DataCAD LT* instead of using the mouse to choose the option from the Draw Toolbar or Menu Window.

In this manual, all keyboard shortcuts are described exactly how they should be executed. If a shortcut requires a lowercase letter, you will be instructed to press only that letter. If a shortcut requires an uppercase letter, you will be instructed to press (Shift) and that letter simultaneously. For instance, the snap grid can be toggled on and off by pressing (X) (a lowercase “x”); however, to open the Object Snap menu via the keyboard, you must use an uppercase “X,” so you must press (Shift) + (X).

There are several shortcuts that will be particularly useful to you as you draw:

<table>
<thead>
<tr>
<th>SHORTCUT</th>
<th>FUNCTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Home)</td>
<td>Centers a drawing or view on the screen at the cursor’s current position. To reposition a drawing, move the cursor to the new center and press (Home).</td>
</tr>
<tr>
<td>()</td>
<td>Deletes only the last entity you drew.</td>
</tr>
<tr>
<td>(&lt;)</td>
<td>Deletes the last group you drew; you can also use Undo in the Edit pull-down menu.</td>
</tr>
<tr>
<td>(.)</td>
<td>Restores only the last entity you deleted. This shortcut does not undo your previous actions; it just restores the deleted entity.</td>
</tr>
<tr>
<td>(&gt;</td>
<td>Restores the last group you deleted; you can also use Redo in the Edit pull-down menu. This shortcut does not redo your previous actions; it just restores the deleted group.</td>
</tr>
<tr>
<td>(Esc)</td>
<td>Refreshes the screen using the information in Display List.</td>
</tr>
<tr>
<td>(End)</td>
<td>Terminates the screen refresh on the active layer only. To terminate the screen refresh on additional layers, press (End) once for each additional layer. (End) does not affect the drawing file, only that portion of it which appears. Save time on large drawings. Once the part of the drawing you want to edit is redrawn, press (End) to cancel the rest of the refresh.</td>
</tr>
<tr>
<td>(Delete)</td>
<td>Terminates the screen refresh on all layers simultaneously.</td>
</tr>
<tr>
<td>(PgUp), (PgDn)</td>
<td>Changes the display scale in increments specified in the To Scale menu. To zoom out, press (PgUp); to zoom in, press (PgDn).</td>
</tr>
<tr>
<td>(P)</td>
<td>Restores the previous view and returns to the previous scale in one keystroke. DataCAD LT remembers up to 25 previous views.</td>
</tr>
<tr>
<td>(U\u)</td>
<td>Redraws the screen using the most recent information in the drawing file database.</td>
</tr>
</tbody>
</table>
Some keyboard shortcuts can yield unexpected results if you don't clearly understand what the command does. For example, there’s a difference between Undo/Redo and Restore commands. The results you get with the keyboard shortcuts (,), (<), (.), and (>) are not the same as what happens when you use Undo or Redo. The keyboard shortcut for Undo (which negates the last command you used) is (Ctrl) + (Z); this produces the same results as selecting Undo from the Edit pull-down menu or clicking the Back button on the Undo/Redo Toolbar. The keyboard shortcut for Redo (which reinstates the last command undone by using Undo) is (Ctrl) + (Y); this produces the same results as selecting Redo from the Edit pull-down menu or clicking the Redo button on the Standard Toolbar.

The Appendix has a complete list of all keyboard shortcuts in DataCAD LT.

The Drawing Area

The Drawing Area, the largest in the DataCAD LT window, displays drawing contents. Lines, arcs, walls, fixtures, and anything else you design are displayed. Although drawings in DataCAD LT are drawn at full scale in an infinite field, you can display any portion of a drawing at any scale. In other words, you can zoom in and out on your drawing, as needed. To do this, you can use the Disp. Scale and Zoom options in the Utility menu. See “Viewing Drawings” later in this chapter for more information on zooming in and out on your drawing.

Figure 2.21: The Drawing Area is the largest part of the DataCAD LT window
**Customizing DataCAD LT**

The Configure DataCAD LT Settings dialog box (available from the Tools/Program Preferences pull-down menu) lets you customize folders for each DataCAD LT file type, how the DataCAD LT screen looks, how the DWG/DXF translator works, and the macros available in the Toolbox pull-down menu, as well as several miscellaneous settings.

**Customizing Pathnames**

The Pathnames tab in the Configure DataCAD LT Settings dialog box lists the default folders that files are stored in.

To reset all folder names to their defaults, click Defaults in the bottom right corner of the Configure DataCAD LT Settings dialog box.

➢ To change a path:

1. Choose Program Preferences from the Tools pull-down menu.
2. Click in the input box of the folder path you’d like to change and type a new path; or click on the folder icon at the right of the path to be changed and browse for a new path.
3. Click on OK to save your changes and close the dialog box; click on Defaults to reset all paths to their DataCAD LT defaults.

If you enter a folder name that doesn’t exist, clicking on OK will simply highlight the incorrect folder.
DataCAD LT tries to resolve invalid reference file paths. It does this by checking the current drawing file folder for valid references. If a valid reference file is found in the current drawing file folder, it will be used instead of the file designated in the original path; however, the original path will be retained.

**Customizing DataCAD LT’s Interface**

DataCAD LT 12 features a program interface that provides Windows 2000-style properties and support for Windows XP Themes. You can position toolbars and menus where you want by tearing them off and docking them to the top, bottom, left, or right side of the application window. You can also place toolbars and menus outside of DataCAD LT to “float” on your desktop, allowing you to resize the drawing area without adversely affecting the user interface. In addition, all of the interface elements in DataCAD LT 12 will inherit the visual style of your current desktop theme. For more information about Windows XP Themes, go to [http://www.themexp.org](http://www.themexp.org).
CHAPTER 2: THE DRAWING BOARD

Figure 2.23: The Interface Settings tab of the Configure DataCAD LT Settings dialog box

Setting the Screen Calibration

You can access the Screen Calibration dialog box by clicking on the Screen Calibration button on the Interface Settings tab. You can measure the test pattern in either decimal inches or millimeters to adjust both the screen scaling and aspect ratio.

➡ To calibrate your screen:

1. Select Program Preferences form the Tools pull-down menu. The Configure DataCAD LT Settings dialog box appears.
2. Click on the Interface tab.
3. Click on the Screen Calibration button. The Screen Calibration dialog box appears.
4. Indicate which unit of measurement you are using by selecting either Inches or mm in the Units section.

5. Measure the horizontal and vertical lines inside the ellipse and enter their lengths in the boxes provided at the bottom of the Screen Calibration dialog. Click on Ok or press (Enter) when you are finished.

**Customizing Menu Labels**

You can easily change menu and toolbar options to customize your DataCAD LT desktop.

Have you been a long-time DataCAD LT user? If so, you may prefer the old-fashioned set-up that was in effect from version 10 and prior. In DataCAD LT version 10 and prior, the menu options, navigation pad, projection pad, and status area was “glued” together (instead of the newer Toolbar elements that you can position anywhere). You can get this classic appearance by making a few changes in the Configure DataCAD LT Settings dialog box and the Toolbars dialog box.

To change the menu labels and/or buttons:

1. Select Program Preferences from the Tools pull-down menu. The Configure DataCAD LT Settings dialog box appears.

2. Click on the Interface Settings tab and go to the Menus area.

3. Change the appearance of Menu Window labels and buttons:
• To use the traditional 8-character labels that were standard with DataCAD LT versions prior to 11, click in the Classic Labels box to insert a checkmark.

• To use the newer, 12-character labels, make sure there is no checkmark in the Classic Labels box.

• To use the traditional button shape for menu options that was a standard feature of DataCAD LT versions prior to 11, click in the Classic Buttons box to insert a checkmark.

• To use the newer, button-free menu, make sure there is no checkmark in the Classic Buttons box.

4. Click on OK to close the Configure DataCAD LT Settings dialog box.

![Figure 2.25: Comparison of 12-character (left) and Classic 8-character (right) menu labels](image)

To change the colors of the Drawing Area, menu buttons, function key labels, and tool tips:

1. Click on Program Preferences in the Tools pull-down menu. The Configure DataCAD LT Settings dialog box appears.

2. Click on the Interface Settings tab, if it’s not already showing.

3. Position your cursor on the color swatch that you want to change.

4. Click to open a Color dialog box.
Figure 2.26: The Color dialog box lets you select new colors for the function key labels, buttons, drawing area background, and tool tips

5. Choose a new color from the basic or custom colors available or mix your own on the right side of the Color dialog box. Click on OK to close the Color dialog box.

6. Repeat steps 3 through 5 to change the colors shown on any of the other swatches on the Interface Settings tab.

7. Click on OK to close the Configure DataCAD LT Settings dialog box. The colors you selected are in effect.

To change the font used on the menu buttons in the Menu Window or the font used in the toolbars:

1. Click on Program Preferences in the Tools pull-down menu. The Configure DataCAD LT Settings dialog box appears.

2. Click on the Interface Settings tab, if it’s not already showing.

3. Click on the Font button in the top left corner of the Interface Settings tab to change the type on the menu and toolbars. Click on the Font button in the Drawing Area section of the Interface Settings tab to change the type in that portion. The Font dialog box appears.
Figure 2.27: The Font dialog box

4. Choose a new font, font style, and size; then click on OK. The Fonts dialog box closes.

5. Click on OK to close the Configure DataCAD LT Settings dialog box. The fonts you selected are in effect.

Going Back to the Traditional Menu Window Setup
You can get the “classic” look that was standard prior to DataCAD LT version 11 by making a few simple changes.

→ To glue the Menu Window, Navigation Pad, Projection Pad, and Status Area together to produce the traditional (DataCAD LT version 10 and prior) appearance:

1. Select Toolbars from the View pull-down menu. The Toolbars dialog box appears.

2. Eliminate the checkmarks in the Projection Pad, Navigation Pad, and Status Panel boxes in the upper portion of the Toolbars dialog box.

3. Click in the three boxes in the Classic Desktop portion of the Toolbars dialog box. When these three boxes in the Classic Desktop portion are checked, these elements will be “glued” together with the Menu Window to produce the traditional (DataCAD LT version 10 and prior) appearance.

You could have duplicate toolbar elements if checkmarks still appear in the Projection Pad, Navigation Pad, and Status Panel boxes in the upper portion of the Toolbars dialog box and you added checkmarks to the three options in the Classic Desktop portion. This will not affect DataCAD LT’s performance, but it will add unnecessary clutter on your computer desktop.
Figure 2.28: The Classic Desktop elements are activated

4. Click OK to close the Toolbars dialog box. The menu, navigation, projection, and status elements are “glued” together.
Selecting Default Icon Toolbars

There are two default user-defined toolbars that can be active simultaneously. You can configure these toolbars by selecting the Interface Settings tab in Program Preferences from the Tools pull-down menu.

You can select any of the available toolbars from the pull-down menu for the two default toolbars. Your options are: Architect, Cleanup, Doorswing, Draw, Edit, Model, Polygon, Polyline, and Windows.

In this example, the default toolbars are Edit and Draw.
Figure 2.30: The default Draw Toolbar with pull-down menu for one icon

In the Draw Toolbar, the icons (from left to right) are: Architect menu – draw walls, doors, and windows; draw lines; draw walls; cleanup intersections of lines and walls; place doors in walls; place windows in walls; draw 2D polygon shapes; draw rectangular shapes; draw arcs, circles, and polylines (with additional options available from a pull-down menu); add text to the drawing; draw arrow or select arrow settings; dimension entities in the drawing; hatch entities in the drawing; and browse symbol directories.

Figure 2.31: Default Edit Toolbar showing one of three pull-down menus

In the Edit Toolbar, the icons (from left to right) are: move drawing entities (with additional options available from a pull-down menu); make copies of drawing entities (with additional pull-down menu options); rotate drawing entities around a point; rotate and keep the original entities; mirror drawing entities about a line; mirror drawing entities about a line and keep the original entities; scale the size of the entities (with additional pull-down menu options); offset (copy entities parallel to existing entities); delete entities from the drawing; identify (display the properties of an entity); identify/set all (change current settings to match those of an existing entity); change the properties of existing entities to match those of another entity; and measure drawing entities and perform takeoffs.

Changing Other Interface Settings

You can personalize other aspects of the DataCAD LT graphical interface to suit your needs (especially helpful if you are colorblind) or your tastes (eclectic versus conservative).

To change other interface settings:

1. Select Program Preferences from the Tools pull-down menu. The Configure DataCAD LT Settings dialog box appears.
2. Click on the Interface Settings tab. The settings affect the left menu and message lines; pull-down menus cannot be changed.
3. Decide what colors you want to change, click on the appropriate sample swatch, and select the color you want from the Color Palette dialog box.

Function key label: Located at the left edge in the left-hand menu.
Buttons: Each menu button has a highlight, text, and text highlight color that you can change. Highlight Color appears when you run your cursor over a regular (not a toggle) menu button; Text Color affects the text on the nonhighlighted menu button (the TestBtn shows a sample); Text Highlight Color appears on a highlighted button as your cursor passes over it.

Normal: Clicking on a normal button calls up a submenu or requests input.
Active Layer: Affects only the active layer, not the inactive ones.
Toggle ON: Affects just the active menu functions (the button is depressed).
Toggle OFF: Affects just the inactive menu functions (the button is raised).

Background: Drawing window color.
Tooltips: Background color of tooltip.

4. Decide what fonts you want to change, click on the appropriate Font button, and select font, style, and size from the Font dialog box:

Display: Affects text that appears in the left-hand menu and in the message, error, and coordinate toolbars.
Drawing Window: Affects text you add to the file displayed in your Drawing Window.

5. Use the slider bars to set how long tooltips should appear.

Display Delay: Affects how fast a tooltip appears from the moment your cursor hovers on a function.
Hide Delay: Affects how quickly the tooltip disappears.

6. Click on OK to make your changes take effect. If you click on Defaults, DataCAD LT ignores your changes and asks you to confirm your decision before it restores the original interface settings.

Figure 2.32: This warning appears if you click on Defaults to restore DataCAD LT’s original interface settings.

Customizing File Translation

The DXF/DWG tab on the Configure DataCAD LT Settings dialog box (via Program Preferences from the Tools pull-down menu) lets you choose an import method, translator default settings, and 3D entity export method. DXF/DWG supports solid fills, TrueType fonts, polylines with voids, and complex hatch patterns (such as StoneCAD).
You can choose between two import methods: the first method allows you to interactively (manually) assign line types and fonts, while the second makes these assignments automatically, according to the Default Import Settings in the Configure DataCAD LT Settings dialog box. The interactive option is the default method and uses the DWG Import Entity Assignments dialog box. The DWG Import Entity Assignments dialog box appears during the import process only if the interactive option is checked.

There are several Default Import Settings you can change as well. Set the default font, line type, base unit, enlargement factor, and translator settings file to use during import. These defaults will be used as assignment suggestions if you opted for the interactive import method; however, with automatic translation, they will be used when DataCAD LT has no equivalent for an existing entity in the DWG or DXF file. To change any of these settings, click on the arrow to the right of the drop-down box and select another setting. You can also check the “Move drawing to origin” option to move drawing geometry to absolute 0 during import. This option is unchecked (off) by default.
During export, the line definitions and shape codes for DataCAD LT line types are stored in a .SHX file. If you export a DataCAD LT drawing named MYDRAWING.AEC, the translator will create two files: MYDRAWING.DWG and MYDRAWING.SHX. In order for the line types in the DWG file to display properly, the .SHX file must be placed in the \SUPPORT folder in the AutoCAD folder. The AutoCAD user may also place the .SHX file in the same folder as the .DWG file. A .SHX file is only created if line types other than Solid, Dashed, Dotted, or Dot-Dash are used.

If you’re not concerned with line types displaying exactly as you drew them, check the User-defined Line Type Export box in the Tools/Program Preferences Configure DataCAD LT Settings dialog box. This will convert all user-defined line types (any line type except Solid, Dotted, Dashed, and Dot-Dash) to Continuous when exporting a DataCAD LT drawing to a DWG or DXF file. In this case, a shape file will not be created because none is needed; instead, all user-defined line types in MYDRAWING.AEC will be permanently translated to the Continuous line type. The User-defined Line Type Export toggle in the Configure DataCAD LT Settings dialog box is off by default.

Both DataCAD LT and AutoCAD define colors in terms of their place in each program’s internal color list. For instance, in DataCAD LT’s code, Color 1 = White, Color 2 = Red, Color 3 = Green, etc. While we see white, red, and green colors on screen, DataCAD LT recognizes these only as Color 1, Color 2, and Color 3, respectively. AutoCAD works similarly, except AutoCAD displays Color 1, Color 2, and Color 3 as red, yellow, and green, respectively.

So if you don’t have the Import/Export Color Translation toggle checked when you export a DataCAD LT file, the resulting DWG/DXF file will only associate “Color 1,” “Color 2,” etc., with each entity. When the file appears in AutoCAD, the program recognizes “Color 1” and displays the entity as red, instead of white as it was drawn in DataCAD LT. With the Import/Export Color Translation toggle on, the table file corrects for this, so that white entities in DataCAD LT are displayed as white when exported to a DWG/DXF file and vice versa.

The Import/Export Color Translation toggle (which is on by default) tells DataCAD LT to use a table (.TBL) file so that colors translate properly when exported to or imported from a DWG/DXF file. An easy way to create a table file is to simply save DEFAULT.TBL under a new name that matches the custom RGB file. You can select DXF/DWG Color Map from the Tools pull-down menu to create a TBL file to match the currently selected RGB file. You must create this file for each custom RGB file. It should be given the same filename as the currently selected RGB file and saved in the DataCAD LT \Support Files folder.
Figure 2.34: The DXF/DWG Color Map File

The 3D Entity Export option, located near the bottom of the DXF/DWG tab, is unchecked (off) by default. Any 3D entities in a DataCAD LT (.AEC) file will be translated as a polyface mesh when exported to a DXF or DWG file; this polyface mesh is a single entity. However, by checking the “Decompose 3D entities as 3D faces” option, each facet of a 3D entity will be turned into an individual polyface; thus, a single sphere in DataCAD LT can be translated into many separate entities arranged in a sphere shape in a DWG or DXF file.

Checking the Decompose option can make translation faster and the translated entities will look the same after a shade or hidden line removal. However, editing may be more difficult since these translated 3D entities are made up of many smaller and separate entities.

Check the “Automatically export reference files” option in the Reference Files section of the DXF/DWG tab to export any XREFs you’ve used in your drawing at the same time you export the drawing itself. Each reference file is exported as a separate .DWG file. This option is checked by default; if you uncheck it, XREFs will not be exported along with your drawing. If you send your drawing to a co-worker or client, be sure to send all of the exported reference files as well so your drawing will be viewed as you intended.

You can toggle on “Expand exported stamps to values” in the final section of the DXF/DWG tab. When this box is unchecked, the stamp will export in its raw token format (i.e., @PLTTIME). When this box is checked, the stamp will export as it appears in DataCAD LT (i.e., 12:00 P.M.).
Customizing the Macros Menu

The Macros tab in the Configure DataCAD LT Settings dialog box (Tools pull-down menu) lets you choose which macros you want to be displayed in the Toolbox pull-down menu. To add macros to the menu, click on the macros in the Available Macros list box, then click on the Add button. To delete macros from the menu, click on the macros in the Macros in Menu list box and then click on the Remove button.

The Available Macros list box contains all macros that you have installed (normally found in the DataCAD LT\Macros folder). It is possible to add macros that are located in other folders: click on the file folder button above the Available Macros list box to browse different folders and select macros to add to the list.

You aren’t uninstalling macros when you remove them from the Toolbox pull-down menu. Macros removed from the Macros in Menu list simply won’t be displayed as options in the pull-down menu.

Figure 2.35: The Macros tab in the Configure DataCAD LT Settings dialog box
Customizing Miscellaneous Settings

The Misc tab on the Configure DataCAD LT Settings dialog box (select Program Preferences from the Tools pull-down menu) lets you customize DataCAD LT’s functionality.

**Figure 2.36:** The Misc tab in the Configure DataCAD LT Settings dialog box

**Default Character Set**

You can select a default font for text that you enter into your drawing. Simply click in the CHR drop-down box to choose a default DataCAD LT font. Also use the TrueType drop-down box to select the default Windows font.
Copy to Clipboard
The Copy to Clipboard section has three options, “Copy entity color,” “Copy entity line weight,” and “Expand exported stamps to values.” The first two options are both checked (on) by default. When you select a DataCAD LT entity to copy, these options cause the entity’s color and line weight to be copied as well. Then when the entity is pasted into another document, the entity displays as it did in the original drawing.

The “Expand exported stamps to values” option lets you determine the format of stamps when they are either copied to the clipboard or exported via DXF/DWG. When this box is unchecked, the stamp will export in its raw token format (i.e., @PLTTIME). When this box is checked, the stamp will export as it appears in DataCAD LT (i.e., 12:00 P.M.).

Previous View
DataCAD LT can remember up to 25 previous views (at set scales) of your drawing. If you’d like Free Zooms and pans and scrolls to be included in these previous views, check Remembers FreeZooms and Remembers Pans/Scrolls in the Previous View section of the Misc tab.

Shortcut: Press (P) to return to the previous view.

Auto-recover Save Interval
You can press the arrow buttons to increase or decrease the minutes between auto-recovery of your drawing file.

And Copy Toggles
The And Copy Toggles option determines whether the status of the And Copy toggles in such menus as Move, Rotate, Enlarge, and Mirror is remembered by DataCAD LT. By unchecking Remember On/Off Status, the And Copy option in the menus will always be toggled off when the menu is opened.

Clip Cube
There is also an option to display the boundary of a clip cube. Check Display On in the Clip Cube section of the Misc tab. See the “Viewing Your Model” chapter for more information on using clip cubes.

Scroll Wheel Zoom
The Scroll Wheel Zoom section of the Misc tab controls how you zoom in and out using your mouse wheel. As a default, “Requires Ctrl key” is checked. This means that you must press (Ctrl) while you move the mouse wheel to zoom in and out on your drawing. The zoom factor is +/- 25%.

Symbol Preview
DataCAD LT displays a preview of selected symbols when you insert symbols using the Insert pull-down menu. Using the Symbol Preview setting on the Misc tab, you can choose to display this preview in orthographic or isometric view. You can also change this setting on the Insert Symbol dialog box; check the Isometric View option below the preview window to display symbols in isometric view or uncheck it to display them in plan view. Symbol previews appear in orthographic view by default.
**Drawing Indicators**

There are three options you can activate in this section of the Misc tab. Click in the appropriate box to Show current reference point and to Show Object Snap point. You can also set the drawing origin indicator by checking Absolute Zero.

**Nested XREFs**

You can disable XREF nesting on a global basis. To do this, make sure there is no checkmark in the Allow Nesting box.

When “Inherit current highlight setting” is unchecked in the Nested XREF section, the nested XREFs will retain their highlight settings if you insert them in another drawing file. If the box is checked, the drawing file’s current settings will be used for XREF highlighting.

**Common Menus in DataCAD LT**

There are several types of menus that appear frequently as submenus throughout DataCAD LT, including selection, value, and color menus.

**Selection Menus**

Selection menus appear frequently in submenus throughout DataCAD LT. Selection refers to the way you mark drawing entities for editing purposes. There are three primary ways to select drawing entities: by Entity (one at a time), by Group (when multiple entities have been associated with one another), or by Area (an editing box stretched around entities).

![Selection Menus Example](image)

**Figure 2.37:** From left to right, examples of Entity, Group, and Area selection

Along with Entity, Group, and Area, selection menus include several other methods for selecting parts of the drawing to edit. All of the options are not available in every selection menu; selection menus are tailored for each editing option. Selection menu options can include:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Entity</td>
<td>Select drawing entities one at a time; this is the default selection method.</td>
</tr>
<tr>
<td>Group</td>
<td>Select entities that are associated as a group.</td>
</tr>
<tr>
<td>Point</td>
<td>Select entities by a single point; available only when using Stretch.</td>
</tr>
<tr>
<td>Area</td>
<td>Select geometry wholly contained within an area that you define with a rubber band box.</td>
</tr>
<tr>
<td>Fence</td>
<td>Select geometry wholly contained within a fence that you define with a temporary polygon boundary.</td>
</tr>
<tr>
<td>Crossing</td>
<td>Select any entity that crosses an area or fence boundary.</td>
</tr>
<tr>
<td>Layer Search</td>
<td>Selects any entity that crosses an area or fence boundary.</td>
</tr>
</tbody>
</table>

**More About Selection Menus**

An *entity* is a straight or curved geometric element defined by two end points. A line, a circle, an ellipse, and an arc are all entities. A B-spline or Bezier curve or a line of text is also an entity, as is a symbol, associative dimensions, and associative hatching. There are also 3D entities, such as slabs, spheres, and cylinders. Entities can be edited alone or as a group.
A group is a set of any number of entities, linked together logically but not necessarily graphically. Entities that do not touch may be part of the same group, and entities that are contiguous may be part of different groups.

Entities are linked as a group in a number of ways. A group of entities drawn in succession without disconnecting the cursor are linked as one group. Similarly, a series of lines of text entered at the same time are linked as one group. You can link entities or groups of entities using the Group option in the Edit menu. Entities are also grouped when they are created at the same time with the Copy option. If the And Copy option is toggled on when you use Move, then the copies will be a single group. When an existing entity is edited, with the Change or Move options for example, it retains the same group associations.

The grouping together of entities in DataCAD LT allows you to edit many related items without affecting other entities in the same portion of a drawing. Because groups are also easily redefined, the designer can organize a drawing as a series of elements composed of logically related pieces or entities.

You can also select entities by area or fence. Area selection uses a box, which is temporarily drawn around the entities you wish to select. All entities and groups enclosed completely within this area box are included in the area selection. Any entities and groups partially enclosed or not enclosed within the area box are not included in the area.

The orientation of the rubber band box for area selection matches the angle of the cursor or grid. When you choose Area from the selection menu for the operation you want to perform, the Rotate toggle appears. When you toggle Rotate on, you can align the rubber band box to the cursor or grid angle. If Rotate is on, DataCAD reverts to ortho boxes. If Rotate is off, the rubber band box aligns with the drawing window. For more information about grid angles, see “Setting the Grid Angle” in the “Before You Draw” chapter.

Similar to an area but allowing more flexibility, fence selection uses a polygon with up to 100 sides (previous versions were limited to 36 sides), which is temporarily drawn around the entities you wish to select. The fence polygon can be concave or convex and must be closed to complete the selection process.

Crossing is a toggle available during area and fence selection that you can enable after selecting the first point of the rubber band box. Using Crossing, you can select any entity that crosses the rubber band box, along with any entities fully within the box. Crossing works with all editing commands except Stretch.

Layer Search controls whether or not DataCAD LT scans all layers during selection operations. If you toggle Layer Search on, you can select entities on all layers that are on (being displayed). When the Layer Search toggle is off, you can select entities only on the active layer (the layer you’re currently working on). We’ll cover layers in more depth later in this chapter.

**Shortcut:** Press the apostrophe (’) - single quotation mark - to toggle layer search on or off.

In addition to the button in the Menu Window, a Layer Search Status Toggle is located in the Status Panel of the DataCAD LT window. If the Layer Search icon is depressed, layer search is on; if it’s raised, layer search is off. Click on the toggle button to turn Layer Search on or off with a single mouse click.

**More About 3D Selection Menus**

The 3D selection menu options are identical, with a few exceptions for Area and Fence. When using Area and Fence for 3D entities, most entities are selected when all the end points of each displayed line segment and all displayed markers (such as center points for cylinders) lie within area or fence boundaries.
When using 3D Fence selection, however, it’s possible to select some 3D entities by enclosing their end points but not enclosing other parts of these entities. If your fence polygon is concave, for instance, you could enclose the end points of a slab and still have the middle part of the slab lie outside the polygon. The entity is still considered in the fence if the end points lie within the fence. But if any end point of an entity lies outside the fence, the entity is considered outside the fence and is then not selected.

Selection by Area and Fence is independent of the current Z-base and Z-height settings. You can think of the region enclosed by the area or fence as going back into the screen infinitely. If you can see the region and it falls inside the boundary, the region is selected when you enclose it with an area or fence.

The following list includes the portions of an entity that must lie within the boundaries of the area or fence to be selected:

- **3D Lines** Entire line.
- **Polygons** End points of all displayed edges, including end points of void edges.
- **Blocks** End points of all edges which directly determine the shape of the block.
- **Slabs** End points of all displayed edges, including end points of void edges.
- **3D Arc** Entire arc.
- **Cylinder** Entire cylinder.
- **Symbol** The symbol reference point.
- **Cone** Entire cone.
- **Truncated Cone** Entire truncated cone.
- **Sphere** Entire sphere.
- **Torus** Entire torus.
- **Mesh Surface** Any control points; the surface and the control grid are ignored.
- **Surface of Rev.** Entire surface of revolution.

**Value Menus**

Some DataCAD LT functions require you to enter a numerical value. When you choose one of these functions from a menu, a list of values appears in the Menu Window, followed by these options:

- **Match** Matches an existing value, entity, or angle; click on Match, then click on the entity to match.
- **Add/Subtract** Adds or subtracts one or more values from a given value; click on the option and then the number to add or subtract.
- **Clear** Returns the given value to zero and starts again (Clear does not function like Undo); choosing Clear and then pressing (Enter) will accept a value of 0.
- **To Layer** Puts an entity on more than one layer or on a different layer than you are currently working on; available when you have more than one layer in the drawing.

You can select a value from the list, use the options on the previous page, or type any value and press (Enter). The total appears in the prompt line in the Message Area but is not entered until you press (Enter).

The decimal separator for all displayed dimensions and numbers is determined by the value of the Windows Decimal Separator. To set this value, click on Control Panel in the Start/Settings menu on your Windows desktop. Double-click on Regional Settings. On the Number tab, set the Decimal symbol value.

**DataCAD LT’s Online Calculator**

DataCAD LT’s online calculator is available anytime you need to enter a value, such as a distance or angle. Any time DataCAD LT prompts you to enter a value, you can simply type = and your equation; DataCAD LT will automatically calculate the value. The online calculator supports pi; you can type pi in any equation.
Distances must be entered in decimal units; however, the results will be displayed according to the Scale Type setting. For instance, the default setting, Architectural (Imperial) units, will display in feet/inches/fractions of inches. See “Setting Scale and Angle Types” in the “Before You Draw” chapter for more information on the Scale Type and Angle Type options.

The online calculator assumes angles are entered in radians, but you can enter an angle in degrees simply by typing d immediately after the value. Results for angle calculations will be displayed according to the Angle Type setting, with the default being Normal (in degrees/minutes/seconds).

The calculator can do the following kinds of operations:

<table>
<thead>
<tr>
<th>OPERATION</th>
<th>EXAMPLE</th>
<th>CALCULATED VALUE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Addition</td>
<td>=4.5+5</td>
<td>9.6 (9’-6&quot;)</td>
</tr>
<tr>
<td>Subtraction</td>
<td>=7-2.5</td>
<td>4.6 (4’-6&quot;)</td>
</tr>
<tr>
<td>Multiplication</td>
<td>=6*4.5</td>
<td>27.0 (27&quot;)</td>
</tr>
<tr>
<td>Division</td>
<td>=45/3</td>
<td>15.0 (15&quot;)</td>
</tr>
<tr>
<td>Parenthetical</td>
<td>=(4+3.5)*(8/2)</td>
<td>30.0 (30&quot;)</td>
</tr>
<tr>
<td>Square</td>
<td>=SQR(3)</td>
<td>9.0 (9&quot;)</td>
</tr>
<tr>
<td>Square Root</td>
<td>=SQRT(16)</td>
<td>4.0 (4&quot;)</td>
</tr>
<tr>
<td>Cosine</td>
<td>=COS(35d)</td>
<td>0.9.27/32 (9 27/32&quot;)</td>
</tr>
<tr>
<td>Sine</td>
<td>=SIN(35d)</td>
<td>0.6.7/8 (6 7/8&quot;)</td>
</tr>
<tr>
<td>Tangent</td>
<td>=TAN(35d)</td>
<td>0.8.13/32 (8 13/32&quot;)</td>
</tr>
<tr>
<td>Arc Tangent</td>
<td>=ATAN(12,16)</td>
<td>0.6435 radians (36.87&quot;)</td>
</tr>
<tr>
<td>Natural Logarithm</td>
<td>=LN(9.3)</td>
<td>2.23 (Base 2.71828)</td>
</tr>
<tr>
<td>Z-Base</td>
<td>=ZBASE+1</td>
<td>Current Z-Base + 1</td>
</tr>
<tr>
<td>Z-Height</td>
<td>=ZHITEx+1</td>
<td>Current Z-Height + 1</td>
</tr>
<tr>
<td>Last X</td>
<td>=LASTX+1</td>
<td>X, Y, or Z coordinate of last point</td>
</tr>
<tr>
<td>Last Y</td>
<td>=LASTY+1</td>
<td>selected relative to</td>
</tr>
<tr>
<td>Last Z</td>
<td>=LASTZ+1</td>
<td>absolute zero</td>
</tr>
<tr>
<td>Truncate</td>
<td>=TRUNCR(123.456)</td>
<td>123</td>
</tr>
<tr>
<td>Fraction</td>
<td>=FRACR(123.456)</td>
<td>0.456</td>
</tr>
<tr>
<td>Logarithm</td>
<td>=LOG(1000)</td>
<td>3 (Base 10)</td>
</tr>
<tr>
<td>Raised to the power of</td>
<td>=10^2</td>
<td>1000</td>
</tr>
<tr>
<td>Exponential</td>
<td>=EXP(1)</td>
<td>2.718281828</td>
</tr>
<tr>
<td>Absolute Value</td>
<td>=ABS(-123.456)</td>
<td>123.456</td>
</tr>
<tr>
<td>PI</td>
<td>=PI</td>
<td>3.14159265359</td>
</tr>
</tbody>
</table>

Following are two examples to illustrate how to use the online calculator to quickly figure scales and angles.

» To define a new plotting scale:

1. Click on Edit Defs. in the Settings menu.
2. Click on Scales in the Edit Defs. menu.
3. Click on Change to modify an existing scale.
4. Select the scale to change from the menu.
5. Look at the prompt to Enter new string for this scale. Enter 1/32 for the menu button name.
6. Respond to the prompt to Enter new scaling value for this scale by typing =(1/32)/12 and pressing (Enter) to get the result 0.002604167.
7. Press (Enter) to accept this value as a new scale factor.
To calculate an angle:

1. Respond to the prompt to enter an angle by typing \texttt{ATAN(6,12)}, where 6 is the rise and 12 is the run.

2. Press (Enter) to calculate an angle of 26.33.54, or 26° 33' 54".

**Color Menus**

When an option requires you to assign a color, a list of colors appears in the Menu Window along with the options Color Number, Custom, Match, and No Change.

![A sample color menu](image)

**Figure 2.38:** A sample color menu

Custom opens the Color Palette dialog box so you can change a color by adjusting its red, green, and blue (RGB) and hue, saturation, and brightness (HSB) values. To work properly, it requires a 256-color driver.

**Warning:** When you make a change to a color menu, you must save this new color palette or the colors will revert back to their original RGB values when you close DataCAD, even if you save the drawing. See “Customizing Colors” in the “Before You Draw” chapter for more information on how to save palettes.

To change the color of one or more entities in your drawing:

1. Click on Custom in any color menu. The Color Palette dialog box appears.
2. Choose a color swatch, excluding the ones in the top row. (The top row contains the 15 standard colors DataCAD LT uses.) If you are satisfied with one of the colors in the dialog box, double-click on the swatch to activate that color and dismiss the Color Palette. You return to the drawing where you are prompted to Select entity to <CHANGE>.

3. Click on the entity whose color you want to change. DataCAD LT substitutes the new color for the old one.

To change the color of one entity to match that of another entity:

1. Click on Match in the color menu.
2. Select the entity whose color you would like to match.
3. Select the entity whose color you would like to change. You can select multiple entities or groups without repeating steps 1 and 2. Click on No Change to exit the color menu without making a change.

**Working with Dual Monitors**

Many people find it easier to work with two monitors. In effect, this just expands your desktop. To increase the size of your DataCAD LT drawing area, you could move many of your toolbars (such as the menu, navigation pad, projection pad, symbol browser, etc.) to the second monitor. You can even expand your DataCAD LT drawing area across the two monitors. DataCAD LT will remember your last setup on this expanded desktop (across the two monitors) so that you won't have to make a lot of changes the next time you open the program.
Working with dual monitors is easy once you have your hardware (the two monitors) and software (usually accessed through the Windows Control Panel, Display Properties, Settings tab) set up properly. This may require you to upgrade your hardware and/or software.

For expert advice on setting up dual monitors, consult your system administrator or a local computer guru. Once the dual monitors are set up and working properly, you’ll discover all sorts of ways to change how DataCAD LT appears on your equipment and to increase your productivity.

**Planning Your Project**

Much of your work will be editing drawings under design development. DataCAD LT is a flexible program in terms of allowing you to change what you have drawn. Nevertheless, the more information you have when you first draw something, the less time you’ll spend making revisions.

With traditional manual design development, you first do a rough sketch of the project and then gradually refine this idea into a drawing that is dimensionally and materially specific. Computer-aided design (CAD), however, produces a drawing with precise dimensions the first time it is drawn.

This suggests that the ideal process of CAD development might be the opposite of manual design development. With CAD, it’s important to know such things as the exterior wall construction before you start to draw, so your drawing will be accurate from the beginning. If you finalize your floor plan before you decide on exterior wall construction materials, you’ll have to go back and change the thickness of all exterior walls to do automatic dimensioning or wall sections and details. In turn, this wall thickness change would impact the interior dimensions of rooms and may affect the modular grids of ceiling and floor tile, lighting, etc. Some well-thought out planning before you start to draw can save you valuable time.

**Gathering Project Information**

Practically speaking, it’s impossible to predict the exact dimensions and materials of everything in the building before you finalize the design. But a realizable goal is to gather as much information as possible about the construction of the building before you begin the design development or construction documents phases of the project. This keeps time-consuming changes to a minimum and allows the building to be drawn and dimensioned accurately.

You need to have as much information as possible on the following:

| Scope of Work | How much do you need to draw? In what detail? What information can be reused for several drawings? |
| Dimensions    | What are the basic dimensions of the structural grid, columns, and load-bearing partitions? What size are the interior partitions? Doors and windows? Sill and jamb conditions? Floor and ceiling heights? Joist sizes? |
| Materials     | What are the walls and foundation made of? What floor and roof systems are you using? |
| Existing Elements | Which parts of the drawing can be used to create other drawings for this project? Which typical details can be used for this project? Which drawings from the schematic design phase can be reused? |

**Planning Layers**

The concept of layering drawings has been used in designing, drawing, and drafting long before computers. In the past, it was referred to as overlay (or pin register) drafting.
With overlay drafting, drawings were developed in layers on trace paper, each aligned with the others. Each sheet contained related information that you could separate and reproduce individually or in any combination. You could also use this layering of drawings during the design process to overlay and quickly trace, change, and rework drawings. This same procedure is easily accomplished using DataCAD LT to form a highly productive drawing process.

The key to efficient CAD is the well-planned use of the almost unlimited number of layers available in each drawing file to isolate related entities, details, and text. By organizing the information displayed on each layer according to type or content, you can perform editing functions on one building component without affecting components on other layers.

There are many layering methods; however, it is important to devise a well thought out strategy based on office standards for the type of work you do. A drawing file with a good layer structure could (and probably should) contain all the drawings for a single project.

Just as your drawing can contribute to the drawings of others, what others in your office have already drawn can help you. As you plan your drawing layers, make a note of where you can get some of the basic information needed for your particular task. There’s no need to redraw all those toilets for the third floor if they’ve already been drawn for the first floor or if you already have an appropriate toilet symbol in a plumbing symbol folder.

Before you begin drawing, it is a good idea to sit down and make a list of all the layers you intend to create, noting what you expect each layer will contain. Although creating layers is easy with DataCAD LT, you will find it helpful to have a reference list as you draw to help you prioritize and chart your drawing process. See “Working with Layers” in the “Before You Draw” chapter for more information on how to set up layers in DataCAD LT.

In DataCAD LT, you can toggle each layer you create on or off at any time; only layers toggled on will be displayed and only one of these layers is active. To continue our parallel with overlay drafting, the active layer can be thought of as the top piece of trace paper; it is the layer you’re currently drawing on. The remaining layers of trace paper in the overlay stack are all the layers toggled on. Existing layers not currently in the stack are all the layers toggled off (not displayed).

The process of drawing from the most general to the most specific is opposite the process of gathering information to prepare for drawing. You want to understand the building in the greatest detail possible before you draw it. But once you start drawing, you want to document all that information gradually, arriving at the most specific drawing (the detail) only after you have graphically described all the general conditions.

![Figure 2.40: The image on the left is how your drawing is organized using layers. On the right is how you see your drawing in DataCAD LT.](image)
Prioritizing Drawing Tasks
In addition to making a list of all your layers, make a flow chart of your drawing process: what you will draw first, second, third, etc. To keep drawing redundancy to a minimum, you will want to draw those parts of your drawing which are the most general first, then proceed to detail your drawing, gradually making it more specific. Along the way, make copies of those parts of your drawing that can be used for other drawings.

Drawing Efficiently
A drawing will, of necessity, contain many entities. The idea behind CAD is to have the computer automatically draw as many of those entities as possible. DataCAD LT incorporates several functions that make this automation possible; entities may be copied or mirrored; symbols and line types may be added as well.

Any entity, group, or area in your drawing can be copied one or several times automatically or flipped and copied at once to produce a mirror image next to the original image. For example, you only need to draw one side of a corridor of rooms if you use Mirror to create the opposite side. For more information on using Mirror, see “Mirroring Entities” in the “Other Ways to Draw” chapter.

Any entity, group, or area in your drawing can be stored as a symbol. You can draw a tree once, save it as a symbol, then place trees all over your site plan just by selecting with the mouse all the places in your drawing where you want the trees to appear.

Many material symbols shown in sections and details can be drawn automatically by selecting the proper line type or by creating one of your own. DataCAD LT has line types for materials like insulation, brick, plywood, and roof shingles. For example, you could produce a line of insulation running up a wall just by choosing the Insull line type and entering the two end points of the line.

DataCAD LT’s Edit menu provides you with many ways to modify anything you draw without redrawing it, including moving or stretching entities or changing their attributes.

Use Stretch to select an area or point and move it to a new location, automatically stretching or shrinking everything attached to what you are moving. For example, you can move a window to a new place in the wall; the wall will be stretched to match the new position of the window. For more information on using Stretch, see “Stretching Entities” in the “Editing Drawings” chapter.

Move is different from Stretch since only the entity, group, selection set, or area you select is moved to a new location in the drawing; everything connected to those items stays where it is. So if you have two cased openings, one of which contains a door, you can move the door to the other cased opening without moving all the wall and jamb lines attached to the door. For more information on using Move, see “Moving Entities” in the “Editing Drawings” chapter.

Use Change to alter the characteristics or attributes of any entity, group, area, or selection set you’ve created. For example, you can change a wall from double-weight solid lines to single-weight dashed lines, alter its height from 8 to 10 feet, change its color from green to blue, etc. For more information on using Change, see “Changing Entities” in the “Editing Drawings” chapter.

Sample Project
This is an example of how to use DataCAD LT by outlining a detailed strategy for completing a project; it is not intended to be a tutorial or replace DataCAD LT training.
Scope of Work

Following is a summary of what is known about the building for which you will produce working drawings:

Description: A 12,300 s.f. YMCA facilities building, two stories, flat roof, sloping site, with parking for 34 cars.

Materials:
- Structure: Clear-span metal frame with steel column grid, 25’ x 20’, lightweight steel floor and bar joists @ 2’-0” O.C.
- Exterior Walls: Metal panel over metal framing with batt insulation, CMU block veneer wall with metal framing, batt insulation and GWB interior.
- Interior Walls: Metal studs with fire-rated GWB.

Dimensions:
- Plan: 100’ x 68’-8” exterior limits of building.
- Elevation Hghts:
  - Lower Level Floor @ 83.00’
  - Lower Level Ceiling @ 91.00’
  - Upper Level Floor @ 95.00’
  - Upper Level Ceiling @ 106.75’
  - Top of Roof @ 107.00’
  - Top of Parapet @ 108.75’

Summary of Available Personnel and Drawings Needed

<table>
<thead>
<tr>
<th>PERSONNEL</th>
<th>DRAWINGS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job Captain</td>
<td>Site Plan</td>
</tr>
<tr>
<td>Draftsman 1</td>
<td>Foundation Plan</td>
</tr>
<tr>
<td>Draftsman 2</td>
<td>Lower Level Plan</td>
</tr>
<tr>
<td></td>
<td>Upper Level Plan</td>
</tr>
<tr>
<td></td>
<td>Four Exterior Elevations</td>
</tr>
<tr>
<td></td>
<td>North/South Building Section</td>
</tr>
<tr>
<td></td>
<td>Lower Level Electrical Plan</td>
</tr>
<tr>
<td></td>
<td>Upper Level Electrical Plan</td>
</tr>
<tr>
<td></td>
<td>Lower Level Plumbing Plan</td>
</tr>
<tr>
<td></td>
<td>Upper Level Plumbing Plan</td>
</tr>
<tr>
<td></td>
<td>Door, Window, and Finish Schedules</td>
</tr>
<tr>
<td></td>
<td>Door and Window Types</td>
</tr>
</tbody>
</table>

Planning the Drawing Time

1. Summarize drawings needed; plan final sheet layout.
2. Draftsman 1 develops base plans while Draftsman 2 begins work on typical details.
3. Draftsman 1 gives Draftsman 2 the plan information. Draftsman 2 begins developing elevations and sections.
4. When plans, elevations, and sections have been developed, develop schedules and details on both workstations using completed drawings as a base for detail drawings.
5. When all drawings have been completed, assemble individual drawings into “sheets” for plotting.

How Draftsman 1 Drew the First Floor Plan

Draftsman 1 first spent some time with the Job Captain, learning what the project involved and the assigned tasks. Then Draftsman 1 sat down and prepared two outlines:

- an outline of the layers required and their names
- a strategy of what to draw first, second, third, etc.

<table>
<thead>
<tr>
<th>LAYER NAME</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>A2-BLK</td>
<td>Lower Level Conc. Block</td>
</tr>
</tbody>
</table>
Draftsman 1’s drawing process outline is as follows:

1. Create drawing file YMC-MSR1.AEC.
2. Create and name drawing layers listed above.
3. Load sheet border from symbol file.
4. Input all existing site information.
5. Draw Columns, Column Grid, Perimeter, and building elements on appropriate layers.
6. Separate drawing layers needed for first floor by saving them out to the hard disk on separate layer files.
7. Create a detailed elevation drawing called YMC-ELV1.AEC.
8. Create and name the required drawing layers.
9. Load basic first floor plan drawing layers from layer files.
10. Draw interior partitions.
11. Place windows in perimeter wall.
12. Save modified plan layers to a layer file called YMC-PLN1.DLF. This layer will become the exterior wall for the second and third floors, which have identical windows to the first floor.
13. Place doors and windows in perimeter wall and in interior partition walls.
14. Zoom in on lobby area and draw lobby details.
15. Zoom in on restroom area and draw fixture layout and details.
17. Add dimensions, labels, and notes to drawing.
18. Create a new detail elevation file for the Second Floor Plan called YMC-ELV2.AEC.

Notice that Draftsman 1’s outlines do not detail how to best draw each part of the drawing. This strategy simply gives an outline of what to do next while leaving Draftsman 1 free to choose the best drawing method for each part of the drawing. Copy, Mirror, and Stretch will be used to produce, respectively, the column grid, two halves of a symmetrical parking layout, and two handicapped parking spaces that are larger than the other parking spaces.
Basic Drawing and Editing

DataCAD LT is ready to draw lines immediately upon opening a drawing; notice that in the Create pull-down menu, Line is checked by default. You can even draw with custom line types to represent such things as insulation, telephone and electrical lines, and siding. Editing lines or anything else you draw is easy with DataCAD LT’s many editing features.

Drawing Using the Mouse

To draw a line by selecting two points:

1. Move the cursor anywhere in the Drawing Area and click. You’ve just selected the first end point of your first line. In addition to simply clicking to select a point and begin drawing, you can snap to a point on another entity and begin drawing from there. See “Object Snapping” in the “Drawing Tools” chapter for more information.

2. Move the cursor to the point where you want the line to end and click. The line is drawn. Notice, however, that if you move your cursor, it is still connected to the end of the line. This allows you to continue drawing lines, using the end of the previous line as the beginning of the next one.

3. Repeat step 2 to continue drawing lines until your last end point meets the first end point you selected in step 1.

4. Right-click to disconnect the cursor from the last line.

Drawing Using Coordinate Entry

Coordinate entry lets you draw lines more precisely by entering the exact coordinates of each end point of a line. In DataCAD LT, you have a choice of five coordinate entry methods or input modes:

- **Relative polar** requires that you enter a distance and an angle relative to the last point entered.
- **Absolute polar** requires that you enter a distance and an angle from absolute 0.
- **Relative Cartesian** requires that you enter an X and Y distance relative to the last point entered.
- **Absolute Cartesian** requires that you enter an X and Y distance from absolute 0.
- **Distance-Direction** requires that you indicate the direction with the mouse and then enter a distance relative to the last point entered.

![Figure 2.41: Polar and Cartesian coordinate entry methods](image)

Once you select a coordinate entry method, it remains active until you choose a different one. The coordinate entry method you’re using is always checked in the Tools pull-down menu’s Input Mode. (Coordinates are only displayed when your cursor is in the Drawing Area.)
Four additional coordinate entry methods are available only while in the 3D Views/Controls menu:
relative and absolute cylindrical (enter distance, angle, and Z coordinate) and relative and absolute
spherical (enter distance, plan angle, and rise angle). These methods provide additional variables to the Z
component of coordinate entry, which may be helpful in specialized modeling applications like entering a
3D line that represents a solar angle.

To choose a coordinate entry method, either:
- press (Insert) until the name of the method you want appears in the Attention toolbar or
- click on Input Mode in the Tools pull-down menu and select a coordinate entry method from the
list.

To draw a line using relative or absolute polar coordinate entry:
1. Click in the Drawing Area to select the line’s first end point.
2. Press (Spacebar).
3. Type the length of the line (the distance from the end point you entered in step 1 to the next end
point) and press (Enter).
4. Type the angle of the line from the X axis and press (Enter). The line is drawn, with your cursor
still attached to the end point of the line.
5. Continue drawing lines by repeating steps 2-4. Right-click to disconnect the cursor from the line.

To draw a line using relative or absolute Cartesian coordinate entry:
1. Click in the Drawing Area to select the line’s first end point.
2. Press (Spacebar).
3. Type the relative or absolute X distance from the first end point and press (Enter).
4. Type the relative or absolute Y distance from the first end point and press (Enter). The line is
drawn, with your cursor still attached to the end point of the line.
5. Continue drawing lines by repeating steps 2-4. Right-click to disconnect the cursor from the line.

To draw a line using direction-distance coordinate entry:
1. Click in the Drawing Area to select the line’s first end point.
2. Drag the cursor in the direction you want to draw the line.
3. Press (Spacebar).
4. Type the length you want the line to be, and press (Enter). The line is drawn, with your cursor
still attached to the end point of the line.
5. Continue drawing lines by repeating steps 2-4. Right-click to disconnect the cursor from the line.

More About Coordinate Entry
You can enter distances and angles either by typing a value or by using a value menu. See “Value Menus”
earlier in this chapter for more information on how to use them. Depending on the scale type you are
using, there may be several different methods you can use to enter coordinates. See “Setting Scale and
Angle Types” in the “Before You Draw” chapter for more information. For instance, in the architectural
scale type, which is DataCAD LT’s default, you must enter distances as feet.inches.fractions of inches.
**TO ENTER: TYPE:**

<table>
<thead>
<tr>
<th>Measurement</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>4’</td>
<td>4</td>
</tr>
<tr>
<td>6”</td>
<td>0.6 or .6 or (Spacebar)6</td>
</tr>
<tr>
<td>3/16”</td>
<td>0.0.3/16 or ..3/16 or ..3.16 or (Spacebar)(Spacebar)3(Spacebar)16</td>
</tr>
<tr>
<td>4’-6”</td>
<td>4.6 or 4(Spacebar)6</td>
</tr>
<tr>
<td>4’-6 3/16”</td>
<td>4.6.3/16 or 4.6.3.16 or 4(Spacebar)6(Spacebar)3(Spacebar)16</td>
</tr>
</tbody>
</table>

Notice in this example that 3/16” is entered as **0.0.3/16**, indicating 0 feet, 0 inches, and 3/16 of an inch. Notice also that you can leave out the zeros when you enter distances, as long as the decimal points remain as placeholders; so you could type ..3/16. Further, slashes, decimal points, and spaces are interchangeable, so you could replace the slash with another decimal point and type ..3.16.

Angles are entered in a similar fashion, except the (Spacebar) method can’t be used. For instance, using relative polar coordinate entry, angles are entered as: degrees.minutes.seconds

**TO ENTER: TYPE:**

<table>
<thead>
<tr>
<th>Angle</th>
<th>Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>38°</td>
<td>38</td>
</tr>
<tr>
<td>12’</td>
<td>0.12 or .12</td>
</tr>
<tr>
<td>30”</td>
<td>0.0.30 or ..30</td>
</tr>
<tr>
<td>38°-12’-30”</td>
<td>38.12.30</td>
</tr>
</tbody>
</table>

**Drawing with Line Types**

DataCAD LT has four standard line types (solid, dotted, dashed, and dot-dash) along with many more custom line types that you can use in your current drawing file.

➤ To draw a line using a line type:

1. Go to the Edit menu in the Menu Window; click on Line Type. A list of the four most common line types (solid, dotted, dashed, and dot-dash) plus other optional lines appears in the Menu Window, along with options to modify a chosen line type’s weight, color, spacing, or overshoot.

   **Shortcut:** Press (Alt) + (L) to access the Line Type menu.

2. Look at a preview of a line type before you use it by moving the mouse cursor over the line type option in the Menu Window. If the line type you need is not included in the list, you can click on Scroll Fwrd or Scroll Back to see more options.

3. Click on a line type in the Menu Window to use that line type.

4. Click on the Spacing, Line Weight, Color, or Overshoots options to change the settings for the line type you chose. See “**Line Type Settings**” in this chapter for details on changing line type settings.

5. Begin drawing lines as described in “**Drawing Using the Mouse**” or “**Drawing Using Coordinate Entry**” earlier in this section.

**Using the Line Type Manager**

The Line Type Manager lets you load or reload external line type definitions into your drawing. In versions prior to DataCAD 12, all line types were listed and you would have to scroll through many options before finding the two or three you use most frequently. Using the Line Type Manager lets you embed only those line types you actually need in the current drawing file, streamlining the line selection process. If you later need additional line types, you can return to the Line Type Manager and add them to the Embedded Lines list.
The upper section of the Line Type Manager displays the definitions that are currently (or will be) loaded into the active drawing. This section is used to modify parameters. Clicking OK or Apply will load newly selected definitions and/or apply changes you’ve made. Once your changes have been applied, you can use the Save or Save As options to save your internal definitions to the hard drive. You can use Reload to overwrite an internal definition with an external one.

The lower section of the Line Type Manager displays external definitions that you may load into the active drawing. You cannot make changes to external definitions in this section. First, you must apply changes to internal definitions, the use the Save or Save As options to externalize your new settings.

You can manually convert DataCAD line types (.LIN) to the new (.DLT) format. To do this, use the Convert option in the Line Type Manager dialog box.

Up to 255 line types are available in DataCAD. You can create your own custom line type definitions, too. When you give colleagues copies of your drawings that contain custom line types, you needn’t worry about supplying them with the new definitions because DataCAD automatically converts them from DCADWIN.LIN to individual .DLT files stored in \DataCAD\Support Files\Line Types.

You can also use the Line Type Manager to set the End Correction and default Factor for embedded or external line type definitions. This means that you can customize the embedded lines.

To use the Line Type Manager:

1. Go to the Edit menu in the Menu Window and click on Line Type. The Line Type menu appears.
2. Click on Line Type Manager. The Line Type Manager dialog box appears. In the lower portion, the External Lines window contains a list of all the other line types you may want to use in this particular drawing file. Each portion of the Line Type Manager contains a preview window so that you can see what the highlighted line will look like.
3. Add one of the external lines to your current drawing file by highlighting the line you want in the lower portion of the Line Type Manager and clicking on the Load button. This loads the line you selected from the External Lines list into the Embedded Lines list.
4. Customize the lines in the Embedded Lines portion if necessary.
   - End Correction – check (enable) or uncheck (disable) the End Correction box in the Embedded Lines portion of the Line Type Manager.
   - Line Spacing – change the default factor by supplying a different value in the Factor input box in the Embedded Lines portion of the Line Type Manager.
5. Click Ok when you are satisfied with the choices you made in the Line Type Manager. The lines you added to the Embedded Lines portion of the Line Type Manager appear in the Line Type menu. These line types are now part of this particular drawing file.

**Line Type Settings**

All custom line types enter building materials at actual size and they appear at the display scale you specify. You can use the following options to customize a line type:

- **Spacing** Changes the size of the line type pattern. Keep in mind that DataCAD defines units in absolute world coordinates. For example, to set dashed lines to repeat every 1” on a 1/4”=1'-0” scale drawing, set the spacing to 4'-0". To set line spacing, click on a value in the value menu or type a spacing value, and press (Enter).

- **Line Weight** Sets the thickness of a line type. The most common line thickness is 1. To set the line weight, click on a line weight in the value menu or type a line weight value, and press (Enter). For line weights to display, Show Weight must be toggled on in the Display menu.

- **Color** Changes the color of a line type. Any new lines that you enter into the drawing appear in the new color.

- **Overshoot** Displays extensions (or punch) at line intersections, giving drawings an architectural look. DataCAD always dimensions to the actual length of a line, ignoring any displayed overshoot.
You must set the overshoot before you draw a line; previously drawn lines are not affected.

By default, DataCAD lets you apply line overshoot selectively to individual entities in your drawing. However, you can change this and globally apply line overshoot to all lines in your drawing. Of course, you must toggle Overshoot on in the Display menu to view and/or plot the overshoots either globally or selectively.

➔ To set the overshoot:
   1. Go to the Edit menu in the Menu Window and click on Line Type. The Line Type menu appears.
   2. Click on Overshoot in the Line Type menu. The Overshoot menu appears.
   3. Decide whether you want to apply line overshoot to entities selectively or to all lines throughout your drawing. These two options are mutually exclusive:
      • By Entity – by default, this is toggled on so that you apply line overshoot selectively to particular entities in your drawing.
      • Globally – by default, this is toggled off. If you want all lines throughout your drawing to overshoot, toggle this option on. This affects all future lines you draw in this file; it does not affect lines you drew prior to toggling this option on. The global line overshoot is scale-independent; it is defined as a real-world, plotted distance.
   4. Choose or type an overshoot length by clicking on New Distance, selecting a value, and pressing (Enter).

➔ To display line overshoot in your current drawing on your monitor and on your plots:
   1. Go to the Utility menu and click on Display. The Display menu appears.
   2. Toggle Overshoot on.

You can add line overshoot to an existing line in your drawing by using the Change menu. Depending on the option you choose in the selection portion of the menu, you can change one line at a time (Entity) or several at once (Group, Area, Fence, or Mask).

➔ To display overshoot for existing lines in your drawing:
   1. Go to the Edit menu in the Menu Window and click on Change. The Change menu appears.
   2. Toggle on Overshoot, select a value for the length of the overshoot, and press (Enter). You are prompted to Select entity to <CHANGE>.
   3. Click on the line you want to overshoot in your drawing. If you want to overshoot more lines, simply continue clicking on them. When you are finished using the overshoot, right-click to exit the Change menu.

**Basic Editing Tools**

DataCAD LT’s Edit pull-down menu provides easy access to most editing functions, including primary editing menus such as Move, Copy, Rotate, Mirror, Stretch, Enlarge, Erase, Change, Partial Erase, Line Cleanup, and Wall Cleanup. Choose any of these editing options to display that menu in the Menu Window. See the “Editing Drawings” chapter for details on these options.
The Edit pull-down menu also includes unlimited, global undo/redo options and cut, copy, and paste. The Undo option reverses the last action, including any drawing or editing, changes made using macros, or the deletion of layers. The Redo option restores the last action. To undo an action, click on Undo in the Edit pull-down menu or press (Ctrl) + (Z); to redo an action, click on Redo in the Edit pull-down menu or press (Ctrl) + (Y). You can also use the Undo/Redo icons in the Standard Toolbar.

Cut, Copy, Paste, and Paste Special are four more Edit pull-down menu options you can use to edit drawings or share parts of drawings between documents. Cut removes entities from the drawing to the clipboard, Copy copies entities in the drawing to the clipboard, Paste adds entities previously cut or copied to the active drawing, and Paste Special lets you choose the format (metafile, text, etc.) for entities previously cut or copied and then adds them to the active drawing. To cut or copy DataCAD LT entities, you must first use the Clipboard Select option in the Edit pull-down menu to select the entities to be cut or copied. You can choose whether to copy just the entity or the entity with its current color and line weight. Check the Copy to Clipboard options on the Misc tab of the Configure DataCAD LT Settings dialog box as appropriate.

To move or copy entities from one drawing to another:

1. Click on Clipboard Select in the Edit pull-down menu. A selection menu appears. See “Selection Menus” in this chapter for more information.

**Shortcut:** Press (Ctrl) + (E) to access the Clipboard Select selection menu.

2. Toggle Ins. Point on to enter an insertion point for the entities. This point can then be used to paste the entities into another drawing. Toggle Ins. Point off to enter entities relative to absolute zero.

3. Choose a selection method by clicking on one of the selection menu options.

4. Select the entities to be moved or copied.

1. Click on Cut in the Edit pull-down menu to remove the entities from the drawing or click on Copy to simply copy them. If Ins. Point was toggled on in step 2, you are prompted to Enter the insertion point. If Ins. Point was toggled off, skip to step 7.

**Shortcut:** Press (Ctrl) + (X) to cut entities or press (Ctrl) + (C) to copy entities.

2. Click in the Drawing Area to select a reference point. Your cursor will be attached to this reference point when you paste the entities into another drawing.

**Shortcut:** Press (Ctrl) + (V) to paste entities.

7. Paste them into another DataCAD LT drawing or into a document in another application:
   - Open the drawing you’d like to add the entities to and click on Paste in the Edit pull-down menu. Toggle By Center on to paste the entities by the center of their extents; toggle it off to paste the entities by their insertion point (if Ins. Point was toggled on) or at absolute zero.
   - Open the drawing you’d like to add the entities to, click on Paste Special in the Edit pull-down menu, and select a format for the entities.
   - Open the Windows application document that you’d like to add entities to and use that application’s paste function.
You can preserve the exact position of an entity (as measured from absolute zero) when copying it from one drawing to another. For example, if a marker was placed at \(x=16', y=16'\) (as measured from absolute zero) in the original file, then pasting it into a new file using Abs. Zero will place the marker at \(x=16', y=16'\) from absolute zero in the new file.

**Referencing Drawings**

You cannot reference (or link) drawings to your current drawing in DataCAD LT. However, you may open drawings that were originally created using the full version of DataCAD that contain XREFs.

**Resolving Orphaned Reference Files**

Reference files can be orphaned if you move the file to another folder on your computer or if you delete the referenced file. You can resolve the broken link between your current drawing and the referenced file by either deleting the link or by redefining the path to where you moved the reference file. Clicking on the Redefine button allows you to redefine XREF files that became orphaned when they were renamed. Redefined XREFs retain the previous XREF’s position, scale, and rotation.

The path between the current drawing and the reference file is limited to 160 characters. This allows you to use the full pathname that includes Drive + Path + Filename.

When you open a file that contains orphaned reference files, you will see a Warning dialog box. Click on Ok and then deal with the orphan.

![Warning](image)

**Figure 2.42:** Orphaned XREFs appear in a drawing

1. To resolve orphaned reference files:
   1. Click on the XREFs tab in the Orphaned Reference Files dialog box to list all the orphaned reference files in your current drawing.
   2. Click on a reference file in the list to select it.
CHAPTER 2: THE DRAWING BOARD

3. Resolve the orphaned file in one of these two ways:
   - Click on Delete to delete the reference file from your current drawing.
   - Click on Redefine or on Redefine Path to reestablish the link between your current drawing and the reference file. A dialog box appears, allowing you to browse for the file; find the referenced file and click on OK.

4. Click on Yes in the Confirm dialog box.

5. Click on Done to close the Orphaned Reference Files dialog box.

Inserting Images Directly into Drawings

You can insert a variety of images into your DataCAD LT drawings. The images you can insert include .BMP, .JPG, .GIF, .TIF, .TGA, .PNG, .PCX, and .PCD files. Also, you can insert SketchUp (.SKP), and Text (.TXT) files directly into DataCAD LT.

To insert an image directly into your drawing:

1. Click on Insert in the pull-down menu bar.

2. Select the type of file you want to insert into your drawing.
Text File  Opens the enter the name of the text file to import dialog box, giving you access to .TXT files.
Bitmap  Opens the Select Image dialog box, giving you access to file formats that include .BMP, .JPG, .GIF, .TIF, .TGA, .PNG, .PCX, and .PCD.

Figure 2.45: The Select Image dialog box

3. Highlight the file you want to insert into your drawing. The highlighted image appears in the Preview Window of the dialog box and the file's name appears in the Filename input field.
4. Click Open or press (Enter). DataCAD LT closes the dialog box and inserts the file you selected into your drawing.

Much like XREFs, bitmaps can become orphans. If your drawing contains one or more orphaned bitmaps, you will see this Warning dialog box. Click on OK and then use the Bitmap Orphans Manager to solve the problem.

Figure 2.46: Files can contain orphaned bitmaps

➤ To resolve orphaned bitmap files:
1. Click on Ok in the Warning dialog box. The Orphaned Reference Files dialog box appears.
2. Click on the Bitmaps tab. The orphaned bitmaps contained in that file appear.
3. Highlight an orphaned bitmap file. Then redefine the path or the file or delete the orphan entirely by clicking on the appropriate button.

- **Redefine Path**: A Browse box appears, allowing you to select a new path for the orphaned bitmap file. After selecting the path, click on OK to close the box.
- **Delete**: Select this option if you want to eliminate the bitmap entirely.
- **Redefine**: The Select Image dialog box appears, allowing you to replace the orphaned bitmap with another file. After selecting the appropriate bitmap file, click on Open. The file you selected appears in the Orphaned Bitmap box on your screen.

4. Click Done to close the Orphaned Reference Files dialog box.

**Viewing Drawings**

Viewing is simply the way you look at your drawing when you work on it. Compare viewing a drawing on the computer with looking at a drawing on your drafting board. As you draft on the board, your eyes are always moving and refocusing, allowing you to concentrate on small details or view the entire drawing sheet quickly and easily. At the computer, you need to consciously decide what you want to focus on and to what degree. To say this in CAD terms, you will zoom in on an area of your drawing when you have to focus on a detail; and when you want to see the entire drawing, you will zoom out to the *extents* or outermost edges of the drawing.

Go-to-views, hyperview linking, and multi-view windows are three additional viewing features that allow you to jump quickly to preset views of your drawing. See the “**Viewing Your Model**” chapter for more information.

**Zooming In and Out**

The Zoom menu in DataCAD LT lets you zoom in on an area by displaying the drawing in a larger scale. When you zoom out, you are actually looking at your drawing in a smaller scale, which allows you to see more of your drawing. The scales that the Zoom menu uses are predefined in the Utility/ Settings/Edit Defs./Scales menu.

- To zoom in on your drawing:
  1. Click on Zoom in the Utility menu.
2. Click above and to the left of the area you want to scale.

3. Move the mouse downward and to the right to stretch the box around the area you want to zoom in on.

4. Click to complete the box. The drawing rescales automatically.

**Shortcuts:** Press (/) to display the Zoom menu in the Menu Window.

To return to the previous view (essentially undoing the zoom), press (P). DataCAD LT remembers up to 25 previous views.

Press (PgUp) and (PgDn) to quickly zoom in and out on your drawing. To use PgUp and PgDn on your numeric keypad, first make sure NumLock is off.

To zoom to your drawing’s extents:

1. Click on Zoom in the Utility menu.

2. Click on Extents in the Zoom menu. Your drawing appears at the largest scale possible while still displaying the drawing in its entirety. If you’ve made significant changes to your drawing, click on Re-Calc. instead of Extents. DataCAD LT will review your drawing and update the extents of the drawing accordingly.

To zoom in on your drawing and display the area to its extents:

1. Click on Zoom in the Utility menu.

2. Toggle Free Zoom on or off in the Zoom menu, depending on your preference. When it is toggled on, DataCAD LT can show a nonstandard display scale. When it is toggled off, DataCAD LT can only use the predefined display scales from the Utility\Disp. Scale menu.

3. Click at one corner of the area you want to zoom in on and move the mouse diagonally to stretch a rubber band box around this area. The area appears at its extents.

**Shortcut:** Press (Home) to center your drawing at the current cursor position in the Drawing Area.

![Figure 2.48: Zooming in on your drawing.](image)
**Changing Your View Using the Keyboard**

You can use the arrow keys to scroll or pan in different directions around the screen. Your view of your drawing changes each time you press an arrow key. Pressing the up arrow key lets you look up toward the top of your drawing by moving the drawing down. The *scroll distance* (the distance that the drawing moves each time you press an arrow key) is defined using the Scroll Dist. option in the Utility/Settings menu. See “Setting the Panning Distance” in the “Before You Draw” chapter for more information on setting the scroll distance.

**Changing Your View Using the Navigation Toolbar**

Several icons on the Navigation toolbar let you quickly change the way you focus on your drawing. If the Navigation toolbar is not currently on your computer monitor, select Toolbars from the View pull-down menu and check Navigation Pad. The following icons affect your view of the drawing:

- **Zoom view in**
- **Zoom view out**
- **Zoom to the drawing's extents**
- **Zoom to an area that you define with a rubber band**
- **Pan arrows to look left, right, up, and down**

**Saving Drawings**

It is a good idea to save your drawing periodically, especially when you walk away from the computer or when you’ve made several changes. There are four ways to save your drawing in DataCAD LT.

- Press (Shift) + (F); if Caps Lock is on, just press (F). This shortcut is a great way to quickly save your drawing with minimal interruption.
- Click on Save in the File pull-down menu.

**Shortcut:** Press (Ctrl) + (S) to save your drawing.

- Click on Save As in the File pull-down menu to save your changes under a different drawing filename.

**Shortcut:** Press (Ctrl) + (Shift) + (S) to save your drawing with a different filename.

- Click on Save All in the File pull-down menu to save changes to all open drawings.

**Warning:** If you close your drawing without saving it, any changes you’ve made since you last saved it will be lost. If it’s a new drawing that has not yet been saved, all references to the drawing in DataCAD LT will be erased.

**Save Image As...**

Shaded images and the drawing window can be saved to .BMP, .JPG, .TIF, .TGA, .PNG, .PCX, or .EPS, format.

- To save a drawing or image in a different file format:
  1. Select Save as Bitmap from the File pull-down menu. The Save Image As dialog box appears.
  2. Choose the file format you want for the saved image from the Files of type drop-down box.
Figure 2.49: The Save Image As dialog box

3. Supply a name for the image in the File name field. If you want, you can keep the name of the original file that appears in the File name field because the file extension will be different based on the choice you made in step 2.

4. Click on Save to save the file in the format you specified. The Save Image As dialog box closes.

More About Naming Your Files

Naming your drawings is an important step to meaningful and efficient file organization. Ideally, the names of your drawings and the folders you store them in will reflect the contents of the file as well as the project they pertain to.

Identifying your drawings and layers with names like “florplan” or “bricks” or “Dimensions” becomes confusing and redundant. Which floorplan? What kind of bricks? Dimensions of what?

Despite the fact that everyone would rather read names than numbers, a naming system based on numbers can eliminate confusion between files. How you structure this numbering system is up to you — only you know the specific needs of your office.

In the sample project outlined earlier in this chapter, we used a different naming system. In the filename YMC-MSR1, “YMC” is the job name abbreviation, “MSR” is the drawing type, and “1” is the drawing version number. A similar convention is used for naming layer files in that project.

The system described below is a typical numbering system that has worked well in several architectural offices.

- The first three characters of the filename = the last three digits of the office job number.
- The next two characters of the filename = the letter and number of the type of drawing. (See the following drawing type list.)
- The last two characters of the filename = the chronological revision number of the drawing.

A suggested system for identifying types of architectural drawings follows:

A0 = General (index, symbols, location plan, 3D views)
A1 = Existing and temporary conditions, site work, demolition
A2 = Plans, detail plans, roof plan
A3 = Exterior elevations, detail elevations
A4 = Building sections, wall sections
A5 = Interior elevations, toilet elevations
A6 = Reflected ceiling plan, floor patterns, furnishings
A7 = Schedules, door and window types
A8 = Details
A9 = Alternates

Structural, mechanical, HVAC, and civil drawings can be identified by type in a similar fashion. Under the above system, the drawing of the fourth elevation in job number 85236 would be named 236A304.AEC.

More About Working with Files

Although not very glamorous, directory/folder and file maintenance have a big impact on DataCAD LT's compatibility with other programs and on your productivity.

The program directory holds the .INI file, allowing you to run an older version (DataCAD LT 10 or earlier) on the same computer. Expanded folder/directory names help you navigate quickly to the directory you want to use. For more information about .INI settings, refer to “INI Settings” in the Appendix.

In comparison with older versions (DataCAD LT 10 and prior), import and export enhancements affect many of the image file formats. Additionally, the drawing file size reduction gives you plenty of room for new projects and makes it easy to share files.

Compressed Drawing Files

DataCAD LT 12 drawings are stored in a compressed format. Though the drawing swap file is nearly double in size (due to the double-precision database), AEC files are roughly 1/5 the size of the DC5 files you created in previous versions.

Because of database changes, several DataCAD LT file extensions have changed. Most of DataCAD LT's file types are now registered with the operating system during installation. DataCAD LT includes some unique file type icons to distinguish them from other programs' files. The following list describes the DataCAD LT 12 file extensions. Items marked with an asterisk apply to DataCAD LT 11 and later versions.

- AEC* DataCAD LT Drawing File
- ANG DataCAD LT Angle File
- ARB* DataCAD LT Auto-recover Backup File
- ARF* DataCAD LT Auto-recover File
- CHR DataCAD LT Font File
- CST* DataCAD LT Context Toolbar Configuration File
- DBK* DataCAD LT Drawing Backup File
- DCA DataCAD LT Command Alias File
- DCX DataCAD LT Add-On Macro File
<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DEC</td>
<td>DataCAD LT Decimal File</td>
</tr>
<tr>
<td>DIMSTYLE</td>
<td>DataCAD LT Dimension Style File</td>
</tr>
<tr>
<td>DIS</td>
<td>DataCAD LT Distance File</td>
</tr>
<tr>
<td>DLF*</td>
<td>DataCAD LT Layer File</td>
</tr>
<tr>
<td>DMF</td>
<td>DataCAD LT Material File</td>
</tr>
<tr>
<td>DOR</td>
<td>DataCAD LT Door Style File</td>
</tr>
<tr>
<td>DPF</td>
<td>DataCAD LT Pen Table File</td>
</tr>
<tr>
<td>DRF*</td>
<td>DataCAD LT Drawing Recovery File</td>
</tr>
<tr>
<td>DSF*</td>
<td>DataCAD LT Symbol File</td>
</tr>
<tr>
<td>DTB*</td>
<td>DataCAD LT Toolbar File</td>
</tr>
<tr>
<td>EDB</td>
<td>Estimator Link Database File</td>
</tr>
<tr>
<td>FRM</td>
<td>DataCAD LT Symbol Report Form File</td>
</tr>
<tr>
<td>GUI*</td>
<td>DataCAD LT Graphical User Interface File</td>
</tr>
<tr>
<td>LBL</td>
<td>DataCAD LT Menu Label File</td>
</tr>
<tr>
<td>LIN</td>
<td>DataCAD LT Line Type Definition File</td>
</tr>
<tr>
<td>LIT</td>
<td>DataCAD LT Shader Light Source File</td>
</tr>
<tr>
<td>MCR</td>
<td>DataCAD LT Keyboard Macro File</td>
</tr>
<tr>
<td>MNU</td>
<td>DataCAD LT Pull-Down Menu File</td>
</tr>
<tr>
<td>MSG</td>
<td>DataCAD LT Message File</td>
</tr>
<tr>
<td>O2C</td>
<td>Object To See File</td>
</tr>
<tr>
<td>PAT</td>
<td>DataCAD LT Hatch Pattern File</td>
</tr>
<tr>
<td>RGB</td>
<td>DataCAD LT Color Palette File</td>
</tr>
<tr>
<td>SCH</td>
<td>DataCAD LT Report Schedule File</td>
</tr>
<tr>
<td>SCL</td>
<td>DataCAD LT Scale File</td>
</tr>
<tr>
<td>SHP</td>
<td>DataCAD LT Font Definition File</td>
</tr>
<tr>
<td>STL</td>
<td>DataCAD LT Text Style File</td>
</tr>
<tr>
<td>STR</td>
<td>DataCAD LT Stair Style File</td>
</tr>
<tr>
<td>$WP</td>
<td>DataCAD LT Drawing Swap File</td>
</tr>
<tr>
<td>SYM</td>
<td>DataCAD LT Symbol File</td>
</tr>
<tr>
<td>TAG*</td>
<td>DataCAD LT Drawing Tag File</td>
</tr>
<tr>
<td>TBL</td>
<td>DataCAD LT DXF/DWG Color Map File</td>
</tr>
<tr>
<td>TPL</td>
<td>DataCAD LT Template File</td>
</tr>
<tr>
<td>USR*</td>
<td>DataCAD LT User File</td>
</tr>
<tr>
<td>WIN</td>
<td>DataCAD LT Window Style File</td>
</tr>
</tbody>
</table>
**DataCAD LT User File**

\DataCAD LT\drawings\my_drawing.U$R

The user file is a temporary file that stores the last date, time, username, and workstation name of the operator who last opened the drawing successfully. DataCAD LT uses this data to provide you with helpful information and appropriate options when you try to open a file that is marked “in-use.” Under normal conditions, the user file is only present when a drawing file is open. However, if you exit a drawing abnormally (e.g., in the case of a program error), the user file remains and DataCAD LT queries it to determine an appropriate course of action the next time you attempt to open the file.

**DataCAD LT Drawing Backup File**

\DataCAD LT\drawings\my_drawing_(backup).DBK

Backup drawings (with a DBK extension) are created each time a drawing is saved. The DBK extension distinguishes DataCAD LT’s backup files from other programs’ generic BAK extension.

**DataCAD LT Drawing Swap File**

\DataCAD LT\temporary files\my_drawing.$WP

The drawing swap file is a temporary copy that is created when you open your drawing. This is the file DataCAD LT modifies when you edit your drawing.

**DataCAD LT Auto-recover File**

\DataCAD LT\drawings\my_drawing.ARF

The auto-recover file is an emergency backup copy of your drawing that DataCAD LT creates at regular time intervals that you set. Auto-recover files are also created when you execute forced file saves.

**DataCAD LT Auto-recover Backup File**

\DataCAD LT\drawings\my_drawing.ARB

The auto-recover backup file is a copy of the auto-recover file. This file is automatically created the second and subsequent times you perform an auto-recover file save.
DataCAD LT Drawing Recovery File
\DataCAD LT\recover archive\my_drawing_(recovered-01).DRF

Drawing recovery files are incrementally-named copies of the drawing file that are created automatically when you opt to restore an auto-recover (ARF) file. This file quarantines copies of recovered files that our technical support staff may use when all attempts to restore the original drawing fail.

Backing Up and Recovering Files
Whenever you exit a drawing abnormally, DataCAD LT will automatically try to recover the most recent version of your file without prompting you with unnecessary warnings and options. The following story about Joe User summarizes the file creation, backup, and recover process.

File Open, Backup, and Recover Process
1. Joe User creates a new drawing. A corresponding swap file is created in the temporary files folder along with a corresponding user file in the drawings folder.
   \drawings\My_Drawing.USR (User File)
   \temporary files\My_Drawing.$WP (Swap File)
2. Joe User continues to work in the new file for 15 minutes when DataCAD LT saves an auto-recover file in the drawings folder.
   \drawings\My_Drawing.USR (User File)
   \drawings\My_Drawing.ARF (Auto-recover File)
   \temporary files\My_Drawing.$WP (Swap File)
3. Joe User continues to work in the new file for another 15 minutes when DataCAD LT saves an auto-recover file for the second time. The current auto-recover file is renamed to serve as a backup and a new auto-recover file is created.
   \drawings\My_Drawing.USR (User File)
   \drawings\My_Drawing.ARF (Auto-recover File)
   \drawings\My_Drawing.ARB (Auto-recover File Backup)
   \temporary files\My_Drawing.$WP (Swap File)
4. A few minutes later, Joe User presses (Shift) + (F) to save his drawing for the first time. At this point, DataCAD LT creates a drawing file, copies the ARF to an ARB, saves a new ARF, and resets the auto-recover timer to zero.
   \drawings\My_Drawing.AEC (Drawing File)
   \drawings\My_Drawing.USR (User File)
   \drawings\My_Drawing.ARF (Auto-recover File)
   \drawings\My_Drawing.ARB (Auto-recover File Backup)
   \temporary files\My_Drawing.$WP (Swap File)
5. About ten minutes later, Joe User completes an extraordinary modeling feat and decides to do a forced file save just to be safe. DataCAD LT copies the AEC file to a backup file for the first time and updates the auto-recover files as previously described.
   \drawings\My_Drawing.AEC (Drawing File)
   \drawings\My_Drawing.DBK (DataCAD LT Backup File)
   \drawings\My_Drawing.USR (User File)
   \drawings\My_Drawing.ARF (Auto-recover File)
   \drawings\My_Drawing.ARB (Auto-recover File Backup)
6. Another auto-recover save occurs and the auto-recover files are updated. However, the drawing and its corresponding backup are not updated.

   \(\text{\textbackslash temporary files\textbackslash My\_Drawing.$WP\ (Swap\ File)}\)

7. Then Joe user performs a forced file save. The drawing and its corresponding backup are updated, the auto-recover files are updated, and the auto-recover timer is reset to zero.

   \(\text{\textbackslash drawings\textbackslash My\_Drawing.AEC\ (Drawing\ File)}\)
   \(\text{\textbackslash drawings\textbackslash My\_Drawing.DBK\ (DataCAD\ LT\ Backup\ File)}\)
   \(\text{\textbackslash drawings\textbackslash My\_Drawing.ARC\ (Auto-recover\ File)}\)
   \(\text{\textbackslash temporary files\textbackslash My\_Drawing.$WP\ (Swap\ File)}\)

**Exit/Save and Crash/Recover Scenarios**

Several things can happen to Joe User’s files. For example, he can successfully exit and save his files, he can suffer a crash and recover his files by himself, or his files can crash and be recovered by another user.

A. Exit and Save

Joe User exits and saves the changes to his drawing. DataCAD LT updates the drawing and its corresponding backup; then, it deletes the swap and auto-recover files.

   \(\text{\textbackslash drawings\textbackslash My\_Drawing.AEC}\)
   \(\text{\textbackslash drawings\textbackslash My\_Drawing.DBK}\)

B. Crash and Recover (Same User)

The power goes out on Joe User. When his computer is back up and running, he tries to re-open the file he was using previously. DataCAD LT checks the user file and determines Joe was the previous user. Then DataCAD LT checks for the presence of an ARF, determines that one is present, and notices it is newer than the AEC file.

DataCAD LT informs Joe he exited the drawing abnormally and gives him the option to proceed and automatically recover the most recent version. Joe User accepts (his only choice) and DataCAD LT copies the AEC file to a "Recover_Archive" folder.

The ARF file is copied to a new AEC file, the ARB file remains, the semaphore file is updated, and the recovered drawing is opened.

   \(\text{\textbackslash drawings\textbackslash My\_Drawing.AEC}\)
   \(\text{\textbackslash drawings\textbackslash My\_Drawing.DBK}\)
   \(\text{\textbackslash temporary files\textbackslash My\_Drawing.$WP}\)

   \(\text{\textbackslash Recover\_Archive\textbackslash My\_Drawing\_\text{(Recovered-01)}\_DRF}\)

**Note:** Each time My_Drawing is recovered, a new DRF file is created sequentially (i.e., My_Drawing\_\text{(Recovered-01)}\_DRF, My_Drawing\_\text{(Recovered-02)}\_DRF, My_Drawing\_\text{(Recovered-03)}\_DRF).
C. Crash and Recover (Different User)

The power goes out on Joe User. He goes home for the day without trying to re-open the file. In the meantime, Jill tries to open the file that Joe just crashed out of.

DataCAD LT checks the user file and determines Joe was the previous user. A message pops up telling Jill that Joe was the last person to open the file and that DataCAD LT will perform a check to see if Joe is still in the file.

Jill selects OK, then DataCAD LT tries to interrogate Joe's computer to see if he has the file open. There is no response (Joe is not running DataCAD LT at the moment), so DataCAD LT then checks for the presence of an ARF and determines one is present and that it is newer than the AEC file.

DataCAD LT informs Jill that the file was exited abnormally and her only option is to proceed and automatically recover the latest version. Jill accepts and DataCAD LT copies the AEC file to a "Recover_Archive" folder.

The ARF file is copied to a new AEC file, the ARB file remains, the semaphore file is updated, and the recovered drawing is opened.

```
\drawings\My_Drawing.AEC
\drawings\My_Drawing.DBK
\drawings\My_Drawing.UR
\drawings\My_Drawing.ARB

\temporary files\My_Drawing.$WP

\Recover_Archive\My_Drawing_(Recovered-01).DRF
```

Exporting Files

You may need to export your DataCAD LT drawings to other file formats, so that you or other offices and/or consultants you work with can use them in other applications. You can export DWG files compatible with AutoCAD releases 12, 13, and 14. You can also export a Text (.TXT), Objects to See (.o2c), 3D Studio (.3DS), and SketchUp (.SKP) file. It's generally a good idea to purge your drawing file before exporting it. For details, see “Purging Files” in this chapter. See “Customizing File Translation” in this chapter for more information about how entities are translated during export.

During export, line definitions and shape codes for DataCAD LT line types are stored in a .SHX file. If you export a DWG file of the DataCAD LT drawing MYDRAWING.AEC, the translator will create two files: MYDRAWING.DWG and MYDRAWING.SHX. For line types in the DWG file to display correctly, the .SHX file must be placed in the \SUPPORT folder in the AutoCAD directory.

➔ To export your drawing to a DXF or DWG file:

1. Save your drawing before starting the export function. This is especially important if you’ve made any changes to your drawing.
2. Click on Export in the File pull-down menu. A submenu appears.
3. Click on DWG or DXF in the submenu. Two export options appear in a submenu: All Layers and On Layers.
4. Click on All Layers to export all the layers in your drawing. Click on On Layers to export only those layers that are toggled on or are currently being displayed. The Export dialog box appears.

5. Go to the File name input box and type a name for the file.

6. Choose a file type from the Save As Type drop-down box. If you chose DWG in step 3, the default file type is R14-DWG file (*.dwg); if you chose DXF in step 3, the default file type is R14-DXF file (*.dxf).

7. Click on Save; the export begins. The export’s progress appears in the Attention toolbar. To cancel the translation, press (End). If the filename you entered in step 4 already exists, a dialog box will be displayed, giving you the choice to overwrite (replace) the existing file. Also if the DWG/DXF file you’re attempting to overwrite is open, a message explaining that the file is currently in use will be displayed. By default, DataCAD LT saves all exported files to the DataCAD LT\Transfer folder.

To export an o2c object:

1. Click on Export in the File pull-down menu. A submenu appears.
2. Click on o2c in the submenu. A dialog box appears.
3. Type a name for the o2c object that you’d like to export.
4. Decide what folder you want to use for the o2c object. By default, o2c objects are saved to your DATACAD LT\RAY folder. If you’d like to save your o2c objects to another folder, use the Save In drop-down box or the Up One Level icon button to change to another folder.
5. Click on Save to export your model as the named o2c object.

**More About o2c Objects**

You can export your DataCAD LT model as an o2c object. o2c, an acronym for Objects to See, is a highly compressed 3D format that is optimized for Internet-based communication.

Simply export your DataCAD LT model as an o2c object and then either distribute it to your client as an e-mail attachment or embed it into one of your web pages.
Using the easy-to-use o2c player, your clients can freely rotate or walk through a fully rendered architectural model. They can view models in wire-frame, hidden-line, flat-shaded, textured, or ray-traced modes. The o2c objects can even contain animated elements that can be played in conjunction with the 3D viewing commands. And because you can generate a high-resolution, photorealistic rendering of the model right in the o2c player, you don’t need to transmit excessively large images via email; your clients can simply create their own. While the o2c player provides comprehensive and powerful viewing controls, objects can’t be modified.

For more information about o2c, see “Using the o2c-based Object Viewer” in the “Viewing Your Model” chapter.

**Launching External Applications**

A toolbar code lets you launch external applications. You can use the new “P” code to launch an external program (such as WordPad) from a DataCAD LT toolbar icon.

To launch an external program from a DataCAD LT toolbar, use the following syntax:

```
[Launch_WordPad]
Hint=Launch WordPad
Icon=WordPad_Icon
P=c:\program files\windows nt\accessories\wordpad.exe
```

If the external program supports command line parameters, you can include them as well. The following example launches WordPad and automatically opens my_document.txt.

```
[Open_My_Document]
Hint=Launch WordPad and open My_Document.txt
Icon=My_Document_Icon
P=c:\program files\windows nt\accessories\wordpad.exe
c:\my_documents\my_document.txt
```
Tutorial: Drawing a Schoolhouse

In this chapter, you’ll learn how to customize both DataCAD LT and your drawing before you ever draw a line. Then you’ll draw the exterior and interior walls of the schoolhouse and add doors and windows to it.

In this chapter:
- Drawing walls
- Drawing windows
- Drawing doors
Setting Up a New Drawing
DataCAD LT contains many options for customizing the way your system operates. In this tutorial, you will make only two modifications: adding layers to a new drawing and changing the snap grid setting.

To begin this tutorial, start DataCAD LT and start a new drawing, as described in “The Drawing Board” chapter.

Setting the Snap Grid for the Tutorial
First, you’ll need to change the snap grid setting.

To set the snap grid:
1. Press (S) on your keyboard. Make sure Caps Lock is off. In the Message toolbar, you are prompted to Enter X-snap grid.
2. Type .1 and press (Enter). You are prompted to Enter Y-snap grid.
3. Type .1 and press (Enter).

You just set the accuracy of the cursor movement to one inch. Move your cursor around the drawing screen and look at the X and Y snap grid values in the Coordinates/Hints toolbar.

Creating New Layers for the Tutorial
When you start a new drawing in DataCAD LT, it contains only one layer (called Layer001), which is also the active layer. Any settings in the active layer will automatically be used in new layers when you create them. For example, the snap grid setting you entered above will be assigned to each layer you add to your drawing; so you won’t have to set the snap grid in every new layer.

To add layers to this drawing:
1. Right-click to return to the Utility menu from the previous exercise.
2. Click on Layers in the Utility menu.
3. Click on New Layer in the Layers menu.
4. Type 8 and press (Enter). You’ve just added eight layers to the drawing for a total of nine layers.

Naming Layers for the Tutorial
You’ll be given the layer names for this exercise, but you should develop your own plan for naming layers based on the type of work you do.

To rename your layers:
1. Make sure you’re in the Layers menu. If you’re not, click on Layers in the Utility menu.
2. Click on Rename in the Layers menu. The Rename menu contains a list of all your layers.
3. Click on Layer001. You are prompted to Enter new name.
4. Type Walls and press (Enter). Look at the list of layers in the Menu Window; notice that Layer001 has been changed to Walls.
5. Click on Layer002. You are prompted to Enter new name.
6. Type Doors and press (Enter). Notice that Layer002 is now named Doors in the layer list in the Menu Window.

7. Rename the rest of your layers as follows: Layer003 to Windows, Layer004 to Plumb, Layer005 to Dim, Layer006 to Hatch, Layer007 to Notes, Layer008 to Misc, and Layer009 to Border.

8. Right-click twice to return to the Utility menu.

Moving Between Layers in the Tutorial

Now that you’ve created and named your new layers, you can move among them. To draw walls on the Walls layer and doors on the Doors layer, you have to change to the corresponding layer before you begin drawing. In DataCAD LT terms, before you place a wall on your drawing, you will make the Walls layer the active layer.

The Status Panel toolbar shows the active layer or the layer that you are drawing on. As you change active layers, the Status Panel toolbar is updated with the corresponding layer name. You can only draw on the active layer.

![Status Panel toolbar](image)

**Figure 3.1:** Check the Status Panel toolbar for active layer name and color.

> To change the active layer:

1. Press (Tab) on your keyboard. Notice that the active layer name in the Status Panel toolbar changes.

2. Keep pressing (Tab). Eventually you’ll return to the beginning of the layer list. Pressing (Shift) + (Tab) cycles backwards through your layers.

Assigning Colors to Layers in the Tutorial

You can assign different colors to layers, so that any entities you add to a layer will be drawn in that layer’s color. You’ll be able to tell at a glance what layer an entity is on simply by its color. That color is the active color for that layer until you change it.

> To assign layer colors:

1. Make sure you’re in the Layers menu. If you’re not, click on Layers in the Utility menu.

2. Press (Tab) until the Doors layer is the active layer. Check the Status Panel toolbar to see which layer is active.

3. Click on Color in the Layers menu.

**Shortcut:** Press (K) to change the color of the active layer. Pressing (K) will cycle through the colors; pressing (Shift) + (K) cycles backwards through the layers.
4. Click on Green. The color assigned to the Doors layer is now Green. The layer color swatch in the Status Panel toolbar is also green.

5. Press (Tab), so that the Windows layer is active.

6. Click on Color in the Layers menu.

7. Click on Cyan. The color assigned to the Windows layer is now Cyan.

8. Use this same procedure to assign colors to the rest of your layers. Make the Plumb layer Lt. Grey, the Dim layer Lt. Grey, the Hatch layer Brown, the Notes layer Lt. Red, the Misc layer Red, and the Border layer Lt. Green.

9. Right-click to return to the Utility menu.

**Drawing Walls, Windows, and Doors**

This part of the tutorial introduces you to using DataCAD LT as an architectural tool. You will learn how to use the wall menu options to begin drawing architectural plans. This tutorial uses Arch units. See “Customizing Drawing Settings” in the “Before You Draw” chapter for more information on how to change drawing units.

**Drawing the Schoolhouse Walls**

Each wall that you draw will have two or more lines, rather than just one. In the following exercises, you will draw walls using both the mouse and the keyboard.

*Figure 3.2: Examples, from left to right, of 2-line walls, 3-line walls, and 4-line walls*
The Architect menu is used for drawing walls as well as doors and windows.

**Figure 3.3:** The Architect menu is used for drawing walls, windows, and doors.

**Drawing the Schoolhouse’s Exterior Walls**

Before you draw the exterior walls of the schoolhouse, you should make sure your wall settings are correct.

➤ To set up for drawing exterior walls:

1. Continue with the drawing you started in the previous section of this tutorial.


3. Click on Walls in the Architect menu to toggle it on; walls will be drawn instead of single lines. Notice that the “w” in the SWOTHLUDFB toolbar is now uppercase. This indicates that you will draw walls instead of single lines.

4. Click on 2 Line Walls in the Architect menu if it’s not already toggled on.

5. Click on Width in the Architect menu to set the width of the wall. A value menu appears; you are prompted to Enter wall width. For more information on using value menus, see “Value Menus” in “The Drawing Board” chapter.

6. Click 1’-0” in the value menu and then right-click or type 1; then, press (Enter).

7. Click Outside in the Architect menu; any walls you draw will be defined by the outside line of the wall.

8. Right-click to return to the Edit menu.

9. Look at the Status Panel toolbar to make sure that Walls is your active layer. If it’s not, press (Tab) until it is.
Now you are ready to draw the exterior walls.

To draw exterior walls:

1. Use the mouse to draw the first wall. Notice that the prompt in the Message toolbar reads *Select first end point of new line/wall*. Move the cursor to the lower left of the Drawing Area and click to enter the first end point of the new wall. You are prompted to *Select next end point of line/wall*.

2. Move the cursor to the right until the coordinate readout shows an X measurement of 28'-0" and a Y measurement of 0 and click. This defines the exterior line of the wall. You are prompted to *Select a point to define the inside of the wall*.

3. Move the cursor to a position anywhere above the displayed line and click. The wall is immediately drawn. You are prompted to *Select next end point of line/wall*.

4. Draw a second wall using coordinate entry. Press (Insert) until the Attention toolbar reads *Current input mode = Relative Polar (distance, angle)*. You can also use coordinate entry to enter points. See “**Drawing Using Coordinate Entry**” in “The Drawing Board” chapter to review coordinate entry methods.

5. Press (Spacebar) to activate coordinate entry. You are prompted to *Enter relative distance*.

6. Type 40.6 and press (Enter); 40.6 means 40 feet 6 inches in architectural units. You are prompted to *Enter relative angle*.

7. Type 90 and press (Enter). The wall is drawn and the corner is automatically cleaned. If the new wall extends beyond your view of the Drawing Area, use the arrow keys to move your drawing into view.
The cursor is connected to the outside corner.

The corners automatically clean up as you draw.

**Figure 3.6:** The second wall is drawn and the corner is cleaned.

8. Click on the icon in the Navigation Pad toolbar to zoom out to the extents of the drawing.

9. Press (Spacebar). You are prompted to *Enter relative distance.*

10. Type 28 and press (Enter). You are prompted to *Enter relative angle.*

11. Type 180 and press (Enter).

12. Move the cursor close to the inside line of the corner where you originally began and click. The last corner is cleaned, leaving a clean outline of the schoolhouse exterior walls.

**Figure 3.7:** Ending your exterior wall
The final corner is automatically cleaned up.

Figure 3.8: The exterior walls are complete.

Drawing the Schoolhouse’s Interior Walls

Now you will draw the interior walls. You’ll change the wall thickness for the interior walls to four inches.

➢ To set up for drawing the interior walls:


   **Shortcut:** Press (A) to access the Architect menu at any time.

2. Click on Width in the Architect menu. You are prompted to *Enter wall width*.

3. Type .4 and press (Enter).

4. Click on Inside in the Architect menu to define the wall by the inside line.

5. Click on Clean to toggle on automatic T intersection cleaning. Walls and 2 Line Walls should still be toggled on.

6. Right-click once to return to the Edit menu.

➢ To draw interior walls:

1. Click on the Navigation Pad toolbar to open the Zoom menu. You are prompted to *Select first corner of the Zoom window*.

2. Position your cursor outside the lower-left corner of the plan and click. You are prompted to *Select second corner of the Zoom window*.

3. Move the mouse diagonally, stretching the rubber band box until it encloses the lower half of the plan as in the next figure and click. Your drawing now appears larger.
4. Right-click to return to the Edit menu.

5. Press (’) on the keyboard to set X and Y to 0. You are prompted to Select reference point. The accent key (’) is located in the upper-left corner of your keyboard, just below (Esc) and to the left of (1) on most keyboards.

6. Move the cursor close to the inside left corner of the bottom wall and either click the middle mouse button or press (N) on the keyboard. This sets this corner as the new reference point to work from. Steps 6-9 are the equivalent of placing one end of an architect’s scale at a corner and marking a point at 10’-2”.

7. Press (Spacebar). You are prompted to Enter relative distance.

8. Type 10.2 (the inside dimension of the office) and press (Enter). You are prompted to Enter relative angle.

9. Type 0 for the relative angle and press (Enter). Notice that your cursor is now attached to the wall exactly 10’-2” to the right of the corner you used as your reference point. This will be the first point of the interior wall.

10. Press (Spacebar). You are prompted to Enter relative distance.
11. Type 10.8 (the inside dimension of the office) and press (Enter). You are prompted to Enter relative angle.

12. Type 90 and press (Enter). You are prompted to Select a point to define the Outside of the wall.

13. Move the cursor to the right of the displayed line and click to indicate the outside of the wall.

![Figure 3.12: Defining the outside of the wall](image)

14. Move the cursor close to the inside line of the left exterior wall and click.

![Figure 3.13: Drawing the last office wall](image)

15. Right-click to disconnect from the line. The office area is complete and all intersections are automatically cleaned.

To draw the remaining interior walls:

1. Press (‘) on the keyboard. You are prompted to Select reference point.

2. Move the cursor close to the inside right corner of the bottom wall and click the middle mouse button. Remember, if you don't have a three-button mouse you can also press (N) on the keyboard.

![Figure 3.14: Selecting a new reference point](image)

3. Press (Spacebar). You are prompted to Enter relative distance.

4. Type 10.2 and press (Enter). You are prompted to Enter relative angle.

5. Type 180 and press (Enter). The cursor connects to a point on the inside line of the exterior wall.

6. Press (Spacebar). You are prompted to Enter relative distance.

7. Type 10.8 and press (Enter). You are prompted to Enter relative angle.

8. Type 90 and press (Enter). You are prompted to Select a point to define the Outside of the wall.
9. Move the cursor to the left of the new wall and click to define the outside of the wall.
10. Move the cursor to the right just before the inside line of the exterior wall and click.
11. Right-click to disconnect from the wall line. The wall is drawn and your intersections are cleaned.

![Figure 3.15: The wall is drawn and the intersections are cleaned.](image)

12. Press ('). You are prompted to Select reference point.
13. Move the cursor near the inside corner of the wall you just drew and click the middle mouse button.

![Figure 3.16: Selecting a new reference point](image)

14. Press (Spacebar). You are prompted to Enter relative distance.
15. Type 5.2 and press (Enter). You are prompted to Enter relative angle.
16. Type 270 and press (Enter). The cursor connects to a point on the inside line of the exterior wall.
17. Move the cursor to the left, close to the inside line of the wall, and click. You are prompted to Select a point to define the Outside of the wall. It is important in step 17 to select a point closer to the inside, not the outside, line of the room you just drew so that the correct wall line will be cleaned.
18. Move the cursor below the displayed line and click to define the outside of the wall.

![Figure 3.17: Drawing the dividing wall between the bathrooms](image)

19. Right-click to disconnect from the wall.
20. Click on in the Navigation Pad toolbar to view the drawing extents.
21. Press (Ctrl) + (S) on the keyboard to save the drawing. This is a good habit to get into. You should do it after you enter several items or make a lot of changes to your drawing.

You have now completed all the walls of the schoolhouse plan and saved your drawing. If any of the walls did not clean and your drawing doesn’t look like the figure above, the next section will help you straighten up your plan.

Cleaning the Schoolhouse’s Wall Intersections
As you insert walls, DataCAD LT automatically cleans intersections. If you right-click by accident and disconnect from a wall prematurely or your intersections clean at the wrong wall line, you will need to clean them.
If you disconnected from a wall and reattached to continue the remaining walls, the corner you reattach to will not clean.

If you were too close to the outside line of this wall when drawing the dividing wall, the wrong line will clean.

If you become disconnected from a wall, when you attempt to complete the last intersection, the "L" intersection will not clean up properly.

Figure 3.19: Examples of wall intersections that were improperly drawn

If an L intersection doesn’t clean properly, despite Clean being toggled on when you drew the walls, it may be because you disconnected your cursor from the end of one wall and then started drawing the next wall. In such a case, you may have to use 2 Line Trim in the Cleanup menu so the wall lines intersect properly; then use Erase to remove any unwanted lines within the intersection.

➔ To fix the error shown in example 1:
1. Go to the Edit menu in the Menu Window; click on Cleanup.
2. Click on L Intersect in the Cleanup menu. You are prompted to Select 1st corner around L intersection (wall lines only).
3. Click above and to the right of the intersection.
4. Diagonally drag the cursor to the lower left of the intersection, stretching the rubber band box, and click.

Figure 3.20: Cleaning an L intersection
To fix the error shown in example 2 on the previous page:

1. Go to the Edit menu in the Menu Window; click on Cleanup.
2. Click on L Intersect in the Cleanup menu. You are prompted to Select 1st corner around L intersection (wall lines only).
3. Click above and to the right of the intersection.
4. Drag the cursor diagonally to the lower left of the intersection, stretching the rubber band box around the intersection, and click.

![Figure 3.21: Cleaning an L intersection](image)

To fix the error shown in example 3 on the previous page:

1. Go to the Edit menu in the Menu Window; click on Cleanup.
2. Click on 1 Line Trim in the Cleanup menu. You are prompted to Select first point of line to clip to.
3. Click on Entity in the 1 Line Trim menu. You are prompted to Point to line to trim to.
4. Click on the inside wall line, shown in Figure 3.22. The line you select becomes dashed. You are prompted to Point to outside.
5. Click to the left of the dashed line. You are prompted to Select entity to trim.
6. Click on the two wall lines to select them as the lines to trim. The lines are trimmed.

![Figure 3.22: Completing a 1-line trim](image)

7. Right-click once to return to the Cleanup menu.
DRAWING WALLS, WINDOWS, AND DOORS | 109

The lines are trimmed to the correct wall, but there is still a break in the wall.

**Figure 3.23:** Trimming wall lines to the correct wall

8. Fix the break in the outside wall by clicking on Weld Line in the Cleanup menu. You are prompted to *Select first line to weld*.

9. Click on one of the lines of the broken wall to select it; it becomes dashed. You are prompted to *Select second line to weld*.

10. Click on the other line of the broken wall to select it. The line mends and becomes a single entity.

**Figure 3.24:** Selecting lines to be welded

11. Right-click once to return to the Cleanup menu.

The lines are trimmed to the inside wall.

**Figure 3.25:** The wall line is welded.

12. To clean up the T intersection in the wall, click on T Intersect in the Cleanup menu. You are prompted to *Select 1st corner around “T” intersect (wall line ends only)*.

13. Click at the lower left corner of the intersection you want to clean. You are prompted to *Select 2nd corner around “T” intersect (Wall line ends only)*.

14. Move the cursor above and to the right of the intersection to enclose the corner to clean and click. You are prompted to *Point to a wall line to trim to*.

15. Click on the inside line to select it as the line to trim to.
16. Right-click twice to return to the Edit menu.

13-14
Place a rubberband box around the corner to clean.

15
Click the left mouse button to define this line as the line to trim to.

Figure 3.26: Completing a T intersection

The wall is cleaned and the T intersection is complete.

Figure 3.27: The wall intersection is cleaned.

**Drawing Countertops in the Schoolhouse**

While the 3-line walls function is usually used for drawing walls, we’ll use it here to quickly draw parallel lines representing countertops.

→ To set up to draw countertops:

1. Click on Architect in the Edit menu.
2. Click on 3 Line Walls in the Architect menu to toggle on the 3-line wall option. This allows you to draw three parallel lines at once. The two outer lines will define the edges of the counter and the centerline will be a dashed line to represent the upper cabinets. Walls should still be toggled on.
3. Click on Center Line in the Architect menu to set the attributes of the centerline of the two parallel lines. This will represent the upper cabinets.
4. Click on Line Type in the Center Line menu. All available line types are listed in the Menu Window.
5. Click on Dashed in the Line Type menu to make the centerline dashed.
6. Right-click once to return to the Architect menu.
7. Click on Width in the Architect menu. You are prompted to Enter wall width.
8. Type 2 and press (Enter). This sets the width of the countertop at two feet.
9. Click on Outside in the Architect menu; the wall will be defined by the outside line.
10. Click on Cap in the Architect menu to automatically cap the end of the parallel lines (or in this case, countertops).
11. Right-click to return to the Edit menu.

Now you are ready to draw the countertops.

To draw countertops on the plan:

1. Click on the Navigation Pad toolbar to open the Zoom menu. You are prompted to Select first corner of the Zoom window.
2. Click near the lower-left corner of the bottom wall. You are prompted to Select second corner of the Zoom window.
3. Drag the mouse diagonally until the rubber band box encloses the lower half of the plan and click. The plan now appears larger.
4. Right-click once to return to the Edit menu.
5. Move the cursor to the corner marked 6 in Figure 3.28 and click the middle mouse button to select it as your first reference point.

**Figure 3.28:** Selecting the starting point of the countertop

6. Press (Spacebar). You are prompted to Enter relative distance.
7. Type 10.2 and press (Enter). You are prompted to Enter relative angle.
8. Type 180 and press (Enter).
9. Move the cursor above the displayed line and click to define the other side of the counter.

**Figure 3.29:** Drawing the countertop

10. Right-click to disconnect from the counter. The countertop lines are drawn and the end is capped.
Figure 3.30: The first countertop is drawn.

11. Repeat steps 5 - 10 for the counter on the opposite side. Remember that the relative angle for this counter will be 0.

Figure 3.31: The second countertop is drawn.

12. Click on the Navigation Pad toolbar to view the extents of the drawing.
13. Press (Ctrl) + (S) to save the drawing.

**Drawing the Schoolhouse’s Doors and Windows**

Now that you have drawn the walls for the schoolhouse plan, you are ready to insert doors and windows.

- To set up to draw a door:
  1. Press (Tab) until the Doors layer is the active layer in the Status Panel toolbar.
  2. In the Edit menu in the Menu Window, click on Architect.
  3. Click on Door Swing in the Architect menu.
4. Click on Draw Marks in the Door Swing menu to toggle the Draw Marks option on.

5. Click on One Layer to toggle it on. (If One Layer is already toggled on, click on it to toggle it off; then toggle it back on again.) You are prompted to Select layer to search for walls; a list of your layers appears in the Menu Window.

6. Click on Walls. DataCAD LT now knows where to find your walls when it needs to cut them for doors and windows.

There are two methods to draw a door: by defining both of its sides and by defining one side and its center. You’ll draw the first door by sides. To position and begin drawing a door, you need to reference and measure from an existing point on the drawing.

⇒ To draw a door by sides:

1. Click on the Navigation Pad toolbar to go to the Zoom menu. You are prompted to Select first corner of the Zoom window.

2. Click at the lower-left corner of the bottom wall. You are prompted to Select second corner of the Zoom window.

3. Drag the mouse diagonally until the rubber band box encloses the lower half of the plan and click. The plan now appears larger.
Click the left mouse button to start the rubberband box.

Click the left mouse button to close the rubberband box.

Figure 3.33: Zooming in on the plan

Figure 3.34: The result of zooming in on your drawing

Figure 3.35: Setting a reference point.

4. Right-click once to return to the Door Swing menu.

5. Press (') on the keyboard. You are prompted to Select reference point.

6. Click the middle mouse button near the upper-right corner of the first room you drew, as shown in Figure 3.35. Stay close to the inside of the corner. This will be your reference point. You are prompted to Select hinge side of door.

7. Press (Spacebar). You are prompted to Enter relative distance.

8. Type .3 and press (Enter). You are prompted to Enter relative angle.
9. Type 270 and press (Enter). You are prompted to *Select strike side of door.*
10. Press (Spacebar). You are prompted to *Enter relative distance.*
11. Type 3 and press (Enter). You are prompted to *Enter relative angle.*
12. Type 270 and press (Enter). You are prompted to *Select direction of door swing.*
13. Click anywhere inside the office (on the left side of the wall); this defines the direction of the swing. The wall is cut and you are prompted to *Select any point on the outside of the wall.*
14. Click to the right of the outside wall to define the nonprinting snap point location. The door is drawn.

![Figure 3.36: Drawing the door](image)

To draw a second door by center:

1. Click on Sides in the Door Swing menu to toggle off the Sides option. Now you can define doors by entering their center and strike side.

2. Move the mouse to the location shown in Figure 3.37. Click the middle mouse button to snap to the midpoint of the inside front wall. You are prompted to *Select strike side of door.*

![Figure 3.37: Defining the center of the front door](image)

3. Press (Spacebar). You are prompted to *Enter relative distance.*
4. Type 1.6 and press (Enter). You are prompted to *Enter relative angle.*
5. Type 0 and press (Enter). You are prompted to *Select direction of door swing.*
6. Click inside the hall (above the wall) to define the direction of the door swing. The wall is cut. You are prompted to **Select any point on the outside of the wall**.

7. Click anywhere on the outside of the exterior wall where you want to locate the nonprinting snap point. The door is drawn.

![Diagram](image1)

**Figure 3.38:** The front door is drawn.

8. Click on Sides to toggle on the Sides option.


10. Click the middle mouse button near the upper-left corner of Room A, shown in Figure 3.39. You are prompted to **Select hinge side of door**.

![Diagram](image2)

**Figure 3.39:** Locating the next door

11. Press (Spacebar). You are prompted to **Enter relative distance**.

12. Type .3 and press (Enter). You are prompted to **Enter relative angle**.

13. Type 270 and press (Enter). You are prompted to **Select strike side of door**.

14. Press (Spacebar). You are prompted to **Enter relative distance**.

15. Type 3 and press (Enter). You are prompted to **Enter relative angle**.

16. Type 270 and press (Enter). You are prompted to **Select direction of door swing**.

17. Click anywhere inside Room A (on the right side of the wall) to define the direction of the swing. The wall is cut. You are prompted to **Select any point on the outside of the wall**.
18. Click inside the hall to define the outside of the wall. This defines the nonprinting snap point location. The door is drawn.

19. Repeat steps 9-18 to create a door for Room B.

20. Right-click twice to return to the Edit menu.

![Figure 3.40: The remaining schoolhouse doors are drawn.]

21. Click on the Navigation Pad toolbar to zoom to the extents of the drawing.

22. Press (Ctrl) + (S) on the keyboard to save the drawing.

You have now completed entering all the doors for this exercise and saved them to your drawing file.

To set up to draw windows:

1. Before you begin to draw windows, press (Tab) until the Windows layer is the active layer in the Status Panel toolbar.

2. In the Edit menu in the Menu Window, click on Architect.

To draw the first window by sides:

1. Click the Navigation Pad toolbar to open the Zoom menu. You are prompted to select first corner of the Zoom window.

2. Click at the lower-left corner of the bottom wall. You are prompted to select second corner of the Zoom window.

3. Drag the mouse diagonally until the rubber band box encloses the lower half of the plan and click to zoom in on your plan.

Figure 3.42: Zooming in on the lower half of your drawing
4. Right-click once to return to the Windows menu.
5. Press (') on the keyboard. You are prompted to Select reference point.
6. Click the middle mouse button near the lower left corner of the interior wall shown in Figure 3.43. This will be your reference point. You are prompted to Select one jamb of window.

![Figure 3.43: Setting a reference point](image)

7. Press (Spacebar). You are prompted to Enter relative distance.
8. Type 3.7 and press (Enter). You are prompted to Enter relative angle.
9. Type 0 and press (Enter). You are prompted to Select one jamb of window.
10. Press (Spacebar). You are prompted to Enter relative distance.
11. Type 3 and press (Enter). You are prompted to Enter relative angle.
12. Type 0 and press (Enter). You are prompted to Select any point on the outside of the wall.
13. Click anywhere on the outside of the exterior wall. The window is drawn.

![Figure 3.44: Drawing the first window](image)

14. Move the cursor to the bottom right corner of Room B and repeat steps 6 - 14 for the window on the opposite side. Remember that the relative angles will now be 180.
15. Click on the Navigation Pad toolbar to view the extents of the drawing.

To draw multiple windows:
1. Click on Sides in the Windows menu to toggle Sides off; you can now define windows by the center and one side or jamb.
2. Click the Navigation Pad to open the Zoom menu. You are prompted to Select first corner of the Zoom window.

3. Click at the upper-right corner of the top wall. You are prompted to Select second corner of the Zoom window.

4. Drag the mouse diagonally until the rubber band box encloses the upper half of the plan and click to zoom in on the plan.

![Figure 3.45: Zooming in on the upper half of your drawing](image)

5. Right-click once to return to the Windows menu.

6. Press (') on the keyboard. You are prompted to Select reference point.

7. Move the cursor to the top left corner of the interior wall, as shown in Figure 3.46 and click the middle mouse button to set the reference point. You are prompted to Select center of window.

![Figure 3.46: Setting a reference point](image)

8. Press (Spacebar). You are prompted to Enter relative distance.

9. Type 7.8 and press (Enter). You are prompted to Enter relative angle.

10. Type 270 and press (Enter). You are prompted to Select one jamb of window.

11. Press (Spacebar). You are prompted to Enter relative distance.

12. Type 1.6 and press (Enter). You are prompted to Enter relative angle.

13. Type 270 and press (Enter). You are prompted to Select any point on the outside of the wall.

14. Click anywhere on the outside of the exterior wall. The wall is cut and the window is drawn.
Figure 3.47: The wall is cut and the window is drawn.

15. Press (‘) on the keyboard. You are prompted to Select reference point.

16. Move the cursor to the center snap point of the window you just drew and click the middle mouse button to set the reference point. You are prompted to Select center of window.

17. Press (Spacebar). You are prompted to Enter relative distance.

18. Type 5.6 and press (Enter). You are prompted to Enter relative angle.

19. Type 270 and press (Enter). You are prompted to Select one jamb of window.

20. Press (Spacebar). You are prompted to Enter relative distance.

21. Type 1.6 and press (Enter). You are prompted to Enter relative angle.

22. Type 270 and press (Enter). You are prompted to Select any point of the outside of the wall.

23. Click anywhere on the outside of the exterior wall. The wall is cut and the window is drawn.

Figure 3.48: The wall is cut and the window is drawn.
24. Repeat steps 15 - 23 for the last window on this wall.

25. Repeat these steps to create the windows on the other wall.

26. Click on the Navigation Pad to view the extents of the drawing. Your plan should look like Figure 3.49.

28. Press (Ctrl) + (S) to save the drawing.
Tutorial: Adding Dimensions, Notes, Symbols, and Hatching

This part of the tutorial covers those functions that transform a drawing into an architectural construction document. You will add text notes and arrows, dimension the drawing, add a tile hatch to the hallway, and insert plumbing symbols in the bathrooms as well as a sink in one of the countertops. Finally, you’ll draw a title block and border around the drawing.
Adding Text to the Schoolhouse Drawing
As you enter text, the schoolhouse floor plan will start to take shape. Depending on the size, placement, and font being used, your drawing can develop into something that looks very professional.

To set text attributes:

1. If you are not already working in DataCAD LT, open the program now. Open the drawing you worked on in the previous chapter.
2. Press (Tab) until the Notes layer is the active layer, as displayed in the Status Panel toolbar.
3. Click on Text in the Edit menu in the Menu Window or click on Text in the Create pull-down menu. The Text menu appears.

![Figure 4.1: The Text menu](image)

4. Set the size of the text by clicking on Size. A value menu appears. The text cursor graphically represents the current size of the text.
5. Click on 1’-0” and right-click or type 1 and press (Enter).
6. Set the aspect ratio of the text by clicking on Aspect. A value menu appears. An aspect ratio below 1.0 creates wider and fatter characters, while an aspect above 1.0 creates thinner characters.
7. Type .75 and press (Enter).
8. Click on Font to select a new font. The Set Text Parameters dialog box appears so that you can select CHR or TTF fonts.
9. Click on ARCWY2HC.CHR. This font has a nice hand-drawn style. Then click on OK to close the dialog box.

10. Click on Alignment in the Text menu to display the Alignment menu.

11. Click on Center to center the text within an area on the drawing. Then right-click to return to the Text menu.

To insert room names:

1. Move the cursor to the center of the large room. You are prompted to Position text using cursor, then ‘ENTER’.

2. Click to set the position of the text.

3. Press (CapsLock) if it isn’t already on.
4. Type **CLASSROOM**. The text appears in the drawing as you type.
5. Right-click to exit this command and return to the Text menu.
6. Repeat steps 1 - 5 for the office, but type **OFFICE** in the room to the lower left instead of typing **CLASSROOM**.

![Figure 4.4: Room labels for the classroom and office are added](image)

To insert notes:

1. Set the size of the text by clicking on Size. A value menu appears.
2. Type **.6** and press (Enter).
3. Click on Aspect. A value menu appears.
4. Type **1.25** and press (Enter). This sets the aspect ratio to create a thinner text.
5. Click on Alignment. Then click on Right in the Alignment menu to align the text on the right side of the indicated placement point.
6. Click in the center of the room, between the text **CLASSROOM** and the countertops. To zoom in closer to the drawing, press (PageDown). Press (PageUp) to zoom out.
7. Type the following note, pressing (Enter) after each line:

   PLASTIC LAMINATE COUNTERTOP
   36" ABOVE FINISHED FLOOR WITH
   ADJUSTABLE SHELVES BELOW

8. Right-click to exit this command and return to the Text menu.
Drawing Text Arrows in the Schoolhouse Drawing

To draw text arrows:

1. Click on Arrows in the Text menu.
2. Click on Size to change the arrow size. You are prompted to Enter arrow size.
3. Type .6 and press (Enter). You are prompted to Draw arrow.
4. Click near the right side of the paragraph of text you just entered. This defines the tail end of the arrow.
5. Click to define any bends in the tail of the arrow.
6. Click to define the arrowhead location.

Figure 4.5: The note is placed on the drawing
Click the left mouse button to define the beginning of the tail.

Click the left mouse button to define the bend of the tail.

Click the left mouse button to define the point of the arrow.

Figure 4.6: Placing an arrow in the drawing

7. Right-click once. The arrow is drawn.
8. Right-click twice to return to the Edit menu.

Editing Text in the Schoolhouse Drawing

To correct existing text:
1. Click on Change in the Edit menu.
2. Click on Text to set the text attribute you want to change.
3. Click on Contents to change or edit the words in existing text.
4. Click on Area to select the text with a window box.
5. Click below and to the left of the text paragraph.
6. Drag the mouse diagonally until the rubber band box completely encloses the entire note and click. The first line of text appears in the Message Area.
7. Type over the text to make the following correction, pressing (Enter) when you're finished:

CERAMIC TILE COUNTERTOP

The first line of text is corrected and the second line of text appears in the prompt.

8. Press (Enter) to accept the second line as it is. The third line of text appears in the prompt.

9. Press (Enter) to accept the third line as it is.

10. Right-click twice to return to the Edit menu.

11. Click on \(\text{[view extents]}\) to view the extents of the drawing.

12. Press (Ctrl) + (S) to save your drawing.

**Dimensioning the Schoolhouse Drawing**

In an architectural office, there are many factors that determine the type of dimension used for a project. In this section of the tutorial, you will insert standard linear dimensions in the schoolhouse floor plan.

To set up to dimension:

1. Press (Tab) until the Dim layer is the active layer in the Status Panel toolbar.

2. Click on Dimensions in the Utility menu to display the Dimensions menu in the Menu Window.

3. Draw linear dimensions by clicking on Linear. The Linear menu appears.
**Figure 4.8: Linear dimension menu**

4. Click on Text Style to change the current text style or settings.
5. Click on Font in the Text Style menu to change the font.
6. Click on ARCWY2HC in the FontName list in the Set Text Parameters dialog box to match the font style of the notes. Then click on OK or press (Enter) to leave the dialog box.
7. Right-click to return to the Linear menu.

**Drawing a String of Dimensions:**

To draw a dimension string:

1. Click on Vertical to draw vertical dimensions. You are prompted to Select first point of distance to dimension.
2. Move the cursor to the lower left corner of the exterior wall and click the middle mouse button or press (N) on the keyboard to object snap to the corner. You are prompted to Select second point of distance to dimension.
3. Move the cursor to the snap point of the window shown in Figure 4.9 and click the middle mouse button to snap to it. You are prompted with Dimension which side of line?
3. Click the middle mouse button to define the second point of distance to dimension.

2. Click the middle mouse button to set the start of the dimension line.

Figure 4.9: Placing the first dimension on the drawing

4. Move the cursor to the outside of the wall and click.
5. Click on String Line to continue drawing dimensions in a stringline. You are prompted to Select next point to dimension to.
6. Move to the snap point of the middle window and click the middle mouse button to snap to the next point to dimension to. You are prompted to Select next point to dimension to.
7. Move to the snap point of the last window and click the middle mouse button to snap to the next point to dimension to.
8. Click the middle mouse button to select the corner of the wall, which is also the end of the stringline.
9. Right-click to exit the String line menu and return to the Linear menu.

8. Click the middle mouse button to end the stringline.
7. Click the middle mouse button to define the next point to dimension to.
6. Click the middle mouse button to define the next point to dimension to.
4. Click the left mouse button to define the outside of the wall. The first line is drawn.

Figure 4.10: Defining a stringline of dimensions

10. Click on Overall in the Linear menu to place an overall dimension of the stringline.
11. Right-click twice to return to the Utility menu.
Automatic Dimensioning
You can also use automatic dimensioning; follow the steps below to use this second method of adding dimensions to your drawing.

1. Click on Dimensions in the Utility menu. The Dimensions menu appears.
2. Click on Linear. The Linear menu appears.
3. Click on Auto Style to change the current automatic dimension settings.
4. Click on Only Points to search and dimension to points only.
5. Click on Layer Search to enable layer searching. All of the layers will be searched for points to dimension.
6. Click on Miss Dist. to set the distance to look for snap points. 7. Click on 1” and right-click or type .1 and press (Enter).
8. Right-click to exit the Auto Style menu and return to the Linear menu.
9. Click on Horizontal to draw horizontal dimensions.
10. Click on Auto Dim. You are prompted to Select first endpoint of line to dimension along.
11. Move the cursor to the bottom left corner of the exterior wall and click the middle mouse button or press (N) on the keyboard. You are prompted to Select second endpoint of line to dimension along.
12. Move the cursor to the bottom right corner of the exterior wall and click the middle mouse button. You are prompted with Dimension which side of line?
13. Move the cursor below the bottom wall and click. The dimension string is drawn automatically.
14. Right-click to return to the Linear menu.
15. Click on Overall to place an overall dimension. The front wall is dimensioned. (See Figure 4.13)
16. Right-click three times to return to the Edit menu.

**Figure 4.13:** The front wall is dimensioned

**Stretching Dimensions**

- To stretch dimensions:
  1. Click on Stretch in the Edit menu. You are prompted to *Select the first point of distance to stretch*.
  2. Click anywhere on the drawing window to locate the first point of the distance to stretch. You are prompted to *Select the second point of distance to stretch*. 
3. Press (Spacebar). You are prompted to Enter relative distance.
4. Type 1.6 and press (Enter). You are prompted to Enter relative angle.
5. Type 270 and press (Enter). The distance and angle to stretch appear in the Attention toolbar.
6. Click on Area as the selection method. You are prompted to Select first corner of box to <STRETCH>.
7. Make sure Layer Search is on.
8. Click outside the upper-left corner of the plan.
9. Drag the mouse diagonally until the rubber band box encloses the rear wall and part of the left and right walls. (See Figure 4.14)
10. Click to close the rubber band box. The walls are shortened by 1’-6” and the dimensions are automatically adjusted.

![Figure 4.14: Stretching the rear wall](image)

11. Click on Invert to stretch the same distance in the opposite direction. The new angle appears in the Attention toolbar. You are prompted to Select first corner of box to <STRETCH>. You can use Invert for most editing commands. It uses the inverse of the defined angle.
12. Repeat steps 8 - 10 to return the wall to its previous shape.
Figure 4.15: The plan is dimensioned

13. Right-click to return to the Edit menu.
14. Press (Ctrl) + (S) to save the drawing.

You have dimensioned the schoolhouse plan. Floor plans for construction of a real building would require more dimension lines as well as lines from many different angles. You can use DataCAD LT to create them all.

**Hatching the Schoolhouse Drawing**

_Hatching_ is adding lines to your drawing that are in patterns, such as square boxes that represent floor tile, for example. As you will soon find out, there are many hatch patterns to choose from.

➔ To set up to draw a tile hatch pattern:

1. Press (Tab) until the Hatch layer is the active layer in the Status Panel toolbar.
2. Click on Hatching in the Utility menu.
3. Click on Associative to toggle associative hatching on. This creates the entire hatch as a single entity. See “Drawing Associative Hatch” in the “Hatch” chapter for details.

4. Choose Pattern to set the type of hatch pattern. You are prompted to Enter hatch pattern name. A preview window appears.

5. Move the cursor over the buttons in the Menu Window. Notice the different patterns displayed in the preview window.

6. Choose Scroll Fwrd three times to scroll to the end of the list.

7. Choose 12x12til for a 12” x 12” tile pattern.

8. Choose Scale to set the scale of the pattern. You are prompted to Enter hatch scale (1 to 9999).

9. Type 1 and press (Enter).

10. Choose Angle to set the angle of the pattern. You are prompted to Enter hatch angle.

11. Type 0 and press (Enter).

To draw a tile hatch pattern:

1. Click on \(\text{Zoom Window}^{\text{Zoom Window}}\) from the Navigation Pad toolbar to go to the Zoom menu. You are prompted to Select first corner of the Zoom window.

2. Click below and to the left of the exterior wall. You are prompted to Select second corner of the Zoom window.

3. Drag the mouse diagonally until the rubber band box encloses the lower half of the plan and click. The plan now appears larger.

4. Right-click to return to the Hatching menu.
5. Click on Origin to start the hatch pattern at a defined point. You are prompted to Select hatch pattern origin.

6. Move the cursor to the lower-left corner of the hall and click the middle mouse button.

7. Click on Boundary to define a boundary for the hatch. You are prompted to Select first point on boundary to hatch to.

8. Use object snapping to select points for the hatch boundary. To select the first point of the boundary, move the cursor to the lower-left corner in the hall and click the middle mouse button. You are prompted to Select next point on boundary to hatch to. For more information on object snapping, see “Object Snapping” in the “Drawing Tools” chapter.

**Shortcut:** Press (N) to object snap to a point.

9. Move the cursor upward and click the middle mouse button to object snap to the corner marked A with. (See Figure 4.17)

10. Move the cursor close to the corner marked B and click the middle mouse button to object snap to that point.

11. Move the cursor close to the corner marked C and object snap to that point.

12. Right-click to close the hatch boundary. Right-click to return to the Hatching menu.

![Figure 4.17: Selecting a hatch boundary](image)

13. Click on Begin to draw the hatch pattern. The pattern will fill the boundary you defined in the previous steps.

14. Click on to recalculate the extents of the drawing.

15. Right-click to return to the Utility menu.

16. Press (Ctrl) + (S) to save the drawing.
You have now created a hatch pattern and saved your updated drawing file.

**Adding Symbols to the Schoolhouse**
Symbols are one of the most powerful features of DataCAD LT. You can build symbol libraries from the drawings you create and reuse them in other drawings. The symbols can be sections, details, notes, furniture, fixtures, or any part of a drawing that will be drawn repetitively.

**Opening a Symbol Folder**

To open a symbol folder:

1. Click on in the Navigation Pad toolbar to open the Zoom menu. You are prompted to *Select first corner of the Zoom window*.
2. Click at the lower-left corner of the exterior wall. You are prompted to *Select second corner of the Zoom window*.
3. Drag the mouse diagonally until the rubber band box encloses the lower half of the plan and click. The plan is now displayed larger.
4. Make sure the Symbol Browser toolbar is displayed. If it isn’t, just select Symbol Browser from the View pull-down menu or use the shortcut (Ctrl) + (T).
5. Click on in the Symbol Browser and select Folder from the drop-down options. The Browse dialog box appears, listing the contents of your DataCAD LT\Symbols folder.
6. Double-click on the Plumbing folder to list the plumbing fixture symbols subfolders.
7. Click on the Commercial folder. The symbols contained in this folder appear in your Symbol Browser. Each box in the browser contains a symbol. Then click on OK to close the Browse dialog box so you can use the plumbing symbols in your drawing.
8. Move the cursor over the symbols; as you move the cursor over a symbol, a description of it appears in the Coordinates/Hints toolbar.
Selecting and Placing Symbols

> To select and place symbols:

1. Press (Tab) until Plumb is the active layer in the Status Panel toolbar.

2. Click on \( \text{ Rotate } \) in the Symbol Browser toolbar to display the Options drop-down menu. Then click on Rotate and make sure a check appears in front of it to toggle dynamic rotation on. This lets you preview a symbol's position before you place it in the drawing.

3. Move the cursor over the toilet with grab bar on the right. You will see

   ![Coordinates/Hints toolbar](image)

   in the Coordinates/Hints toolbar. Click to select the symbol.

4. Move the cursor into the Drawing Area. A boxed outline representing the toilet and grab bars is now attached to your cursor. The insertion point is at the upper-left corner of the symbol, the point the cursor is connected to. Remember, you can use the arrows on the keyboard to pan around your drawing.
5. Position the cursor near the upper-right corner of the room that is in the lower-right corner of the plan and click the middle mouse button. This is the insertion point and the center of rotation for the symbol. If you move your cursor slightly up or down, you will see the boxed outline rotate around the insertion point.

6. Position the cursor near the lower-right corner of the bathroom and click the middle mouse button. The toilet with grab bars is drawn. If you place the toilet incorrectly, click on Undo Place Symbol in the Edit pull-down menu to delete it and then place the toilet again.

![Figure 4.20: Placing the toilet on your plan](image)

7. Right-click to cancel the toilet symbol.

![Figure 4.21: The toilet and grab bars are placed on the drawing](image)

8. Move the cursor over the WALL-HUNG SINK (probably the top left symbol in the Symbol Browser toolbar) and click on it to select it.

9. Move the cursor into the Drawing Area. A boxed outline representing the sink is now attached to your cursor. The insertion point for this symbol is in the back center of the sink.

10. Position the cursor at the center point, between the window and hallway wall, as shown in Figure 4.22. Click the middle mouse button.
10. Click the middle mouse button to define the insertion point for the sink.

Figure 4.22: Placing the sink in your drawing

11. Rotate the symbol by dragging the cursor away from the insertion point and clicking when it is in place. The sink is drawn. If you place the sink incorrectly, click on Undo Place Symbol in the Edit pull-down menu to delete it and then place the sink again.

Figure 4.23: The sink is drawn

12. Right-click to cancel the sink symbol.

13. Press (Ctrl) + (S) to save the drawing.

**Selecting Another Symbol File**

To select another symbol file:

1. Click on [ ] in the Symbol Browser toolbar and select Folder from the drop-down menu. The Browse dialog box appears so that you can select another symbol folder.

2. Double-click on the Kitchen folder to view a list of Kitchen subfolders.

3. Click on Equipment folder in the Browse dialog box and click on OK. The kitchen equipment symbols appear in the Symbol Browser toolbar.

4. Select the bar sink (upper left in the Symbol Browser toolbar) and place it as shown in the figure below. Refer to the previous section if you need help placing this sink.
Place the kitchen sink, and rotate into place.

Figure 4.24: The kitchen sink is drawn

5. Right-click to go to the Edit menu.

**Copying Symbols**

➢ To copy symbols:

1. Click on Copy in the Edit menu in the Menu Window. You are prompted to Select first point of the distance to copy.

2. Move the cursor to the upper-right corner of the bathroom you just placed fixtures in and click the middle mouse button to define the first point to copy from. You are prompted to Select second point of distance to copy.

3. Move the cursor to the upper-right corner of the room directly above the bathroom and click the middle mouse button. The distance and angle you just defined appear in the Attention toolbar.

Figure 4.25: Defining a distance to copy

4. Click on Area if it’s not already active. You are prompted to Select first corner of area to <COPY>.

5. Click on Layer Search to toggle layer searching off and search only the active layer for items to copy.

6. Click at the lower left of the bathroom sink. You are prompted to Select second corner of area to <COPY>.

7. Drag the mouse diagonally to the upper right of the toilet and grab bars, until the area box encloses all bathroom fixtures and their insertion points.

8. Click to close the box. The sink, toilet, and grab bars are copied into the other bathroom.
To draw a title block and border:

1. Press (Tab) until Border is the active layer in the Status Panel toolbar.
2. Press (=) to toggle the Walls option off. Note the w in SwOTHLUDFB in the Status Panel toolbar is now lowercase.
3. Click on Polygons in the Edit menu in the Menu Window.
4. Click on Rectangle to draw a rectangle.
5. Move the cursor to the lower-left corner of the drawing where you want the border to start and click. If necessary, press (PageUp) once to zoom out and give yourself more space to work around your drawing.
Click the left mouse button to define the first corner of the border.

Figure 4.28: Creating a border

6. Press (Insert) until the prompt in the Attention toolbar reads *Current input mode = relative Cartesian (x, y).*

7. Press (Spacebar). You are prompted to *Enter relative X-distance.*

8. Type 80 and press (Enter). You are prompted to *Enter relative Y-distance.*

9. Type 60 and press (Enter). The border is drawn.

10. Right-click to return to the Edit menu.

11. Click on ![icon] to view the extents of the drawing.

**Moving the Border**

To move the border:

1. Click on Move in the Edit Menu.

2. Click on Drag.

3. Click on Group. You are prompted to *Select group to <MOVE>.*

4. Move the cursor to the center of the rectangle you just created and click the middle mouse button. The rectangle appears in dashed lines to indicate its selection. You are prompted to *Select the point to drag from.*

5. With the cursor still at the center of the rectangle, click the middle mouse button. Notice that you can now move the border by moving the mouse.
6. Press (O) to turn off ortho mode. This allows free movement when you place the border. Note the “o” in SwoTHLUDFB in the Status Panel toolbar is now lowercase.

7. Use (PageUp) or (PageDown) for a better view if you need to, then move the border over the floor plan so the plan appears centered within it.

8. Click to set the border into place.

9. Right-click twice to return to the Edit menu.

10. Click on to recalculate the extents of the drawing.

Figure 4.29: The border is placed

**Drawing a Title Block**

To draw a title block:

1. Click on Copy in the Edit menu. You are prompted to *Select first point of the distance to copy.*

2. Move the cursor to the lower right corner of the border and click the middle mouse button. You are prompted to *Select second point of the distance to copy.*

3. Press (Spacebar). You are prompted to *Enter relative X-distance.*

4. Type -5 and press (Enter). You are prompted to *Enter relative Y-distance.*

5. Type 0 and press (Enter). The distance and angle to copy appear in the Attention toolbar.

6. Click on Entity in the Menu Window. You are prompted to *Select entity to <COPY>.*

7. Select the right vertical line of the border by clicking on it. The line is copied.

8. Right-click to return to the Edit menu.

10. Move the cursor to the lower right outside corner of the border and click the middle mouse button to set a new reference point.

![Diagram](image.png)

**Figure 4.30:** Completing the title block

11. Press (Spacebar). You are prompted to *Enter relative X-distance*.

12. Type 0 and press (Enter). You are prompted to *Enter relative Y-distance*.

13. Type 5 and press (Enter). You connect to a point on the right line of the border.

14. Press (Spacebar). You are prompted to *Enter relative X-distance*.

15. Type -5 and press (Enter). You are prompted to *Enter relative Y-distance*.

16. Type 0 and press (Enter). A line is drawn.

17. Right-click to disconnect from the line and return to the Edit menu.

18. Click on Move in the Edit menu.

19. Click on Drag.

20. Click on And Copy. You are prompted to *Select entity to <MOVE>*.

21. Select the line you just drew by clicking on it. The line becomes dashed. You are prompted to *Select the point to drag from*.

22. Select an end point of the dashed line with the middle mouse button.

23. Press (O) to toggle ortho mode on.

24. Move the cursor upwards and click to place the line in a few different locations to section off the title block, as in Figure 4.31.

25. Right-click three times to return to the Edit menu. The title block is drawn.
26. Press (Ctrl) + (S) to save the drawing.
Tutorial: Printing a Drawing

DataCAD LT has many options available for plotting or printing your drawing. This chapter will focus on printing your plan on an 8 1/2” x 11” sheet of paper.

In this chapter:

- Printing the schoolhouse drawing
- Setting printing options
Printing the Schoolhouse Drawing

If you are not in DataCAD LT, start DataCAD LT now. Choose the drawing you worked on in the previous tutorials. Before plotting the schoolhouse floor plan, make sure:

- a printer or plotter is either connected to your computer or available via a network connection
- the printer or plotter is turned on and is online or ready to receive data
- you have the corresponding Windows driver for your printer installed on your computer (see your printer’s manual for more information about installing a printer driver)

To plot the schoolhouse:

1. Choose Print from the File pull-down menu in the Menu Bar or choose Print/Plot from the Utility menu in the Menu Window. The following message appears:

   Since this is the first time you’ve printed this drawing, DataCAD LT requires you to choose a printer, paper size, and orientation before you assign pens, complete a print layout, and plot your drawing. To accept the default settings, click OK and skip to step 5; otherwise, continue with step 2 below.

   ![Figure 5.1: The Print/Plot menu](image)

   - **Print/Plot**: Prints the current drawing layout
   - **To File**: Accesses the Pen Table dialog box
   - **Scale**: Calls up a multi-scale plotting sheet
   - **Scale To Pen**: Accesses the Printer/Plotter Settings dialog box
   - **Pen Table**: Exit
   - **Pen Width**: Exit
   - **Partial**: Exit
   - **Quick Layout**: Exit
   - **Rotate**: Exit
   - **Save Settings**: Exit
   - **Load Settings**: Exit
   - **Preview**: Exit
   - **Sheet**: Exit
   - **Setup**: Exit
   - **3D Views**: Exit

2. Choose a printer from the Printer Name drop-down box in the Printer/Plotter Settings dialog box.
3. Choose a paper size. The sizes available are read from your printer driver. If a size you want is not displayed in the drop-down box, your printer may not support it. Choose the closest appropriate size, or use the User-Defined option if available, or use a different printer.

4. Click OK to close the Settings dialog box. The Print/Plot menu appears. You can exit DataCAD LT and open the printer driver to see the supported paper sizes. Many times, the default settings of the driver do not include all supported sizes. You must check them to activate them.

5. Choose Scale to set the plotting scale. The current plotting scale appears in the Message Window.
6. Choose 1/8" if it's not already the current plotting scale.
7. Choose Quick Layout from the Print/Plot menu. A dashed box appears representing the 8 1/2" x 11" sheet. If you move the cursor over the Drawing Window, you will find a movable copy of this box. You are prompted to Locate sheet of paper using cursor, “ENTER” to end.
8. Center the box over the drawing and click the middle mouse button. This object snaps to the center of the title block (the centered point of the rectangle) and centers the title block. You can also move the box anywhere you want and click with the left mouse button.
9. Choose Print/Plot to see a preview copy of the plot.
10. Click on Plot to send the drawing directly to the plotter or printer. The schoolhouse floor plan is plotted.
Printing Options
There are many printing options that help you get the plotted output you want.

Assigning Pens
Use Pen Assignments in the Pen Table dialog box to set a hierarchy of line weights, which help add line definition to your drawings. For example, if your walls were a heavier line weight than your doors and windows, the door and window openings would appear clearer. This difference in line weight helps define the content of your drawing.

To set the pens for printing the schoolhouse drawing:

1. Choose Print/Plot.
2. Choose Pen Table to open the Pen Table dialog box. In the Pen Assignments section, you will assign pen numbers to match the colors used in the drawing. You’ll notice that the first color in the Pen Assignments list box is highlighted.

The Pen Table dialog box also includes a Pen Settings section that allows you to choose the pen width, color, and color density for each pen you assigned in the Pen Assignments portion of the dialog box. See “Using Pen Tables” in the “Printing Your Drawing” chapter for detailed information on using the Pen Table.
3. Select White in the Pen Assignments box if it's not already highlighted. Notice that just below this list box is a small box displaying the highlighted color, followed by a number in a small input box. This number is the pen that will be used to plot all white lines in your drawing.

4. Type 1 in the input box. The color white is now set for pen number 1.

5. Select Red in the Pen Assignments box or press (Down Arrow) to highlight Red.

6. Type 3 in the input box. The color red is now set for pen number 3.

7. Set the remainder of the colors: for Green use pen 1, for Cyan use 3, for Magenta use 3, for Brown use 4, for Lt. Grey use 4, for Lt. Red use 2, for Lt. Green use 3, and for Yellow use 2.

8. Click OK to save the pen assignments and close the Pen Table dialog box.

9. Right-click to return to the Utility menu.
This chapter guides you through some of the more commonly used macros to help you complete the schoolhouse. In order to keep this exercise simple and to help you understand a little about 3D spatial relationships, you will work in orthographic (plan) view and then use the 3D Views menu to view your work.

In this chapter:

- Adding 3D windows and doors
- Adding a roof
- Viewing the model in 3D
**Modeling the Schoolhouse**

You will create five new layers for the 3D items that you are going to add to the drawing. This enables your drawing file to contain both your plan drawings (used for construction documentation) and 3D drawings (used to present your designs).

If you are not in DataCAD LT, start DataCAD LT now.

To add layers to your drawing:

1. Choose the drawing file that you worked on in the previous chapters.
2. Add five new layers to your drawing file.
3. Name the new layers: 3DWalls, 3DDoors, 3DWindows, 3DRoof, and 3DMisc.
4. Go to the Layers menu.
5. Turn off Doors, Windows, Plumb, Dim, Hatch, Notes, Misc, and Border.
6. Press (Esc) on the keyboard to refresh the drawing display.
7. Zoom in on the lower half of the plan.

**Adding Windows**

You will work with the walls, doors, and windows that you have already placed in your drawing. Do not erase them; they are an essential part of your drawing file.

To add windows:

1. Make the 3DWindows layer the active layer.
2. Click on the Toolbox pull-down menu. If AEC_MODL is not one of the options, click on Configure, click on AEC_MODL, click on Add. This makes the AEC_MODL macro appear in the Toolbox pull-down menu. Click on OK to close the Configure DataCAD LT Settings dialog.
3. Choose AEC_MODL from the Toolbox pull-down menu. You are prompted to Select building component to model.
4. Choose Windows to go to the WindPlan menu.
5. Choose In Plan to draw the windows in plan view.
6. Choose UnitType. You are prompted to Select type of window unit.
7. Choose DblHung to draw double-hung windows.
8. Return to the WindPlan menu.
9. Choose Glass to go to the Glass menu.
10. Choose PaneHorz to define the number of glass panes (divisions) across the window. You are prompted to supply the Number of panes in the horizontal direction.
11. Choose 3.
12. Choose PaneVert to define the number of glass panes top to bottom in the window. You are prompted to supply the Number of panes in the vertical direction.
13. Choose 2.
14. Return to the WindPlan menu. You are prompted to Enter a point on first inside corner of window.

15. Click the middle mouse button on an inside corner of the front window opening in the office. You are prompted to Enter a point on second inside corner of window.

16. Click the middle mouse button the other inside corner of the window opening. You are prompted to Enter a point on outside surface of wall.

17. Click the middle mouse button on the outside of the wall. The window is created.

18. Repeat steps 15 - 17 to create the remaining windows. Remember that you can use the arrow keys on the keyboard to move around the drawing.

19. When you are finished placing windows, return to the AEC_MODL menu.

**Adding 3D Doors**

To add doors:

1. Make 3DDoors the active layer.

2. Choose Doors from the AEC_MODL menu to go to the DoorPlan menu. You are prompted to Enter a point on first inside corner of door.

3. Move the cursor to an inside corner of the door opening in the office and click the middle mouse button. You are prompted to Enter a point on second inside corner of door.
4. Move the cursor to the other inside corner of the door and click the middle mouse button. You are prompted to \textit{Enter a point on outside surface of wall}.

5. Move the cursor to the outside corner of the wall and click the middle mouse button. The first door is created.

6. Choose Door. You are prompted to \textit{Select door data to change}.

7. Choose HingLft to change the hinge side of the front door to the left side.

8. Return to the DoorPlan menu.

9. Repeat steps 3 - 5 for the remaining doors.

10. Return to the Edit menu.

11. Recalculate the extents of the drawing.

There are many other options you can use when placing doors and windows.
**Viewing the 3D Model**

Choose Isometric from the View menu on the Menu Bar. You will learn more viewing techniques later in this chapter.

![Figure 6.5: An isometric view of the schoolhouse walls, windows, and doors](image)

**Adding a 3D Roof**

As mentioned throughout this book, layers allow you more control over your drawing. Later in this section of the Tutorial you will use these different layers to switch between viewing construction plans and presentation graphics.

1. To add a roof:
   1. Change to the 3D Roof layer.
   2. Change the color of the 3D Roof layer to Magenta.
   3. Click on the Toolbox pull-down menu. If ROOFIT is not one of the available options, click on Configure, add it to the list of available macros, and close the dialog box.
   4. Choose ROOFIT from the Toolbox pull-down menu to go to the RoofIt menu.
   5. Choose Gable to create a gable roof.
   6. Choose Settings.
   7. Set the wall thickness to 1 foot.
   8. Return to the RoofIt menu. You are prompted to *Pick the 1st point of roof boundary.* It is important to select the points of the roof boundary in a clockwise direction to ensure that the roof will be placed correctly.
   9. Select the lower-left corner of the exterior wall with the middle mouse button. You are prompted: *Enter second point of roof length.*
   10. Select the upper-left corner of the exterior wall with the middle mouse button. You are prompted: *Enter second point of roof width.*
   11. Select the upper-right corner of the exterior wall with the middle mouse button. The roof appears on top of the walls.
   12. Return to the Edit menu.
   13. Choose Isometric from the View menu on the Menu Bar to view the drawing in isometric.
Figure 6.6: An isometric view of the schoolhouse with the new roof

**Finishing the Schoolhouse Drawing**

Notice that in the isometric view, portions of the wall above and below the windows are missing. You will fix them in the next exercise, but these wall segments are going to be put on a different layer than the existing Walls layer. Later in this chapter, you will see the reason for having two wall layers.

To finish the drawing:

1. Choose Plan from the View pull-down menu or click on ![Plan View](image) in the Projection Pad toolbar to see the schoolhouse in plan view.
2. Choose Layers from the Utility menu in the Menu Window.
3. Make 3DWalls the active layer, with only the Walls layer turned on. All other layers should be off.
4. Change the 3DWalls layer color to yellow.
5. Go to the Architect menu and toggle the Walls option on.
6. Toggle the 2-line wall option on.
7. Set a new wall width of 1 foot.
8. Toggle Outside on.
9. Toggle Cap off, if it is on.
10. Press (Z) on the keyboard. You are prompted to *Enter new Z-base*.
11. Type 0 and press (Enter). You are prompted to *Enter new Z-height*.
12. Type 3.4 and press (Enter). You have just established a new 3D setting for all new items you draw. All lines will now be drawn with a Z-base of 0 and a Z-height of 3’-4”.
13. Zoom in on the lower half of the plan.
14. Return to the Edit menu. You are prompted to *Select first end point of new line/wall*.
15. Move the cursor to an outside corner of the window opening in the office and click the middle mouse button. You are prompted: *Select next end point of line/wall.*
16. Move the cursor to the other outside corner of the window and click the middle mouse button. You are prompted: Select a point to define the Inside of the wall.

17. Move the cursor anywhere on the inside of the plan and click. The cutout is filled.

18. Right-click to disconnect from the wall you just drew.

19. Repeat steps 15 - 18 for the remaining exterior window openings. Be sure to disconnect from each wall segment you draw, before drawing the next. Remember to use the arrow keys on the keyboard to move around the drawing.

20. Press (Z) on the keyboard. You are prompted to Enter new Z-base.

21. Type 6.8 and press (Enter). You are prompted to Enter new Z-height.

22. Type 8 and press (Enter). You have just established a new 3D setting for all new items you draw. All lines will now be drawn with a Z-base of 6.8 and a Z-height of 8'-0".

23. Repeat steps 15 - 18 to fill in over top of the sills to create window headers. You are prompted to Select first end point of new line/wall.

24. Click the middle mouse button at the outside corner of the front door opening. You are prompted to Select next end point of line/wall.

25. Move the cursor to the other outside corner of the door and click the middle mouse button. You are prompted to Select a point to define the Inside of the wall.

26. Move the cursor anywhere on the interior of the plan and click. The door header is drawn.

27. Press (=) on the keyboard. The Attention toolbar reads Walls will NOT be drawn.

28. Press (=) again. You are prompted to Enter new wall width.

29. Type .4 and press (Enter). You are now set to draw the headers above the interior doors.

30. Move the cursor to an outside corner of the interior door opening in the office.

31. Repeat steps 24 - 26 to complete this header and the remaining interior headers.

32. Choose Isometric from the View pull-down menu on the Menu Bar to see the isometric view.

33. Toggle the 3DDoors, 3DWindow, and 3DRoof layers on.

34. Return to the Utility menu.
35. Recalculate the extents of the drawing.

**Viewing Your Drawing in 3D**
Perhaps one of the most exciting features of DataCAD LT is that everything you draw has 3D parameters.

➢ To change your view:
1. Choose 3D Menus from the Edit menu and click on 3D Views to go to the 3D Views menu.
2. Choose Isometric. If your drawing is not centered choose from the Navigation Pad toolbar. The lines that you drew earlier now appear in 3D.
3. Return to the Edit menu.
4. Choose Plan from the View pull-down menu in the Menu Bar to view your drawing in plan view.
5. Choose Isometric to view the isometric view.
6. Choose Plan to view your drawing again in plan view. Switching between 2D and 3D helps you better understand what you are drawing.
7. Press (Ctrl) + (S) on the keyboard to save the drawing.

**Advanced 3D Viewing**
Throughout this tutorial, you moved around the drawing using a few of DataCAD LT’s different viewing methods. One of the most exciting features of DataCAD LT is viewing your work in 3D. This section steps you through a few viewing exercises of 2D (orthographic or plan) and 3D.

➢ To use advanced viewing techniques:
1. Choose GoTo View from the Utility menu.
2. Choose 3D Menus and then click on 3D Views.
Each time you start a new drawing, the Parallel and Perspective options in the 3D Views menu do not do anything. They become active after you set the viewing parameters for each button. When you selected Isometric when working with hatch earlier in the tutorial, you could choose Plan and Parallel and view 3D Views. If you chose Perspective, nothing happened.

**Perspective Viewing**

- To create a perspective view:
  1. Press (PageUp) twice to zoom out.
  2. Choose Set Persp. from the 3D Views menu. You are prompted to Select position of eye point for perspective view.
  3. Click at the lower left corner of the screen. A perspective view of the schoolhouse appears.
4. Choose Walk Through from the 3D Views menu. This displays a menu used for moving around the 3D model. You can also use the Viewer toolbar (select Toolbars from the View pull-down menu, then make sure Viewer is checked in the Toolbars dialog box) to display options for walking through perspective views.

5. Choose Walk Back. You just stepped away from the model.

6. Experiment with a few of the other options in this menu.

7. Exit the 3D menu and choose Plan from the View pull-down menu on the Menu Bar to view the drawing in plan.

8. Choose Perspective from the View pull-down menu on the Menu Bar to view the perspective again.

9. Choose Isometric from the View pull-down menu on the Menu Bar to view the isometric.

10. Choose Plan from the View pull-down toolbar to view the plan view again.

Once you establish the viewing options, all of these options display a different image of the drawing. This is an easy way to change the view of a drawing during any stage of a project.

**Hidden Line Removal**

As you become more experienced with DataCAD LT, you will be adding more complex 3D elements to the drawing. The more you add to a drawing, the harder it can be to understand a 3D view. The Hide option in the 3D Menus menu is used to hide the lines in your model that would not be visible if it were an actual building. This 3D view can be saved as a layer and edited.

To hide lines in your model:

1. Choose 3D Menus from the Edit menu to enter DataCAD LT's 3D menus: 3D Menus, 3D Views, and 3D Entity.

2. Choose Perspective from the View pull-down menu on the Menu Bar to display the perspective of the schoolhouse.

3. Choose Hide.

4. Choose Begin. The hidden line removal generates a new image without most of the unwanted lines.
5. Wait until the hidden line removal is finished, then choose New Layer. You are prompted to Enter name of new layer to be added.

6. Type Hide1 and press (Enter). You are asked Do you want the new layer ON or OFF?

7. Choose Off. You will toggle this layer on later in the chapter. The hidden line removal is complete and you have added a new layer to the drawing.

8. Choose Plan from the View pull-down menu to see the schoolhouse in plan view.

9. Choose Layers from the 3D Menus

10. Select Active Only from the Layers menu.

11. Choose Hide1. You’ll notice that there are still a few lines visible that should not be there, such as the vertical lines above and below windows and doors. You can erase these lines from this view without adversely affecting your drawing.

12. Choose Erase from the 3D Menus menu.

13. Choose Entity as the selection method for erasing lines.

14. Use your mouse to select any lines on the perspective that should not be there.

15. Return to the Utility menu. If you choose Perspective from the View pull-down menu on the Menu Bar, you will see that the image is flat. This is because the hidden line removal created a flat line drawing from the perspective. This drawing has no connection to the original 3D model.

Figure 6.10: The perspective view after a hidden line removal

16. Choose GoTo View.

17. Choose 3DPlan.

18. Choose Plan to see the schoolhouse in plan view.

Creating Elevations

This section shows you how to create elevations from the work you have already completed. You will use the same procedure discussed in the Hide section for creating your elevations.

To create elevations:

1. Choose Elevation from the View pull-down menu; then select Front to display the front elevation of the schoolhouse. Alternatively, click on in the Projection Pad toolbar

2. Recalculate the extents of the drawing.
3. Choose 3D Menus from the Edit menu.
4. Choose Hide.
5. Choose Begin. The hidden line removal process generates a new image with everything behind the front wall not shown.

6. Wait until the hidden line removal is completed. Then choose New Layer. You are prompted to Enter name of new layer to be added.
7. Type FrntElev and press (Enter). You are asked Do you want the new layer ON or OFF?
8. Choose Off. You will turn this layer on later in the tutorial. The hidden line removal is complete and a new layer has been added to the drawing.
9. Choose Plan from the View pull-down menu.
10. Choose 2D Menus to return to the Edit menu.
11. Choose Layers from the Utility menu.
12. Choose Active Only. You are prompted to Select layer to be the only layer on.
13. Choose Scroll Fwrd to view the end of the layer list.
14. Choose Elevation/Front from the View pull-down menu to display the schoolhouse front elevation.
15. Return to the Edit menu.
16. Recalculate the extents of the drawing.
17. Choose Erase from the Edit menu.
18. Choose Entity as the selection method for erasing lines.
19. Select any lines on the front elevation that should not be there.
20. Return to the Utility menu.

Experiment with a few symbols, hatch patterns, etc.

Figure 6.13: The schoolhouse elevation with symbols and hatch

This completes the DataCAD LT Tutorial. For additional instruction, please contact DATACAD LT LLC for information on training materials and support options or visit us online at www.DataCAD LT.com.
Before You Draw

There are many settings that you can use to customize how you’ll draw in DataCAD LT. You can keep track of time spent on a drawing and enter other administrative information directly into the drawing. The Settings menu has a variety of options to customize your work session, including setting scale and angle types, creating drawing passwords, setting cursor accuracy, adjusting the time delay for creating autosave files, and editing the definitions of DataCAD LT’s scale, angle, and distance lists.

You can also set the size and angle of both the snap grid and the two display grids and choose whether the display grids are visible. And, perhaps most importantly, you can create and name new layers for your drawing, choose which of these will be displayed, assign different colors for each, and even save them to a separate file.

In this chapter:
- Setting the snap grid
- Setting the display grids
- Creating and naming new layers
- Moving between layers
- Setting the active layer
- Assigning colors to layers
- Entering project costing information
- Selecting the scale type and angle type
- Creating passwords
Managing Your Project

The Project Directory provides the basis for a comprehensive management system based on actual computer usage and application. You can use Directory to review and enter project information directly into the drawing file. You can also save the project information and time data to a text file and even purge unused symbol information from your drawing. Simply click on Directory in the Utility menu in the Menu Window or click on Directory in the Tools pull-down menu in the Menu Bar to display the Directory dialog box. Even if you delete a symbol from your drawing, the symbol’s name will still be listed in the Directory. To purge the names of all unused symbols from your drawing, click on Purge Symbols in the Directory dialog box.

In the Billing Rate, Department Number, Phase Number, and Service Number text input boxes, you can enter a number from 0 to 32,000. In the Project text input box, you can enter up to nine alpha-numeric characters; in the Employee text input box, you can enter up to seven alpha-numeric characters.

Figure 7.1: The Drawing Information dialog box

Setting Up Your Drawing Grids

There are three separate grids in DataCAD LT: a snap grid and two display grids. The snap grid controls cursor movement while drawing. The two display grids, used primarily for visual reference while drawing, are shown as a series of dots and help you create drawings quickly and accurately. Each layer in DataCAD LT has its own snap and display grids as well as grid origin and sizes. This lets you move quickly between layers without having to change grid sizes or toggle grids on or off.
Using the Snap Grid

Although the snap grid doesn’t display in the Drawing Area, it helps you draw more precisely. The snap grid causes the cursor to jump (or snap) from one point of the snap grid to the next as you move the mouse across the Drawing Area. See “Changing Grid Size,” “Setting the Snap Angle,” and “Setting the Grid Angle” later in this chapter for more information about the snap grid.

Look at the X and Y coordinate display in the Coordinates/Hints toolbar to see the exact coordinates of the cursor as you move it over the Drawing Area. With the snap grid toggled on, notice the coordinate display reflects the cursor’s “jumps” from one invisible snap point to the next across the snap grid. When you toggle the snap grid off, the cursor advances freely across the Drawing Area, without snapping to grid points.

➔ To toggle the snap grid on or off:
  1. Go to the Utility menu and click on Grids. The Grids menu appears.

  **Shortcut:** Press (G) or (Shift) + (G) to access the Grids menu.

  2. Click on Grid Snap.

  **Shortcut:** Press (X) to toggle the snap grid on or off. Note that the “S” in SWOTHLUDFB in the Status Panel toolbar appears in lowercase when snap grid is toggled off and uppercase when it’s toggle on.

Using the Display Grids

There are two display grids in DataCAD LT. One is a series of white dots in the Drawing Area, while the second display grid is a series of small yellow crosses. These grids are visual aids only and can’t be printed. The display grid colors are white and yellow by default. However, you can change these colors; see “Changing Display Grid Color” later in this chapter.

➔ To toggle display grid 1 on or off:
  1. Go to the Utility menu and click on Grids. The Grids menu appears.
  2. Click on Disp. Grid 1.

**Shortcut:** Press (]) to toggle Disp. Grid 1 on and off.

➔ To toggle display grid 2 on or off:
  1. Go to the Utility menu and click on Grids. The Grids menu appears.
  2. Click on Disp. Grid 2.

**Shortcut:** Press (]) to toggle Disp. Grid 2 on and off.

Changing Grid Size

The snap grid’s default setting is 4”, display grid 1’s is 4’-0”, and display grid 2’s is 16’-0”. You can change any or all of these grid sizes for each layer in your drawing. To change a grid size for another layer, simply change the active layer before following the step-by-step instructions in the next paragraph.

➔ To set the snap grid’s size for the active layer:
  1. Go to the Utility menu and click on Grids. The Grids menu appears.
2. Click on Grid Size in the Grids menu. The Grid Size menu appears.
3. Click on Set Snap in the Grid Size menu. A value menu appears.
3. Use the value menu to select a new value or click Custom; type a new snap grid value and press (Enter).

**Shortcut:** Press (S) to set the snap grid size.

➢ To set display grid 1’s size for the active layer:
1. Go to the Utility menu and click on Grids. The Grids menu appears.
2. Click on Grid Size in the Grids menu. The Grid Size menu appears.
3. Click on Set Grid 1 in the Grid Size menu. A value menu appears.
4. Use the value menu to select a new value, type a new display grid value, and press (Enter). For more information on using value menus, see “Value Menus” in “The Drawing Board” chapter.

➢ To set the display grid 2’s size for the active layer:
1. Go to the Utility menu and click on Grids. The Grids menu appears.
2. Click on Grid Size in the Grids menu. The Grid Size menu appears.
3. Click on Set Grid 2 in the Grid Size menu. A value menu appears.
4. Use the value menu to select a new value or click Custom; type a new display grid value and press (Enter).

You can use the Custom option to enter a new value for any of these grid settings. For more information on how to use the Custom option, see “Value Menus” in “The Drawing Board” chapter.

**Changing Display Grid Color**

You can change the color of both of the display grids; however, this setting is global, meaning the colors will change on every layer in your drawing. You can’t set separate grid colors on each layer.

➢ To change the color of display grid 1:
1. Go to the Utility menu and click on Grids. The Grids menu appears.
2. Click on Grid Color in the Grids menu. The Grid Color menu appears.
3. Click on Set Grid 1 in the Grid Color menu. A color menu appears.
4. Choose a new color from the Grid Color menu. For more information on using color menus, see “Color Menus” in “The Drawing Board” chapter.

➢ To change the color of display grid 2:
1. Go to the Utility menu and click on Grids. The Grids menu appears.
2. Click on Grid Color in the Grids menu. The Grid Color menu appears.
3. Click on Set Grid 2 in the Grid Color menu. A color menu appears.
4. Choose a new color from the Grid Color menu.
Setting the Snap Angle

The snap angle is the angle increment that you can draw lines at when ortho (plan) mode is on. When you’re drawing a line or wall, once you click to place the first end point, you can move the cursor around that point. Notice though that your cursor jumps (or snaps) in increments around that first end point. These increments are set with the snap angle. With the snap angle set to 4, your cursor moves in 90° increments. If you change the setting to 36, the cursor snaps to 10° increments. If you toggle ortho (plan) mode off, your cursor will move freely and you’ll be able to draw at any angle.

**Shortcut:** Press (O) to toggle ortho (plan) mode on or off. The “O” in SWOTLUDFB in the Status Panel toolbar will display as lowercase when ortho (plan) mode is off and uppercase when ortho (plan) mode is toggled on.

- To set the snap angle:
  1. Go to the Utility menu and click on Grids. The Grids menu appears.
  2. Click on Snap Angle in the Grids menu. A value menu appears.
  3. Use the value menu to set a new snap angle or type a new value and press (Enter). The maximum setting for the snap angle is 36.

Setting the Grid Angle

Rotating the snap grid and both display grids can make it easier to draw in some situations. The Angle option will rotate all three grids. You can’t rotate each grid separately.

- To rotate all three grids:
  1. Go to the Utility menu and click on Grids. The Grids menu appears.
  2. Click on Angle in the Grids menu. A value menu appears.
  3. Choose or type a new angle value (from 0° to 90°) and press (Enter).

- To rotate the grids to the same angle as an entity in your drawing:
  1. Go to the Utility menu and click on Grids. The Grids menu appears.
  2. Click on Angle in the Grids menu. A value menu appears.
  3. Click on Match: in the Angle menu.
  4. Click on an entity to match its angle; the angle of this entity appears in the Attention toolbar. Check the Attention toolbar as you choose different options; it will display the angle associated with each of the options in step 5.
  5. Decide which angle to use. To use this angle, right-click to exit the menu. To use the inverse of this angle, click on Invert. To use the complementary angle of the original angle, click on Complement. To use the supplementary angle of the original angle, click on Supplement. Click on Original to go back to the original angle.
  6. Right-click to return to the value menu and press (Enter) to accept the angle value. The grid rotates to the Angle setting.
Setting the Grid Origin
You can change the origin for the snap grid and both display grids on each layer or for all layers simultaneously. The grid origin is not the drawing origin, which is a fixed point. The grid origin is changed on all layers, whether they’re toggled on (and currently being displayed) or not.

➤ To change the grid origin on all layers in your drawing:
1. Go to the Utility menu and click on Grids. The Grids menu appears.
2. Click on Grid Origin in the Grids menu. The Grid Origin menu appears.
3. Look at the Grid Origin menu to make sure Set All is toggled on.
4. Click anywhere in the Drawing Area or use coordinate entry to set the new grid origin. The display grids realign themselves based on your new origin. For more information on using coordinate entry, see “Drawing Using Coordinate Entry” in “The Drawing Board” chapter.

To display the grids at their new origin, you may have to press (Esc) to refresh the Drawing Area. You can press (Esc) at any time while you work in DataCAD LT to refresh your drawing. Use object snapping to more precisely choose the point in your drawing for the new grid origin. See “Object Snapping” in the “Drawing Tools” chapter.

➤ To change the grid origin on the active layer only:
1. Go to the Utility menu and click on Grids. The Grids menu appears.
2. Click on Grid Origin in the Grids menu. The Grid Origin menu appears.
3. Look at the Grid Origin menu to make sure Set All is toggled off.
4. Click anywhere in the Drawing Area or use coordinate entry to set the new grid origin. The display grids realign themselves based on your new origin.
5. Change the grid origins on other layers in your drawing if necessary. Just press (Tab) to change the active layer and repeat steps 2 through 4.

Working With Layers
You can organize your drawing into groups (or layers) of related information to help increase your editing speed and productivity. By organizing the information on each layer according to type or content, you can display only the information that you need for the current drawing task. See “Planning Layers” and “Sample Project” in “The Drawing Board” chapter for an introduction to planning your layering system.
Creating Layers

When you create a new drawing, only one layer exists, named Layer001. But you can create up to 1,000 layers in every drawing, either one at a time or in groups.

Save time when you create new drawings by using a default drawing that contains all the layer names and settings you’d normally use. Your new drawings will automatically have all the layers in your default drawing and you can start drawing right away. See “Creating a New Drawing Using a Default Drawing” in “The Drawing Board” chapter.

⇒ To create layers in your drawing:

1. Go to the Utility menu and click on Layers. The Layers menu appears.

   **Shortcut:** Press (L) or (Shift) + (L) to access the Layers menu.

2. Click on New Layer in the Layers menu. A value menu appears.

3. Use the value menu to enter the number of new layers you’d like to create or type a value and press (Enter). The number of layers created appears in the Attention toolbar, along with the total number of layers now in your drawing.
More About Creating Layers

The active layer in your drawing acts as a seed layer for any new layers you create. When you create a new layer, it takes on the settings of the active layer. To save time and avoid redefining settings for each new layer, change the active layer to the layer in your drawing whose settings most closely match those you want your new layer to have.

Each layer has several independent settings that you can customize. These include grid size, grid angle, whether the snap grid is toggled on or off, whether ortho (plan) mode is toggled on or off, and layer color. See “Setting Up Your Drawing Grids” earlier in this chapter for more information on grid settings.

A seed layer is a layer that is used as a basis for subsequent layers. For example, you might have a basic perimeter plan of a multi-story building you’re drawing. This plan might contain the perimeter and bearing walls, the columns, the column centerlines, and the common core elements, each on a different layer. These layers could be used as seed layers for the partitioning layout on the third floor; in turn, that could be used as the seed layer for the reflected ceiling plan or HVAC layout for the third floor. Any layers you want to use as seed layers should be kept as generic and uncluttered as possible.

Setting the Active Layer

The active layer is the layer on which you’re currently drawing. To quickly check which layer is your active layer, check the Status Panel toolbar.

To change the active layer:

1. Go to the Utility menu and click on Layers. The Layers menu appears.
2. Click on Set Active in the Layers menu. A list of layers appears.
3. Click on a layer in the list to make it your active layer or type the layer name and press (Enter). The active layer changes and the active layer name is updated in the Status Panel toolbar.

Shortcut: You can also use the keyboard to change the active layer. Press (Tab) to scroll through all the layers in your drawing that are toggled on. To scroll backward through the layers, press (Shift) + (Tab). Notice the active layer name in the Status Panel toolbar changes as you scroll through the layers.

To change the active layer and simultaneously toggle all other layers off:

1. Go to the Utility menu and click on Layers. The Layers menu appears.
2. Click on Active Only in the Layers menu. A list of layers appears.
3. Click on a layer in the list to make it your active layer or type the layer name and press (Enter). The active layer name is updated in the Status Panel toolbar.

Displaying Layers

One of the most useful things about using layers in your drawings is that you can view only those layers that you need at any given time. For instance, you don’t need to see the site plan while you’re working on a reflected ceiling plan. In DataCAD LT, you simply toggle layers on to display them or off to hide them.

You can toggle certain layers on to view them in the Drawing Area. You can then use go-to-views to save that view of your drawing. See the “Viewing Your Model” chapter.
To toggle a layer on or off:

1. Go to the Utility menu and click on Layers. The Layers menu appears. The Menu Window displays up to 15 layer names at one time; when there are more than 15 layers in your drawing, options to scroll forward (Scroll Fwrd) and scroll backward (Scroll Back) through the list are available.

2. Click on On/Off in the Layers menu. A list of all the layers in your drawing appears.

3. Click on the layer you want to toggle on or off. You can’t toggle all layers off in DataCAD LT. If the active layer is the only one toggled on, you can’t toggle it off until you make a different layer active. If there’s at least one other layer toggled on besides the active layer, you can toggle the active layer off; the next layer in the list automatically becomes the active layer.

To toggle on all the layers in your drawing simultaneously:

1. Go to the Utility menu and click on Layers.

2. Click on All On in the Layers menu. In the Message toolbar, you are asked Are you sure you want to turn on all layers?

3. Click on Yes. All layers are toggled on.

More About Displaying Layers

Refresh speed should also be considered when you plan and create the layers in your drawing. While your computer’s speed determines the time it takes to refresh the display of your drawing, you can dramatically increase refresh speed using some of the Layers options.

Shortcut: There are many reasons why you may want to refresh the display of your drawing during your work session. Press (Esc) at any time to refresh your drawing.

As you toggle each layer on, DataCAD LT can automatically update (or refresh) your drawing in the Drawing Area. To do this, toggle the layer refresh option (Layer Ref.) on in the Layers menu. To quickly toggle several layers on without waiting for your drawing to refresh after each layer, make sure Layer Ref. is toggled off before you begin toggling layers on. After you’ve finished toggling layers on, press (Esc) to refresh the display of your drawing.

Each time you zoom in or out on your drawing or change the view (two things you’ll be doing frequently), DataCAD LT must refresh the display of your drawing to reflect the change. Since only those layers that are actually displayed are refreshed, toggling on only those layers that are necessary for your current drawing task will speed up refresh rates. This is one of the many reasons why planning and maintaining a good layer structure is important.

Additionally, controlling the number of entities on each layer will increase refresh rates. A drawing containing many layers with a few entities on each will refresh faster than a drawing containing a few layers with many entities on each. In other words, you can edit ten layers containing 100 lines faster than one layer containing 1,000 lines.

Locking Layers

You can lock a layer to prevent others from editing the entities on that layer. In the list of layers in the Menu Window, a line appears through the layer name of a locked layer.
You can’t modify the layer in any way when it’s locked. If you try to edit a locked layer, a message saying that no entities are selected appears in the Message Area. The layer lock status is saved with the layer when you export or import layers.

- To lock a layer:
  1. Go to the Utility menu and click on Layers. The Layers menu appears.
  2. Click on Lock in the Layers menu. A list of all the layers in your drawing appears in the Menu Window.
  3. Click on the layer you want to lock in the list or type the layer name and press (Enter). DataCAD LT draws a line through that layer’s name; if you make that layer the active layer, a small “X” appears over the layer color box in the Status Panel toolbar. The layer can’t be edited until it’s unlocked.

- To unlock a layer:
  1. Go to the Utility menu and click on Layers. The Layers menu appears.
  2. Click on Lock in the Layers menu. A list of all the layers in your drawing appears.
  3. Click on the layer you want to unlock in the list or type the layer name and press (Enter). The line through the layer name disappears; the layer can now be edited.

**Renaming Layers**

When you create new layers, DataCAD LT assigns generic names to the layers in numerical order, such as Layer001, Layer002, etc. You can either rename the layers when you create them or rename them at some other time. Layer names support extended characters.

- To rename an existing layer:
  1. Go to the Utility menu and click on Layers. The Layers menu appears.
  2. Click on Rename in the Layers menu. A list of layers in your drawing appears in the Menu Window.
  3. Click on the layer you want to rename.
  4. Type a new layer name (up to 88 characters) and press (Enter). You can use spaces; however, you cannot use the following characters in layer names: , . * + / \ [ ] ; : .

**Changing Layer Color**

You can assign a color to a layer, so that all new entities you create on that layer appear in that color. Assigning a different color to each layer gives you an easy way to tell at a glance what layer an entity is on. If you assign yellow to your Walls layer, all entities drawn on the Walls layer will display in yellow. By default, white is the color assigned to all layers.

When you change a layer’s color, entities already on that layer will not change to the new color. To change these entities’ colors, you must use the Change menu. For more information, see “Changing Entity Attributes” in the “Editing Drawings” chapter.

- To change the color assigned to a layer:
  1. Go to the Utility menu and click on Layers. The Layers menu appears.
2. Click on Color in the Layers menu. A color menu appears. See “Color Menus” in “The Drawing Board” chapter for more information on how to use them.

3. Click on a color in the list or use the color menu options Custom or Match to assign a new color to the layer.

**Shortcut:** To change the color of the active layer, press (K) to scroll through available colors; press (Shift) + (K) to scroll backwards through the color menu.

### Viewing a Layer

When you’re working with your layers, you may need to temporarily view a specific layer. Perhaps you need to quickly verify the contents of a layer before you toggle it on.

➢ To temporarily view a layer:

1. Go to the Utility menu and click on Layers. The Layers menu appears.

2. Click on View Layer in the Layers menu. See “View Layer Menu Options” for more information on these settings.

3. Make sure Extents, Layer Ref., and Border are toggled on in the View Layer menu.

4. Click on Select in the View Layer menu. A list of all the layers in your drawing appears in the Menu Window.

5. Click on the layer you’d like to view or type the layer name and press (Enter). The contents of that layer appear in the Drawing Area.

6. Press (Esc) when you’re finished viewing layers. This will refresh the Drawing Area and return to the original view of your drawing, before you entered the View Layer menu.

### View Layer Menu Options

<table>
<thead>
<tr>
<th>Select</th>
<th>Lists the layers in your drawing; click on the layer name in the list or type the layer name and press (Enter).</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extents</td>
<td>Toggle on to display the layer at its extents; toggle off to display the layer at the current scale.</td>
</tr>
<tr>
<td>Layer Ref.</td>
<td>Toggle on to refresh the Drawing Area as you select each layer.</td>
</tr>
<tr>
<td>Border</td>
<td>Toggle on to use an invisible border to display each layer in.</td>
</tr>
<tr>
<td>Image Size</td>
<td>Sets the percentage of the Drawing Area to use to display layers; only available when border is toggled on.</td>
</tr>
</tbody>
</table>

### Deleting Layers and Their Contents

When a layer is no longer useful to your project, you can erase only the contents of the layer or delete the actual layer as well as its contents.

➢ To erase the contents of a layer:

1. Go to the Utility menu and click on Layers. The Layers menu appears.

2. Click on Clear Layer in the Layers menu. A list of all the layers in your drawing appears in the Menu Window.

3. Click on the layer that contains the entities you want to erase or type the layer name. You are asked *Are you sure you want to erase: <layer name>*.

4. Click on Yes to erase the layer’s contents. The layer itself is not deleted and isn’t changed in any other way. Click on No to exit the Clear Layer menu without erasing the layer’s contents.
To delete a layer and its contents from the drawing:

1. Go to the Utility menu and click on Layers.

   **Warning:** As a precaution, use Export Layer to save a copy of the layer before you delete it. If you find you still need the layer later, you can then use Import Layer to copy it back into your drawing.

2. Click on Delete Layer in the Layers menu. A list of all the layers in your drawing appears.

3. Click on the layer that you want to delete or type the layer name. The prompt *Are you sure you want to delete layer <layer name>* appears in the Message toolbar.

4. Click on Yes to delete the layer. Click on No to exit the Delete Layer menu without deleting a layer. You cannot delete the active layer.

### Selecting Layers Without Using Layer Names

You may have noticed the Match option in several of the Layers submenus. Match is used to select a layer by selecting an entity on that layer instead of having to find the correct layer name in a list. You can set the active layer, move entities from one layer to another, or point DataCAD LT to a specific layer, all without having to remember layer names.

You can use Match with any of the following Layers menu options: On/Off, Set Active, Active Only, Lock, Rename, Clear Layer, Delete Layer, View Layer/Select. It is also available when using To Layer in the Move or Copy menus or when using Layer Search.

To set the active layer using Match:

1. Go to the Utility menu and click on Layers. The Layers menu appears.

2. Click on Set Active in the Layers menu. The Set Active menu appears.

3. Click Match in the Set Active menu. You are prompted to *Select entity on layer to match*.

4. Click on an entity in the Drawing Area to select the layer it is on. The active layer setting is changed to that layer.

To move entities to another layer using Match:

1. Go to the Edit menu and click on Move.

2. Click on To Layer in the Move menu. You are prompted to *Select layer to move to* in the Message toolbar. The To Layer option is only available if your drawing has more than one layer. See “Creating Layers” earlier in this chapter for more information on creating additional layers.

3. Click Match in the To Layer menu. You are prompted to *Select entity to match* in the Message toolbar.

4. Click on an entity in the Drawing Area to select the layer to move the entity to. You are prompted to *Select entity to move* in the Message toolbar.

5. Click on the entity you want to move. The entity is moved to the layer you selected in step 4.
To point DataCAD LT to a specific layer using Match:

1. Indicate the Walls layer. When drawing doors or windows on a different layer from walls, you must tell DataCAD LT which layer your walls are on so they can be cut properly. Make the Doors layer your active layer and click on Architect in the Edit menu. See “Setting the Active Layer” earlier in this chapter for more information.

2. Click on Door Swing in the Architect menu.

3. Toggle Layer Search on in the Door Swing menu. If it’s already toggled on, toggle it off and then back on again to display the list of layers in your drawing.

4. Respond to the prompt to select layer to search for walls in the Message toolbar. Click on Match at the bottom of the list of layers.

5. Respond to the prompt to Select entity on layer to match in the Message toolbar. Click on a wall in your drawing to select the layer that your walls are drawn on.

6. Draw your door. The wall will be cut properly on the Walls layer. This same procedure can be used with the Windows or Cut Wall options. For details on how to draw doors and windows, see the “Drawing Walls, Windows, and Doors” chapter.

Searching for Layers

You may have noticed the Filter option in several of the Layers submenus. Filter is used to search for layers with similar names. For example, if you’ve put your plumbing and electrical drawings on separate layers, you might have layers named 1FLPLUMB, 2FLPLUMB, 3FLPLUMB, 1FLELECT, 2FLELECT, and 3FLELECT. To search for a plumbing layer, you’d use Filter and enter ???plumb. Or you could search for first floor layers by entering 1f* or 1fl????.

Use an asterisk (*) in place of any number of characters and a question mark (?) in place of each character you’re unsure of. The filter disregards any characters following an asterisk. Therefore, if you enter *plumb to search for plumbing layers, DataCAD LT recognizes only * as the search parameter and all of your layers will be displayed.

To search for layers:

1. Go to the Utility menu and click on Layers. The Layers menu appears.

2. Click on the Layers option you want to use (for example, On/Off).

3. Click on Filter in the Layers option submenu to toggle Filter on.

4. Type the search parameter, including any wildcard character(s), for the layers you want to find. Your search results appear in a list in the Menu Window.

5. Choose the layer(s) you want to use.

More About Searching for Layers

DataCAD LT groups layers with affixes (prefixes or suffixes) similar to what you entered. If your search doesn’t find the layer you want, you can scroll through these groups to find the appropriate layer using the Filter Back and Filter Fwd. options that appear at the bottom of the Menu Window, below your search results.

DataCAD LT remembers the last search you did using Filter. When you next use Filter, the search parameter you used last appears in the Attention toolbar and your search results appear in the Menu Window.
Saving and Loading Layers

You may occasionally need to copy a layer from one drawing to another, you may simply want to save a copy of a layer before you delete it in case you find you need it again, or perhaps you’d like to save a hidden line removal of your model to a layer file to avoid increasing your drawing file size. The Export Layer and Import Layer options in the Layers menu can help you do all of these things. Export Layer saves a layer to a layer (.DLF) file; Import Layer pastes a layer file into a drawing.

To save a layer:

1. Go to the Utility menu and click on Layers. The Layers menu appears.
2. Click on Export Layer in the Layers menu. A list of your layers appears in the Menu Window.
3. Click on the layer you want to save. A dialog box appears.

![Figure 7.3: Export Layer produces this dialog box](image)

4. Type the name of layer file and click on Save or press (Enter). DataCAD LT saves the layer with a .DLF extension. If you already have a layer file by that name, DataCAD LT prompts you to verify that you want to overwrite the existing file (replace the old version of the file with this new one). Press (Enter) to overwrite the file. You are returned to the Layers menu. By default, files are saved in your DataCAD LT\Layer Files folder. You can change the folder that layer files are saved to using the Pathnames tab in the Tools/Program Preferences Configure DataCAD LT Settings dialog box.

To load a layer into a drawing:

1. Go to your drawing and change the active layer to the layer that you want to copy the layer file onto.
2. Go to the Utility menu and click on Layers. The Layers menu appears.
3. Click on Import Layer in the Layers menu. You are asked *Delete active layer?* in the Message toolbar.
4. Click on Yes in the Menu Window to erase anything on the active layer. Click on No to add the entities on the layer you will load to the entities already on your active layer. A dialog box appears, listing all your layer files.
**Warning:** If you choose Yes to delete the active layer, you cannot restore those entities.

5. Click on the layer file you want to load or type the filename in the File name input box.

![Import Layer dialog box](image)

*Figure 7.4: Import Layer produces this dialog box*

6. Click on Open or press (Enter). The layer file is copied to the active layer in your drawing.

**More About Naming a Layer File**

Just as you planned how to name the layers in your drawing, you should also plan a logical, useful naming scheme for your layer files. To keep track of where the layer came from, the layer filename should be as similar as possible to the name of the drawing file from which it originated. One way to name layer files is to use the drawing filename followed by a descriptive name for the layer. For example, if you saved the layer that contained a hidden line removal from the drawing file HOUSE.AEC, you might name the layer file HOUSE_HL.DLF.

**Using Layer Sets**

In the Layers menu, Layer Sets replaces the layer utility macro from DataCAD LT versions 10 and prior. Layer Sets controls settings on a per drawing basis and retains them with the drawing file.

- To create a layer set:
  1. Select Layers from the Utility menu. Then choose Layer Sets from the Layers menu. The Layer Sets menu appears.
  2. Click on Create and toggle on the options you want in the current layer set.
     - All Layers: Creates a layer set with all layers.
     - On Layers: Creates a layer set with only the layers that are on.
     - Views: Includes saved views in the layer set.
     - Details: Includes multi-scale plot details in the layer set.
  3. Click on Begin. A dialog box appears so that you can enter the name of the layer set you want to create.
Figure 7.5: Supply a name for the Layer Set file you want to create

4. Click in the File name input box, supply a name, and click Open or press (Enter).

To load a layer set:

1. Select Layers from the Utility menu. Then choose Layer Sets from the Layers menu. The Layer Sets menu appears.

2. Select Load from the Layer Sets menu. A dialog box appears, prompting you to enter the name of the layer set you want to load.

Figure 7.6: Select a .DLS file to load

3. Select the layer set you want to load from the *.DLS files in the list and click on Open or press (Enter).

To delete a layer set:

1. Select Layers from the Utility menu. Then choose Layer Sets from the Layers menu. The Layer Sets menu appears.
2. Select Delete Set from the Layer Sets menu. A dialog box appears, prompting you to enter the name of the layer set you want to delete.

![Select the .DLS file you want to delete](image)

Figure 7.7: Select the .DLS file you want to delete

3. Select the layer set you want to delete from the *.DLS files in the list and click on Open or press (Enter). If you want to delete another layer set, repeat this step. If you do not want to delete another layer set, click Cancel.

### Assigning Materials for a Layer

You can assign materials on a per‐layer basis to control your rendered drawing when you use the Object Viewer or export your file to o2c format. This global setting is stored in the DCADLT.INI file.

To define materials on a per‐layer basis:

1. Select Rendering Settings from the View pull‐down menu. The Material Assignment (Layer) dialog box appears.

2. Click on the Layer button.
3. Select a layer from the pull-down list in the Layer area of the dialog box.

4. Make changes in other portions of the dialog box to control the appearance of the rendering. For more information about rendering settings, see “Using the O2C-based Object Viewer” in the “Viewing Your Model” chapter.

**Setting Z-Base and Z-Height for a Layer**

Each layer can have different Z-base and Z-height settings.

➢ To specify Z-base and Z-height settings for each layer:

1. Select Settings from the Utility menu. The Settings menu appears.
2. Toggle on Z By Layer. The Z-base and Z-height will be remembered for each layer.

**Using the Layer Manager**

The Layer Manager gives you control over each layer’s number, status (on, off, locked, and unlocked), color, and name. It displays the number of entities on each layer in the Count column.

**Accessing Layer Manager**

➢ To open the Layer Manager, use one of these options:

- Select Layers from the Utility menu and click on Manage in the Layers menu. The Layer Manager dialog box appears.
- Or select Layer Manager from the Tools pull-down menu. The Layer Manager dialog box appears.
- Or use the keyboard shortcut (L) for Layer and (S8) for Manage. The Layer Manager dialog box appears.
- Or use the keyboard shortcut (Ctrl) + (L). The Layer Manager dialog box appears.
- Or click on the active layer’s name in the status window.

Initially, the only active buttons are All On, New, Ok, and Cancel. When you highlight the layer you want to work with, other buttons will become active.
Changing a Layer’s Number

To change a layer’s number:

1. Click on the number of the layer you want to change. The layer you selected is highlighted in the Layer Manager dialog box. Notice that in addition to All On and New, the Set Active, ActiveOnly, Erase, Delete, MoveUp, and MoveDn buttons are active.

   **Hint:** To select several successive layers (for example, layers 3 through 6) click on the first one, press down and hold (Shift), and click on the last layer. Release the (Shift) key when you have highlighted the successive layers you want to work with in the Layer Manager dialog box.

   To select several layers that are not in consecutive order (for example, layers 3, 5, and 7), you select the first one, press down and hold (Ctrl), and click on the other layers. Release the (Ctrl) key when you have highlighted the nonconsecutive layers you want to work with in the Layer Manager dialog box.

2. Click on the MoveUp or MoveDn button until you are satisfied with the layer’s new position. Alternatively, you can use the mouse to reposition the layer with drag and drop. Just click on the number, drag your mouse, and release the left mouse button when you reach the desired new number to dynamically reposition the layer.

   **Hint:** When you make changes to the position of the layers by using the MoveUp or MoveDn buttons or the drag-and-drop method, DataCAD LT automatically inserts a checkmark in the Save new layer order box. If this box does not contain a checkmark, your changes will not be saved and the layers will return to their original positions when you leave the Layer Manager dialog.

3. Click on the Apply or Ok button when you finish rearranging the layers. This saves your layers in the new arrangement and deactivates the Revert button. When you click the Ok button, the Layer Manager dialog box disappears and you return to the drawing window.

To return the layers you moved to their original positions, use one of these options:

- Click on the Revert button if this option is available. If you selected Apply, the Revert button will not be active. If you selected Ok, the Layer Manager dialog box will not be displayed on your screen.

- Or click on the Undo arrow once if the Layer Manager dialog box is not on your screen to return to the positions that were last active.

- Or press (Ctrl) + (Z) for Undo if the Layer Manager dialog box is not on your screen.

Sorting the Layers

Use Layer Manager to sort your drawing’s layers by clicking on the column titles. Clicking the same column title twice will reverse the sorting order. For example, you may want to sort the layers alphabetically A-Z by the information in the Name column. If you click the Name column a second time, the layers will appear alphabetically Z-A.

**Hint:** Sorting your layers by clicking on the column titles does not automatically place a checkmark in the Save new layer order box. If you want to save the layers in the newly sorted order, make sure you click in the Save new layer order box so that a checkmark appears before you exit from the Layer Manager dialog box.
If you just want to quickly check the on/off or lock/unlock status of the layers, you may not want to store the layers in that order. In these cases, you probably wouldn’t want to put a checkmark in the Save new layer order box. Leaving the box unchecked means that DataCAD LT will return the layers to the order they were in when you last opened the Layer Manager dialog box.

Figure 7.10: Layers sorted alphabetically

This is what happens when you use the column titles to sort your layers:

- **LayerNum**: Layers are arranged in numerical order. Clicking LayerNum again reverses the layers.
- **On**: Layers that are On will appear first. Clicking On again makes the Off layers appear first.
- **Lock**: Layers that are locked will appear first. Clicking Lock again makes the unlocked layers appear first.
- **Color**: Layers will be sorted from white through the darkest shades. Clicking Color again will sort layers from darkest shades to white.
- **Name**: Layers will be sorted alphabetically from A to Z. Clicking Name again will sort layers from Z to A.
- **Count**: Layers will be sorted numerically from the smallest to the largest number. Clicking Count again will sort layers from the largest to the smallest numbers.

**Hint**: Count indicates the number of entities contained on a particular layer. You can sort by count to quickly find the layers that do not contain any drawing entities. This makes it easy for you to delete empty layers from your file.

### Changing Layer Settings

Each layer has different settings that you can change. These settings are on/off, lock/unlock, color, and name.

**On/Off**

A solid yellow light bulb in the On column indicates that a layer is on; a clear bulb means that a layer is off. The green bulb designates the active layer. Only one bulb in the layer list can be green (meaning that layer is on and active); however, any number of bulbs may be yellow (on) or clear (off).
To change the on/off setting for one layer:

1. Click on the light bulb of the layer you want to change. If the bulb was originally yellow, it changes to clear and vice versa.
2. Click on Apply if you want to make other changes in the Layer Manager or click Ok to return to the drawing window, where your change is in effect.

To change the on/off setting for several layers:

1. Highlight the layers you want to change by using (Shift) for successive or (Ctrl) for nonconsecutive layers.
2. Click on the light bulb for one of the highlighted layers. All the bulbs in the highlighted layers are changed to the same setting.

**Hint:** This is true even if some of the bulbs in the layers you selected were on and others were off. For example, if you highlighted layers 3 (on), 5 (off), and 6 (on) before you clicked on the bulb in layer 3, DataCAD LT would switch all three bulbs off.

3. Click on Apply if you want to make other changes in the Layer Manager or click Ok to return to the drawing window, where all your changes are in effect.

![Layer Manager](image.png)

**Figure 7.11:** Changing the On/Off status of a layer

To turn all the layers on:

1. Click the All On button.
2. Click on Apply if you want to make other changes in the Layer Manager or click Ok to return to the drawing window, where all the layers are on.

To designate the active layer:

1. Select the layer you want to change to active status.
2. Click on the Set Active button. The bulb for the highlighted layer changes to green and its name is underlined. The bulb for the layer that was previously active changes to yellow (on) and its name is no longer underlined.
3. Click on Apply if you want to make other changes in the Layer Manager or click Ok to return to the drawing window. Notice that the layer you selected is active in the status box in your drawing window.

To display only the layer you designate as active:

1. Highlight the layer you want to designate as active.
2. Click the ActiveOnly button. The highlighted layer’s bulb is green (indicating it is on and active); all other bulbs are clear (off). The layer’s name is also underlined.

3. Click on Apply if you want to make other changes in the Layer Manager or click Ok to return to the drawing window. Notice that the active layer is the only one that appears in the drawing window.

**Lock/Unlock**

You can edit unlocked layers, which are designated by an open padlock. Locked layers (red, closed padlock) are protected and cannot be edited.

- **To lock or unlock one layer:**
  1. Click on the padlock you want to change. DataCAD LT changes that layer’s lock status accordingly.
  2. Make changes to other layers in the Layer Manager if necessary. Remember that if you locked a layer, DataCAD LT will not allow you to make any changes to it.
  3. Click Ok to return to the drawing window.

- **To lock or unlock several layers simultaneously:**
  1. Highlight successive layers by using (Shift) or several nonconsecutive layers by using (Ctrl) to select the padlocks you want to change.
  2. Click on a padlock in one of the selected layers. If the padlock you clicked was originally unlocked, DataCAD LT will lock it and all the others in the layers you selected in step 1.
  3. Click Ok to return to the drawing window.

**Color**

In the Layer Manager, the color of each layer appears in a square swatch. Changing the color that applies to entities on a layer is easy. Keep in mind that the color change will apply only to the entities you create on that layer; the new color doesn’t affect the entities that were on the layer.

- **To change the color of a layer:**
  1. Click on the square swatch in the Layer Manager for the layer you want to change. The Color Palette dialog box appears.
2. Select a new color from the sample swatches in the palette.

3. Click OK. Notice that the new color you selected appears on the swatch in the Layer Manager.

If you do not like any of the available colors, you can easily mix your own.

**Caution:** Make sure that the color you want to edit is unique among the layers in your drawing. If several layers use the same color, change the selected layer’s color as shown in the previous steps so that it is different from the others. If the color of the layer you want to change is not unique, all other layers sharing that color will also be changed in the editing process.

If you want to mix your own color for a layer, refer to the section on “Customizing Colors” at the end of this chapter.

**Name**

DataCAD LT allows you to use up to 88 characters (including spaces) for meaningful layer names. You can change a layer’s name in several ways with the Layer Manager. When you click on a layer’s name once, that layer is highlighted or selected; however, you cannot edit the name.

➢ To change a layer’s name use one of these methods:

- Double-click on the layer name you want to change, type the new name (up to 88 characters long), and press (Enter). The new name appears on the list in the Layer Manager.
Figure 7.13: Double-clicking on the layer name lets you type a new name

- Press (Enter) when a layer is highlighted, type the new name, and press (Enter).
- Press (F2) when a layer is highlighted, type the new name, and press (Enter).

Using Other Layer Functions

With the Layer Manager, you can add new layers, erase all the entities on a layer, delete a layer, or revert to previous layer settings. To access these basic functions, you use the buttons on the right side of the layer list.

Figure 7.14: Buttons to the left of the layer list show options for changing settings

Add New Layer

The Layer Manager makes it easy to add new layers to your drawing. While you add the layer, you also set its name, on/off and lock/unlock status, and color. Initially, the new layer will not contain any drawing entities; those accumulate in the Count column as you use the layer.

To add a new layer to your drawing file:

1. Highlight the layer that should appear before or above the new one you are creating. DataCAD LT adds the new layer after the highlighted one. For example, if you want the new Brick layer to come before Stucco, you would highlight Metal.
2. Click on the New button to the right of the layer list. The Create New Layer(s) dialog box appears and you are prompted to *Enter the number of new layers to create.*

3. Input the number of layers you want to add to your drawing and press (Enter) or click Ok. The new layer appears above the one you initially highlighted.

4. Type a name for the new layer and press (Enter). Notice that Count contains a zero because there are no entities in this layer yet.

5. Continue adding new layers by repeating steps 1 through 4.
6. Click in the box at the bottom of the Layer Manager to put a checkmark, indicating that you want DataCAD LT to save the new layer order. When you are finished adding new layers to your drawing file, click on Apply (if you want to continue working in the Layer Manager) or Ok (if you do want to leave the Layer Manager and return to your drawing window now).

![Image of Layer Manager](image_url)

**Figure 7.19:** Check the “Save new layer order” box.

### Erase Entities from a Layer

You can quickly eliminate all the entities on a layer. This can help you save time when you want to make major changes on a particular layer of your drawing.

➢ To erase entities from a layer:

1. Highlight the layer that contains the entities you want to eliminate.
2. Click on the Erase button to the right of the layer list. A Warning box appears.

![Warning box](image_url)

**Figure 7.20:** Warning box

3. Click on the Yes button or press (Enter). DataCAD LT puts an eraser in the Count column to signify that you are eliminating all of the entities on that particular layer.

**Hint:** The entities will be erased from your drawing when you click Apply or Ok (to exit the Layer Manager dialog box), but DataCAD LT gives you a chance to change your mind and keep those entities. To change your mind, simply select either the Revert or Cancel button.

![Layer Manager with eraser](image_url)

**Figure 7.21:** An eraser appears in the Count column to show that entities will be erased from that particular layer.

4. Click on Apply if you want to have the entities erased while you continue working in the Layer Manager. Click Ok if you want to have the entities erased and return to your drawing window. DataCAD LT erases the entities on the layer.
Delete a Layer
You can eliminate an entire layer from your drawing. It doesn’t matter whether the layer contains hundreds of entities or none.

To delete a layer:
1. Highlight the layer you want to eliminate from your drawing file.
2. Click on the Delete button to the right of the layer list. A warning box appears, giving you a chance to change your mind.

3. Select Yes or press (Enter) to indicate that you want to continue. The layer disappears from the list.

Oh No! What if you accidentally deleted the wrong layer? Don’t panic because DataCAD LT gives you two more chances to change your mind. You can click Revert to restore the layer immediately; the other alternatives are to select Cancel or use the Undo function.

Changing an Incorrect Layer Setting
There are three ways for you to change settings if you made a mistake in the Layer Manager dialog box. Depending on when you notice the mistake, you can select Revert or Cancel or use the Undo button if you don’t catch the error until you leave the Layer Manager dialog box.

Revert to Previous Settings in the Layer Manager
If you accidentally do something to a layer (such as eliminate all its entities, turn a layer off, or eliminate the layer entirely), you can go back to the previous settings with Revert.

Revert is available after you do something on the Layer Manager’s list and only applies to what you just did. For example, if you change a layer’s status to Off and then give the layer a new name, Revert will give you a chance to return to the older name but will not turn the status to On. If Revert is unavailable (the button is gray), it’s too late to change your mind about a previous decision.
Cancel
If Revert is not available (the button is gray) or you notice a previous error (such as eliminating all the entities in the wrong layer) you made during the current Layer Manager session, you can use the Cancel button. Selecting Cancel closes the Layer Manager and puts you back in the drawing window, ignores all the changes you made since you entered the dialog box, and returns all layer settings to those that existed previously in your drawing file.

Cancel affects all the settings you changed in the Layer Manager dialog box since you opened it. You can’t selectively eliminate some changes and retain others. If selecting Cancel eliminated settings that you wanted to keep, you must reopen the Layer Manager dialog box, make the changes again, and save them when you exit the dialog by choosing the Ok button.

Undo
Use the Undo arrow on your button bar or select Undo Layer Manager from the Edit pull-down menu if the Layer Manager dialog box is not active on your screen. This eliminates all the things you changed the last time you used the Layer Manager dialog box. If you restored your old layer settings with Undo but want to keep them after all, just click on the Redo button or select Redo Layer Manager from the Edit pull-down menu.

Exiting from the Layer Manager
The buttons on the bottom of the Layer Manager dialog box give you several exit options:

- **Apply.** When you click on this button, the changes you make in the layer list take effect in your drawing while the Layer Manager dialog box remains open.
- **Save new layer order.** This check box is available if any of your changes involved the original layer order or if you added or deleted layers. By default, when this box is initially active, it contains a checkmark. Remember to uncheck this box if you want to go back to the layer order that was in effect before you opened the Layer Manager.
- **Cancel.** This disregards everything you did since opening the Layer Manager dialog box. Clicking this button returns you to the drawing window and retains your layer settings to those that were in effect before you opened the Layer Manager.
- **Ok.** Clicking this button returns you to your drawing screen and makes all the layer setting changes take effect in your drawing file.

Customizing Drawing Settings
Passwords, scale and angle types, and a variety of display options can be set and modified at any time during your work session.

Setting a Password
A password can provide a level of security to individual drawing files. DataCAD LT’s password option requires that the password be entered correctly to open the drawing.
Warning: There is no way to circumvent this setting if you forget your password. Use a password you can easily remember or store a reminder of it in a safe place.

To set a password for your drawing:

1. Go to the Utility menu and click on Settings. The Settings menu appears.
2. Click on Password in the Settings menu. A Password dialog box appears.
3. Enter a password (from 1 to 11 characters long) and press (Enter) or click OK. DataCAD LT prompts you to Verify password by re-entering.

   The password is case-sensitive. If you used “12mydrawing” as the password, you cannot open the file with “12Mydrawing,” “12MyDrawing,” or any other combination of upper- and/or lower-case letters. The file can only be opened if you use “12mydrawing” as the password.

4. Type the same password again and press (Enter) or click OK. The password is set. Make sure you save your drawing before closing it so that the new password is saved with the drawing file.
5. Repeat these steps if you need to change the password.

After you save and close a drawing file that is password-protected, it can only be opened if you know the password. Even though you can see the drawing in the Preview Window of the Enter name of drawing file to open dialog box, you cannot open it without the password.

You can remove the password from a file after you open it. Just select Password from the Settings menu and press (Enter) twice. This enters a blank password.

Setting Scale and Angle Types
You can change the scale and angle types your drawing uses. When you change the scale type, all associative dimensions in your drawing will be updated.

To change the scale type:

1. Go to the Utility menu and click on Settings.
2. Click on Scale Type in the Settings menu.
3. Click on the scale type you want: architectural, engineering, decimal, inch fractions, decimal inches, metric, meters, centimeters, millimeters, DIN standard, or AS 1100 standard.
4. Choose how dimensions are displayed, using the Units, Do Float, Sig. Digits, and Stack Frac. options. Toggle these on or off, as you like. See “Scale Type Menu Options” later in this section for details on these settings.
5. Right-click to exit the Scale Type menu when you’re finished.

To change the angle type in your drawing:

1. Go to the Utility menu and click on Settings.
2. Click on Angle Type in the Settings menu.
3. Click on the angle type you want: normal, bearings, decimal degrees, radians, or gradients. See “Angle Type Menu Options” later in this section for details on these settings.
4. Choose how angles are used. You can do this by using the Compass, Clockwise, and Start. Angle options.
5. Right-click to exit the Angle Type menu when you’re finished.

Figure 7.25: The Normal angle type as is (left) and with Compass applied (right).

Scale Type Menu Options

Arch. Uses and displays dimensions and coordinates in the architectural scale or Imperial units (feet, inches, and fractions of inches); this is DataCAD LT’s default scale type.

Eng. Uses and displays dimensions and coordinates in the engineering scale (feet and decimal inches).

Decimal Uses and displays dimensions and coordinates in decimal feet.

Inch/Frac. Uses and displays dimensions and coordinates in inches and fractions of inches.

Inch/Decimal Uses and displays dimensions and coordinates in decimal inches.

Metric Uses and displays dimensions and coordinates in meters, centimeters, and millimeters.

Meters Uses and displays dimensions and coordinates in decimal meters.

Centimeter Uses and displays dimensions and coordinates in decimal centimeters.

Millimeter Uses and displays dimensions and coordinates in decimal millimeters.

DIN Uses and displays dimensions and coordinates in the form meters.centimeters with superscripted millimeters.

AS 1100 Uses and displays dimensions and coordinates in millimeters with a space separating thousands, hundred thousands, millions, and so on; input is done in meters.

Units Toggle on to use and display dimensions and coordinates with unit abbreviations.

Do Float Toggle on so that distance readouts use a floating decimal point; only available with the Decimal, Inch/Decimal, Meters, Centimeter, or Millimeter scale types. When Do Float is toggled off, the Sig. Digits option becomes available.

Sig. Digits Sets the number of decimal places or significant digits (0 to 3) to display; only available with the Decimal, Inch/Decimal, Meters, Centimeter, or Millimeter scale types, when Do Float is toggled off.

Stack Frac. Toggle on so that fractions of an inch appear “stacked” (with the numerator over the denominator) rather than inline; available only with the Arch. scale type. Some third-party fonts have improper character definitions, which may cause the fraction to overwrite the nonfractional portion of the dimension when using Stack Frac. Should this occur, try using a different font.

Angle Type Menu Options

Normal Toggle on to set zero degrees equal to the positive X axis, a horizontal line to the right.

Bearings Toggle on to enter angles using bearings.

Dec. Degrees Toggle on to enter angles in decimal degrees.

Radians Toggle on to enter angles in radians.

Grads Toggle on to enter angles in gradients.

Compass Sets zero degrees equal to the positive Y axis, a vertical line pointing north; this is not a toggle, but simply clicking on it activates it.

Clockwise Toggle on to increase the angle in a clockwise direction; toggle off to increase the angle in a counterclockwise direction. When you click on Compass, Clockwise is automatically toggled on.

Start. Angle Sets zero degrees equal to two specified points.
Editing Scale, Angle, and Distance Lists

With some functions, DataCAD LT will list scale, angle, or distance values for you to choose from. You can modify these scale, angle, and distance lists associated with your drawing. You can list the current values, add new values, change existing values, or delete values you don’t use.

➔ To list scale, angle, or distance definitions:

1. Go to the Utility menu and click on Settings. The Settings menu appears.
2. Click on Edit Defs. in the Settings menu. The Edit Defs. menu appears.
3. Click on the definition list you’d like to edit: Scales, Angles, or Distances. Each of these options contains a submenu that includes List, Add, Change, Delete, Save File, and Load File choices.
4. Click on List. The definitions appear in the Menu Window.
5. Right-click anywhere on the screen or press any key on your keyboard to exit the list.

➔ To add a value to a definition list:

1. Go to the Utility menu and click on Settings. The Settings menu appears.
2. Click on Edit Defs. in the Settings menu. The Edit Defs. menu appears.
3. Click on the definition list you’d like to edit: Scales, Angles, or Distances. You are limited to 18 definitions in a scale, distance, or angle list. If you already have 18 in the list you want to add to, you must either delete or change an existing one.
4. Click on Add. If you’re adding a new angle or distance, you are prompted to enter the new definition in the Message toolbar. If you’re adding a new scale you are first prompted to *Enter new string for this scale*. Supply the text that will appear in the list and press (Enter) before continuing with the next step.
5. Type a new definition and press (Enter). The new value is added to the definition list. You can save your customized scale, angle, or distance lists to a separate file (with a .SCL, .ANG, or .DIS file extension, respectively) and load them into DataCAD LT at any time for use in your drawings.

➔ To delete a value from a definition list:

1. Go to the Utility menu and click on Settings. The Settings menu appears.
2. Click on Edit Defs. in the Settings menu. The Edit Defs. menu appears.
3. Click on the definition list you’d like to edit: Scales, Angles, or Distances.
4. Click on Delete. In the Message toolbar, you are prompted to select the definition to delete.
5. Click on the definition in the list that you want to delete. Instantly, DataCAD LT deletes the definition you selected.

➔ To change a value in a definition list:

1. Go to the Utility menu and click on Settings. The Settings menu appears.
2. Click on Edit Defs. in the Settings menu. The Edit Defs. menu appears.
3. Click on the list to be edited: Scales, Angles, or Distances.
4. Click on Change. You are prompted to select the definition that you want to change.
5. Click on the definition you want to change. If you’re changing an angle or distance, you are prompted to enter the new definition in the Message toolbar. If you’re changing a scale, you are prompted to Enter new string for this scale; enter the text that will appear in the list and press (Enter) before continuing with the next step.

6. Enter a new definition to replace the existing one and press (Enter).

To save your customized definition list:
1. Go to the Utility menu and click on Settings. The Settings menu appears.
2. Click on EditDefs. in the Settings menu. The EditDefs. menu appears.
3. Click on the definition list you’d like to edit: Scales, Angles, or Distances.
4. Click on Save File. A Save dialog box appears.
5. Type a name for the customized list file and click on Save or press (Enter). The customized list is saved.

To load a customized definition list for use in your drawing:
1. Go to the Utility menu and click on Settings. The Settings menu appears.
2. Click on EditDefs. in the Settings menu. The EditDefs. menu appears.
3. Click on the definition list you’d like to edit: Scales, Angles, or Distances.
4. Click on Load File. A Load dialog box appears.
5. Click on the name of the customized list file that you want to load and click on Open or press (Enter). The customized list is loaded into DataCAD LT.

**More About Architectural Scales**

To calculate additional scales, you can use DataCAD LT’s online calculator. For example, to calculate the scale value for 1/4”=1'-0", type =**(1/4)/12** when you’re prompted for a new scaling value. Or type =**.25/12** to get the same result: 0.02083333". For more information on the calculator, see “DataCAD LT’s Online Calculator” in “The Drawing Board” chapter.

An architectural scale list example follows:

<table>
<thead>
<tr>
<th>SCALE</th>
<th>DECIMAL FORM</th>
</tr>
</thead>
<tbody>
<tr>
<td>1/32&quot;=1'-0&quot;</td>
<td>.00260416</td>
</tr>
<tr>
<td>1/16&quot;=1'-0&quot;</td>
<td>.00520833</td>
</tr>
<tr>
<td>3/32&quot;=1'-0&quot;</td>
<td>.00781250</td>
</tr>
<tr>
<td>1/8&quot;=1'-0&quot;</td>
<td>.01041666</td>
</tr>
<tr>
<td>3/16&quot;=1'-0&quot;</td>
<td>.01562500</td>
</tr>
<tr>
<td>1/4&quot;=1'-0&quot;</td>
<td>.02083333</td>
</tr>
<tr>
<td>3/8&quot;=1'-0&quot;</td>
<td>.03125000</td>
</tr>
<tr>
<td>1/2&quot;=1'-0&quot;</td>
<td>.04166666</td>
</tr>
<tr>
<td>3/4=1'-0&quot;</td>
<td>.06250000</td>
</tr>
<tr>
<td>1&quot;=1'-0&quot;</td>
<td>.08333333</td>
</tr>
<tr>
<td>1 1/2&quot;=1'-0&quot;</td>
<td>.12500000</td>
</tr>
<tr>
<td>2&quot;=1'-0&quot;</td>
<td>.16666666</td>
</tr>
<tr>
<td>3&quot;=1'-0&quot;</td>
<td>.25000000</td>
</tr>
<tr>
<td>6&quot;=1'-0&quot;</td>
<td>.50000000</td>
</tr>
<tr>
<td>12&quot;=1'-0&quot;</td>
<td>1.00000000</td>
</tr>
<tr>
<td>24&quot;=1'-0&quot;</td>
<td>2.00000000</td>
</tr>
</tbody>
</table>
More About Engineering Scales
To calculate additional scales, you can use DataCAD LT’s online calculator. For example, to calculate the scale value for 1:20, type 

\((\frac{1}{20})/12\)

and press (Enter) when you’re prompted for a new scaling value. The calculated value is .00416666. An engineering scale list example follows:

<table>
<thead>
<tr>
<th>SCALE</th>
<th>DECIMAL FORM</th>
</tr>
</thead>
<tbody>
<tr>
<td>1:10</td>
<td>.00833333</td>
</tr>
<tr>
<td>1:20</td>
<td>.00416666</td>
</tr>
<tr>
<td>1:33</td>
<td>.00250000</td>
</tr>
<tr>
<td>1:40</td>
<td>.00208333</td>
</tr>
<tr>
<td>1:50</td>
<td>.00166666</td>
</tr>
<tr>
<td>1:80</td>
<td>.00104166</td>
</tr>
<tr>
<td>1:100</td>
<td>.00083333</td>
</tr>
<tr>
<td>1:200</td>
<td>.00041666</td>
</tr>
<tr>
<td>1:400</td>
<td>.00020833</td>
</tr>
<tr>
<td>1:600</td>
<td>.00013888</td>
</tr>
<tr>
<td>1:1000</td>
<td>.00008333</td>
</tr>
</tbody>
</table>

More About Metric Scales
To calculate additional scales, simply type the ratio in decimal form. To use DataCAD LT’s online calculator for this, type 

\(1/20\) and press (Enter) to get the new scale value 0.05000000. For more information on the calculator, see “DataCAD LT’s Online Calculator” in “The Drawing Board” chapter.

A metric scale list example follows:

<table>
<thead>
<tr>
<th>SCALE</th>
<th>DECIMAL FORM</th>
</tr>
</thead>
<tbody>
<tr>
<td>1:1</td>
<td>1.00000000</td>
</tr>
<tr>
<td>1:2</td>
<td>0.50000000</td>
</tr>
<tr>
<td>1:5</td>
<td>0.20000000</td>
</tr>
<tr>
<td>1:10</td>
<td>0.10000000</td>
</tr>
<tr>
<td>1:20</td>
<td>0.05000000</td>
</tr>
<tr>
<td>1:50</td>
<td>0.02000000</td>
</tr>
<tr>
<td>1:100</td>
<td>0.01000000</td>
</tr>
<tr>
<td>1:200</td>
<td>0.00500000</td>
</tr>
<tr>
<td>1:500</td>
<td>0.00200000</td>
</tr>
<tr>
<td>1:1000</td>
<td>0.00100000</td>
</tr>
<tr>
<td>1:2000</td>
<td>0.00050000</td>
</tr>
<tr>
<td>1:5000</td>
<td>0.00020000</td>
</tr>
<tr>
<td>1:10000</td>
<td>.00010000</td>
</tr>
</tbody>
</table>

Setting Cursor Accuracy
Your cursor’s miss distance is the length (in pixels) extending from the center of your cursor’s crosshairs outward. The smaller the miss distance, the closer you’ll have to place your cursor to an entity to select it. This distance affects object snapping and other editing commands where you use your cursor to select a point or entity. The default miss distance is 20.

➤ To set your cursor’s miss distance:

1. Go to the Utility menu and click on Settings. The Settings menu appears.
2. Click on Miss Dist. in the Settings menu. A value menu appears. For more information on using value menus, see “Value Menus” in “The Drawing Board” chapter.
3. Choose a new distance value from the list or type a new value and press (Enter).
Setting Display Options

There are several display options that you can customize in DataCAD LT, including grid display, reference mark display, cursor size, and information displayed in the Message toolbar.

When you zoom out from your drawing, the grid spacing becomes smaller. The grid can become so small that it’s difficult to work with and even distracting. You can use the Small Grid option in the Settings menu to turn off the display grids when it reaches a specific pixel spacing. A good setting is usually between 15 and 20 pixels.

**Shortcut:** Press (PgDn) and (PgUp) to zoom in and out on your drawing.

- To set the smallest grid size at which the display grid will still display:
  1. Go to the Utility menu and click on Settings. The Settings menu appears.
  2. Click on Small Grid in the Settings menu. A value menu appears. For more information on using value menus, see “Value Menus” in “The Drawing Board” chapter.
  3. Choose a new value from the list or type a new value for the smallest grid size that will display and press (Enter).

Another display option is the Draw Marks toggle in the Settings menu. Toggle Draw Marks on to have DataCAD LT automatically draw temporary visual references for every point and entity you draw. These small Xs do not plot and you can’t snap to them. When you refresh the Drawing Area, the marks disappear.

**Shortcut:** Press (Esc) to refresh the display of your drawing in the Drawing Area.

You can also toggle the Big Cursor option on in the Settings menu to display a large cursor that spans the Drawing Area; toggle it off to display a smaller cursor. When you toggle Big Cursor off, you can specify the size of the cursor.

**Shortcut:** Press (+) to toggle between large and small cursors.

- To set the size of a small cursor:
  1. Go to the Utility menu and click on Settings. The Settings menu appears.
  2. Click on Big Cursor to toggle it on. If it’s already toggled on, skip to step 3.
  3. Click on Big Cursor to toggle it off. A value menu appears. For more information on value menus, see “Value Menus” in “The Drawing Board” chapter.
  4. Use the value menu or type a new value for the cursor size (in pixels) and press (Enter).

In the Settings menu, Neg. Dist. allows you to customize the Message toolbar display. To allow the display of negative coordinates in the Message toolbar, toggle Neg. Dist. on.

Setting the Panning Distance

You can adjust the distance the screen scrolls when you use the arrow keys to pan around your drawing. For example, a setting of 50% scrolls 50% of the Drawing Area width each time you press an arrow key.

**Shortcut:** Press the arrow keys to pan around your drawing.

- To adjust the scroll distance:
  1. Go to the Utility menu and click on Settings. The Settings menu appears.
2. Click on Scroll Dist. in the Settings menu. A value menu appears. For more information on value menus, see “Value Menus” in “The Drawing Board” chapter.

3. Choose a new scroll distance from the list or type a new value and press (Enter).

Automatically Saving Your Drawing

DataCAD LT’s automatic save feature creates an auto-recover (.ARF) file that you can use to recover your drawing file should DataCAD LT unexpectedly close before you’re able to save the changes you’ve made to your drawing. The Save Delay option in the Settings menu determines how often DataCAD LT updates the auto-recover (.ARF) file. When an autosave is finished, Auto-recover file created appears in the Attention toolbar. If there are a lot of entities on a layer, you may want to adjust this save delay to a higher setting to avoid frequent interruptions until you’re finished working on that layer.

Warning: Autosave is not a substitute for saving your file. Autosave does not mean that DataCAD LT automatically saves your file. If you chose No when you close the drawing, DataCAD LT will not automatically save your changes.

The moral of the story: Use File Save often while you are drawing and when you are closing a file.

The autosave function does not permanently save your drawing, so your drawing (.AEC) file is not updated. See “Backing Up and Recovering Files” in “The Drawing Board” chapter for information on how to use autosave files.

⇒ To adjust the time interval between automatic saves:

1. Go to the Utility menu and click on Settings. The Settings menu appears.

2. Click on Save Delay in the Settings menu. A value menu appears. To turn off the automatic save function, set Save Delay to zero. However, DataCAD LT does not recommend this because it leaves you no way to recover work done since you last saved your drawing (.AEC) file.

3. Use the value menu to choose a value for the time interval or type a new time value and press (Enter).

Synchronizing the Distance Display

In DataCAD LT, you can rotate the grids along with your cursor to make it easier to draw at an angle. The Dist. Sync. option in the Settings menu is toggled on by default so that the coordinate display in the Coordinates/Hints toolbar matches the rotated cursor position. If you are working with a rotated cursor but want to view the distance relative to standard X and Y coordinates, toggle Dist. Sync. off.

Customizing Display

You can use the Display menu options to toggle the text, dimensions, hatching, or certain drawing attributes on or off. Because the text, dimensions, and hatching that you add to your drawing are made up of many entities, you may want to toggle one or all of these options off to speed up the refresh time while you draw. Toggle these options on again before you plot the drawing.

⇒ To customize the display of your drawing:

1. Go to the Utility menu and click on Display. The Display menu appears.
2. Decide what you want to display in your drawing. You can display all the text, associative dimensions, and hatch patterns that you’ve added to your drawing or you can choose not to display them while you work to decrease drawing refresh times. Toggle Show Text on to display text; toggle it off to display text as boxes. Toggle Show Dim. on to display associative dimensions; toggle it off to hide associative dimensions. Toggle Show Hatch on to display hatch patterns; toggle it off to hide hatch patterns.

Some DataCAD LT menu options are **toggles**, switches that can be turned on or off. When a toggle is on, the button appears depressed. When a toggle is off, the button appears raised.

You can quickly identify on and off toggles by color. DataCAD LT uses green as the default for toggles that are on; red is the default for toggles that are off. You can easily change the on and off colors by selecting Program Preferences from the Tools pull-down menu, clicking on the Interface Settings tab in the Configure DataCAD LT for Windows dialog box, and choosing different colors in the Toggle ON Button and Toggle OFF Button areas. For more information, see “Customizing DataCAD LT’s Interface” in “The Drawing Board” chapter as well as “Customizing Colors” later in this chapter.

**TEXT**

![Text Options](image)

**ADJUSTABLE ASPECT RATIO**

**Figure 7.26**: Show Text toggle on

**Figure 7.27**: Show Text toggle off

3. Look at the toggles that change how the lines in your drawing are displayed. Toggle Show Weight on to display line weights you’ve applied to your drawing; toggle it off to display lines with a weight greater than 1 as single solid lines. You can also toggle on User Line to display any user-defined line types you’ve added to your drawing. If User Line is toggled off, user-defined lines (such as insulation, hedge, and shingles) appear as single solid lines. When User Line is toggled off causing user-defined lines to display as solid, these lines are not changed in any way; they are merely represented on screen by a simple solid line. Toggle Overshoot on to display line overshoots.

4. Change display settings for symbols as well. Toggle Show Ins. on to display symbol insertion points; toggle it off to hide symbol insertion points. You can also click on Small Symbol to set the smallest displayable symbol size. Any symbol smaller than the Small Symbol setting will be displayed as a box. A setting of 0 displays all symbols, regardless of size. See “Value Menus” in “The Drawing Board” chapter for more information on using value menus.
5. Change settings for displaying text by clicking on Small Text or Box Color. Small Text sets the smallest text size displayable on screen; any text smaller than the Small Text setting appears as a box. A setting of 0 displays all text, regardless of size. Box Color sets the color of the boxes that replace small text or that replace all text if Show Text is toggled off. See “Color Menus” in “The Drawing Board” chapter for more information on using color menus. You can select a global text box color or click on No Change to display the text boxes in the same color as the text they replace.

6. Display control points of associative dimensions by toggling Dim. Points on.

7. Display the center points of 2D curves by toggling Curve Center on.

8. Display visible attributes added with a macro by toggling Show Attrib. on.

9. Click on Layer Order to assign the order in which to refresh drawing layers. In the Layer Order menu, toggle First on to refresh the active layer first; toggle Last on to refresh the active layer last; or toggle In Order on to refresh the layers in the order you created them. Only one of these three options can be toggled on at any one time.

If Display List is on, Display List is also available in the Utility / Display menu. Click Display List, click on Statistics in the Display menu, and look at the Attention toolbar to see how many entities and line segments are in the Display List and how much memory is used to maintain the list. For more information about Display List, see “Customizing Miscellaneous Settings” in “The Drawing Board” chapter.

10. Look at the Arc Factor option; it changes how arcs and curves are displayed. The higher the setting, the smoother curves appear. Use a lower setting while drawing to increase refresh speeds; then increase the setting when drawing is complete (see Figure 7.28).

11. Display bitmaps in your drawing using the Bitmap On toggle. Turn this toggle off if you want to suppress bitmaps to increase speed and refresh rates.

11. Right-click to exit when you’ve finished changing Display menu settings.

Figure 7.28: Arc factor settings (0.5 and 3 respectively)

**Customizing Colors**

You can use any customized palette by loading it in the Color Palette dialog box.

- To use a standard palette:
  1. Click on Color Palettes in the Tools pull-down menu. The Color Palette dialog box appears.
CHAPTER 7: BEFORE YOU DRAW

Figure 7.29: The Color Palette dialog box

2. Select a palette from the drop-down box. You can choose from Default, DXFDWG, Munzell, Prizma, RGB_BMKR, RGB_CBGR, RGB_CBGR, RGB_KRGY, RGB_MWRY, RGB_WCYG, Sepia, and White. The color swatches in the palette you selected appear in the dialog box.

3. Click on OK or press (Enter) to use that palette in subsequent drawing sessions.

To mix your own custom color:

1. Click on Color Palettes in the Tools pull-down menu to display the Color Palette dialog box.

2. Select a palette from the drop-down box.

   The Prizma palette is good to use for developing custom colors. Using the blank swatches below the colored ones can help you keep your custom colors separate from the supplied ones.

3. Click on the swatch you want to customize in the Color Palette dialog box.

4. Supply a name for the color you want to create. In this example, the new color will be called “Mint.” Then click on the Edit button to display the Color Picker dialog box.

5. Use your mouse in the RGB (red, green, blue) and/or HSB (hue, saturation, brightness) window to mix the color you prefer. Since the original and new colors appear at the bottom of the Color Picker dialog box, it is easy to compare the two.
Figure 7:30: The Color Picker dialog box lets you mix custom colors for your color palette

6. Select OK when you are satisfied with the new color. The Color Palette now contains your custom color in the swatch.

7. Click OK to exit the Color Palette dialog box.
The Architect menu includes the three most basic drawing elements. It offers options for drawing 2-line, 3-line, and 4-line walls. Door Swing and Windows open subsequent menus that allow you to choose the door styles and windows you want, along with a variety of customizable options.

With a single choice from the Architect menu, you can begin drawing walls whose intersections can be cleaned automatically. Windows, doors, and other wall openings can then be inserted with just a few clicks and, if necessary, removed just as easily.
**Drawing Walls**

Walls can be drawn by simply toggling on the Walls option in the Architect menu. DataCAD LT automatically cleans wall intersections, including the last intersection where the first and last walls drawn meet.

You can draw 2-line walls using the 2 Line Walls option, 3-line walls using the 3 Line Walls option, or 4-line walls using the 4 Line Walls option. Two line walls draw an inside and an outside line, 3-line walls add a centerline, and 4-line walls add two cavity lines. The 2 Line Walls, 3 Line Walls, and 4 Line Walls toggles are mutually exclusive; when one is toggled on, the others are automatically toggled off.

![Figure 8.1: DataCAD LT’s wall types](image)

When you select Architect from the Edit menu, the Architect context-sensitive toolbar appears. The first eight icons can be used to draw and edit walls: From left to right, these icons let you draw 2-line walls, 3-line walls, or 4-line walls; select and manage wall styles; set the wall width; draw walls by the outside; draw walls by the center; and clean up wall intersections.

To draw walls:

1. Make sure you are in Ortho or Plan mode. You can toggle Plan on in the View pull-down menu, click on the plan icon in the Projection Pad toolbar, or toggle on Ortho Mode in the View pull-down menu. Walls can only be drawn in plan (or orthographic) view.

2. Go to the Edit menu in the Menu Window and click on Architect. Alternatively, you can click on in the Icon Draw toolbar. (For information about defining the two Icon toolbars, see “Selecting Default Icon Toolbars” in “The Drawing Board” chapter.) A third option is to select Wall from the Create pull-down menu and indicate the type of wall you want to draw in the submenu; if you use this method, skip to step 5.
**Shortcut:** Press (A) to access the Architect menu. Press (=) to quickly toggle Walls on or off from anywhere in DataCAD LT.

3. Click on Walls in the Architect menu to toggle it on; Wall is checked in the Create pull-down menu. You can now draw walls instead of lines.

4. Click on 2 Line Walls to draw 2-line walls, click on 3 Line Walls to draw 3-line walls, or click on 4 Line Walls to draw 4-line walls.

5. Set the wall attributes using the Highlight option along with Width for 2-line walls, Center Line for 3-line walls, and Exterior, Interior, and Cavity for 4-line walls. See “More About Setting Wall Attributes” later in this chapter.

6. Select two points to draw a wall. When you do this, the line connecting those two points becomes the outside wall, inside wall, center of the wall, or center of the wall cavity, depending on whether Outside, Inside, Center Wall, or Center Cav. is toggled on, respectively. Outside defines walls by the outside of the wall; Inside defines them by the inside of the wall; Center Wall by the center of the wall; or Center Cav. by the center of the wall cavity. When drawing 2-line walls or 3-line walls, Center Wall and Center Cav. work the same way. You can choose either option to create walls based on the wall center.

7. Click on Clean to automatically clean wall intersections as you draw your walls; click on Cap to cap wall ends as you draw your walls. For more information on using Clean and Cap, see “More About Finishing Walls” later in this chapter.

8. Click anywhere in the Drawing Area or use coordinate entry to start drawing your walls.

9. Move the cursor using your mouse and click again or use coordinate entry to specify the end of the first wall.

10. Click anywhere on the inside or outside of the wall, depending on what you did in step 6. If you chose Outside, Center Wall, or Center Cav. in step 6, click anywhere on the inside of the wall; if you chose Inside in step 6, click anywhere on the outside the wall.

11. Notice that your cursor is still connected to the end of your first wall. You can continue selecting wall end points, as you did in step 9; all intersections will be automatically cleaned.

12. Finish drawing walls by right-clicking to disconnect your cursor from the wall or clicking near the first endpoint of your first wall to close your wall plan. Your cursor is automatically disconnected.

Sometimes, you may need to fix wall intersections that didn’t clean properly when they were drawn. Use the Cleanup menu’s T Intersect, L Intersect, and X Intersect options to clean wall intersections. Use the Cleanup menu’s Weld Line and Weld Wall options to mend openings in walls. See “Cleaning Wall Intersections” and “Welding Lines and Walls” in the “Editing Drawings” chapter.

**More About Setting the Width of Walls**

When toggling on the Walls option in the Architect menu, you are prompted for a new wall width. A *wall width* is the distance between the inside and outside wall. You can also change wall width anytime while drawing 2-line or 3-line walls.

- To change the width of walls to be drawn:
  1. Go to the Edit menu in the Menu Window and click on Architect.
2. Click on Width in the Architect menu. You can also click on \( \text{width} \) in the context-sensitive Architect toolbar. A value menu appears. The Width option is not available when 4 Line Walls is toggled on.

**Shortcut:** Press (=) to set the wall width.

3. Use the value menu to enter a new width or type a new width and press (Enter). DataCAD LT sets the new wall thickness and subsequent walls will be drawn with that thickness. For more information on using value menus, see “Value Menus” in “The Drawing Board” chapter.

**More About Setting Wall Attributes**

You can assign different attributes to outside or inside walls, including colors, line types, and line weights by using the Highlight option in the Architect menu. Other attribute options apply only to 3-line or 4-line walls.

- To draw walls with either the outside or inside wall in a different color, line type, or line weight:
  1. Go to the Edit menu in the Menu Window and click on Architect.
  2. Click on Highlight in the Architect menu. The Highlight menu appears.

  You can only set Highlight options for either the inside wall or the outside wall. For example, you can’t assign a color to the outside wall and a line type to the inside wall. If the Highlight menu does not appear, click on Highlight in the Architect menu twice.

  3. Click on Outside in the Highlight menu to highlight the outside of your walls. Click on Inside to highlight the inside of your walls.
  4. Click on Color to choose a highlight color, click on Line Weight to choose a line weight to highlight your walls with, or click on Line Type to choose a line type as a highlight.
  5. Right-click to return to the Architect menu.
  6. Begin drawing your walls. Notice that DataCAD LT applies the color, line type, or line weight attributes you set as you draw walls.

- To set attributes for the center line when drawing 3-line walls:
  1. Go to the Edit menu in the Menu Window and click on Architect.
  2. Click on Center Line in the Architect menu. The Center Line menu appears. The Center Line option is only displayed when 3 Line Walls is toggled on.
  3. Click on Color to choose a highlight color, click on Line Weight to choose a line weight to highlight your walls with, click on Line Type to choose a line type as a highlight, or click on Spacing to set the spacing for the center line. The Spacing setting lengthens both the lines and the spaces in a line type, so that the aspect ratio of the line type is preserved.

- To set the distance from the exterior wall to the exterior cavity wall when drawing 4-line walls:
  1. Go to the Edit menu in the Menu Window and click on Architect.
  2. Click on Exterior in the Architect menu. A list of width values appears.
  3. Use the value menu or type a new value and press (Enter) to set the exterior wall thickness. For more information about how to use value menus, see “Value Menus” in “The Drawing Board” chapter.
➔ To set the distance from the interior wall to the interior cavity wall when drawing 4-line walls:
   1. Click on Architect in the Edit menu.
   2. Click on Interior in the Architect menu. A list of width values appears.
   3. Use the value menu or type a new value and press (Enter) to set the interior wall thickness.

➔ To set the attributes for the cavity wall when drawing 4-line walls:
   1. Click on Architect in the Edit menu.
   2. Click on Cavity in the Architect menu. The Cavity menu appears.
   3. Click on Width to set the width from the exterior cavity wall to the interior cavity wall; click on Color to choose a color for cavity walls; click on Line Weight to set the line weight of cavity walls; click on Line Type to set the line type for cavity walls; click on Spacing to set the spacing for cavity walls.

**More About Finishing Walls**

As you saw in the tutorial in this manual, DataCAD LT always cleans the intersections of walls as you draw them, as long as you don’t disconnect your cursor from the last wall you drew. For T intersections, you can toggle on Clean in the Architect menu to automatically trim the interior wall lines as you draw the walls so that your walls look continuous, without internal lines at corners.

Sometimes you may need to fix wall intersections that didn’t clean properly when they were drawn. Use the Cleanup menu’s T Intersect, L Intersect, and X Intersect options to clean wall intersections. Use the Cleanup menu’s Weld Line and Weld Wall options to mend openings in walls.

**Shortcut:** Press (1) to toggle Clean on or off.

The Cap option in the Architect menu can be toggled on to insert a wall cap or closure on the end of a wall. When you draw walls, DataCAD LT automatically caps the ends instead of leaving them open.

The Clean and Cap toggles are mutually exclusive; when one is toggled on, the other is automatically toggled off.

**Using Wall Styles**

You can save wall styles for 2-line, 3-line, or 4-line walls with the wall attributes you use most often, and then use them in any drawing file. The following attributes are saved in a wall style:

- line color, line type, line spacing, and line weight of wall lines. The line spacing setting lengthens both the lines and the spaces in a line type, so that the aspect ratio of the line type is preserved.
- whether you want to highlight the inside or outside line of your walls using color, line weight, and line type.
- wall widths and center line and cavity wall attributes.

➔ To save a new wall style:
   1. Go to the Edit menu in the Menu Window and click on Architect.
   2. Click on Wall Style in the Architect menu, or click on in the context-sensitive Architect toolbar, or select Wall Style from the extended Create/Wall pull-down menu. The Wall Style Manager dialog box appears.
DataCAD LT provides several default wall styles in the drop-down box in the Wall Styles Available portion of the dialog box. You can also use the arrow buttons beside the drop-down box to scroll through the available default wall styles.

3. Click on SaveAs in the Wall Styles Available section at the bottom of the dialog box. Supply a name (up to nine characters long) for the wall style and press (Enter) or click on OK. The wall style is saved and now appears in the drop-down list in the bottom left corner of the dialog box.

4. Type a name for your new wall style and press (Enter) or click on OK. The wall style is saved and now appears in the drop-down list in the bottom left corner of the dialog box.

5. Make decisions about the lines, colors, spacing, line weight, and other options available in the Wall Style Manager dialog box.

6. Click on Save to store your decisions and then click on OK. Now, you’re ready to draw walls using your new style.

To save changes to a wall style:

1. Go to the Edit menu in the Menu Window and click on Architect.
2. Click on Wall Style in the Architect menu. The Wall Style Manager dialog box appears.
3. Use the drop-down list in the Wall Styles Available section at the bottom of the dialog box or click on the arrow buttons to select the wall style you want to modify.
4. Change wall settings as necessary.
5. Click on Save in the Wall Styles Available section at the bottom of the dialog box. The wall style is saved with any changes you made to wall settings. Click on OK to exit the dialog box.
To use a wall style:

1. Go to the Edit menu in the Menu Window and click on Architect.
2. Click on Wall Style in the Architect menu. The Wall Style Manager dialog box appears.
3. Use the drop-down list or the arrow buttons in the Wall Styles Available section at the bottom of the dialog box to select the wall style you want to use. Wall settings in the dialog box are changed to those of the wall style you selected.
4. Click on OK to close the dialog box.

To delete a wall style:

1. Go to the Edit menu in the Menu Window and click on Architect.
2. Click on Wall Style in the Architect menu. The Wall Style Manager dialog box appears.
3. Use the drop-down list or the arrow buttons in the Wall Styles Available section at the bottom of the dialog box to select the wall style you want to delete.
4. Click on Delete. By asking Are you sure you want to delete filename?, DataCAD LT gives you a chance to change your mind. Click on Yes to complete the process. The selected wall style is deleted.
5. Click on OK to close the Wall Style Manager dialog box.

To display the settings for a wall style:

1. Go to the Edit menu in the Menu Window and click on Architect.
2. Click on Wall Style in the Architect menu. The Wall Style Manager dialog box appears.
3. Use the drop-down list in the Wall Styles Available section at the bottom of the dialog box to select the wall style whose settings you want to view. Wall settings in the dialog box are changed to those of the wall style you selected.
4. Click on OK to use those wall style settings and close the dialog box or click on Cancel to close the dialog box without changing wall settings.

Cutting Walls

You can use Cut Wall in the Architect menu to remove sections of walls.

To cut openings in walls using the mouse:

1. Go to the Edit menu in the Menu Window and click on Architect.
2. Click on Cut Wall in the Architect menu or click on \[\text{Cut Wall} \] in the context-sensitive Architect toolbar. The Cut Wall menu appears.
3. Determine which layer your walls are on. If your walls are on a layer other than the active layer, click on Layer Search to toggle it on. If Layer Search is already on, toggle it off and then back on again to choose your walls layer. The layers in your drawing are listed in the Menu Window.
4. Click on the layer your walls are drawn on.
5. Select one side of the opening by clicking on a point on the wall or using coordinate entry to specify the exact coordinates. To choose a coordinate entry method, use the Input Mode option in the Utility pull-down menu.

6. Select the other side of the opening by moving the mouse along the wall and clicking on any point or by using coordinate entry. The wall is cut and the wall ends are capped automatically.

If the wall opening is a result of adding a door or window when Cutout (an option in the Door Swing and Windows menus only) was toggled off, you must use Erase in the Edit menu to erase the framed opening. You will then need to use Weld Wall in the Edit/Cleanup menu to weld the wall.

To remove an opening from your drawing:

1. Go to the Edit menu in the Menu Window and click on Architect.

2. Click on Cut Wall in the Architect menu or click on \( \text{cut wall} \) in the context-sensitive Architect toolbar. The Cut Wall menu appears.

3. Determine which layer contains your walls.
   - If you don’t want to search for the wall layer, toggle on Any Layer.
   - If you want to cut walls that appear on a specific layer, toggle on One Layer to list the layers in your drawing. Then select the layer you want from the list.

4. Click on Remove in the Cut Wall menu.

5. Click to one side of the opening and move your mouse diagonally to stretch the rubber band box around it, completely enclosing all elements of the opening. You can stretch the box around multiple openings to remove them all at once.

6. Click to complete the box. DataCAD LT removes the opening and welds the wall. If any remnant of the opening remains, click (Esc) to refresh the drawing.

### Drawing Doors

Not only can you draw walls using the Architect menu, you can also use it to draw doors, complete with door swings, in a few quick steps. DataCAD LT places a jamb into the wall, erases the wall between the jambs, draws the door at the specified thickness, and draws the door swing in the direction you designated and the angle you selected.

You can draw doors by selecting the sides of the door or by selecting the center and strike side of the door. When toggled on, the Sides option lets you draw doors by indicating the door sides (door jambs). When Sides is toggled off, doors are drawn by indicating their center and strike side.

You can use the One Layer toggle if you want to select the specific layer (from those listed) that contains the walls you want to cut for the doors. If you toggle on Any Layer, DataCAD LT will search all the “on” layers for the walls that can hold your doors.

To draw a door using the mouse:

1. Go to the Edit menu in the Menu Window and click on Architect.
2. Click on Door Swing in the Architect menu. The Door Swing menu appears. You can also access the Door Swing menu in the Edit/Architect menu using the Doors option in the DCAD_AEC macro in the Toolbox pull-down menu. In addition, you can click on the icon if you loaded the Draw toolbar.

3. Set the door jamb, angle, style, thickness, head height, and swing style as necessary. See the following pages for more information on setting these door options.

4. Look at the Sides toggle switch. If Sides is toggled on, you are prompted to Select hinge side of door. If Sides is toggled off, you are prompted to Select center of door. To enter the point you’re prompted for, click on a wall or use coordinate entry. You are prompted to Select strike side of door.

5. Click on the wall or use coordinate entry to enter the strike side of the door. You are prompted to Select direction of door swing. See “Drawing with Coordinate Entry” in “The Drawing Board” chapter.

6. Click either inside or outside the wall to indicate which direction the door should swing. You are prompted to Select any point on the outside of the wall.

7. Click anywhere outside the wall. The door and doorjamb are drawn.

![Diagram of door drawing process]

**Figure 8.4:** Drawing a door

**More About Door Styles**

The Door Style menu allows you to choose from six door styles: single, double, bi-fold, sliding, pocket, and overhead. See Figure 8.5 for examples of door styles. Single creates single-leaf, hinged doors of any size. This is the default setting for the Door Style menu. Click on Double to draw two opposing doors hung on a single frame. Bi-fold creates simplified folding doors, while Sliding creates 2-panel sliding doors, and Pocket creates pocket doors. Click on Overhead to create overhead garage doors. A dotted line representing the overhead door in a raised position will be drawn, with the dimensions equaling the width and head height of the door.
**More About Door Jambs**

Some of the Door Swing menu options affect how the door is drawn in the wall. Click on Draw Jamb, In Wall, or Cutout to toggle the option on. The Draw Jamb option draws jambs for each wall opening, while In Wall precisely centers door openings between the two wall faces, and Cutout removes the wall segment between the two jambs. An added benefit to drawing doors with Cutout toggled on is that the walls will automatically weld themselves if you use Remove to erase the door. If you toggled on One Layer, DataCAD LT presents a list of the layers in your drawing so that you can choose the wall layer where the doors should be drawn.

Jamb In is a toggle that determines whether the door will be drawn by rough opening or finished opening. *Rough opening* means that the door jamb is drawn inside the opening specified; *finished opening* means the door jamb will be drawn outside the opening specified. By default, Jamb In is toggled off, meaning the door will be drawn by finished opening. When Jamb In is toggled on, DataCAD LT draws the door by rough opening.

To explain further, when using Sides to draw a door with Jamb In off, the two points you select mark the inside of the finished opening; therefore, the jamb will be drawn outside the two points specified. If you toggle Jamb In on and draw another door, the two points you select mark the rough opening in the wall and the jamb is drawn inside the two points.

You can also change the jamb width for your doors.

→ To set a new jamb width:

   1. Go to the Edit menu in the Menu Window and click on Architect.
   2. Click on Door Swing in the Architect menu. The Door Swing menu appears.
   3. Click on Jamb Width in the Door Swing menu.
   4. Choose or type a jamb width value and press (Enter).

Match Wall in the Door Swing menu is toggled on by default, causing jamb depth to automatically match the wall width. When Match Wall is toggled off, the Jamb Depth option becomes available; you can use Jamb Depth to set the jamb depth independently of the wall width. Jamb Depth is only available from the menu when Match Wall is toggled off.
More About Door Angles

Click on Angle in the Door Swing menu to determine the door opening. An angle set to 0-0’ will result in the doors being drawn closed, while a 90-0’ angle will result in the doors being drawn fully open. For bi-fold doors, a 90° angle creates a right angle at the intersection of each door. When an angle between 0-0’ and 90-0’ is entered, DataCAD LT will draw single and double doors open to varying degrees.

DataCAD LT will draw sliding and pocket doors open to varying degrees when an angle between 10-0’ and 90-0’ is chosen. When any angle 90-0’ or greater is chosen, sliding and pocket doors will be drawn fully open. When fully open, sliding doors will be drawn to one side and at the first point chosen for the door opening, making the opening at the second point. When doors are drawn closed, the door overlap is equal to double the door thickness. The Angle setting does not affect Overhead doors; they are always drawn the same, regardless of angle.

To set the angle of the door opening:

1. Go to the Edit menu in the Menu Window and click on Architect.
2. Click on Door Swing in the Architect menu. The Door Swing menu appears.
3. Click on Angle in the Door Swing menu.
4. Use the value menu to enter a new angle or type an angle value and press (Enter). An angle of 0-0’ draws doors closed. An angle of 90-0’ draws most doors fully open. See “Value Menus” in “The Drawing Board” chapter for more information on how to use them.

More About Door Swing

The Swing Style option in the Door Style menu lets you choose the type and color of the door swing. From the Swing Style menu, you can choose to draw either a line or arc swing style or to have no door swing drawn at all. The Line option draws a straight line from the corner of the door jamb to the corner of the open door to represent the door swing. The Arc option draws a curve from the corner of the jamb to the corner of the door.

With both Line and Arc, you can toggle Match Door on in the Swing Style menu to match the door swing color to the door color. This option is toggled on by default. When Match Door is toggled off, the Swing Color option is available in the menu. Click on Swing Color to choose a color for the door swing, independent from the door color.

More About Other Door Settings

Regardless of which way you draw a door, you can use Center Point to add a point in the center of the door. Then you can use the automatic dimensioning feature to find and dimension to this center point. See “Drawing Linear Dimensions” in the “Dimensions” chapter.

The Draw Marks option in the Door Swing menu is another helpful, visual drawing aid. With Draw Marks toggled on, DataCAD LT draws small crosses on the screen where you’ve selected points in the Drawing Area. These marks are a temporary visual reference only; they disappear when you press (Esc) to refresh the screen. They don’t plot and you can’t object snap to them.

This Draw Marks option is independent of Draw Marks in the Utility/Settings menu and affects only doors and windows. See “Setting Display Options” in the “Before You Draw” chapter for more information on the Settings menu’s Draw Marks option.

The Door Swing menu also has options to set the door thickness and head height.
To set the door thickness:
1. Go to the Edit menu in the Menu Window and click on Architect.
2. Click on Door Swing in the Architect menu. The Door Swing menu appears.
3. Click on Thickness in the Door Swing menu. A value menu appears.
4. Use the value menu to enter a door thickness or type a thickness value and press (Enter). See "Value Menus" in "The Drawing Board" chapter for more information on how to use them.

To set the door head height:
1. Go to the Edit menu in the Menu Window and click on Architect.
2. Click on Door Swing in the Architect menu. The Door Swing menu appears.
3. Click on Head Height in the Door Swing menu. A value menu appears.
4. Use the value menu to enter a door thickness or type a height value and press (Enter).

Removing a Door
You can quickly remove any door from your drawing and automatically weld the wall with the Remove option in the Door Swing menu. Keep in mind that Remove only erases the door if Cutout was toggled on in the Door Swing menu when the door was drawn. If you didn't use Cutout when you drew the door, use Erase to erase the door as a group. You will then need to use Weld Wall in the Edit/Cleanup menu to weld the wall. See "Erasing Entities" and "Welding Lines and Walls" in the "Editing Drawings" chapter.

To remove a door from your drawing:
1. Go to the Edit menu in the Menu Window and click on Architect.
2. Click on Door Swing in the Architect menu. The Door Swing menu appears.
3. Click on Remove in the Door Swing menu. You are prompted to Select first point of box around door or window to remove.
4. Click above and to the left of the door to be removed.
5. Move your mouse diagonally, completely enclosing all elements of the door, and click. DataCAD LT removes the door. You can stretch the box around multiple doors to remove them all at once.

Drawing Windows
The Windows option draws windows with cased openings in walls, either by selecting the sides of the window or by selecting the center and strike side of the window. You can customize the detail of the windows by changing basic window components, including jamb size, sill projection, glass thickness, sill height, and head height.

To draw a window:
1. Go to the Edit menu in the Menu Window and click on Architect.
2. Click on Windows in the Architect menu. The Windows menu appears.
3. Set the window jamb, exterior and interior sill projections, thickness of glass, and sill height and head height as necessary. See the following pages for more information on setting window options.
4. Toggle Sides on to draw windows by selecting the window sides (jambs); toggle Sides off to draw windows by selecting their center point and one side. If Sides is toggled on, you are prompted to Select one jamb of window. If Sides is toggled off, you are prompted to Select center of window.

5. Click on a wall to enter one side of the window jamb or the center of the window. You are prompted to Select second jamb of window or Select one jamb of window, depending on the status of the Sides toggle.

If One Layer is toggled, you may encounter the error message No walls found to cut. Please check search layer. Toggle One Layer on (if it’s already on, toggle it off and then on again) to display the layers in your drawing. Choose the layer your walls are drawn on from the list in the Menu Window.

6. Click on the wall to enter the side of the window jamb. You are prompted to Select any point on the outside of the wall.

7. Click outside the wall. The window is drawn.

![Diagram](image)

**Figure 8.6**: Drawing a window with Sides toggled on

**More About Window Jambs**

Some of the Windows menu’s options affect how the window is drawn in the wall. The Draw Jamb option draws window jambs for each wall opening, while In Wall precisely centers window openings between the two wall faces, and Cutout removes the wall segment between the two jambs. Click on Draw Jamb, In Wall, or Cutout to toggle the option on. An added benefit to drawing windows with Cutout toggled on is that the walls will automatically weld themselves if you use Remove to erase the window. You may need to use One Layer with this if you’re drawing windows on a different layer than your walls are on; click on One Layer and then click on the layer your walls are on.

Jamb In is a toggle that determines whether the window will be drawn by rough opening or finished opening. Rough opening means that the window jamb is drawn inside the opening specified; finished opening refers to the window jamb being drawn outside the opening specified. By default, Jamb In is toggled off, meaning the window will be drawn by finished opening. When Jamb In is toggled on, DataCAD LT draws the window by rough opening.

To explain further, when using Sides to draw a window with Jamb In off, the two points you select mark the inside of the finished opening; the jamb will be drawn outside the two points specified. If you toggle Jamb In on and draw another window, the two points you select mark the rough opening in the wall; the jamb is drawn inside the two points.

Match Wall is toggled on by default, causing the jamb depth of the window to automatically match the wall width. When this option is toggled off, you can use Jamb Depth to set the jamb depth independently of the wall width. Jamb Depth is only available from the menu when Match Wall is toggled off.

You can also change the jamb width for your windows.
To set a new jamb width:
1. Go to the Edit menu in the Menu Window and click on Architect.
2. Click on Windows in the Architect menu. The Windows menu appears.
3. Click on Jamb Width in the Windows menu.
4. Use the value menu to enter a jamb width or type a jamb width value and press (Enter).

More About Sill and Glass Settings
Other Windows options you’ll want to set include distances for the exterior and interior sill projections, the thickness of the glass, and the sill height and head height.

To change the distance of the exterior sill projection:
1. Go to the Edit menu in the Menu Window and click on Architect.
2. Click on Windows in the Architect menu. The Windows menu appears.
3. Click on Out Sill in the Windows menu. A value menu appears.
4. Use the value menu to enter a new exterior sill projection or type a sill projection value and press (Enter).

To change the distance of the interior sill projection:
1. Go to the Edit menu in the Menu Window and click on Architect.
2. Click on Windows in the Architect menu. The Windows menu appears.
3. Click on In Sill in the Windows menu. A value menu appears.
4. Use the value menu to enter a new interior sill projection or type a sill projection value and press (Enter).

To change the thickness of the glass:
1. Go to the Edit menu in the Menu Window and click on Architect.
2. Click on Windows in the Architect menu. The Windows menu appears.
3. Click on Glass Thk. in the Windows menu. A value menu appears.
4. Use the value menu to enter a new thickness or type a new value and press (Enter). If you enter a thickness of 0", DataCAD LT draws a single sheet of glass.

To enter a new window sill height relative to the current Z-base elevation:
1. Go to the Edit menu in the Menu Window and click on Architect.
2. Click on Windows in the Architect menu. The Windows menu appears.
3. Click on Sill Height in the Windows menu. A value menu appears.
4. Use the value menu to enter a new exterior sill projection or type a new height value and press (Enter).

To enter a new window head height relative to the current Z-base elevation:
1. Go to the Edit menu in the Menu Window and click on Architect.
2. Click on Windows in the Architect menu. The Windows menu appears.
3. Click on Head Height in the Windows menu. A value menu appears.
4. Use the value menu to enter a new exterior sill projection or type a new height value and press (Enter).

More About Other Window Settings
Regardless of which way you draw a window, you can use Center Point to add a point in the center of the window. You can use DataCAD LT's automatic dimensioning feature to find and dimension to this center point.

The Draw Marks option in the Windows menu is another helpful, visual drawing aid. With Draw Marks toggled on, DataCAD LT draws small crosses on the screen when you select points in the Drawing Area. This Draw Marks option is independent of Draw Marks in the Utility/Settings menu and affects only doors and windows. These marks are a temporary visual reference only; they disappear when you press (Esc) to refresh the screen. They don’t plot and you can’t object snap to them.

Removing a Window
You can quickly remove any window from your drawing and automatically weld the wall with the Remove option in the Windows menu. Keep in mind that Remove only erases the window if Cutout was toggled on in the Windows menu when the window was drawn. If you didn’t use Cutout when you drew the window, use Erase to erase the window as a group. You will then need to use Weld Wall in the Edit/Cleanup menu to weld the wall.

➤ To remove a window from your drawing:
1. Go to the Edit menu in the Menu Window and click on Architect.
2. Click on Windows in the Architect menu. The Windows menu appears.
3. Click on Remove in the Windows menu. You are prompted to Select first point of box around door or window to remove.
4. Click above and to the left of the window to be removed.
5. Move your mouse diagonally, completely enclosing all elements of the window, and click. DataCAD LT removes the window. You can stretch the box around multiple windows to remove them all at once.
Drawing Other Geometry

DataCAD LT offers several additional drawing tools outside of the Architect menu. The Polygons and Curves menus in the Edit menu allow you to draw a number of geometric shapes, from simple rectangles to Bezier curves.

In this chapter:

- Drawing polygons
- Drawing curves
- Drawing polylines
- Drawing stairs
- Drawing elevators
Drawing Polygons

With the Polygons menu, you can draw rectangles or polygons with up to 36 sides. DataCAD LT uses a temporary circle to define a polygon. The relationship between this circle and the resulting polygon is dependent on the Inscribe option (see Figure 9.1). The points you select to draw the polygon will determine the orientation of the polygon in your drawing.

To draw a polygon:

1. Go to the Edit menu in the Menu Window and click on Polygons. You can also click on the icon in the Draw toolbar. The Polygons menu appears.

2. Look at the toggle switches. The Dynamic, Center Point, Vertex, Diameter, and Inscribe options are toggled on by default. Change these settings as necessary. See “Polygon Menu Options” below for more information.

3. Click on No. of Sides in the Polygons menu. A value menu appears and you are prompted to Enter number of sides.

4. Use the value menu or type a number and press (Enter). You are prompted to Select first point on polygon.

5. Click in the Drawing Area or use coordinate entry to select the first point for the polygon, as prompted. See “Drawing Using Coordinate Entry” in “The Drawing Board” chapter to review coordinate entry methods.

6. Click to select the second point on the outside of the temporary circle used to define the polygon. With Diameter toggled off, the distance between these two points defines the radius of the temporary circle; with Diameter toggled on, the distance between the points is the diameter of the circle. The polygon is drawn.

![Polygon drawn with Inscribe on](image1.png)  ![Polygon drawn with Inscribe off](image2.png)

**Figure 9.1:** Polygons are actually defined by two points on a circle. These circles are not displayed.

Polygon Menu Options

When you create polygons with both Vertex and Diameter toggled on, the two points you specify are vertices opposite each other on the polygon. With Vertex on and Diameter off, you specify the center point and one vertex. With Vertex off and Diameter on, you specify the mid-point of two sides of the polygon that are opposite each other.
Dynamic Toggle on to see the size and shape of the polygon you’re drawing before you choose the second point; Dynamic is toggled on by default.

Center Point Toggle on to display a snapping point, marking the center of the polygon; Center Point is toggled on by default.

Vertex Toggle on to draw polygons by defining two vertices of the polygon; toggle off to define polygons by the mid-points of opposite sides of the polygon; Vertex is toggled on by default.

Diameter Toggle on to draw polygons by defining the diameter of the polygon (two points opposite each other); toggle off to define the radius of the polygon (the center point and one side or vertex); Diameter is toggled on by default.

Inscribe Toggle on to draw polygons as though they were inscribed within a circle; toggle off to draw polygons as though a circle was inscribed within them (see Figure 9.1); Inscribe is toggled on by default. See Figure 9.1 for more information about using Inscribe.

**Drawing Rectangles**

To draw a rectangle, you must select two diagonally opposite corner points. The X and Y coordinates of these diagonal corners appears in the Message Area as you draw the rectangle.

To draw a rectangle:

1. Click on Polygons in the Edit menu. You can also click on the icon in the Draw toolbar.

   **Shortcut:** Press (Alt) + (R) to access the Polygons menu.

2. Click on Rectangle in the Polygons menu.

3. Toggle Center Point on to automatically add a snap point marking the center of the rectangle. If Walls are toggled on and the Outside or Inside option in the Architect menu is toggled on as well, you will be prompted to indicate the inside or outside of the wall, respectively, after you enter the second point for your rectangle.

4. Click in the Drawing Area or use coordinate entry to select the first point of the rectangle. For more information on using coordinate entry, see “Drawing Using Coordinate Entry” in “The Drawing Board” chapter.

5. Move the cursor diagonally and click or use coordinate entry to enter the second point of the rectangle. The rectangle is drawn.
**Drawing Curves**

You can draw circles, arcs, ellipses, and other curvilinear entities using a wide variety of methods.

Selecting from the Menu Window is the traditional method. You can also click on \( ☐ \) in the Draw toolbar to open the drop-down menu that offers many curve-drawing alternatives:

- Draw arcs, circles, and polylines
- Draw curve by center, starting, and end points
- Draw curve tangent from an existing line or curve
- Draw circle by radius method
- Create three-dimensional contours
- Draw polylines
- Draw ellipse within a rectangular boundary

**Shortcut:** Press (Alt) + (A) to access the Curves menu.

**Drawing 2-Point Arcs**

Two-point arcs are drawn by indicating the radius of the arc and then defining the length of the arc.

**Figure 9.2:** 2-point arc

To draw a 2-point arc:

1. Click on Curves in the Edit menu in the Menu Window to display the Curves menu. Alternatively, click on \( ☐ \) in the Draw toolbar, select \( ☐ \) from the drop-down options to display the 2 Pt. Arc menu, and skip to step 3.

2. Click on 2 Pt. Arc in the Curves menu. You can also click on 2D Curves in the Create pull-down menu and then click on 2-Point Arc in the submenu. The 2 Pt. Arc menu appears.

3. Toggle Dynamic on in the 2 Pt. Arc menu to preview the arc before you enter the final point. With Dynamic toggled on, you can move your mouse around the center point to preview the arc at various angles before selecting the second point. You are prompted to Select center of arc.

4. Select the center point of the arc by clicking in the Drawing Area or using coordinate entry. For more information on coordinate entry, see “**Drawing Using Coordinate Entry**” in “The Drawing Board” chapter. You are prompted to Select start point of arc.

5. Select the first point on the arc by clicking in the Drawing Area or using coordinate entry. The Clockwise option is now available in the menu. You are prompted to Select end point of arc.
6. Toggle Clockwise on to draw the arc clockwise from the first point; toggle it off to draw the arc counterclockwise.

7. Select the second point on the arc by clicking in the Drawing Area or using coordinate entry. This point is used only to determine the angle of the arc, so it doesn’t have to be exactly on the arc. The arc is drawn.

**Drawing 3-Point Arcs**

Three-point arcs are drawn by selecting the end points of the arc as well as one other point on the arc.

![Figure 9.3: 3-point arc](image)

To draw a 3-point arc:

1. Click on Curves in the Edit menu in the Menu Window to display the Curves menu. Alternatively, click on \[\text{Curves}^\rightarrow\] in the Draw toolbar and select \[\text{Draw arcs, circles, and polylines}\] from the drop-down options.

2. Click on 3 Pt. Arc in the Curves menu. You can also click on 2D Curves in the Create pull-down menu and then click on 3-Point Arc in the submenu. The 3 Pt. Arc menu appears.

3. Toggle Dynamic on in the 3 Pt. Arc menu to preview the arc before you enter the final point. With Dynamic toggled on, you can move your mouse to preview the arc at various angles before selecting the third point. You are prompted to Select first end point of arc.

4. Select the first end point of the arc by clicking in the Drawing Area or using coordinate entry. You are prompted to Select second end point of arc. For more information on coordinate entry, see “Drawing Using Coordinate Entry” in “The Drawing Board” chapter.

5. Select the second end point of the arc by clicking in the Drawing Area or using coordinate entry. Keep in mind when selecting the second end point that the arc will be drawn in a counterclockwise direction. You are prompted to Select any point on the arc.

6. Select the third point on the arc by clicking in the Drawing Area or using coordinate entry. The arc is drawn, along with its center point.
**Drawing Arcs By Center Angle**

You can draw arcs based on a center angle that you define.

![Diagram](Image)

**Figure 9.4:** An arc defined by selecting an end point, the center point, and an angle

To draw an arc by defining the center angle:

1. Click on Curves in the Edit menu in the Menu Window. Or click on \[\text{Draw arcs, circles, and polylines}\] in the Draw toolbar and select `Draw arcs, circles, and polylines` from the drop-down options. The Curves menu appears.

2. Click on Cent. Angle in the Curves menu. You can also click on 2D Curves in the Create pull-down menu and then click on Center Angle Arc in the submenu. The Cent. Angle menu appears and you are prompted to Select starting point of arc.

3. Select the first end point of the arc by clicking in the Drawing Area or using coordinate entry. For more information on coordinate entry, see “Drawing Using Coordinate Entry” in “The Drawing Board” chapter. Keep in mind when selecting this starting point that the arc will be drawn in a counterclockwise direction. You are prompted to Select starting point of arc.

4. Select the center point of the arc by click in the Drawing Area or using coordinate entry. You are prompted to Enter included angle; a value menu listing angle values appears.

5. Type an angle or use the value menu to enter an angle and press (Enter). For more information on using value menus, see “Value Menus” in “The Drawing Board” chapter. The arc is drawn.

**Drawing Arcs By Arc Length**

You can draw arcs by defining their length.

![Diagram](Image)

**Figure 9.5:** An arc defined by the starting point, center point, and length of the arc
To draw an arc based on the arc’s length:

1. Click on Curves in the Edit menu in the Menu Window. Or click on \( \text{Draw arcs, circles, and polylines} \) in the Draw toolbar and select \( \text{Draw arcs, circles, and polylines} \) from the drop-down options. The Curves menu appears.

2. Click on Cent. Arc in the Curves menu. You can also click on 2D Curves in the Create pull-down menu and then click on Center Arc in the submenu. The Cent. Arc menu appears and you are prompted to Select starting point of arc.

3. Select the first end point of the arc by clicking in the Drawing Area or using coordinate entry. For more information on coordinate entry, see “Drawing Using Coordinate Entry” in “The Drawing Board” chapter. Keep in mind when selecting this starting point that the arc will be drawn in a counterclockwise direction. You are prompted to Select center of arc.

4. Select the center point of the arc by clicking in the Drawing Area or using coordinate entry. You are prompted to Enter arc length; a value menu appears.

5. Type a length or use the value menu to enter a length, and press (Enter). For more information on using value menus, see “Value Menus” in “The Drawing Board” chapter. The arc is drawn.

**Drawing Arcs By Chord Length**

You can draw arcs by defining the length of a chord, measuring from the starting point of the arc to an end point.

![Figure 9.6: An arc defined by selecting the starting point of the arc, its center point, and the length of a chord from end point to end point.](image)

To draw an arc based on chord length:

1. Click on Curves in the Edit menu in the Menu Window. Or click on \( \text{Draw arcs, circles, and polylines} \) in the Draw toolbar and select \( \text{Draw arcs, circles, and polylines} \) from the drop-down options. The Curves menu appears.

2. Click on Cent. Chord in the Curves menu. You can also click on 2D Curves in the Create pull-down menu and then click on Center Chord Arc in the submenu. The Cent. Chord menu appears and you are prompted to Select starting point of arc.
3. Select the first end point of the arc by click in the Drawing Area or using coordinate entry. For more information on coordinate entry, see “Drawing Using Coordinate Entry” in “The Drawing Board” chapter. Keep in mind when selecting this starting point that the arc will be drawn in a counterclockwise direction. You are prompted to Select center of arc.

4. Select the center point of the arc by clicking in the Drawing Area or using coordinate entry. You are prompted to Enter chord length; a value menu appears. For more information on using value menus, see “Value Menus” in “The Drawing Board” chapter.

5. Type a length or use the value menu to enter a length and press (Enter). The arc is drawn.

**Drawing Arcs By Radius**

You can draw arcs by selecting two endpoints and then entering the length of the arc’s radius.

![Arc](image)

Figure 9.7: An arc defined by selecting a starting point and an ending point for the arc and then setting an arc radius

To draw an arc based on a specified radius:

1. Click on Curves in the Edit menu in the Menu Window. Or click on \( \text{Draw arcs, circles, and polylines} \) in the Draw toolbar and select \( \text{Draw curves} \) from the drop-down options. The Curves menu appears.

2. Click on End Pt. Rad in the Curves menu. You can also click on 2D Curves in the Create pull-down menu and then click on End Point Radius Arc in the submenu. The End Pt. Rad menu appears and you are prompted to Select starting point of arc.

   To properly define an arc, you must make the radius value larger than half the distance between the starting and ending points. If the message *These points do not define an arc* appears in the Attention toolbar, increase the radius length.

3. Select the first end point of the arc by clicking in the Drawing Area or using coordinate entry. Keep in mind when selecting this starting point that the arc will be drawn in a counterclockwise direction. You are prompted to Select ending point of arc.

4. Select the end point of the arc by clicking in the Drawing Area or using coordinate entry. You are prompted to Enter radius of arc; a value menu appears.

5. Type a radius length or use the value menu to enter a radius and press (Enter). The arc is drawn.

**Drawing Arcs By Included Angle**

You can draw arcs by selecting the end points of the arc and then entering an arc angle.
To draw an arc based on its included angle:

1. Click on Curves in the Edit menu in the Menu Window. Or click on \( \text{Draw arcs, circles, and polylines} \) in the Draw toolbar and select \( \text{Draw arcs, circles, and polylines} \) from the drop-down options. The Curves menu appears.

2. Click on End Pt. Ang. in the Curves menu. You can also click on 2D Curves in the Create pull-down menu and then click on End Point Angle Arc in the submenu. The End Pt. Ang. menu appears and you are prompted to Select starting point of arc.

3. Select the first end point of the arc by clicking in the Drawing Area or using coordinate entry. For more information on coordinate entry, see “Drawing Using Coordinate Entry” in “The Drawing Board” chapter. Keep in mind when selecting this starting point that the arc will be drawn in a counterclockwise direction. You are prompted to Select ending point of arc.

4. Select the end point of the arc by clicking in the Drawing Area or using coordinate entry. You are prompted to Enter included angle; a value menu appears.

5. Type an angle or use the value menu to enter an angle and press (Enter). For more information on using value menus, see “Value Menus” in “The Drawing Board” chapter. The arc is drawn.

**Drawing Arcs Using a Tangent Line**

The Start Ang. option in the Curves menu uses a temporary tangent line to define the angle of the arc.

1. Click on Curves in the Edit menu in the Menu Window. Or click on \( \text{Draw arcs, circles, and polylines} \) in the Draw toolbar and select \( \text{Draw arcs, circles, and polylines} \) from the drop-down options. The Curves menu appears.
2. Click on Start Ang. in the Curves menu. You can also click on 2D Curves in the Create pull-down menu and then click on Start Direction of Arc in the submenu. The Start Ang. menu appears and you are prompted to Select starting point of arc.

3. Select the first end point of the arc by clicking in the Drawing Area or using coordinate entry. For more information on coordinate entry, see “Drawing Using Coordinate Entry” in “The Drawing Board” chapter. Keep in mind when selecting this starting point that the arc will be drawn in a counterclockwise direction. You are prompted to Select ending point of arc.

4. Select the end point of the arc by clicking in the Drawing Area or using coordinate entry. You are prompted to Select starting direction of arc. Notice that a line is now connected to the starting point you entered and the line moves as you move your mouse.

5. Move your cursor until the line is positioned as a tangent line to the arc you want to draw.

6. Click to set the tangent line. The arc is drawn. If Ortho mode is toggled on in the Tools pull-down menu, the tangent line will “jump” in increments equal to the snap angle setting.

**Drawing Tangent Arcs**

You can draw arcs that are tangent to an existing line or arc by simply selecting the entity to be tangent and then selecting an end point.

➤ To draw arcs tangent to another entity:

1. Click on Curves in the Edit menu in the Menu Window to display the Curves menu and then click on Tangent. Or click on \[
\text{Draw curve tangent from an existing line or curve}
\]
in the Draw toolbar, select from the drop-down options. You can also click on 2D Curves in the Create pull-down menu and then click on Tangent Arc in the submenu. The Tangent menu appears; Dynamic is toggled on by default, allowing you to preview the arc before entering the final point. You are prompted to Select line or arc from which to draw.

2. Move your cursor over the entity that will be tangent to the arc you’re drawing and click to select it. You can also object snap to an entity at a particular point. For more information on object snapping, see “Object Snapping” in the “Drawing Tools” chapter. If you’ve selected the wrong entity, click on New Line in the Tangent menu (or simply right-click using your mouse) to deselect the entity; you can then select another entity for your tangent. You are prompted to Select ending point of arc.

3. Select the end point of the arc by clicking in the Drawing Area or using coordinate entry. For more information on coordinate entry, see “Drawing Using Coordinate Entry” in “The Drawing Board” chapter. The arc is drawn. Notice your cursor is still attached to the arc. You can continue drawing tangent arcs by entering end points. Right-click to detach your cursor from the last arc you drew.

**Drawing Circles By Radius**

You can draw a circle by defining its radius.
To draw a circle based on its radius:

1. Click on Curves in the Edit menu in the Menu Window to display the Curves menu and then click on Radius Circ. Or click on in the Draw toolbar and select . You can also click on 2D Curves in the Create pull-down menu and then click on Radius Circle in the submenu. The Radius Circ. menu appears with Dynamic toggled on by default, allowing you to preview the circle before you select the last point. You are prompted to Select center of circle.

2. Select the center point of the circle by clicking in the Drawing Area or using coordinate entry. For more information on coordinate entry, see “Drawing Using Coordinate Entry” in “The Drawing Board” chapter. Notice the radius (and, therefore, the circle) changes size as you move your mouse. You are prompted to Select any point on circle.

4. Select a point on the circle by clicking in the Drawing Area or using coordinate entry. The circle is drawn.

**Drawing Circles By Diameter**

You can draw a circle by defining its diameter.

To draw a circle based on its diameter:

1. Click on Curves in the Edit menu in the Menu Window. Or click on in the Draw toolbar and select from the drop-down options. The Curves menu appears.
2. Click on Dia. Circ. in the Curves menu. You can also click on 2D Curves in the Create pull-down menu and then click on Diameter Circle in the submenu. The Dia. Circ. menu appears with Dynamic toggled on by default, allowing you to preview the circle before you select the last point. You are prompted to Select first point on circle.

3. Select the first point on the circle by clicking in the Drawing Area or using coordinate entry. Notice the diameter (and, therefore, the circle) changes size as you move your mouse. You are prompted to Select second point on circle.

4. Select the second point on the circle by clicking in the Drawing Area or using coordinate entry. The circle is drawn.

**Drawing Circles By Points**

You can draw a circle by defining three points on the circle.

![Figure 9.12: A circle defined by selecting three points](image)

To draw a circle by selecting points:

1. Click on Curves in the Edit menu in the Menu Window. Or click on ![Draw arcs, circles, and polylines](image) in the Draw toolbar and select ![Draw arcs, circles, and polylines](image) from the drop-down options. The Curves menu appears.

2. Click on 3 Pt. Circ. in the Curves menu. You can also click on 2D Curves in the Create pull-down menu and then click on 3-Point Circle in the submenu. The 3 Pt. Circ. menu appears with Dynamic toggled on by default, allowing you to preview the circle before you select the last point. You are prompted to Select first point on circle.

3. Select the first point on the circle by clicking in the Drawing Area or using coordinate entry. For more information on coordinate entry, see “Drawing Using Coordinate Entry” in “The Drawing Board” chapter. You are prompted to Select second point on circle.

4. Select the second point on the circle by clicking in the Drawing Area or using coordinate entry. Notice the circle changes size as you move your mouse. You are prompted to Select third point on circle.

5. Select the third point on the circle by clicking in the Drawing Area or using coordinate entry. The circle is drawn.

**Drawing Ellipses**

You can draw ellipses by simply selecting two diagonally opposed points, as though you were selecting two diagonal corners of a rectangle.
To draw an ellipse:

1. Click on Curves in the Edit menu in the Menu Window to display the Curves menu; then click on Ellipse. Or click on \[ \text{Draw ellipse within a rectangular boundary} \] in the Draw toolbar and select \[ \text{Draw ellipse within a rectangular boundary} \] from the drop-down options; then click on Ellipse in the Curves menu. In the Ellipse menu, Dynamic is toggled on by default, allowing you to preview the ellipse before you select the last point. You are prompted to Select first corner of ellipse rectangle.

2. Select the first point for the ellipse by clicking in the Drawing Area or using coordinate entry. For more information on coordinate entry, see “Drawing Using Coordinate Entry” in “The Drawing Board” chapter. Notice the ellipse changes shape and size as you move your mouse. You are prompted to Select second corner of ellipse rectangle.

3. Select the second point for the ellipse by clicking in the Drawing Area or using coordinate entry. The ellipse is drawn.

**Drawing Curves Using Control Points**

You can draw more complex curves by selecting control points that affect how the curves are drawn.

![Control Points](image1)

**Figure 9.13:** A Bezier curve with selected control points

![Control Points](image2)

**Figure 9.14:** A B-spline curve with selected control points

To draw a Bezier curve:

1. Click on Curves in the Edit menu in the Menu Window. Or click on \[ \text{Draw arcs, circles, and polylines} \] in the Draw toolbar and select \[ \text{Draw arcs, circles, and polylines} \] from the drop-down options. The Curves menu appears.
2. Click on Bezier in the Curves menu. You can also click on 2D Curves in the Create pull-down menu and then click on Bezier Curve in the submenu. The Bezier menu appears with Dynamic toggled on by default, allowing you to preview the curve as you select control points. You are prompted to Select Bezier control point.

3. Select a control point for the curve by clicking in the Drawing Area or using coordinate entry. For more information on coordinate entry, see “Drawing Using Coordinate Entry” in “The Drawing Board” chapter.

4. Continue selecting control points; you must select at least three but no more than eight points.

5. Right-click to detach your cursor from the curve. The Bezier curve is drawn. If you enter all eight control points, your cursor is detached automatically and the curve is drawn.

The formula used to create B-spline curves in DataCAD LT is specific to Third Order splines.

To draw a B-spline curve:

1. Click on Curves in the Edit menu in the Menu Window. Or click on \[ \text{Draw arcs, circles, and polylines} \] in the Draw toolbar and select \[ \text{Draw arcs, circles, and polylines} \] from the drop-down options. The Curves menu appears.

2. Click on B-Spline in the Curves menu. You can also click on 2D Curves in the Create pull-down menu and then click on B-Spline Curve in the submenu. The B-Spline menu appears with Dynamic toggled on by default, allowing you to preview the curve as you select control points. You are prompted to Select B-Spline control point.

3. Select a control point for the curve by clicking in the Drawing Area or using coordinate entry. For more information on coordinate entry, see “Drawing Using Coordinate Entry” in “The Drawing Board” chapter.

4. Continue selecting control points; you must select at least three but no more than eight points.

5. Right-click to detach your cursor from the curve. The B-spline curve is drawn. If you enter all eight control points, your cursor is detached automatically and the curve is drawn.

**Drawing Curves Using Surveyor’s Data**

You can draw curves based on surveyor’s data that you enter. Based on this data and the options you use, DataCAD LT can even extrapolate additional data. For instance, if you enter the radius point of the curve, the central angle of the curve, and the starting point of the curve, DataCAD LT can calculate the coordinates of the ending point and draw the curve. For more information on the options noted in Figure 9.15, see “Curve Data Menu Options” on the following page.
Figure 9.15: An arc drawn by entering surveyor’s data

To draw a curve using surveyor’s data:

1. Click on Curves in the Edit menu in the Menu Window. Or click on \( \text{Draw arcs, circles, and polylines} \) in the Draw toolbar and select \( \text{Draw arcs, circles, and polylines} \) from the drop-down options. The Curves menu appears.

2. Click on Curve Data in the Curves menu. You can also click on 2D Curves in the Create pull-down menu and then click on Curve from Data in the submenu. The Curve Data menu appears.

3. Enter the surveyor’s data using Curve Data menu options. Once enough information has been entered to draw the curve, an Add option appears in the Curve Data menu.

4. Click on Add. The curve is drawn.

**Curve Data Menu Options**

- **Radius Point** Defines the center (or radius point) of the curve.
- **Start Point** Defines the starting point (or the point) of the curve.
- **End Point** Defines the ending point (or point of tangency) of the curve.
- **Int. Point** Defines the point of intersection, where the tangent line intersects the starting point of the curve.
- **Angle** Defines the central angle about the radius point.
- **Radius** Defines the radius of the curve, or the distance between the radius point and the starting point or the ending point of the curve.
- **Tangent** Defines the distance from the starting point or ending point to the intersection of the tangent lines to these two points.
- **Chord** Defines the straight-line distance between the starting point and the ending point of the curve.
- **Arc Length** Defines the distance along the curve from the starting point to the ending point.
- **Bearing In** Defines the bearing of the line going into the starting point of the curve.
- **Bearing Out** Defines the bearing of the line going away from the ending point of the curve.
- **Bearing P.C.** Defines the bearing of the line from the radius point to the starting point of the curve.
- **Bearing P.T.** Defines the bearing of the line from the radius point to the ending point of the curve.

**Drawing Polylines**

A *polyline* is a continuous series of lines and/or arcs that are treated by DataCAD LT as a single entity. You can use the Rectangle option to quickly draw rectangular polylines or draw polylines, segment by segment. You can use the Curves option to create polylines with curved rather than straight line segments. Polylines can be open or closed, depending on whether you toggle Closed off or on.
Closed polylines can be hatched; see the “Hatch” chapter for more information about hatching. If your polyline (no matter how irregular) is not closed, you cannot hatch it. In addition, you can measure the area or perimeter of a closed polyline or find its centroid; see “Measuring Areas, Perimeters, and Volumes” in the “Drawing Tools” chapter for more information.

To draw a rectangular polyline:

1. Click on Curves in the Edit menu in the Menu Window to display the Curves menu; then click on Polyline. Or click on \( \text{Draw poly} \) in the Draw toolbar and select \( \text{Draw polylines} \) from the drop-down options to display the Polyline menu. You can also select Polyline from the Create pull-down menu; the Polyline menu appears.
2. Click on Rectangle in the Polyline menu. You are prompted to Select first corner of rectangle.
3. Click in the Drawing Area or object snap to a point to select the first corner of the polyline. Notice that the rectangle stretches as you move your cursor. You are prompted to Select second corner of rectangle.
4. Click in the Drawing Area or object snap to a point to select the second corner of the polyline. The polyline is drawn.
To draw a polyline, segment by segment:

1. Click on Curves in the Edit menu in the Menu Window to display the Curves menu; then click on Polyline. Or click on in the Draw toolbar and select from the drop-down options to display the Polyline menu. You can also select Polyline from the Create pull-down menu; the Polyline menu appears. Closed is toggled on by default, allowing you to draw a polyline that will automatically be closed when you’re finished selecting points. You are prompted to Select first point on polyline.

2. Toggle Closed on or off, depending on whether you want to draw a closed or open polyline.

3. Toggle Covered on or off, depending on whether you want DataCAD LT to supply a top and bottom covering (like a roof and floor) for a closed polyline. Covered is available if you toggled Closed on in step 2; it is not offered as an option if you toggled Closed off in step 2.

4. Decide how you want to begin drawing your polyline:
   - To begin with a curve drawn without a 2-point or 3-point arc, click on Curves in the Polylines menu.


   The Polyline/Curves options are exactly the same as those in the standard Curves menu. In Version 10, DataCAD LT added them to the Polyline menu for your convenience. Accessing these options through the Polyline menu makes it easier to draw curved polylines because you don’t have to constantly right-click to back up to the main Curves menu.

   - To begin with a 2-point arc, select the first point for the polyline by clicking in the Drawing Area or using coordinate entry. For more information on coordinate entry, see “Drawing Using Coordinate Entry” in “The Drawing Board” chapter. You are prompted to Select next point on polyline. Click on 2 Pt. Arc in the Polyline menu. Select a center point for the arc (toggle Clockwise off if you want to draw in a counterclockwise direction). Either continue drawing 2-point arcs as part of the polyline or right-click to exit that function.

   If you only need the 2 Pt. Arc or 3 Pt. Arc polyline options, you do not need to select the Curves submenu from the Polylines menu. Those two functions appear in the Polyline menu if you click to select the first point on the polyline immediately, instead of opening the Curves submenu.

   - To begin with a 3-point arc, select the first point for the polyline by clicking in the Drawing Area or using coordinate entry. For more information on coordinate entry, see “Drawing Using Coordinate Entry” in “The Drawing Board” chapter. Click on 3 Pt. Arc in the Polyline menu. You are prompted to Select second end point of arc. Click where you want the arc to end or use coordinate entry. You are prompted to Select any point on the arc. Drag your mouse or use coordinate entry, then click to select any other point on the arc. Either continue drawing 3-point arcs as part of the polyline or right-click to exit that function.

   - To begin with a straight line, select the first point for the polyline by clicking in the Drawing Area or using coordinate entry. For more information on coordinate entry, see “Drawing Using Coordinate Entry” in “The Drawing Board” chapter. You are prompted to Select next point on polyline. Indicate the second point of a straight line segment by clicking in the Drawing Area, using coordinate entry, or object snapping to a point on an entity.
5. Continue drawing line segments, curves, or arcs until your polyline is complete.

Notice that Tangent appears in the Polyline menu after you finish drawing the first straight line segment or after you right-click to exit the 2-point or 3-point arc functions. It also appears in the Polyline/Curves menu. When you are prompted to Select next point on polyline, you can draw a tangent arc in your polyline by clicking on Tangent. Move your cursor until the arc displayed is the one you want drawn and then click to draw the arc. For more information, see the "Drawing Tangent Arcs" section earlier in this chapter.

6. Click Backup any time to erase the last line segment or arc of your polyline. You can click Cancel at any time to erase the polyline you’re drawing.

7. Right-click to finish the polyline. If Closed is toggled on, the polyline is automatically closed. If Closed is toggled off, your cursor is detached from the last point of the open polyline.

To draw a polyline that is both closed and covered:

1. Click on Curves in the Edit menu in the Menu Window to display the Curves menu; then click on Polyline. Or click on \( \text{Draw polylines} \) in the Draw toolbar and select Polyline from the drop-down options to display the Polyline menu. You can also select Polyline from the Create pull-down menu; the Polyline menu appears. Closed is toggled on by default, allowing you to draw a polyline that will automatically be closed when you’re finished selecting points. You are prompted to Select first point on polyline.

2. Toggle Covered on in the Polyline menu.

3. Draw the polyline. Right-click when you are finished.

4. Select Object Viewer from the View pull-down menu to look at the covered polyline from all angles.

### Voids in Polylines

You can add voids to or erase voids from polylines as well as convert voids to polygons. To add a polyline void, you must first draw the closed master polyline (to which you want to add the void); then, draw the closed polyline that represents the void itself. For example, in a building elevation that you want to hatch, you would create a master polyline around the perimeter of the elevation. Then, you would draw closed polylines around each of the windows and doors; these would become voids or areas that you wouldn’t want to hatch.

To add a void to a polyline:

1. Click on Curves in the Edit menu in the Menu Window to display the Curves menu; then click on Polyline. Or click on \( \text{Draw polylines} \) in the Draw toolbar and select Polyline from the drop-down options to display the Polyline menu. You can also select Polyline from the Create pull-down menu; the Polyline menu appears.

2. Draw your master, closed polyline. Then, draw the closed polyline(s) that will become your void(s) within that master polyline.

3. Click on Voids in the Polyline menu. You are prompted to Select master polyline to process voids.

4. Click on the closed master polyline that you want to put the void in. DataCAD LT puts dashed lines around that shape. You are prompted to Select entity to select polylines to convert to voids.

5. Make sure Entity and Add Void are toggled on in the Voids menu.
6. Click on the polyline that will represent the void. The void is added. Dashed lines surround the void.

7. Continue selecting other closed polylines within the master if necessary.

You could easily hatch the polyline with voids. Just select Hatching from the Utility menu; click Pattern, choose one of the options, and press (Enter); then click on the polyline you want to hatch and select Begin from the Hatching menu. The area within the master polyline is hatched, but the voids are not. Alternatively, you could fill the master polyline with solid fills or bitmaps.

To erase a void polyline:

1. Click on Curves in the Edit menu in the Menu Window to display the Curves menu; then click on Polyline. Or click on in the Draw toolbar and select from the drop-down options to display the Polyline menu. You can also select Polyline from the Create pull-down menu; the Polyline menu appears.

2. Click on Voids in the Polyline menu. You are prompted to Select master polyline to process voids.

3. Click on the master polyline that contains the void(s) you want to erase. The Voids menu appears.

4. Toggle Erase Void on. You are prompted to Select polyline to delete from drawing.

5. Click on a void to erase it. If you want to eliminate more voids, click on them, too.

To convert a void to a polygon:

1. Click on Curves in the Edit menu in the Menu Window to display the Curves menu; then click on Polyline. Or click on in the Draw toolbar and select from the drop-down options to display the Polyline menu. You can also select Polyline from the Create pull-down menu; the Polyline menu appears.

2. Click on Voids in the Polyline menu. You are prompted to Select master polyline to process voids.

3. Click on the master polyline. The Voids menu reappears.

4. Toggle Convert Void on. You are prompted to Select void convert to polyline.

5. Click on a void to convert it. The polyline remains, but the void is gone.
Other Ways to Draw

Drawing lines and entering points directly in the Drawing Area are the most common ways of drawing. However, DataCAD LT has other tools that can significantly increase your productivity and even the accuracy of your drawings.

The Copy and Mirror options in the Edit menu are two such tools that can add entities to your drawing with just a few steps, freeing you from drawing similar things over and over.

DataCAD LT even offers a tool that can be used to sketch your ideas before you begin drawing. With the Freehand tool in the Utility menu, you can sketch in a variety of line widths and line types.

In this chapter:

- Copying entities
- Making multiple copies of entities
- Mirroring entities
- Freehand Sketching
Copying Entities
There are several ways to copy DataCAD LT entities. The Copy option in the Edit pull-down menu (grouped with Cut and Paste) is a standard Windows command and can be used to quickly copy entities to other DataCAD LT drawings or to other Windows applications. For details on how to use Cut, Copy, and Paste, see “Basic Editing Tools” in “The Drawing Board” chapter.

The Copy option in the Edit menu in the Menu Window (also available just below the Move option in the Edit pull-down menu) duplicates entities at a specified distance within the same drawing. With this option, you can:

• copy entities at a distance and angle that you set,
• copy entities by dragging them,
• copy entities to a different layer in your drawing, or
• make multiple copies of selected entities, arranged in rectangular or circular arrays.

To copy entities in the Z direction, use the Move Z option in the Move menu. See “Moving Entities” in the “Editing Drawings” chapter for details.

You can also use the icon in the Edit toolbar to copy drawing entities. When you click on this icon, three options appear in a drop-down menu:

Shortcut: To access the Copy menu, press (C) or (Shift) + (C).

Copying Entities a Specified Distance and Angle
When you use Copy in the Edit menu in the Menu Window, you are prompted to enter two points. The distance between these two points will be the distance the copy is drawn from the original entity you selected; the angle defined by these two points will be the angle the copy is drawn from the original one.

To copy an entity a specified distance and angle:

1. Click on Copy in the Edit menu in the Menu Window, or click on Copy (located just below Move) in the Edit pull-down menu, or click on in the Edit toolbar and select from the drop-down options. The Copy menu appears and you are prompted to Select first point of the distance to copy. To use the same distance and angle as the last time you used Copy, click on Prev. Dist.

2. Click in the Drawing Area or use coordinate entry to enter the first point. A directional arrow appears; notice that moving your mouse changes the length and angle of the arrow. You are prompted to Select second point of the distance to copy. The points you select in steps 2 and 3 can be selected anywhere on the screen; they indicate the distance and angle to copy only; these are not the beginning and ending points of the copy.

3. Click in the Drawing Area or use coordinate entry to enter the second point. For more information on using coordinate entry, see “Drawing Using Coordinate Entry” in “The Drawing Board” chapter. A selection menu as well as other Copy options appear.
4. Click on a selection method in the menu. For more information on using selection menus, see “Selection Menus” in “The Drawing Board” chapter. You are prompted to select the entities you want to copy.

5. Select the entities; they are copied in the drawing. You can continue selecting entities to make additional copies at the same distance and angle.

6. Copy entities at the same distance and angle but in the opposite direction by clicking on Invert and then selecting the entities to be copied (see Figure 10.1).

7. Enter a new distance and angle by clicking on New Distance and continuing with step 2 above.

![Figure 10.1: Inverting a copy](Image 108x358 to 240x374)

**Copying Entities by Dragging**

Instead of entering a specific distance and angle to copy entities, you can simply drag the copy any distance and at any angle.

- To copy entities by dragging them:

1. Click on Copy in the Edit menu in the Menu Window, or click on Copy (located just below Move) in the Edit pull-down menu, or click on ![Make copies of drawing entities](Image 285x377 to 313x398) in the Edit toolbar and select from the drop-down options. The Copy menu appears.

2. Click on Drag in the Copy menu. The Drag menu appears.

3. Toggle Layer Search on if the entities you want to copy are on a different layer than the active layer.

4. Drag complex entities more smoothly by setting the maximum number of lines to be displayed while dragging. Click on Max. Lines and use the value menu to enter the number of lines. Press (Enter) or right-click to return to the Drag menu. When the entities you selected to drag contain more lines than the Max. Lines setting, a rectangular box representing the selected entities appears when you begin to drag them. The entities reappear after you select the new location for them. When you set Max. Lines to 0, the rectangular box is always displayed while dragging.

5. Toggle Multiple on to make multiple selections of entities to be copied.

6. Click on a selection method in the menu. You are prompted to select the entities you want to copy.

7. Select the entities to be copied. You are prompted to *Select the point to drag from.*

8. Check the button for Multiple. If it is toggled off, skip to step 9. If you toggled Multiple on in step 5, click on Begin and continue with step 9.

9. Click on a point in the Drawing Area; you can also use coordinate entry or object snapping to select this point. For more information on using coordinate entry, see “Drawing Using Coordinate Entry” in “The Drawing Board” chapter. You are prompted to *Select new position for these entities.*
10. Move your mouse to drag the entities to their new position and click to place them. The entities are copied in the drawing. You can copy the same entities and place them in another position by repeating this step. Right-click when you are finished copying.

**Copying Entities at the Perpendicular**

You can copy an entity a specific distance from and perpendicular to the original. While you can’t copy an entity at any angle, as you can with the Copy function described above, this is a very straightforward way to quickly make one entity into an entire row.

👉 To copy an entity perpendicular to the original:

1. Click on Geometry in the Tools pull-down menu and then click on Offset in the extended menu. You can also click on Geometry in the Utility menu and select Offset in the Geometry menu.

   Alternatively, click on the icon in the Edit toolbar. The Offset menu appears.

2. Set the copy distance using one of the following methods:
   - You can toggle Dynamic off (if it’s toggled on) and define the distance just as you did in steps 2 and 3 in “Copying Entities a Specified Distance and Angle.” Click in the Drawing Area or use coordinate entry to select two points to define the distance.
   - You can toggle Dynamic on (if it’s toggled off); you’ll be able to see the position of the copy before you place it in your drawing.
   - You can click on Perp. Dist. to display a value menu. Use the value menu or type distance and press (Enter). If Perp. Dist. is already toggled on, toggle it off and on again to display the value menu.

   You are prompted to **Select object of offset**.

3. Toggle Layer Search on if the entities you want to copy are on a different layer than the active layer.

4. Click on the entity you want to copy. The selected entity appears in dashed lines. If you toggled Dynamic on in step 2, a copy of the entity is attached to your cursor. You are prompted with **Offset to which side?**

5. Click to one side or the other of the original entity. The copy is placed.

6. Continue copying entities by repeating steps 4 and 5; or if Dynamic is toggled on, simply repeat step 5. To redefine the offset distance, click on New Distance and continue with step 2 above.

**Copying to Another Layer**

When you have more than one layer in your drawing, the To Layer option appears in the Copy menu. To Layer is used to copy entities from one layer to another in your drawing. You can copy entities in the same position as the original layer (no distance and angle entered) or you can copy entities to another layer at a specified distance and angle. For more information on creating layers, see “Creating Layers” in the “Before You Draw” chapter.
To copy entities to another layer without changing their positions:

1. Click on Copy in the Edit menu in the Menu Window. Or click on Copy (located just below Move) in the Edit pull-down menu. Or click in the Edit toolbar and select from the drop-down options. The Copy menu appears.

2. Click on To Layer in the Copy menu. A list of all the layers in your drawing appears and you are prompted to Select layer to copy to.

3. Click on the layer you’d like to copy entities to or type the name of the layer and press (Enter). If your drawing has many layers, you can use the Match and Filter options in the To Layer menu to select or find the layer you want to copy to. For details on how to use these options, see “Selecting Layers Without Using Layer Names” and “Searching for Layers” in the “Before You Draw” chapter.

4. Click on a selection method in the menu. You are prompted to select the entities you want to copy.

5. Select the entities; they are copied to the layer you chose in step 3. You can continue selecting entities to make additional copies.

6. Choose another layer to copy entities to by clicking on New Layer and continuing with step 3 above.

To copy entities to another layer at a specific distance and angle:

1. Click on Copy in the Edit menu in the Menu Window. Or click on Copy (located just below Move) in the Edit pull-down menu. Or click in the Edit toolbar and select from the drop-down options. The Copy menu appears. You are prompted to Select first point of the distance to copy.

2. Click in the Drawing Area or use coordinate entry to enter the first point. A directional arrow appears; notice that moving your mouse changes the length and angle of the arrow. You are prompted to Select second point of the distance to copy. The points you select in steps 2 and 3 can be selected anywhere on the screen; they indicate the distance and angle to copy only; these are not the beginning and ending points of the copy. To use the same distance and angle as the last time you used Copy, click on Prev. Dist.

3. Click in the Drawing Area or use coordinate entry to enter the second point. A selection menu as well as other Copy options appears.

4. Click on To Layer in the Copy menu. A list of all the layers in your drawing appears and you are prompted to Select layer to copy to.

5. Click on the layer you’d like to copy entities to or type the name of the layer and press (Enter). A selection menu as well as other Copy options appears. For more information on using selection menus, see “Selection Menus” in “The Drawing Board” chapter.

6. Click on a selection method in the menu. You are prompted to select the entities you want to copy.

7. Select the entities; they are copied to the layer you chose in step 5. You can continue selecting entities to make additional copies.
8. Choose another layer to copy entities to if necessary. Just click on New Layer and continue with step 5 above.

**Copying Using Arrays**

You can make multiple copies of an entity in a one-dimensional, rectangular, or circular array. A one-dimensional array simply makes multiple copies in one direction. In a circular array, an entity is copied a specified number of times at a specified angle of separation around a center of rotation.

A rectangular array repeats an entity a specified number of times at a specified angle. You can copy an array of elements in the X direction, the Y direction, or in both directions at the same time. The number of X and Y repetitions determines the total number of entities in the array. An array of one X repetition and one Y repetition has only one entity, the original. A two-by-two array has a total of four entities (see figures 10.2 and 10.3). You can also change the angle of the X and Y axes to create a rectangular array at the specified angle.

![Figure 10.2](image1.png)

**Figure 10.2:** Creating a rectangular array in only the X direction. You can also use Array in the Copy menu to make multiple copies in only one direction. See the instructions for copying an entity in a one-dimensional array below.

![Figure 10.3](image2.png)

**Figure 10.3:** Creating a rectangular array in only the Y direction. You can also use Array in the Copy menu to make multiple copies in only one direction. See the instructions for copying an entity in a one-dimensional array below.
To copy an entity in a one-dimensional array:

1. Click on Copy in the Edit menu in the Menu Window. Or click on Copy (located just below Move) in the Edit pull-down menu. Or click on \(\text{COPY AN ARRAY OF ENTITIES}\) in the Edit toolbar and select from the drop-down options. The Copy menu appears. You are prompted to Select first point of the distance to copy.

2. Click in the Drawing Area or use coordinate entry to enter the first point. A directional arrow appears; notice that moving your mouse changes the length and angle of the arrow. You are prompted to Select second point of the distance to copy. The points you select in steps 2 and 3 can be selected anywhere on the screen; they indicate only the distance and direction of each copy in the array; these are not the beginning and ending points of the copy.

3. Click in the Drawing Area or use coordinate entry to enter the second point.

   If you used the icon from the Edit toolbar in step 1, a value menu appears; skip to step 5. If you used selected Copy from either the Edit menu in the Menu Window or the Edit pull-down menu, a selection menu as well as other Copy options appear in the Menu Window; go to step 4.

4. Click on Array in the Copy menu. A value menu appears and you are prompted to Enter the number of repetitions.

5. Use the value menu or type a number and press (Enter). You are prompted to select the entities you want to copy.

6. Select the entities; they are copied in the array you defined. You can continue selecting entities to make additional copies.

To copy an entity in a rectangular array:


   Or click on \(\text{COPY ENTITIES TO A RECTANGULAR ARRAY}\) in the Edit toolbar and select from the drop-down options. The Rect. Array menu appears. You are prompted to Select first point of the distance to copy. Skip to step 3.

2. Click on Rect. Array in the Copy menu. The Rect. Array menu appears and you are prompted to Select first point of the distance to copy.

3. Click in the Drawing Area or use coordinate entry to enter the first point. Two bi-directional arrows appear, representing the X and Y axes. Notice that moving your mouse changes the length and direction of the arrows; the length and direction of the arrows indicates the distance and angle you want to copy entities at. You are prompted to Select second point of the distance to copy. The points you select in steps 3 and 4 can be selected anywhere on the screen; they indicate only the distance and direction of each copy in the array; these are not the beginning and ending points of the copy. For more information on using coordinate entry, see “Drawing Using Coordinate Entry” in “The Drawing Board” chapter.

4. Click in the Drawing Area or use coordinate entry to enter the second point. A value menu appears and you are prompted to Enter number of X-repetitions. For more information on using value menus, see “Value Menus” in “The Drawing Board” chapter.

5. Select the number of repetitions from the value menu or type a number and press (Enter). You are prompted to Enter number of Y-repetitions.
6. Select the number of repetitions from the value menu or type a number and press (Enter). The Rect. Array menu offers selection methods and other options.

7. Toggle Counter on in the Rect. Array menu to display on the Attention toolbar the number of entities added each time you copy.

8. Click on a selection method in the menu. You are prompted to select the entities you want to copy.

9. Select the entities; they are copied in the array you defined. You can continue selecting entities to make additional copies.

10. Click on NewArray to define another rectangular array, then continue with step 3 above. If you don’t want to define another array, right-click or click on Exit to return to the Edit menu.

Keep in mind that an array is a separate group from the original copied entity. If you use Group in the selection menu and select an entity in an array, the entire array will be copied.

![Figure 10.4: Creating a rectangular array](image)

To copy an entity in a rectangular array set at an angle:


   Or click on ![Copy entities to a rectangular array](image) in the Edit toolbar and select ![Copy entities to a rectangular array](image) from the drop-down options. The Rect. Array menu appears. Skip to step 3.

2. Click on Rect. Array in the Copy menu. The Rect. Array menu appears.

3. Click on Angular in the Rect. Array menu. You are prompted to *Select first point of the distance to copy.*

   ![Figure 10.4: Creating a rectangular array](image)
4. Enter the angle for the X axis for the copy by defining the beginning and end points of a directional arrow. The points you select for directional arrows can be selected anywhere on the screen; they indicate only the distance and direction of each copy in the array and **not** the beginning and ending points of the copy. Click in the Drawing Area or use coordinate entry to enter the beginning point. A directional arrow appears; notice that moving your mouse changes the angle of the arrow. You are prompted to **Select vector indicating angle of array.** For more information on using coordinate entry, see “**Drawing Using Coordinate Entry**” in “The Drawing Board” chapter.

5. Click in the Drawing Area or use coordinate entry to enter the first point. Two bi-directional arrows appear, representing the X and Y axes. Notice that moving your mouse changes the length and direction of the arrows; the length and direction of the arrows indicates the distance and angle you want to copy entities at. You are prompted to **Select the second point of the distance to copy.** The points you select in steps 4 and 5 can be selected anywhere on the screen; they indicate only the distance and direction of each copy in the array; these are **not** the beginning and ending points of the copy. For more information on using coordinate entry, see “**Drawing Using Coordinate Entry**” in “The Drawing Board” chapter.

6. Click in the Drawing Area or use coordinate entry to enter the second point. A value menu appears and you are prompted to **Enter number of X-repetitions.** For more information on using value menus, see “**Value Menus**” in “The Drawing Board” chapter.

7. Select the number of repetitions from the value menu or type a number and press (Enter). You are prompted to **Enter number of Y-repetitions.**

8. Select the number of repetitions from the value menu or type a number and press (Enter). The Rect. Array menu offers selection methods and other options.

9. Toggle Counter on in the Rect. Array menu to display the number of entities added each time you copy.

10. Click on a selection method in the menu. You are prompted to select the entities you want to copy.

11. Select the entities; they are copied in the array you defined. You can continue selecting entities to make additional copies.

12. Click on NewArray to define another rectangular array and continue with step 3 above. If you don’t want to define another array, right-click or click on Exit to return to the Edit menu.

Keep in mind that an array is a separate group from the original copied entity. If you use Group in the selection menu and select an entity in an array, the entire array will be copied.

To copy an entity in a circular array:

1. Click on Copy in the Edit menu in the Menu Window. Or click on Copy (located just below Move) in the Edit pull-down menu. Or click on **( )** in the Edit toolbar and select **Copy an array of entities** from the drop-down options. The Copy menu appears.

2. Click on Circ. Array in the Copy menu. The Circ. Array menu appears and you are prompted to **Select center point of array.** For more information on circular array options, see “**More About Circ. Array Menu Options**” later in this chapter.
3. Click in the Drawing Area or use coordinate entry to enter the center point. A value menu appears and you are prompted to Enter relative X-distance. For more information on using value menus, see “Value Menus” in “The Drawing Board” chapter.

4. Use the value menu or type a number and press (Enter). Another value menu appears and you are prompted to Enter relative Y-distance.

5. Use the value menu or type a number and press (Enter). Another value menu appears and you are prompted to Select angle between items (+=CCW, -=CW). If you enter a positive angle, the array will be copied in a counterclockwise direction; if you enter a negative angle, the array will be copied in a clockwise direction.

6. Use the value menu or type a number and press (Enter). Another value menu appears and you are prompted to Enter number of objects in array.

7. Use the value menu or type a number and press (Enter). The Circ. Array menu appears.

8. Click on a selection method in the menu. You are prompted to select the entities you want to copy.

9. Select the entities; they are copied in the array you defined. You can continue selecting entities to make additional copies. When you are finished, click on Exit or right-click to return to the Edit menu.

Keep in mind that an array is a separate group from the original copied entity. If you use Group in the selection menu and select an entity in an array, the entire array will be copied.

**More About Using Z Elevations in Rectangular Arrays**

The Z elevation can be increased or decreased incrementally with each repetition in a rectangular array. In the Rect. Array menu, the Z Inc. X option sets the Z elevation in the X direction of an array, while the Z Inc. Y option sets the Z elevation in the Y direction of an array. To set an incremental Z elevation for an array that copies an entity in both the X and Y directions, set both options.

The Z Inc. X and Z Inc. Y options are set using value menus. For more information on using value menus, see “Value Menus” in “The Drawing Board” chapter.

You can use the Z Inc. X and Z Inc. Y to generate such things as three-dimensional stairs with only a few keystrokes (see Figure 10.5). You can also generate several three-dimensional floors of a building by setting Z Inc. X or Z Inc. Y to the floor-to-floor height for the building and copying a rectangular array with an X and Y distance of zero. This creates an array of floors, stacked one above the other.

![3D Stairs](image)

**Figure 10.5:** Creating 3D stairs with the incremental Z elevation options

| X Repetitions = 1 | Z Incr X = 0 |
| Y Repetitions = 8 | Z Incr Y = 8” |
More About Circ. Array Menu Options

You can change array settings, set a Z elevation for the array, and even rotate the entity copies using the following Circ. Array menu options:

New Center Sets a new center for the array you are copying; click on New Center, select a new center point for the array, and then select the entity to copy.

Obj. Center Sets a new center for the entity you are copying; click on Obj. Center, select a new center point for the entity, and then select the entity to copy.

Sep. Angle Sets a new angle of separation between each entity in the array; click on Sep. Angle, enter a new angle, and press (Enter).

No. Object Sets a new number of repetitions for the array; click on No. Object, enter a new number, and press (Enter).

Z Increment Sets the Z elevation with each repetition in the array; click on Z Increment, enter a positive value to increase the elevation or a negative value to decrease it, and press (Enter) (use this option to draw 3D circular stairs).

Rotate Toggle on to rotate each copy in the array by an angle equal to the angle of separation; toggle off to leave the orientation of each copy in the array the same as the original entity.

Mirroring Entities

In some projects, being able to copy and mirror part of your drawing would save you a lot of time. For instance, it would be far more efficient to draw only one side of a hotel corridor and mirror that side to create the full corridor than it would be to draw both sides. The Mirror option in the Edit menu allows you to do just that, mirroring geometry across a reflection line that you define.

To mirror entities:

1. Click on Mirror in either the Edit menu in the Menu Window or the Edit pull-down menu. Or click on the icon (mirror only) in the Edit toolbar if you want to mirror the entity and move it to the opposite side of the line of reflection. Or click on the icon (mirror and copy) in the Edit toolbar if you want to mirror the entity, copy it to the opposite side of the line of reflection, and keep the original entity in its place. The Mirror menu appears and you are prompted to Select first point along the line of reflection.

Shortcut: Press (Alt) + (M) to access the 2D Mirror menu.

Hint: You can use the same reflection line as the last time you used Mirror. Instead of defining a new reflection line, click on Prev. Line in the Mirror menu. This displays the previous line of reflection. The Prev. Line option is only available if you have used Mirror during the current drawing session. If you want to keep the previous line of reflection, skip to step 5. If you want to change the previous line of reflection, go to step 4.

2. Click in the Drawing Area or use coordinate entry to select the first point of the reflection line. You are prompted to Select second point along the line of reflection.

3. Click in the Drawing Area or use coordinate entry to select the second point of the reflection line. DataCAD LT draws a temporary, dashed line representing the reflection line. The Mirror menu appears.

4. Determine if the reflection line is not correct. If you want to change it, click on New Line, then repeat steps 2 and 3 to create a new line of reflection.

5. Mirror and copy the selected entities across the reflection line by toggling And Copy on. Toggle And Copy off to mirror and move selected entities across the reflection line.
6. Toggle Fix Text on to mirror the position of text but not its orientation. When Fix Text is toggled off, text is mirrored and rotated 180° (see Figure 10.6).

7. Click on a selection method. You are prompted to select the entities you want to mirror.

8. Select the entities; they are mirrored across the reflection line you defined. You can continue selecting entities to mirror. When you are finished, click on Exit or right-click to leave the Mirror menu and return to the Edit menu.

![Figure 10.6: Mirroring text with Fix Text toggled on (left) and toggled off (right)](image)

**Freehand Sketching**

You can use the Freehand option to sketch lines in varying widths and line types. When using line types such as dotted or dashed, you can give a rendered or weighted quality to the lines by varying the speed that you move the cursor across the Drawing Area as you draw. Sketching with Freehand works best if you toggle both grid snapping and ortho mode off. Press (X) to toggle grid snapping off; press (O) to toggle ortho mode off.

To sketch:

1. Click on Freehand in the Utility menu. The Freehand menu appears.

   **Shortcut:** Press (Alt) + (H) to access the Freehand menu.

2. Toggle Lines on to draw lines, toggle 3D Lines on to draw three-dimensional lines, or toggle Polyline on to draw polylines. You can toggle only one of these three options on at any given time.

3. Toggle Closed on to automatically close the shape when you finish drawing.

4. Click in the Drawing Area and then move your mouse to draw.

5. Click to disconnect your cursor from the line when your sketch is complete. You can continue drawing additional shapes.

6. Click on Exit or right-click to return to the Utility menu.
Drawing Tools

There are many tools in DataCAD LT to aid in drawing. Reference points can be set anywhere in your drawing, giving you a precise way to position new entities. Object snapping can help you add entities to existing geometry quickly and accurately.

You can also identify and measure entities in your drawing to retrieve information, such as what layer the entity is drawn on, its line type and line weight, its length or angle, or even its area or perimeter measurements.

In this chapter:
- Setting reference points
- Object snapping
- Identifying entities
- Measuring entities
- Dividing entities
- Editing entity attributes
Setting Reference Points

A reference point is used as a starting point for drawing. In DataCAD LT, there are two kinds of reference points: floating and fixed.

Floating reference points are useful when you use relative coordinate entry methods to draw. They can be set at any time, regardless of what menu appears or what you’re drawing. Floating reference points are temporary and can be displayed and snapped to, but they can’t be plotted.

To see how floating reference points are used when drawing, see the “Tutorial: Drawing a Schoolhouse” chapter, specifically the instructions on drawing interior walls and adding windows and doors to the schoolhouse.

Fixed reference points are useful when you use absolute coordinate entry methods to draw. Absolute coordinate entry uses absolute zero as a fixed point of reference: every time you enter a point using absolute coordinate entry, the distances you enter are measured from absolute zero. With a fixed reference point, you can use another point in your drawing, exactly as you would use absolute zero.

To set a floating reference point:

1. Click on Reference Point in the Tools pull-down menu. The Ref. Point menu appears.

   **Shortcut:** Press (‘) [located in the upper-left corner of most keyboards, just below (Esc)] to quickly access the Ref. Point menu and set a reference point. After selecting a point, you are automatically returned to the menu you were working in before you set the point.

2. Click on Draw Marks to display a small “x,” representing the reference point.

3. Click in the Drawing Area, use coordinate entry, or object snap to a point in your drawing to select the reference point. The reference point is marked with a small “x.” Reference points are displayed until you refresh your drawing by pressing (Esc).

To set a fixed reference point:

1. Click on Settings in the Utility menu. The Settings menu appears.

2. Toggle Draw Marks on in the Settings menu if you want the fixed reference point marked with a small “x.” Toggle Draw Marks off if you don’t want the small “x” to appear.

3. Click on Fixed Ref. in the Settings menu. You are prompted to **Select fixed reference point using cursor**.

4. Click in the Drawing Area, use coordinate entry, or object snap to a point in your drawing to select the reference point. If Draw Marks was toggled on in step 2, the reference point is marked with a small “x.” Reference points are displayed until you refresh your drawing by pressing (Esc).

5. Right-click to exit the Settings menu. You can now continue drawing, using your fixed reference point.

6. Use absolute zero again if necessary. Instead of your fixed reference point, click on Settings in the Utility menu, toggle Fixed Ref. off and then on again (click on the option twice); next, click on Abs. Zero. Right-click to exit the Settings menu and continue drawing.
More About Setting Reference Points

Reference points can give you a quick way to draw very precisely. For example, to insert a window in a wall 3'-0" from the corner of a room, you could create a reference point at that corner and then, using relative Cartesian for coordinate entry, simply enter the distance (in this case, it is 3'-0'') from the reference point.

To use a reference point, using this example:

1. Make sure the current input mode is Relative Cartesian. You can do this in several ways: click on Input Mode in the Tools pull-down menu and make sure Relative Cartesian is checked; check the input mode in the Status Panel toolbar; or press (Ins) until Current input mode = Relative Cartesian \((x, y)\) appears in the Attention toolbar.
2. Click on Window in the Create pull-down menu, or select Windows in the Edit/Architect menu, or click on the \(\square\) icon in the Draw toolbar. The Windows menu appears.
3. Press ('), the Ref. Point menu appears.
   
   **Shortcut:** To set a reference point using the mouse, press (Ctrl) and click. To set a reference point at a specific point on an entity by object snapping to it, press (Ctrl) and click the middle mouse button or press (Ctrl) + (Shift) and click the left mouse button.

4. Toggle Draw Marks on to display the reference point.
5. Object snap to the inside left corner of the wall to place your reference point exactly at the corner intersection. You are prompted to Select one jamb of window. For more information on object snapping, see “Object Snapping” in this chapter.
6. Press (Spacebar) to activate coordinate entry. You are prompted to Enter relative X-distance.
7. Type 3 and press (Enter). You are prompted to Enter relative Y-distance.
8. Type 0 and press (Enter). Your cursor is connected to a point on the wall that is 3'-0" from the corner of the room. You are prompted to Select second jamb of window.
9. Press (Spacebar) to activate coordinate entry and enter the X and Y coordinates for the other side of the window. You are prompted to Select any point on the outside of the wall.
10. Click anywhere outside the wall. The window is drawn, exactly 3'-0" from the corner of the room.

Using reference points with direction-distance coordinate entry is even easier and faster.

To use a reference point and direction-distance mode, using the same example:

1. Make sure the current input mode is Direction-Distance. You can do this in several ways: click on Input Mode in the Tools pull-down menu and make sure Direction/Distance is checked; check the input mode in the Status Panel toolbar; or press (Ins) until Current input mode = Direction, Distance appears in the Attention toolbar.
2. Click on Window in the Create pull-down menu, or select Windows in the Edit/Architect menu, or click on the \(\square\) icon in the Draw toolbar. The Windows menu appears.
3. Press ('); the Ref. Point menu appears.
4. Toggle Draw Marks on to display the reference point.
5. Object snap to the inside left corner of the wall to place your reference point exactly at the corner intersection. You are prompted to Indicate the reference angle, which is the direction that will be used in the following steps.

6. Make sure Ortho mode is on, then drag your cursor to the right and click. You are prompted to Select one jamb of window.

   **Shortcut:** To toggle Ortho mode on or off, press (O).

7. Press (Spacebar), type 3, and press (Enter). You are prompted to Select second jamb of window.

8. Drag your cursor to the right. Press (Spacebar), type the width of the window, and press (Enter). You are prompted to Select any point on the outside of the wall.

9. Click anywhere on the exterior side. The window is inserted in the wall.

**Object Snapping**

**Object snapping** is a precise way of selecting a point on an existing entity or selecting a snap point that you’ve set. Depending on what drawing function is in progress, this point may simply be entered to complete the task or your cursor may be attached to that point so you can begin drawing from there.

You can object snap to drawing entities and snap points in several ways. You can use one method or any combination of the object snapping methods described in this chapter.

**Shortcut:** Press (N) or (Shift) + (N) to use object snapping.

**Object Snap Menu Options**

Most object snapping options are in the Utility/Object Snap menu; however, a related function called Get-Snap also uses snapping to help you draw. See “Using Get-Snap” later in this chapter for details.

- **None** Toggles all object snap methods off.
- **Fast Symbol** Toggle on to snap only to symbol insertion points rather than end points within the symbol. Increases object snapping speed. See “More About Increasing Snapping Speed” in this chapter.
- **Fast 3D** Toggle on to snap to the center marker of circular 3D entities. Increases object snapping speed. See “More About Increasing Snapping Speed” in this chapter.
- **Miss Dist.** Set the distance your cursor can be from a point while still being able to snap to it.
- **Layer Snap** Toggle on to snap to entities on all displayed layers; toggle off to snap to entities only on the active layer.
- **Search Hatch** Toggle on to snap to hatch lines; toggle off to ignore hatching when object snapping and increase snapping speed.
- **Quick** Toggle on to snap to the first entity you drew; toggle off to snap to the nearest point according to the snapping methods you have toggled on. Increases object snapping speed. See “More About Increasing Snapping Speed” in this chapter.
- **Sel. Set** Toggle on to snap only to entities in the active selection set. Increases object snapping speed. See “More About Increasing Snapping Speed” in this chapter.
- **Aperture** Toggle on to display a box representing the miss distance. Toggle Aperture on to make sure the point you want to snap to is inside the miss distance.

**More About Snapping Points**

You can add snapping points anywhere in your drawing; these points are displayed as dots in the Drawing Area but can’t be plotted.

- To add a snapping point to your drawing:
  1. Go to the Utility menu and click on Measures.
2. Click on Snap Point in the Measures menu.
3. Click in the Drawing Area or use coordinate entry to enter the snapping point. The point appears in the Drawing Area.

**More About Using Your Mouse for Snapping**

If you’re using a three-button mouse, set your middle mouse button to Middle Button; do not set it to Double Click, because you will not be able to use it for object snapping. If your middle mouse button doesn’t seem to be snapping to points, check your mouse settings.

⇒ To check your mouse settings:
1. Close DataCAD LT if it is running. From the Windows Start menu, click on Settings and then on Control Panel.
2. Double-click on Mouse in the Control Panel window to open the Mouse Properties dialog box.
3. Click on the Devices tab and make sure you have a three-button mouse driver installed.
4. Click on the Buttons tab and make sure the left button is set to Click Select, the middle button is set to Middle Button, and the right button is set to Alternate Menu/Click Select. If there is no Middle Button setting, set the middle mouse button to Unassigned or Default. Another option is to use Auto-Scroll.
5. Click on OK to close the dialog box.

**More About Increasing Snapping Speed**

There are several options you can use to increase object snapping speed. Use Sel. Set, Search Hatch, and Fast Symbol to more precisely target the geometry you want to snap to.

The Fast 3D option can also increase snapping speed when your drawing has many circular 3D entities, such as 3D arcs, cylinders, cones, domes, tori, or contour curves. When you toggle on Fast 3D and then select entities using the area or fence selection method, only those entities whose center axis markers or control points are within the defined area or fence are selected.

**Snapping to the Nearest Point**

You can snap to the point nearest your cursor, regardless of what other object snap options are toggled on. For instance, even if you don’t have Mid Point toggled on, it is still possible to snap to the midpoint of a line using the Nearest option, as long as that midpoint is the point nearest to your cursor.

⇒ To snap to the nearest point:
1. Go to the Utility menu and click on Object Snap. You can also click on Settings in the Tools pull-down menu and then click on Object Snap in the submenu. The Object Snap menu appears. Press (PageDown) to zoom in on your drawing and place your cursor more accurately.

   **Shortcut:** Press (Shift) + (X) to access the Object Snap menu.

2. Click on Nearest in the Object Snap menu.
3. Move your cursor close to the point you’d like to snap to and press (N) or click the middle mouse button. The nearest point on any entity is snapped to.
Snapping to Dividing Points

You can divide an entity in a specified number of sections, with each section separated by a snapping point. These snapping points are only visible if Draw Marks is toggled on in the Settings menu and after you snap to them.

Figure 11.1: Snapping to a point on a divided entity

To snap to a dividing point:

1. Go to the Utility menu and click on Object Snap. You can also click on Settings in the Tools pull-down menu and then click on Object Snap in the submenu. The Object Snap menu appears.
2. Click on No. Points in the Object Snap menu. A value menu appears.
3. Set the number of divisions for an entity by use the value menu or typing a number. Then press (Enter).
4. Move your cursor close to the point you’d like to snap to and press (N) or click the middle mouse button. The nearest division point is snapped to.

Snapping to End Points

You can snap to the end points of entities in your drawing.

Figure 11.2: Snapping to an end point of a line

To snap to the nearest end point:

1. Go to the Utility menu and click on Object Snap. You can also click on Settings in the Tools pull-down menu and then click on Object Snap in the submenu. The Object Snap menu appears. You can also snap to end points of lines in unexploded symbols and nested symbols. For more information on symbols, see the “Symbols, Images, and Objects” chapter.
2. Click on End Point in the Object Snap menu.
3. Move your cursor close to the point you’d like to snap to and press (N) or click the middle mouse button. The nearest end point is snapped to.

Snapping to the Midpoint of a Line

You can snap to the nearest midpoint of a line.
Figure 11.3: Snapping to the midpoint of a line

To snap to the nearest midpoint of a line:
1. Go to the Utility menu and click on Object Snap. You can also click on Settings in the Tools pull-down menu and then click on Object Snap in the submenu. The Object Snap menu appears.
2. Click on Mid Point in the Object Snap menu.
3. Move your cursor close to the point you’d like to snap to and press (N) or click the middle mouse button. The nearest midpoint is snapped to.

Snapping to Arc and Circle Centers
You can snap to the center point of an arc or circle.

Figure 11.4: Snapping to the center point of a circle

To snap to the nearest center point:
1. Go to the Utility menu and click on Object Snap. You can also click on Settings in the Tools pull-down menu and then click on Object Snap in the submenu. The Object Snap menu appears.
2. Click on Center in the Object Snap menu.
3. Move your cursor close to the point you’d like to snap to and press (N) or click the middle mouse button. The nearest center point of any arc or circle point is snapped to.

Snapping to Quadrant Points
You can snap to points marking the north, south, east, or west quadrants of a circle or arc.

Figure 11.5: Snapping to a quadrant point on a circle

To snap to the nearest quadrant point:
1. Go to the Utility menu and click on Object Snap. You can also click on Settings in the Tools pull-down menu and then click on Object Snap in the submenu. The Object Snap menu appears.
2. Click on Quadrant in the Object Snap menu.
3. Move your cursor close to the point you’d like to snap to and press (N) or click the middle mouse button. The nearest quadrant point is snapped to.

**Snapping to Intersections**
You can snap to the intersection of lines, arcs, and circles.

![Figure 11.6: Snapping to an intersection of two lines](image)

To snap to the nearest intersection point:

1. Go to the Utility menu and click on Object Snap. You can also click on Settings in the Tools pull-down menu and then click on Object Snap in the submenu. The Object Snap menu appears.
2. Click on Intersect in the Object Snap menu.
3. Move your cursor close to the point you’d like to snap to and press (N) or click the middle mouse button. The nearest intersection point is snapped to.

**Snapping to a Perpendicular**
You can use perpendicular snapping to draw a line that is perfectly perpendicular to another line, arc, or circle.

![Figure 11.7: Snapping to a point that forms a perpendicular to a line](image)

To draw a line perpendicular to another entity:

1. Go to the Utility menu and click on Object Snap. You can also click on Settings in the Tools pull-down menu and then click on Object Snap in the submenu. The Object Snap menu appears.
2. Click on Perp. in the Object Snap menu.
3. Click in the Drawing Area or use coordinate entry to enter the first end point of the line.
4. Move your cursor close to the entity you’d like to draw the line perpendicular to and press (N) or click the middle mouse button to snap to it. The nearest perpendicular point on that entity is snapped to.

**Shortcut:** Press (Alt) + (O) to toggle Perp. object snapping on and off.
Snapping to Tangents

You can use tangent snapping to draw a line that is tangent to an arc or circle.

Figures 11.8: Snapping to a point that forms a tangent with a circle

To draw a line that is tangent to an arc or circle:
1. Go to the Utility menu and click on Object Snap. You can also click on Settings in the Tools pull-down menu and then click on Object Snap in the submenu. The Object Snap menu appears.
2. Click on Tangent in the Object Snap menu.
3. Click in the Drawing Area or use coordinate entry to enter the first end point of the line.
4. Move your cursor close to the arc or circle you'd like to draw the line tangent to and press (N) or click the middle mouse button to snap to it. The nearest tangent point on the arc or circle is snapped to.

Using Get-Snap

Get-Snap allows you to input distances relative to other objects in the drawing. Instead of inputting a distance, you can simply object snap to a point; the distance between your original point and the point you snapped to is automatically entered. So you can quickly create, move, copy, or stretch entities that align with other objects without having to draw guidelines or markers first.

Hint: You can only access Get-Snap functions with the middle mouse button, not with the object snap keyboard shortcut (N) or (Shift) + (N).

To use snapping to enter a horizontal or vertical distance:
1. Enter a point in your drawing. This may be one end point of a wall or the first point in the distance to move an entity.
2. Press and hold down (Shift) while you click the middle mouse button for object snap. The Get-Snap pop-up menu appears.

Get X
Get Y
Get Angle
Get X + Distance
Get Y + Distance
Get Angle + Angle

Figure 11.9: The Get-Snap pop-up menu

3. Click on either Get X or Get Y and begin to type a number. A value menu appears and the number you are typing appears in the input field in the Message toolbar that prompts you to Enter relative X-distance.
4. Continue typing the X distance value and press (Enter). Another value menu appears and you are prompted to *Enter relative Y-distance*. If you want to enter a negative value, type the “−” (minus) sign at the beginning of the input field.

5. Type the Y distance value and press (Enter). If you want to enter a negative value, type the “−” (minus) sign at the beginning of the input field. The line extends from your initial point to the one you just designated. Since your cursor is attached to the last point you designated, you can continue to input horizontal and vertical distances to extend the line.

<table>
<thead>
<tr>
<th>To add to or subtract from the Get X distance:</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Enter a point in your drawing. This may be one end point of a wall or the first point in the distance to move an entity.</td>
</tr>
<tr>
<td>2. Press and hold down (Shift) and object snap to a point in your drawing. The Get-Snap pop-up menu appears.</td>
</tr>
<tr>
<td>3. Click on Get X + Distance to enter a horizontal distance; click on Get Y + Distance to enter a vertical distance. A value menu appears and you are prompted to <em>Enter relative distance</em>.</td>
</tr>
<tr>
<td>4. Type a positive value to add to the distance between your original point and the point you snapped to; type a negative value to subtract from the distance between your original point and the point you snapped to.</td>
</tr>
<tr>
<td>5. Press (Enter). The distance is entered.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>To use snapping to define an angle:</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Enter a point in your drawing. This may be one end point of a wall or the first point in the distance to move an entity.</td>
</tr>
<tr>
<td>2. Press and hold down (Shift) and object snap to the point that lies along the angle. The Get-Snap pop-up menu appears.</td>
</tr>
<tr>
<td>3. Click on Get Angle from the pop-up menu. A value menu appears and you are prompted to <em>Enter relative distance</em>.</td>
</tr>
<tr>
<td>4. Use the value menu or type a length for your line and press (Enter). The line is created at the referenced angle and length.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>To use snapping to define an angle, and then add or subtract from it:</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Enter a point in your drawing. This may be one end point of a wall or the first point in the distance to move an entity.</td>
</tr>
<tr>
<td>2. Press and hold down (Shift) and object snap to the point that lies along the angle. The Get-Snap pop-up menu appears.</td>
</tr>
<tr>
<td>3. Click on Get Angle + Angle in the pop-up menu. A value menu appears and you are prompted to <em>Enter angle from the origin</em>.</td>
</tr>
<tr>
<td>4. Use the value menu to enter the angle to add to the reference angle or type an angle and press (Enter). The default is 90°. A value menu appears and you are prompted to <em>Enter relative distance</em>.</td>
</tr>
<tr>
<td>5. Use the value menu to enter the length of the line or type a value and press (Enter). The line is created at the referenced angle and length.</td>
</tr>
</tbody>
</table>
**Using Virtual Snapping**

In the Object Snap menu, the Virtual option applies only to Nearest, Intersect, and Perp. snapping methods. When Virtual is turned off, DataCAD LT’s object snapping mechanism will only return points that lie on line segments passing through the current Miss Dist. (the snap aperture) and will not return either intersections or perpendicualrs that lie beyond the endpoints of these lines.

By default, Virtual is toggled off. If you want Virtual to be toggled on when you open drawings created prior to DataCAD LT 10 for the first time, you can add the following entry to the [General] section of the DCADLT.INI file:

```
Virtual Snapping=TRUE
```

To use virtual snapping:

1. Click on Object Snap in the Utility menu. The Object Snap menu appears.
2. Make sure that one of the options Nearest, Intersect, and Perp. is active.
3. Toggle Virtual on.

**Identifying Entities**

You can review the attributes of any entity in your drawing.

To identify an entity:

1. Click on Identify in the Tools pull-down menu; or click on Identify in the Edit menu in the Menu Window; or click on the icon in the Edit toolbar. The Identify menu appears.

   **Shortcut:** Press (Shift) + (I) or (Alt) + (I) to access the Identify menu.

2. Click on the entity in your drawing that you want to identify. The selected entity is temporarily displayed as dashed lines and a list of its attributes appears in the Menu Window. It may be necessary to change the view of your drawing, so that you have a clear view of the entity you want to identify. Click on 3D Views in the Identify menu to display the 3D Views menu and change the view of your drawing, choose a view from the View pull-down menu, or simply zoom in on your drawing.

To identify an entity with the pop-up menu:

1. Place your cursor on the entity you want to identify.
2. Hold down the (Ctrl) key while you right-click with the mouse. The entity appears as a dashed line and a pop-up menu appears.
3. Click on Identify in the pop-up menu to look at the properties of the entity you selected.

**More About Entity Properties**

The properties displayed when you identify an entity can vary, depending on the type of entity. For example, if you identify a line, the following information might be displayed:

<table>
<thead>
<tr>
<th>Identify</th>
<th>CIRCLE</th>
</tr>
</thead>
<tbody>
<tr>
<td>GoTo View</td>
<td>Layer: Layer001</td>
</tr>
<tr>
<td>URL</td>
<td>Color: White</td>
</tr>
<tr>
<td>File</td>
<td>Line Type: Solid</td>
</tr>
<tr>
<td>Object Viewer</td>
<td>Spacing: 1&quot;-0&quot;</td>
</tr>
<tr>
<td>Material by Entity</td>
<td>Line Wgt: 1</td>
</tr>
<tr>
<td>Material by Entity Layer</td>
<td>Overshoot:</td>
</tr>
<tr>
<td></td>
<td>Z-Base: 0&quot;</td>
</tr>
</tbody>
</table>
|  | Z-Hite: 8'-0"

If you select text, the following information might be displayed:

<table>
<thead>
<tr>
<th>Identify</th>
<th>TEXT</th>
</tr>
</thead>
<tbody>
<tr>
<td>GoTo View</td>
<td>Fix Text: Off</td>
</tr>
<tr>
<td>URL</td>
<td>Layer: Layer001</td>
</tr>
<tr>
<td>File</td>
<td>Color: White</td>
</tr>
<tr>
<td>Object Viewer</td>
<td>Font: ROMANS</td>
</tr>
<tr>
<td>Material by Entity</td>
<td>Size: 6&quot;</td>
</tr>
<tr>
<td>Material by Entity Layer</td>
<td>Angle: 0-0'</td>
</tr>
<tr>
<td></td>
<td>Weight: 1</td>
</tr>
<tr>
<td></td>
<td>Slant: 0-0'</td>
</tr>
</tbody>
</table>
|  | Aspect: 1.0

**Measuring Entities**

You can measure the length or angle of entities or measure the distance between two points without dimensioning them. You can also calculate areas and perimeters as well as the total length of lines in your drawing. And most measurements can be added as text to your drawing.

**Measuring Lengths and Angles**

You can take a variety of measurements of lines, arcs, and angles in your drawing.
To measure the length of a line:

1. Go to the Tools pull-down menu, click on Measure, and then click on Line in the extended menu. Or click on Measures in the Utility menu and click on Line in the Measures menu. You are prompted to Select line.

**Shortcut:** Press (Alt) + (X) to access the Measures menu.

2. Click on the line in your drawing that you want to identify. The line appears as a dashed line and the measurement appears in the Attention toolbar.

3. Add this measurement as text to your drawing by clicking on To Drawing, setting the text options as necessary, and clicking in the drawing where you want to place the text.

To measure the angle of a line:

1. Go to the Tools pull-down menu, click on Measure, and then click on Line Angle. Or click on Measures in the Utility menu and click on Line Angle in the Measures menu. You are prompted to Select line.

2. Click on the line. The angle measurement appears in the Attention toolbar.

3. Add this measurement as text to your drawing by clicking on To Drawing, setting the text options as necessary, and clicking in the drawing where you want to place the text.

To measure the distance between two points in your drawing:

1. Go to the Tools pull-down menu, click on Measure, and then click on Pnt. To Pnt. Or click on Measures in the Utility menu and click on Pnt. To Pnt. in the Measures menu. You are prompted to Select first point of distance to measure.

2. Click on the first point, object snap to a point, or use coordinate entry to select a point. You are prompted to Select second point of distance to measure.

3. Click on the second point, object snap to a point, or use coordinate entry to select a point. The measurement appears in the Attention toolbar.

4. Add this measurement as text to your drawing by clicking on To Drawing, setting the text options as necessary, and clicking in the drawing where you want to place the text.

To measure the diameter of a curve:

1. Go to the Tools pull-down menu, click on Measure, and then click on Diameter. Or click on Measures in the Utility menu and click on Diameter in the Measures menu. You are prompted to Select curve.

2. Click on the curve in your drawing that you want to identify. The curve appears as a dashed line and the measurement appears in the Attention toolbar.

3. Add this measurement in text to your drawing by clicking on To Drawing, setting the text options as necessary, and clicking in the drawing where you want to place the text.

To measure the radius of a curve:

1. Go to the Tools pull-down menu, click on Measure, and then click on Radius. Or click on Measures in the Utility menu and click on Radius in the Measures menu. You are prompted to Select curve.
2. Click on the curve in your drawing that you want to identify. It’s displayed in a dashed line and the measurement appears in the Attention toolbar.

3. Add this measurement as text to your drawing by clicking on To Drawing, setting the text options as necessary, and clicking in the drawing where you want to place the text.

To measure the chord length of an arc:

1. Go to the Tools pull-down menu, click on Measure, and then click on Chord. Or click on Measures in the Utility menu and click on Chord in the Measures menu. You are prompted to Select curve.

2. Click on the curve in your drawing that you want to identify. It’s displayed in a dashed line and the measurement appears in the Attention toolbar.

3. Add this measurement as text to your drawing by clicking on To Drawing, setting the text options as necessary, and clicking in the drawing where you want to place the text.

To measure the arc length of a curve:

1. Go to the Tools pull-down menu, click on Measure, and then click on Arc Length. Or click on Measures in the Utility menu and click on Arc Length in the Measures menu. You are prompted to Select curve.

2. Click on the curve in your drawing that you want to identify. It’s displayed in a dashed line and the measurement appears in the Attention toolbar.

3. Add this measurement as text to your drawing by clicking on To Drawing, setting the text options as necessary, and clicking in the drawing where you want to place the text.

To measure the circumference of a circle:

1. Go to the Tools pull-down menu, click on Measure, and then click on Circ. Or click on Measures in the Utility menu and click on Circ. in the Measures menu. You are prompted to Select curve.

2. Click on the circle in your drawing that you want to identify. It’s displayed in a dashed line and the measurement appears in the Attention toolbar.

3. Add this measurement as text to your drawing by clicking on To Drawing, setting the text options as necessary, and clicking in the drawing where you want to place the text.

To measure the included angle between two lines:

1. Go to the Tools pull-down menu, click on Measure, and then click on Incl. Angle. Or click on Measures in the Utility menu and click on Incl. Angle in the Measures menu. You are prompted to Select first line of angle to measure.

2. Click on the first line. You are prompted to Select second line of distance to measure.

3. Click on the second line. The measurement appears in the Attention toolbar.

4. Add this measurement as text to your drawing by clicking on To Drawing, setting the text options as necessary, and clicking in the drawing where you want to place the text.
To measure the excluded angle between two lines:

1. Go to the Tools pull-down menu, click on Measure, and then click on Excl. Angle. Or click on Measures in the Utility menu and click on Excl. Angle in the Measures menu. You are prompted to Select first line of angle to measure.
2. Click on the first line. You are prompted to Select second line of distance to measure.
3. Click on the second line. The measurement appears in the Attention toolbar.
4. Add this measurement as text to your drawing by clicking on To Drawing, setting the text options as necessary, and clicking in the drawing where you want to place the text.

**Measuring the Total Length of Lines**
You can calculate the total length of lines in a drawing according to color, line type, and line weight. You can use the Color, Line Type, and Weight filters individually or in any combination.

To measure total length of lines:

1. Go to the Tools pull-down menu, click on Measure, and then click on Takeoffs. Or click on Measures in the Utility menu and click on Takeoffs in the Measures menu. The Takeoffs menu appears.
2. Decide which lines you want to include:
   - To include all lines of a specific color in the measurement, click on Color in the Takeoffs menu and then select a color from the color menu. For more information on using color menus, see “Color Menus” in “The Drawing Board” chapter.
   - To include all lines of a specific type, click on Line Type in the Takeoffs menu and then select a line type from the menu.
   - To include all lines of a specific weight, click on Weight in the Takeoffs menu and then select a weight from the value menu. For more information on using value menus, see “Value Menus” in “The Drawing Board” chapter.
   - To include lines on all displayed layers, toggle Layer Search on. Toggle it off to include only those lines on the active layer.
3. Click on Begin. The measurement appears in the Attention toolbar.
4. Add this measurement as text to your drawing by clicking on To Drawing; choose to add the area, the perimeter, or both to your drawing; set the text options as necessary; and click in the drawing where you want to place the text.

**Measuring Areas, Perimeters, and Volumes**
You can calculate the area, perimeter, and volume of an existing polyline or circle in your drawing, or you can define a temporary polyline to measure an area or arc in your drawing.

To measure the area, perimeter, and volume of an existing polyline or circle:

1. Go to the Tools pull-down menu, click on Measure, and then click on Area/Perimeter. Or click on Measures in the Utility menu and click on Area/Per. in the Measures menu. The Area/Per. menu appears.
2. Click on Scale Type; a list of scale types appears. This Scale Type setting is independent from the drawing scale type set in the Settings/Scale Type.

3. Click on a scale type to select it and right-click to exit the scale type list. If you selected Decimal, Inch/Decimal, Meters, Centimeter, Millimeter, DIN, or AS1100 for the scale type, the Area Prec. option is available in the scale type menu if Do Float is toggled off. Use this option to set the number of digits of precision to be displayed for area calculations.

4. Right-click to return to the Area/Per. menu and toggle Add Snap on to add a snapping point to your drawing at each vertex of the polyline you select.

5. Click on Select. You are prompted to Select polyline or circle for area/perimeter calculation.

6. Click on the polyline or circle you want to measure. The area and perimeter measurements appear in the Attention toolbar and additional Area/Per. menu options appear. If you select Arch., Eng., Decimal, Inch/Frac., or Inch/Decimal for the scale type, the Acres option is available in the Area/Per. menu, which you can toggle on to display area units in acres.

7. Display the centroid of the polyline by clicking on Centroid; then click on Show It to display a cross marking the centroid of the polyline or click on Add to add a snapping point at the centroid. Right-click to return to the Area/Per menu.

8. Add or subtract the next area or perimeter measurement from the total. Click on Perim. + to add the next perimeter measurement, click on Perim. - to subtract the next perimeter measurement, click on Area + to add the next area measurement, or click on Area - to subtract the next area measurement. Repeat step 6 as necessary to add or subtract an area or perimeter measurement. Click on Volume in the Area/Per menu to display the volume of the selected polyline. If you select Decimal, Inch/Decimal, Meters, Centimeter, Millimeter, DIN, or AS1100 for the scale type, Area Prec. is available in the scale type menu. Click on Area Prec. and use the value menu to set the number of digits of precision to be displayed for area calculations.

9. Add the measurement as text to your drawing by clicking on To Drawing; choose to add the area, the perimeter, the volume, or both area and perimeter to your drawing; set the text options as necessary; and click in the drawing to place the text.

To measure the area, perimeter, and volume of a polyline you define:

1. Go to the Tools pull-down menu, click on Measure, and then click on Area/Perimeter. Or click on Measures in the Utility menu and click on Area/Per. in the Measures menu. The Area/Per. menu appears.

2. Click on Scale Type. A list of scale types appears.

3. Click on a scale type to select it and then right-click to exit the scale type list. If you select Arch., Eng., Decimal, Inch/Frac., or Inch/Decimal for the scale type, the Acres option is available in the Area/Per. menu, which you can toggle on to display area units in acres.

4. Toggle Add Snap on to add a snapping point to your drawing at each vertex of the polyline you select.

5. Define the polyline to measure using one of these methods:

   - Trace the closed polyline by clicking in the Drawing Area or using object snap to precisely select the first point for the polyline. You are prompted to Select next point on polyline. Continue selecting points as necessary, until the area you want to measure is enclosed by the polyline. You can also trace around arcs. See “More About Tracing Polylines” on the following pages for details.
• Use Rectangle to define a rectangular polyline.
• Use Cont. Search to define any type of closed polyline.

6. Click on Close in the Area/Per. menu to automatically connect the last point on the polyline you selected with the first one. Your cursor is detached from the polyline, and the area and perimeter measurements appear in the Attention toolbar. Additional Area/Per. menu options appear in the Menu Window. Click on Volume in the Area/Per. menu to display the volume of the selected polyline.

7. Display the centroid of the polyline if necessary. Click on Centroid; then click on Show It to display a cross marking the centroid of the polyline, or click on Add to add a snapping point at the centroid. Right-click to return to the Area/Per. menu.

8. Add or subtract the next area or perimeter measurement from the total. Click on Perim. + to add the next perimeter measurement, click on Perim. - to subtract the next perimeter measurement, click on Area + to add the next area measurement, or click on Area - to subtract the next area measurement. Repeat step 5 and 6 as necessary to add or subtract an area or perimeter measurement. To measure a rectangular area or perimeter, simply click on Rectangle in the Area/Per. menu and enter two, diagonally opposite points.

9. Add this measurement as text to your drawing by clicking on To Drawing; choose to add the area, the perimeter, the volume, or both area and perimeter to your drawing; set the text options as necessary; and click in the drawing to place the text.

More About Tracing Polylines
Besides tracing straight sides for your polylines, you can also trace around 2-point arcs, 3-point arcs, and tangent arcs. The 2 Pt. Arc, 3 Pt. Arc, and Tangent options are available in the Area/Per. menu after you select the first point for your polyline.

➤ To trace 2-point arcs:
1. Begin your polyline anywhere on the shape and continue it until you select one end point of the 2-point arc.
2. Click on 2 Pt. Arc in the Area/Per. menu. You are prompted to Select center of arc.
3. Click on the center of the arc or object snap to it. You are prompted to Select end point of arc.
4. Click or object snap to the other end point of the arc. For more information on how to object snap, see “Object Snapping” earlier in this chapter.
5. Repeat steps 3 and 4 to immediately trace around another 2-point arc or right-click to exit the 2 Pt. Arc menu.
6. Continue tracing your polyline and click on Close when finished. The area and perimeter measurements appear in the Attention toolbar.

➤ To trace 3-point arcs:
1. Begin your polyline anywhere on the shape and continue it until you select one end point of the 3-point arc.
2. Click on 3 Pt. Arc in the Area/Per. menu. You are prompted to Select second end point of arc.
3. Click on the second end point of the arc or object snap to it. You are prompted to Select any point on the arc.
4. Click anywhere on the arc.
5. Repeat steps 3 and 4 to immediately trace around another 3-point arc or right-click to exit the 3 Pt. Arc menu.
6. Continue tracing your polyline and click on Close when finished. The area and perimeter measurements appear in the Attention toolbar.

To trace tangent arcs:
1. Begin your polyline anywhere on the shape, making sure you trace the line the arc was drawn tangent to before you reach the first end point of the tangent arc.
2. Select the first end point of the tangent arc, then click on Tangent in the Area/Per. menu. You are prompted to Select ending point of arc.
3. Click on the other end point of the arc or object snap to it.
4. Repeat step 3 to immediately trace around another tangent arc or right-click to exit the Tangent menu.
5. Continue tracing your polyline and click on Close when finished. The area and perimeter measurements appear in the Attention toolbar.

Working with Entities
The Geometry menu has three options that may help you work with the entities in your drawing. You can mark divisions or intersections of entities as well as rotate the snap grid and even the X and Y axes to match an entity.

Shortcut: Press (Alt) + (G) to quickly access the Geometry menu.

Dividing Entities
You can calculate equal divisions of lines and arcs and mark those divisions with snap points. This feature is useful for such things as dividing a stair run into equal tread lengths.

You can also divide a line using the Golden Mean proportion. Golden Mean divides a line into two segments, one longer than the other, so that the smaller section is to the larger section as the larger is to the whole. The exact ratio is 1:1.618, a proportion considered harmonic by ancient Greeks.

To divide a line:
1. Click on Geometry in the Tools pull-down menu or select Geometry from the Utility menu and then click on Divide. The Divide menu appears.
2. Click on Divisions. A value menu appears and you are prompted to Enter number of divisions.
3. Use the value menu or type a number and press (Enter).
4. Decide how you want to divide the line. If you simply want to divide the line into equal parts, skip to step 5. However, to divide the line into sections of a specific distance as well, click on Div. + Dist. A value menu appears and you are prompted to Enter distance between division points. Use the value menu or type a number and press (Enter). You are prompted to Select first point.
5. Click in the Drawing Area to select the first end point of the line or use object snap to select it. You are prompted to Select second point. Click in the Drawing Area to select the second end point of the line or use object snap to select it. The line is divided and a snap point appears at each division.

If you clicked on Div. + Dist. in step 4, you are prompted to Indicate direction of arrows. Drag your cursor to pull the arrow in the direction you want. Then click. DataCAD LT breaks the line into the number of divisions you selected in step 3; however, each division is the length you specified in step 4. If the sum of the lengths of the divisions is less than the total length of the line, DataCAD LT will mark off only the number of divisions you specified. If the sum of the lengths of the divisions is more than the total length of the line, some markers will extend past the end of the line.

To divide an arc, circle, or line:

1. Click on Geometry in the Tools pull-down menu or select Geometry from the Utility menu and then click on Divide. The Divide menu appears.

2. Click on Divisions. A value menu appears and you are prompted to Enter number of divisions.

3. Use the value menu or type a number and press (Enter).

4. Decide how you want to divide the line, arc, or circle. If you simply want to divide the entity into equal parts, skip to step 5.

   However, to divide the entity into sections of a specific distance as well, click on Div. + Dist. A value menu appears and you are prompted to Enter distance between division points. Use the value menu or type a number and press (Enter). Div. + Dist. can be used on straight lines only, not on arcs or circles. You are prompted to Select first point. Skip to the second paragraph in step 6.

5. Click on Entity. You are prompted to Select line, arc, or circle to divide.

6. Select the entity you want to divide by clicking on it in the Drawing Area. The line is divided and a snap point appears at each division.

   If you clicked on Div. + Dist. in step 4, click at the beginning of the line you want to divide. You are prompted to Indicate direction of arrows. Drag your cursor to pull the arrow in the direction you want. Then click. DataCAD LT breaks the line into the number of divisions you selected in step 3; however, each division is the length you specified in step 4. If the sum of the lengths of the divisions is less than the total length of the line, DataCAD LT will mark off only the number of divisions you specified. If the sum of the lengths of the divisions is more than the total length of the line, some markers will extend past the end of the line.

To divide a line using Golden Mean:

1. Click on Geometry in the Tools pull-down menu or select Geometry from the Utility menu and then click on Divide. The Divide menu appears.

2. Click on Golden Mean. You are prompted to Select first point.

3. Select the two end points of the line or simply select the line itself.

   If you select the two end points of a line, the longer segment will start at the first end point.

   If you want to select the line itself, click on Entity. You are prompted to Select line to be divided for Golden Section. When you select the line using Entity, the longer segment will appear on the side of the line that you clicked on.
4. Click in the Drawing Area to select the entity you want to divide. The line is divided and a snap point appears at the division between the two segments.

![Figure 11.11: When you divide the line AC at point B using Golden Mean, the ratio of AB:AC is equal to 1:1.618](image)

**Marking Line Intersections**

You can identify the precise point where two lines intersect and mark the intersection with a snapping point.

➤ To mark the intersection of two lines:

1. Click on Geometry in the Tools pull-down menu or select Geometry from the Utility menu and then click on Intersection. The Intersection menu appears.
2. Determine if the two lines are on different layers. If so, toggle Layer Search on. You are prompted to *Select first line*.
3. Click on one of the lines to select it. You are prompted to *Select second line*.
4. Click on the other line to select it. The intersection is marked with a snapping point.

**Matching the Snap Grid to an Entity**

You can rotate the snap grid to match the angle of an entity, making it easier to draw. This does not rotate the X and Y axes.

➤ To match the snap grid to an entity:

1. Click on Geometry in the Tools pull-down menu or select Geometry from the Utility menu and then click on Tangents. The Tangents menu appears. DataCAD LT automatically changes to orthographic (plan) view when you use Tangents.
2. Set the number of cursor snap angles by clicking on Tan. Div. A value menu appears and you are prompted to *Enter number of cursor snap angles*.
3. Use the value menu or type a number and press (Enter). You are prompted to *Select the line to draw tangent to*.
4. Select an entity to match its angle or select two lines and align the snap grid with the line that bisects the angle between them. You can also select an arc or circle; the cursor is rotated to match the angle of the entity *at the point you selected*.
   - To match an entity’s angle, click on a line to select it. The cursor and snap grid are rotated to match the angle of the line.
- To match a bisected angle between two lines, click on Bisect. Click on the two lines to select them. The cursor and snap grid are rotated to match the angle of the line bisecting the selected entities (see Figure 11.13).

- To align the X and Y axes with the tangent entity, toggle Dist. Sync. on in the Utility/Settings menu (see Figure 11.12).

**Figure 11.12:** Rotating the cursor and snap grid with Tangents, both with and without Dist. Sync. toggled on

**Figure 11.13:** Rotating cursor and snap grid to match bisecting angle
Editing Drawings

Tools included in Edit (in both the Menu Window and the pull-down menu) can change the visible characteristics of entities as well as their position in the drawing. You can clean wall and line intersections, weld breaks, and trim lines to another entity or to an intersection in your drawing.

In addition to repairing drawing mistakes, you can also use a number of features to edit entities. Not only can you change such attributes as the color or line type of an entity, you can also move, rotate, or stretch an entity or even an entire room.

In this chapter:
- Cleaning intersections
- Welding lines and walls
- Trimming lines
- Changing entity attributes
- Moving entities
- Rotating entities
- Erasing entities
- Enlarging entities
- Stretching entities
- Clipping entities
Trimming, Welding, and Cleaning

There are several tools you can use to trim corners and lines, weld lines and walls, and clean up intersections in your drawing.

Trimming Corners

You can connect any two nonparallel lines with either an arc or a line. The Fillets option connects two lines with an arc and can then trim them to make a smooth curve. The Chamfer option connects two lines with a line and can then trim the two lines to the chamfer. These two lines do not have to be connected prior to using Fillets or Chamfer. They can be two lines that form the corner of a room or they can be two completely separate lines in your drawing.

To connect two lines with an arc:

1. Click on Cleanup in the Edit menu in the Menu Window to display the Cleanup menu; go to step 2.
2. Alternatively, click on Fillets in the Draw toolbar and click on Cleanup in the Context toolbar to display the Fillets menu; go to step 3.

**Shortcut:** Press (Alt) + (F) to access the Fillets menu.

3. Change the fillet radius if necessary. The default setting for the fillet radius is 1’-0.” To change the radius of the fillet arc, click on Radius. A value menu appears. Use the value menu or type a radius and press (Enter). The radius remains at this setting for this drawing until you change it. In fact, this setting is saved with the drawing, so that every time you open the drawing, the Fillets radius is automatically set to the value you enter in these steps.

4. Toggle Clip on or off. To trim the ends of the selected lines to the ends of the arc, toggle Clip on. To draw the arc but leave the ends of the lines unaffected, toggle Clip off (see Figure 12.1).

5. Connect lines on two different layers by toggling Layer Search on. You are prompted to **Select first line to fillet.**

6. Click on one of the lines to select it. You are prompted to **Select second line to fillet.**

7. Click on the other line to select it. The two lines are connected by an arc.

You can use Fillets to extend two nonparallel, nonintersecting lines until they intersect. Simply set the Radius to 0 and select the two lines. The lines are lengthened until they intersect.

**Figure 12.1:** Lines trimmed to fillet (Clip on) and lines left untrimmed (Clip off)
To connect two lines with a line:

1. Click on Cleanup in the Edit menu in the Menu Window to display the Cleanup menu; go to step 2.
2. Alternatively, click on in the Draw toolbar and click on in the Context toolbar to display the Chamfer menu; go to step 3.

2. Click on Chamfer in the Cleanup menu. The Chamfer menu appears.

3. Set the chamfer distance for each line by clicking on Distances. The chamfer distance is the distance from the intersection of the two lines to the chamfer point on each line. A value menu appears. You are prompted to Enter first chamfer distance. See Figure 12.2 for an illustration of chamfer distances and how they relate to the lines you select.

4. Use the value menu or type a chamfer distance for the first line you will select and press (Enter). Another value menu appears. You are prompted to Enter second chamfer distance.

5. Use the value menu or type a chamfer distance for the second line you will select and press (Enter).

6. Toggle Clip on or off. To trim the ends of the selected lines to the ends of the chamfer line, toggle Clip on. To draw the chamfer but leave the ends of the lines unaffected, toggle Clip off.

6. Connect lines on two different layers by toggling Layer Search on. You are prompted to Select first line to chamfer.

7. Click on one of the lines to select it. You are prompted to Select second line to chamfer.

8. Click on the other line to select it. The two lines are connected by a line.

Lines may be shortened or lengthened to meet the ends of the chamfer.

Figure 12.2: The first chamfer distance entered corresponds with the first line you select and the second chamfer distance entered corresponds with the second line you select.
Trimming Entities

Trimming entities involves either shortening or lengthening selected lines or arcs. You can trim existing entities to a temporary line that you draw, you can trim two lines so they intersect cleanly, or you can specify not only what entities you want trimmed, but exactly how to trim them. Two-line trim can handle line/arc and arc/arc conditions.

To trim entities so they end at a line you specify:

1. Click on Line Cleanup in the Edit pull-down menu and then click on 1 Line Trim in the submenu. You can also select Cleanup from the Edit menu in the Menu Window and click on 1 Line Trim in the Cleanup menu. Alternatively, you can click on ‌ in the Draw toolbar and click on ‌ in the Context toolbar. The 1 Line Trim menu appears.

2. Select a trim line, a line that entities will be trimmed to. Entities in your drawing will either be shortened or lengthened to meet the trim line. This line can either be an existing line in your drawing or it can be a temporary line that you draw.

   - To use an existing line in your drawing as the trim line, click on Entity in the 1 Line Trim menu. Toggle Layer Search on if your trim line is on a different layer. Click on the line in your drawing to select it as the trim line. Skip to step 4.

   - To draw a temporary trim line, click in the Drawing Area or use coordinate entry to enter the first end point of your trim line. Click in the Drawing Area or use coordinate entry to enter the second end point of your trim line. A dashed line representing the trim line appears.

3. Click anywhere on the outside of the trim line; this will be the side that will be trimmed (see Figure 12.3).

4. Choose a selection method and then select the entities you want to trim. The entities are trimmed to the trim line. For more information on using selection menus, see “Selection Menus” in “The Drawing Board” chapter.

Original

<table>
<thead>
<tr>
<th></th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>line/arc</td>
<td></td>
</tr>
<tr>
<td>line/arc</td>
<td></td>
</tr>
<tr>
<td>line/arc</td>
<td></td>
</tr>
<tr>
<td>___________________</td>
<td></td>
</tr>
<tr>
<td>___________________</td>
<td></td>
</tr>
<tr>
<td>___________________</td>
<td></td>
</tr>
<tr>
<td>___________________</td>
<td></td>
</tr>
</tbody>
</table>

**Figure 12.3:** Trimming entities to a trim line

To trim two lines to their intersection:

1. Click on Line Cleanup in the Edit pull-down menu and then click on 2 Line Trim in the submenu. You can also select Cleanup from the Edit menu in the Menu Window and click on 2 Line Trim in the Cleanup menu. Alternatively, you can click on ‌ in the Draw toolbar and click on ‌ in the Context toolbar. The 2 Line Trim menu appears.

2. Toggle Layer Search on if the lines you want to trim are on different layers. You are prompted to **Select first line to trim.**

3. Click on one of the lines you want to trim. You are prompted to **Select second line to trim.**
4. Click on the other line you want to trim. The lines are trimmed at their intersection. The lines you select do not have to intersect; if they don’t, they will be lengthened when they are trimmed.

![Figure 12.4: Trimming two intersecting lines](image)

To specify the entities to be trimmed and how to trim them:

1. Click on Line Cleanup in the Edit pull-down menu and then click on Free Trim in the submenu. You can also select Cleanup from the Edit menu in the Menu Window and click on Free Trim in the Cleanup menu. The Free Trim menu appears. Free Trim only trims to or between selected entities; therefore, you must select not only the entity you want to trim, but also all the entities that it intersects with.

2. Choose a selection method and then select the entities you want to trim as well as any intersecting entities. All selected entities are displayed in dashed lines.

3. Click on Begin in the Free Trim menu. You are prompted to Select entity section to be trimmed.

4. Click on the line or arc segment that you want trimmed (removed). DataCAD LT searches for the nearest intersections and trims to the intersection points (see Figure 12.5).

5. Continue selecting segments to be trimmed or leave the Free Trim menu by clicking on Exit or right-clicking once.

If you get unexpected results after using Free Trim, click on Undo Free Trim in the Edit pull-down menu or press (Ctrl) + (Z).

![Figure 12.5: Selecting the line segment you want trimmed (removed)](image)

**Welding Lines and Walls**

You can repair lines and walls that have breaks in them, making a single, straight, continuous line or wall.
To weld lines:
1. Click on Line Cleanup in the Edit pull-down menu and then click on Weld Line in the submenu. You can also select Cleanup from the Edit menu in the Menu Window and click on Weld Line in the Cleanup menu. Alternatively, you can click on \( \text{in the Draw toolbar and click on } \) in the Context toolbar. The Weld Line menu appears.

**Shortcut:** Press (Alt) + (W) to access the Weld Line menu.

2. Toggle Layer Search on if the lines you want to weld together are on different layers. You are prompted to *Select first line to weld.*

3. Click on one of the lines you want to weld. You are prompted to *Select second line to weld.*

To weld walls:
1. Click on Wall Cleanup in the Edit pull-down menu and then click on Weld Wall in the submenu. You can also select Cleanup from the Edit menu in the Menu Window and then click on Weld Wall. Or you can click on \( \text{in the Draw toolbar and click on } \) in the Context toolbar. The Weld Wall menu appears.

   If you have already cut the walls by inserting a window or door, you must first erase the window or door before you can weld the walls.

2. Toggle Layer Search on if the walls you want to weld together are on different layers. You are prompted to *Select first point on box around wall opening to weld.*

3. Select the walls to be welded by drawing a rubber band box around the two wall ends you want to weld. There must be only two wall ends within the rubber band box in order for the walls to be welded. To select the first corner of this box, click above and to the left of the wall ends you want to weld. You are prompted to *Select second point on box around wall opening to weld.*

4. Move your mouse diagonally to stretch the rubber band box around the two wall ends you want to weld and click. The walls are welded. If the two walls are not in line with each other, an error message will be displayed in the Attention toolbar, saying *Unable to weld these walls.*

![Figure 12.6: Welding two wall ends](image)

**Cleaning Wall Intersections**
You can clean the wall intersections of 2-line, 3-line, or 4-line walls that meet in an L, T, or X shape.
To clean wall lines meeting in a T intersection:

1. Click on Wall Cleanup in the Edit pull-down menu and then click on T-Intersection in the submenu. You can also select Cleanup from the Edit menu in the Menu Window and then click on T-Intersect. Or you can click on in the Draw toolbar and click on in the Context toolbar. The T Intersect menu appears.

2. Toggle Layer Search on if the wall intersection you want to clean is on a different layer than the active layer. You are prompted to Select first corner around T intersect (wall line ends only).
3. Select the intersection to be cleaned by drawing a rubber band box around it. To select the first corner of the box, click above and to the left of the intersection. You are prompted to *Select second corner around T intersect (wall line ends only).*

4. Move your mouse diagonally to stretch the rubber band box around the intersection and click. You are prompted to *Point to wall line to trim to.* Make sure you include only one intersection within the rubber band box.

5. Click on the wall line to trim to (see Figure 12.10). The intersection is cleaned.

![Figure 12.10: Cleaning a T-shaped intersection](image)

To clean wall lines meeting in a L intersection:

1. Click on Wall Cleanup in the Edit pull-down menu and then click on L-Intersection in the submenu. You can also select Cleanup from the Edit menu in the Menu Window and then click on L-Intersect. Or you can click on in the Draw toolbar and click on in the Context toolbar. The L Intersect menu appears.

2. Toggle Layer Search on if the wall intersection you want to clean is on a different layer than the active layer. You are prompted to *Select first corner around L intersect (wall line ends only).*

3. Select the intersection to be cleaned by drawing a rubber band box around it. To select the first corner of the box, click above and to the left of the intersection you want to clean. You are prompted to *Select second corner around L intersect (wall line ends only).*

4. Move your mouse diagonally to stretch the rubber band box around the intersection and click. The intersection is cleaned.

![Figure 12.11: Cleaning L-shaped intersections](image)
To clean wall lines meeting in a X intersection:

1. Click on Wall Cleanup in the Edit pull-down menu and then click on X-Intersection in the submenu. You can also select Cleanup from the Edit menu in the Menu Window and then click on X-Intersect. Or you can click on in the Draw toolbar and click on in the Context toolbar. The X Intersect menu appears.

2. Toggle Layer Search on if the wall intersection you want to clean is on a different layer than the active layer. You are prompted to Select first corner around X intersect (0 line ends).

3. Select the intersection to be cleaned by drawing a rubber band box around it. To select the first corner of the box, click above and to the left of the intersection you want to clean. You are prompted to Select second corner around X intersect (0 line ends).

4. Move your mouse diagonally to stretch the rubber band box around the intersection and click. The intersection is cleaned.

![Box](image.png)

Original Resulting "X" Intersection

**Figure 12.12:** Cleaning an X-shaped intersection

### Changing Entities

You can change an entity's attributes, such as line type, line weight, color, line spacing, overshoot, Z-base, and Z-height. You can also change the size, weight, slant, aspect, and font of text.

In addition to attributes, some entities have information associated with them; you can also edit this information. There's even a macro that you can use to convert lines to walls or walls to lines.

### Changing Entity Attributes

The line type, line weight, line spacing, overshoot, Z-base, and Z-height attributes can all be changed using value menus. Line spacing settings apply only to nonsolid line types. Use a color menu to change an entity's color.

To change entity attributes:

1. Click on Change in either the Edit pull-down menu or the Menu Window. Or click on in the Edit toolbar. The Change menu appears.

   **Shortcut:** Press (Alt) + (C) to access the Change menu.

2. Toggle Layer Search on if the entities you want to change are on a different layer than the active layer.

3. Click on the attribute you want to change: Line Type, Line Weight, Spacing (line spacing), Overshoot (line overshoot), Z-Base, or Z-Height. A value menu appears.
4. Use the value menu or type a number and press (Enter). For more information on using value menus, see “Value Menus” in “The Drawing Board” chapter.

5. Change the color of the entity by clicking on Color. Select the color you want to use from the color menu. For more information on using color menus, see “Color Menus” in “The Drawing Board” chapter.

6. Choose the selection method you want to use. You are prompted to select the entities you want to change.

7. Select the entities you want to change. The attributes of these entities are modified.

![Figure 12.13: Changing the overshoot of lines](image)

To change entity attributes to match those of another entity:

1. Click on Change in either the Edit pull-down menu or the Menu Window. The Change menu appears. Or click on \( \text{ } \) in the Edit toolbar and skip to step 3.

2. Click to toggle Match on.

3. Toggle Layer Search on if the entities you want to change are on a different layer from the entities you want to match.

4. Choose which attributes to change by toggling on any of the following options: Line Type, Line Weight, Color, Spacing, Overshoot. Z-Base, and Z-Height. Or click on All to toggle all of these attribute options on.

5. Choose the selection method you want to use. You are prompted to select the entity you want to change. For more information on selection menus, see “Selection Menus” in “The Drawing Board” chapter.

6. Select the entity you want to change. You are prompted to select the entity whose attributes you want to match.

7. Select the entity to match. The attributes of the entities you selected in step 6 are modified.

**Changing Text Attributes**

You can change the attributes of a single line of text or of all text in your drawing, depending on what selection method you use.

To change the attributes of text:

1. Click on Change in either the Edit pull-down menu or the Menu Window. Or click on \( \text{ } \) in the Edit toolbar. The Change menu appears.
2. Click on Text in the Change menu.
3. Toggle Layer Search on if the text you want to change is on a different layer than the active layer.
4. Change the appearance of text in your drawing. You can change the size, weight, slant, aspect, contents, capitalization, font name, and matching characteristics in the Change \ Text menu. For more information on text parameter settings, see the “Text, Notes, and Labels” chapter.
   - To change the font, click on Font. The Set Text Parameters dialog box appears. Select a font in the Font Name list box. Keep in mind that the fonts displayed under Font Name are determined by the Font Type selection in the lower-left corner of the dialog box. You can display TrueType fonts (TTF), DataCAD LT fonts (CHR), or both in the list. Make other changes in the dialog box if necessary.
   - To change the text’s size, use the Size button and type the new value. Alternatively, you can click Font to open the Set Text Parameters dialog box; then enter the new size in the Height field or select a value from the Height list box.
   - To change the angle of the lines of text, type an angle value or click on one in the Angle list box.
   - To change the height of each character relative to its width, type an aspect ratio value or click on one in the Aspect list box.
   - To change the slant of text when using a DataCAD LT CHR font, type a slant value or click on one in the CHR Slant list box.
   - To change the line weight of text when using a DataCAD LT CHR font, type a weight value or click on one in the CHR Weight list box.
   - To change the font style when using a TrueType font, click on a style in the TTF Style list box.
   - To change the text properties when using a TrueType font, select Fill, Outline, or Both and then set the colors for the Fill and Outline, as necessary.
5. Click on OK to save the text parameter changes and close the dialog box.
6. Change the text itself by clicking on Contents. (Otherwise, skip to step 9.) You are prompted to select the text you want to change.
7. Choose a selection method from the menu and then select the text. It appears in the Message toolbar. For more information on selection menus, see “Selection Menus” in “The Drawing Board” chapter.
8. Type the new text and press (Enter).
9. Choose the selection method you want to use. You are prompted to select the text you want to change.
10. Select the text you want to change. The attributes of the text are modified.

➤ To change text attributes to match those of another text block:
1. Click on Change in either the Edit pull-down menu or the Menu Window. The Change menu appears. Or click on  
   in the Edit toolbar and skip to step 3.
2. Click on Match.
3. Toggle Layer Search on if the text you want to change is on a different layer from the text you want to match.

4. Choose which attributes to change by toggling on any of the following options: Size, Weight, Slant, Aspect, and Font. Or click on All to toggle all of these attribute options on.

5. Choose the selection method you want to use. You are prompted to select the text you want to change.

6. Select the text you want to change. You are prompted to select the text whose attributes you want to match.

7. Select the text to match. The attributes of the text you selected in step 6 are modified.

**Moving Entities**

You can move an entity to a different position in your drawing by either specifying the distance and angle to reposition it or by dragging it to the new location. You can also move entities to another layer in your drawing.

If an entity is linked to others in a group or selection set, it remains linked when you move it.

You can use object snapping to align a point on the entity you move with a point on another entity in your drawing. Simply snap to the entity to move at the point you want to align and then snap to the other entity at the point to align. The first entity is moved and aligned at the points you snapped to.

**Moving Entities to Absolute Zero**

To move entities to absolute zero:

1. Select Input Mode from the Tools pull-down menu and choose Absolute Cartesian. You can also select Abs. Cartesian from the drop-down list in the Status Panel toolbar. Or click (Ins) until you see Current input mode = Absolute Cartesian (x, y) in the Attention toolbar.

2. Recalculate the extents of the drawing by clicking on in the Navigation Pad toolbar. Then press (PgUp) to zoom out.

3. Select Move from the Edit pull-down menu or the Menu Window. Or you can click on in the Edit toolbar and select Move drawing entities from the drop-down list. The Move menu appears. You are prompted to Select first point of the distance to move.

**Shortcut:** Press (M) to access the Move menu.

4. Select the first point near the center of the drawing. You are prompted to Select second point of the distance to move.

5. Press (Spacebar) to use coordinate entry. The press (Enter) twice to accept the coordinates 0, 0 as the distance from absolute zero.

6. Toggle Layer Search on.

7. Make sure that no layers are locked.
**Hint:** Click on in the Status Panel toolbar to display the Layer Manager dialog box; then check the Lock column and click on any locked icons to change them to unlocked status. Then click on Ok to close the dialog box.

8. Click on Area in the selection portion of the Move menu. You are prompted to Select first corner of area to <MOVE>.

9. Draw an area box around the entire drawing. To do this, click at the upper left of the drawing, drag your mouse diagonally downward until the rubber band surrounds the entire drawing, and click again in response to the prompt to Select second corner of area to <MOVE>. DataCAD LT moves all the entities in your drawing to absolute zero.

**Moving Entities by Specific Distance and Angle**

When you use Move, you are prompted to enter two points. The distance between these two points will be the distance the entity is moved from the original position; the angle defined by these two points will be the angle of the move from the original position.

➢ To move an entity a specified distance and angle:

1. Click on Move in the Edit pull-down menu or the Menu Window. Or you can click on in the Edit toolbar and select Move drawing entities from the drop-down list. The Move menu appears. You are prompted to Select first point of the distance to move.

2. Click in the Drawing Area or use coordinate entry to enter the first point. A directional arrow appears; notice that moving your mouse changes the length and angle of the arrow. You are prompted to Select second point of the distance to move. To use the same distance and angle as the last time you used Move, click on Prev. Dist.

3. Click in the Drawing Area or use coordinate entry to enter the second point. A selection menu as well as other options appear in the Move menu. The points you select in steps 2 and 3 can be selected anywhere on the screen; they indicate the distance and angle to move only, not the beginning and ending points of the move.

4. Move the selected entities in the Z direction if necessary. To do this, click on Move Z and use the value menu to enter the distance to move the entities in the Z direction. Press (Enter) or right-click to return to the Move menu.

5. Toggle Layer Search on if the entities you want to move are on a different layer than the active layer.

6. Toggle And Copy on to copy the selected entities the specified distance and angle.

7. Click on a selection method in the menu. You are prompted to select the entities you want to move. For more information on using selection menus, see “Selection Menus” in “The Drawing Board” chapter.

8. Select the entities; they are moved in the drawing. You can continue selecting entities to move them at the same distance and angle.

   • To move entities at the same distance and angle but in the opposite direction, click on Invert and then select the entities to be moved.

   • To enter a new distance and angle, click on New Distance and continue with step 2 above.
Moving Entities by Dragging

One advantage to dragging entities is that you have the option to select multiple entities before moving them.

➢ To move entities by dragging them:

1. Click on Move in the Edit pull-down menu or the Menu Window. The Move menu appears. Or you can click on \[\text{Move}\] in the Edit toolbar and select \[\text{Move drawing entities by dragging}\] from the drop-down list and skip to step 3.

2. Click on Drag in the Move menu. The Drag menu appears.

3. Toggle Layer Search on if the entities you want to move are on a different layer than the active layer.

4. Toggle And Copy on to copy the selected entities as you drag them.

5. Change the maximum number of lines to be displayed if your entities are complex and you want a smoother drag. Click on Max. Lines and use the value menu to enter the number of lines. Press (Enter) or right-click to return to the Drag menu. When the entities you selected to drag contain more lines than the Max. Lines setting, a rectangular box representing the selected entities appears when you begin to drag them. The entities reappear after you select a new location for them. When you set Max. Lines to 0, the rectangular box is always displayed while dragging.

6. Toggle Multiple on to make multiple selections of entities to be moved.

7. Click on a selection method in the menu. You are prompted to select the entities you want to move.

8. Select the entities to be moved. You are prompted to select a point to drag from.

9. Skip to step 10 if Multiple is toggled off. If you toggled Multiple on in step 6, click on Begin and continue with step 10.

10. Click on a point in the Drawing Area; you can also use coordinate entry or object snapping to select this point. For more information on using coordinate entry, see “Drawing Using Coordinate Entry” in “The Drawing Board” chapter.
11. Move your mouse to drag the entities to their new position and click to place them. The entities are moved in the drawing.

12. Continue dragging and placing copies of the selected entities if And Copy is toggled on.

Moving Entities to Another Layer

When you have more than one layer in your drawing, the To Layer option appears in the Move menu. To Layer is used to move entities from one layer to another in your drawing. You can move entities in the same position as the original layer (no distance and angle entered) or you can move entities to another layer at a specified distance and angle. For more information on creating layers, see “Creating Layers” in the “Before You Draw” chapter.

To move entities to another layer without changing their positions:

1. Click on Move in the Edit pull-down menu or the Menu Window. Or you can click on \( \text{Move drawing entities} \) in the Edit toolbar and select \( \text{Move drawing entities} \) from the drop-down list. The Move menu appears.

2. Click on To Layer in the Move menu. A list of all the layers in your drawing appears and you are prompted to Select layer to move to.

3. Click on the layer you’d like to move entities to or type the name of the layer and press (Enter). The To Layer menu appears. Use Match and Filter to select or find the layer you want to move to. For details on how to use these options, see “Selecting Layers Without Using Layer Names” and “Searching for Layers” in the “Before You Draw” chapter.

4. Toggle Layer Search on if the entities you want to move are on a different layer than the active layer.

5. Click on a selection method in the menu. You are prompted to select the entities you want to move.

6. Select the entities; they are moved to the layer you chose in step 3. You can continue selecting entities to move them.

7. Choose another layer to move entities to by clicking on New Layer and continuing with step 4 above.

To move entities to another layer at a different distance and angle:

1. Click on Move in the Edit pull-down menu or the Menu Window. Or you can click on \( \text{Move drawing entities} \) in the Edit toolbar and select \( \text{Move drawing entities} \) from the drop-down list. The Move menu appears and you are prompted to Select first point of the distance to move. To use the same distance and angle as the last time you used Move, click on Prev. Dist.

**Hint:** The points you select in steps 2 and 3 can be selected anywhere on the screen; they indicate the distance and angle to move only, not the beginning and ending points of the move.

2. Click in the Drawing Area or use coordinate entry to enter the first point. A directional arrow appears; notice that moving your mouse changes the length and angle of the arrow. You are prompted to Select second point of the distance to move.
3. Click in the Drawing Area or use coordinate entry to enter the second point. A selection menu as well as other Move options appear. For more information on using coordinate entry, see “Drawing Using Coordinate Entry” in “The Drawing Board” chapter.

4. Click on To Layer in the Move menu. A list of all the layers in your drawing appears. You are prompted to Select layer to move to.

5. Click on the layer you’d like to move entities to or type the name of the layer and press (Enter). A selection menu plus other Move options appear.

6. Toggle Layer Search on if the entities you want to move are on a different layer than the active layer.

7. Click on a selection method in the menu. You are prompted to select the entities you want to move. For more information on using selection menus, see “Selection Menus” in “The Drawing Board” chapter.

8. Select the entities; they are moved to the layer you chose in step 5. You can continue selecting entities to move them.

9. Choose another layer to move entities to by clicking on New Layer and continuing with step 6 above.

**Moving SPB-Filled Entities**

You can change the order of entities that contain solid, pattern, and bitmap (SPB) fills – instead of standard, vector-based hatch patterns – on a per-layer basis. You can move one SPB-filled entity in front of or behind one another. If you have many of these entities, you can bring one to the front of the group or move it all the way to the back. For more information on creating filled entities, see “Using SPB Fills Instead of Standard Hatch Patterns” in the “Hatch” chapter.

In addition to moving the SPB-filled entities forward and backward, you can change their order using Swap. The In Front, Behind, To Front, To Back, and Swap functions do not work with entities containing standard, vector-based hatch patterns.

You can only move SPB-filled entities forward and backward if they are all on the same layer. If you try to move SPB-filled entities that are on separate layers, the message Both entities must reside on the same layer! appears in the Attention toolbar.

⇒ To move one SPB-filled entity in front of another on the same layer:

1. Click on Move in the Edit pull-down menu or the Menu Window. The Move menu appears. Or you can click on in the Edit toolbar and select Move an entity in front of another from the drop-down list and skip to step 3.

2. Click on In Front. The In Front menu appears and you are prompted to Select entity to move.

3. Click on the SPB-filled entity you want to move in front of another. The entity is surrounded by dashed lines and you are prompted to Select entity to move in front of.

4. Click on the entity that you want to follow the one you selected in step 3. The first SPB-filled entity you selected is now in front of the second.
To move one SPB-filled entity behind another on the same layer:

1. Click on Move in the Edit pull-down menu or the Menu Window. The Move menu appears. Or you can click on in the Edit toolbar and select from the drop-down list and skip to step 3.
2. Click on Behind. The Behind menu appears and you are prompted to Select entity to move.
3. Click on the SPB-filled entity you want to move behind another. The entity is surrounded by dashed lines and you are prompted to Select entity to move behind.
4. Click on the SPB-filled entity that you want to precede the one you selected in step 3. The first entity you selected is now behind the second.

To move an SPB-filled entity to the front of its layer:

1. Click on Move in the Edit pull-down menu or the Menu Window. Or you can click on in the Edit toolbar and select from the drop-down list. The Move menu appears.
2. Click on To Front. The To Front menu appears and you are prompted to Select entity to move to front of layer.
3. Click on the SPB-filled entity you want to move to the front of the layer. The entity you selected is moved.

To move an SPB-filled entity to the back of its layer:

1. Click on Move in the Edit pull-down menu or the Menu Window. Or you can click on in the Edit toolbar and select from the drop-down list. The Move menu appears.
2. Click on To Back. The To Back menu appears and you are prompted to Select entity to move to back of layer.
3. Click on the SPB-filled entity you want to move to the back of the layer. The entity you selected is moved.

To exchange the order between two SPB-filled entities on one layer:

1. Click on Move in the Edit pull-down menu or the Menu Window. Or you can click on in the Edit toolbar and select from the drop-down list. The Move menu appears.
2. Click on Swap. The Swap menu appears and you are prompted to Select first entity to swap.
3. Click on the first SPB-filled entity you want to swap. The entity is now surrounded by dashed lines and you are prompted to Select entity to swap database positions with.
4. Click on the second SPB-filled entity. The positions of the two entities are swapped.
Rotating Entities
You can turn an entity around a rotation center and position it at a specific angle. Or you can dynamically rotate an entity, so that you can preview the rotated position before you place the entity.

➢ To rotate an entity:

1. Click on Rotate in the Edit pull-down menu or the Menu Window. Or you can click on in the Edit toolbar. The Rotate menu appears and you are prompted to Select center of rotation.

   **Shortcut:** Press (R) or (Shift) + (R) to access the Rotate menu.

2. Click in the Drawing Area or use coordinate entry to enter the center of rotation. A selection menu as well as other Rotate options appear.

3. Toggle Layer Search on if the entities you want to rotate are on a different layer than the active layer.

4. Enter an angle of rotation by clicking on NewAngle. A value menu appears. The default angle of rotation is 90°. Use the value menu or type an angle and press (Enter).

5. Toggle And Copy on if you want to both rotate and copy the selected entities.

6. Click on a selection method in the menu. You are prompted to select the entities you want to rotate.

7. Select the entities; they are rotated in the drawing. You can continue selecting entities to rotate them at the same angle and around the same center.
   
   - To rotate entities around the same rotation center but at the opposite angle, click on Invert and then select the entities to be rotated.
   
   - To return to the original angle, click on Invert again.
   
   - To enter a new center of rotation, click on New Center and continue with step 2 above.

➢ To rotate and copy an entity from the Edit toolbar:

1. Click on in the Edit toolbar. appears in the Drawing Area.

2. Click in the Drawing Area or use coordinate entry to enter the center of rotation. A selection menu as well as other Rotate options appear. Notice that And Copy is already toggled on.

3. Toggle Layer Search on if the entities you want to rotate are on a different layer than the active layer.

4. Enter an angle of rotation by clicking on NewAngle. A value menu appears. The default angle of rotation is 90°. Use the value menu or type an angle and press (Enter).

5. Click on a selection method in the menu. You are prompted to select the entities you want to rotate.

6. Select the entities; they are rotated in the drawing. You can continue selecting entities to rotate them at the same angle and around the same center.
• To rotate entities around the same rotation center but at the opposite angle, click on Invert and then select the entities to be rotated.
• To return to the original angle, click on Invert again.
• To enter a new center of rotation, click on New Center and continue with step 2 above.

To rotate an entity dynamically:

1. Click on Rotate in the Edit pull-down menu or the Menu Window. Or you can click on \( \text{\textbullet} \) in the Edit toolbar. The Rotate menu appears and you are prompted to Select center of rotation.
2. Click in the Drawing Area or use coordinate entry to enter the center of rotation. A selection menu as well as other Rotate options appear.
3. Toggle Layer Search on if the entities you want to rotate are on a different layer than the active layer.
4. Click on NewAngle to enter an angle of rotation. A value menu appears. Use the value menu or type an angle and press (Enter).
5. Toggle And Copy on to both rotate and copy the selected entities.
6. Click on Dynamic to preview the rotation before you place the entity. The Max. Lines and Multiple options appear.
7. Set the maximum number of lines to be displayed while rotating for smoother rotating of complex entities. Click on Max. Lines and use the value menu to enter the number of lines. Press (Enter) or right-click to return to the Rotate menu.
8. Toggle Multiple on to select multiple entities to be rotated.
9. Click on a selection method in the menu. You are prompted to select the entities you want to rotate.
10. Select the entities; they are rotated in the drawing. You can continue selecting entities to rotate them at the same angle and around the same center.

More About Setting an Angle of Rotation

Not only can you set the angle of rotation using the NewAngle value menu, but you can also use other options when you click on Match in the value menu to get exactly the angle you want. You can:
• click on an entity to match its angle of rotation
• select two points which define an angle of rotation to match
• enter an angle of rotation and then use the inverse of that angle
• enter an angle of rotation and then use the complement of that angle
• enter an angle of rotation and then use the supplement of that angle

For instance, when your original angle is 30°, clicking on Invert in the Match menu gives you an angle of rotation of –30°. The complement angle is 60° and the supplement angle is 150°.
Stretching Entities

You can increase or decrease the length of an entity — or even an entire room — while maintaining connections to adjacent entities. For example, you can stretch a wall or closet without breaking it from connected walls.

To stretch an entity:

1. Click on Stretch in the Edit pull-down menu or the Menu Window. The Stretch menu appears and you are prompted to *Select first point of the distance to stretch.*

   **Shortcut:** Press (Alt) + (S) to access the Stretch menu.

2. Click in the Drawing Area or use coordinate entry to enter the first point. A directional arrow appears; notice that moving your mouse changes the length and angle of the arrow. You are prompted to *Select second point of the distance to stretch.*

   To increase the possible angles of the directional arrow, press (O) to toggle ortho mode off.

3. Click in the Drawing Area or use coordinate entry to enter the second point. A selection menu as well as other Stretch options appear.

4. Toggle Layer Search on if any of the entities you want to stretch are on a different layer than the active layer.

5. Click on a selection method in the menu. You are prompted to select the entities you want to stretch.

6. Select the entities; they are stretched in the drawing. You can continue selecting entities to stretch them at the same distance and angle.

   - To stretch entities at the same distance and angle but in the opposite direction, click on Invert and then select the entities to be stretched.

   - To enter a new stretch distance and angle, click on New Distance and continue with step 2 above.

![Figure 12.15: Stretching a wall](image)

Figure 12.15: Stretching a wall
Enlarging Entities

You can increase or decrease the size of an entity by entering specific enlargement values for the X, Y, and Z axes.

You can enlarge or reduce imported bitmap and vector graphics to real-world scale. For example, if you import a site map, you can use the Calibrate Distance function to enlarge the plan to real-world dimensions. For more information about this, refer to “Calibrating Enlargements” in the “Symbols, Images, and Objects” chapter.

To enlarge an entity:

1. Click on Enlarge in the Edit pull-down menu or the Menu Window. Or click on the icon in the Edit toolbar and select Scale the size of entities from the drop-down options. The Enlarge menu appears and you are prompted to Select center of enlargement.
2. Click in the Drawing Area or use coordinate entry to enter the center of enlargement. A selection menu as well as other Enlarge options appear; the enlargement factor and line spacing setting appear in the Attention toolbar.
3. Click on Enlarge Z to enter a Z elevation for the center of enlargement. Use the value menu to enter a Z elevation and press (Enter).
4. Toggle Layer Search on if the entities you want to enlarge are on a different layer than the active layer.
5. Click on Enlargement in the Enlarge menu to change one or all of the enlargement factors. The X Enlargmnt., Y Enlargmnt., Z Enlargmnt., Line Factor, and Set All options appear.
6. Click on any enlargement factor option to display a value menu that you can use to set these factors:
   - To enlarge entities along the X axis, click on X Enlargmnt.
   - To enlarge entities along the Y axis, click on Y Enlargmnt.
   - To enlarge entities along the Z axis, click on Z Enlargmnt.
   - To set the line spacing enlargement factor for nonsolid line types, click on Line Factor. The Line Factor setting affects how line types like Dashed are enlarged. A setting matching those of the X, Y, and Z enlargement factors will maintain the line type’s spacing. The Line Factor setting cannot be applied to the geometry of referenced files.
   - To set all of these options to the same setting and enlarge the entity equally in all directions, click on Set All.
7. Use the value menu or type an enlargement setting and press (Enter).
8. Right-click to return to the Enlarge menu.
9. Toggle And Copy on if you want to both enlarge and copy the selected entities.
10. Click on a selection method in the menu. You are prompted to select the entities you want to enlarge.
11. Select the entities; they are enlarged in the drawing. You can continue selecting entities to enlarge them by the same factor and around the same center.
• To enlarge entities around the same enlargement center but at different enlargement factors, click on Invert and then select the entities to be enlarged. Invert mathematically inverts all of the current enlargement factors and displays the new factors in the Attention toolbar. For example, if your enlargement factor is 2.0, clicking on Invert sets it to 0.5.

• To enter a new center of enlargement, click on Center and continue with step 2 above.

You can use the options in the drop-down list when you click on in the Edit toolbar to enlarge entities by set amounts. If you select the option , you must first indicate an enlargement center; then the Set All value menu appears, prompting you to Enter enlargement factor.

**Erasing Entities**

You can remove entities from your drawing by simply using the selection menu in the Erase menu to select the entities. You can also erase a specific segment of a line, circle, or curve.

All entities in an array are identified as a single group. To erase entities within an array, use the Entity or Area selection method.

➢ To erase an entity:

1. Click on Erase in the Edit pull-down menu or the Menu Window. You can also click on in the Edit toolbar. The Erase menu appears.

   **Shortcuts:** Press (E) or (Shift) + (E) to access the Erase menu. Press (,) to erase the last entity you drew. Press (<) to erase the last group of entities, such as an entire array.

2. Toggle Layer Search on if the entities you want to erase are on a layer other than the active layer.
3. Click on a selection method in the menu. You are prompted to select the entities you want to erase.
4. Select the entities; they are erased from the drawing. You can continue selecting entities to erase them.

   Avoid choosing an entity where it crosses another entity because it may be difficult for DataCAD LT to know which one you want to select. Zoom in on your drawing or change your view to select entities more precisely.

5. Right-click when you’re finished erasing entities to exit the Erase menu.

➢ To erase a selected piece of an entity:

1. Click on Partial Erase in the Edit pull-down menu or select Erase in the Edit menu in the Menu Window. You can also click on in the Edit toolbar. The Erase menu appears.

2. Click on Partial in the Erase menu. The Partial menu appears.
3. Toggle Layer Search on if the entities you want to erase are on a layer other than the active layer. You are prompted to Select entity to modify.
4. Click on the entity. It appears in dashed lines to indicate that you selected it. You are prompted to
   Select first point of line segment to remove.

   You cannot partially erase a B-spline or Bezier curve, polyline, or contour.

5. Object snap or click on one point of the segment you want to remove. You are prompted to Select
   second point of line segment to remove.

6. Object snap or click on the other end point of the segment you want to remove.
   • When erasing the end of an entity, select the second point slightly beyond the end of the
     segment to avoid leaving a single point at the end of the line.
   • If you’re erasing part of a line, the line segment you selected is removed; skip to step 8.
   • If you’re erasing part of a curve or circle, you are prompted to Select point on arc to clip out.

7. Click between the two points you selected to remove that segment of the curve or circle or click
   outside the two points you selected to remove the rest of the curve or circle.

8. Repeat steps 4 – 7 as necessary to continue erasing entities. When you’re finished erasing entities,
   right-click to exit the Erase menu.

**Editing Multiple Entities**

You can associate entities in DataCAD LT to simplify editing groups of entities, making your drawing
process more efficient and productive. Simple linking groups selected entities together, while selection
sets associate entities and groups based on their attributes.

**Grouping Entities Together**

You can combine entities, groups, areas of your drawing, or even multiple selection sets into a single
group to make editing easier.

Caution: When you group entities, DataCAD LT moves all entities in the group to the same layer. By
definition, all entities in a group must be on the same layer.

To group or link entities:

1. Click on Group in the Edit menu in the Menu Window or click on Group Entities in the Tools
   pull-down menu. The Group menu appears.

   Shortcut: Press (Alt) + (K) to access the Group menu.

2. Toggle Layer Search on if the entities you want to group together are on different layers.

   Note: When you select entities that are on other layers, DataCAD LT moves all entities to the
   current layer. By definition, a group resides on one layer.

3. Click on a selection method in the menu. You are prompted to select the entities you want to link
   together into a group.

4. Click on the entities you want to group; they are displayed in dashed lines as you select them.

5. Right-click when you’re finished selecting entities. This groups or links the selected entities
   together.

6. Click on Exit or right-click again to exit the Group menu.
To ungroup or separate entities:

1. Click on Group in the Edit menu in the Menu Window or click on Group Entities in the Tools pull-down menu. The Group menu appears.
2. Toggle Layer Search on if the groups you want to separate are on different layers.
3. Toggle Un-Group on in the Group menu.
4. Click on a selection method in the menu. You are prompted to select the entities you want to separate.
5. Click on the entities you want to separate; they are displayed in dashed lines as you select them.
6. Right-click when you’re finished selecting entities. This removes the selected entities from the group.
7. Click on Exit or right-click again to exit the Group menu.

**Clipping and Cropping**

The ClipIt macro can be used to erase, move, or copy 2D and 3D lines, 2D arcs, or 2D circles. ClipIt is especially useful for editing hatched areas in elevation drawings or for copying large portions of your drawing. Entities that are clipped or cropped retain such attributes as line type and line color. Circles, 2D arcs, and 2D lines all retain their Z-base and Z-height settings. The Z values for the new end points for 3D lines are recalculated based on the slope of the line.

ClipIt only works in orthographic (plan) view. So if you are using a perspective view, DataCAD LT will automatically switch to plan view for ClipIt functions and then switch back to perspective view when you exit ClipIt.

**Caution:** Make sure you leave the ClipIt macro by clicking the Exit button in the Menu Window. This macro creates a temporary file that it uses as an undo buffer. If you exit the ClipIt macro by right-clicking, this temporary undo buffer is not deleted. That can lead to file corruption in future drawing sessions. When you click on the Exit button to leave the ClipIt macro, you delete the temporary undo buffer.

You can choose whether to clip or crop the selected portion of your drawing. **Clipping** selects entities inside the selection boundary, while **cropping** selects entities outside the selection boundary.

**Figure 12.16:** Clipping vs. cropping
You can also choose to erase the selection from your drawing, move the selection to another place in your drawing, or copy the selection to another place in your drawing.

<table>
<thead>
<tr>
<th></th>
<th>Before Clipping</th>
<th>Select area to Clip</th>
<th>After Clipping</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut</td>
<td><img src="image1.png" alt="Cut example" /></td>
<td><img src="image2.png" alt="Cut example" /></td>
<td><img src="image3.png" alt="Cut example" /></td>
</tr>
<tr>
<td>CutCopy</td>
<td><img src="image4.png" alt="CutCopy example" /></td>
<td><img src="image5.png" alt="CutCopy example" /></td>
<td><img src="image6.png" alt="CutCopy example" /></td>
</tr>
<tr>
<td>Copy</td>
<td><img src="image7.png" alt="Copy example" /></td>
<td><img src="image8.png" alt="Copy example" /></td>
<td><img src="image9.png" alt="Copy example" /></td>
</tr>
</tbody>
</table>

**Figure 12.17:** Different results from cutting, cutting and copying, and copying

To clip or crop entities in your drawing:

1. Click on ClipIt in the Toolbox pull-down menu. The ClipIt menu appears. If ClipIt is not listed as a macro, click on Configure in the Toolbox pull-down menu and add ClipIt to the Macros in Menu list.

2. Toggle one of the four boundary types (Area, Fence, Radius Circ., or DiaCirc) on. The ClipIt boundary separates a selected area from the rest of your drawing, allowing you to select entities either inside or outside of it.
   - Area lets you draw a rectangular boundary by selecting two diagonal corners of the rectangle.
   - Fence lets you draw a polygonal boundary with up to 36 sides that can be concave or convex as long as its lines don’t cross. If you select less than 36 points for the boundary, right-click to finish the polygon.
   - Radius Circ. lets you draw a circle by defining its radius (select its center point and a point on the circle).
   - DiaCirc lets you draw a circle by defining its diameter (select two points opposite each other on the circle).

   Generally, ClipIt processes entities most quickly when the boundary is a rectangle or a simple polygon with only three or four sides. A circular boundary will process more slowly and a more complex polygon will have the slowest processing time.

3. Click on Cut to erase entities, click on CutCopy to move entities, or click on Copy to copy entities. You can clip or crop entities from multiple layers, but you can only copy entities to the active layer.

4. Click on Clip to select entities inside the boundary you will draw or click on Crop to select entities outside the boundary.

5. Click on 2D Line, 3D Line, 2D Arc, or Circle to specify the type of entity you want to select. You can select one or any combination of these four entity types.

6. Toggle Boundry on to leave the outline of the boundary in your drawing. (See “After Clipping” for Cut and CutCopy in Figure 12.17 for an example of a boundary outline.)
7. Toggle LyrSrch on to clip or crop entities on all layers that are toggled on; toggle LyrSrch off to clip or crop entities on only the active layer.

To decrease processing time, click on Layers in the ClipIt menu and toggle off all the layers that don’t have entities that you want to clip or crop. This Layers option accesses the Layers menu in DataCAD LT without exiting ClipIt.

8. Select points as prompted to draw the boundary. After you select the last point for the boundary:
   - If you toggled Cut on, selected entities are clipped or cropped. Skip to step 11.
   - If you toggled CutCopy or Copy on, you are prompted to Enter point to drag from.

9. Click in the Drawing Area to enter the point where your cursor will attach to the copy. You are prompted to Enter point of insertion on [the active layer].

10. Place the copy in your drawing. To do this, move your mouse and click in the Drawing Area, use coordinate entry, or object snap to an existing entity. Repeat this step to continue placing copies.

11. Repeat steps 2 – 10 to continue clipping or cropping. When you are finished, click on Exit to close the ClipIt macro.

If your drawing is very complex, the percentage of entities clipped/cropped (not the percentage of processing time) appears in the Attention toolbar. When processing is complete, the total time is also displayed.

You can change the layer to copy to – without changing the active layer setting – by clicking on To Layer in the ClipIt menu and selecting the layer you want to copy to. To create new layers to copy to, use the Layers option in the ClipIt menu to quickly access the Layers menu without exiting ClipIt.
Text, Notes, and Labels

You can add notes, labels, and other text to your drawing using DataCAD LT’s Text tools. You can control text appearance and justification, and save these settings as a text style that you can use in any drawing. To place text in your drawing, simply click in the Drawing Area to select a justification point or define an area to fit the text into. With either method, you can position notes quickly and precisely.

Text can be imported into your drawing or even exported from it. DataCAD LT uses text (.TXT) files in each of these processes.

You can use Windows TrueType fonts to enter text in your drawings.
Drawing Text

Text can be entered and edited anywhere in your plan. DataCAD LT has 23 text fonts you can use, and you can add your own fonts to your DATACAD LT\Fonts folder. You can also use any TrueType fonts (TTF) that you have installed on your computer.

When the Text menu appears, the text cursor replaces the standard drawing crosshairs. This cursor appearance represents the current text height, angle, slant, and aspect ratio settings. To change the appearance of text already in your drawing, you must select Change\Text\Font to open the Set Text Parameters dialog box. This lets you change text parameters. See “Changing Text Attributes” in the “Editing Drawings” chapter.

To add text to your drawing:

1. Click on Text in the Create pull-down menu, or click on Text in the Edit menu in the Menu Window, or click on Text in the Draw toolbar. The Text menu appears.

2. Customize the appearance of text by clicking on each setting option in the Text menu or by clicking on Font to change all the settings at once. If you click on Font, the Set Text Parameters dialog box appears.

Note: Using the Set Text Parameters dialog box saves time and lets you see a sample of the font in the preview window before you click OK.

- Click on a font in the FontName list box. Keep in mind that the fonts displayed under FontName are determined by the Font Type selection in the lower-left corner of the dialog box. You can display TrueType fonts (TTF), DataCAD LT fonts (CHR), or both in the list.
**Note:** Each drawing has its own 0.5MB swap space for CHR fonts. DataCAD LT also has an indexed list of fonts (both TTF and CHR) you used; this list is limited to 64 fonts. This means you can display up to 64 fonts simultaneously.

- To set the text’s actual size in your drawing, type a height value or click on one in the Height list box. With Text Scale toggled on, text is entered in the drawing relative to the current plot scale setting. For example, if you set Height to 1" and the plotting scale to ¼", text entered in your drawing would appear 4' high.

- To set the angle of the lines of text, type an angle value or click on one in the Angle list box.

- The aspect ratio of text is the height relative to the width of each character. An aspect ratio of 1 represents the normal character style, while an aspect ratio of 5 produces text that is taller and narrower. To set the height of each character relative to its width, type an aspect ratio value or click on one in the Aspect list box.

- When using a DataCAD LT CHR font (not a TTF font), you can set the angle of each character of text, as measured from the base of the character to its top. Type a slant value or click on one in the CHR Slant list box.

- When using a DataCAD LT CHR font (not a TTF font), you can set a text weight from 1 to 99, with “1” being the default weight setting. For example, to triple the weight of text, set Weight to 3. To set the line weight of the text, type a weight value or click on one in the CHR Weight list box. Another way to produce heavy text on a drawing is to place it on a separate layer and then define a unique color for that layer. When you plot the drawing, you can assign a thicker pen to that layer. See “Using Pen Tables” in the “Printing Your Drawing” chapter for details on how to set pens for plotting.

- When using a TrueType font, you can select a font style. Click on a style in the TTF Style list box.

- When using a TrueType font, you can set the properties for the font using the TTF Properties options. Select Fill, Outline, or Both and then set the colors for the Fill and Outline, as necessary.

3. Click on OK to save the text parameter changes and close the dialog box.

4. Set the space between lines of text by clicking on Factor in the Text menu. Use the value menu or type a factor for your text; right-click to return to the Text menu. DataCAD LT calculates the amount of space between lines of text by multiplying the text height by the factor.

5. Toggle Dynamic on to enter text directly into the drawing as you type it. Toggle Dynamic off to enter the text only in the Message toolbar; you will have to press (Enter) to add the text to the drawing.

**Hint:** With Dynamic on, your cursor must remain in the drawing window if you want carriage return to work when you press (Enter).

6. Toggle Text Scale on to size your text by using the Size setting relative to the current plot scale. If you toggle Text Scale off, the text size displays and plots, according to the Height setting in the Set Text Parameters dialog box.

7. Toggle All Caps on to enter your text in capital letters; toggle All Caps off to enter text as you typed it.
8. Decide on how you want to align the text. Use the Alignment button to set text appearance before entering text. To left align text, toggle Left on; to center align text, toggle Center on; to right align text, toggle Right on.

If you want to align text that has already been entered, use the Justify button.

9. Click in the Drawing Window or use coordinate entry to select the point where text should be entered in your drawing. This is the point of justification for the text you enter.

10. Type the text. If you toggled Dynamic on in step 5, the text appears in the drawing as you type; if Dynamic is toggled off, the text appears in the Message toolbar and you must press (Enter) to add the text to the drawing.

Text can include many other characters in addition to those found on the keyboard. These extended characters are typed by pressing (Alt) + a character number. See the Appendix for a complete list of extended characters.

11. Click on Exit or right-click when you’re finished entering text.

**Justifying Text**

You can change the justification of text after you enter it in your drawing. Text can be justified to the left, center, or right of a justification line that you define.

➔ To justify text in your drawing:

1. Click on Text in the Create pull-down menu, or click on Text in the Edit menu in the Menu Window, or click on in the Draw toolbar. The Text menu appears.

2. Click on Justify in the Text menu. You are prompted to Select first point on justification line.

The justification line should be vertical, not horizontal.

3. Click in the Drawing Area or use coordinate entry to enter the first point of the justification line. You are prompted to Select second point on justification line.

4. Click in the Drawing Area or use coordinate entry to enter the second point of the justification line. The Justify menu appears.

5. Decide how you want to justify the text. To left justify text, toggle Left on; to center justify text, toggle Center on; to right justify text, toggle Right on.

6. Click on a selection method in the menu. You are prompted to select the text you want to justify. For more information on using selection menus, see “Selection Menus” in “The Drawing Board” chapter.

7. Select the text you want to justify. The text is aligned with the justification line, according to the justification setting you chose in step 5.

8. Continue selecting text to justify it to the same justification line; click on NewLine to define a new justification line and continue with step 3 above; or right-click to return to the Text menu.

**Aligning Text**

You can control the alignment of the text you use in your drawing. There are nine text alignment points:

- Top - Left
Top – Center
Top – Right
Middle – Left
Middle – Center
Middle – Right
Bottom – Left
Bottom – Center
Bottom - Right

To set the alignment for the text you enter into your drawing:
1. Click on Text in the Create pull-down menu, or click on Text in the Edit menu in the Menu Window, or click on button in the Draw toolbar. The Text menu appears.
2. Click on Alignment in the Text menu. The Alignment menu appears.
3. Use the toggles to control the way your text will be inserted.
   - Left: Text inserted from left to right.
   - Center: Text inserted from the center.
   - Right: Text inserted from right to left.
   - Top: Cursor is at the top of the characters you input.
   - Middle: Cursor is at the midpoint of the characters you input.
   - Bottom: Cursor is at the bottom of the characters you input.
   - Aligned: Adjusts text to fit between two given points.
   - Fit: Adjusts text to fit a certain width and height.
   - Reversed: Draws each character backward from right to left.
   - Mirrored: Draws each character upside down from left to right.
4. Right-click to return to the Text menu.

The text cursor coincides with the current text alignment setting. A “+” marker is incorporated into the carat as a visual indicator of the current alignment setting.

Fitting Text into Defined Areas
Another way to enter text in your drawing is to define the height and width of the area where you’d like to place a line of text. The text size and aspect ratio are automatically calculated so that the text you type fits into the area you defined.

To fit text into an area:
1. Click on Text in the Create pull-down menu, or click on Text in the Edit menu in the Menu Window, or click on button in the Draw toolbar. The Text menu appears.
6. Click on Alignment in the Text menu. You are prompted to Set text alignment method.
7. Toggle Fit on. Then right-click to display the Fit Text menu. You are prompted to Select text start point.
8. Click in the Drawing Area or use coordinate entry to enter the point where you want the text to begin. You are prompted to Select text end point.

9. Click in the Drawing Area or use coordinate entry to enter the point where you want the text to end. You are prompted to Select point to mark text height.

10. Click in the Drawing Area or use coordinate entry to enter a point; this point and the end point you selected in step 5 define the height of the area. You are prompted to Enter text.

11. Type the line of text that you want to fit in the defined area. Then press (Enter). DataCAD LT calculates the aspect ratio and size so that it can fit the text you typed into the area you defined. This changes the Aspect and Size settings in the Text menu.

To return Aspect and Size to their previous settings (before you used Fit), change them in the Text menu.

8. Enter additional lines of text using the same aspect ratio and size calculated in step 7 by simply typing them. Since DataCAD LT does not support word wrapping, you must press (Enter) at the end of each line.

![One Two Three](image)

**Figure 13.2:** Three words fit in the parameters set in steps 3 through 5

9. Stop fitting text within the defined area by right-clicking to return to the Fit Text menu, selecting Alignment to go to the Alignment menu, clicking on Aligned, and right-clicking to go to the Aligned Text menu. Then you can select the text start point and type the information. If you right-click again, you return to the Edit menu.

If you do not toggle Aligned on, DataCAD LT will continue using the Fit criteria the next time you type text. In the Alignment menu, Aligned and Fit are mutually exclusive toggles.

### Importing and Exporting Text

You can export text in your drawing to a text (.TXT) file as well as import a text file into your drawing. Using this method to import text only supports MS-DOS Text (*.TXT) files. To import other text formats, open the text file in its native program (for example, MS Word or Word Perfect), then use Copy and Paste to bring the text into DataCAD LT.

To import text into your drawing:

1. Click on Text File in the Insert pull-down menu. In the dialog box that appears, find the text files you want to insert into your drawing. If necessary, you can search in other folders (not just those listed in the Plot Files folder).
2. Click on the text (.TXT) file you want to import; then click on Open. The dialog box closes and the FromFile menu appears.

3. Use the menu options (as described earlier in this chapter in the instructions on adding text to your drawing) to customize the appearance of the text you want to import. You are prompted to Select point to position text.

1. Click in the Drawing Area or use coordinate entry to enter the upper-left point of the block of text being imported. The text is added to the drawing.

The Wrap Length option uses a value menu to set the number of characters allowed per line; characters over this number are wrapped to the next line.

5. Continue selecting points to copy the imported text to other parts of your drawing or right-click to return to the Text menu.

To export text from your drawing:

1. Click on Export in the File pull-down menu; then click on TXT in the submenu. The dialog box prompts you to Enter the name of the text file to create.

2. Type a name for the text file that you want to export text to; then click on Save. The dialog box closes and a From File selection menu appears.

3. Click on a selection method in the From File menu. You are prompted to select the text you want to add to the text file. For more information on using selection menus, see “Selection Menus” in “The Drawing Board” chapter.

4. Select the text you want to export. DataCAD LT exports the text you selected to the text file you created in step 2.

5. Continue selecting text to export to the text file. Alternatively, you can right-click to display the dialog box again and save information in another text file. If you don’t need to save another text file, click Cancel to close the dialog box.

Using Text Styles

You can save your Text menu settings as a text style. Then, you can use them later to quickly apply those settings before adding text to a drawing.

To save a text style:

1. Click on Text in the Create pull-down menu, or click on Text in the Edit menu in the Menu Window, or click on Text in the Draw toolbar. The Text menu appears.

2. Click on Font… in the Text menu. The Font dialog appears.

3. Click on Text Style Name dialog appears.
4. Type a name for your new text style and click OK. DataCAD LT saves the text style.

   To use a text style:
   1. Click on Text in the Create pull-down menu, or click on Text in the Edit menu in the Menu Window, or click on \(\text{Text}\) in the Draw toolbar. The Text menu appears.
   2. Click on Font… in the Text menu. The Font dialog appears.
   3. Click on \(\text{Title Text}\) in the Text Styles section. A list of text styles appears.
   4. Click on a text style in the list. Settings for Text options are changed to those of the text style you chose; any text you draw now will use those settings.

   To delete a text style:
   1. Click on Text in the Create pull-down menu, or click on Text in the Edit menu in the Menu Window, or click on \(\text{Text}\) in the Draw toolbar. The Text menu appears.
   2. Click on Font… in the Text menu. The Font dialog appears.
   3. Click on \(\text{Title Text}\) in the Text Styles section. A list of existing text styles appears.
   4. Select the name of the text style you want to delete then click on \(\times\) A confirmation box appears.

   5. Press (Enter) or click Yes to confirm you really want to delete the text style.

**Drawing Text Arrows**

You can draw arrows from text in your drawing to the parts of the drawing the text refers to. It is easy to customize the size, style, aspect, weight, and color of the arrowheads.
To draw a text arrow:

1. Click on Text in the Create pull-down menu, or click on Text in the Edit menu in the Menu Window, or click on \( \text{Text} \) in the Draw toolbar. The Text menu appears.

2. Click on Arrows in the Text menu. The Arrows menu appears.

3. Choose an arrowhead style. Click on Style in the Arrows menu. A list of five arrowhead styles appears (see Figure 13.3 for examples).

4. Click on the name of the arrowhead style you want to use and right-click to return to the Arrows menu.

   For Closed and Dot arrowheads, you can fill the space with a color or leave it blank. Use the Filled toggle to fill (On) or to leave the arrowhead blank (Off). The Filled toggle is not available if you select Open, Bridge, or Tick arrowhead styles.

5. Indicate the size of the arrowhead. The size of the arrowhead is the measurement of its widest point. Arrowhead size is relative to text size; if the Size setting in the Text menu is 1 and the Size setting in the Arrows menu is 3, the arrowhead size will be three times the height of your text. To set the size of the arrowhead, click on Size. A value menu appears.

   For Open and Closed arrowheads, Size sets the length of the arrowhead base. For Bridge arrowheads, Size sets the radius of the curve of the arrowhead. For Dot arrowheads, Size sets the diameter of the dot. For Tick arrowheads, Size sets the length of the tick mark.

6. Use the value menu or type a number for the size and press (Enter). This setting, Relative arrow size, appears in the Attention toolbar whenever you are in the Arrows menu.

7. Set the aspect ratio for arrowheads by clicking on Aspect in the Arrows menu. A value menu appears.

8. Use the value menu or type a number for the aspect ratio and press (Enter). See Figure 13.3 for examples of aspect settings. An ANSI-standard arrowhead has an aspect ratio of 6.

9. Set the line weight for arrowheads by clicking on Weight. A value menu appears.
10. Use the value menu or type a number for the line weight and press (Enter).

11. Set the color for arrowheads by clicking on Color. A color menu appears. For more information on using color menus, see “Color Menus” in “The Drawing Board” chapter.

12. Use the color menu to select a color for arrowheads. You are prompted to Draw arrow.

13. Draw arrows. Arrows are drawn from the end of the arrow to the point of the arrowhead. Click in the Drawing Area or use coordinate entry to enter the end of the arrow.

14. Continue entering points to draw bends or angles in the arrow if necessary. The last point you enter will be the point of the arrowhead.

15. Right-click to complete the arrow; the arrowhead is drawn according to the settings you specified in previous steps.

Using TrueType Fonts Instead of SHX Fonts
In addition to “stroke”, a.k.a. vector-based SHX fonts, you can use TrueType fonts in your drawings. You can convert TrueType fonts to 3D for signage in architectural models. Any font definitions that cannot be found will be replaced by the default SHX or TrueType font specified in Program Preferences.

To use TrueType fonts:

1. Click on Text in the Create pull-down menu, or click on Text in the Edit menu in the Menu Window, or click on in the Draw toolbar. The Text menu appears. Then, click on Font in the Text menu. The Set Text Parameters dialog box appears.

![Figure 13.4: Control the appearance of TrueType fonts](image)
2. Type something in the small box at the lower right corner of the Font Preview area. For example, in Figure 13.4, HapPenInc is the name of the Hap company that manufactures pens. The larger display shows what the text will look like, depending on the font you highlight in the FontName section of this dialog box.

3. Go to the Font Type section and click Only TTF if you want to display just the TrueType fonts in the Font Name section of this dialog box.

4. Change the settings in the Font Name, Height, Angle, Aspect, CHR Slant, CHR Weight, and TTF Style sections until the sample in the Font Preview window is correct.

   • To choose colors, click Fill, Outline, or Both in the TTF Properties section.
   • To use the active layer’s color for the fill and/or outline, check the Fill using current color and/or the Outline using current color boxes.
   • To specify your own colors for the fill and/or outline, uncheck the boxes. Then click on the color swatch to the left of the unchecked box to display the Color Palette dialog box, where you can either select a standard color or mix your own. For more information on using the color palette, see “Color Menus” in “The Drawing Board” chapter and “Customizing Colors” in the “Before You Draw” chapter.

6. Click OK when you are satisfied with your text parameters. When you return to the Drawing Window, the cursor changes to a text tool and you are prompted to Select point to position text.

7. Click where you want the text to appear in your drawing.

8. Type the text in your drawing. Notice that all your font settings are in effect.

9. Right-click when you are finished typing text.

![HapPenInc](image)

**Figure 13.5:** Results of TrueType font decisions in the drawing

> To convert TrueType fonts to 3D:

1. Go to the 3D Menus menu and select Explode.

2. Click on TTF->P-Line in the Explode menu to convert the TrueType fonts to covered polylnines.

You can create 3D signage by exploding the polylnines to slabs. To do this, use the TTF-> Slab option in the Explode menu.
Using Text Attributes for Symbols

Text attributes can be defined and added to symbols. This lets you use the same symbol multiple times, supplying a unique text string for each one. For example, you could use one desk symbol several times and label them “Jim’s desk,” “Nancy’s desk,” and “Bob’s desk.”

Adding Text Attributes for Symbols

When you create a text attribute for a symbol, you use the Drawing Window as a scratch pad. There are several ways to create these attributes: using Sym Attrib in the Text menu, choosing Create Attribute in the Symbol Browser’s Options menu, or selecting Symbol Attributes from the Create pull-down menu. You control the appearance of the attribute by selecting options from the Text menu.

You associate the text attribute you created with an exploded symbol by using Save Symbol from the Symbol Browser’s Options menu. Make sure Explode is off when you place the symbol back into your drawing.

→ To create a symbol attribute from the Text menu:

1. Place an exploded symbol in your Drawing Window.
2. Click on Text in the Create pull-down menu, or click on Text in the Edit menu in the Menu Window, or click on \[ \text{\textbf{Text}} \] in the Draw toolbar. The Text menu appears. Make decisions about the text’s appearance by using the Size, Angle, Weight, Slant, Aspect, Factor, Font, Text Style, Text Scale and All Caps options.

**Hint:** Save time by selecting Font from the Text menu and use the Set Text Parameters dialog box to control many of your options and view a sample in the Font Preview window.

3. Click on Alignment and use the toggles to control the way your text will be inserted; then right-click to return to the main Sym Attrib menu.

| Left       | Text inserted from left to right. |
| Center     | Text inserted from the center.    |
| Right      | Text inserted from right to left. |
| Top        | Cursor is at the top of the characters you input. |
| Middle     | Cursor is at the midpoint of the characters you input. |
| Bottom     | Cursor is at the bottom of the characters you input. |
| Aligned    | Adjusts text to fit between two given points. |
| Fit        | Adjusts text to fit a certain width and height. |
| Reversed   | Draws each character backward from right to left. |
| Mirrored   | Draws each character upside down from left to right. |

**Note:** The text cursor coincides with the current text alignment setting. A “+” marker is incorporated into the carat as a visual indicator of the current alignment setting. There are nine text alignment points.

4. Click on Sym Attrib. The text cursor appears and you are prompted to *Select point to position text.* Once you position your cursor, the Create Symbol Attribute dialog box appears for a symbol.

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Name of the attribute.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prompt</td>
<td>Reminder question.</td>
</tr>
<tr>
<td>Value</td>
<td>Information that should appear on the symbol. This can include constant text.</td>
</tr>
<tr>
<td>Value Properties</td>
<td></td>
</tr>
</tbody>
</table>
Invisible
Information that appears in the Value field will be invisible if you check this box. If there is no check in the box, the Value text will appear in your drawing. This can be applied to either Locked or Preset.

Variable
Supply new information when prompted.

Preset
Add new information. This allows you to use constant text either before or after the new information.

Locked
Supply information that cannot be changed.

Create multiple attributes
If this is checked, you can supply more symbol attributes. Each symbol can have many attributes.

---

**Figure 13.6:** A symbol can have multiple attributes if the Create multiple attributes box is checked.

5. Click on OK or press (Enter) to leave the Create Symbol Attribute dialog box. If you enabled (the box is checked) Create multiple attributes, repeat steps 4 and 5. When you are finished creating attributes for this symbol, make sure you disable Create multiple attributes (the box is not checked).

6. Turn off Explode in the Symbol Browser’s Options pull-down menu. Then save the symbol and its attribute by following the directions under “Creating New Symbols” in the “Symbols, Images, and Objects” chapter. Make sure you use Area in the Save Symbol menu rather than Group. (Group ignores the attribute.) DataCAD LT creates a .DSF file for the symbol. When you are finished saving the symbol and its attribute, right-click to leave the Sym Attrib menu.

7. Place the symbol into your drawing as often as necessary.
Figure 13.8: You can place several symbols in your drawing and modify the attributes

8. Select Edit Symbol Attributes from the Symbol Browser’s Options pull-down menu. Then click on the symbol. The Edit/Customize Symbol Attribute dialog box appears.

Figure 13.9: The Edit/Customize Symbol Attribute dialog box prompts you for the value that should appear on the symbol in your drawing

9. Supply the information in the Value column and click on Ok. (In this example, “’s Desk” and “PD-1-” were constants; “Michelle” and “936” were added to these constant values.) If you placed the same symbol into your drawing several times and want to use different values, repeat steps 8 and 9 as often as necessary.

Figure 13.10: Several personalized desks were placed in the drawing

**Editing Text Attributes for Symbols**

If you selected Locked in the Value Properties portion of the Create Symbol Attribute dialog box, you cannot edit the value. If you selected Variable, you supply new information when responding to the Prompt question.
What if some of the information in a symbol changes. For example, what if Harry leaves the company and his desk is reassigned to MaryJane?

- To edit an existing symbol attribute for a symbol:
  1. Select Edit Symbol Attributes from the Symbol Browser’s Options menu.
  2. Click on the symbol attribute you want to edit. (In this case, Harry.) The Edit/Customize Symbol Attribute dialog box appears.
  3. Change only the relevant information. (In this case, change Harry to MaryJane.) Then click on OK.

![Figure 13.11: Notice that the inventory control number stayed the same, but MaryJane replaced Harry as the desk's owner.](image)

4. Edit other existing symbol attributes by repeating steps 2 and 3.

Symbol Attributes appear as Block Attributes when you open a DWG file.

**Generating Reports Based on Symbol Text Attribute Data**

You can use symbol text attributes to generate reports. In addition, you can assign values to symbol text attributes by selecting them from a tab-delimited database.

- To generate a report based on symbol text attribute data:
  1. Create the text attributes and symbols and place them in your drawing.
  2. Select Extract Attributes from the Symbol Browser’s Options menu. The Symbol Attribute Report dialog box appears. Each attribute has its own column.
  3. Select one of the options in the Layer Search block. You can search for symbol attributes in only the Active layers, only the layers that are turned On, or All the layers in your drawing.
  4. Determine how you want to display the data and click in the appropriate boxes:
    - Quantities – displays the attributes with a Qty column.
    - Layers – displays the attributes with a Layer column.
    - Quantities and Layers – displays the attributes with both Layer and Qty columns.
Figure 9.20: Symbol Attribute Report dialog box.

Click on Copy if you want to add the symbol attribute report to your clipboard. This allows you to paste the symbol attribute report into a drawing file or a document.
Dimensions

Dimensions in DataCAD LT can measure the distance between two points, the diameter or radius of curves, or the angle between two entities. You have full control over how the dimension text, lines, and arrows look as well as where they are placed in your drawing.

Stringline and baseline dimensions can be drawn by simply selecting a series of points; they can even be drawn automatically, with the distance between every end point along a wall measured and added to the series of dimensions.

You can even draw associative dimensions. These dimensions are linked to the entity they measure; whenever that entity changes size, the dimension is automatically updated.
Drawing Linear Dimensions

Linear dimensions (the most common type) measure the distance between two points. You can draw standard stringline or baseline linear dimensions, which require you to select the end points for each dimension, or you can automatically create a stringline or baseline dimension by simply selecting the two end points of the entire series of dimensions. In addition, you can edit dimensions or explode them into separate entities.

To dimension between two points in your drawing:

1. Click on Dimension in the Create pull-down menu and then click on Linear Dimension in the submenu. You can also click on in the Draw toolbar or click on Dimensions in the Utility menu, then select Linear from the Dimensions menu. The Linear menu appears.

2. Choose one of the following options to position dimensions:
   - To dimension a single line, arc, or circle, simply click on Entity and follow the prompts.
   
   You can toggle only one of the following options on at any time: Horizontal, Vertical, Aligned, and Rotated.

   - To draw horizontal linear dimensions, toggle Horizontal on.
   - To draw vertical linear dimensions, toggle Vertical on.
   - To draw linear dimensions that are parallel to the dimensioned entity, toggle Aligned on.
   - To set the angle to draw linear dimensions, click on Rotated and use the value menu to enter a rotation angle. For more information on using value menus, see “Value Menus” in “The Drawing Board” chapter.

![Examples of the four available positions for linear dimensions](image)

3. Decide whether you want to use associative dimensions. Associative dimensions are connected to the entity they measure; so if you were to stretch that entity, its dimension would automatically be updated. Toggle Associative on if you want to draw associative dimensions. Another advantage to using associative dimensions is that if you change drawing scales (for example, from architectural to engineering), all associative dimensions would automatically be updated with the new scale.
4. Customize the way dimension text is drawn by clicking on Text Style and setting the options as necessary. See “Text Style Options for Linear Dimensions” on the following pages for details.

5. Customize the way dimension lines are drawn by clicking on Dim. Style and setting the options as necessary. See “Line Style Options for Linear Dimensions” on the following pages for details.

6. Customize the way dimension arrows are drawn by clicking on Arrow Style and setting the options as necessary. See “Arrow Style Options for Linear Dimensions” on the following pages for details.

7. Respond to the prompt to Select first point of distance to dimension. For greater accuracy, object snap to one end point of the distance you want to dimension. You can also select this point by clicking in the Drawing Area or using coordinate entry. You are prompted to Select second point of distance to dimension. For more information on how to object snap to an entity, see “Object Snapping” in the “Drawing Tools” chapter.

8. Object snap to the second end point of the distance you want to dimension. The dimension lines appear; notice if you move your mouse cursor to the other side of the entity you’re dimensioning, the dimension lines flip to that side. You are asked, Dimension which side of line?

9. Click to one side of the line to place the dimension on that side. If the dimension text fits between the extension lines, the dimension is drawn; skip to step 12 to continue.

   If the dimension text doesn’t fit between the extension lines, only the dimension lines are drawn and you’re prompted with Text does not fit. Enter new text position.

10. Place dimension text that doesn’t fit between the extension lines by using any of the following options:

    You can use any combination of the Rotate, Draw Leader, and Text Style options to customize dimension text.

    - Click on Rotate and use the value menu to set an angle for the text; click in the Drawing Area to place the text.
    - Click on Draw Leader to draw a leader from the dimension line to the text. Click in the Drawing Area or use coordinate entry to draw the leader, and then right-click to place the dimension text.
    - Click on Text Style to change the text style settings so that the text will fit between the extension lines; click in the Drawing Area to place the text.

11. Draw stringline dimensions from the dimension you just drew by clicking on String Line. To draw baseline dimensions, click on Baseline. Follow the prompts to draw the series of dimensions. Using String Line or Baseline to dimension along an entire wall of your plan can save you time because you only have to enter the second point of each dimension. Whether this series of dimensions is stringline or baseline depends on the settings in the Auto Style menu.

12. Finish drawing the dimension series. Then right-click to return to the Linear menu.

13. Complete drawing stringline dimensions. Then click on Overall in the Linear menu to dimension the entire stringline.

14. Continue with step 8 above to enter additional dimensions.
To automatically create a series of dimensions:

1. Click on Dimension in the Create pull-down menu and then click on Linear Dimension in the submenu. You can also click on in the Draw toolbar or click on Dimensions in the Utility menu, then select Linear from the Dimensions menu. The Linear menu appears.

2. Indicate which of these four options you want use to position dimensions:
   - To draw horizontal linear dimensions, toggle Horizontal on.
   - To draw vertical linear dimensions, toggle Vertical on.
   - To draw linear dimensions that are parallel to the dimensioned entity, toggle Aligned on.
   - To set the angle to draw linear dimensions, click on Rotated and use the value menu to enter a rotation angle.

See Figure 14.2 for examples of these options.

3. Decide whether you want to use associative dimensions. Associative dimensions are connected to the entity they measure; so if you were to stretch that entity, its dimension would automatically be updated. Toggle Associative on if you want to draw associative dimensions. Associative dimensions can be exploded or changed to standard dimensions that aren't connected to the entity. See “Exploding Linear Dimensions” later in this chapter for more information.

4. Customize the way dimension text is drawn by clicking on Text Style and setting the options as necessary. See “Text Style Options for Linear Dimensions” on the following pages for details.

5. Customize the way dimension lines are drawn by clicking on Dim. Style and setting the options as necessary. See “Line Style Options for Linear Dimensions” on the following pages for details.

6. Customize the way dimension arrows are drawn by clicking on Arrow Style and setting the options as necessary. See “Arrow Style Options for Linear Dimensions” on the following pages for details.

7. Customize the way automatic dimensions are drawn by clicking on Auto Style and setting the options as necessary. See “Automatic Dimension Style Options for Linear Dimensions” on the following pages for details.

8. Click on Auto Dim. You are prompted to Select first end point of line to dimension along.

9. Object snap to one end point of the distance you want to dimension for greater accuracy. You can also select this point by clicking in the Drawing Area or using coordinate entry. You are prompted to Select second end point of line to dimension along.

10. Object snap to the second end point of the distance you want to dimension. The dimension lines appear; notice if you move your mouse cursor to the other side of the entity you’re dimensioning, the dimension lines flip to that side. You are asked, Dimension which side of line?

11. Click to one side of the line to place the dimension on that side. The series of dimensions is drawn.

Figure 14.2: Examples of stringline, stringline with overall, and baseline dimensions

**Text Style Options for Linear Dimensions**

Use the following options in the Text Style menu to customize dimension text styles:

- **Text Size**: Set the dimension text’s actual size in your drawing. The Text Size, Weight, Slant, Aspect, Color, Text Scale, and Font options work exactly like equivalent options in the Text menu. See the “Text, Notes, and Labels” chapter for more information. For more information on using value menus, see “Value Menus” in “The Drawing Board” chapter. The decimal separator for all dimensions and numbers is determined by the Decimal Symbol setting. In your Windows Start menu, click on Settings, click on Control Panel, click on Regional Settings, and click on the Number tab.

- **Weight**: Set the line weight of dimension text, from 1 to 99 with “1” being the default weight setting; to triple the weight of text, for instance, set Weight to 3.

- **Slant**: Set the angle of each character of text, as measured from the base of the character to its top.

- **Aspect**: Set the height of each character relative to its width; an aspect ratio of 1 represents the normal character style, while an aspect ratio of 5 produces text that is taller and narrower.

- **Text Scale**: Toggle Text Scale on to size your text by using the Size setting relative to the plot scale; toggle Text Scale off to size your text size based only on the Text Size setting.

- **In Horiz.**: Toggle on to place dimension text horizontally in your drawing (independent of the orientation of the dimension lines); the dimension line is “broken” to accommodate the text.
Out Horiz.  Toggle on to place dimension text horizontally in your drawing (independent of the orientation of the dimension lines) and at the end of the leader; this option is only used with the Draw Leader option, which is available only if the text is too large to fit between the dimension's extension lines.

Above  Toggle on to draw the dimension text parallel to and “above” the dimension line; if InHorz is also toggled on, then the dimension text will be drawn horizontally but the dimension line will not be “broken”.

Offset  Set the distance of text from the dimension line.

Auto  Toggle on to automatically place text, according to the Text Style menu settings; toggle off to place the text for each dimension manually, using Rotate, Draw Leader, or Text Style as described in the instructions for drawing dimensions earlier in this chapter; when Auto is off, right-clicking to place the dimension text will place the text as if Auto were toggled on.

Color  Set the color of dimension text. For more information on using color menus, see “Color Menus” in “The Drawing Board” chapter.

Font  Set the font used for dimension text (see Figure 14.3).

---

**Figure 14.3:** Selecting a font, with a preview of the selection

---

**Line Style Options for Linear Dimensions**

Each dimension in a stringline shares its extension lines with the next dimension in the series, so you see only a single line displayed on screen. But when you plot your drawing, your plotter reads two lines – the second extension line for one dimension and the first extension line for the following dimension. If your plotter prints both these lines, extension lines in a stringline can appear to have a double thickness. To avoid this, toggle either Line 1 or Line 2 off when you draw stringline dimensions.

Use the following options in the Dim. Style menu to customize dimension line styles:

- **Line 1**  Toggle on to draw the first extension line.
- **Line 2**  Toggle on to draw the second extension line.
- **Offset**  Set the distance between the entity being dimensioned and the beginning of the extension lines of the dimension (see Figure 14.4).
Overlap
Set the distance extension lines are drawn past dimension lines (see Figure 14.4).

Increment
Set the distance between dimension lines when drawing baseline dimensions; this option has no effect on stringline dimensions unless set to 0, which results in a running dimension without the first arrow (see Figure 14.4).

Overrun
Set the distance dimension lines are drawn past extension lines; a setting of 0 results in the dimension line ending at the extension lines (see Figure 14.4).

Fixed Incr.
Toggle on to draw dimension lines a fixed distance away from the entity being dimensioned; toggle off to enter the distance yourself when you click to select which side of the entity to draw the dimension on (see Figure 14.4).

DIN Standard
Toggle on to use the DIN Standard, set by the German Institute for Standardization (see Figure 14.5).

Rounding
Set rounding for dimension text; toggle RoundIt on and choose from rounding up or down or banker’s rounding; click on Precision to set the fractional rounding value for rounding up or down.

Limits
Set the upper and lower limit for the size of entities to dimension (see Figure 14.6).

Tolerance
Set positive and negative geometric tolerances (see Figure 14.6).

Figure 14.4: Dimension settings: A = Offset, B = Overrun, C = Overlap, D = Increment (with Fixed Incr. toggled on), E = Text Offset

Figure 14.5: DIN standard dimension

Figure 14.6: Dimensions with Limit and Tolerance settings
**Arrow Style Options for Linear Dimensions**

Use the following options in the Arrow Style menu to customize dimension arrow styles:

<table>
<thead>
<tr>
<th>Only one of the three options Arrows, Tick Marks, and Dots can be toggled on at a time.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arrows</td>
</tr>
<tr>
<td>Tick Marks</td>
</tr>
<tr>
<td>Dots</td>
</tr>
<tr>
<td>Size</td>
</tr>
<tr>
<td>Weight</td>
</tr>
<tr>
<td>Aspect</td>
</tr>
<tr>
<td>Filled</td>
</tr>
<tr>
<td>Color</td>
</tr>
</tbody>
</table>

**Automatic Dimension Style Options for Linear Dimensions**

Use the following options in the Auto Style menu to customize automatic dimension styles:

<table>
<thead>
<tr>
<th>Just one of the two options Only Points and No Points one can be toggled on at a time.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Only Points</td>
</tr>
<tr>
<td>No Points</td>
</tr>
<tr>
<td>Min. Dist.</td>
</tr>
<tr>
<td>Miss Dist.</td>
</tr>
<tr>
<td>Layer Search</td>
</tr>
<tr>
<td>Direct Dim.</td>
</tr>
</tbody>
</table>

**Editing Linear Dimensions**

You can edit any linear dimensions in your drawing by changing the text styles, lines styles, or arrow styles of the dimension. You can also change the position of dimension text.

⇒ To edit linear dimension text, lines, or arrows:

1. Click on Dimension in the Create pull-down menu and then click on Linear Dimension in the submenu. You can also click on in the Draw toolbar or click on Dimensions in the Utility menu, then select Linear from the Dimensions menu. The Linear menu appears.

2. Click on Change in the Linear menu. The Change menu appears.
3. Click on Text Style to change the dimension text settings, click on Dim. Style to change the dimension line settings, or click on Arrow Style to change the dimension arrow settings. The Text Style, Dim. Style, and Arrow Style options in the Change menu are the same as those in the Linear menu. See “Text Style Options for Linear Dimensions,” “Line Style Options for Linear Dimensions,” and “Arrow Style Options for Linear Dimensions” earlier in this chapter for details.

4. Click on a selection method in the Change menu. You are prompted to select the dimension you want to change.

5. Click on the dimension you want to edit. The dimension is changed to match the text, line, and arrow style changes you made in step 3.

➢ To move dimension text:

1. Click on Dimension in the Create pull-down menu and then click on Linear Dimension in the submenu. You can also click on in the Draw toolbar or click on Dimensions in the Utility menu, then select Linear from the Dimensions menu. The Linear menu appears.

2. Click on Change in the Linear menu. The Change menu appears.

3. Click on Text Pos. in the Change menu. You are prompted to Select associative dimension to change text position.

4. Click on the dimension text you want to move. A box representing the text is connected to your cursor and the Rotate option appears in the menu.

5. Rotate the text before repositioning it in your drawing by clicking on Rotate and using the value menu to enter a rotation angle. Otherwise, continue with step 6.

6. Move your cursor to the new location and click to place the text in its new position or use coordinate entry to enter a new location for the text. For more information on using coordinate entry, see “Drawing Using Coordinate Entry” in “The Drawing Board” chapter.

7. Move dimension text back to its default position by clicking on Default and then clicking on the dimension text. The text is returned to its default angle and position.

Exploding Linear Dimensions
While you can freely edit nonassociative dimensions, there may also be times that you need to edit an associative dimension measurement. Associative dimensions are connected to the entity they measure, so these measurements automatically adjust when the entity changes size. To edit an associative dimension, you first must explode the dimension or disconnect it from the entity it’s associated with.

When you explode dimensions, their appearance is not affected.

➢ To explode an associative dimension:

1. Click on Dimension in the Create pull-down menu and then click on Linear Dimension in the submenu. You can also click on in the Draw toolbar or click on Dimensions in the Utility menu, then select Linear from the Dimensions menu. The Linear menu appears.

2. Click on Explode in the Linear menu. The Explode menu appears.

3. Click on a selection method in the Explode menu. You are prompted to select the dimension you want to explode.
4. Click on the associative dimension(s) you want to explode. The dimensions you selected are exploded or disassociated from the entities they measure. They become 2D lines and text.

**Drawing Dimensions for Angles and Curves**

You can dimension the angle between two lines as well as the diameter or radius of a curve.

To dimension the angle between two lines:

1. Click on Dimension in the Create pull-down menu and then click on Angular Dimension in the submenu. You can also click on \[\text{Angular Dimension}\] in the Draw toolbar or click on Dimensions in the Utility menu, then select Angular from the Dimensions menu. The Angular menu appears.

2. Customize the way dimension text is drawn by clicking on Text Style and setting the options as necessary. See “Text Style Options for Angle and Curve Dimensions” on the following pages for details.

3. Customize the way dimension lines are drawn by clicking on Dim. Style and setting the options as necessary. See “Line Style Options for Angle and Curve Dimensions” on the following pages for details.

4. Customize the way dimension arrows are drawn by clicking on Arrow Style and setting the options as necessary. See “Arrow Style Options for Angle and Curve Dimensions” on the following pages for details.

5. Toggle Layer Search on if the lines that form the angle you want to dimension are on different layers. You are prompted to Select first line.

6. Click on one of the lines in your drawing that forms the angle you want to dimension. The line appears as dashed to indicate its selection. You are prompted to Select second line.

7. Click on the other line in your drawing that forms the angle you want to dimension. The line appears as dashed to indicate its selection. Also notice that your cursor is connected to a curve representing the angle dimension line; moving your cursor changes the position of the dimension line.

8. Position the angle dimension line and click to place it in your drawing. You are prompted to Enter angle.

9. Press (Enter) to accept the actual angle measurement or type an angle and press (Enter). The dimension line is drawn and a small box representing the dimension text is connected to your cursor.

10. Place the dimension text next to the dimension line by positioning your cursor and clicking. To place the text in its default position, simply right-click. The dimension is completed.

To dimension a curve’s diameter:

1. Click on Dimension in the Create pull-down menu and then click on Diameter Dimension in the submenu. You can also click on \[\text{Diameter Dimension}\] in the Draw toolbar or click on Dimensions in the Utility menu, then select Diameter from the Dimensions menu. The Diameter menu appears.

2. Customize the way dimension text is drawn by clicking on Text Style and setting the options as necessary. See “Text Style Options for Angle and Curve Dimensions” on the following pages for details.
3. Customize the way dimension lines are drawn by clicking on Dim. Style and setting the options as necessary. See “Line Style Options for Angle and Curve Dimensions” on the following pages for details.

4. Customize the way dimension arrows are drawn by clicking on Arrow Style and setting the options as necessary. See “Arrow Style Options for Angle and Curve Dimensions” on the following pages for details.

5. Toggle Layer Search on if the curve you want to dimension is on another layer. You are prompted to Select arc or circle to dimension.

6. Click on the curve you want to dimension. You are prompted to Enter diameter.

7. Press (Enter) to accept the actual diameter measurement or type a diameter and press (Enter). The dimension is drawn.

To dimension a curve’s radius:

1. Click on Dimension in the Create pull-down menu and then click on Radius Dimension in the submenu. You can also click on \( \text{Radius} \) in the Draw toolbar or click on Dimensions in the Utility menu, then select Radius from the Dimensions menu. The Radius menu appears.

2. Customize the way dimension text is drawn by clicking on Text Style and setting the options as necessary. See “Text Style Options for Angle and Curve Dimensions” on the following pages for details.

3. Customize the way dimension lines are drawn by clicking on Dim. Style and setting the options as necessary. See “Line Style Options for Angle and Curve Dimensions” on the following pages for details.

4. Customize the way dimension arrows are drawn by clicking on Arrow Style and setting the options as necessary. See “Arrow Style Options for Angle and Curve Dimensions” on the following pages for details.

5. Toggle Layer Search on if the curve you want to dimension is on another layer. You are prompted to Select arc or circle to dimension.

6. Click on the curve you want to dimension. You are prompted to Enter radius.

7. Press (Enter) to accept the actual radius measurement or type a radius and press (Enter). The dimension is drawn.

**Text Style Options for Angle and Curve Dimensions**

Use the following options in the Text Style menu to customize dimension text styles:

- **Text Size**: Set the dimension text's actual size in your drawing. The Text Size, Weight, Slant, Aspect, Color, Text Scale, and Font options work exactly like equivalent options in the Text menu. See the “Text” chapter for more information.

- **Weight**: Set the line weight of dimension text, from 1 to 99 with “1” being the default weight setting; to triple the weight of text, for instance, set Weight to 3. For more information on using value menus, see “Value Menus” in “The Drawing Board” chapter.

- **Slant**: Set the angle of each character of text, as measured from the base of the character to its top.

- **Aspect**: Set the height of each character relative to its width; an aspect ratio of 1 represents the normal character style, while an aspect ratio of 5 produces text that is taller and narrower.

- **Text Scale**: Toggle Text Scale on to size your text by using the Size setting relative to the plot scale; toggle Text Scale off to size your text size based only on the Text Size setting.
Auto  
Toggle on to automatically place text, according to the Text Style menu settings; toggle off to place the text for each dimension manually, using Rotate, Draw Leader, or Text Style as described in the instructions for drawing dimensions earlier in this chapter.

Color  
Set the color of dimension text.

Font  
Set the font used for dimension text (see Figure 14.3).

The decimal separator for all dimensions and numbers is determined by the Decimal Symbol setting. In your Windows Start menu, click on Settings, click on Control Panel, click on Regional Settings, and click on the Number tab.

**Line Style Options for Angle and Curve Dimensions**

Use the following options in the Dim. Style menu to customize dimension line styles:

- **Offset**: Set the distance between the entity being dimensioned and the beginning of the extension lines of the dimension. See Figure 14.4 for an example of Offset and Overlap settings.
- **Overlap**: Set the distance extension lines are drawn past dimension lines.
- **Center Mark**: Toggle on to draw center marks for diameter and radius dimensions.
- **Rounding**: Set rounding for dimension text; toggle Round It on; and choose Round Up or Round Down or Bankers rounding; click on Precision to set the fractional rounding value for rounding up or down.
- **Limits**: Set the upper and lower limit for the size of entities to dimension (see Figure 14.6).
- **Tolerance**: Set positive and negative geometric tolerances (see Figure 14.6).

**Arrow Style Options for Angle and Curve Dimensions**

While the Arrows, Tick Marks, and Dots toggles appear only in the Arrow Style menu for linear dimensions, they affect all four dimension types: Linear, Angular, Diameter, and Radius. Use the following options in the Arrow Style menu to customize dimension arrow styles:

- **Size**: Set the size of dimension arrows, tick marks, or dots; this setting is relative to the dimension text size, so if Size is set to 2, dimension arrows will be drawn twice the size of dimension text.
- **Weight**: Set the line weight of tick marks; not available if Open or Dots is toggled on in the Arrow Style menu for linear dimensions.
- **Aspect**: Set the aspect ratio of the dimension arrows; this aspect ratio setting is the length of the arrowhead divided by the height, so a setting of 1 draws arrowheads with a 90° angle; not available when Tick Marks or Dots is toggled on in the Arrow Style menu for linear dimensions.
- **Filled**: Fill in the arrowhead when Open or Dots is toggled on.
- **Color**: Set the color of arrows, dots, or tick marks. For more information on using color menus, see “Color Menus” in “The Drawing Board” chapter.
Hatch patterns can add detail as well as visual information to your drawings. In DataCAD LT, there are two types of hatch: standard and associative. Standard hatch is a group of entities inserted in your drawing according to Hatching menu settings. Associative hatch is a single entity and will update itself as necessary when you edit your drawing. Both types require you to define polyline boundaries for the hatch pattern.
**Drawing Hatch Patterns**

You can fill areas of your drawing with repetitive patterns, called *hatch patterns*, to distinguish between building materials or to highlight parts of your drawing. However, standard hatch can increase file size and refresh times dramatically. To control file size as well as save time while editing your drawing, use associative hatch. See the Appendix for a list of the hatch patterns that come with DataCAD LT.

**Drawing Standard Hatch**

The lines in hatch patterns are separate entities that are linked as a group, so you can move or edit the entire area of hatch using the Group option in selection menus. However, you can also edit individual lines in the hatch pattern using the Entity selection method.

To draw a standard hatch pattern:

1. Click on Hatch in the Create pull-down menu, or click on Hatching in the Utility menu, or click on \( \) in the Draw toolbar. The Hatching menu appears.

   **Shortcut:** Press (H) or (Shift) + (H) to access the Hatching menu.

2. Click on Hatch Type to set the hatching type. Select one of the three options available and then right-click to return to the main Hatching menu.
   - **Normal** – toggle this on to alternate hatching within defined boundaries (see Figure 15.1).
   - **Outermost** – toggle this on to hatch only the first boundary (see Figure 15.2).
   - **Ignore** – toggle this on to hatch within the outermost boundary and ignore all other boundaries (see Figure 15.3).

\[ \]

**Figure 15.1:** Hatching using the Normal hatching type

**Figure 15.2:** Hatching using the Outermost hatching type
3. Click on Pattern. A list of the hatch patterns you appear, along with a preview window. Notice that as you move your cursor over each hatch pattern name in the list, an example of the highlighted hatch pattern appears in the preview window. Click on Scroll Fwrd to scroll forward through the list of patterns; click on Scroll Back to scroll back through the list. Choose a pattern by clicking on its name in the list and pressing (Enter). You are returned to the Hatching menu.

5. Change the scale or angle of the hatch pattern you selected if necessary.
   - Scale – change this setting by clicking on Scale. A value menu appears. Use the value menu or type a scale and press (Enter).
   - Angle - change this setting by clicking on Angle. A value menu appears. Use the value menu or type an angle and press (Enter). (The default setting is 0°.)

5. Set the point where the hatch pattern will begin by clicking on Origin. You are prompted to Select hatch pattern origin. Click in the Drawing Area, use coordinate entry, or object snap to an entity to select the origin for the hatch pattern.

6. Define a boundary for the hatch pattern. A boundary is a polyline that defines the area of your drawing that will be hatched. Click on Boundary. The Boundary menu appears. You can define a rectangular boundary, have DataCAD LT automatically create it with Cont. Search, generate a unique one that may include curves/arcs as well as straight line segments, or create voids within the polyline that will not be hatched. These different boundary definition methods are described in “Defining the Hatch Boundary.”

Notice that the Attention toolbar describes your hatch pattern, scale, angle, and type.

6. Click on Begin to hatch the area within the boundary. The hatch pattern is drawn. Click on Clear to delete the boundary and return all hatch settings to their defaults.

Using the Hatch Pattern Manager

There are many hatch patterns available with DataCAD; however, you probably don’t want to scroll through all of them when you just need six or seven in your drawing file. The Hatch Pattern Manager allows you to embed a few patterns from all those available into your current drawing file. Later, you can add more hatch patterns to the list if you want to embed more into a particular file.

Embedded hatch patterns now require less memory than those used in DataCAD versions 10 and prior. DataCAD automatically converts your hatch pattern definitions from DCADWIN.PAT to individual .DHP files stored in \DataCAD\Support Files\Hatch Patterns.
The Hatch Pattern Manager has two sections: the Embedded Hatch Patterns and the External Hatch Patterns. The lower section lists all the External Hatch Patterns that are available from your hard disk or server. When you highlight one of the patterns, a picture of it appears in the window to the right of the list. Beneath the picture of the hatch pattern is information about the scale, angle, and display scale of that pattern.

In the External Hatch Patterns section, highlight the pattern you want and click on the Load button to add a copy of it into the Embedded Hatch Patterns list. You cannot make changes to external definitions in this section.

You can make changes (affecting scale, angle, and/or display scale settings) to hatch patterns that are loaded into the Embedded Hatch Patterns section only. If you do not want to use changes you made to the scale, angle, and/or display scale settings, you click on the Reload button to reload the pattern’s default values from the hard drive or server.

The upper section lists the Embedded Hatch Patterns that you selected and modified (if necessary) from the list in the lower window. This list of patterns is attached to your current drawing file. When you select Pattern from the Hatching menu, you will see only the patterns that appear in the Embedded Hatch Patterns window of the Hatch Pattern Manager.

You can make a change (for example, changing the scale value) to one of the embedded hatch patterns. If you want this change to take effect, click on Apply. This activates the Save and Save As buttons in the Embedded Hatch Patterns section. Highlight the pattern you changed, click Save As, and supply a name for the hatch pattern. It will be saved as a .DHP file and be added to the External Hatch Patterns portion of the Hatch Pattern Manager. Then, you can load the newly named pattern into the Embedded Hatch Patterns section. If you want to reinstate the values of the original pattern, simply highlight it in the list of Embedded Hatch Patterns and click on Reload.

When you are satisfied with your choices and/or modifications, clicking on OK transfers the list in the Embedded Hatch Patterns section of the Hatch Pattern Manager to your current drawing file. This list appears when you select Pattern from the Hatching menu.

You can manually convert DataCAD hatch patterns (.PAT) to the new (.DHP) format. Use the Convert option from the Hatch Pattern Manager to do this.
Defining the Hatch Boundary

The hatch boundary is a closed polyline that surrounds the hatch pattern. One of the easiest ways to define the hatch boundary is to let DataCAD LT perform a contour search. The next easiest method is to hatch within a rectangular boundary. The most complex method is to define a boundary that includes curves and/or arcs as well as straight line segments.

To hatch a closed polyline with contour search:

1. Click on Hatch in the Create pull-down menu, or click on Hatching in the Utility menu, or click on the Hatch button in the Draw toolbar. The Hatching menu appears.
2. Choose Boundary from the Hatching menu.
3. Click on Cont. Search in the Boundary menu. You are prompted to Select point inside/outside contour.
4. Click on the boundary of the closed polyline you want to use.
6. Right-click to return to the Hatching menu.

To define a rectangular boundary:
1. Click on Hatch in the Create pull-down menu, or click on Hatching in the Utility menu, or click on the Draw toolbar. The Hatching menu appears.
2. Click on Boundary. The Boundary menu appears.
3. Select Rectangle. The Rectangle menu appears and you are prompted to Select first corner of rectangle.
4. Select the first point of the rectangle by clicking in the Drawing Area, using coordinate entry, or object snapping to an entity. For more information on coordinate entry, see “Drawing Using Coordinate Entry” in “The Drawing Board” chapter. You are prompted to Select second corner of rectangle.
5. Drag your mouse toward the diagonally opposite corner of the rectangular area you want to hatch. Click once when you get to the opposite corner of the rectangle. The rectangular boundary is drawn.
6. Right-click to return to the Hatching menu.

To define a boundary that includes curves and/or arcs:
1. Click on Hatch in the Create pull-down menu, or click on Hatching in the Utility menu, or click on the Draw toolbar. The Hatching menu appears.
2. Click on Boundary. The Boundary menu appears and you are prompted to Select first point on boundary to hatch to.
3. Select the first point of the boundary by clicking in the Drawing Area, using coordinate entry, or object snapping to an entity. The options 2 Pt. Arc and 3 Pt. Arc appear in the Boundary menu. You are prompted to Select next point on boundary to hatch to. For more information on coordinate entry, see “Drawing Using Coordinate Entry” in “The Drawing Board” chapter.
4. Add a line segment, 2-point arc, or 3-point arc to your polyline boundary:
   - To select the second point of a straight line segment, click in the Drawing Area, use coordinate entry, or object snap to a point on an entity. After you select the second point of the boundary, the Tangent option is added to the menu.
   - To add a 2-point arc to the boundary, click on 2 Pt. Arc in the Boundary menu. Select a center point for the arc, toggle Clockwise on (if you want to draw the boundary in a clockwise direction) or off (if you want to draw the boundary in a counterclockwise direction), and select an end point. You can continue drawing additional 2-point arcs or you can right-click to exit the 2-point arc function.
   - To add a 3-point arc to the boundary, click on 3 Pt. Arc in the Boundary menu. Select a second end point for the arc (with the first end point being the point you selected in the previous step) and then select any other point on the arc. You can continue drawing additional 3-point arcs or you can right-click to exit the 3-point arc function.
• To add a tangent arc to the boundary, click on Tangent in the Boundary menu. (The Tangent option appears in the Boundary menu after you select the second point of the polyline boundary.) Move your cursor until the arc displayed is the one you want drawn and then click to draw the tangent arc.

You can click Backup any time to erase the last straight line segment or arc of your boundary. You can click Cancel any time to erase the entire boundary you’ve drawn.

5. Continue selecting points for line segments or arcs, as outlined in step 4, until your polyline boundary is complete.

6. Click on Close in the Boundary menu and click on Exit in the next menu that appears. Alternatively, just right-click twice to leave both Boundary menus. The Hatching menu appears.

➤ To hatch a master polyline that contains voids (or areas that you do not want to hatch):

1. Create the master polyline. This will contain the hatch pattern. For details on creating the master polyline, see “Voids in Polylines” in the “Drawing Other Geometry” chapter.

2. Create the polylines that will serve as voids (areas that will not be hatched).

3. Click on Voids in the Polyline menu. You are prompted to Select master polyline to process voids.

4. Click on the closed master polyline that you want to put the void in. DataCAD LT puts dashed lines around that shape.

5. Make sure Entity and Add Void are toggled on in the Voids menu. You are prompted to Select entity to convert to voids.

6. Click on the polyline that will represent the void. The void is added. Dashed lines surround the void.

7. Continue selecting other closed polylines within the master if necessary.

8. Click on Hatch in the Create pull-down menu, or click on Hatching in the Utility menu, or click on in the Draw toolbar. The Hatching menu appears.

9. Click on Pattern and choose one of the options. Make other adjustments to the pattern if necessary. For example, you may want to change the scale or the angle. The decisions you make for the pattern, scale, angle, and hatch type are shown in the Attention toolbar.

10. Click the polyline you created in steps 1 through 7. This selects the polyline.

11. Click on Begin. The hatch pattern you selected appears within the master polyline boundary; however, the voids you created are empty.

Using SPB Fills Instead of Standard Hatch Patterns

Instead of using the standard vector-based hatch patterns (saved as .PAT files), you can use solid, pattern, and bitmap (SPB) fills. Unlike hatch patterns, solid fills will display and print with the same density, no matter what the viewed or plotted scale is.
To use solid, pattern, and bitmap fills:

1. Click on Display in the Utility menu or select Settings from the Tools pull-down menu and click on Display. Make sure Fill On and Bitmap On are toggled on in the Display menu. Then, right-click to return to the Utility menu. There is now an upper-case F in SWOTHFLUDFB, indicating that Fill is on (lower-case f means it’s off).

2. Select Hatching from the Utility menu.

3. Choose SPB-Fill from the Hatching menu.

4. Click on Settings to choose the colors and patterns you want in your drawing. The Select Fill Color/Pattern dialog box appears.

![Select Fill Color/Pattern dialog box](image)

**Figure 15.4:** Control the solid, pattern, and bitmap (SPB) fills.

5. Make decisions about the solid, pattern, and/or bitmap fills for your drawing. Your choices appear in the Preview window of the Select Fill Color/Pattern dialog box.

6. Click in the box beside Solid Pattern Fill or Bitmap Fill. These are mutually exclusive.

Use the Fill Settings options to make decisions about solid pattern details.

- Control the fill and pattern colors by clicking on the rectangular swatch and making your selections from the Color Palette dialog box. For more information, see “Customizing Colors” in the “Before You Draw” chapter.

- Select the pattern you prefer from the drop-down box. The outline boundary, pattern, and fill may have different colors. Your choices are shown in the Preview window.

- Check the Entity box if you want the fill to display with the color of the polyline entity in the drawing.

Use the Bitmap/JPEG options to make decisions about bitmap fills.

- Click the file folder button to select the image you want to use. Supported file types are listed in the drop-down box in the Select Image dialog box. After you select the image, click on Open or press (Enter) to return to the Select Fill Color/Pattern dialog box.
• Uncheck the Maintain Aspect box if you want to change the X/Y aspect of the original image.

Figure 15.5: Select the image you want for the fill.

6. Click OK on the Select Fill Color/Pattern dialog box when you are satisfied with your choices. The dialog box disappears.

7. Click on an existing polyline boundary that you want to fill. If none exists yet, select Boundary from the Solid Fill menu and draw one.

You can reposition SPB-filled entities that are on the same layer. For example, you can move one in front of another, move one behind another, move one to the top, move one to the bottom, or swap two of them. For more information, see “Moving SPB-Filled Entities” in the “Editing Drawings” chapter.

You can control whether solid fills and bitmaps print behind or in front of lines by using the Print first or Print last options in the Pen Table. For more information about using the Pen Table, see “Using Pen Tables” in the “Printing Your Drawing” chapter.

**Drawing Associative Hatch**

Associative hatch treats hatch patterns as a single entity, instead of a group of entities as standard hatch does. You can associatively hatch only 3D polygons and 2D polylines. When you use associative hatch:

• You can stretch walls in your drawing and the hatch will update automatically.

• You can rotate your drawing without changing the angle of the hatch pattern.

• Your drawing file size is usually smaller because the hatch pattern is a single entity instead of a group of entities.

• You can’t edit individual lines in the hatch pattern.

• The hatch is drawn the same color as your entity. If you use standard hatch (Associative is toggled off), the hatch is drawn in the current layer’s color.

• You have different hatch type options: OutLine draws an outline around the hatching, while NoOutLin does not.
To draw associative hatching:

1. Click on Hatch in the Create pull-down menu, or click on Hatching in the Utility menu, or click on in the Draw toolbar. The Hatching menu appears.

2. Click on Hatch Type to set the hatching type.

3. Toggle Outline on to draw an outline around the hatching; toggle No Outline on to draw only the hatching. Right-click or click on Exit when you are done.

4. Toggle Associative on in the Hatching menu.

5. Set the hatch pattern, scale, and angle. For more information, see “Drawing Standard Hatch” in this chapter.

6. Set the point where the hatch pattern will begin by clicking on Origin.

7. Define the boundary for the hatch pattern.

8. Click on Begin in the Hatching menu to draw the associative hatch.

After the hatching is drawn, you can click on Del. Assoc. to remove the associative hatching, without clearing the boundary you traced. Click Clear to delete the boundary and return the hatch settings to their defaults.
Symbols, Images, and Objects

A symbol is a group of lines and arcs that is treated as a single entity. The Symbol Browser makes it easy to work with and manage these entities.

Symbols in DataCAD LT can be organized and displayed in Symbol Browser. You can enter symbols in your drawing, revise symbol descriptions as well as the symbols themselves, and even create new symbols from geometry in your drawing. Each symbol can have an unlimited amount of information associated with it. And one of the biggest advantages to using symbols in your drawings, instead of separate lines and arcs, is that you can use this information to generate a variety of reports.

In addition to symbols, you can also import many types of images into your drawings or insert o2c objects.
Using the Symbol Browser

DataCAD LT makes it easy to use symbols in your drawings. With just a few mouse clicks, you can open the appropriate folder, display the symbols in the browser, and select the ones you want to use into your drawing. If you developed custom templates with DataCAD LT 10 and prior versions, you can open them in the Symbol Browser, too. In effect, the subfolders in the DataCAD LT\Symbols folder contain collections of symbols that you can access via the Symbol Browser.

Shortcut: The hotkey (Ctrl) + (T) toggles the Symbol Browser on and off.

Note: In the Symbol Browser and Insert Symbol dialog, .DSF files supersede .SM3 (used in DataCAD LT 10 and prior versions) files.

Positioning the Symbol Browser on your DataCAD LT Desktop

When you first open DataCAD LT, the Symbol Browser is docked along the right side of your Drawing Window. Since it is actually a toolbar, you can undock the Symbol Browser and position it anywhere on your desktop or hide it from view altogether.

➔ To undock the Symbol Browser:

1. Place the cursor along the upper margin of the Symbol Browser. Move the cursor until it is shaped like a cross with arrows at its tips.
2. Click and keep the mouse button depressed to grab the Symbol Browser.
3. Drag the Symbol Browser away from the side of the Drawing Window and position it elsewhere. Notice that “Symbol Browser” appears in the title bar at the top of this toolbar.

You can dock the Symbol Browser at either the right or left edge of the Drawing Window; however, you cannot dock it at the top or bottom edge. When you originally open DataCAD LT, the Symbol Browser is docked at the right edge.
To dock the Symbol Browser:
1. Click and hold on the title bar near Symbol Browser.
2. Drag the Symbol Browser to the right or left margin of the Drawing Window until the title bar disappears. To dock the Symbol Browser to the left of the Edit/Utility menu bar, simply continue dragging it leftward until it pops into place.

DataCAD LT automatically calculates the divisions to display all the symbols in the folder you selected. This occurs when the lock on the Symbol Browser menu bar is “on” (or depressed) and the pull-down number menus are grayed (this means you cannot change them).

To specify the number of X and Y divisions for the Symbol Browser:
1. Click on the auto divisions icon on the Symbol Browser menu bar. When the drop-down arrows appear next to the X and Y division numbers, you can change these values manually to suit your needs.
2. Select the number of X divisions you want the Symbol Browser to display.
3. Select the number of Y divisions you want the Symbol Browser to display.

![Symbol Browser](image)

**Figure 16.3:** X and Y divisions can be set manually

**Selecting and Placing Symbols**
Symbols that you can use in your drawing are contained in DataCAD LT's Symbols folder or directory. Clicking the arrow to the right of the folder gives you three options:

- **Folder** shows you all the symbol files in the DataCAD LT Symbols directory or folder.
- **Template** displays the files in the DataCAD LT Templates directory or folder. The templates were either supplied older versions of DataCAD LT (version 10 and prior) or were created in your office to meet specific clients' needs. Templates hold collections of symbols. You will probably find it more efficient to create new subfolders containing collections of symbols in your Symbols folder rather than using the more cumbersome, old-fashioned templates.
- **Drawing** contains just the symbols you placed in the current drawing. DataCAD LT remembers this information so that you can have quick access to the symbols you’ve already used and may want to re-use elsewhere in your drawing.
To open a collection of symbols:
1. Click on the arrow to the right of the folder in the Symbol Browser.
2. Select Folder, Template, or Drawing from the pull-down list.
   • If you select Folder, the Browse dialog box opens. Notice that as you click on different folders, their contents appear in the Symbol Browser. Click OK when you find the folder that contains the symbol(s) you want to use in your drawing.

![Figure 16.4: Symbols contained in the folder in the Browse window simultaneously appear in the Symbol Browser](image)

   • If you pick Template, the Select Template File to Browse dialog box opens. When you click on a file in the list, its collection of symbols is displayed in the Symbol Browser. Click Open when you find the file that contains the symbol(s) you want to use in your drawing. For information about accessing Template files from DataCAD LT versions prior to 11, refer to “Finding and Using Older Template and Symbol Files” in the Appendix.
   • If you choose Drawing, DataCAD LT displays the symbols you used already in the current drawing.
3. Open the file that contains the symbols you want to use in your drawing. Once you open a file, the Browse or Select Template File to Browse dialog box closes, allowing you to work directly with the symbols.

You are now ready to place the symbols into your drawing. Basically, you select a symbol from the Symbol Browser and place it into your drawing where you want it to appear.

To look at an object you are considering placing in your drawing:
1. Move your cursor over the symbol you want to examine.
2. Right-click to display a pop-up menu.
3. Select Object Viewer from the menu. The item appears in the Object Viewer window, where you can examine it.
4. Click on the X in the upper right corner to close the Object Viewer.

To insert a symbol into your drawing:

1. Click on the symbol you want in the Symbol Browser. This attaches a particular symbol to your cursor.

2. Position your cursor where you want the symbol to appear in your drawing. Notice that the symbol assumes a rectangular shape until you decide where you want to place it.

3. Click when the rectangular shape is positioned where you want to place the symbol into your drawing. Notice that a rectangular shape is still attached to your cursor. This allows you to “place” many copies of a symbol into your drawing. (For chairs, replication may be a convenient feature, but most houses only require one kitchen.)

4. Right-click when you are finished placing the symbol(s) into your drawing. The cursor returns to its normal shape, allowing you to continue working in your drawing or to select and place other symbols.
Controlling Symbols

You don’t have to live with the symbols as they are; you can change them in several ways by using the Options pull-down menu. For example, you can enlarge, offset, or rotate them.

Figure 16.9: The Options menu lets you further control the symbols you add to your drawing. The left menu offers related options when you insert a symbol.

The Attention toolbar tells how the symbol will behave within the drawing. In the following example, the desk symbol will be rotated, enlarged, and offset based on the options that you set. These settings remain in effect for placing all future symbols until you change one of the options.

Figure 16.10: The Attention toolbar summarizes settings you selected through the Options menu

To rotate a symbol:

1. Select Rotate from the Symbol Browser’s Options pull-down menu. The Edit menu appears and you are prompted to Position symbol on drawing.

2. Decide whether you want to rotate the symbol dynamically with your cursor or use a fixed rotation angle. When Rotate is on, you can place the symbol dynamically; when Rotate is off, you are prompted to specify the angle you want.
If you opted for a fixed angle instead of dynamic rotation, remember to set the angle back to zero. If you don't do this, all future symbols will be placed at the rotation angle you specified. For example, if you set a 30-degree rotation angle while placing a desk symbol and neglect to change it back to zero, the next symbol (perhaps a conference table) will also appear at a 30-degree angle.

To enlarge a symbol:

1. Select Enlarge from the Symbol Browser’s Options pull-down menu. The Enlarge menu appears and you are prompted to Select symbol enlargement factor to change.
2. Choose X Enlargmnt., Y Enlargmnt., Z Enlargmnt., Line Factor, or Set All from the Enlarge menu; select an enlargement value from the list or type your own; and press (Enter). Notice that the enlargement factor(s) you entered are displayed on the Attention toolbar.

**Hint:** If you want to reduce the size of a symbol, use a decimal value (such as .25). If you want to mirror the symbol, enter a negative value (such as –1).

3. Right-click, or click on Exit, or press (Shift) + (F10) to leave the Enlarge menu.
4. Click on the symbol that you want to drag into your drawing.
5. Drag the symbol into your drawing with your mouse. You are prompted to Position symbol on drawing.
6. Click the left button when the symbol is in the correct place. The enlarged symbol appears in the drawing. Continue placing additional copies of the symbol by repeating this step.
7. Right-click to stop placing additional copies of the symbol into your drawing.

To offset the insertion height of symbols:

1. Select Z Offset from the Symbol Browser’s Options pull-down menu. The Z Offset menu appears and you are prompted to Enter Z Offset for symbols.
2. Supply the value and press (Enter). Notice that the Z Offset you entered is displayed on the Attention toolbar.
3. Click on the symbol that you want to drag into your drawing.
4. Drag the symbol into your drawing with your mouse. You are prompted to Position symbol on drawing.
5. Click the left button when the symbol is in the correct place. The symbol appears in the drawing at the Z Offset you supplied in step 2. Continue placing additional copies of the symbol by repeating this step.
6. Right-click to stop placing additional copies of the symbol into your drawing. You can use the Object Viewer in the View pull-down menu to see the effect of the Z Offset you applied.

**Editing Symbols**

If you want to edit or change the symbol, you must first convert it into separate lines and/or arcs. In other words, you will “explode” the symbol back into its component drawing elements. You can do this when you insert the symbol into your drawing or after the symbol has been inserted. Once the symbol has been edited, you can reform the symbol lines and arcs into a single symbol entity and save it back into the Symbol Browser and then update the symbols already in your drawing.
To explode a symbol:
1. Click on the Options icon in the Symbol Browser.
2. Select Explode. When this function is “on,” a checkmark appears to the left of the word “Explode.”
3. Click on the symbol you want to use and drag it into your drawing.
4. Click the left mouse button to place it. The exploded symbol appears in your drawing. You can repeat this step to continue placing copies of the exploded symbol.
5. Right-click to stop placing copies of this symbol.
6. Make changes to the exploded symbol.
7. Select and place other symbols you want to drag into your drawing as exploded lines and/or arcs.
8. Deactivate Explode in the Symbol Browser’s Options menu when you are finished. Until the checkmark to the left of Explode disappears, all symbols that you place will be converted to lines and/or arcs in your drawings.

When you activate Explode in the Symbol Browser’s Options menu, the left Layers menu includes an Explode button. This is how you explode a symbol when you place it. If you want to explode a symbol that you previously placed in your drawing, select Explode from the 3D Edit menu.

Creating New Symbols
You can create and save your own symbols in a new or existing folder.

To create and save a symbol:
1. Draw something that you want to use as a symbol.
2. Select Save Symbol from the Options pull-down menu in the Symbol Browser. The contents of the active symbol folder appear in a window and you are asked to Enter name of symbol file to be saved.
3. Type a name for the item you drew in step 1. Then press (Enter) or click on Save. The Save Symbol menu appears.

The file name is limited to 255 characters.
You could save the item in another folder or create a new folder by using the icons at the top of this window.

4. Select the entities you drew in step 1. The items you selected are highlighted. You are prompted to Select an insertion point for symbol.
5. Click once in the Drawing Window to create a “handle” that will help you place your symbol. A symbol descriptor window appears.
6. Fill in the fields with information about the item. Double-click in a field and supply information in the Name or Value columns. When you double-click on the Type column, you can select Text, Decimal, or Integer for the information that should appear in the Value column.

7. Click on Ok when you have finished describing the item. The object you created appears in the Symbol Browser. Once an item you created is designated as a symbol, you can put clones of it anywhere in the drawing on your screen.

**Editing Symbols**

What if you want to edit information about a symbol or get rid of it in your Symbol Browser? That’s easy.

- To edit information about a symbol:
  1. Move your cursor in the Symbol Browser to the symbol you want to edit.
  2. Right-click to display the pop-up menu.
  3. Select Edit Fields. The symbol descriptor box appears.
  4. Double-click in the field you want to change and supply the new information in the Name or Value columns. When you double-click on the Type column, you can select Text, Decimal, or Integer for the information that should appear in the Value column.
  5. Click on Ok when you have finished editing the description of the symbol.

- To delete a symbol from the Symbol Browser:
  1. Move your cursor in the Symbol Browser to the symbol you want to delete.
  2. Right-click to display a pop-up menu.
  3. Click on Delete. Then click on Yes or press (Enter) to confirm that you really want to eliminate the symbol. The undesirable symbol disappears from the Symbol Browser and from your computer’s hard drive.

- To replace one symbol with another in your drawing:
  1. Select Replace from the Options pull-down menu in the Symbol Browser. You are prompted to *Select symbol to replace.*

---

**Figure 16.13:** Describe the item you are saving as a symbol
2. Click on the symbol in your Drawing Window that you want to replace with another one that appears in your Symbol Browser. You are prompted to *Select symbol to replace with.*

3. Click on the symbol you want in your Symbol Browser. You are prompted to *Select entity to replace.*

4. Click on the undesirable symbol in your Drawing Window again. The undesirable symbol disappears and its replacement that you selected in step 3 appears in your Drawing Window. Continue using the replacement symbol by clicking on other undesirable symbols in your Drawing Window.

5. Right-click in your Drawing Window to discontinue the replacement process.

If you select Reload All from the Options pull-down menu, DataCAD LT gets the most recent definition of a symbol from the hard drive. Otherwise, it goes to the drawing itself for the definition.

Once you place a symbol in your drawing, DataCAD LT will no longer read the definition from your hard drive. That's why Reload All is important.

Symbols you insert “travel” with your drawing. If you insert symbol A into drawing 1, then redefine symbol A from drawing 2, symbol A will look different in drawings 1 and 2. You can use Reload All to make symbol A look the same in drawings 1 and 2.

**Generating Reports About Symbols**

You can generate reports based on the symbols that appear in your drawing.

To generate reports about symbols used in your drawing:

1. Select Reports from the Options pull-down menu. The Report Forms dialog box appears.

![Figure 16.16: The Report Forms dialog box](image)
2. Click in the box to the left of the items you want to include in your report. If you want reports on all the items, click on Select All. If you want to start over with a clear slate, click on Select None. Symbols that are not currently used in your drawing but still “live” in your drawing’s database are grayed out or unavailable for reports.

3. Use the drop-down box in the right corner to select the type of report you want to generate. If you want to use forms that are in another folder, click on the browse icon and make your selection.

4. Decide which layer(s) you want to include in your reports by clicking on the appropriate option in the Layer Search box.

5. Choose an output option in the lower left portion of the Report Forms dialog box:
   - If you select To File, you are asked to supply a file name. The file will be in .TXT format.
   - If you select To Printer, the report goes to your default text printer.
   - If you select To Drawing, you are prompted to Select point to position text. You can change the appearance of the text by selecting Size, Angle, Weight, Slant, Aspect, Factor, or Font from the left menu. Place the text insertion icon where you want the report to appear in your Drawing Window.

   **Hint:** To keep report column spacing consistent, use a fixed-width font (such as ARCWY2FW).

6. Right-click to return to the Report Forms dialog box. You can generate other reports and select the appropriate output option by following steps 2 through 5.

7. Click Close when you are finished generating reports.

### Purging Unused Symbols

DataCAD LT remembers all the symbols you used even though you may have already erased some of those symbols from the drawing on your screen. When you add a symbol to your drawing, DataCAD LT stores that symbol with your drawing. This definition is not deleted when you erase the symbol and continues to take up drawing file space. When you erase symbols from your drawing, it’s important to **purge** the symbol if you don’t plan to use it again.

> To eliminate unused symbols from your drawing:

1. Select Purge Unused Symbols form the Options pull-down menu. A confirmation box appears.

   ![Figure 16.18: You can change your mind about purging unused symbols](image)

   **Figure 16.18:** You can change your mind about purging unused symbols

2. Press (Enter) or click on Yes to continue the purge. If DataCAD finds unused symbols to remove from your drawing, another warning box appears.
Figure 16.19: You can still change your mind at this point

3. Click on Yes or press (Enter). All the unused symbols as well as all prior actions (such as erased entities) are eliminated from your Undo buffer.

Text Attributes for Symbols,

Text attributes can be defined and added to symbols. This lets you use the same symbol multiple times, supplying a unique text string for each one. For example, you could use one desk symbol several times and label them “Jim’s desk,” “Nancy’s desk,” and “Bob’s desk.” For more information on creating and editing text attributes, see “Using Text Attributes for Symbols” in the “Text, Notes, and Labels” chapter.

Layers in Symbols

Symbols retain layer information. This lets you customize on/off layer settings for each symbol. When a symbol is exploded, its constituent entities are returned to their proper layers or new layers are created automatically if necessary.

Symbol Browser Settings

The Symbol Browser retains the following settings between DataCAD LT sessions.

- Last browse type (folder, template, or drawing)
- Last path browsed for symbols (independent from Templates and Insert Symbol menus)
- Last path browsed for templates (independent from Templates menu)
- Auto-divisions On/Off status

Shortcut: You can use (Ctrl) + (Click) on either the Folder or Templates menu item in the browse pull-down menu to bypass the folder/file dialog. This lets you go directly to browsing the last symbol folder or template file.

If the Symbol Browser is not displayed, you can click on the Symbol Browser button in the Draw toolbar. The Symbol Browser will appear.
Inserting Stamps
You can choose from more than a dozen pre-formatted date-, time-, and file-related stamps to insert into your drawing. The examples shown in the stamp selection menu are based on the current date, time, and file settings as they will appear in the drawing. The values are updated when the display is regenerated and when the drawing is printed. Since a stamp is really an ordinary DataCAD LT text entity that contains a special formatting string, it has all the font, sizing, and style options of ordinary DataCAD LT text strings. You can further customize how you want stamps to appear in your drawing by doing a change/text/content and adding text around the special strings. Stamp text can be used in XREFs and symbols. The values update automatically, making stamps very flexible.

To add a stamp to your drawing:
1. Select Stamp form the Insert pull-down menu.
2. Select the stamp you want to use from the extended menu.

Inserting o2c Objects
Thousands of o2c objects (including people, cars, furniture, and landscape elements) are available for you to import into DataCAD LT drawings. Or you can import your own o2c objects, such as your company logo.

To insert an o2c object:
1. Click on o2c Object in the Insert pull-down menu. A dialog box appears, prompting you to Select o2c file to import.
2. Locate the o2c object you want to insert into your drawing and click on it to select it.
3. Click on Open. The dialog box closes, and a box representing the extents of the o2c object is now attached to your cursor.
4. Place the object by clicking in the Drawing Area, using coordinate entry, or object snapping to a point in your drawing. The o2c object is inserted into your drawing. For details on coordinate entry, see “Drawing Using Coordinate Entry” in “The Drawing Board” chapter. For details on object snapping, see “Object Snapping” in the “Drawing Tools” chapter.
5. Repeat the previous step to continue placing the object in your drawing or right-click to exit the menu.

Importing BMP, JPEG, and Other Image Files
You can import bitmap (.BMP), JPEG (.JPG), GIF (.GIF), Tagged Image (.TIF), Targa (.TGA), Portable Network Graphics (.PNG), Z-Soft (.PCX), and Kodak (.PCD) files into your DataCAD LT drawing. Import any number of black and white, grayscale, and 8- to 32-bit color images. You can trace scanned drawings, display site maps, or show digital photos of existing building facades when you import bitmaps into your drawing.

Imported bitmaps are referenced, not inserted into your drawing file. That means your drawing file size will not increase.

To import an image:
1. Click on Bitmap in the Insert pull-down menu. The Select Image dialog box appears.
2. Click on the .BMP, .JPG, .GIF, .TIF, .TGA, .PNG, .PCX, or .PCD file you want to insert in your drawing and click Open. The Bitmap menu appears and you are prompted to Enter first point of bitmap rectangle.

3. Toggle Outline on if you want to draw a visible polyline boundary around the inserted image. Toggle No Outline on if you do not want a visible boundary around the image. These are mutually exclusive toggles.

4. Toggle the Fixed Ratio option on to preserve the original dimensions of the image; toggle it off to dynamically stretch the X and/or Y ratios while you are inserting the bitmap. After you insert the image, you cannot change the ratio if Fixed Ratio was turned on; therefore, for future flexibility, you may want to turn Fixed Ratio off.

While working in your drawing, you can toggle off Bitmap On in the Display menu to decrease drawing refresh times by not displaying all the bitmaps in your drawing. Toggle it on again to display all images in your drawing as well as allow printing of them. Notice that SWOTHFLUDFB in the Status Window contains an upper-case letter B if BmpOn is active; but it turns to a lower-case b if BmpOn is not active.

5. Enter the first corner of the image’s extents by clicking in the Drawing Area, using coordinate entry, or object snapping to an existing point in your drawing. Notice that if you move your cursor diagonally away from that point, a rectangular box (representing the extents of your image) stretches with it. You are prompted to Enter second point of bitmap rectangle.

6. Enter the corner diagonally across from the first corner by clicking in the Drawing Area, using coordinate entry, or object snapping to an existing point in your drawing. The image is inserted in your drawing. If Bitmap On is toggled off in the Utility/Display menu, only a rectangular box representing the extents of the image appears in your drawing. To display your image, toggle Bitmap On in the Display menu.

7. Use the Calibrate options in the Enlarge menu to scale bitmaps to real-world size. For more information about this, see “Calibrating Enlargements” in this chapter.

You can control whether bitmaps or JPEGs print behind or in front of lines by using the Print first or Print last options in the Pen Table. For more information, see “Using Pen Tables” in the “Printing Your Drawing” chapter.

**Calibrating Enlargements**

You can enlarge or reduce imported bitmap and vector graphics to real-world scale. For example, if you import a site map, you can use the Calibrate Distance function to enlarge the plan to real-world dimensions.

- To calibrate imported bitmaps or vector graphics and enlarge to real-world size:
  1. Select Enlarge from the Edit menu. You are prompted to Select CENTER of enlargement.
  2. Click on the graphic you want to resize. Options appear in the Enlarge menu.
  3. Select Enlargement to display the calibration options.
  4. Click on Cal. Dist.
5. Show the length of an entity or a known distance in the bitmap by clicking on your imported graphic at the first point to begin drawing a measuring line. Extend the line and click again when you reach the end of the entity or known distance in the graphic. You are prompted to *Enter new distance*. The current distance follows this prompt.

6. Replace that value with what it should be in the “real world.” For example, the current value may be 0.8, but in reality, it should be 6 feet; therefore, you would type 6 in the input field. Press (Enter). DataCAD LT calculates the enlargement factor.

7. Right-click to go to the Enlarge menu. You are prompted to *Select entity to <ENLARGE>*.

8. Select the entity or entities that you want to enlarge by that factor.

Cal. Dist. automatically calculates an equal X/Y enlargement factor. Instead of Cal. Dist., you can use the Cal. X and Y, Cal. X, or Cal. Y options to enlarge entities independently or unequally in the X and Y directions.
Elevations and Sections

With the EZ Tools macro, you can parametrically draw residential or commercial elevations and sections quickly and easily. This set of tools eliminates the need for the tedious linework and calculations otherwise required to create basic elevations. All angles, lines, offsets, and line lengths are done automatically, leaving you free to concentrate on the drawing aesthetics.

The Elevations tool assists in drawing exterior and interior residential elevations (including door, window, and cabinet elevations); the Sections tool draws cabinet outline sections.
**Drawing Exterior Elevations**

Exterior elevations are defined by selecting two points along the line of the subfloor. The exterior elevation will be drawn relative to those two points, based on the Exterior menu settings.

![Diagram of Exterior Elevation with Default Settings Table]

<table>
<thead>
<tr>
<th>Default Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plate Hgt</td>
</tr>
<tr>
<td>Pitch</td>
</tr>
<tr>
<td>Roof Thck</td>
</tr>
<tr>
<td>Overhang</td>
</tr>
<tr>
<td>Wall Thck</td>
</tr>
<tr>
<td>Fascia</td>
</tr>
<tr>
<td>Rake End</td>
</tr>
<tr>
<td>Cornr End</td>
</tr>
<tr>
<td>GradThck</td>
</tr>
<tr>
<td>GradElev</td>
</tr>
</tbody>
</table>

**Figure 17.1:** A sample exterior elevation with default exterior elevation settings noted. EZ Tools draws only those lines represented above by extra line thickness.

To draw an exterior elevation:

1. Click on EZTOOLS in the Toolbox pull-down menu. The EZ Tools menu appears. If EZTOOLS is not listed in the Toolbox pull-down menu, click Configure in the Toolbox menu and add EZTOOLS to the Macros in Menu list.

2. Click on Elev in the EZ Tools menu. The Elev menu appears.

4. Choose between a full or partial elevation. Full exterior elevations are drawn by assuming that the points you will select are on two opposite walls of the structure. Partial elevations are drawn by assuming that the first point you select will be on a wall and the second point will be at the mid-point of the structure. To draw a full elevation, toggle Full on; to draw a partial elevation, toggle Partial on. These two toggles are mutually exclusive; only one can be toggled on at any given time.

5. Set the roof style for your elevation by clicking on Style. The Style menu appears and you are prompted to Select roof style.

6. Decide what type of roof you want to use by selecting one of the four mutually exclusive toggles:
   - Toggle Gable on to draw a gable roof in your elevation.
   - Toggle Hip on to draw a hip roof in your elevation.
   - Toggle Boston on to draw a Boston-style roof in your elevation.
   - Toggle Shed on to draw a shed roof in your elevation.

   You are returned to the Elev menu.

7. Set the height of the top plate on which the rafters rest by clicking on PlateHgt. A value menu appears and you are prompted to Enter plate height. The default PlateHgt setting is 8'-0". For more information on using value menus, see “Value Menus” in “The Drawing Board” chapter.

8. Use the value menu or type a height and press (Enter).

9. Set the rise of the roof for every one foot of run by clicking on Pitch. A value menu appears and you are prompted to Enter rise per foot for roof.

10. Use the value menu or type a pitch value and press (Enter). The default Pitch setting is 6".

11. Set the width of the rafters by clicking on RoofThck. A value menu appears and you are prompted to Enter the roof thickness.

   Notice that the roof thickness is drawn relative to the plate height and the roof line is always drawn an additional 1/2" from the top surface of the rafter.

12. Use the value menu or type a thickness and press (Enter). The default RoofThck setting is 9 1/2".

13. Set the length of the roof overhang by clicking on Overhang. A value menu appears and you are prompted to Enter the roof overhang.

   Notice that the roof overhang is measured from the wall exterior framing surface to the back surface of the fascia.

14. Use the value menu or type a length and press (Enter). The default Overhang setting is 1'-0".

15. Set the wall thickness by clicking on WallThck. A value menu appears and you are prompted to Enter the wall thickness.

   Notice that the wall thickness is drawn relative to the first point you will select to draw the elevation.

16. Use the value menu or type a thickness and press (Enter). The default WallThck setting is 3 1/2".

17. Set the fascia width by clicking on Fascia. A value menu appears and you are prompted to Enter the width of the fascia.

   Notice that the fascia width is measured across the back surface of the fascia; the fascia thickness is set to 3/4" and can’t be changed.
18. Use the value menu or type a width and press (Enter). The default Fascia setting is 7 1/2”.

19. Set the rake board width by clicking on Rake Brd. A value menu appears and you are prompted to Enter the width of the rake board.

    Notice that the rake board width is measured from the roof line.

20. Use the value menu or type a height and press (Enter). The default Rake Brd setting is 7 1/2”.

19. Set the corner board width by clicking on CornrBrd. A value menu appears and you are prompted to Enter the width of the corner board.

    Notice that the corner board width is measured relative to the exterior wall line.

20. Use the value menu or type a width and press (Enter). The default CornrBrd setting is 5 1/2”.

19. Set the cladding thickness by clicking on CladThck. A value menu appears and you are prompted to Enter the cladding thickness.

    Notice that the thickness of the cladding is measured from the wall framing out to the exterior wall line.

20. Use the value menu or type a thickness and press (Enter). The default CladThck setting is 1 1/2”.

19. Set the grade elevation by clicking on GradElev. A value menu appears and you are prompted to Enter sub-floor distance above the grade.

    Notice that the grade elevation is measured relative to the subfloor.

20. Use the value menu or type a distance and press (Enter). The default GradElev setting is 2'-0". The distance between the top surface of the subfloor and the bottom edge of the cladding is 1'-0" and can’t be changed. For best results, set the grade elevation to 1'-0" or greater.

21. Set the color of the outside lines of the elevation by clicking on Out Colr. A color menu appears and you are prompted to Select outer color.

22. Use the color menu to set the outside line color. The default Out Colr setting is White.

23. Set the color of the inside lines of the elevation by clicking on In Colr. A color menu appears and you are prompted to Select inner color. The default In Colr setting is Red.

24. Use the color menu to set the inside line color.

25. Select the two points along the top surface of the subfloor. The first point should be located on the outside surface of the wall framing. To select the first point, click in the Drawing Area, use coordinate entry, or object snap to a point in your drawing. You are prompted to select the other side of the elevation.

26. Select the second point by clicking in the Drawing Area, using coordinate entry, or object snapping to a point in your drawing. The elevation is drawn, aligned with the two points you just selected. You can click on Defaults at any time to restore all default settings in the Exterior menu.

**Drawing Door Elevations**

Door elevations are defined by selecting two points along the subfloor line. The door elevation will be drawn relative to those two points, based on the Door menu settings.
To draw a door elevation:

1. Click on EZTOOLS in the Toolbox pull-down menu. The EZ Tools menu appears. If EZTOOLS is not listed in the Toolbox pull-down menu, click Configure in the Toolbox menu and add EZTOOLS to the Macros in Menu list.

2. Click on Elev in the EZ Tools menu. The Elev menu appears.

3. Click on Door in the Elev menu. The Door menu appears.

4. Toggle on the door type: Single or Double. These are mutually exclusive toggles; only one can be toggled on at any given time. The Single and Double toggles do not apply to Garage A, Garage B, or Sliding door styles.

5. Set the door style for your elevation by clicking on Style. The Style menu appears and you are prompted to *Pick style of door to draw*.

![Door styles](Image)

Figure 17.2: Door styles available for door elevations

6. Click on a door style in the list. You are returned to the Door menu. See “Door Styles for Elevations” below for details.
7. Set the head height of the door by clicking on Head Hgt. A value menu appears and you are prompted to Enter door head height.

8. Use the value menu or type a height and press (Enter).

9. Toggle on Trim or SideLght; these are mutually exclusive toggles, so you can select only one. Draw door trim in your elevation by toggling Trim on; draw the door sidelight by toggling SideLght on. The Stop option appears. The default setting for Trim is 2 1/2”, the style for the SideLght option is automatically set, and the Stop option default is 3/4”.

10. Toggle Stop on to draw the door stop if you toggled either Trim or SideLght on in the previous step.

11. Set the trim color by clicking on TrimColr. A color menu appears and you are prompted to Select the trim color.

12. Use the color menu to set the trim color. The default TrimColr setting is White.

13. Set the door color by clicking on DoorColr. A color menu appears and you are prompted to Select the door color.

14. Use the color menu to set the door color. The default DoorColr setting is Red.

15. Enter the first point for the door elevation. You can click in the Drawing Area, use coordinate entry, or object snap to a point in your drawing. You are prompted to enter a point for the other side of the door.

16. Enter the second point for the door. You can click in the Drawing Area, use coordinate entry, or object snap to a point in your drawing. The door elevation is drawn. You can click on Defaults at any time to restore all default settings in the Door menu.

**Door Styles for Elevations**

- **Flush**: Flush door style.
- **HalfLght**: Half light door style.
- **Patio**: Patio door style.
- **French**: French door style.
- **Leaded**: Leaded glass door style.
- **HalfLead**: Half leaded glass door style.
- **SixPanel**: Six panel door style.
Bifold  Bifold door style.
Accord  Accordian door style.
Vented  Vented door style.
NarLtRt  Door drawn with a narrow light on the right side of the door.
NarLtLt  Door drawn with a narrow light on the left side of the door.
StorFrnt  Storefront door style.
Garage A  Garage door style, with four panels; Single and Double toggles do not apply to this style.
Garage B  Garage door style, with four panels and four windows in the second panel from the top; Single and Double toggles do not apply to this style.
Sliding  Sliding door style; Single and Double toggles do not apply to this style.

Drawing Window Elevations

Window elevations are defined by selecting two points along the subfloor line. The window elevation will be drawn relative to those two points, based on the Window menu settings.

吸入 To draw a window elevation:

1. Click on EZTOOLS in the Toolbox pull-down menu. The EZ Tools menu appears. If EZTOOLS is not listed in the Toolbox pull-down menu, click Configure in the Toolbox menu and add EZTOOLS to the Macros in Menu list.
2. Click on Elev in the EZ Tools menu. The Elev menu appears.
3. Click on Window in the Elev menu. The Window menu appears.
4. Toggle on either Single or Double; these are mutually exclusive toggles. Draw single windows by toggling Single on; draw double windows by toggling Double on.
5. Set the window style for your elevation by clicking on Style. The Style menu appears and you are prompted to Pick style of window to draw. The Single and Double toggles do not apply to the casement and sliding window styles.

Figure 17.4: Window styles available for window elevations

6. Click on a window style in the list. You are returned to the Window menu. See “Window Styles for Elevations” below for details.
7. Set the head height of the window by clicking on Head Hgt. A value menu appears and you are prompted to *Enter window head height.*

8. Use the value menu or type a height and press (Enter).

9. Set the sill height of the window by clicking on Sill Hgt. A value menu appears and you are prompted to *Enter window sill height.*

10. Use the value menu or type a height and press (Enter).

11. Toggle one of the five mutually exclusive sill, capstone, and shutter options on to draw brick sills, capstones, or shutters with your window elevations.
   - Toggle BrkSillA on to draw brick sills along the bottom of the window.
   - Toggle BrkSillB on to draw brick sills along the bottom and top of the window.
   - Toggle Capstone on to draw a bottom and top sill with a capstone.
   - Toggle ShutterA on to draw a single shutter on either side of the window.
   - Toggle ShutterB on to draw a double shutter on either side of the window.
   - To draw window elevations without brick sills, capstones, or shutters, click on whatever option is toggled on to toggle it off again.

12. Set the frame color by clicking on FramColr. A color menu appears and you are prompted to *Select the frame color.*

13. Use the color menu to set the frame color. The default FramColr setting is White.

14. Set the window sash color by clicking on SashColr. A color menu appears and you are prompted to *Select the sash color.*

15. Use the color menu to set the sash color. The default SashColr setting is Red.

16. Enter the first point for the window by clicking in the Drawing Area, using coordinate entry, or object snapping to a point in your drawing. You are prompted to enter a point for the other side of the window.

17. Enter the second point for the window by clicking in the Drawing Area, using coordinate entry, or object snapping to a point in your drawing. The window elevation is drawn. You can click on Defaults at any time to restore all default settings in the Window menu.

---

**Figure 17.5:** Sill and shutter styles for window elevations
**Window Styles for Elevations**

<table>
<thead>
<tr>
<th>Style</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Picture</td>
<td>Picture window style.</td>
</tr>
<tr>
<td>Pct 4x8</td>
<td>Picture window style with four columns and eight rows of panes.</td>
</tr>
<tr>
<td>Pct3x6</td>
<td>Picture window style with three columns and six rows of panes.</td>
</tr>
<tr>
<td>PictLead</td>
<td>Picture window style with leaded glass.</td>
</tr>
<tr>
<td>DH 1/1</td>
<td>Double-hung window style with no panes.</td>
</tr>
<tr>
<td>DH 4/4</td>
<td>Double-hung window style with four panes in each window.</td>
</tr>
<tr>
<td>DH 6/6</td>
<td>Double-hung window style with six panes in each window.</td>
</tr>
<tr>
<td>DH 6/4</td>
<td>Double-hung window style with six panes in the top window and four panes in the bottom window.</td>
</tr>
<tr>
<td>DH 9/6</td>
<td>Double-hung window style with nine panes in the top window and six panes in the bottom window.</td>
</tr>
<tr>
<td>CasemntA</td>
<td>Casement window style with no panes; Single and Double toggles do not apply to this style.</td>
</tr>
<tr>
<td>CasemntB</td>
<td>Casement window style with three panes of equal size; Single and Double toggles do not apply to this style.</td>
</tr>
<tr>
<td>CasemntC</td>
<td>Casement window style with four panes of equal size; Single and Double toggles do not apply to this style.</td>
</tr>
<tr>
<td>CasemntD</td>
<td>Casement window style with three panes, with the center pane larger and the two side panes of equal size; Single and Double toggles do not apply to this style.</td>
</tr>
<tr>
<td>CasemntE</td>
<td>Casement window style with four panes, two center panes larger and of equal size and the two outside panes of equal size; Single and Double toggles do not apply to this style.</td>
</tr>
<tr>
<td>HSliderA</td>
<td>Horizontal sliding window style with two panes of equal size; Single and Double toggles do not apply to this style.</td>
</tr>
<tr>
<td>HSliderB</td>
<td>Horizontal sliding window style with three panes of equal size; Single and Double toggles do not apply to this style.</td>
</tr>
</tbody>
</table>

**Drawing Cabinet Elevations**

Cabinet elevations are defined by selecting two points along the subfloor line. The cabinet elevation will be drawn relative to those two points, based on the Cabinet menu settings.

Click on Section in the Elev menu to display the Section menu and draw cabinet sections.

1. To draw a cabinet elevation:
   1. Click on EZTOOLS in the Toolbox pull-down menu. The EZ Tools menu appears. If EZTOOLS is not listed in the Toolbox pull-down menu, click Configure in the Toolbox menu and add EZTOOLS to the Macros in Menu list.
   2. Click on Elev in the EZ Tools menu. The Elev menu appears.
   3. Click on Cabinet in the Elev menu. The Cabinet menu appears.
   4. Toggle on Single or Double; these two options are mutually exclusive. Draw cabinets with one door by toggling Single on; draw cabinets with double doors by toggling Double on. The Single and Double toggles do not apply to the drawer, desk, pantry, or oven cabinet styles.
   5. Set the cabinet style for your elevation by clicking on Style. The Style menu appears and you are prompted to Pick style of cabinet to draw.
6. Click on a cabinet style in the list. You are returned to the Cabinet menu. See “Cabinet Styles for Elevations” below for details.

7. Set the wall height of the cabinet by clicking on WCab Hgt. A value menu appears and you are prompted to Enter wall cabinet height.

8. Use the value menu or type a height and press (Enter).

9. Set the splash height of the cabinet by clicking on SplshHgt. A value menu appears and you are prompted to Enter wall splash height.

10. Use the value menu or type a height and press (Enter).

11. Toggle on either PullRt or PullLft to draw cabinet pulls; these are mutually exclusive toggles. If you toggle Pull Rt on, cabinet pulls are drawn on the right; if you toggle PullLft on, cabinet pulls are drawn on the left. These options only affect cabinet elevations when Single is toggled on in the Cabinet menu; they have no effect when Double is toggled on.

12. Set the counter color by clicking on CntrColr. A color menu appears and you are prompted to Select the counter color.

13. Use the color menu to set the counter color.

14. Set the cabinet color by clicking on Cab Colr. A color menu appears and you are prompted to Select the cabinet color.

15. Use the color menu to set the cabinet color. The default Cab Colr setting is Red.

16. Enter the first point for the cabinet. You can click in the Drawing Area, use coordinate entry, or object snap to a point in your drawing. You are prompted to enter a point for the other side of the cabinet.

17. Enter the second point for the cabinet. You can click in the Drawing Area, use coordinate entry, or object snap to a point in your drawing. The cabinet elevation is drawn. You can click on Defaults at any time to restore all default settings in the Cabinet menu.

**Cabinet Styles for Elevations**

- **Std Wall**: Standard wall cabinet style.
- **Std Base**: Standard base cabinet style.
**std drwr** Standard drawer cabinet style; Single and Double toggles do not apply to this style.

**std sink** Standard sink cabinet style.

**std desk** Standard desk cabinet style; Single and Double toggles do not apply to this style.

**van base** Vanity base cabinet style.

**van drwr** Vanity drawer cabinet style; Single and Double toggles do not apply to this style.

**van sink** Vanity sink cabinet style.

**hc wall** Handicapped wall cabinet style.

**hc drwr** Handicapped drawer cabinet style; Single and Double toggles do not apply to this style.

**hc sink** Handicapped sink cabinet style.

**hc desk** Handicapped desk cabinet style; Single and Double toggles do not apply to this style.

**pantry** Pantry cabinet style; Single and Double toggles do not apply to this style.

**oven** Oven cabinet style; Single and Double toggles do not apply to this style.

**Drawing Sections**
The Section tool gives you a quick way to create an outline section cut through cabinets, baths, and showers. Click on Elev in the Section menu to display the Elev menu and draw elevations.

```plaintext
Figure 14.6: A sample cabinet section with default settings noted
```

- To draw a cabinet section:
  1. Click on EZTOOLS in the Toolbox pull-down menu. The EZ Tools menu appears. If EZTOOLS is not listed in the Toolbox pull-down menu, click Configure in the Toolbox menu and add EZTOOLS to the Macros in Menu list.
  2. Click on Section in the EZ Tools menu. The Section menu appears.
  3. Click on Cabinet in the Section menu. The Cabinet menu appears.
  4. Set the cabinet style for your section by clicking on Style. The Style menu appears and you are prompted to *Select the type of section to draw*. See “Cabinet Styles for Sections” below for details.
  5. Click on a style in the list. You are returned to the Cabinet menu.
  6. Set the soffit height of the cabinet by clicking on Soff Hgt. A value menu appears and you are prompted to *Enter soffit height*.
  7. Use the value menu or type a height and press (Enter).
  8. Set the wall elevation of the cabinet by clicking on WCabElev. A value menu appears and you are prompted to *Enter wall cabinet elevation*.
  9. Use the value menu or type a value and press (Enter).
10. Set the wall height of the cabinet by clicking on WCab Hgt. A value menu appears and you are prompted to *Enter wall cabinet height*.

11. Use the value menu or type a height and press (Enter).

12. Set the back-splash height of the cabinet by clicking on SplshHgt. A value menu appears and you are prompted to *Enter back-splash height*.

13. Use the value menu or type a height and press (Enter).

14. Set the section color by clicking on SectColr. A color menu appears and you are prompted to *Select the section color*.

15. Use the color menu to set the section color. The default SectColr setting is White.

16. Set the element color (for bathtubs and showers) by clicking on ElemColr. A color menu appears and you are prompted to *Select the element color*.

17. Use the color menu to set the element color. The default ElemColr setting is Red.

18. Enter the first point for the cabinet section. You can click in the Drawing Area, use coordinate entry, or object snap to a point in your drawing. You are prompted to enter a point for the other side of the section.

19. Enter the second point for the cabinet section. You can click in the Drawing Area, use coordinate entry, or object snap to a point in your drawing. The cabinet section is drawn. You can click on Defaults at any time to restore all default settings in the Cabinet menu.

**Cabinet Styles for Sections**

- **Standard**
  - Standard cabinet style.
- **HandiCap**
  - Handicapped cabinet style.
- **Vanity**
  - Vanity cabinet style.
- **PassThru**
  - Pass-through cabinet style.
- **BarTop**
  - Bar top style.
- **Bathtub**
  - Bathtub style.
- **Shower**
  - Shower style.
Printing Your Drawing

Printing in DataCAD LT offers you many different options, so you can always get the result you need. You can set the plotting scale for your drawing, customize pen widths for plotting, and assign colors and weights to different plotter pens. You can plot your entire drawing or just part of it by using a quick layout. DataCAD LT’s print preview allows you to visually check your plot before you send it to your plotter. You can quickly check to make sure your final plot will be correct.

In this chapter:
- Assigning colors and plotter pen widths
- Laying out your drawing on sheets
- Previewing your print
- Checking your print
- Printing details and drawings
Printing Basics

Make sure you first set up the printer(s) you intend to use in Windows so that you can plot your DataCAD LT drawings. You can check the printers attached to your computer locally or available on your office network with Windows. Simply click on the Start button, select Settings, and click on Printers. If the printer(s) or plotter(s) you intend to use are not displayed in the Printers dialog box, click on the Add Printer icon. Follow the instructions in Windows to set up the printer(s) you want to use. If you want to use a printer that is connected to your office network, but it doesn’t appear in the listing in the Printers dialog box, ask your Network Administrator for assistance. If you occasionally use a printer in your home, make sure you add that to the list, too.

The first time you print a drawing, you need to set several printing options, including the printer/plotter you’ll use, the paper size and orientation, and the layout orientation of the drawing. These settings become part of your drawing when you save the file and DataCAD LT will use them the next time you print that particular drawing. You can always change these settings later by using the Print Setup option in the File pull-down menu.

DataCAD LT stores printing information on a per-drawing file basis. For each subsequent drawing file, you must again establish that file’s printing/plotting criteria.

Printing your DataCAD LT drawing is a simple process. Just display the drawing on your screen as you want to print it. Then go to the Print/Plot menu. Use the options in this menu to set the criteria for the plotter, control the plotting scale and the pens (including the width, density, and color), and lay out the drawing on the sheet(s). You can preview the drawing before you commit it to paper. Finally, you send the drawing to the printer/plotter or to a file.

👉 To print a drawing:

1. Display in the Drawing Window exactly what you want to print. Decide if you want to print the text, dimensions, hatching, and line weights in your drawing. If you do, make sure Show Text, Show Dim., Show Hatch, and Show Weight, respectively, are toggled on in the Utility/Display menu. Keep in mind that the printed version of your drawing will contain only what is displayed on your screen. If something isn’t visible in the Drawing Window, it will not appear on paper either.

2. Click on Print in the File pull-down menu, click on Print/Plot in the Utility menu, or click on in the Standard toolbar. Depending on whether you’ve printed this drawing before or not, one of two things may happen now:

   • If you’ve printed this drawing before, the Print/Plot menu appears. Click on Setup in the Print/Plot menu to display the Printer/Plotter Settings dialog box.

   • If this is the first time you’ve printed this drawing, DataCAD LT tells you A printer has not yet been selected for this drawing. Please click OK to assign a printer and select a paper size for this drawing. Click on OK to close the message box and display the Printer/Plotter Settings dialog box.

Shortcut: Press (Ctrl) + (P) to print your drawing.
3. Indicate the printer/plotter settings for this drawing file. Make your decisions using the Printer/Plotter Settings dialog box. These settings will be stored as part of your file so that you can use them the next time you want to print this particular drawing. Of course, you can change any of the settings the next time you want to print your drawing.

- **Printer section** - use the Name drop-down box to select the printer you’d like to use. Clicking the Properties button displays details about the printer you selected.

- **Paper section** - use the Size drop-down box to select a paper size. The paper sizes available in the Size drop-down box are read from your Windows printer driver. If a size you want is not listed, then your printer doesn’t support it or the driver may not be configured to display it. You can change the driver properties by closing DataCAD LT and opening the Printers dialog box from the Control Panel in Windows. Choose the next closest appropriate size, select User-Defined if listed, or use a different printer.

Notice that the Effective plotting area dimensions (displayed directly below the Size drop-down box) change depending on the Size of paper you choose. The effective plotting area is the printable area for the paper size you’ve selected, as defined by the printer manufacturer’s driver. Any part of the drawing extending outside this area will not be printed (see Figure 18.2).

- **Paper Orientation at Device section** - click on Normal or Rotated.
• **User Defined Paper Size section** – indicate the units of measurement (English for inches or Metric for millimeters) for your printer. Then indicate the width and length of the paper you want to use. Some printer drivers (such as LaserJets and older plotters) don’t support user-defined paper sizes, even though that option remains listed in the Size drop-down box. One way to check is to select User-Defined for the paper size and enter a width and length for the paper size. If the Effective plotting area dimensions don’t change based on the size dimensions, then the selected printer’s driver doesn’t support user-defined paper sizes. Select another paper size from the drop-down box.

![Figure 18.2: Example of printed sheet showing the edges of the sheet, the nonprinting area, the effective plotting area, and the extents of the drawing](image)

• **Check Plot section** – decide whether you want to print a test copy of your drawing on your laser printer. If you do not want to print a test copy, click on None. If you want to print a test copy, use the other options in this portion of the Printer/Plotter Settings dialog box. For more information, see “Printing a Check Plot” later in this chapter.

• **Copies section** - enter the number of copies of each sheet you’d like to print.

• **DataCAD LT Layout Orientation section** - click on Normal to print the sheet as it appears on screen or click on Rotated to rotate the sheet 90° for plotting. The Rotated option in the DataCAD LT Layout Orientation section rotates the geometry for the print only; it does not rotate the drawing itself.

4. Click OK to close the Printer/Plotter Settings dialog box. The Print/Plot menu appears.

5. Make decisions about the plotting scale, pen width and/or colors, and rotation for this drawing.

• **Scale** - change the plotting scale by clicking on Scale. A value menu appears and you are prompted to Select new scale. Use the value menu to select a new scale and press (Enter).
- *Pen Width* - determine if you have lines in your drawing with a line weight above “1.” If so, you can change the amount of space between pen passes when printing these thicker lines (see Figure 18.3). Click on Pen Width in the Print/Plot menu and use the value menu to enter a width.

**Figure 18.3:** Lines drawn with a line weight of 4 and printed with a pen width setting of 12 (left) and 95 (right)

- *Pen Table* - use Pen Table to assign each pen in your plotter to a line color in your drawing as well as to set the width and color density for each pen. To change Pen Table settings, click on PenTable in the Print/Plot menu; the Pen Table dialog box appears. Change the settings as necessary and click on OK. See “Using Pen Tables” later in this chapter for more information.

- *Rotate* – toggle this option on if you want to plot your drawing or detail at a rotation angle, use the value menu to select an angle, and then press (Enter).

Depending on the plotting history for this drawing, one of two things may happen if you toggle Rotate on:

If you haven’t plotted this drawing before or if you used the Quick Layout option the last time you plotted it, you are prompted to *Select CENTER of rotation*. Click in the Drawing Area to enter the center of rotation for your plot. You are prompted to *Enter ANGLE of rotation*.

6. Lay out your drawing with the Quick Layout option. Use the Quick Layout option if you want everything displayed in your Drawing Window to be printed as is on one sheet of paper. See “Laying Out Your Drawing” later in this chapter for more information on using the Quick Layout option.

7. Decide if you want to look at the plot before sending it to the printer/plotter. Toggle Preview on to look at your plot before you actually send it to the plotter; toggle Preview off to send the sheet directly to the plotter. (The Preview toggle can only be used with the Plot and Partial options in the Print/Plot menu. See “More About Previewing Your Plot” for details.)

8. Plot the sheet using one of the following options:

- *Print/Plot* – send the sheet to your printer by clicking on Print/Plot in the Print/Plot menu. If you toggled Preview off in the previous step, the sheet is plotted; if you toggled Preview on, the DataCAD LT Plot Previewer opens, allowing you to see the plot before sending it to your plotter. To interrupt a plot in progress, press (End).

- *To File* – send the sheet to a file by clicking on To File in the Print/Plot menu. A dialog box appears. Type a name for your plot (.PLT) file and click on Save or press (Enter). Plot files are saved by default in your DataCAD LT\Plot Files folder.

- *Partial* - plot only a part of your drawing by clicking on Partial. Choose a selection method from the Partial menu and then select the part of your drawing you want plotted. If you toggled Preview off in the previous step, the selection is plotted; if you toggled Preview on, the DataCAD LT Plot Previewer opens, allowing you to see the selection before sending it to your plotter.
More About Previewing Your Plot

Preview is a look-before-you-leap function. This is especially useful in large offices where several people share a printer or plotter. It is also a convenient way to spare a tree.

Previewing a plotting sheet before actually printing it allows you to verify that you’re using the proper paper size and plotting scale, that your drawing is positioned properly, and that such things as hatching, dimensions, and line overshoot are displayed as you want them. From the DataCAD LT Plot Previewer window, you can change the view of your preview and then plot, copy, or save it.

Printing a Check Plot

You can use check plots to do a quick test print to your laser printer before sending the file to your plotter. Check plots use separate settings for the printer, paper size, and paper orientation you designated.

To do a check plot:

1. Click on Setup in the Print/Plot menu. The Printer/Plotter Settings dialog box appears. Go to the Check Plot section and select the options you prefer.
2. Click on Fit to or Use this factor. These options are mutually exclusive.
   - Fit to – select this if you want to fit the drawing to a single page. This option scales a previously defined layout to fit on the selected paper size. It does not automatically scale your drawing to fit on a defined paper size.
   - Use this factor – select this to scale your drawing to a particular size for the check plot. Select the scale factor percentage by clicking on the arrows. Your drawing and pen widths (as set in the Pen Table) are scaled.

Notice that all the settings above the Check Plot section are now grayed and the settings in the Check Plot section are now available.
3. Select a printer or plotter to use from the drop-down box in the To this printer area in the Check Plot section.

4. Choose a page size from the drop-down box in the Check Plot section.

5. Go to the Paper Orientation at Device area in the Check Plot section and select Normal or Rotated. This setting works exactly like the one described in “Printing Basics” earlier in this chapter.

6. Click on OK to close the Printer/Plotter Settings dialog box.

7. Continue with step 5 in the instructions under “Printing Basics” earlier in this chapter.

**Using Pen Tables**

Using pen tables will allow you to print the lines in your drawing in different colors than you drew them, in greyscale, or in black, or all of these in a single print! Custom color names also appear in the pen definition list. When you map a pen to a color, the color is remembered when you re-select the color to map to. The “In order” option prints SPB fills in order instead of first or last.

First assign a pen number to the on-screen line color in the Pen Assignments list box.

Next, set the desired width, density, and printed color for that pen number in the Pen Settings table.

Checking a box prompts you to select a printed color for the pen. The checkbox is surrounded with the color you choose.

If the Map to Color box is not checked, the pen number will print in the on-screen color.

Overrides the above color settings and prints all pens in black.

![Figure 18.6: DataCAD’s Pen Table](image)

To use a pen table:

1. Click on PenTable in the Print/Plot menu. The Pen Table dialog box appears.

2. Go to the Pen Assignments list box and click on the color you want to assign to a pen. The color and its name appear beneath the list box, along with the pen number that color is currently assigned to.

3. Type the pen number you want to assign to that color. The pen assignment is changed in the list.
4. Repeat steps 2 – 3 to continue changing pen assignments as necessary.

4. Go to the Pen Settings section and make decisions about the width, density, and colors for the pens.
   - **Width** - enter the width (in millimeters) for each pen that you assigned a color to.
   - **Percent Density** - print screened colors. A setting of 100% prints full color; entering a lesser percentage prints a screened color. This setting works only with printers that accept RGB color definitions. For example, a LaserJet IV can print shades of grey using screened black, but a LaserJet III can only print black.
   - **Map to Color** - print lines in your drawing in a different color than they are on screen by checking the box for the pen assigned to the color you used in your drawing. The Color dialog box appears so that you can select the color (or create a custom color) you’d like to print. After you click on OK in the Color dialog box, the new color surrounds the Map to Color checkbox. The Map to Color checkboxes only affect printing; they don’t change entity colors in your drawing.

   **Percent Density and Map to Color** settings are used only for color and greyscale printing, so they are only available when All Black is unchecked.

   - **All Black** - print all lines in black (regardless of what color they are on screen or what settings are entered in the rest of the pen table) by checking this option.

6. Click on OK to save the changes you made to the pen table.

**More About Using Pen Tables**

Here are some examples of how pen table settings affect plotting:

- If you set the Width for Pen 1 to .25 and the Percent Density to 20% and leave Map to Color unchecked, all lines printed with Pen 1 will be printed .25mm wide in 20% of their full color (i.e., with a 20% color screen). **Full color** is a color at 100% density.

- You can produce heavy text on a print by drawing all text in a specific color and then mapping that color to a thicker pen using the Pen Table dialog box.

- To print in gray scale, check the Map to Color option for any pen you’d like to print as gray scale. The Color dialog box appears. Since black is chosen by default, click on OK to accept black as the color mapped to that pen. Then set the Percent Density option. For example, to print a half-toned black color, change Percent Density to 50%. Some black and white printers will automatically produce grayscale print when Map to Color and All Black are left unchecked.

- To print lines in a different color than they are on screen, click on the Map to Color checkbox. Select a color from the Color dialog box; black is selected by default. Click on OK. All lines using that pen will be reprinted in the selected color, regardless of their color on the screen. The Map to Color options only affect printing; the actual colors of the entities aren’t changed.

**Saving and Using Pen Table Settings**

You can save a lot of time when setting up to plot your drawings if you save your Pen Table settings in a .DPF file. You can then quickly load those settings when you want to use them, instead of having to change all the Pen Table settings each time you print.

The name of the Pen Table file used in a drawing is always saved in that drawing. The default Pen Table file is dcadwin.dpf, located in your DataCAD\Support Files folder.
To save pen table settings:
1. Click on Pen Table in the Print/Plot menu. The Pen Table dialog box appears.
2. Change the settings as necessary.
3. Click on Save As in the Pen Table dialog box. Another dialog box appears, prompting you to save pen file as.
4. Type a name for the Pen Table settings file and click on Save or press (Enter). The dialog box closes.
5. Click on OK in the Pen Table dialog box to close it.

To use pen table settings that you’ve saved in a .DPF file:
1. Click on Pen Table in the Print/Plot menu. The Pen Table dialog box appears.
2. Click on Load in the Pen Table dialog box. Another dialog box appears, prompting you to load pen file.
3. Click on the pen file you want to use and click on Open or press (Enter). The dialog box closes and the settings are loaded into the Pen Table dialog box.
4. Click on OK in the Pen Table dialog box to close it.

Laying Out Your Drawing
You can easily lay out your drawing at a single scale on a single sheet of paper with Quick Llayout.

Whenever you change Print/Plot menu settings, make sure you check the layouts you’ve already set up before you plot them. You can use the Preview option to check your sheets.

Using Quick Layout
As its name implies, quick layout is a fast, simple way to print all or part of your drawing on a single sheet.

To quickly lay out your drawing for plotting at a single scale:
1. Click on Quick Layout in the Print/Plot menu. The Layout menu appears. Notice that a grid representing the plotting area of the selected paper size is now attached to your cursor. (A dashed grid may also be displayed, representing the last defined quick layout.)
2. Position the grid over your drawing, so that the part you want to print is inside the grid. If your drawing is too large or small for the grid, exit the Layout menu and change the plotting scale; repeat steps 1 – 2.
3. Position the grid as you want it and click. The layout is defined and you can continue with the plotting instructions given in “Printing Basics” earlier in this chapter.
Modeling Basics

DataCAD has a comprehensive set of 3D modeling tools, which can be used to complement the 2D tools. Since DataCAD is a true 3D modeling program, 2D and 3D data can coexist in the same drawing, allowing the user to combine the flexibility and strengths of each method. For example, you can develop a 2D drawing that can then be used to construct a 3D profile or perhaps a surface of revolution.

In this chapter:
- Z-base and Z-height
- The zero plane
- Changing 3D settings
- Drawing 3D lines
- 3D snapping
- Using markers
Z-Base and Z-Height

After using DataCAD as a 2D drafting tool, you’re probably familiar with the concept of Z-base and Z-height as the “floor” and “ceiling” of entities you draw. When you use the 3D modeling tools in DataCAD, however, Z-base and Z-height no longer have to be floor and ceiling values. Instead, they’re measured from the zero plane. Normally, the zero plane is parallel to the floor of your model; so in plan view, positive values for Z-base and Z-height extend toward you (out of the screen) while negative Z values extend away from you (into the screen). See “The Zero Plane” below for more information.

Z-base doesn’t have to be at a lower elevation than Z-height, although you may find it easier to use them this way. Keep in mind, however, that entities are always constructed from Z-base to Z-height.

Most 3D entities have some kind of thickness associated with them; for instance, slabs have thickness while cylinders and cones have height. Because you can place the zero plane, Z-base, and Z-height in any spatial orientation with respect to your model, DataCAD can use the Z-base and Z-height settings to determine the thickness or height of a 3D entity. They can represent the front and back walls of a building, the sides of a bookcase, or any other two values that, taken together, create a depth to a drawing object.

In addition to Z-base and Z-height, you can use two auxiliary Z elevations as well: Z-User 1 and Z-User 2. These elevations are two extra planes in space, placed somewhere between Z-base and Z-height, that can be useful for creating 3D entities.

Z By Layer

Beginning with DataCAD version 11, you can set unique Z-base and Z-height values on each layer. To do so, toggle Z By Layer on in the 2D Utility \ Settings menu. Each time you set Z-base and Z-height, those settings will affect the current layer only. Any new layers you create take on the settings of the current layer, including its values.

The Zero Plane

The zero plane is the plane in your model where Z=0. In plan view, the zero plane is fixed at the ground plane; however, in other views, you can change its position in relation to your model. It is important to note that, regardless of how its position changes relative to your model, the zero plane is always parallel to the screen. When you change its position, the zero plane doesn’t change in relation to your screen; rather it changes in relation to your model. So when you change views of your model, you can use the following methods to change the orientation of the zero plane as well:

- Change the view of your model to orthographic (plan) view. The zero plane is changed to equal the ground plane. This method is best used when changes to your model can be made in plan view. Keep in mind that the model is temporarily displayed in plan view when you define a new elevation.
- Create a new elevation (click on New in the View/Elevation pull-down menu). The zero plane is changed to equal the elevation plane. This method is best used when changes to your model can be made in elevation view.
- Change the view of your model to a parallel view; this is often an elevation but you can use any parallel view. Use Edit Plane in the 3D Views menu to change the orientation of the zero plane. See “More About Positioning the Zero Plane” for more information on using the Edit Plane and Plane Snap options.
• Change the view of your model to an isometric or similar view. Using Plane Snap in the 3D Views menu, change the orientation of the zero plane by selecting three points on the plane, such as the corners of a slab. This method is useful when you want to change the zero plane to match the plane of a roof or something similar.

• Using the Controls option in the 3D Views menu, change the view of your model to any parallel view. The zero plane is changed so that it passes through the view center.

**More About Positioning the Zero Plane**

As described above, you can use both Edit Plane and Plane Snap to position the zero plane. Following are specific instructions on using both options.

➤ To position the zero plane using Edit Plane:

1. Change to a parallel view that will allow you to draw a line indicating where you want the zero plane to be. This parallel view is usually an elevation of some kind.

2. Click on 3D Menus in the Edit menu in the Menu Window. The 3D Menus appears.

3. Click on 3D Views. The 3D Views menu appears.

4. Click on Edit Plane in the 3D Views menu. The Edit Plane menu appears.

5. Notice that a new view center is created when you define a new zero plane. To set the Z coordinate (or height) of the view center, click on Center Z in the Edit Plane menu, enter a Z value, and press (Enter). You are prompted to Select a point on the edit plane. The Center Z setting automatically reverts back to its default of 5'-0" after you finish defining the new zero plane.

6. Click in the Drawing Area or use coordinate entry to enter the first point of the new zero plane. This point will also be the new view center. The cursor changes to a New Elevation Indicator and you are prompted to Indicate the direction of the edit plane. See “**More About the New Elevation Indicator Cursor**” in the “Viewing Your Model” chapter.

7. Click in the Drawing Area or use coordinate entry to enter the second point of the new zero plane. The view is changed based on the plane you just defined.

8. Save this new view. Click on Add View in the Edit Plane menu, type a name for the view, and press (Enter). The view is added to your go-to-view list. Keep in mind that view names can include up to eight characters but no spaces. If your model moves off screen, click Reset in the Edit Plane menu. The view is changed back to the most recent plan view.

There are a few rules when using Plane Snap that you should be aware of before you begin:

• When you select the three plane-defining points, be sure you snap to them in a clockwise direction.

• The first two points you snap to will align with the bottom of the screen in the new view; be sure to select the points in such a way that the new view will make sense to you. Keep in mind that if the new view is not what you wanted, you can always click on Reset in the Plane Snap menu to revert back to your original view.

In the following example, we need to place a skylight in the roof. To do this, we must first reposition the zero plane so it matches the plane of the roof. The easiest method for doing this is to use Plane Snap to simply snap to three points of the roof.

Remembering to work in a clockwise direction, we snap to the first two points along the bottom edge of the roof, rather than along the side. This bottom edge of the roof is aligned with the bottom of the screen, making it easy for us to orient ourselves to the new view, shown on the right of the example below.
To position the zero plane using Plane Snap:

1. Change to a parallel view that will give you easy access to three points that lie on the plane that will be the new zero plane.
2. Click on 3D Menus in the Edit menu in the Menu Window. The 3D Menus appears.
3. Click on 3D Views in the 3D Menus menu. The 3D Views menu appears.
4. Click on Plane Snap in the 3D Views menu. The Plane Snap menu appears and the cursor changes to a 3D world-snapping cursor. You are prompted to Select first point of snapping plane. For details on the 3D world-snapping cursor, see "All About 3D Snapping" later in this chapter.
5. Enter the first point on the new zero plane and snap to a point on your model. You are prompted to Select second point of snapping plane.
6. Enter the second point on the new zero plane and snap to the point on your model. You are prompted to Select third point of snapping plane.
7. Enter the third point on the new zero plane and snap to the point on your model. The view is changed based on the plane you just defined. If your model moves off screen, click Reset in the Plane Snap menu. The view is changed back to the most recent plan view.
8. Save this new view. Click on Add View in the Plane Snap menu, type a name for the view, and press (Enter). The view is added to your go-to-view list. Keep in mind that view names can include up to eight characters but no spaces.

**Changing 3D Settings**

The 3D Settings menu has several toggles and other settings that affect the 3D menus. You can either click on Settings in the 3D Menus menu or click on Settings in the Tools pull-down menu and then click on 3D Settings in the submenu.

**3D Settings Toggles**

There are several toggles that affect drawing using 3D entities:

- **Layer Search Toggle** on to scan all layers when you’re selecting entities; this option works exactly like the one in 2D selection menus. See "More About Selection Menus" in “The Drawing Board” chapter for more information on Layer Search.
- **Quick Search Toggle** on to select curved 3D entities only by their center points; toggle off to select them by any displayed edge.
- **Layer Snap Toggle** on to scan all layers when you’re snapping to entities; toggle off to snap to entities on the current active layer only. See "More About 3D Snapping" later in this chapter for more information on quick snap.
Quick Snap  Toggle on to snap only to straight edges or center points of 3D entities; toggle off to snap to these points as well as the endpoints of curved entities.

Draw Marks  Display (on) or suppress (off) control points. This letting also applies to control points on 2D polylines.

Mesh Grid  Display (on) control grid for mesh surfaces.

Mesh Point  Display (on) control points for mesh surfaces.

Global Divs.  Use fixed primary and secondary divisions for all curved entities (on).

Dynamic  Display entities while rotating (on).

Slab Refs.  Display slab reference points (on).

**Setting Primary and Secondary Divisions**

*Primary divisions* are the number of curve divisions in the plane of the screen, also known as the sweep angle. *Secondary divisions* are those divisions that affect curves that bulge into or out of the plane of the screen; these are known as *rise or roll angles*. You can set the primary and secondary divisions for curved 3D entities using the 3D Settings menu.

> To set the number of primary divisions:

1. Click on Settings in the 3D Menus menu. The Settings menu appears.
2. Click on Prim. Divs. in the Settings menu. A value menu appears and you are prompted to *Enter number of primary circle divisions*.
3. Use the value menu or type a value and press (Enter). The primary divisions setting is changed and you are returned to the Settings menu.

> To set the number of secondary divisions:

1. Click on Settings in the 3D Menus menu. The Settings menu appears.
2. Click on Sec. Divs. in the Settings menu. A value menu appears and you are prompted to *Enter number of secondary circle divisions*.
3. Use the value menu or type a value and press (Enter). The secondary divisions setting is changed and you are returned to the Settings menu.

**Setting Z-Elevations**

You can change the Z-base and Z-height elevations in the 3D Settings menu, as well as two alternative Z-elevation settings.

> To change a Z-elevation:

1. Click on Settings in the 3D Menus menu. The Settings menu appears.
2. Click on the Z-elevation you want to change: Z-Base, Z-Height, or one of the two alternative Z-elevations, Z-User 1 or Z-User 2. A value menu appears and you are prompted to enter a new value for the Z-elevation.
3. Use the value menu or type a value and press (Enter). The Z-elevation is changed and you are returned to the Settings menu.

**Drawing 3D Lines**

3D lines are like wires or threads in space; they can connect any two points in 3D space. They are not constrained to lie in the XY plane; however, unlike 2D lines, 3D lines have no extrusion value.
When you draw 3D lines from Z-base to Z-height and select two points at exactly the same place on the screen, you create a line that is perpendicular to the screen. Such a line looks like a dot from the current view (a line viewed end-on). Although this method works, it is usually conceptually easier to draw such lines flat across the screen in an appropriate elevation view.

You can specify the end points of 3D lines in the same way that you specify the end points of 2D lines. You can select points with the left mouse button, snap to points with the middle mouse button, or enter coordinates. You can also use the 3D cursor.

The first four options in the 3D Entity/3D Lines menu are toggles that specify one of the four standard Z-elevations at which you can define entities. 3D lines can be drawn at Z-Base, Z-Height, or one of two alternative Z-elevations (Z-User 1 or Z-User 2), which are set using the Set Z User 1 and Set Z User 2 options in the 3D Lines menu, respectively.

➤ To set the height of the Z-User 1 variable:
1. Choose Set Z User 1 from the 3D Lines menu. A list of values appears.
2. Choose or type a height value and press (Enter).

➤ To set the height of the Z-User 2 variable:
1. Choose Set Z User 2 from the 3D Lines menu. A list of values appears.
2. Choose or type a height value and press (Enter).

You can also draw 3D lines that begin at Z-base (first point selected) and end at Z-height (second point selected) by toggling the Base/Height option on in the 3DLine menu. See “Z-Base and Z-Height” in the beginning of this chapter for more information on Z-elevations.

Further, you can toggle Chain on to create 3D lines that rubber band from the last point entered, just like 2D lines. If you toggle Chain off, you must select both end points of each 3D line you draw.

All about 3D Snapping

DataCAD 3D uses a different technique for object snapping than the two-dimensional DataCAD editor.

The most important difference between normal 3D snapping and its 2D counterpart is that normal 3D snapping attaches the cursor to the projection of the model on the screen, not to the model itself. A projection is a two-dimensional view of a three-dimensional object. If you want to attach the cursor to points on the model, you need to orient the zero plane (screen plane) so that it coincides with the part of the model you are snapping to.

Three-dimensional snapping is designed to work when the model appears in orthographic or any parallel view. See “The Zero Plane” earlier in this chapter for more information.
In several menus in DataCAD 3D, you can use a 3D world-snapping cursor to snap to the end points you see in the model. This 3D world-snapping cursor snaps to the entities themselves rather than connecting to the projections of those entities. If the 3D cursor appears, then world snapping is on; if you press the middle button on the mouse, you snap to points on the model and not the projections of those points on the screen. World snapping works regardless of the location of the zero plane.
CHAPTER 19: MODELING BASICS

Figure 19.4: 3D world-snapping cursor

Zero plane not aligned with the model

World snapping here with the 3-D cursor will attach you directly to the model

Figure 19.5: World snapping with 3D cursor

More About 3D Snapping

If you toggle Fast 3D on in the 2D Utility/Object Snap menu or toggle Fast 3D Snap on in the 3D Menus/Settings menu, you can only snap to the edges of straight-edged objects and the center axis points of curved entities. If you toggle Fast 3D or Fast 3D Snap off, you can snap to the end points of the circular divisions as well.

The following is a list of entities that you can snap to using Fast 3D and Quick Snap:

- **3D Lines**: Snap to either end of a 3D line
- **Polygons**: Snap to either end of any displayed edge (including the edges of voids)
- **Blocks**: Snap to either end of any edge
- **Slabs**: Snap to either end of any displayed edge (including the edges of voids)
- **3D Arc**: Snap to the arc center marker; with Fast 3D Snap off, you can snap to the end points of the division segments that make up the arc itself
- **Horizontal or Vertical Cylinder**: Snap to any of the three center axis markers; with Fast 3D Snap off, you can snap to the end points of the circular divisions of a cylinder
- **Cone**: Snap to any of the three center axis markers; with Fast 3D Snap off, you can snap to the end points of the circular divisions of the cone
- **Truncated Cone**: Snap to any of the three center axis markers; with Fast 3D Snap off, you can snap to the end points of the circular divisions of the truncated cone
- **Sphere**: Snap to any of the three center axis markers; with Fast 3D Snap off, you can snap to any edge of the facets that make up the sphere
- **Torus**: Snap to the center marker of the sweep or the center markers at the beginning and end of the roll; with Fast 3D Snap off, you can snap to any edge of the facets that make up the torus
Contour Curve or Mesh Surface  Snap to any control point; Fast 3D Snap has no effect on snapping to contours or mesh surfaces

Surface of Revolution  Snap to any control point; with Fast 3D Snap off, you can snap to any edge of the single-curvature facets which make up the surface of revolution, but you cannot snap to the edges of the double-curvature facets

Symbol  Snap to any displayed edge of any portion of the symbol according to the rules for each individual entity that makes up the symbol

**Using Markers**

A marker is a 3D snapping point. When you choose 3D Markers from the 3D Entity menu, the following options appear:

- **Z-Base**  Places a marker at the current Z-base
- **Z-Height**  Places a marker at the current Z-height
- **3D Cursor**  Snaps to any object with world snapping enabled; for more information on world snapping. See “All about 3D Snapping” earlier in this chapter for more information on world snapping.
- **3D Views**  Accesses the 3D Views menu
Modeling with 3D Polygons, Slabs, and Blocks

DataCAD’s 3D polygons, slabs and blocks are closely related entities with a few important differences. A 3D polygon is a single entity with no thickness (unlike a 2D polygon, which is a group of lines drawn from Z-base to Z-height). Slabs, usually the most common entity in a model, are very similar to polygons, except that they have a thickness that you can specify. Blocks are simple solids with six rectangular or parallelogram-shaped faces. Because the top of a block doesn’t have to lie directly over its bottom, blocks are particularly useful for modeling support members that lean to one side.

Another important distinction between 3D polygons and slabs is that slabs have a reference face, which is the face of the slab that orients the slab, controls the direction that you can pass a void through the slab, and is important when moving or adding vertices or voids to a slab. DataCAD automatically assigns one face of a slab to be the reference face, depending on what kind of slab you draw:

Horizontal slabs  If you draw the slab from Z-base with the specified thickness (Base+Thk toggle), the reference face is at Z-base. If you draw the slab from Z-height with the specified thickness (Height+Thk toggle), the reference face is at Z-height. If you draw the slab from Z-base to Z-height (Base/Height toggle), the reference face is at Z-base.

Vertical slabs  When you draw a slab from the top of the screen to the bottom, the reference face is on the left. When you draw a slab from the bottom of the screen to the top, the reference face is on the right.

Inclined slabs  The reference face is always on the underside of the slab.

If you forget which face of a slab is the reference face, toggle Slab Refs. on in the 3D Menus/Settings menu. Dots will be displayed on every vertex of each reference face, along with an additional dot on one of the opposite vertices.
Drawing Rectangular 3D Polygons and Slabs

To draw a rectangular 3D polygon:
1. Choose Rectangle from the 3D Entity/Polygons menu.
2. Choose a Z elevation (Z-Base, Z-Height, Z-User1, or Z-User2) at which to draw the rectangle. To set the alternative Z elevations, choose Set Z User 1 to set the Z-User 1 elevation or choose Set Z User 2 to set the Z-User 2 elevation.
3. Select a point to start the rectangle.
4. Drag the cursor diagonally to size the rectangle and click. The rectangle is drawn. You can also create rectangular polygons with Horizontal, but using Rectangle is faster and easier.

To draw rectangular slabs:
1. Choose Rectangle from the 3D Entity/Slabs menu.
2. Choose a Z elevation at which to draw the rectangular slab: from Z-base to a thickness (Base+Thk), from Z-height to a thickness (Height+Thk), or from Z-base to Z-height (Base/Height).
3. Determine if you are using Base+Thk or Height+Thk to draw slabs. Set the thickness value by choosing Thickness from the Rect. Slab menu and then choosing or typing a value and pressing (Enter). As with all Z measurements, a positive thickness extends out of the screen and a negative thickness extends into the screen.
4. Select a point to start the rectangle.
5. Drag the cursor diagonally to size the slab and click. The slab appears. You can also create rectangular slabs with Horizontal, but using Rectangle is faster and easier.

Drawing Horizontal 3D Polygons and Slabs

To draw horizontal 3D polygons:
1. Choose Polygons from the 3D Entity menu. Then select Horizontal from the Polygons menu.
2. Choose the elevation at which you want to draw the polygon: Z-Base, Z-Height, or one of the two alternative Z elevations (Z-User 1 or Z-User 2). These alternative Z elevations are set using the Set Z User 1 and Set Z User 2 options in the menu, respectively. To set the height of an alternative Z elevation, choose Set Z User 1 or Set Z User 2 from the Polygons menu and then choose or type a height value and press (Enter). See “Z-Base and Z-Height” in the “Modeling Basics” chapter for details about Z-elevations.
3. Select the first point of the polygon. You can create polygons of up to 36 vertices this way.
4. Continue selecting points until you are ready to close the polygon. If you make a mistake in placing a vertex, use Backup to erase the last selected point. Use Backup to erase the last side of the polygon you drew. Backup is available as soon as you select the first point of a polygon and until you close the polygon or right-click to disconnect from the polygon you’re drawing. To cancel the polygon before the polygon is completed and added to the drawing, choose Cancel. Use Cancel to erase the polygon you’re currently drawing. Cancel is only available after you select the third point of the polygon and until you close the polygon or right-click to disconnect from the polygon you’re drawing. You can also choose Exit, which is available until you select the third point of the polygon, when it becomes Close. Use Exit to stop drawing a polygon and erase what you’ve drawn to that point.

If you create a 36-vertex polygon, DataCAD closes the polygon for you. To circumvent this 36-vertex limitation, see “Editing 3D Polygons and Slabs” later in this chapter.

5. Connect the last point you selected with the first one and close the polygon by choosing Close or right-clicking.

**Hint:** Do not place two points directly on top of one another. For example, to create a square polygon, select four points, not five. When you right-click to close the polygon, DataCAD automatically connects the first and last points. In this example, point four will be automatically connected to point one.

➔ To draw horizontal slabs:

1. Choose Slabs from the 3D Entity menu. Then select Horizontal from the Slabs menu.

2. Choose the elevation at which you want to draw the slab: Z-base extending to a thickness (Base+Thk.), Z-height extending to a thickness (Height+Thk.), or Z-base extending to Z-height (Base/Height). Backup is available as soon as you select the first point of a slab and until you close the slab or right-click to disconnect from the slab you’re drawing.

3. Set a thickness for the slab by choosing Thickness from the Slabs menu. Then choose or type a value and press (Enter). As with all Z measurements, a positive thickness extends out of the screen and a negative thickness extends into the screen. Set Thickness when you are drawing slabs with Base+Thk. or Height+Thk.; otherwise, the Thickness setting is ignored.

4. Select the first point or vertex of the slab. You can create slabs of up to 36 vertices. If you create a 36-vertex slab, DataCAD closes the slab for you. If you make a mistake in placing a vertex, use Backup to remove the last vertex you entered and then continue to place vertices. Use Exit to stop drawing a slab and erase what you’ve drawn to that point. After you select the third point of the slab, the Exit option changes to Close. See “Editing 3D Polygons and Slabs” later in this chapter for more information about simulating polygons or slabs with more than 36 sides.

5. Select a second corner point that, along with the first point, forms an edge for the base of the block.

6. Choose Cancel if you want to cancel the slab before it is completed and added to the drawing. Cancel is only available after you select the third point of the slab and until you close the slab or right-click to disconnect from the slab you’re drawing.

7. Use Close when you want to connect the last point you selected with the first one and finish the slab.
**Drawing Vertical 3D Polygons and Slabs**

Vertical polygons and slabs are rectangular shapes drawn edge on. Vertical polygons are useful for quickly creating forms that show some kind of extruded quality (like gutters or irregular curtain walls); vertical slabs are useful for quickly creating free-standing walls. Draw the edge of the vertical polygon or slab by selecting points on the screen; the height of the entity is determined by the separation of Z-base and Z-height (or the two alternative Z elevations).

1. Choose Polygons from 3D Entity menu. Then select Vertical from the Polygons menu. The Vert. Poly menu appears.

2. Choose to draw the polygon from Z-base to Z-height (Base/Height) or from Z-User 1 to Z-User 2 (Z1/Z2). These toggles set the height of the vertical polygon to run from one Z elevation to the other (from Z-base to Z-height or from Z1 to Z2). To set the height of the Z1 or Z2 elevation, choose Z-User 1 or Z-User 2 from the Vert. Poly. Menu, choose or type a height value, and press (Enter).

3. Choose Chain to create vertical polygons in succession, with the first edge of each polygon connected to the last edge of the previous polygon. This is similar to the way 2D lines are drawn. When you toggle Chain off, DataCAD does not automatically connect lines, so you must select both points of each polygon edge you draw.

4. Select two points on the screen creating one edge of the vertical polygon. The polygon is drawn upright, into or out of the screen.

**Figure 20.1:** Vertical polygons

1. Choose Slabs from the 3D Entity menu. Then select Vertical from the Slabs menu. The Vert. Slab menu appears.

2. Choose to draw the slab from Z-base to Z-height (Base/Height) or from Z-alternative 1 to Z-alternative 2 (Z1/Z2). These toggles set the height of the vertical slab to run from one Z elevation to the other; they are mutually exclusive. To set the values of Z-alternative 1 and Z-alternative 2, choose Z-User 1 or Z-User 2 from the Vert. Slab menu, select a value from the list, or type a value and press (Enter).
3. Set the thickness of the slab by choosing Thickness from the Vert. Slab menu. Then choose or type a value and press (Enter). Do not confuse this setting with the Thickness setting in horizontal and rectangular slabs. Thickness for vertical slabs refers to the short dimension of the slab as seen across the screen, not the depth of the slab going into the screen.

4. Choose Left, Center, or Right to determine the side of the slab on which to attach the cursor. The terms Left, Center, and Right refer to the slab as drawn from the top of the screen toward the bottom. If you draw the slab from the bottom to the top with Left toggled on, your cursor appears attached to the right side of the slab. These toggles are mutually exclusive and can be activated at any time, even after you select the first point of the slab.

Figure 20.2: Cursor positions on vertical slabs

5. Select the first corner point of the vertical slab.

6. Move the cursor diagonally to the opposite point of the slab. The slab sizes dynamically with the cursor. Click to complete the slab. The slab is drawn upright, between the two elevations you selected in step 2.

Figure 20.3: Vertical slabs

Use Slab Refs. to display markers that indicate the reference face for a slab as well as the direction of extrusion. The reference face of the slab is determined by the points selected on the screen. The extrusion is determined by the relative Z-base and Z-height (or Z-User 1 or Z-User 2) settings you have entered.
CHAPTER 20: MODELING WITH 3D POLYGONS, SLABS, AND BLOCKS

Figure 20.4: Reference faces

Drawing Inclined 3D Polygons and Slabs
Inclined polygons can be used to create roof elements. Roofs that you create with this menu do not have a thickness. To create roofs with thickness, use the Inclines menu in the 3DEntity/Slabs menu, or use the RoofIt macro available from the Toolbox menu to create simple roofs automatically.

To create roof elements using inclined polygons:
1. Use the 3D Views option from the 3D Entity/Polygons menu and then select Plans to place the model in an orthographic view.
2. Set Z-Base to the height of the lowest point on the roof.
3. Set Z-Height to the height of the ridge line (peak) of the roof. DataCAD needs Z-base and Z-height information about the roofs that you are going to create—information that is easily calculated but not immediately at hand. Calculate the heights and breadths of roofs before using the Inclines menu.
4. Choose Inclines from the Polygons menu.
5. Continue with the sections below to draw the three- or four-edged inclined polygon you need.

To create roof elements using inclined slabs:
1. Place the model into orthographic (plan) view.
2. Choose Slabs from the 3D Entity menu. Then select Inclines from the Slabs menu.
3. Choose Thickness to set the depth of the roof element; choose or type a value and press (Enter).
4. Choose whether to add the thickness perpendicularly or vertically. Vertical adds the thickness of the slab to the roof element vertically or perpendicular to the ground. This produces a plumb cut on the edge of the roof element. Perped. adds the thickness of the slab to the roof perpendicularly to the roof slope.
5. Continue with the instructions below to draw the three- or four-edged inclined slab you need.

To draw gable, A-frame, and shed roofs:
1. Choose 4 Edge Para. from the 3D Entity/Slabs/Inclines/Slabs menu.
2. Select the first corner point at the bottom edge of the slope.
3. Select the second corner point at the bottom edge of the slope.
4. Select the first corner point on the ridge of the roof. Enter this third point opposite the first point, as shown below. Locate this point by snapping or with a reference point shortcut and coordinate entry. The fourth corner point is automatically derived.

Figure 20.5: Four-edged parallelograms

⇒ To draw hip and mansard roofs:
1. Choose 4 Edge Trap. from the 3D Entity/Slabs/Inclines/Slabs menu.
2. Select the first corner point at the bottom edge of the slope.
3. Select the second corner point at the bottom edge of the slope.
4. Select the first corner point on the ridge of the roof. Enter this third point opposite the first point, as shown below. Locate this point by snapping or with a reference point shortcut and coordinate entry. The fourth corner point is automatically derived.
Figure 20.6: Four-edged trapezoids

When a portion of a roof has four edges, but the opposite edges are not parallel due to unusual intersections or valleys with other roofing elements, use the four-edged general inclined polygon or slab option.

To draw dormers and other unusual roofs:
1. Choose 4 Edge Gen. from the 3D Entity/Slabs/Inclines/Slabs menu.
2. Select the first corner point at the bottom edge of the slope.
3. Select the second corner point at the bottom edge of the slope.
4. Select the first corner point on the ridge of the roof. Enter this third point opposite the first point, as shown below. Locate this point by snapping or with a reference point shortcut and coordinate entry.
5. Select the last corner point on the ridge of the roof.

Figure 20.7: Four-edged general incline

To draw the triangular pieces of hip roofs:
1. Choose 3 Edge Bot. from the 3D Entity/Slabs/Inclines/Slabs menu.
2. Select the first point at the bottom edge of the slope (at Z-base).
3. Select the second corner point at the bottom edge of the slope (also at Z-base).
4. Select the corner point on the ridge of the roof (at Z-height). Locate this point by snapping or with a reference point shortcut and coordinate entry.
To draw simple dormers:

1. Choose 3 Edge Top from the 3D Entity/Slabs/Inclines/Slabs menu.
2. Select the first corner point on the ridge of the roof (at Z-height).
3. Select the second corner point on the ridge of the roof (also at Z-height). Locate this point by snapping or with a reference point shortcut and coordinate entry.
4. Select the corner point at the bottom edge of the slope (at Z-base).

To draw rafters using vertical inclined polygons or slabs:

1. Choose 4 Edge Vert. from the 3D Entity/Slabs/Inclines/Slabs menu.
2. Choose Thickness to set the depth of the polygon or slab (rafter). A list of values appears.
3. Choose or type a value and press (Enter).
4. Select the location for the lower edge of the polygon or slab or the base of the incline, including the thickness of the polygon or slab.
5. Select the location for the upper edge of the polygon or slab or the top of the incline. The polygon or slab ends at the Z-height, including the thickness of the polygon or slab.
To create three-edged vertical, inclined polygons or slabs:

1. Choose 3 Edge Poly. from the 3D Entity/Slabs/Inclines/Slabs menu.
2. Set the thickness of the slab using the Thickness option if you're drawing a slab.
3. Snap to the first corner point on the incline. Use the 3D cursor to snap to the corners of roof elements already in place. You don't have to select the points in any particular order.
4. Snap to the second corner point on the incline.
5. Snap to the third corner point on the incline. The polygon or slab is drawn.

Adding Voids to Polygons and Slabs

The Voids menu in the Polygons and Slabs menus has options for creating and deleting holes in polygons and slabs. You create a void by drawing a small polygon or slab (representing the void) inside a larger (primary) polygon or slab. The smaller polygon or slab is then converted into a void with the Add Void option.

When creating slabs, the reference face of each void must coincide exactly with the reference face of the primary slab; in addition, the voids must be exactly as thick as the primary slab.

To add a void:

1. Draw a primary polygon or slab (the polygon or slab you will be adding a void to). Use Plane Snap, Elevation/New Elev., or Edit Plane (in the 3D Views menu) to bring the primary polygon or slab into the zero plane before adding voids. When you create both the primary and void polygons or slabs without changing the view, they automatically lie in the same plane.
2. Draw the void polygon or slab inside the primary polygon or slab in exactly the same plane, at Z-base (or whatever Z elevation you drew the primary polygon or slab at) equal to zero. You can draw more than one void polygon or slab at this time. Make sure the void polygon or slab lies completely within the primary polygon or slab.
3. Choose Voids from the Polygons or Slabs menu.
4. Highlight the primary polygon or slab by selecting one of its edges.

5. Choose Add Void.

6. Select the void polygon(s) or slab(s) you drew in step 2. The void polygons or slabs are highlighted as you select them. The primary polygon or slab now has voids in it.

When you add a void to a polygon or slab, you are left with one entity (a polygon or slab with a hole in it) where separate polygons or slabs existed before. If you erase or move the primary polygon or slab, the void moves with it, as you would expect of a single entity. The void polygons or slabs no longer have an identity apart from the primary polygon or slab to which they belong.

Use Convert Void to convert voids back into the polygons or slabs from which they originated. You must convert a void when you want to edit the void by adding, deleting, or moving vertices using the Visibility menu.

➤ To convert a void:
   1. Select Voids from the Polygons or Slabs menu.
   2. Select a primary polygon or slab by indicating one of its edges. The primary polygon or slab and any voids are highlighted.
   3. Choose Convert Void from the Voids menu.
   4. Select the voids that you want to convert back into polygons or slabs. Any converted voids now exist as individual, embedded polygons or slabs.

To add vertices to a void, convert the void back into a polygon or slab with Convert Void, add vertices with Add Vertx from the Visibility menu, then use Add Void to turn the polygon or slab back into a void. You can also move a void or resize it using 3D Menus/Stretch.

Once you add a void to a primary polygon or slab, the void polygon or slab no longer exists as an independent entity; it becomes a hole in a larger object. Use Erase Void to remove these voids from a primary polygon or slab.

➤ To erase a void:
   1. Choose Voids from the Polygons or Slabs menu.
   2. Select the primary polygon or slab by indicating one of its edges. The polygon or slab and any voids are highlighted.
   3. Choose Erase Void from the Voids menu.
   4. Select the voids that you want to delete from the polygon or slab. Selected voids disappear entirely, sealing the hole.

Editing 3D Polygons and Slabs

With the Visibility menu options, you can edit (move, add, or delete vertices in) a polygon or slab. You can also toggle the edges of a polygon or slab to visible or invisible.

To maintain its integrity, edit the polygon or slab in the same plane in which it was created or at least in a plane parallel to the polygon or slab. Use Plane Snap, NewElev, or Edit Plane from the 3D Views menu. See the chapter on “Viewing Your Model” for more information about the options for Plane Snap, Elevation/New Elev., and Edit Plane in the 3D Views menu.
To simulate polygons or slabs with more than 36 sides, you can create a 36-sided polygon or slab and mark one of the edges as invisible. You can connect another polygon or slab with a shared invisible edge to the first invisible edge. By hiding the seams, you can build a patchwork of polygons or slabs that simulates a polygon or slab of an unlimited number of sides.

To add vertices to a polygon or slab:

1. Choose Visibility from the 3D Entity/Polygons or Slabs menu. Then select Add Vertex from the Visibility menu. Make sure that the current editing plane is parallel to the polygon or slab you want to edit.

   **Warning:** Use caution with Move Vertex and Add Vertex. These commands can create physically impossible shapes. The most common problems include letting edges cross over one another and pulling vertices out of the plane of the polygon or slab, thus creating a twisted and ambiguous shape.

2. Select the edge of the polygon or slab to which you want to add a vertex. Remember that a polygon or slab can have no more than 36 vertices. Notice that this edge of the polygon or slab becomes a rubber band line with your cursor attached to the edge.

3. Position the new vertex.

![Figure 20.11: Adding a vertex](image)

To delete the vertices of a polygon or slab:


2. Select the vertex you want to delete. The vertex disappears and the two edges that led into the deleted vertex now become a single edge. Because a polygon or slab can have no less than three vertices, you cannot delete a vertex from a triangular-shaped polygon or slab.

![Figure 20.12: Deleting a vertex](image)
To reposition the vertex of a polygon or slab:

1. Choose Move Vertex from the Visibility menu. Make sure that your current editing plane is parallel to the polygon or slab that you want to edit.

2. Select the vertex you want to move. Notice that this vertex is now attached to your cursor and the two edges of the polygon or slab that lead to this vertex become rubber band lines. You can also move a vertex with the Stretch option in the 3D Edit menu.

3. Select a new vertex position.

![Figure 20.13: Moving a vertex](image)

Use Show/Hide to change the visibility of individual edges of a polygon or slab. Selecting a visible edge makes it invisible, while selecting an invisible edge makes it visible. Edges made invisible are not erased; they are suppressed from view, usually to hide the seams between adjacent polygons or slabs. Invisible edges remain invisible after hidden line removal, but the polygon or slab is processed as if they were visible; invisible edges can obscure objects that lie behind them.

To make an edge visible or invisible:

1. Choose Show/Hide from the Visibility menu.

2. Select the edge of the polygon or slab you want invisible.

![Figure 20.14: Using MarkVis on one edge](image)

To make all edges visible:

1. Choose Show All from the Visibility menu.

2. Select the polygon or slab that you want visible. The edges of the selected polygon or slab become visible.
To make all edges invisible:
1. Choose Hide All from the Visibility menu.
2. Select the polygon or slab that you want invisible. The edges of the selected polygon or slab become invisible.

Making a polygon or slab completely invisible with Hide All has obvious problems. The best way to recover an invisible polygon or slab is to use Area or Fence from the selection menu with Show All in the region where you think the polygon or slab exists.

**Drawing Blocks**

A block is a simple solid with six rectangular or parallelogram-shaped faces. Because the top of a block is not constrained to lie directly over its bottom, blocks are particularly useful for modeling supporting members that lean to one side.

To draw blocks:

1. Choose Blocks from the 3D Entity menu.
2. Select the shape of the base of the block: for a rectangular base, choose Rectangle; for a parallelogram base, choose Parallel.
3. Choose Auto Height to automatically place the vertex at Z-height, centered over the center point of the base; otherwise, you must place the vertex manually.
4. Choose to place the reference face of the block with one of the following:
   - Base+Thk.  At Z-base, extending up through a distance equal to the thickness parameter set below
   - Height+Thk.  At Z-height, extending up through a distance equal to the thickness parameter set below
   - Base/Height  At Z-base, extending up to Z-height

If you choose Base+Thk. or Height+Thk., you can use Thickness to set the thickness of the block. (Otherwise, the Thickness setting is ignored.) As with all Z measurements, a positive thickness extends out of the screen, and a negative thickness extends into the screen. Choose Thickness from the Blocks menu; then choose or type a value and press (Enter).

5. Continue with the sections below for either rectangular-based blocks or parallelogram-based blocks.

To draw rectangular-based blocks:

1. Select the first corner of the block base.
2. Move the mouse diagonally, expanding the base of the block to the proper size. Select the second corner of the block base. If you selected Auto Height, DataCAD places the top of the block directly over the bottom and the block is finished.
3. Turn Auto Height off and select a location of the top of the block; the sides of the block are drawn, connecting the top and bottom faces.
Figure 20.15: Rectangular-based blocks

To draw parallelogram-based blocks:

1. Select a point to serve as one corner of the block.
2. Select a second corner that, along with the first point, forms an edge for the base of the block.
3. Select a third corner point to form the parallelogram base of the block. Notice how opposite sides of the base remain parallel but are not constrained to right angles. When you select Auto Height, DataCAD places the top of the block directly over the bottom and the block is finished.
4. Turn Auto Height off and select a location of the top of the block; the sides of the block lean to connect the top and bottom faces.
Drawing Single-Curved Entities

Unlike their 2D counterparts, all curved 3D entities in DataCAD are actually drawn using a number of short line segments to approximate true curves.

Some 3D entities, such as cylinders, 3D arcs, cones, and truncated cones, only curve in one direction, around the entity’s center point or central axis. For these entities, you only need to set the number of primary divisions.

Entities that curve in more than one direction, such as domes and spheres, tori, surfaces of revolution, and mesh surfaces, have both primary and secondary division settings. See “Drawing Double-Curved Entities” for more information on drawing entities with both primary and secondary divisions.

In this chapter:
- Drawing 3D arcs
- Drawing horizontal cylinders
- Drawing vertical cylinders
- Drawing cones
- Drawing truncated cones
**Drawing 3D Arcs**

3D arcs are essentially the same as their 2D counterparts, with the following exceptions:

- 3D arcs can exist at any orientation in space;
- 3D arcs can be specified as open or closed;
- 3D arcs have no extrusion value
- 3D arcs are approximations of arcs consisting of up to 36 short line segments called divisions.

The first eight options on the 3D Curves menu are quite common and are seen wherever there is a curved 3D entity. Creating this 3D arc footprint is often the first step in creating a curved 3D entity. This footprint defines the sweep angles for the entity.

3D two- and three-point arcs and radius, diameter, and three-point circles are drawn exactly as their 2D counterparts. Use Clockwise (available only with 2 Pt. Arc) to create an arc in the clockwise direction rather than counterclockwise. Use Closed to close the arc and perform a hidden line removal. See “Drawing Curves” in the “Drawing Other Geometry” chapter for more information about arcs and circles.

![Figure 21.1: Open and closed arcs and circles](image_url)

Use Tangent to draw arcs that are tangent to a specified line. This method is slightly different from the way tangent arcs are created in 2D.

- To draw a 3D tangent arc:
  1. Choose Tangent from the 3D Curves menu.
  2. Select the first point of the tangent line. This is the line that the 3D arc draws to.
  3. Select the beginning point of the arc.
  4. Select the end point of the arc.
Figure 21.2: Drawing a tangent arc

A dog-leg arc is defined by the two tangent points of the arc and the point at which those two tangent lines cross (the knee point). You can use Dog-leg to create an arc that must be tangent to two existing lines.

To draw a dog-leg arc:
1. Choose Dog-leg from the 3D Curves menu.
2. Select the first point of tangency, or the first point of the arc.
3. Select the knee point, the point where the two lines of tangency meet.
4. Select the second point of tangency or the end of the arc.

Figure 21.3: Drawing a dog-leg arc

You can enter the arc at the current elevation of Z-base or Z-height. Choose Z-base or Z-Height, respectively, and draw the arc.

To create 3D arcs that curve out of the screen:
1. Choose Vertical from the 3D Curves menu.
2. Select the center point of the arc.
3. Select a starting point for the arc. A list of values appears.
4. Choose or type a value and press (Enter).
5. Type the angle of elevation for the first end point and press (Enter).
6. Type the angle of elevation for the second end point and press (Enter).

To set the number of divisions for 3D arcs:
1. Choose Divisions from the 3D Curves menu. A list of values appears.
2. Choose or type a division value and press (Enter).

![Figure 21.4: Divisions examples (36, 24, 12, and 8 respectively)](image)

**Drawing Vertical Cylinders**

Vertical cylinders are drawn as columns or posts standing on end. The diameter of the column is dynamically specified by drawing the footprint of the cylinder using one of the standard 3D arcs. The height of the column is controlled by setting Z-base, Z-height, and thickness.

To draw a vertical cylinder:

1. Choose Vert. Cyls. from the 3D Entity menu.
2. Select one of these options: 2 Pt. Arc, 3 Pt. Arc, Tangent, Dog-leg, Radius Circ., Dia. Circ., and 3 Pt. Circ. These options are identical to those in the 3D Curves menu. Choose one of these options to draw the footprint of the cylinder. A footprint is the shape of the base of the cylinder. For example, to draw a full cylinder, choose Radius Circ., Dia. Circ., or 3 Pt. Circ. to draw a circular footprint.
3. Choose whether to draw the cylinder from Z-base to the thickness value (Base+Thk.), from Z-height to the thickness value (Height+Thk.), or from Z-base to Z-height (Base/Height).
4. Use Closed to create a closed cylinder for hidden line removals. The cylinder is processed as a solid element with Closed on.
5. Follow the prompts in drawing the footprint of the cylinder. For more information on using 2 Pt. Arc, 3 Pt. Arc, Tangent, Dog-leg, Radius Circ., Dia. Circ., 3 Pt. Circ., and Clockwise, see “3D Arccs” earlier in this chapter.
**Drawing Horizontal Cylinders**

Horizontal cylinders draw flat across the screen.

To draw a horizontal cylinder:

1. Choose Horiz. Cyls. from the 3D Entity menu.
2. Select a radius for the cylinder.
3. Choose the extent of the sweep angles with Start Angle and End Angle. Alternatively, you can select one of the four presets: Full Circle, Top Half, Bottom Half, or Side Half.

For more control over the portion of the cylinder that appears, you can:

---

Set Thickness when you draw cylinders by Base+Thk. or Height+Thk.; otherwise the Thickness value is ignored. As is true for all Z measurements, positive thickness extends out of the screen, while negative thickness extends into the screen.

- To set a thickness:
  1. Choose Thickness from the Vert. Cyls. menu. A list of values appears.
  2. Choose or type a value and press (Enter).

- To set the number of divisions for the cylinders:
  1. Choose Divisions from the Vert. Cyls. menu. A list of values appears. This setting is the same as Prim. Divs. in the 3D Menus/Settings menu.
  2. Choose or type a value and press (Enter).

The 3D Views option is a shortcut to the 3D Views menu. See the “Viewing Your Model” chapter for more information about the 3D Views menu.

---

**Figure 21.5:** Vertical columns
• Reorient the view to draw a vertical cylinder and use the 3D Curves menu to set the portion of the cylinder needed
• Stay with horizontal cylinders and explicitly specify sweep angles for the cylinder
4. Select two points to represent the end points of the cylinder.

To create a cylinder section that covers from the 10:00 position to the 2:00 position on a clock, decide which way you want to draw the cylinder across the screen. You can draw it from top to bottom or bottom to top. When drawing from top to bottom, remember that cylinders are drawn counterclockwise.

Figure 21.6: Horizontal cylinder

➢ To specify the beginning angle of the cylinder sweep angle:
  2. Choose or type a beginning sweep angle and press (Enter).

➢ To specify the ending sweep angle of the cylinder sweep angle:
  2. Choose or type an ending sweep angle and press (Enter).
To control the radius of the cylinder:
2. Choose or type a radius value and press (Enter).

To draw a full and complete cylinder:
2. Select the center point of one end of the cylinder.
3. Select the center point of the other end of the cylinder.

To draw the top half of a cylinder using a preset pair of sweep angles (much like a speed bump):
2. Select the center point of one end of the cylinder.
3. Select the center point of the other end of the cylinder.

To draw the bottom half of a cylinder using a preset pair of sweep angles (much like a trough):
2. Select the center point of one end of the cylinder.
3. Select the center point of the other end of the cylinder.

To draw half of a cylinder using a preset pair of sweep angles:
2. Select the center point of one end of the cylinder.
3. Select the center point of the other end of the cylinder. When the two points used to define the cylinder are drawn from the top to the bottom of the screen, the resulting half-cylinder appears on the left.

Use Closed to create a closed cylinder for hidden line removals. The cylinder is processed as a solid element when Closed is on.

Use the Z-Base toggle to set the centerline of the cylinder to lie at Z-base. If you draw a full circle cylinder, half of the cylinder lies above Z-base and half lies below. Similarly, the Z-Height toggle sets the centerline of the cylinder to lie at Z-height. If you draw a full circle cylinder, half of the cylinder lies above Z-height and half lies below.

- To set the number of divisions for the cylinders:
  1. Choose Divisions from the Horiz. Cyls. menu. A list of values appears. This setting is the same as Prim. Divs. in the 3D Menus/Settings menu.
  2. Choose or type a value for the number of cylinder divisions and press (Enter).

3D Views accesses the 3D Views menu. See the “Viewing Your Model” chapter for more information about the 3D Views menu.

**Drawing Cones and Truncated Cones**

Cones are entities that are not used often in architectural modeling, but they are sometimes seen in spires and pylons. You can create cones by drawing the base of the cone (at Z-base) using the standard 3D Curves menu and placing the vertex of the cone at Z-height. DataCAD automatically places the vertex, thus creating a right cylinder, or you can place the vertex yourself, creating a skewed cylinder.

- To draw a cone:
  1. Choose Cones from the 3D Entity menu.
  2. Choose Auto Height to automatically place the vertex of the cone at Z-Height, centered over the center point of the base. Otherwise, you will have to manually place the vertex.
  3. Use Divisions to set the number of divisions for the cone. (This setting is the same as the Prim. Divs. setting of the 3D Menus/Settings menu.) To set the divisions of a cone, choose Divisions from the Cones menu; then choose or type a value for the number of divisions and press (Enter).
  4. Toggle Closed on to close the bottom of the cone, creating a solid base. This base won’t be visible unless you perform a hidden line removal or shade the image.
  5. Draw the footprint (sweep angle) of the cone. The base of the cone is always drawn at Z-base and the vertex is always drawn at Z-height. See “Drawing 3D Arches” earlier in this chapter for more information about drawing the footprints of the cone or on using 2 Pt. Arc, 3 Pt. Arc, Tangent, Dog-leg, Radius Circ., Dia. Circ., 3 Pt. Circ., Clockwise, and Closed.
  6. Place the vertex of the cone if you toggled Auto Height off. If you place the vertex to one side, you create a skewed cone.
Figure 21.8: Cones


Truncated cones have sheared off tops. Creating a truncated cone is similar to creating a regular cone, except you must also specify the diameter of the top opening of the truncated cone.

⇒ To draw a truncated cone:
1. Choose Trunc. Cones from the 3D Entity menu.
2. Set the Z-base and Z-height appropriately. As with regular cones, you draw truncated cones from Z-base to Z-height.
3. Toggle Closed on to close the bottom and top of the cone, creating a solid base and top. This solid base and top won’t be visible unless you perform a hidden line removal or shade the image.
4. Choose the footprint (sweep angle) of the truncated cone by drawing one of the 3D arcs.
5. Determine whether Auto Height is toggled on or off. If Auto Height is toggled on, DataCAD prompts you for the diameter of the top part of the truncated cone. If Auto Height is toggled off, DataCAD prompts you for the center point of the top circle, and then the radius.

Figure 21.9: Truncated cones

The 3D Views option is a shortcut to the 3D Views menu. See the "Viewing Your Model" chapter for more information about the 3D Views menu.
Drawing Double-Curved Entities

Unlike their 2D counterparts, all curved 3D entities in DataCAD are actually drawn using a number of short line segments to approximate true curves.

Some 3D entities, such as cylinders, 3D arcs, cones, and truncated cones, only curve in one direction, around the entity’s center point or central axis. See “Drawing Single-Curved Entities” for more information on drawing entities with only primary divisions.

Entities that curve in more than one direction, such as domes and spheres, tori, surfaces of revolution, and mesh surfaces, have both primary and secondary division settings. Primary divisions are the number of curve divisions in the plane of the screen, also known as the sweep angle. Secondary divisions are those divisions that affect curves that bulge into or out of the plane of the screen; these are known as rise or roll angles.

In this chapter:
- Drawing domes and spheres
- Drawing tori
- Drawing surfaces of revolution
- Drawing mesh surfaces
**Drawing Spheres and Domes**

Spheres are any full sphere or section of a sphere. The menu combines features from both the vertical and horizontal cylinder menus as well as the 3D arcs menu. See “Drawing 3D Arcs,” “Drawing Vertical Cylinders,” and “Drawing Horizontal Cylinders” in the “Drawing Single-Curved Entities” chapter for more information.

➔ To draw a sphere:

1. Choose Spheres from the 3D Entity menu.
3. Set the rise angles with Start Angle or End Angle or use one of the presets: Full Circle, Top Half, or Bottom Half. This determines exactly how much of the sphere curves out of the plane of the screen.
4. Set the Z-Base or Z-Height properly to set the location of the sphere. The sphere is drawn with its center point at either Z-base or Z-height, depending on which is toggled on.
5. Draw the footprint with 3D curves options. DataCAD generates the dome from the footprint and the rise angles you supplied.

![Figure 22.1: Spheres](image)

For more control over the portion of the sphere that appears, you can specify rise angles. A *rise angle* describes the angle by which something tilts out of the plane of the screen. Something that lies exactly in the plane of the screen has a rise angle of 0°; something that extends straight out of the screen has a rise angle of 90°.
To set the beginning rise angle for the sphere:
1. Choose Start Angle from the Spheres menu. A list of beginning rise angles appears.
2. Choose or type a beginning rise angle and press (Enter).

To set the ending rise angle for the sphere:
1. Choose End Angle from the Spheres menu. A list of ending rise angles appears.
2. Choose or type an ending rise angle and press (Enter). When setting the rise angles for the beginning and end of the sphere, remember that spheres are drawn counterclockwise.

Use Full Circle to create a sphere section encompassing both the north and south hemispheres. Use Top Half to create a sphere section with just the northern hemisphere. Use Bottom Half to create a sphere section with just the southern hemisphere. Use Z-Base to set the center of the sphere at the Z-base. Use Z-Height to set the center of the sphere at the Z-height.

To set the primary (sweep) divisions of the dome:
1. Choose Prim. Divs. from the Spheres menu. A list of values appears.
2. Choose or type a value for the number of primary divisions and press (Enter).

To set the secondary (roll) divisions of the dome:
2. Choose or type a value for the number of secondary divisions and press (Enter).

Figure 22.2: Primary and secondary divisions
### Drawing Tori

A torus is a donut-shaped entity. Full tori are obviously very rare in architectural modeling, but sections of tori are fairly common. Typical applications include turns in railings, elbow connectors in pipes, and even children’s playground slides.

⇒ To draw a torus:

1. Choose Tori from the 3D Entity menu.
3. Set the roll angles for the tube part of the torus with Start Angle or End Angle. To use one of the preset angles, click on Presets in the Tori menu and choose Full Circle, Top Half, Bottom Half, In Half, or Out Half; then right-click to return to the main Tori menu.
4. Choose Z-Base or Z-Height. Center the torus at either the Z-base or the Z-height, respectively.
5. Draw the 3D curves footprint of the torus. The torus (or toroidal section) is calculated from the footprint and the roll angles.

For more control over how far the torus sweeps out of the plane of the sphere, you can specify roll angles. A roll angle describes the angle by which something tilts out of the plane of the screen. Something that lies exactly in the plane of the screen has a roll angle of 0°; something that comes straight out of the screen has a roll angle of 90°.

⇒ To set the beginning roll angle for the torus:

1. Choose Start Angle from the Tori menu. A list of beginning roll angle values appears.
2. Choose or type a beginning roll angle and press (Enter).

⇒ To set the ending roll angle for the torus:

1. Choose End Angle from the Tori menu. A list of ending roll angle values appears.
2. Choose or type an ending roll angle and press (Enter). When setting the roll angles, remember that tori are drawn counterclockwise as seen in a front elevation.

You can also use these preset options (available when you select Presets from the Tori menu) to set the most common roll angles:

- **Full Circle**: Creates a full inner-tube torus section
- **Top Half**: Creates a torus section using only the top part of the torus roll
- **Bottom Half**: Creates a torus section using only the bottom part of the torus roll
- **In Half**: Creates a torus using only the inside part of the torus roll
- **Out Half**: Creates a torus using only the outside part of the torus roll

⇒ To indicate the radius of the tube section of the torus (not the radius of the torus itself):

1. Choose Radius from the Tori menu. A list of radius values appears.
2. Choose or type a radius value and press (Enter).
To set the primary (planar) divisions of the torus:
1. Choose Prim. Divs. from the Tori menu. A list of values appears.
2. Choose or type a value for the number of primary divisions and press (Enter).

To set the secondary (roll) divisions of the torus:
1. Choose Sec. Divs. from the Tori menu. A list of values appears.
2. Choose or type a value for the number of secondary divisions and press (Enter).

Figure 22.3: Torus connecting two cylinders

**Drawing Surfaces of Revolution**
Use Rev. Surface to create 3D solids with radial symmetry. Columns, lampshades, fountains, and canopies are all examples of objects with radial symmetry that you can model using Rev. Surface.

Surfaces of revolution are so named because of the way you construct them: a polyline profile revolved around an axis of revolution. As the profile revolves around a given axis, it “sweeps out” a surface in its wake. This surface is the surface of revolution. To create any surface of revolution, you must determine what profile and axis combination generates the surface you want.

Surfaces of revolution are single entities. To modify or edit a surface of revolution, you can explode it and stretch it; alternatively, you can enlarge it to create complex shapes. If you’re trying to model a shape that doesn’t have radial symmetry, but is close, try starting with a surface of revolution. Then through enlargements, explosions, and stretches, shape the solid into the form you need.
To draw a surface of revolution:

1. Choose Rev. Surface from the 3D Entity menu.

2. Draw or select the profile to rotate. Create the cross section of the object as a polyline. If you already have a polyline, you can use Select to select the polyline. You can use Backup and Cancel to create polylines.


4. Set the rise angles for the surface of revolution:
   
   - **Start Angle**: Sets the beginning rise angle on the surface of revolution
   - **End Angle**: Sets the ending rise angle on the surface of revolution
   - **Full Circle**: Sets the rise angle to rotate the profile 360° around, thus creating a full solid
   - **Top Half**: Sets the rise angle to rotate the profile 180° out of the screen, creating just the top half of a full surface of revolution
   - **Bottom Half**: Sets the rise angle to rotate the profile 180° into of the screen, creating just the bottom half of a full surface of revolution
   - **Side Half**: Sets the rise angle to rotate the profile 180° into and out of the screen, on whatever side the contour appears, creating half of a full surface of revolution

5. Choose a surface of revolution:
   
   - **Open**: With open ends and sides; no surfaces are generated for these parts of the surface of revolution
   - **Close Side**: With closed sides; sides are inside surfaces, the part of the surface of revolution you see if you stand on the axis of revolution and look outward toward the profile or if you stand outside the surface and look inward toward the axis
   - **Close End**: With closed ends; ends refer to the top and bottom, the part of the surface of revolution you see if you look along the axis of revolution

6. Choose Prim. Divs. to set the number of circular divisions along the roll of the surface of revolution (the surfaces which curve out of or into the plane of the screen, which rotate around the X or Y screen axes. Select Prim. Divs. from the Rev. Surface menu, choose or type a value for the number circular divisions along the roll, and press (Enter).
7. Choose Sec. Divs. to set the number of circular divisions along the sweep of the surface of revolution (the surfaces that show curvature in the plane of the screen, which rotate around the Z screen axis). Select Sec. Divs. from the Rev. Surface menu, choose or type a value for the number of circular divisions along the sweep, and press (Enter).

8. Choose Z-Base or Z-Height to create a surface of revolution whose axis of revolution is at the Z-base or Z-height, respectively.

9. Choose Exit when you are done with the polyline cross section.

10. Select two points for the axis of revolution. The action here is to spin the polyline profile around the axis of revolution, sweeping out a solid in the process.
**Drawing Mesh Surfaces**

*mesh surface* is a smooth patch that you can mold into a variety of useful shapes including free-form built structures, tents, and canopies. Mesh surfaces are the surface equivalents of Bezier curves.

Like contours, mesh surfaces are created through a series of control points that you specify. The greater the variation in the elevation of these control points, the more dramatic the curves in the surface.

There are always exactly 16 control points to specify for a mesh surface, and these 16 control points always form a 4x4 grid of points, although the spacing of these points may not be uniform.

---

*Figure 22.6: Selecting the axis of revolution*

*Figure 22.7: Mesh surfaces*
• Specify all 16 control points individually, as four rows, with four points per row. The first control point is numbered \([1,1]\), meaning row 1, column 1 in the grid of points. The second control point is numbered \([1,2]\), then \([1,3]\) followed by \([1,4]\), then \([2,1]\), etc. You can change the Z-base or Z-height at any time during the entry of control points, thus creating a surface that curves into and out of the screen. The resulting surface is a Bezier-like curved sheet that curves into and out of the screen.

• Draw a rubber band box that forms the outer boundary of the mesh surface. The 16 control points are equally spaced in this box. The resulting surface is a flat sheet.

• Place four points in the drawing that represent the four rows of a rectangular sheet surface that go into the screen.

➢ To manually draw a mesh surface:

1. Choose Mesh Surface from the 3D Entity menu.
2. Select the Z elevation of the first control point \([1,1]\).
3. Select the first control point.
4. Repeat steps 2 and 3 until you enter all 16 control points.

![Figure 22.8: Mesh grid and its corresponding control points](image)

➢ To create a rectangular mesh surface:

2. Select one corner of a rubber band box to contain the mesh surface.
3. Select the opposite corner of the rectangular region. The 16 control points are automatically placed within the boundary rectangle, all at the same elevation and an equal distance apart. To create a rolling surface, take an elevation view and use the stretch command to move the control points.
To create a vertical mesh surface from Z-base to Z-height:

2. Select four points across the screen. DataCAD generates a mesh surface that runs from Z-base to Z-height that fits the control points. For each control point you select on the screen, DataCAD generates four points: one at Z-base at that location, one at Z-height, and two more, equally spaced between these extremes.

To set the number of columns (divisions in the surface in direction 1):

1. Choose Divs. Dir. 1 from the Mesh Surface menu. A list of surface division values appears.
2. Choose or type a value for the number of surface divisions in Direction 1 and press (Enter).

To set the number of rows (divisions in the surface in direction 2):

1. Choose Divs. Dir. 2 from the Mesh Surface menu. A list of surface division values appears.
2. Choose or type a value for the number of surface division in Direction 2 and press (Enter).

Use Disp. Points to display the control points for the surface. When you edit a mesh surface, toggle Disp. Points on. Toggle Disp. Points off for presentations.
Use Display Grid to connect the surface’s control points with lines. Toggle Display Grid off for presentations.

As with Contours, you can specify an increment distance to add or subtract to the base elevation as you enter control points. Set Index sets the index; Add Index and Sub. Index determine whether you add to or subtract from the current Z elevation value. See “Drawing Topographical Maps with Contours” in the “Site Modeling” chapter for more information about contours.

➢ To specify and increment distance:

1. Choose Set Index from the Mesh Surface menu. A list of distance values appears.
2. Choose or type an increment distance and press (Enter).

These are the four standard elevations at which you can enter a mesh surface control point. Use all four to create a mesh surface with varying Z elevations. Use Add Index or Sub. Index to change these values.

➢ To set the values for Z-User 1 and Z-User 2:

1. Choose one of these elevation options from the Mesh Surface menu. A list of elevation values appears.
2. Choose or type an elevation value and press (Enter).
Site Modeling

DataCAD has a tool you can use for site modeling: the Drop Mesh tool. The Drop Mesh tool creates a triangulated regular network (TRN) of 3D polygons and is an averaged representation of data points. Drop Mesh produces a "clean," rectilinear result, which may be desirable when accuracy is less of a concern than the visual representation.

Contours are curved 3D lines drawn through points that you enter. These are particularly useful for drawing topographical maps.

As with most tools in DataCAD, the Drop Mesh can be used to create not only site models but also any surface in your model. Contours can be used in other drawing situations as well.

In this chapter:
- Using the drop mesh
- Using contours to create topographical maps
Site Modeling with Drop Mesh

One option in the 3D Entity/Polygons menu is Drop Mesh. It creates a regular, triangulated, polygon mesh that lays over selected geometry or points, which can be created from a survey data file. This mesh can then be shaded or processed through a hidden line removal to provide a model of the building site.

A drop mesh is a group of triangulated polygons, not a single entity; thus, it can increase your drawing file size substantially. A mesh with 100 X divisions and 100 Y divisions will add 20,000 polygons to your drawing (X divisions x Y divisions x 2 polygons per grid division, or 100x100x2), increasing your drawing file by 3MB. Additionally, since entities are not deleted from the drawing database even after you delete them from the drawing itself, your drawing file size can increase rapidly if you add a drop mesh, delete it, add another one, and so on. To remove unused entities from the drawing database, use Manage in the Edit/Layers menu or select Layer Manager from the Tools pull-down menu. DataCAD recommends that you only use as many divisions as is necessary for a reasonably accurate model.

A drop mesh acts like a cloth dropped over the geometry. The way it drapes over the geometry can be adjusted with the Divisions-X, Divisions-Y, Stiffness, Smooth, and Smooth Pass options. The mesh is made up of a grid of polygon divisions, with lines running in both the X and Y directions. These divisions are set with the Divisions-X and Divisions-Y options; increasing these values adds flexibility to the mesh. Smooth adds points between the geometry to flatten the surface. Smooth Pass increases the number of smoothing passes. Stiffness controls how closely the mesh coincides with the actual geometry; in other words, the lower the stiffness setting, the more tightly it fits to the geometry.

To drop a mesh:

1. Choose Drop Mesh from the 3D Entity/Polygons menu. Notice that the current settings appear in the Attention toolbar.

2. Click on Options. The Drop Mesh dialog box appears.

![Drop Mesh dialog box]

**Figure 23.1:** The Drop Mesh dialog box

3. Choose Divisions-X and Divisions-Y to set the number of X and Y divisions in the mesh grid.

4. Choose Stiffness to set the stiffness of the mesh. Enter a number from 1 through 10, where 1 is the stiffest, and press (Enter). The default setting is 5.
5. Choose Smoothing to toggle on smoothing. This setting will have no effect on points created from an imported survey data file; it only works with vector geometry. Use of this option increases the time it takes DataCAD to generate the mesh.

6. Determine if Smoothing is toggled on. If Smoothing is toggled on, the Smooth Pass option becomes available on the Drop Mesh menu. Choose Smooth Pass to set the number of smoothing passes. Enter a number from 1 through 10, where 1 is the minimum number of passes; 1 is the default setting.

7. Toggle Drop Edge on to model the site edges. When Drop Edge is toggled on, Edge Height becomes available on the menu. Choose Edge Height to set the distance below the lowest, calculated point of the site model. The default edge height is 10 feet.

8. Toggle Show Diagonals on if you want to display the diagonal polygon edges of the mesh.

9. Drop a mesh over either selected geometry or imported, survey points. To drop a mesh over existing geometry, use the selection menu at the top of the Drop Mesh menu to select geometry in your drawing. You can select all of the geometry or only a portion of it. When selection is complete, continue with step 10. You can choose Clear at any time to cancel your selections. To use survey data instead, skip to step 10. You can drop a mesh over any geometry in the drawing except geometric primitives, such as spheres, cones, or cylinders. To drop a mesh over geometric primitives, you must first explode the entities.

10. Make sure survey data is in a text file formatted in columns. You must use one of five data formats, including X-Y-Z, Y-X-Z, Horizontal Angle-Distance-Height (HorizAng-Dis-Hght), Distance-Horizontal Angle-Height (Dist-HorizAng-Hght), and Horizontal Angle-Vertical Angle-Distance-Elevation (HorizAng-VertAng-Dist-Elev). To import one of these files, choose Import from the Drop Mesh menu. The Points File Settings dialog box appears.

![Figure 23.2: The Points File Settings dialog box](image)

11. Set the scale for the data of the imported file in the Size of Points File Units input field. Select one data format from the File DataType portion. Also select the Horizontal Angles and Vertical Angles options. Click on Continue. The Open dialog box appears.
12. Select the file you want to use and press (Enter) or click on Open. Points based on the survey data appear in the Drawing Window.

13. Choose Begin from the Drop Mesh menu to begin drawing the drop mesh. Press End to cancel the mesh at any time.
The following series of figures demonstrate the effect that the divisions, stiffness, and smoothing options have on a drop mesh.

Figure 23.3: Site plan drawn using contours

Figure 23.4: Isometric view of contour line drawing.
Figure 23.5A: Model using 16 x 30 divisions, a stiffness setting of 5, and Smooth toggled off. The isometric view to the right shows the results of these drop mesh settings. As you can see above, the mesh (represented by the gray line) does not always meet the points on the contour lines (represented by the darker line and dots). The result is a rougher approximation of the contour geometry.

Figure 23.6A: Divisions are increased to 32 x 60, while the stiffness and smooth settings remain the same. A higher resolution mesh produces a stair-step effect with this stiffness setting.
Figure 23.5B: Isometric view of model using 16 x 30 divisions with stiffness set to 5 and Smooth toggled off.

Figure 23.6B: Isometric view of model with divisions increased to 32 x 60.
Figure 23.5A: Divisions remain at 32 x 60 with Smooth toggled off, but stiffness is increased to 9. The stiffness is adjusted to counter the stair-stepping effect, resulting in a closer relationship to the contour points.

Figure 23.6A: Another way to smooth the drop mesh is to use the Smooth option. Here the divisions and stiffness have been reduced to their original values of 16 x 30 and 5, respectively. However, Smooth has been toggled on and SmthPass has been set to 5. The interpolation of the smoothing operation creates smoother transitions between contour points.
**Drawing Topographical Maps with Contours**

*Contours* are curved versions of 3D lines; like 3D lines, they have no thickness. Use contours to create topographical maps.

Creating contours is similar to creating Bezier or B-spline curves. You place a number of control points that define the curve. DataCAD accepts up to 36 control points. Unlike Bezier or B-spline curves, the contour curve that DataCAD generates passes through the points that you draw.

→ To draw a contour:

1. Choose Contours from the 3D Entity menu. The Contours menu appears.

2. Choose the type of contour you want to draw: Natural, Cyclic, or Tangent. Natural creates a contour that begins at the first control point you select and ends at the last point. Cyclic creates a contour that connects the first and last control points with a smooth curve, making a closed shape. Tangent creates a contour that connects two additional points to the control points, making a tangency at the end of the contour.

3. Use the Stiffness option to determine the curvature as the contour passes through each control point. A high stiffness forces the contour to remain flat as it passes through each point. To set a stiffness for the contour, choose Stiffness from the Contours menu and choose or type a stiffness value and press (Enter).
4. Choose Divisions and enter a value to indicate the number of line segments you want to use in between each control point. The further apart your control points, the more divisions you need. If you set too many divisions, your display regeneration time slows.

5. Choose the elevation at which you want to draw this contour. Z-Base, Z-User 1, Z-User 2, and Z-Height are the four standard elevations at which you can enter a contour control point. You can use Add Index or Sub. Index to alter these values. To set the Z elevations, Z-User 1 and Z-User 2, choose one of these elevation options from the Contours menu, choose or type an elevation value, and press (Enter).

6. Determine if you are working with tangent contours. Only with tangent contours, select a first tangent point, the point before the curve. This point determines the direction of the curve as it enters the first control point.

7. Select the control points. You can choose up to 36 control points for any one contour. You may select Add Index or Sub. Index to enter the next control point at a new elevation. Choose Add Index to add the value of the Index setting to the current Z elevation value. Choose Sub. Index to subtract the value of the Index setting from the current Z elevation value.

   - If you are working with tangent contours, specify the ending tangent point. This is the point after the curve. It determines the direction that the curve heads as it enters the last control point.

Figure 23.7: Types of contours (Natural, Cyclic, and Tangent respectively)

Use 3D Cursor to attach a control point to a particular point on your model (vertex of a slab, center of a sphere, etc.) by snapping in world coordinates with the 3D cursor.

You can force the contour to lie in a plane by specifying that the control points have a fixed Z elevation. Use the Z-Base, Z-Height, Z-User 1, or Z-User 2 toggles to set the height.

Use Set Index to help create a single contour that rises steadily in the Z direction. For example, to create a series of concentric contours set at 10' intervals, use Set Index to set the index to 10'. After drawing the first contour at Z-base, select Add Index and draw the second contour, which would be entered into the drawing 10' higher than the first, and so on.

→ To draw a contour that steadily rises:

1. Choose Set Index from the Contours menu. A list of index distance values appears.
2. Choose or type an index distance and press (Enter).
Editing 3D Entities

The 3D Menus menu looks similar to its 2D counterpart and, in most cases, works the same way. In fact, the Erase, Layers, and Identify options in 3D Menus are actually shortcuts to those menus in the (2D) Edit menu. However, keep in mind that the 3D Menu options should only be used on 3D entities, unless otherwise noted. See the “Rules for Editing 3D Entities” section in this chapter for details.

Perhaps one of the most useful features of 3D entities is that you can edit them in any plan or parallel view. The 3D Menus work closely with the 3D Views menu; all 3D Menus submenus have a 3D Views option, which takes you immediately to the 3D Views menu. In addition, to help you move quickly from menu to menu, 3D Menus also includes shortcuts to the Edit menu and the 3D Entity menu.

In this chapter:
- Rules for editing 3D entities
- Moving, copying, rotating, stretching, mirroring, and enlarging 3D entities
- Exploding 3D entities
- Modifying 3D entity attributes
Rules for Editing 3D Entities

Keep in mind the following when editing 3D entities:

- **You can’t erase edges.** The lines that make up a 3D entity represent the edges of a single entity; they are not an entity themselves. If you try to erase one edge of a slab, for instance, the entire slab is deleted.

- **Edit 2D entities with 2D editing options only.** The Edit menu contains the 2D editing tools you’ll need to edit 2D entities. However, the Erase, Change, and Explode options in the 3D Menus can also be used on 2D entities.

- **Many 2D editing options can be used on 3D entities.** For example, the Stretch option in 3D Menus can be used on a horizontal slab. However, keep in mind that most 2D editing options work only in plan view. When you select such an editing option, DataCAD automatically changes to plan view.

- **Edit in plan or parallel views only.** If your model is not being displayed in plan or parallel view and you select a 3D editing option, DataCAD automatically changes to the last plan or parallel view.

- **Select entities in any view.** However, when using Entity or Group in 3D selection menus, you can select entities according to the following rules:

<table>
<thead>
<tr>
<th>3D line</th>
<th>Anywhere on the line</th>
</tr>
</thead>
<tbody>
<tr>
<td>Polygon</td>
<td>Any displayed edge (including the edges of voids)</td>
</tr>
<tr>
<td>Slab</td>
<td>Any displayed edge (including the edges of voids)</td>
</tr>
<tr>
<td>Block</td>
<td>Any displayed edge</td>
</tr>
<tr>
<td>3D arc</td>
<td>The arc’s center marker</td>
</tr>
<tr>
<td>Cylinder</td>
<td>Any of the three center axis markers</td>
</tr>
<tr>
<td>Cone</td>
<td>Any of the three center axis markers</td>
</tr>
<tr>
<td>Truncated cone</td>
<td>Any of the three center axis markers</td>
</tr>
<tr>
<td>Sphere</td>
<td>The center marker</td>
</tr>
<tr>
<td>Torus</td>
<td>The center marker of the sweep or the center markers at the beginning and end of the roll</td>
</tr>
<tr>
<td>Contour</td>
<td>Any control point (you can’t select the curve itself)</td>
</tr>
<tr>
<td>Mesh surface</td>
<td>Any displayed edge of the control grid or any of the displayed control points (you can’t select the surface itself)</td>
</tr>
<tr>
<td>Surface of Rev.</td>
<td>Any control point</td>
</tr>
<tr>
<td>Symbol</td>
<td>The insertion point</td>
</tr>
</tbody>
</table>

With Fast 3D Snap toggled off (3D Menus/Settings menu), you can select any circular division of a 3D arc, cone, truncated cone, sphere, or torus; you can also select any edge of a single-curved facet of a surface of revolution, but not an edge of a double-curved facet. With both Fast 3D Snap and Fast 3D (Utility/Object Snap menu) toggled off, you can select any displayed edge of a symbol, according to the rules for each entity in that symbol.

Moving 3D Entities

Use Move in 3D Menus to shift an entity to a different position on the screen. 3D Move works the same as the 2D Move option, with the exception of the following:

- **When specifying the two points of the distance to move, the model can be in any parallel or orthographic view.** DataCAD draws specific distances across the screen, but the distance and direction is taken with respect to the model in the current view. For example, if you view the model in an elevation view and specify a distance and angle to move (such as 10’ at 90°), objects that you select move up, off the ground plane.
• The model displays in any view during the process of selecting entities to move. This makes the precise selection of individual entities or collections of entities easier, especially in cases where entities are stacked one upon another or when it is difficult to separate one entity from another.

![Diagram of 3D movement](image)

**Figure 24.1:** Using the 3D Move option

Choose 3D Cursor from the Move menu to toggle on the world snapping cursor. The world cursor lets you snap directly to the objects in the model rather than to their projections on the screen. See “All About 3D Snapping” in the “Modeling Basics” chapter for more information on the world snapping cursor.

⇒ To move an entity:

1. Choose Move from 3D Menus.

2. Toggle And Copy on to copy the entity at the same time you move it. If you toggle And Copy off, the entities move to the new location but do not copy.

3. Select the first point of the distance to move.

4. Select the second point of the distance to move.

5. Choose Z Distance to move the entity in the Z-direction relative to the plane on the screen. Positive distances indicate movement out of the screen; negative distances indicate movement into the screen. You can also use Z-Only to set the move distance to zero (0) in the X and Y directions. Then select the entities to move. Entities move relative to the screen Z-axis. DataCAD resets the Z-distance to zero each time you choose Move from 3D Menus.

6. Choose a selection method and select the objects to move. Use the 3D Views menu to reorient your view to get the best vantage point for selecting objects. DataCAD moves the selected entities relative to the plane of the screen.

7. Choose Invert if you make a mistake and select the wrong entity to move; then, reselect the moved entity. The entity returns to its original position.

You can also use Prev. Dist. to use the last distance and direction specified in an editing option. You can choose this option instead of specifying two points of the distance to move. Or use New Distance to enter a new move distance. This does not change the Z distance. New Distance only appears after you’ve entered a move distance.

⇒ To move an entity to another layer in your drawing file:

1. Choose To Layer from the Move menu.

2. Choose a layer from the list or use Match or Filter to indicate the layer to move to. See the instructions below to use Match and Filter.

3. Choose a selection method and select the entity or entities to move.
Use Match to select a layer by selecting an entity on that layer. Set the active layer, move objects to another layer, or point DataCAD to a specific layer, all without having to remember layer names.

➔ To move entities to another layer using Match:

1. Select To Layer from the Move menu. You are prompted to Select layer to move to.
2. Choose Match from the To Layer menu. You are prompted to Select entity to match. Use Match with any of the following Layers options: On/Off; Set Active; Active Only; Lock; Name; Clear Layer; Delete Layer; Export Layer; View Layer, Select. It is also available when using To Layer under Move and Copy or when using Layer Search.
3. Select an entity to select the layer it is on. You are prompted to Select entity to move.
4. Select the entity you want to move to the selected layer. The entity is moved to the selected layer.

Use the Filter toggle to scan or filter for layers with similar names. When you specify a prefix or suffix that the filter searches for, a list of layers with that affix appears. To access a layer that you don’t know the name of, use Filter to search for layers with a similar affix.

For example, if you specify layers by plumbing and electrical, you might have layers named 1FPLUMB.LYR, 2FPLUMB.LYR, 3FPLUMB.LYR, and 1FLELECT.LYR, 2FLELECT.LYR, 3FLELECT.LYR. To search for a plumbing layer, use ???plumb. You can search for first floor layers using a prefix of 1fl: 1fl* or 1fl?????.

Use the asterisk (*) in place of any number of characters and the question mark (?) in place of each character you’re unsure of.

The Filter toggle only appears when you are prompted to select from the list of layers. The filter disregards any characters following an asterisk. Therefore, if you entered *plumb to search for plumbing layers, all layer names would be displayed.

➔ To filter layers:

1. Choose Filter from the To Layer menu to toggle Filter on.
2. Type the affix, including the wildcard character(s), for the layer you want to find and press (Enter). A list of layer files with this affix appears.
   
   DataCAD also allows you to scroll through different layer groups with similar affixes. If the group you initially searched for doesn’t contain the layer you wanted, you can scroll through the remaining groups to find the appropriate layer.
   
   Filter Back Scrolls back to a group of similarly named layers.
   Filter Fwd Scrolls forward to a group of similarly named layers.
3. Choose the layers you want to use.

DataCAD remembers the last affix for which you filtered. The prefix name appears in the Message Window and the layer names appear in the Menu Window when you re-enter the Filter function.

**Copying 3D Entities**

The 3D Copy option works identically to the 2D Copy option: specify the distance to copy from any parallel or orthographic view, and then select the objects to copy in any view.

➔ To copy 3D entities:

1. Choose Copy from 3D Menus.
2. Enter the first point of the distance to copy.
3. Enter the second point of the distance to copy.
4. Select the objects to copy using the Selection Menu. You can use the 3D Viewer to reorient your view and get the best vantage point for selecting the objects. DataCAD copies the selected entities relative to the plane of the screen.

**Rectangular Arrays**

Use Rect. Array to create three-dimensional rectangular arrays of 3D entities at any orientation in space. This option works like the 2D rectangular array option, except that you can copy objects in the X, Y, and Z directions simultaneously, each with its own spacing and number of repetitions.

➔ To create a rectangular array:

1. Choose Copy from 3D Menus.
2. Choose Rect. Array from the Copy menu.
3. Set the Z distance to copy if you are creating an array of more than one element in the Z direction.
4. Select the first point of the distance to copy each element of the array.
5. Select the second point of the distance to copy each element of the array.
6. Type the number of repetitions in the array in the X direction, Y direction, and Z direction, pressing (Enter) after each value entered.
7. Choose a selection method and select the objects to copy in the rectangular array. You can use the 3D Views menu to reorient your view to get the best vantage point in selecting objects.

**Figure 24.2:** Original object to copy

**Figure 24.3:** Resulting array
Choose 3D Cursor to toggle on the world snapping cursor. The world cursor lets you snap directly to the objects in the model rather than to their projections on the screen. See “All About 3D Snapping” in the “Modeling Basics” chapter for more information.

**Rotating 3D Entities**

Like all 3D editing options, you can use the Rotate option in any parallel or orthographic view. Choose the center of rotation, and then select the objects to rotate. You can rotate the objects in any order.

➤ To rotate a 3D entity:
1. Choose Rotate from 3D Menus.
2. Choose And Copy to copy the entities at the same time you rotate them. To rotate entities without copying them, leave And Copy toggled off.
3. Select a point that defines the center of rotation relative to the plane of the screen. If you want the Z-coordinate of the center of rotation to be something other than zero, use Center Z to enter the Z-coordinate. See the instructions below to set the Z-coordinate. You can use New Center to re-enter the center of rotation relative to the current plane of the screen. This option does not change the Z-coordinate of the center of rotation. New Center only appears after you choose a center of rotation.
4. Choose which of the three axes (X, Y, or Z) you wish to rotate around, relative to the screen. Use X-Axis to rotate selected entities about an axis parallel to the X axis of the screen and passing through the center of rotation. Use Y-Axis to rotate selected entities about an axis parallel to the Y axis of the screen and passing through the center of rotation. Use Z-Axis to rotate selected entities about an axis parallel to the Z axis of the screen and passing through the center of rotation.
5. Choose X Angle, Y Angle, or Z Angle to set the angle at which entities rotate around the X, Y, and Z axis, respectively, relative to the plane of the screen at the time the center of rotation is specified. The option you choose should match the axis that you selected in step 3. Use X Angle, Y Angle, and Z Angle from the Rotate menu, then choose or type a value, and press (Enter).
6. Choose a selection method and select the objects that you want to rotate. You can use the 3D Viewer to reorient your view to find the best vantage point in selecting objects.
7. Select Invert if you make a mistake and select the wrong entity to rotate. Then, reselect the entity. The entity returns to its original position.

➤ To set the Z-coordinate of the center of rotation relative to the plane of the screen:
1. Choose Center Z from the menu. A list of values appears.
2. Choose or type a value and press (Enter). DataCAD resets Center Z to zero each time you choose Rotate from 3D Menus.

**Mirroring 3D Entities**

Use Mirror to mirror entities about a plane in space. You can view a model from any angle in space; the mirror plane is always perpendicular to the screen.

You define the mirroring plane the same way as with the 2D Mirror option.

➤ To mirror a 3D entity:
1. Choose Mirror from 3D Menus.
2. Create the mirror line by responding to the prompts to Select first point of line about which to mirror and then Select second point of line about which to mirror. The mirror line appears.

3. Choose And Copy to copy entities at the same time you mirror them. To mirror entities without copying them, leave And Copy toggled off. You can use New Line to re-enter the mirroring plane perpendicular to the current plane of the screen. New Line only appears after you create a mirror line.

4. Choose a selection method and select the objects that you want to mirror. You can use the 3D Viewer to reorient your view to find the best vantage point for selecting objects.

**Stretching 3D Entities**

3D Stretch lets you stretch three-dimensional entities similarly to 2D Stretch. As with other 3D Entity menu options, you can specify the distance, direction, and entities to stretch from any parallel or orthographic (plan) view.

- Explode curved 3D entities into polygons or lines before stretching them. See “Exploding Entities” later in this chapter for instructions.
- Cylinders, 3D arcs, spheres, cones, truncated cones, and tori are nonstretchable entities. Use Enlarge to increase or decrease their size in one direction by an appropriate factor; alternatively, explode them into polygons and then stretch the polygons.
- 3D Stretch can only be used on 3D lines, polygons (and their voids, if any), blocks, slabs (and their voids, if any), contour curves, and mesh surfaces. You can use Stretch to edit polygons, slabs, and voids. You must define the distance to stretch in a plane parallel to the polygon or slab you want to stretch; otherwise, the resulting polygon or slab may become nonplanar. To make sure that the plane of the screen is parallel to the slab, you can use Plane Snap, Elevation/New Elev., or Edit Plane from the 3D Views menu.
- If the entity you select is contained completely within the limits of the selecting point, area, or fence, DataCAD moves the entity the distance you indicated to stretch.

→ To stretch a 3D entity:

1. Choose Stretch from 3D Menus. See the “Viewing Your Model” chapter for more information.
2. Select the first point of the distance to stretch.
3. Select the second point of the distance to stretch.
4. Choose Z Distance to enter a distance to stretch portions of entities in the Z direction relative to the plane of the screen. Positive distances indicate movement out of the screen; negative distances indicate movement into the screen. You can use New Distance to re-enter the distance to stretch in the X and Y directions. New Distance does not change the distance to stretch in the Z direction.
5. Use Prev. Dist. if you want to deal with the last X and Y distance and direction you specified in an editing option to stretch. You can use this option instead of specifying the distance to stretch in steps 2 and 3.
6. Choose a selection method and select the objects that you want to stretch. You can use the 3D Viewer to reorient your view to get the best vantage point for selecting objects.
7. Choose Invert if you make a mistake and select the wrong entity to stretch. Then, reselect the
stretched entity. The entity returns to its original size. DataCAD resets the Z distance to zero each
time you choose Stretch from 3D Menus. Choose Z-Only to set the stretch distance in the X and Y
directions to zero. Then select the entities to stretch.

**Enlarging 3D Entities**

Use Enlarge to enlarge or scale entities to different sizes in the X, Y, and Z directions. Enlarge works
similarly to its 2D counterpart, except that you can set the center of enlargement in any orthographic
(plan) or parallel view. You can also select entities you want to enlarge in any view or orientation once
you enter the center of enlargement.

כנו:

1. Choose Enlarge from 3D Menus.

2. Choose And Copy to copy entities at the same time you enlarge them. To enlarge entities without
copying them, leave And Copy toggled off. After you choose a center of rotation, you can use
New Center to re-enter the center of enlargement. This option does not change the Z coordinate
of the center of enlargement. To set the Z coordinate relative to the plane of the screen, choose
Center Z from the menu, then choose or type a value, and press (Enter).

3. Select a point that defines the center of enlargement relative to the plane of the screen.

4. Use X Enlargmnt., Y Enlargmnt., and Z Enlargmnt. to change the current value of the
enlargement factor in the X, Y, and Z directions of the screen, respectively. The enlargement factor
cannot be zero. Choose X Enlargmnt. from the menu, then choose or type a value, and press
(Enter). Use Reset to set all of the enlargement factors to 1.0. The 2.0x option sets all of the
enlargement factors to 2.0. The 0.5x option sets all of the enlargement factors to 0.5.

5. Choose a selection method and select the objects that you want to enlarge. You can use the 3D
Viewer to reorient your view to get the best vantage point for selecting objects.

6. Choose Invert if you make a mistake and select the wrong entity to enlarge. Then, reselect the
entity. The entity returns to its original size. DataCAD resets the Center Z to zero each time you
choose Enlarge from 3D Menus.

**Exploding 3D Entities**

Use Explode to separate 3D entities into their polygonal facets or into three-dimensional lines. After you
explode an entity into lines or polygons, it is not possible to reverse the operation and recreate the
original entity from these lines and polygons.

Explode can create a large amount of data in the drawing file. For example, take a single sphere with 20
divisions in the sweep direction (primary divisions) and 10 divisions in the rise direction (secondary
divisions). After an explode operation, this single sphere produces some 200 polygons, each of which
occupies approximately as much drawing storage space as did the original sphere. A mesh surface with
20 divisions in each direction would produce 800 polygons, which would collectively require 364 times as
much drawing storage space as the original mesh surface.

- Explode separates curved entities (cylinders, cones, truncated cones, tori, spheres, mesh surfaces, and
surfaces of revolution) into lines or polygons for subsequent editing operations (like stretch).
- You can explode a text entity into 3D lines that you can then rotate in space. The lines then respond to
a hidden line removal.
• Explode determines the validity of exploding entities. For example, if you select a contour curve to explode into polygons, DataCAD ignores the selection and does not explode the curve because it has no polygonal components.

⇒ To explode a 3D entity:
1. Choose Explode from 3D Menus.
2. Toggle To Lines on to explode entities into 3D lines; alternatively, toggle To Polygons on to explode entities into polygons.
3. Choose a selection method and select the objects that you want to explode. You can use the 3D Views menu to reorient your view to get the best vantage point in selecting objects.

Changing 3D Entities
3D Change lets you change the divisions of circular entities and the stiffness of contours as well as colors, line types, line overshoots, and more.

⇒ To change an attribute of a 3D entity:
1. Choose Change from 3D Menus.
2. Choose the option you want to change.
3. Choose or enter a new value; follow the prompts in the Message Window.
4. Choose Closed to indicate whether 3D arcs, cylinders, cones, and truncated cones are treated as closed solids or as open surfaces, then choose one of the following:
   - Yes 3D entities will be treated as closed shapes
   - No 3D entities will be treated as open shapes
5. Choose a selection method and select the objects that you want to change. You can use the 3D Views menu to reorient your view to get the best vantage point for selecting objects.

Use Prim. Divs. to change the number of segment divisions of circular entities. Prim. Divs. affects 3D arcs, cylinders, cones, truncated cones, spheres, tori, surfaces of revolution, contour curves, and mesh surfaces. For spheres, surfaces of revolution, and tori, Prim. Divs. affects only the number of segment divisions in the sweep direction (in the plane of the screen). For mesh surfaces, it affects only the number of segment divisions in the first direction. For contour curves, it affects the number of segment divisions between each control point of the curve.

Use Sec. Divs. to change the number of segment divisions of certain circular entities. This toggle affects only spheres, tori, surfaces of revolution, and mesh surfaces. For spheres and surfaces of revolution, it affects the number of segment divisions in the rise direction. For tori, it affects the number of segment divisions in the roll direction. For mesh surfaces, it affects the number of segment divisions in the second direction.

Use Stiffness to change the stiffness factor associated with contour curves. Stiffness affects only contour curves. The stiffness can be any number except zero.
Viewing Your Model

DataCAD gives you several ways to view your model to help you draw and create views for plotting or presentations. While there are many different kinds of views, only plan, parallel, perspective, and oblique are commonly used for architectural models, and DataCAD lets you customize each of these types of views. You must use a parallel or plan view for editing your drawing, while perspectives and obliques are most often used for visualization, rendering, and presentations.

Once you have a view defined, you can perform a hidden line removal of it or shade it. You can save any hidden-line, shaded, or standard 3D view and then link any entity in your model to that view to easily display it. You can even create walkthroughs of your model.

The o2c-based object viewer provides real-time, dynamic, shaded 3D views of DataCAD models. You can adjust many of the o2c settings and save them as high-quality rendered images.
Figure 25.1: Examples of views you can create in DataCAD
Creating Parallel Views

Parallel in the View pull-down menu restores the last parallel view you generated and displays the globe. Elevations and isometrics are parallel views but by no means the only ones. Because these two cases are used so frequently, they have their own menu selections. It may help, however, to remember that these are just different kinds of parallel views. You can, in fact, choose any eye point to create a parallel view. See “More About Changing the Eye Point for a View” later in this chapter for more information on the globe display and how it affects parallel views.

Elevations and isometric views can be quickly created in DataCAD in just a few steps. Isometric views can be created by simply choosing Isometric from the View pull-down menu or by choosing Isometric from the 3D Views menu. You can use the Viewer Toolbar to work with any parallel view. Choose Viewer Toolbar from the View pull-down menu. This toolbar will automatically change when you change your view to any parallel view or to orthographic (plan) view.

More About Rotation Angles in 3D Views

In 2D, positive rotation angles go counterclockwise; in 3D, the concept is a bit more complex. This rotation angle of -90° flips the model to the left. DataCAD uses the right-hand rule to indicate the direction in which positive angles run. To understand the right-hand rule, point the thumb of your right hand in the direction of the axis in question. Your fingers curl in the direction of positive rotation. The Y-axis goes up, so when you point your thumb up, your fingers curl toward you a counterclockwise direction. Negative angles run in a clockwise direction.

![Right-hand rule](image)

Figure 25.2: Right-hand rule

More About Changing the View Center

When you create the first parallel view in a drawing, DataCAD calculates the view center by examining the extents of the model. DataCAD generates all parallel views with the assumption that the model is situated over a point called the view center or the point in space at which the observer is looking. DataCAD places the view center in the middle of the extents, halfway between Z-base and Z-height. Ideally, this is somewhere near the center of the model.
The view center is not attached to the model in any way, so if the model moves, the view center does not change. Be careful when you use Globe. Sometimes, models spin off the screen completely because the globe is always situated directly over view center. Reposition the view center to somewhere inside the model to avoid this problem.

The view center in a perspective view is always the point of intersection between the picture plane and the line of sight.

- To reposition the view center:
  1. Choose Reset from the 3D Views/Controls menu. Reset places the drawing in the last orthographic view you generated. This helps you find a center of the model.
  2. Choose View Center; an Auto option becomes available.
  3. Select a new center point in one of the following ways:
     - Select a point in the center of the model
     - Choose Auto to calculate a view center with the center point halfway between Z-base and Z-height

The new view center is set and you return to the Controls menu.

In the 3D Views menu, both the Elevation/New Elev. and Edit Plane options change the view center implicitly. In both of these options, you select a point on the plane where Z=0. This point becomes the new view center for parallel views. This point also becomes the new grid origin for grid snapping. See “Creating Perspective Views” later in this chapter for more information on the view center in a perspective view.

### More About Changing the Eye Point for a View

The view sphere (known as the “globe” in versions 10 and prior) display is used to reorient your eye point in a parallel or perspective view; it is automatically displayed on screen whenever you choose a parallel or perspective view. Selecting a point inside the view sphere display indicates the new observer position for viewing the model.

In perspective views, the view sphere changes the elevation of the observer’s eye point and the direction from which you observe the model (north, south, east, or west), but it does not change the view center, the distance to the object, or the cone of vision.

In a parallel view, the view sphere sets the observer’s eye point above or below the ground plane at which the observer stands. The center of the view sphere represents a point directly over view center and all points on the outer circle represent a point in space directly below the view center looking up.

**Figure 25.3:** View sphere perspective
To visualize how the view sphere operates, imagine that the model sits inside a large sphere. Half of the sphere is above the ground plane and half of it is below, with the ground plane cutting the sphere at the equator. The equator of this sphere is represented as the inner circle. Therefore, all points inside this circle are the upper half of the sphere (above ground) and all points outside the inner circle are the lower half of the sphere (below ground).

While the view sphere display is in the upper-left corner of the screen by default, you can use the View Sphere option in the 3D Views menu to reposition it on the screen. You can:

- Move the view sphere to a different location on the screen so that you can continue to work on a part of the model without interference
- Change the size of the view sphere; a larger view sphere gives you finer control over the rotation of a parallel or perspective view

To move the view sphere display:

1. Choose View Sphere from the 3D Views menu. The View Sphere menu appears:
   - Default: Returns the view sphere to its customary position in the upper-left corner of the Drawing Window
2. Select a new center for the view sphere. Move your mouse to dynamically size the View Sphere display.
3. Select a point on the perimeter of the new view sphere. The view sphere moves to the selected position.

Use 3D Views/Controls to specify a vantage point for a parallel view. You can think of the Controls menu as a more accurate version of View Sphere and just another way of generating parallel views. You can use the Controls menu to position the view center inside the model for smoother operation of the view sphere.

When you choose Controls from the 3D Views menu, the Controls menu appears in the Menu Window. In addition, the control buttons appear on the Viewer toolbar if that is currently displayed. (To display the Viewer toolbar, select Toolbars from the View pull-down menu and make sure there is a checkmark for Viewer in the Toolbars dialog box.)

The cursor you see while you are in the Controls menu displays the current orientation of the X, Y, and Z world coordinate axes.
Figure 25.4: Screen coordinates vs. world coordinates

The Screen option rotates the view around the screen coordinate axes. Screen coordinates refer to the right-handed coordinate system that you worked with in 2D. The +X axis goes to the right, the +Y axis goes up, and the +Z axis comes out of the screen. This does not change.

The World option rotates the view around the world coordinate axes. World coordinates refer to the right-handed coordinate system associated with the model. Imagine that your model is in orthographic view and you attach the screen coordinate axes to the model itself. What you have is a set of three axes known as world coordinate axes. These do not change with respect to the model, but they do change with respect to the screen.

When you choose any of the Rotate options, DataCAD rotates the view by a set number of degrees around the axis you indicate.

Reset changes the current view to the last orthographic view taken. Reset also brings the model back into view in case it moves off the screen. Use this option before using View Center.

Rot. Angle controls the number of degrees that the object rotates under any Rotate+ or Rotate- options.

Four additional input modes are available in the Controls menu: relative and absolute cylindrical (distance, angle, Z coordinate) and relative and absolute spherical (distance, plan angle, rise angle). These modes provide additional variables to the Z component of coordinate entry, which may be helpful in specialized modeling applications like entering a 3D line that represents a solar angle.

**Hint:** You can access these modes by pressing the (Insert) key.

- To set the rotation angle:
  2. Choose or type a value and press (Enter).

Add View adds the current parallel view to the list of saved views.
**Creating an Isometric View**

Isometric creates a true isometric view. Isometric views are a special parallel view where the X- and Y-axes of the model form a 30° angle from the horizontal. To make sure that the angle is precise, choose Isometric from the 3D Views menu or choose Isometric from the View pull-down menu.

**Creating Elevations**

Elevations are a special kind of parallel view. When you view an elevation in plan, the front of the model faces the bottom of the screen.

Use Front Elev. to view the front elevation of the model. Use Back Elev. to view the back elevation of the model. Use Right Elev. to view the right elevation of the model. Use Left Elev. to view the left elevation of the model.

In addition to the four preset elevations (Front Elev., Back Elev., Left Elev., and Right Elev.), you can create nonorthogonal elevations. You can use New Elev. to generate views for rendering or to orient the model for a side view in which you can precisely place the zero plane, Z-base, and Z-height. If you choose a Front Elev., you cannot guarantee where Z-base and Z-height are in relation to the new view.

To create a new elevation:

1. Choose New Elev. from the 3D Views/Elevation menu or choose Elevation/New from the View pull-down menu. The view changes into plan view so that you can specify the elevation line. Center Z appears in the Elevation menu.
2. Choose Center Z to set the height of the view center. You must choose this option before you select the first point in the new elevation indicator. A list of values appears.
3. Choose or type a value and press (Enter).
4. Select a point to lie on the new zero plane (such as the corner of a wall). This point also serves as the new view center and grid origin.

Move the cursor and it changes into a New Elevation Indicator. There are several parts to this cursor:

- Z-base indicator
- Z-height indicator
- Zero plane (the plane at which Z = 0)
- Direction of view

The Z-base and Z-height indicators may not be visible if their values appear off the screen or if their values are set to zero, in which case these indicators coincide with the zero plane.
5. Adjust Z-base and Z-height if necessary. The indicators change position to show you the new location of Z-base and Z-height. Remember that negative distances go in the direction of the view (into the screen).

6. Select a point in the direction of the view. The specified view appears on the screen.

Options for creating front, back, left, right, and new elevations are available from both the View/Elevation pull-down menu and the 3D Views/Elevation menu in the Menu Window.

⇒ To add the current elevation to the list of saved views:
   1. Choose Add View from the Elevation menu.
   2. Type the name of the new view (up to eight characters) and press (Enter). The view is added to the list of saved views.

More About the New Elevation Indicator Cursor

This cursor has an arrow indicating the direction of the new zero plane position and a tail representing the current Z-base and Z-height settings. (The end of the tail nearest the crosshair is Z-base and the end furthest from the crosshair is Z-height.) If Z-base is set to 0, the tail meets the crosshair; if Z-height is set to 0, the end of the tail won’t be displayed.
Creating Perspective Views

DataCAD can generate one-, two-, and three-point perspectives. The differences between these perspective types lie only in the location of the eye of the observer (Eye Point Z) and the point in the model at which the observer is focusing (Focal Pnt. Z).

You can use the Viewer Toolbar to work with your perspective view. Choose Viewer Toolbar from the View pull-down menu. This toolbar will automatically change when you change your view to any parallel view or to orthographic (plan) view.

For each perspective type, you must select an eye point for the observer and a focal point to mark the point in the model where the observer is looking. When you select the first point, the cone of vision appears. See “More About Changing the Eye Point for a View” earlier in this chapter for more information on the view sphere.

Figure 25.6: The New Elevation Indicator cursor with Z-base=0 and Z-height=8
**Figure 25.7:** Cone of vision for perspective view

The line that cuts across the cone of vision is the picture plane. Things in front of this plane (on the same side as you, the observer) appear larger than normal; things behind the picture plane appear smaller.

The line that leads directly from the eye point to the view center is the line of sight. As with parallel views, always place the view center somewhere inside the model so that the view sphere is stable and predictable.

**Establishing Perspective Settings**

- To set the elevation of the observer’s eye point:
  1. Choose Eye Point Z from the Set Persp. menu. A list of perspective eye point values appears.
  2. Choose or type a value and press (Enter).

- To set the elevation of the center of the view:
  1. Choose Focal Pnt. Z from the Set Persp. menu. A list of values appears.
  2. Choose or type a value and press (Enter).

The Reset option in the Set Persp. menu returns you to a perspective view using the current settings in this menu.

Use Hither Clip to reduce the fisheye distortion that can appear in close-up perspectives. You can also increase the hither clip distance to partially cut your model shown in perspective view and then create a shaded “sectional perspective” with the Quick Shader menu. The hither clip plane appears as a crosshair on the cone of vision.

- To use Hither Clip:
  1. Choose Hither Clip from the Set Persp. menu. A list of values appears.
  2. Choose or type a value and press (Enter).
Create one-point perspectives by choosing an eye point at the same elevation as the view center; the observer is looking straight ahead, neither up nor down. A one-point perspective must have the picture plane parallel to one of the frontal faces of the model.

To set the width of the field of vision to an angle using Cone Angle:
1. Choose Cone Angle from the Set Persp. menu. A list of values appears.
2. Choose or type a value between 1 and 179 degrees and press (Enter).

To set the width of the field of vision using Camera:
1. Choose Camera from the Set Persp. menu. A list of values appears.
2. Choose or type a value and press (Enter). Camera sets the width of the field of vision by expressing it as the length of a camera lens. The longer the lens, the narrower the cone of vision.

Creating a One-Point Perspective

To create a one-point perspective:
1. Choose Set Persp. from the 3D Views menu. When you choose Perspective from the 3D Views menu for the first time in a drawing, the Set Persp. menu is automatically displayed so you can set up the perspective view.
2. Set Eye Point Z to a reasonable value. When an observer is standing on the ground, 5\(^\prime\) is a typical height for the observer’s eye.
3. Set Focal Pnt. Z to the same elevation you used in step 1.
4. Select a point for the eye point.
5. Select a point inside the model for the center point. Use ortho mode to make sure that the line of sight is perpendicular to one of the faces of the model.
Creating a Two-Point Perspective

Use two-point perspectives to relax one of the two constraints that you placed on one-point perspectives. You can either:

- Set the eye point and center point at different elevations and keep the line of sight perpendicular to one of the frontal faces of the model; or
- Keep the eye point and center point Z the same and set the line of sight at an angle other than 90°.

Creating a Three-Point Perspective

Three-point perspectives are generated when the eye point Z elevation is different from the center point Z elevation and the line of sight is at an angle other than 90°. With these constraints, set the eye point Z and the center point Z appropriately and choose these points in your model.
Perspective Navigation Controls
Hotkeys and MouseWheel controls automate perspective setup and navigation by using video game-style controls. For more detailed information about the navigation aids, see “Walking Through Your Model” later in this chapter.

Creating Oblique Views
DataCAD can create both plan obliques (architectural axonometrics) and elevation obliques. Choose Oblique from the 3D Views menu, then select Plan Oblique to create a plan oblique or Elev Oblique to create an elevation oblique. If this is the first time you’ve chosen Elev Oblique, follow the directions for selecting the New Elev. option in the Set Oblique menu. See “Creating Elevations” earlier in this chapter for more information on the New Elev. option.

Establishing Oblique Settings
The Set Oblique option in the 3D Views menu (which is only available after you select Elev Oblique) defines which elevation of the model you want to use as your frontal elevation in constructing the oblique view. It works exactly the same way as the New Elev. option in the 3D Views/Elevation menu.

Obliq.Angle controls the angle of rotation before the plan oblique is taken. Angles are usually between 30° and 45°. For elevation obliques, this setting controls the angle at which the lines sweep away from the elevation.

Creating an Elevation Oblique View
➢ To create an elevation oblique view:
  1. Select Set Oblique from the 3D Views menu.
  2. Choose Elev Oblique from the Oblique menu.

Creating a Plan Oblique View
➢ To create a plan oblique view:
  1. Select Set Oblique from the 3D Views menu.
  2. Choose Plan Oblique from the Oblique menu.
Creating a Hidden Line Removal

Use 3D Menus/Hide to perform hidden line removals in DataCAD. DataCAD's hidden line removal system is a two-pass system with an additional initialization step. The initialization step performs a few simple and quick operations: allocating memory, calculating the limits of your model for a specified view, and initializing the temporary hidden line removal database.

The hidden line removal process does not recognize text and associative dimensions; therefore, they do not appear after a Hide. To display these entities after a Hide, convert them into 3D lines with the 3D Edit, Explode command.

Pass one (the calculating pass of the hidden line removal system) scans through the entire model and temporarily separates it into a series of polygonal faces or free lines, as follows:

- DataCAD breaks entities like 2D lines (having height), polygons, slabs, blocks, cylinders, etc., into a series of polygons that the hidden line removal system can understand and interpret.
- DataCAD breaks entities like 3D lines, contour curves, 3D arcs, etc., into a series of free line segments. Free line segments are assumed to be infinitely thin.
- DataCAD also recognizes voids in polygons.

Pass two of the hidden line removal process is where most of the work takes place; consequently, it usually takes longer. Each line segment that is potentially a visible edge or a free line is compared with each polygonal face. DataCAD uses the tests to determine if the line segment lies completely in front of, completely behind, straddles, or pierces a given polygon.

Depending on the results of these tests, the line is either eliminated from consideration, split into one or more pieces, or left intact to be tested later against the remaining polygons. If, after having been compared against all of the possible polygons, some portion of the line segment remains, DataCAD displays the segment and optionally adds it to a temporary database for the saved image.

DataCAD uses a number of optimization techniques for reducing the computing time of the display pass to a minimum.

To perform a hidden line removal:

1. Choose Hide from 3D Menus or choose Hidden Line Removal from the View pull-down menu. Set the following options as necessary:
   - Begin: Starts the hidden line removal process and displays operation's progress in the Message Window; press (Delete) or (End) to cancel the hide at any time
   - Save Image: Save the image produced by a hidden line removal
   - Crop Image: Performs a hidden line removal only on the portion of the model that is visible on the screen
   - HLR Partial: Divides the Drawing Window into smaller sub-areas for faster hides

Figure 25.13: Plan oblique
Tip on Maximizing Performance

- Use lines rather than polygons whenever possible. For example, if you want to draw some rectangles on the faces of a slab block to schematically represent windows, use 3D lines instead of polygons to outline the windows to increase performance. Since the rectangles are simply inscribed on the face of the slab, polygons are not needed; there is nothing to hide.

- Use three-dimensional entities like blocks, cylinders, and slabs instead of collections of 2D lines and simple polygons.

- Keep models as simple as possible. As the size of the model increases, the time required to compute a given image increases at a faster rate. You may consider placing some of the detail for a given model on separate layers so that you can temporarily toggle some layers off for preliminary runs of the hidden line removal system. After you complete the modeling process, you can then toggle on all applicable layers and perform this more complicated hidden line removal analysis on the complete model.

Saving the Hide Image

If you toggle Save Image on before you choose Begin, DataCAD saves the hidden line removal image for later use; if Save Image is toggled off, DataCAD does not save the image and only displays it on the screen.

Once the hidden line removal process is complete, the Save Image menu appears:

Active Layer
New Layer
Layer File
Offset
To add a retained image to the active layer:
   1. Use (Tab) and (Shift) + (Tab) to scan through the available layers to select the layer to add the new image to. DataCAD saves the image to the active layer.
   2. Choose Active Layer after the hidden line removal process is complete. DataCAD adds the image to the active layer; you return to the Hide menu.

To add the retained image to a new layer in the drawing:
   1. Choose New Layer at the completion of the hidden line removal process to create a new layer for the drawing.
   2. Enter a name for the new layer.
   3. Indicate whether you want the new layer On or Off. If you plan to create a series of images, leave the layer off to return directly to the Hide menu and create a new image.

To add the retained image to a layer file:
   1. Choose Layer File at the completion of the hidden line removal process.
   2. Enter the name of the layer file you want to create. DataCAD lists the layer files in the current layer folder in a dialog box.

If you click Cancel in the dialog box without specifying a layer file, DataCAD deletes the image.

The image created by the hidden line removal process contains only 2D lines; you can use all of the normal DataCAD editing operations on the resulting image such as erasing, trimming, enlarging, moving, rotating, stretching, and hatching. Since the image contains 2D lines, an orthographic view is the best.

Before you choose Active Layer or New Layer, you can offset the image in the XY-plane by some distance. This helps you to create a composition of views by arranging them on the screen apart from each other.

To offset an image:
   1. Choose Offset after completion of the hidden line removal process.
   2. Select the first point of a distance to offset the image in the plane of the screen.
   3. Select the second point of a distance to offset the image in the plane of the screen.
   4. Choose either Active Layer or New Layer and proceed with the instructions listed above for adding the image to the drawing.

Choose Cancel to delete the retained image and return to the Hide menu. Remember that after the hidden line removal process, if you toggle Save Image on, DataCAD saves the image before you select a destination for it. If you choose Cancel, DataCAD deletes the previously saved image from the drawing and makes this space available.

**Increasing Hide Speed**

Use HLR Partial to partition the Drawing Window into smaller sections, allowing for faster hides. Hide treats each section separately, resulting in continuous lines being divided. It also allows you to see sections in their entirety as the hidden line removal progresses.
To change Drawing Window partitions:
1. Choose HLR Partial from the Hide menu.
2. Choose X Segments.
3. Type a new value and press (Enter).
4. Choose Y Segments.
5. Type a new value and press (Enter).

Hide Options
Use Options in the Hide menu to perform different functions within a hidden line removal.

Editing Hidden Line Removal Images
If you use HLR Partial to partition your hidden line removal image, continuous lines will be broken wherever they cross a partition. While these breaks aren’t visible, they can make editing that image time-consuming, if not difficult. Using the Join option allows you to more easily edit the hidden line removal image after it is complete. When you perform a hidden line removal with HLR Partial on, toggle Join on in the Hide/Options menu to weld (reattach) lines on a model.

Deleting Double Lines
The Delete Db. option in the Hide/Options menu deletes any double lines in the model that were created as a result of performing a hide with Join and HLR Partial on.

Drawing Hidden Lines
If the Draw Hidden option in the Hide/Options menu is on before you choose Begin, DataCAD draws hidden lines using the line color, line type, and line spacing you set by the Hidden Color, Hidden Style, and Hidden Spac. options. If you toggle Draw Hidden off, DataCAD does not draw the hidden lines.

Disregarding Backfaces
Use the Backface option in the Hide/Options menu for a faster Hide performance. DataCAD calls all polygonal faces facing away from the viewer backfaces. With this toggle on, DataCAD ignores the backfaces for a hidden line removal. This decreases the amount of area to hide and the time it takes to complete the hidden line removal.
Hidden Line Colors
Use the Hidden Color option in the Hide/Options menu to change the color used to draw the hidden lines. This color menu works exactly like its 2D counterpart. See “Color Menus” in “The Drawing Board” chapter for more information on the 2D options.

Hidden Line Types
Use Hidden Style to change the line type used to draw the hidden lines. When you toggle Draw Hidden off, Hidden Style is ignored. When you toggle Draw Hidden off, Hidden Color is ignored.

➔ To change the hidden line type:
1. Choose Hidden Style from the Options menu. A list of line types appears.
2. Select a new line type for hidden lines.

Hidden Line Spacing
Use Hidden Space to change the line spacing used to draw hidden lines. When you toggle Draw Hidden off, Hidden Spac. is ignored.

➔ To change the hidden line spacing:
1. Choose Hidden Spac. from the Hide/Options/Hide menu. A list of spacing values appears.
2. Choose or type a new spacing value and press (Enter).

Closing 2D Arcs
Unlike 3D arcs and 3D cylinders, ordinary 2D arcs do not have an option for being treated as closed objects. If you toggle Close 2D Arc on in the Hide/Options menu, DataCAD treats 2D arcs as closed, which makes them opaque to the hidden line removal process. 2D arcs that have a Z-height work like cylinders with closed ends and sides. If you toggle Close 2D Arc off, during the hidden line removal process, DataCAD treats 2D arcs as ordinary curved lines (arcs with no Z-height) or open-ended cylinders (arcs having Z-height).

Figure 25.15: 2D circles

These are 2D circles, not cylinders.

Closing 2D Ellipses
If you toggle Close Ellip. on in the Hide/Options menu, DataCAD treats 2D ellipses as closed, solid objects during the hidden line removal process. If you toggle Close Ellip. off, DataCAD treats ellipses as ordinary curved lines (no height) or curved surfaces (having height) with no top or bottom.
**Displaying Outlines Only**

Toggle No Prim Edge on in the Hide/Options menu to display the outline of tori and cylinders. No Prim Edge does not display any other divisions of these entities.

**2D Arc Divisions**

During the hidden line removal process, DataCAD uses the current value of the circle divisions setting. This Divisions option is duplicated on the Hide/Options menu for convenience in adjusting the current value of this variable. Choose Divisions from the Hide/Options menu and set it to an integer value from 4 to 36.

**Creating a Shaded Image**

DataCAD’s Shader creates a shaded image of your model by temporarily breaking it down into 3- and 4-sided polygons and then shading the surfaces according to light source and shader settings. You can define and place up to seven light sources in your model and use ambient light as well. These light sources are specific points that radiate light out in all directions and can be toggled on or off to create different lighting effects. Each surface of your model is illuminated independently of the others, so one surface will not cast a shadow on its neighbor. The only factor that affects the light on a surface is the distance of the light source from it. The Shader supports all 256 colors in the DataCAD palette as well as a rendering palette of 16.8 million colors.

To create a shaded image of your model:

1. Go to the 3D Menus.
2. Click on Shader in 3D Menus. The Shader menu appears.
3. Click on Settings in the Shader menu. The Shader Settings dialog box appears, allowing you to change light source settings, the background color or image of the shader window, how edges are shaded, and more. The settings in the Shader Settings dialog box are also available individually in the Shader menu. You can use either the dialog box or the menu to change settings; all changes will be reflected both in the dialog box and the menu options.

![Figure 25.16: The Shader Settings dialog box](image-url)
4. Change the Light Settings by choosing the light source whose settings you want to change from the Light Source list box. Then, follow the instructions below. Repeat this for each light source you want to customize.

- The light sources are named LtName1, LtName2, etc., by default. To rename the light source, click in the Name input box and type a new name. The name will be updated in the Light Source list box when you either click in the list box or click OK to save the shader settings.

You can also position a light source by simply clicking anywhere in the Drawing Window. Click on the light source name in the Shader menu, click On/Off in the menu if the light source has not yet been toggled on, and then choose Position from the menu. A 3D cursor appears in the Drawing Window; note the cursor’s coordinates displayed in the Coordinates/Hints toolbar. Click to place the light source. Please note that you cannot use the light source settings in the Shader Settings dialog box to position the light using this method.

- The light source’s intensity is the percent of white used in the light, with percentage values ranging from 0 to 100. To set the intensity of the light source, use the up and down arrows to increase or decrease the percent value, respectively.

- To enter specific coordinates for a light source, click in the X, Y, Z Coordinate input boxes and type new coordinates. (The left input box is the X coordinate, the middle input box is the Y coordinate, and the right input box is the Z coordinate.)

- To toggle a light source on or off, click in the On/Off checkbox.

- To give the light source the ability to cast shadows, toggle Cast Shadows on. Note that shadows are not actually cast in the shaded image unless Cast Shadows in the bottom right corner of the dialog is checked.

- The intensity of ambient light can be adjusted just as light source intensity was. To set the ambient light intensity, use the up and down arrows to increase or decrease the percent value, respectively.

5. Customize the sun light source settings.

- Turn the sun light source on by clicking in the On/Off box.

- Select the brightness by using the up and down arrows in the Intensity box.

- Click one of the eight buttons to show the sun’s position in relation to your drawing.

6. Customize the background color of the Shader window, change the size of the shaded image, and change how you move from the shaded image back to your drawing:

- To change the background color, click on the colored rectangle in the Background Color section. Click on a new color in the Color Palette dialog box and then click on OK.

- Click on the Right-Click to Exit checkbox to check this option; this will allow you to close the shader window by simply right-clicking. Uncheck this option to use a pop-up menu to quickly save your image, move between images and your drawing, or import your shaded image into eZmeeting.

- The shaded image is created as a bitmap (.BMP) file. You can adjust Shader window size by using the up and down arrows to increase or decrease the percent value, respectively, with 100% being the full size of the Drawing Window. You can go as high as 1,000%, depending on how much system memory you have available.
10. Go to the Edge Type section. Click on No Edge to shade only the surfaces of your model, click on Show Edge to shade both the edges and surfaces, or click on Edge Only to shade only the edges (similar to a hidden line removal with lights). The default setting is No Edge.

11. Add edge and overshoot lines to your shaded image.
   - To set the length of the overshoot, click in the Length input box and type a value. The default length is 0.0.
   - To set the width of the lines used for edges and overshoots, use the up and down arrows to enter a width in pixels. The default is 1.
   - To draw edge/overshoot lines in the same color as the entity’s surface, check the Use Entity color checkbox. This is checked by default. If you’d like to use a different color, uncheck the box, click on the color swatch to the right, and choose a new color. The Edge/Overshoot properties section is only available when Show Edge is toggled on.

12. Use the Highlight setting to produce a visible area of light around a light source, much like a lamp throws on a wall and ceiling. This setting is off by default, but you can set it to three intensities, with Large being the most intense.

13. Choose a background image for your shaded image by clicking on the folder icon in the Background Image section and choosing a supported file format (.BMP, .JPG, .GIF, .TIF, .TGA, .PNG, .PCX, and .PCD). Leave Maintain Aspect checked to ensure the background image covers the entire Shader window. You cannot customize the size of the background image.

14. Go to the bottom portion of the Shader Settings dialog box. Check Render both faces to render both sides of a polygon, instead of rendering only the side with the positive normal. When this option is unchecked, any negative normals of polygons that face you will not be rendered, unless Normals toward viewer is checked in the following step.

15. Check Normals toward viewer to set the positive normals of all polygons so that they face you. Uncheck this option to leave positive normals facing their original direction.

16. Cast shadows in your shaded image, according to the light sources you set for shadows in step 4, by checking the Cast Shadows box in the lower portion of the dialog box. (Note that you must still complete steps 19 – 21 to actually draw the shadows.)

17. Make sure the Show Lights checkbox is checked on. This option displays the light sources as small symbols around your model, letting you see exactly where they are positioned. These symbols do not print; they are only displayed for visual reference.

18. Click OK to save your new settings and close the Shader Settings dialog box.

19. Cast shadows in your shaded image by clicking on Shadow Plane in the Shader menu. Then, toggle Recv. Shadow on. You are prompted to Select entity to receive shadow.

20. Select the entity on which the shadow will fall (for example, the polygon acting as the floor or ground plane). Use the selection menu to select and highlight the entity. If you select the wrong entity, toggle Recv. Shadow off and select that entity again. Repeat this step to select the correct entity. An entity cannot cast a shadow and receive one (have a shadow fall on it) at the same time.

21. Right-click to return to the main Shader menu.

22. Click Shade in the Shader menu. Your model is shaded and the bitmap image appears in the Drawing Area. You can now save the shaded image as a bitmap file or return to your drawing file. You can save your settings and then use them later without having to change all the Shader settings again. See “Saving and Using Shader Settings” later in this chapter.
More About Polygon Normals

A characteristic of a polygon surface is its orientation or normal. Think of a polygon as a sheet of paper that only allows you to write on one side. This side is the positive normal, while the other side is the negative normal. In a visual sense, polygons are one-dimensional because they may only be seen from one side in a rendered view.

To quickly shade your model without changing any Shader settings, click on Shade in the View pull-down menu. Your model is shaded.

You can’t see polygon normals in DataCAD. While a normal is a condition of the coordinate points that describe a particular polygon, they really don’t matter much in the DataCAD world. Whether you view, quick-shade, or hide a polygon from either side, it will look and display exactly the same. The only way to know which way a normal faces is to remember how it was created. Did you define the polygon right to left (counter clockwise) or left to right (clockwise)? If you went counter clockwise, then the normal faces toward you, out of the screen. If you went clockwise, then it faces away from you, into the screen. This method of orientation is known as the right-hand rule. To further complicate things, if you mirror an entity, all of its normals will reverse.

Saving and Using Shader Settings

You can save your settings and then use them later without having to change all the Shader settings again.

To save your shader settings:

1. Customize the options in the Shader Settings dialog box. See “Creating a Shaded Image” earlier in this chapter for more information on customizing shader settings.
2. Click on the Save As button in the Shader Settings dialog box. A dialog box appears, prompting you to Save light information to.
3. Change to the folder where you want to save your .LIT file, if necessary, and type a name for the file.
4. Click on Save. The dialog box closes and your .LIT file is saved.

To use a .LIT file:

1. Click on Settings in the Shader menu. The Shader Settings dialog box appears.
2. Click on Load. A dialog box appears, prompting you to Load light information from.
3. Change to the folder where your .LIT file is stored if necessary. Then, click on the file.
4. Click on Open. The dialog box closes and the light settings are loaded into the Shader Settings dialog box.
**Saving Your Shaded Image**

You can save your shaded image or send the bitmap to an eZmeeting conference.

- To save your shaded image:
  1. Click on Save or Save As in the File menu or right-click in the bitmap window to display a pop-up menu and click on Save Bitmap or Save Bitmap As. (Keep in mind that if you use the Save option, the bitmap is saved in the last folder you used.) The Right-Click to Exit option in the Shader Settings dialog box must be unchecked for the pop-up menu to display when you right-click in the Shader window.
  2. Determine if you used the Save As option in the previous step. If so, type a name for the bitmap file and click Save.

**Viewing Selected Entities in Your Model**

Use Clip Cube in the 3D Views menu to restrict your view of the model so that only the entities inside a rectangular region are visible. If an entity is only partially inside the clip cube, DataCAD clips it at the point where it passes outside the cube. This reduces the visual clutter of a complex model as it develops. You cannot edit entities outside of the clip cube.

There are two clip cubes you can use: one for orthographic and one for parallel views. These cubes are independent of one another. When you begin the clip cube operation from orthographic view, DataCAD uses the orthographic clip cube. When you use Clip Cube while in a parallel view, the parallel clip cube is used.

The clip cube status is one of the attributes stored with the Add View function in the GoTo View menu. Restoring a saved view also restores the clip cube that was in use when you saved the view.

The Arc Factor setting controls the smoothness of clipped arcs that use a solid line type.

- To activate the clip cube:
  1. Select Clip Cube from the 3D Views menu. The Clip Cube menu appears.
  2. Toggle Clip On on.

- To create a new clip cube:
  1. Choose New Cube from the Clip Cube menu.
  2. Set Z-Min and Z-Max so that they enclose the part of the model you want. First set the height of the floor of the clip cube by selecting Z-Min from the Clip Cube menu, choosing or typing a value, and pressing (Enter).
  3. Set the height of the ceiling of the clip cube by selecting Z-Max from the Clip Cube menu, and choosing or typing a value, and pressing (Enter).
  4. Select the area with a rubber band box.
  5. Right-click to exit or select two new corners to reset the rubber band box.
  6. Choose Clip On to toggle the cube on.
Refresh updates the screen after you activate the clip cube. When Refresh is off, press (Esc) to refresh the screen yourself to see the effects of the new clip cube.

You can insert an XREF into your drawing and define a clip cube within it. Either you can do this by using the Insert pull-down menu or by selecting XREF Clip from the 3D Views menu.

To define a clip cube in an XREF attached to your drawing with Reference File Management:

1. Open a new drawing or select an existing file.
2. Attach a reference file to it by selecting XREF from the Insert pull-down menu.
3. Double-click on the name of the file you want to insert. Your cursor is now loaded with a boundary box that represents the extents of the reference file. Toggle on By Center in the Insert XREF menu. You are prompted to Position XREF on drawing. Click the left mouse button to place the reference file by its center. The reference file appears in your Drawing Window.
4. Select Reference File Management from the Insert pull-down menu. Choose Clip Cubes from the extended menu. You are prompted to Select XREF to modify ClipCube.
6. Select Z-Min in the Identify menu, choose or type a value that is below the floor or Z-base of the model, and press (Enter). Similarly, select Z-Max to set the Z-height above the roof of the model.
7. Click on New Cube. You are prompted to Select the first corner of the clipping cube.
8. Click where you want the clip cube to begin. Then, pull the rubber band out diagonally and click when it encloses the area you want to display in the clip cube.
9. Select Clip On. This toggles the clip cube on.

To define a clip cube in an XREF attached to your drawing with XREF Clip:

1. Open a new drawing or select an existing file.
2. Attach a reference file to it by selecting XREF from the Insert pull-down menu.
3. Double-click on the name of the file you want to insert. Your cursor is now loaded with a boundary box that represents the extents of the reference file. Toggle on By Center in the Insert XREF menu. You are prompted to Position XREF on drawing. Click the left mouse button to place the reference file by its center. The reference file appears in your Drawing Window.
4. Make sure you are in the 3D Views menu. Select Clip Cube from the 3D Views menu. The Clip Cube menu appears.
5. Select XREF Clip from the Clip Cube menu. You are prompted to Select XREF to modify ClipCube.
6. Click on the XREF you placed in your drawing. The Identify menu appears.
7. Set Z-Min and Z-Max values so that they are respectively below and above the model’s Z-base and Z-height.
8. Click on New Cube. You are prompted to Select the first corner of the clipping cube.
9. Click where you want the clip cube to begin. Then, pull the rubber band out diagonally and click when it encloses the area you want to display in the clip cube.
10. Select Clip On. This toggles the clip cube on.

**Saving a View**

Use Save Image in the 3D Views menu to create a snapshot of the current view. The snapshot consists of 2D lines and can be edited with normal 2D editing commands in orthographic view.

➔ To save an image:
1. Choose Save Image from the 3D Views menu. The Save Image menu appears.
2. Make decisions about the image you want to save:
   - Active Layer: Save the image to the active layer
   - New Layer: Save the image to an automatically created new active layer
   - Layer File: Save the image to an automatically created layer file
   - Offset: Select the distance and direction to offset a saved image from the current geometry
3. Select the destination for the saved image.
4. Enter a name for the new destination layer (when you place the image on a new layer or in a layer file). DataCAD generates the image. The image that this procedure creates is made entirely of 2D lines with Z-base = 0 and Z-height = 0; therefore, DataCAD creates the image flat on the ground plane and in orthographic view.

**GoTo View**

When you save a view using the GoTo View menu in the 3D Views menu, DataCAD stores information about the current view including:

- viewing scale
- zoom location (what you have zoomed in on)
- view type (orthographic, parallel, perspective, or oblique)
- location and orientation of the zero plane
- location of the view center
- active and inactive layers
- size, location, and status (on or off) of the clip cube

Restoring these saved views actually restores all of these stored settings to their previous state. However, restoring a view does not restore the values of Z-base and Z-height. The Layers On/Off setting may or may not be restored, depending on whether Layer Set is on or off. The Layer Set option in the GoTo View menu restores layers to their last saved condition (on, off, active). When Layer Set is off, DataCAD uses the current state of the layers but restores all the other parameters.
The top part of the GoTo View menu displays the names of any saved views in the drawing. If there are more than ten views for this drawing, Scroll Fwrd and Scroll Back appear on the menu to let you scroll through your views. Selecting a view from the menu restores that view to the Drawing Window.

To add the current view to the list of saved views:
1. Choose GoTo View from the View pull-down menu.
2. Choose Add View from the GoTo View menu.
3. Type the name of the new view (up to eight characters) and press (Enter). The view is added to the list of saved views.

To add any changes you made to the view without creating a new view:
1. Choose GoTo View from the View pull-down menu.
2. Choose Update View from the GoTo View menu.
3. Choose the view that you want to update with the current settings. This update includes active or inactive layers, scale, and location of the zero plane.

To delete a selected view from the menu:
1. Choose GoTo View from the View pull-down menu.
2. Choose Del. View from the GoTo View menu.
3. Choose the view that you want to delete. DataCAD deletes the view parameters only; the entities in the drawing are not affected by this operation.

To move a view from one position in the menu to another:
1. Choose GoTo View from the View pull-down menu.
2. Choose Move View from the GoTo View menu.
3. Choose the view that you want to move from the list of saved views.
4. Choose the view you want to appear after the view selected in step 2. The moved view appears before the view selected in step 3. This is useful for moving an often-used view into one of the first ten positions on the menu so you can access it quickly and easily.

To rename a saved view:
1. Choose GoTo View from the View pull-down menu.
2. Choose Rename View from the GoTo View menu.
3. Choose the view that you want to rename.
4. Type the new view name (up to eight characters) and press (Enter). The view is renamed.

To toggle between the previous and current views respectively:
1. Use (Ctrl) + Left Arrow.
2. Use (Ctrl) + Right Arrow.
Walking Through Your Model

With the Walk Through option in the 3D Views menu, DataCAD simulates an observer walking through a perspective model. You can walk toward or away from the model, turn right or left, step up or down or to one side, or look up or down or to one side. Before using the options that move you around the model, you must set the distance or angle to control how far you will move with each option.

Before you can use Walk Through, you must set up a perspective view. After you've set up a perspective view, you can toggle on the Viewer toolbar in the View pull-down menu. This toolbar contains the same functions as the 3D Views/Walk Through menu.

Perspective Navigation Controls

Use hotkeys and MouseWheel controls to help you walk through your model. You can use these hotkeys in any perspective view.

- (PageUp) Walk backward
- (PageDn) Walk forward
- MouseWheel Walk forward/backward
- (Up Arrow) Walk forward
- (Dn Arrow) Walk backward
- (Right Arrow) Step right
- (Left Arrow) Step left
- (Shift) + (Up Arrow) Look up
- (Shift) + (Dn Arrow) Look down
- (Shift) + (Right Arrow) Turn right
- (Shift) + (Left Arrow) Turn left

The Walk Through, Options menu lets you customize the way you navigate.

- To start a walk-through session, use one of these alternatives to set up a perspective view:
  - Select Set Perspective from the View pull-down menu; establish the eye point by clicking in the drawing where you want to begin the walk-through; move your mouse until the cone is positioned properly, then click. DataCAD remembers this eye point and uses it for subsequent walk-throughs until you change it by selecting Set Perspective from the View pull-down menu or choosing Set Persp. from the 3D Views menu.
  - Select Perspective from the View pull-down menu.
  - Click on the Magnifying Glass in the Projection Pad toolbar.
  - Click on Perspective in the 3D Views menu and use Set Persp. to define the eye point and cone.

- To customize walk-through options:
  1. Go to the 3D Views menu, toggle on Perspective, and select Walk Through.
  2. Select Options from the Walk Through menu.
  3. Set the three toggle switches, keeping the following in mind:
     - If Fixed Focal is toggled on, you will always look at the same point in your model while navigating.
     - If Fixed Focal is toggled off, your focal point will move the same distance as your eye point while navigating.
• If both Fixed Focal and Fixed Dist. are toggled on, you will navigate spherically around a fixed focal point.
• You cannot toggle off Fixed Focal and Fixed Dist. at the same time.
• If Pan View is toggled on, the walk-through controls are disabled. This means you can pan and zoom your perspective view as if it were a two-dimensional drawing.

**Walking**
Walk Dist. controls how far forward or backward the observer walks with Walk Forward and Walk Back.

➤ To change the walking distance:
1. Choose Walk Dist. from the Walk Through menu. A list of values appears.
2. Choose or type a value and press (Enter).
Now choose Walk Forward or Walk Back from the Walk Through menu. Walk Forward makes it look as if the observer has stepped toward the model by a distance equal to the walk distance by shifting both the eye point and the view center forward along the line of sight. Walk Back makes it look as if the observer has stepped away from the model by a distance equal to the walk distance by shifting both the eye point and the view center backwards along the line of sight.

**Turning**
Turn Angle controls how far the observer will turn with Turn Left and Turn Right.

➤ To change the turning distance:
1. Choose Turn Angle from the Walk Through menu. A list of angles appears.
2. Choose or type a value and press (Enter).
Choose Turn Right or Turn Left from the Walk Through menu. Turn Right turns the observer’s cone of vision to the right (clockwise) by an angle equal to the Turn Angle. Turn Left turns the observer’s cone of vision to the left (counterclockwise) by an angle equal to the Turn Angle.

**Stepping**
Step Dist. sets the step distance used with Step Up, Step Down, Step Left and Step Right.

➤ To change the stepping distance:
1. Choose Step Dist. from the Walk Through menu. A list of values appears.
2. Choose or type a step distance and press (Enter).
Step Up moves both the observer’s eye point and the view center upward, away from the ground plane. Step Dist. controls the distance that the observer’s eye point is elevated. With StepDown, both the observer’s eye point and the view center move downward, toward the ground plane. Step Dist. controls the distance that the observer’s eye point is lowered.
Step Left shifts the view to the right, as if the observer took a step to the left. Technically, this option causes both the observer’s eye point and view center to move to the left by a distance equal to the Step Dist. In this context, left means the observer’s left, facing toward the view center. Step Right shifts the view to the left, as if the observer took a step to the right by causing both the observer’s eye point and view center to move to the right by a distance equal to the Step Dist. In this context, right means the observer’s right, facing toward the view center.

**Looking**

Look Angle sets the angle that the line of sight changes using Look Up or Look Down.

→ To set the rotation angle of the observer’s line of sight:

1. Choose Look Angle from the Walk Through menu. A list of values appears.
2. Choose or type a value and press (Enter).

Look Up changes the view to simulate looking up, away from the ground plane. The eye point remains fixed while the view center moves up, away from the ground plane by an angle equal to the Look Angle.

Look Down changes the view to simulate looking down, toward the ground plane. The eye point remains fixed while the view center moves down, toward the ground plane by an angle equal to the Look Angle.

**Saving a View**

→ To add the current perspective view to the list of saved views:

1. Choose Add View from the Walk Through menu.
2. Type the name of the new view (up to eight characters) and press (Enter). The view is added to the list of saved views.

**Using the o2c-based Object Viewer**

The Object Viewer lets you see your model and enhance the image by controlling the rendered colors and textures.

**Hint:** You can set interior (or positional) light sources by using the lights you named in the 3D Shader menu.

→ To use the Object Viewer:

1. Select Object Viewer from the View pull-down menu. The o2c-based Object Viewer window appears.
2. Use the toolbar icons to control the view:
   - Sun – toggles sunlight on and off
   - Ambient lights 1, 2, and 3 – toggles ambient lighting on and off
   - Lamp – toggles interior lighting on and off
   - Sun/moon – switches between day and night
   - Parallel/perspective – switches between views
   - Clockwise rotation – hold down to move around the Z axis
   - Counter clockwise rotation – hold down to move around the Z axis
   - Decrease field of view
   - Increase field of view
   - Plan view
   - Elevation views – left, right, front, and back
   - Isometric view
   - Oblique or axonometric view

3. Depress and hold the left mouse button while you move the cursor to dynamically adjust the view.

4. Depress and hold the right mouse button while you draw the cursor toward you or away from you to zoom in and out. Alternatively, use the + and – buttons at the bottom right corner of the Object Viewer to zoom in (+) and out (−).
5. Right-click to open the o2c pop-up menu. From here, you can further control the view or save it to a file.
   - Show all - makes the entire model fit in the screen. Or click on the “a” button at the junction of the scroll bars.

When DataCAD calculates the extents of the model for the Object Viewer, it takes into account the position of each light source you defined in the 3D Shader menu. If one of these lights is far away from the model center, the model will be small and will not appear to rotate around its center. To correct this problem, either turn off the lights in the 3D Shader menu or position them closer to the center of your model.

**Figure 25.19:** The Save bitmap dialog box

- Start raytrace - renders the model. Or click on the R button at the right edge of the horizontal scroll bar of the Object Viewer to raytrace the model.

- Save image - creates a permanent high-quality rendering. The Save bitmap dialog box lets you control the quality of the file while you save the view as a bitmap image. In the Quality section, high produces the best results, but it takes longer to process. Set the Width in pixels (try 320 for thumbnails, 640 for presentations, and 1024 for printing); DataCAD uses the width to automatically calculate the Height in pixels. Check Raytrace if you want shadows and reflections in your saved image; however, this takes a long time to process. Type the File name and select the appropriate folder (shown in the Save in box). Click on the Save button when you are finished and want to return to the Object Viewer.

**Figure 25.20:** The Background dialog box
• Background – controls what is behind the model in the Object Viewer. Use Load image to access lists of available bitmap files; use Select color to choose from the Color dialog box. If you selected Load image, you can also check “Tiled background picture” to put many copies of the bitmap behind your model and further control the X and Y offset. If you clicked Select color, all options except Monochrome are unavailable (greyed).

6. Exit the Object Viewer by clicking on the X in the right corner of the title bar.

**Rendering Settings**

Selecting Rendering Settings from the View pull-down menu lets you define materials for rendering and assign them to specific colors in the DataCAD palette. Mapping entity colors to material definitions controls rendered output. The material settings for a given drawing are stored in a .DMF (DataCAD Material File) file. You can save custom material files for use in other drawings. Also, you can save individual material definitions and load them one at a time. These definitions are compatible with other o2c-based programs such as DCvis, ArCon, and o2c Composer.

DataCAD lets you choose from a standard set of matte, glossy, and glass materials. By adjusting the various settings and experimenting a bit, you’ll be able create your own materials to produce artistic, photo-realistic renderings of DataCAD models.

To use the Rendering Settings by Layer dialog box:

1. Access material settings for a given color by using (Ctrl)-right-click on an entity in the DataCAD Drawing Window. A small pop-up menu appears. For this example, just the STUCCO layer is active.

2. Select Rendering Settings from the pop-up menu. This opens the Rendering Settings by Layer dialog box that lets you precisely define the materials. The name of the active material file appears in the title of the Layer portion of the dialog box.

3. Look at the Preview window to see the results of your choices in the rest of this dialog box.

![Rendering Settings by Layer dialog box]

**Figure 25.21:** The decisions you make affect the Preview model.
4. Use the slider bars, input boxes, and check boxes in the various sections of the dialog box to define the material.

- Layer – click on Color in the Layer portion and click on the rectangle to make your selection from the Color Palette. Alternatively, click on the arrows on the right and left sides of the color box to scroll through options in the palette. All entities that have the same color will also have the same material properties. The first 15 colors shown on the ColorPalette are most frequently used in DataCAD and are the most popular; however, you can define up to 255 unique materials per drawing by using custom colors (beyond yellow). If you click on Layer, select the layer name from the drop-down list.

- Rendered Color – click on the rectangle to make your selection from the Color Palette. Use the slider bars to further determine the proportion of diffuse and ambient lighting properties of materials. A high diffuse proportion will cause the light from defined light sources to reflect strongly into various nonspecific directions. Use low diffuse values to simulate light-absorbing materials such as velvet. If the ambient proportion is too high, the object will appear relatively pale (like plastic) because it will very strongly reflect the environment's light. Rendered Color is the material color for all entities that are the current Layer Color. For example, if you choose white in the Layer Color section, the Rendered Color you select for all white entities could be Dahlia Purple or any other color in the Color Palette, including a custom-mixed color that you define with the Color Picker dialog box.

- Reflection - defines both the color and the proportional degree for reflections. In principle, the color defines the highlight on the objects. Higher reflection proportion values simulate glossy surfaces, such as chrome.

- Highlight Size – determines the size of reflected highlights from light sources. Adjustments to this value can only be seen in the o2c Player when using the raytrace option; they are not shown in the Preview window. You must use a relatively high reflective proportion to see the effect of changing this value. In principle, this value measures the intensity of a highlight as a function of the angle. The higher the value is, the smaller the highlight becomes. For matte-shining materials (such as unpolished gold or anodized aluminum), use small values around 3; for high gloss materials (such as polished gold or polished plastic), use large values.

- Opacity – the top slider bar determines the degree to which the material is opaque or transparent. A value of 50% means that when examining an object with this material, 50% of the color behind the object shows through it and 50% of the object's color is visible. The bottom slider bar affects how refractive (or hard) the transparent material is. To simulate glass, use a refractive index of 12; to simulate something like bubbles in water, use a refractive index smaller than 10. To see how your selections affect the material, you have to raytrace the object in the Preview window.

- Material File – mutually exclusive buttons apply preset Matte, Glossy, or Glass properties to the material. When you first work with the color map, you may rely on the presets; however, you will soon feel more confident about applying your own definitions via the slider bars and other options in this dialog box to produce photo-realistic materials. These presets affect the slider bars throughout the dialog box that keep the current rendered color, but change its reflective properties. Load lets you select an o2c color that will appear in the rectangle in the Rendered Color section; Save As lets you name and store your material definitions.

When simulating real-world elements using computer graphics, the surface properties of a material are based on various parameters. The level of realism depends partly on how the parameters are set. The o2c Player uses a standard computer material model known as PHIGS PLUS. This model simulates real-world material properties, but real-time renderers such as the o2c Player have limitations on how accurately they can be depicted in final rendered output.
The way an object (or surface) appears is affected by both the material properties and the lighting (including all sources which light the object). A rendered material is made up of a layering of different lighting properties (the diffuse portion simulates matte properties; the ambient portion reflects light in the environment; the reflective portion simulates polished material properties; and the opacity portion simulates transparent material properties.

By using bitmaps, you can also apply textures to enhance the material definition to simulate real-world surfaces such as carpet, tile, wallpaper, and brick. The preview window lets you see how a material will look before you apply it to your model.

Figure 25.22: The Load Material File dialog box

- Miscellaneous – check the boxes that apply: self-illuminate, render backface, and allow smoothing. Select self-illuminate to see the material even without lights. This causes an object to simulate a light source, but it will not illuminate its surroundings. This material setting is ideal for neon and other low-level lighting that is normally used in dark settings. Render backface forces the o2c Player to render both sides of a surface. By default, render backface is on for all colors. Smoothing blends a material across adjacent, noncoplanar polygons (such as a mesh surface). Otherwise, each polygon will be rendered independently, revealing the creases between adjacent polygons. This option is especially useful for rendering reflective and transparent objects that are made up of many polygons (such as a sphere or a cylinder). Without this option, shiny objects will reflect a fragmented view of the surrounding environment.

- Texture – controls the interaction of textures and the defined material. Check Apply Texture to activate other options. Experiment until you get the results you want in the Preview window.

In some cases, you may want to mix the colors of the texture with the diffuse color. This makes it possible to tint (or lighten or darken) a texture without modifying the original bitmap.

If you check Apply texture as reflection map, textures appear to be reflected from, rather than mapped onto, a given surface. This simulates optimum mirror images, where the object’s texture, not its environment, is reflected in the object.
RENDERING SETTINGS

Figure 25.23: Select the background image for the o2c viewer.

- Rendering Settings File – affects your settings, saved in a .DMF (DataCAD Material File). The Load button lets you access material assignments you created for other models. Save As lets you give the current definition a unique name.

- Preview Object – lets you apply your material definitions to different shapes: sphere, cube, cylinder, or teapot. One object may give you a better idea of how the material definition will affect the entities in your drawing than another. For example, if you wanted a velvety material, you probably would steer away from displaying it on the teapot.

- Background – controls the color behind the image. This is a global setting, independent from the material file. When you click on the rectangle, the Color Palette appears so that you can select a color.

Figure 25.24: Select the background image for the object viewer.

- Preview window – lets you see your material assignments. This is a mini o2c object viewer. Click on “R” to raytrace the material. Some material settings can only be seen in a raytraced view. Although the default object is a sphere, you could change this to a cube, cylinder, or teapot to give you a better idea of how the material will look in your model.
5. Click on OK when you are satisfied with all the settings in the color mapping dialog box.

6. Select Object Viewer from the View menu. The Object Viewer appears. The decisions that affect the STUCCO layer (see Figure 25.21) appear in the Object Viewer. If you are unhappy with the way the material looks, you can return to step 1 and go through the process again.

Figure 25.25: The results of decisions shown in Figure 25.22
Framing Your Model

FrameIt is a utility that helps you frame 3D floors, walls, and roofs. The RoofIt macro is used to create the outer portion of the 3D roof.

In this chapter:
- Framing floors
- Framing walls
- Framing roofs
- Saving and using framing settings
Framing Floors

Framing is easy when you use the FrameIt macro from your Toolbox pull-down menu. If the FrameIt
macro is not available, select Configure from the Toolbox pull-down menu and add it to your list of active
macros. For more information on adding FrameIt to your list, go to “Customizing the Macros Menu” and
“Customizing DataCAD” in “The Drawing Board” chapter.

➔ To frame a floor:

1. Choose Floors from the FrameIt menu.

2. Verify settings for Plate, Joist, and SubFloor. See “Sill Plate, Joist, and Sub-Floor Settings” in this
chapter for more information.

3. Choose either Center or Sides to define the floor boundary from the center line of the vertical
member or from one side of the floor to the other.

4. Define the floor to frame by defining a floor boundary or by choosing Select and selecting an
existing floor boundary. To define the floor boundary, object snap to each point of the floor
boundary, tracing the floor. If you make a mistake, use the Backup button to erase the last point
you selected.

5. Choose Opening to define floor openings, such as chimneys or stairs. Select the first point of the
floor opening, move the mouse to stretch the rubber band box around the opening, and select the
second point of the rubber band box to define the floor opening.

6. Choose Beam to define beam style and location. Set the following options as necessary:

<table>
<thead>
<tr>
<th>Single</th>
<th>Double</th>
<th>Custom</th>
<th>Color</th>
<th>Size</th>
<th>Flush</th>
<th>Below</th>
<th>Change</th>
<th>FileI/O</th>
</tr>
</thead>
<tbody>
<tr>
<td>Models single beams</td>
<td>Models double beams</td>
<td>Customizes the number of entities that make up a beam</td>
<td>Assigns a beam color. See “Color Menus” in “The Drawing Board” chapter for more information about how to choose a color.</td>
<td>Sets a beam size (choose Change to change a standard lumber size in the menu)</td>
<td>Positions the top of the beam flush or equal to the top of the joist</td>
<td>Positions the top of the beam equal to the bottom of the joist</td>
<td>Changes the current framing member attributes (those attributes set when you selected or defined the floor boundary)</td>
<td>Accesses file options to save the current framing settings in a file, load saved settings, or delete or rename framing settings files</td>
</tr>
</tbody>
</table>

7. Make any changes before choosing Build. Choose Edit or Change to access DataCAD editing
options (including Move, Copy, Rotate, Mirror, Stretch, Enlarge, Erase, and Layers) or to globally
change any floor member attributes. If you choose Edit or Change, you must choose Build again
for those changes to take effect.

8. Save floor settings to a file by choosing Save File from the FileI/O menu.

9. Choose Build and select the boundary on which to generate a floor system. Build generates a
framing system based on the settings you defined above. See the “The Drawing Board” chapter
for more information on using the selection menu to choose the boundary to frame.

Use the following toggles before you select the boundary to frame for added control over the
Build process:

<table>
<thead>
<tr>
<th>SchemLyr</th>
<th>ActvLyr</th>
</tr>
</thead>
<tbody>
<tr>
<td>Builds framing members on the schematic layer</td>
<td>Builds framing members on the active layer</td>
</tr>
</tbody>
</table>
FrsOnly Builds only floors with the current settings; otherwise, DataCAD builds all members; only available in the Floors/Build menu
WalsOnly Builds only walls with the current settings; otherwise, DataCAD builds all members; only available in the Walls/Build menu
RfsOnly Build only roofs with the current settings; otherwise, DataCAD builds all members; only available in the Roofs/Build menu

10. Finish framing. When framing is complete, you have access to the following DataCAD options: 3D Views, Hide, and Layers. See the “Viewing Your Model” and “Before You Draw” chapters for more information on 3D Views, Hide, and Layers.

11. Choose Exit to return to the Floors menu.

Sill Plate, Joist, and Subfloor Settings
Use Plate to set the following sill plate options:

DoPlate Models sill plates
Single Models single plates
Double Models double plates
Custom Customizes the number of entities that make up the plate
Color Assigns a plate color. See “Color Menus” in “The Drawing Board” chapter for more information about how to choose a color.
Size Sets a plate size; choose Change to change a standard lumber size in the menu

Use Joist to set the following joist options:

DoJoist Models the joists
Size Assigns a joist size, or defines a custom joist size; choose Change to change a standard lumber size in the menu
Spacing Assigns joist spacing (measure spacing from the center line of one joist to the center line of the next joist)
Color Assigns a joist color. See “Color Menus” in “The Drawing Board” chapter for more information about how to choose a color.
Angle Changes the angle in which your joist member will be modeled within the schematic

Use SubFloor to set the following subfloor options:

DoSubflr Models the subflooring
Single Models single layer subfloors
Double Models double layer subfloors
Custom Customizes the number of entities that make up a subfloor
Color Assigns a subfloor color. See “Color Menus” in “The Drawing Board” chapter for more information about how to choose a color.
Thickness Sets the subfloor thickness for each layer

Framing Walls

➢ To frame a wall:

1. Choose Walls from the FramIt menu.
2. Verify the settings for WallHght, Plate, and Stud. See “Wall Height, Plate, and Stud Settings” later in this chapter for more information.
3. Choose either Center or Sides to define the wall boundary from the center line of the vertical member or from one side of the wall to the other.
4. Choose either Exterior or Interior. Use Exterior to create outside wall systems; DataCAD assumes this will be a closed boundary. Use Interior to create inside wall systems; DataCAD toggles Closed off and you are drawing a single or string-line wall that does not close itself.

5. Define the wall to frame by defining a wall boundary or by choosing Select and selecting an existing floor or wall boundary. If defining the wall by the boundary, object snap to the first point of the wall boundary to frame and continue tracing the boundary from that point. If you make a mistake, use the Backup button to erase the last point you selected.

6. Choose Opening to define wall openings. Choose either Window or Door (for Exterior) or PassThru or Door (for Interior). If you choose Window or PassThru, verify the settings for Sill Height, HeadHght, and HeadStyl. For Door, define only HeadHght and HeadStyl.

   - **Window** Defines window openings in the wall
   - **Door** Defines door openings in the wall
   - **SillHght** Defines the sill height; available only when Window is toggled on
   - **HeadHght** Defines the header height of the door
   - **HeadStyl** Defines the header style:
     - **Cripple** Member with smaller studs that run from the top of the header to the bottom of the lower top plate; maintains stud spacing
     - **Boxed** Solid member that runs from the top of the header to the bottom of lower top plate
   - **Change** Changes any opening attributes
   - **FileI/O** Accesses file options to save the current framing settings in a file, load saved settings, or delete or rename framing settings files

7. Make any changes before choosing Build. Choose Edit or Change to access DataCAD editing options, including Move, Copy, Rotate, Mirror, Stretch, Enlarge, Erase, and Layers, or to globally change any wall member attributes. If you choose Edit or Change, you must choose Build again for those changes to take effect.

8. Save wall settings to a file by choosing Save File from the FileI/O menu.

9. Choose Build and select the boundary on which to generate a wall system. Build generates a framing system based on the settings you defined above. See “The Drawing Board” chapter for more information on using the selection menu to choose the boundary to frame.

   Use the following toggles before you select the boundary to frame for added control over the Build process:
   - **SchemLyr** Builds framing members on the schematic layer
   - **ActvLyr** Builds framing members on the active layer
   - **FlrsOnly** Builds only floors with the current settings; otherwise, DataCAD builds all members; only available in the Floors/Build menu
   - **WalsOnly** Builds only walls with the current settings; otherwise, DataCAD builds all members; only available in the Walls/Build menu
   - **RfsOnly** Builds only roofs with the current settings; otherwise, DataCAD builds all members; only available in the Roofs/Build menu

10. Choose Exit when framing is complete to return to the Walls menu.

**Wall Height, Plate, and Stud Settings**

Use WallHght to set wall height options. Choose a wall height from the list or type a wall height and press (Enter).

Use Plate to set the following top and bottom plate options:

- **DoTop** Models top plates
- **Single** Models single top plates
Double  Models double top plates
Custom  Customizes the number of entities that make up a top plate
Color  Assigns a top plate color. See “Color Menus” in “The Drawing Board” chapter for more information about how to choose a color.
DoBottom  Models bottom plates
Single  Models single bottom plates
Double  Models double bottom plates
Custom  Customizes the number of entities that make up a bottom plate
Color  Assigns a bottom plate color. See “Color Menus” in “The Drawing Board” chapter for more information about how to choose a color.

Use Stud to set vertical framing member options:

DoStud  Models the vertical stud member
Size  Assigns a stud size or defines a custom stud size
Spacing  Assigns stud spacing (measure spacing from the center line of one stud to the center line of the next stud)
Color  Assigns a stud color. See “Color Menus” in “The Drawing Board” chapter for more information about how to choose a color.

Framing Roofs

Use Roof Framing to create three-dimensional roof framing systems. You can frame the following roof types: Shed, Gable, Hip, and Gambrel. See “3D Roofs” later in this chapter for more information on roof types

➤ To frame a roof:

1. Choose Roofs from the Framelt menu.
2. Choose the roof type to frame: Shed, Gable, Hip, or Gambrel.
3. Choose Settings to set the options for roof settings, including pitch, purlin height, rafters, sheathing, and overhang. See “Settings” later in this section for more information.
4. Define the roof by defining a roof boundary or by choosing Select and selecting an existing wall or roof boundary. To define the roof with an existing boundary, choose that boundary and continue with step 6. To define the roof by a boundary, object snap to the first and second corners of the roof boundary to define the length of the roof parallel to the ridge. Make sure that you define the roof boundary at a Z-base set to the plate height of the wall.

The following options appear on the menu:

<table>
<thead>
<tr>
<th>Selected Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Closed</td>
<td>Models a closed roof boundary</td>
</tr>
<tr>
<td>Backup</td>
<td>Backs up one roof corner so you can enter a new position</td>
</tr>
<tr>
<td>Cancel</td>
<td>Returns you to the Framelt menu without defining a roof perimeter</td>
</tr>
<tr>
<td>Close/Exit</td>
<td>Stops defining the roof perimeter</td>
</tr>
</tbody>
</table>

5. Choose the third corner of the roof perimeter to define the width of the roof perpendicular to the ridge if you define the roof by the boundary. The roof boundary is calculated and closed.

6. Choose Opening to define roof openings, such as chimneys. Select the first point of the roof opening, move the mouse to stretch the rubber band box around the opening, and select the second point of the rubber band box to define the roof opening.

7. Make any changes before choosing Build. Choose Edit or Change to access DataCAD editing options (including Move, Copy, Rotate, Mirror, Stretch, Enlarge, Erase, and Layers) or to globally change any roof framing member attributes. If you choose Edit or Change, you must choose Build again for those changes to take effect.
8. Save roof settings to a file by choosing Save File from the File/O menu.

9. Choose Build and select the boundary on which to generate a roof system. Build generates a framing system based on the settings you defined above. When you define a roof boundary, FramIt bases the plate height on the current Z-Base setting. When you use Select to select an existing wall boundary, FramIt uses the plate height of the wall. FramIt always centers ridge boards when framing roofs.

10. Choose Exit when framing is complete to return to the Roofs menu.

**Settings**

Use Pitch to set a pitch for Shed, Gable, and Hip roofs. Pitch is defined by rise and run; choose a pitch from the menu, or choose Custom, type a pitch, and press (Enter). Use UprPitch and LwrPitch to set the pitch for the upper and lower sections, respectively, of a Gambrel roof.

Use MidRdgHt to set the height for purlins for Gambrel roofs. Choose a height from the menu, or choose Custom, type a height, and press (Enter).

Use Rafters to set the following rafter options:

- **DoRafter** Models rafters; models collar ties every four feet
- **Size** Sets a rafter size from the list, or defines a custom rafter size
- **Spacing** Sets rafter spacing or defines custom rafter spacing (measure spacing from the center line of one rafter to the center line of the next rafter)
- **Color** Sets a ridge board and rafter color. See “Color Menus” in “The Drawing Board” chapter for more information about how to choose a color.
- **EaveSqr** Models fascia square to the angle of the rafter
- **EavePlmb** Models fascia parallel to the wall
- **BrdMouth** Assigns a Bird’s Mouth dimension; choose a dimension from the menu, or choose Custom, type a dimension, and press (Enter)

Use Sheathing to set the following roof sheathing options:

- **DoSheath** Models roof sheathing
- **Single** Models single layer roof sheathing
- **Double** Models double layer roof sheathing
- **Custom** Models a custom number of roof sheathing layers
- **Color** Assigns a roof sheathing color. See “Color Menus” in “The Drawing Board” chapter for more information about how to choose a color.
- **Thickness** Assigns the thickness of the roof sheathing material or defines a custom thickness

Use the following OverHang options to set the overhang distance. Measure OverHang from the outside face of the sheathing to the outside face of the rafter.

- **EaveOhng** Assigns an overhang distance at the eave
- **RakeOhng** Assigns an overhang distance on the gable end

RoofIt automates the construction of 3D roof models. You define the roof boundary and RoofIt automatically calculates and constructs a roof based on your settings.

The standard roof types available with RoofIt are Gable, Hip, Boston, Gambrel, Mansard, and Shed. You can also create your own customized roof shape. You can vary the pitch, overhang, and plate height settings, and specify the type of soffit and fascia you want to model. RoofIt also lets you join a new roof to an existing roof. You can create dormers or other complex roof shapes using this feature. A complete roof model is composed entirely of 3D polygons. Because of this, you can easily process the model with DataCAD's hidden line removal feature, Hide.
Figure 26.1: Standard roof types

➢ To create a roof model:

1. Choose RoofIt from the Toolbox menu. The following options appear:
   - RectRoof: Constructs an orthogonal (rectangular) roof with no variation in settings; RectRoof is the easiest way to model a rectangular roof. RectRoof and PolyRoof are mutually exclusive; only one option will be displayed in the menu at any given time. If RectRoof appears in the RoofIt menu, clicking on it will change it to PolyRoof, putting DataCAD in polygonal roof drawing mode; you can begin drawing polygonal roofs. To change back to rectangular roof drawing mode, click on the PolyRoof option to change it to RectRoof.
   - PolyRoof: Constructs a polygonal roof that is not orthogonal or a roof that has varied pitch, overhang, or plate height settings
   - Gable: Available roof type
   - Hip: Available roof type
   - Boston: Available roof type
   - Gambrel: Available roof type
   - Mansard: Available roof type
   - Shed: Available roof type
   - Join: Defines a Gable, Hip, or Shed roof that connects to an existing roof plane; the roof that you join onto may be any roof type you create using RoofIt
   - Settings: Sets roof options depending on the type of roof you’re drawing. See “Setting Options” later in this section.
   - PlatHgt: Sets different plate height values for each roof line than what’s currently set in Settings/PlatHgt during PolyRoof creation; when PlatHgt is on, RoofIt prompts you for the plate height of each roof; only changes with Gable and Gambrel roofs
   - Pitch: Sets different pitch values for each roof line than what’s currently set in Settings/Pitch during PolyRoof creation; when Pitch is on, RoofIt prompts you for the pitch of each roof side; only changes with Gable and Gambrel roofs
   - Overhng: Sets different overhang values for each roof line than what’s currently set in Settings/Overhng during PolyRoof creation; when Overhng is on, RoofIt prompts you for the overhang of each roof side; only changes with Gable, Gambrel, and Shed roofs
   - Hide: Shortcut to the 3DEdit/Hide menu without exiting RoofIt. See the “Viewing Your Model” chapter for more information about Hide, 3D Views, and 3D Entity.
   - 3D Views: Shortcut to the 3D Views menu and look at your 3D model in different orientations without exiting RoofIt. See the “Viewing Your Model” chapter for more information about Hide, 3D Views, and 3D Entity.
   - 3DEntity: Shortcut to the 3DEntity menu without exiting RoofIt. See the “Viewing Your Model” chapter for more information about Hide, 3D Views, and 3D Entity.
2. Choose RectRoof or PolyRoof to define a rectangular or polygonal roof. See “Defining the Roof Boundary” later in this chapter for more information.

3. Choose one of the six standard roof types: Gable, Hip, Boston, Gambrel, Mansard, or Shed.

4. Choose Join if you are defining a roof to join with an existing Gable, Hip, or Shed roof plane.

5. Choose Settings to set roof options (if you don’t need to vary any values, skip to step 6). Choose the option to set. These options vary depending on which roof type you selected in step 3. See “Settings Options” later in this chapter for more information

6. Choose PlatHgt, Pitch, or Overhng from the RoofIt menu if you are creating a Gable, Gambrel, or Shed polygonal roof. This lets you change that setting for each roof edge you draw. Once you select the first point of the roof boundary, you can’t move the control from one parameter to another. You can only change the value of one parameter as you define the roof boundary.

7. Define a roof boundary by entering length and width values for a rectangular roof or by entering a series of four points for a polygonal roof. See “Defining the Roof Boundary” later in this chapter for more information.

8. Choose the roof plane to join to when prompted if you are defining a roof to join.

**Defining the Roof Boundary**

The method you use to define the roof boundary depends on whether the RectRoof or PolyRoof option appears in the RoofIt menu. (The option that appears is the type of roof you’ll draw.)

**Rectangular Roofs**

When you model a rectangular roof, you define the roof shape by selecting points (in a clockwise direction) that define its length and width. This results in an orthogonal roof shape.

➔ To define a rectangular roof boundary:

1. Choose PolyRoof if RectRoof is not displayed in the RoofIt menu. Then, toggle RectRoof on.

2. Select the first point of the roof boundary; this point is the first point of the roof length, which runs parallel to the ridge of the roof.

3. Select the second point of roof length.

4. Select the third point of the roof boundary to define the roof width. The roof width is the distance from one side of the building to the other; this is perpendicular to the roof length and roof ridge. On a Shed roof, this point locates the ridge (minus the overhang).

![Diagram of a rectangular roof boundary](Figure 26.2)

**Figure 26.2:** Defining a rectangular roof boundary
**Polygonal Roofs**

To model a nonorthogonal roof or one with varying parameters (PlatHgt, Pitch, or Overhng), use PolyRoof.

When you define a polygonal roof, you enter a series of four points. These points trace the edges of the roof boundary in a clockwise direction. The first and third edges of the boundary run parallel to the ridge; and the ridge bisects the second and fourth edges. Because the roof shape may be either orthogonal or nonorthogonal, the edges of the roof don’t have to be parallel and perpendicular to the ridge.

To define a polygonal roof boundary:

1. Choose RectRoof if PolyRoof is not displayed in the RoofIt menu. Then, toggle PolyRoof on.
2. Select the first point of the roof boundary. This is the first point of the roof length.
3. Enter the appropriate value if you’re drawing a Gable, Gambrel, or Shed roof and you toggled PlatHgt, Pitch, or OverHng on in the RoofIt menu. RoofIt applies this value to the first edge of the roof.
4. Select the second point of the first roof edge.
5. Enter a value if you’re drawing a Gable, Gambrel, or Shed roof and you toggled Overhng on in the RoofIt menu. RoofIt applies this value to the second edge of the roof.
6. Select the third point of the roof boundary. The second edge of the roof boundary is bisected by, but not necessarily perpendicular to, the ridge. The Shed roof is an exception; on a Shed roof, this point locates the ridge (minus the overhang).
7. Enter a value if you’re drawing a Gable, Gambrel, or Shed roof and you toggled PlatHgt, Pitch, or OverHng on in the RoofIt menu. RoofIt applies this value to the third edge of the roof.
8. Select the fourth point of the roof; unless you toggled OverHng on in the RoofIt menu, the boundary closes and the roof model is constructed.
9. Enter a value if you toggled Overhng on. RoofIt applies this value to the fourth edge of the roof. After you enter the value, the boundary closes and the roof model is constructed.

![Diagram of a polygonal roof boundary](image)

**Figure 26.3:** Defining an orthogonal PolyRoof boundary
Joining Roofs

Use Join to define a Gable, Hip, or Shed roof that connects to any one existing roof plane. The roof that you join onto may be any roof type created with RoofIt.

The following example shows how to use RectRoof to join a Hip roof; you can also use PolyRoof. Define the roof boundary in a clockwise manner regardless of which input mode you use: RectRoof or PolyRoof.

To join two roofs:

1. Model the first roof using the steps outlined at the beginning of this section.

2. Toggle Join on in the RoofIt menu. This tells RoofIt that the next roof you define will join onto an existing roof.

3. Define the boundary of the second roof. RoofIt prompts you to select the roof plane to join onto. When defining the joining roof, if you selected any parameters to vary, RoofIt prompts you for values as outlined in the previous sections.
Figure 26.7: Join: Defining the second boundary

4. Select a point within the perimeter of the roof plane to join to. RoofIt highlights the roof plane and starts the join operation. The roof you defined extends to and clips at the selected roof plane.

Figure 26.8: Selecting roof plane to join

Figure 26.9: Result of join (plan view and perspective hidden-line image)

**Settings Options**

The options that appear in the RoofIt/Settings menu depend on the type of roof you’re drawing. The following table illustrates which settings appear for each roof type:

<table>
<thead>
<tr>
<th></th>
<th>Gable</th>
<th>Hip</th>
<th>Boston</th>
<th>Gambrel</th>
<th>Mansard</th>
<th>Shed</th>
</tr>
</thead>
<tbody>
<tr>
<td>PlatHgt</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Pitch</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>MidRidge</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>2ndPitch</td>
<td></td>
<td></td>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>RoofThck</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Overhang</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>GblOffst</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>WallThck</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Fascia</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>EndWall</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>X</td>
</tr>
</tbody>
</table>
Settings options include:

- **PlatHgt**: Sets the roof plate height; this value is an absolute Z-value and is not relative to the current Z-base and Z-height settings.
- **Pitch**: Sets the roof pitch in rise and run values (4:12, 5:12, 6:12, etc.); or enter a Custom pitch.
- **MidRidge**: Sets the purlin height on a Gambrel or Mansard roof; mid-ridge is a Z distance relative to the current PlatHgt setting.
- **2ndPitch**: Sets the second pitch on a Gambrel or a Mansard roof in rise and run values (4:12, 5:12, 6:12, etc.); or enter a Custom pitch.
- **RoofThck**: Sets the plate thickness of the roof.
- **Overhng**: Sets the roof overhang; measure overhang in the X, Y plane, from the roof definition boundary to the outermost point on the fascia.
- **GblOffst**: Sets the gable offset on a Boston roof; this distance is measured in the X, Y plane from the roof definition boundary to the exterior face of the gable end wall; only available when you choose to draw a Boston roof.
- **WallThck**: Sets the exterior wall thickness; controls the distance in the X, Y plane from the roof definition boundary to the intersection of the plate and the bottom plane of the roof.
- **Fascia**: Sets the width of the fascia on roofs with plumb fascia and horizontal soffits; does not affect the roof thickness (controlled by RoofThck); fascia width cannot exceed the plumb distance through the roof thickness; only available when SoffHorz and FaciaPlb are toggled on.
- **SoffHorz/SoffIncl**: Toggles between SoffHorz and SoffIncl to define the shape of the soffit; toggle SoffHorz on to draw the underside of the overhang (the soffit) horizontal, or parallel to the ground; toggle SoffIncl on to draw the soffit inclined, or parallel to the roof plane.
- **FaciaPlb/FaciaSqr**: Toggles between FaciaPlb and FaciaSqr to define the shape of the fascia; toggle FaciaPlb on to draw the outside of the overhang (the fascia) plumb, or perpendicular to the ground; toggle FaciaSqr on to draw the fascia is square, or perpendicular to the roof plane.
- **EndWall**: Toggles the construction of end walls as part of the roof model (end walls fill in the gaps between the plate and the underside of the roof); when you toggle EndWall on, RoofIt prompts you to enter the color of the end walls. EndWall only appears when you select a Gable, Boston, Gambrel, or Shed roof type. RoofIt determines the thickness of the end wall by using WallThck.

**Figure 26.10**: Roof parameters

**Figure 26.11**: 2ndPitch and MidRidge settings
**Saving and Using Framing Settings**

Use File I/O to access file options:

- **Load File**    Loads a previously saved file of floor, wall, or roof framing settings
- **Save File**    Saves the current framing settings in a file
- **DelFile**      Deletes an existing file of framing settings
- **Rename**       Renames an existing file of framing settings
Modeling Concrete Forms

With the Concrete tool, you can add six different types of preconstructed concrete forms to your model: columns, inverted tee, single tee, double tee, standard, and I-beam forms. These forms are actually slabs and can be edited the same way you'd change regular DataCAD slabs, using the editing options in the 3D Menus.

With the exception of columns, all forms are drawn based on a defining line, which is the line connecting the two points you enter that represent the two ends of the form. In plan view, this line can define the right, left, or center of the form and can lie at Z-base or Z-height. This line can also be defined in the Z direction. In addition, the form’s top, bottom, or center can intersect the defining line in the Z direction. These options give you 18 possible positions for every form you draw.

In this chapter:
- Drawing columns
- Drawing inverted, single and double tee forms
- Drawing standard forms
- Drawing I-beam forms
Drawing Columns

Columns begin as rectangular boxes. You can chamfer the vertical edges of the column and add up to four seats to the column to support the girders and beams. The location of a column is defined by two points, at opposite corners of a box, indicating the overall dimensions of the column. The column extends vertically from the current value of Z-base to the current value of Z-height.

To draw columns:

1. Choose Column from the Toolbox menu’s Concrete submenu. The following options appear:
   - **Width**: Sets the column width
   - **Depth**: Sets the column height
   - **Rotate**: Enters columns that rotate about the entry point; you are prompted for the rotation angle of the column
   - **LoLeft**: Specifies the location of the column by its lower left corner
   - **Center**: Specifies the location of the column by its center point
   - **UpRight**: Specifies the location of the column by its upper right corner
   - **TopSeat/**BotSeat/**LtSeat/**RhtSeat**: These four options indicate the side of the column where the column seat is. You are prompted for the height of the column seat from the current value of Z-base (when a toggle is off, column seats are not added for that particular side)
   - **SeatOnly**: Adds column seats to an existing column or multiple sets of column seats to a single column in a multiple-story structure with monolithic concrete columns. When this toggle is on, you can add seats to a column, but you cannot add actual columns.
   - **SeatWdth**: Sets the distance from the face of the column to the outside of the column seat
   - **SeatHght**: Sets the distance from the top face of the column seat to the bottom edge of the column seat
   - **Chamfer**: Chamfers the edges of the column; otherwise, the column is angular in cross section (the size of the column seats automatically adjusts)
   - **ChamSize**: Sets the size of the column chamfers
2. Choose any options you want to set. When you choose Width, Depth, Rotate, TopSeat, BotSeat, LtSeat, RhtSeat, SeatWdth, and SeatHght a list of values appears.
3. Choose or type a value and press (Enter).
4. Select a point in the Drawing Window to place the column’s location.

Drawing Inverted, Single and Double Tee Forms

Inverted tees, or girders, are typically used for supporting single or double tees across a long span such as a parking garage bay. Because they are in the shape of an inverted T, the beam portion of a single, double, or quad tee can be placed on a tee’s shelf. You have a variety of options for changing the overall dimensions of the beam and for its placement in your model.

To draw an inverted tee:

1. Choose InvrtTee from the Concrete menu. The following options appear:
   - **OvrlHght**: Sets the overall height of the inverted tee; choose OvrlHght and then choose or type a value and press (Enter)
   - **OvrlWdth**: Changes the overall width of the inverted tee; choose OvrlWdth and then choose or type a value and press (Enter)
   - **NtchDpth**: Changes the depth of the notch in the inverted tee; choose NtchDpth and then choose or type a value and press (Enter)
BeamThck  Changes the thickness of the narrow portion of the inverted tee; choose BeamThck and then choose or type a value and press (Enter)
Left         Draws the form to the left of the defining line in the X-Y plane
Center       Draws the form centered about the defining line in the X-Y plane
Right        Draws the form to the right of the defining line in the X-Y plane
Top          Draws the form with its top aligned with the defining line
Center       Draws the form with its center aligned to the defining line
Bottom       Draws the form with its bottom aligned to the defining line
Z-Base       Sets the defining line at the Z-base
Z-Height     Sets the defining line at the Z-height
Single       Places a shelf on only one side of the inverted tee (to the left of the defining line) on the end of the first inverted tee that is entered
Double       Places shelves of identical size on both sides of the inverted tee

2. Select the first end of the defining line.
3. Select a second point that is the opposite end of the defining line.

Single tee concrete forms are used as combination beams and floor slabs. In applications where the primary function is creating floors, a double tee form is generally used. Industrial buildings and parking structures use double tees for upper floors that must support large floor loads. A double tee form is easier to position and place because of the stability provided by having two beam sections. Single tees are used in special cases, where spans are exceptionally long or floor loads are exceptionally high. In these cases, the weight and size of double tee forms can make them too large and heavy for practical fabrication, shipment, or placement.

To draw a single tee:
1. Choose SnglTee from the Concrete menu. The following options appear:

   Width         Sets the overall width of the single tee form (the location of the beam flanges of the form are automatically adjusted); choose Width and then choose or type a width and press (Enter)
   Depth         Sets the overall depth of the single tee form; choose Depth and then choose or type a depth and press (Enter)
   WebThck       Sets the thickness of the floor slab portion of the single tee form; choose WebThck and then choose or type a thickness and press (Enter)
   BeamThck      Sets the thickness of the two support beams for the single tee slab
   Left          Draws the form to the left of the defining line in the X-Y plane
   Center        Draws the form centered about the defining line in the X-Y plane
   Right         Draws the form to the right of the defining line in the X-Y plane
   Top           Draws the form with its top aligned to the defining line
   Center        Draws the form with its center aligned to the defining line
   Bottom        Draws the form with its bottom aligned to the defining line
   Z-Base        Places the defining line at Z-base
   Z-Hght        Places the defining line at Z-height

2. Set the size of cross-sectional dimensions of the single tee form.
3. Select the first end point of the defining line.
4. Select the second end point of the defining line.

To draw a double tee:
1. Choose DbleTee from the Concrete menu. The following options appear:

   Width         Sets the overall width of the double tee form (the location of the beam flanges of the form are automatically adjusted); choose Width and then choose or type a width and press (Enter)
Depth | Sets the overall depth of the double tee form; choose Depth and then choose or type a depth and press (Enter)
--- | ---
WebThck | Sets the thickness of the floor slab portion of the double tee form; choose WebThck and then choose or type a thickness and press (Enter)
BeamThck | Sets the thickness of the two support beams for the double tee slab; choose BeamThck and then choose or type a thickness and press (Enter)
Left | Draws the form to the left of the defining line in the X-Y plane
Center | Draws the form centered about the defining line in the X-Y plane
Right | Draws the form to the right of the defining line in the X-Y plane
Top | Draws the form with its top aligned to the defining line
Center | Draws the form with its center aligned to the defining line
Bottom | Draws the form with its bottom aligned to the defining line
Z-Base | Places the defining line at Z-base
Z-Hght | Places the defining line at Z-height

2. Set the size of the cross-sectional dimensions of the double tee form.
3. Select the first end point of the defining line.
4. Select the second end point of the defining line.

**Drawing Standard Beam Forms**

Standard beams have a simple rectangular cross section, but they can also have chamfers along the four edges of the beam. You can vary the height and width of the beam. There are 18 possible ways to position the beam relative to a defining line that extends from the first point entered to the second point entered.

➔ To draw a standard beam:

1. Choose Std Beam from the Concrete menu. The following options appear:

   Width | Sets the beam width
   Depth | Sets the beam depth
   Chamfer | Chamfers the beam on all edges; otherwise, the beam is rectangular in the cross section. When Chamfer is on, you must enter the chamfer size.
   Left | Draws the form to the left of the defining line in the X-Y plane
   Center | Draws the form centered about the defining line in the X-Y plane
   Right | Draws the form to the right of the defining line in the X-Y plane
   Top | Draws the form with its top aligned to the defining line
   Center | Draws the form with its center aligned to the defining line
   Bottom | Draws the form with its bottom aligned to the defining line
   Z-Base | Places the beam's defining line at the Z-base
   Z-Hght | Places the beam's defining line at the Z-height

2. Choose any options you want to set. When you choose Width, Depth, and Chamfer, a list of values appears. Choose or type a value and press (Enter).
3. Select the first end point of the defining line.
4. Select the second end point of the defining line.

**Drawing I-Beam Forms**

I-beams are similar to standard beams, except that the beam is narrower at the middle of the cross section than it is at either end of the cross section. For a typical application, the stresses in the concrete are much higher at the top or bottom of the beam; therefore, an I-beam can be more economical to use than a standard rectangular beam.
To draw an I-beam:

1. Choose I-Beam from the Concrete menu. The following options appear:
   - **Width**
     Sets the overall horizontal measurement of the cross section of the I-beam
   - **Depth**
     Sets the overall vertical measurement of the cross section of the I-beam
   - **WebThick**
     Sets the thickness of the narrower portion of the beam independently of the overall width of the I-beam
   - **FlngDpth**
     Sets the vertical dimensions of the I-beam flange independently of all other I-beam cross section dimensions
   - **Left**
     Draws the form to the left of the defining line in the X-Y plane
   - **Center**
     Draws the form centered about the defining line in the X-Y plane
   - **Right**
     Draws the form to the right of the defining line in the X-Y plane
   - **Top**
     Draws the form with its top aligned with the defining line
   - **Center**
     Draws the form with its center aligned with the defining line
   - **Bottom**
     Draws the form with its bottom aligned with the defining line
   - **Z-Base**
     Sets the beam’s defining line at the Z-base
   - **Z-Height**
     Sets the beam’s defining line at the Z-height

2. Choose any options you want to set. When you choose Width, Depth, WebThick, or FlngDpth, a list of values appears. Choose or type a value and press (Enter).

3. Select the first end of the defining line.

4. Select the second end of the defining line.
Modeling Stairs

The 3D Stairs tool gives you everything you need to create any of seven predefined 3D stairs, including single-run, straight-run, double-back, L-shaped, open-well, curved, and spiral stairs.

For each stair type, you can customize settings for treads, risers, landings, stringers, handrails, balusters, and more. These settings can then be reviewed on screen and even saved to a stair (.STR) file that will allow you to quickly load customized settings for drawing additional stairs.
**Drawing 3D Stairs**

The 3DStairs macro provides everything you need to create a set of three-dimensional stairs. 3DStairs creates real stairs, not stacked slabs, making this representation of stairs more accurate than ever before. The 3DStairs macro has these main features:

- seven predefined stair types -- single-run, straight-run, double-back, L-shaped, open-well, curved, and spiral
- a stair calculator, which makes it easy for you to calculate the values of stair settings and then readjust the Settings menu values

With the stair forms and other settings, you can customize the shape and placement of stair components. There are three ways to define the settings for the type of stairs you want to model:

- use the 3DStairs/Settings menu to select options and enter individual values for the various stair components
- use StrForm to display the settings on the screen for reference and/or customization
- save your stair settings to a file through the StrFile menu; when you want to model that specific stair type again, you can recall the file

Because of the interactive nature of stair components, changing one option can cause other options to change automatically. For example, when you close stringers, you can't have tread extensions.

The sections that follow describe how to create each stair type. You can only use the Stair Calculator for single-run stairs. See the “More About Drawing Single-Run Stairs” later in this chapter for more information.

➢ To draw 3D stairs:

1. Choose 3DStairs from the Toolbox pull-down menu.
2. Choose a stair type.
3. Set the options for the stair style you want. You can use either the Settings menu, the Stair Form, or load a stair file. When you model single-run stairs, you can use the Stair Calculator to determine the settings. See “More About Drawing Single-Run Stairs” later in this chapter for more information.

4. Choose Begin to place the stairs. The tool automatically changes to a plan view and a boundary box appears representing the run of stairs. When Ortho mode is on, the boundary box does not track with the cursor. Press (O) to toggle Ortho mode off.

5. Drag the stairs by the lower outside corner of the first run to the new stair position. The boundary box rotates as you move your cursor.

6. Rotate the stairs to the angle you want. The box rotates as you move the cursor.

7. Click to place the stairs. The stair model appears in the selected location with the settings you chose.

8. Change the results by erasing the last group by pressing (Shift) + (<) and repeat steps 2 through 6.

**More About Drawing Single-Run Stairs**

The Stair Calculator (Calculat) is available only when you create single-run stairs. Use it to calculate one of six possible values: total rise, number of risers, riser height, total run, number of treads, or tread depth.

Use the Stair Calculator as you would use a desktop calculator; prompts appear in the Message toolbar at the bottom of the screen. Save the answers to automatically update the 3DStairs/Settings menu for single-run stairs.

→ To use the stair calculator:

1. Choose Calculat from the 3DStairs menu.
2. Select an option from the Calculat menu to calculate and modify:

- **TotRise** The number of risers times the riser height; same value regardless of whether LandTop is on or off
- **# Risers** The total rise divided by the riser height, including the rise of the top landing; changing the number of risers automatically changes the number of treads and vice versa
- **RiserHgt** The vertical distance from the top of one tread to the top of the next tread; the total rise divided by the number of risers
- **TotalRun** The horizontal distance from the top of the run of stairs to the bottom of the stairs; the number of treads times the tread depth (the distance can include landing depth for the top and bottom landings when those toggles are turned on)
- **# Treads** The number of treads in the stair run; changing the number of treads automatically changes the number of risers and vice versa (you can set TreadDth from this menu to recalculate the number of treads)
- **TreadDth** The horizontal distance from the face of one riser to the face of the next riser; the total run divided by the number of treads (you can change # Treads in this menu)
- **LandBtm** When LandBtm is on, the total run value includes the bottom landing depth
- **LandTop** When LandTop is on, the total run value includes the top landing depth
- **Reset** Resets your calculator settings to the default values
- **Update** Overwrite the old settings in the Setting menu with new settings; saves your calculated values
- **Begin** Use Begin to start modeling stairs. Follow the steps in the “Using Stairs” section for information on using Begin.
- **Template** Shortcut to the Template menu; select a template from the menu, or type a template name, and press (Enter)
- **Hide** Perform hidden line removals; see “Hide” in the “3D Editing” chapter for more information. See the “Viewing Your Model” chapter for more information on templates, hidden line removals, and the 3D Views menu.
- **3D Views** Shortcut to the 3D Views menu; see the “3D Viewing” chapter for more information

3. Look at the submenu that appears after some Calculat menu options. If this occurs, choose an option to modify; if not, skip to step 5.

4. Choose a new value from the menu or type a different value. As you change the values of a setting, the results are automatically calculated and displayed. The stair calculator only accepts a whole number of treads or risers as a result. If the values you enter in a calculation result in a fractional solution, the stair calculator modifies the values.

5. Modify other options by repeating steps 3 and 4.

6. Choose Update to update the settings in the 3DStairs/Settings menu.

![Figure 29.2: Total rise, riser height, and number of risers](image-url)
**Figure 29.3:** Total run, tread depth, and number of treads

For example, to calculate the number of risers through changing RiserHgt:

<table>
<thead>
<tr>
<th></th>
<th>Initial Settings</th>
<th>Modified Settings</th>
<th>Stair Calculator Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>TotlRise</td>
<td>12’0”</td>
<td>12’0”</td>
<td>12’3”</td>
</tr>
<tr>
<td>RiserHgt</td>
<td>6”</td>
<td>7”</td>
<td>7”</td>
</tr>
<tr>
<td>#Risers</td>
<td>24</td>
<td>20.57</td>
<td>21</td>
</tr>
</tbody>
</table>

Because #Risers is a fractional number, the Stair Calculator automatically adjusts the TotlRise so that the results are whole numbers. If you change TotlRise, Stair Calculator adjusts RiserHgt to find a whole number solution.

**Customizing Stair Settings**

Use the Settings menu to change the settings for 3DStairs. Different options appear depending on the stair type you selected from the 3DStairs menu.

The options in the top half of the menu are global settings that apply to all stair types. The bottom half of the menu are stair component submenus. Each of these submenus contains the various settings for that particular component.

When you choose any of the Settings options, a list of values appears. Choose a value or press (Enter) to accept the given value.

**Base Elevation**

Use BaseElev to change the base elevation of a flight of stairs. Base elevation is the height, or elevation, at which the flight of stairs begins.
Treads
Use TrdLngth to change the tread length. The tread length is the horizontal distance from one side of the tread to the other side. It does not include tread extension values. Any tread extensions are added to the tread length and only apply to stairs modeled with open stringers.

Figure 29.5: Tread length

Use Trd/Run1 to change the number of treads in the first run of stairs. This applies to all stair types. The number of treads does not include the landing at the top of the run and is equal to one less than the number of risers.

Use Trd/Run2 to change the number of treads in the second run of stairs. Trd/Run2 is only available for straight, double-back, open-well, and L-shaped stairs.

Use Trd/Run3 to change the number of treads in the third run of stairs. Trd/Run3 is only available for open-well stairs.

Radius of Curved Stairs
Use Radius to change the inner radius of curved and spiral stairs. Measure Radius from the exact center point to the inside face of the stringer for curved stairs and the radius of the center pole for spiral stairs.

Figure 29.6: Radius on a curved flight of stairs

Clockwise
Clockwise applies to all stair types except single and straight. You can place the stairs clockwise or counterclockwise depending on your needs.

Chases
Use Chase to control the horizontal distance between the runs of a double-back flight of stairs. This setting affects the width of the intermediate landing and the tread length.
Landings
The top, bottom, and in some cases, intermediate landings all have depth and thickness settings. You can change the specific settings for each landing you create by using the Landing menu in the 3DStairs/Settings menu. (Changing the settings on the top landing does not affect the settings of the bottom landing and vice versa.)

Toggle DoLndTp on to model a landing at the top of the flight of stairs; toggle DoLndBt on to model a landing at the bottom of a flight of stairs.

The Depth option sets the landing depth. The landing depth is the horizontal distance from the front of the landing to the rear of the landing. When you model L-shaped or open-well stairs, you cannot set a landing depth on the intermediate landing. The landing depth equals the width of the run of stairs.

Thickness shows the current thickness of a landing. Measure the landing thickness vertically from the underside to the top side. Thickness sets the top, intermediate, and bottom landing thicknesses.

For stair types that have intermediate landings, IntrLand is always on. It is available for straight, double-back, open-well, or L-shaped stairs only. For rectangular or curved intermediate landings, use the Rectangle/Curved option; this is available for L-shaped, double-back, or open-well stairs only.

Use Color to set the landing color. All landings in a single flight of stairs are modeled using the same color. See “Color Menus” in “The Drawing Board” chapter for more information about how to choose a color.
**Risers**

Use the Riser menu to set options that create risers and determine riser height, thickness, and color. Toggle DoRiser on to model risers on your flight of stairs.

RiserHgt displays the current riser height in the Message toolbar and lets you reset it. The riser height is the vertical distance from the top of one tread to the top of the next.

![Diagram of Riser Height, Total Rise, and Tread Depth](image)

**Figure 29.9: Riser height, total rise, and tread depth**

The Thickness option displays the current riser thickness in the Message toolbar and lets you reset it. The *riser thickness* is the horizontal distance from the front side of the riser to the backside of the riser when you choose Thickness.

Use Color to set the landing color. All landings in a single flight of stairs are modeled using the same color. See “**Color Menus**” in “The Drawing Board” chapter for more information about how to choose a color.

**Treads**

Use Tread to set options that model treads and determine the depth, thickness, and nosing of the treads. Toggle DoTread on to automatically calculate and model treads on a flight of stairs.

Depth displays the current tread depth in the Message toolbar and lets you reset it. The tread depth is the horizontal distance from the front of one tread to the front of the next tread. When you select a spiral stair, TredDegr (tread degrees) appears in the menu in place of depth. Tread degrees displays the inclusive angle of the treads on spiral stairs in the Message toolbar and lets you reset it.

Thickness displays the current tread thickness in the Message toolbar and lets you reset it. The tread thickness is the vertical distance from the top side of the tread to the bottom side of the tread.

LeftExtn and RghtExtn display the current left and right extension, respectively, of the tread in the Message toolbar and lets you reset it. Left extension includes tread length, the distance from one stringer to the next. LeftExtn controls the distance that the tread extends beyond the outside of the stringer. LeftExtn is available only for stairs with open stringers.
Figure 29.10: Tread extension

When Nosing is toggled on, you can set the nosing length and type for treads. 3DStairs prompts you for an overhang value when you toggle nosing on. Nosing controls the distance that the front of the tread extends beyond the front of the riser.

To set the nosing type to square or round, click on the RndNosng/SqrNosng toggle. This Nosing option changes between round and square just by clicking on it. If RndNosng appears in the Nosing menu, round nosing will be drawn on the stair treads; if SqrNosng appears in the Nosing menu, square nosing will be drawn on the stair treads.

Figure 29.11: Nosing

Use Color to set the color for the treads. All treads in a flight of stairs are the same color. See “Color Menus” in “The Drawing Board” chapter for more information about how to choose a color.

Stringers

Stringer allows you to set options that create stringers and determine where and what kind you want to use. Toggle DoLeft on to model a stringer on the left side of the run of stairs, toggle DoCtr on to model a stringer in the center of a run of stairs, or toggle DoRght on to model a stringer on the right side of the stairs. When using DoCtr, the stringer is always modeled as an open stringer.

Use the ClosdStr/OpenStr toggle to set the stringer type to open or closed. When ClosdStr appears in the Stringer menu, stringers will be modeled as closed; when OpenStr appears in the Stringer menu, stringers will be modeled as open. Choose ClosdStr or OpenStr to toggle between the two options.

Width displays the current width of the stringer in the Message toolbar and lets you reset it. Measure the width from the top edge of the stringer to the bottom edge of the stringer.
The stringer thickness is the horizontal distance from the inside of the stringer to the outside of the same stringer. Choose Thickness from the Stringer menu and then choose or type a new thickness value and press (Enter).

Use Color to set the color for the stringer. All stringers in a flight of stairs are modeled using the same color. See “Color Menus” in “The Drawing Board” chapter for more information about how to choose a color.

**Handrails**

Toggle DoLeft on to model a handrail on the left side of the flight of stairs. Toggle DoRght on to model a handrail on the right side of a flight of stairs. When either of these options is toggled off, 3DStairs does not model the handrails on that side of the stairs.

The Rectangle/Cylinder toggle lets you choose between modeling a cylindrical or rectangular handrail. When you select Cylinder, the Radius and Division options appear for you to enter settings. When you select Rectangle, the Width and Depth options appear for you to set.

The Radius/Width toggle displays the current radius or width of the handrail in the Message toolbar, depending on whether you selected cylindrical or rectangular handrails. When you model a cylindrical handrail, you can adjust the radius of the cylinder. When you model a rectangular handrail, you can adjust the width of the rectangle. Measure the width from the top of the handrail to the bottom of the handrail.
The Depth/Division toggle displays the current depth or number of divisions in the handrail in the Message toolbar, depending on whether you select cylindrical or rectangular handrails. When you model a cylindrical handrail, you can adjust the division of the cylinder, or the number of sides in the cylinder. When you model a rectangular handrail, you can adjust the depth of the rectangle. Measure the depth from one side of the handrail to the other side. You can use up to 36 divisions, but the more divisions you have, the longer it takes DataCAD to redraw.

Use Height to see or reset the current height of the handrail. Measure the handrail height from the top surface of the handrail to the top of the tread.

Use Color to set the color for the handrails. All handrails in a flight of stairs are modeled using the same color. See “Color Menus” in “The Drawing Board” chapter for more information about how to choose a color.

**Balusters**

Use the Baluster menu in the 3DStairs/Settings menu to choose what kind of balusters, if any, to use for your stairs. Toggle DoBalus in the Baluster menu on to model balusters on your flight of stairs.

The Baluster menu has three options for baluster placement. OnSide models balusters on the sides of the stringers, OnTread models balusters on the treads, and OnStrng models balusters on the center of the stringer. OnStrng is available only when you model a closed stringer.

Depending on whether you choose OnSide, OnTread, or OnStrng for baluster placement, either the Bal/Tred or Bal/Run1 option appears in the Baluster menu. The Bal/Tred option displays the number of balusters per tread in the Message Window and lets you change the value. Bal/Tred is only available when you use OnTread. The Bal/Run1 option displays the current number of balusters in the first run of the stairs in the Message toolbar and lets you change that value. Bal/Run1 is available only when you place the balusters on the side of the stringer (OnSide) or on the stringer (OnStrng).
The Bal/Run2 option displays the current number of balusters in the second run of the stairs in the Message toolbar and lets you change that value. Bal/Run2 is available only when you place the balusters on the side of the stringer (OnSide) or on the stringer (OnStrng) on straight, double-back, open-well, and L-shaped stairs.

The Bal/Run3 option displays the current number of balusters in the third run of the stairs in the Message toolbar and lets you change that value. Bal/Run3 is available only when you place the balusters on the side of the stringer (OnSide) or on the stringer (OnStrng) on open-well stairs.

Use Cylinder/Rectangle to choose between modeling a cylindrical or rectangular baluster. When you select Cylinder, the Radius and Division options appear. When you select Rectangle, the Width and Depth options appear.

The Radius/Width toggle displays the current radius or width of the baluster in the Message toolbar, depending on whether you selected cylindrical or rectangular balusters. When you model a cylindrical baluster, you can adjust the radius of the cylinder. When you model a rectangular baluster, you can adjust the width of the rectangle. Measure the width from one side to the other of one baluster.

The Depth/Division toggle displays the current depth or number of divisions in the baluster in the Message toolbar, depending on whether you selected cylindrical or rectangular balusters. When you model a cylindrical baluster, you can adjust the division of the cylinder, or the number of sides in the cylinder. When you model a rectangular baluster, you can adjust the depth of the rectangle. Measure the depth from the front to the back of the baluster. You can use up to 36 divisions, but the more divisions you have, the longer it takes DataCAD to redraw.

![Figure 29.16: Baluster width and depth](image)

Use Symbol to model balusters as symbols. When balusters are symbols, you can replace the balusters produced by 3DStairs with different, more detailed baluster symbols that you create.

1. To use custom balusters in stairs:
   1. Create your detailed baluster in the DataCAD drawing window and save it as a symbol. See “Creating and Editing Symbols” in the “Symbols, Images, and Objects” chapter for more information.
   2. Choose 3DStairs from the Toolbox pull-down menu.
   3. Set the baluster options as necessary.
   4. Toggle Symbol on to draw the balusters as symbols.
   5. Create your run of stairs.
   6. Replace the existing balusters with the symbol you created in step 1 using the Replace option in the Template menu. See “Replacing Symbols in Your Drawing” in the “Symbols, Images, and Objects” chapter for more information.
VertOfst shows the current vertical offset of the baluster. Vertical is the distance that the bottom end of the balusters extends below the treads. Vertical offset appears only when you select OnSide.

HorzOfst shows the current horizontal offset of the baluster. When you model balusters on the treads, measure the offset from the side edge of the tread to the middle of the baluster. HorzOfst only appears when you select OnTread.

Use Color to set the color for the balusters. All balusters in a flight of stairs are modeled using the same color. See “Color Menus” in “The Drawing Board” chapter for more information about how to choose a color.

**Newel Posts**

Use NewelPst to model newel posts on the stairs. Toggle DoNIPst on to model newel posts on a flight of stairs. When DoNIPst is toggled off, 3DStairs models balusters in place of newel posts.
Use Cylinder/Rectangle to choose between modeling a cylindrical or rectangular newel post. When you select Cylinder, the Radius and Division options appear. When you select Rectangle, the Width and Depth options appear.

The Radius/Width toggle displays the current radius or width of the newel post, depending on whether you selected cylindrical or rectangular newel posts, in the Message toolbar. When you model a cylindrical newel post, you can adjust the radius of the cylinder. When you model a rectangular newel post, you can adjust the width of the rectangle. Measure width from one edge, near a baluster, to the other edge, facing out, of the same newel post.

The Depth/Division toggle displays the current depth or number of divisions in the newel post, depending on which of the previous options you selected, in the Message toolbar. When you model a cylindrical newel post, you can adjust the division of the cylinder, or the number of sides in the cylinder. When you model a rectangular newel post, you can adjust the depth of the rectangle. Measure the depth from the edge of the newel post near the handrail to the open edge. You can use up to 36 divisions, but the more divisions you have, the longer it takes DataCAD to redraw.

Use Symbol to model newel posts as symbols. When newel posts are symbols, you can replace the newel posts produced by 3DStairs with custom newel post symbols that you create.

To use custom newel posts in stairs:

1. Create your detailed newel post in the DataCAD drawing window and save it as a symbol. See “Creating and Editing Symbols” in the “Symbols, Images, and Objects” chapter for more information.
2. Choose 3DStairs from the Toolbox pull-down menu.
3. Set the newel post options as necessary.
4. Toggle Symbol on to draw the newel posts as symbols.
5. Create your run of stairs.
6. Replace the existing newel posts with the symbol you created in step 1 using the Replace option in the Template menu. See “Replacing Symbols in Your Drawing” in the “Symbols, Images, and Objects” chapter for more information.

Use Color to set the color for the newel posts. All newel posts in a flight of stairs are modeled using the same color. See “Color Menus” in “The Drawing Board” chapter for more information about how to choose a color.

Stair Form

➔ To display values and settings for all stair types:

1. Choose StrForm from the 3DStairs menu.
2. Press (Tab) to move forward or (Shift) + (Tab) to move backward through each line of the stair form.
3. Scroll through the two-page form by selecting Scroll Fwrd or Scroll Back from the menu.
4. Press (Esc) to save settings and exit the StrForm menu or choose Exit to leave the StrForm menu without saving any changes. For settings with options, you can scroll through them using (Spacebar).

Saving and Using Stair Settings

Use the StrFile option in the 3DStairs menu to save stair settings for future use, as well as load, save, delete, and rename stair setting files:

LoadStr  Loads a stair settings file; choose LoadStr from the StrFile menu and type the name of the file to load
SaveStr  Saves your current stair settings to a file; choose SaveStr from the StrFile menu and type the name of the file to save
DelStr  Deletes a stair settings file; choose DelStr from the StrFile menu and type the name of the file to delete
Rename  Renames an existing stair file; choose Rename from the StrFile menu, choose the file to rename, and type a new name
StrForm  Shortcut to the Stair Form menu. See “Stair Form” earlier in this chapter for more information on using this menu.
Appendix

This appendix contains additional information for advanced users as well as tables defining such things as DataCAD’s standard line types, hatch patterns, and keyboard shortcuts.

In this chapter:
- INI Settings
- DWG/DXF translation tables
- Creating custom toolbars
- Creating line types
- Standard hatch patterns
- Creating keyboard shortcuts
- Standard keyboard shortcuts
- Standard fonts
- Extended characters
### INI Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| [General]
PurgeDrawingsOnExit=1 | Enables or disables the automatic purging of unused drawing data upon exiting and saving a drawing. |
| [General]
USER_NAME=John Doe
USER_COMPANY=John Doe Architects, Inc.
USER_SERIAL=DCXIWO0000 | Identifies the user, company, and serial number for the current DataCAD version. |
| [General]
CAVWALL=FALSE | If TRUE, inserting doors and windows into cavity (4-line) walls trims the outer jamb lines to the cavity lines. |
| [General]
CoplanarCheck=FALSE | If TRUE, this forces the vertices on 3D polygons with more than three sides to be coplanar, based on the first three noncollinear vertices. |
| [General]
ShowWinCursor=FALSE | If TRUE, it would activate the Windows system cross-hair cursor along with the DataCAD cursor. This is useful for screen capture programs that record the movement of the Windows system cursor. |
| [General]
OldHelp=FALSE | If TRUE, accessing help from the pull-down menu or with [Ctrl]+[F1] opens the old DCADWIN.HLP instead of the new DataCAD11_Manual.PDF. |
| [General]
MinusKeyTogglesOvershoot=TRUE | If FALSE, the minus key will invoke direct distance input. |
| [General]
CommaKeyErasesLastEntity=TRUE | If FALSE, the comma key will invoke direct distance input. |
| [General]
PeriodKeyRestoresLastEntity=TRUE | If FALSE, the period key will invoke direct distance input. |
| [General]
CapsLock=FALSE | If TRUE, the AllCaps toggle operates like CapsLock instead of forcing all uppercase letters. |
| [General]
FixFont=FALSE | If TRUE, corrects fonts with zero width character definitions. |
| [General]
HYPERVIEW=ALT | If ALT, access hyperlinked views using [Alt]+Left-click. If ALT+SHIFT, access hyperlinked views via [Alt]+[Shift]+Left-click. |
| [General]
SymbolCacheSize=2 | Size (in whole numbers) of Symbol Browser cache in megabytes. |
<table>
<thead>
<tr>
<th>Section</th>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>NoGridInSelect=TRUE</td>
<td>If FALSE, DataCAD will not automatically disable grid snapping during selection and Window In.</td>
</tr>
<tr>
<td>Paths</td>
<td>INSTALL_DIR=c:\Program Files\DCADLT\</td>
<td></td>
</tr>
<tr>
<td></td>
<td>PATH_SWAP=Temporary Files\</td>
<td></td>
</tr>
<tr>
<td></td>
<td>PATH_SUPPORT=Support Files\</td>
<td></td>
</tr>
<tr>
<td></td>
<td>PATH_DEFAULTS=Support Files\</td>
<td></td>
</tr>
<tr>
<td></td>
<td>PATH_ICON=Support Files\Toolbars\</td>
<td></td>
</tr>
<tr>
<td></td>
<td>PATH_BMP=Support Files\Toolbars\</td>
<td></td>
</tr>
<tr>
<td></td>
<td>PATH_MSG=Support Files\</td>
<td></td>
</tr>
<tr>
<td></td>
<td>PATH_HELP=Help\</td>
<td></td>
</tr>
<tr>
<td></td>
<td>PATH_RECOVERY=Recover Archive\</td>
<td></td>
</tr>
<tr>
<td></td>
<td>PATH_PENTABLE=Support Files\</td>
<td></td>
</tr>
<tr>
<td>PaletteFile</td>
<td>DoCustomColors=TRUE</td>
<td>If TRUE, DataCAD will save the 16 custom colors that can be defined using the Windows Color Picker from the Pen Table dialog.</td>
</tr>
<tr>
<td>o2cViewer</td>
<td>SmoothDistance=0</td>
<td>Distance between adjacent poly-gons to be considered for smoothing.</td>
</tr>
<tr>
<td>o2cViewer</td>
<td>SmoothAngle=30</td>
<td>Angle between adjacent polygons to be considered for smoothing.</td>
</tr>
<tr>
<td>Printer</td>
<td>FitToAdjustment=0</td>
<td>Percentage (positive or negative whole number) to add or subtract from DataCAD's automatic FitTo calculation.</td>
</tr>
<tr>
<td>Printer</td>
<td>NewFitTo=TRUE</td>
<td>If TRUE, DataCAD uses a more accurate method to determine the available print area which may be incompatible with some drivers. If FALSE, DataCAD uses the original method to determine the available print area.</td>
</tr>
<tr>
<td>Alias</td>
<td>PopupWidth=300</td>
<td>Width of command line alias popup window in pixels.</td>
</tr>
<tr>
<td>Alias</td>
<td>PopupLines=4</td>
<td>Number of lines displayed in command line alias window.</td>
</tr>
<tr>
<td>MenuBtn</td>
<td>BTN_SPACING=2</td>
<td>Set the number of pixels between menu buttons vertically; alternatively, set the number of pixels to add or subtract from the width of menu buttons.</td>
</tr>
<tr>
<td>StatusArea</td>
<td>DropDownList=0</td>
<td>Width in pixels to add or subtract from Status Panel.</td>
</tr>
<tr>
<td>Undo</td>
<td>Disabled=FALSE</td>
<td>If TRUE, undo/redo system is disabled.</td>
</tr>
</tbody>
</table>
**DWG/DXF Translation Tables**

Importing data from a DWG or DXF file to a DataCAD (.AEC) file is not always a one-to-one translation. There are a few instances where data is handled differently in DataCAD. For instance, entities in AutoCAD with a color-by-block attribute will be read into DataCAD as white.

Dimension arrowheads must also be changed in order to display in DataCAD. AutoCAD arrowheads, which are blocks (symbols), will be replaced *globally* with the arrow style set with the ArroStyl option of the Dimensions menus. When exported back to a DWG/DXF file, all arrowheads will be set to the AutoCAD default. Dimension text and extension lines will remain the same color, but dimension lines will be changed to the same color as the extension lines.

Text, in some cases, is also treated differently in DataCAD. A single instance of vertical text in a DWG/DXF file will be translated to horizontal text. MText (AutoCAD’s multi-line text) is broken into single lines; it is no longer a single entity.

Symbol Attributes appear as Block Attributes when you open a DWG file.

Third-party fonts may need to be scaled to display correctly. To adjust the scale and aspect of a font, open the CHR2SHX.DAT in the \CHR subdirectory of your DataCAD directory, locate the font in the list, and modify the values as necessary. Fonts can also be added to the list; remember to update the total number of fonts in the file (value located on first line of file). Be sure to make necessary adjustments before you import or export a file, so that the changes will appear in that file.

The Importing and Exporting sections that follow provide translation tables showing how entities are treated in “round-trip” scenarios, where a file would begin and end in AutoCAD or DataCAD.

### Importing

<table>
<thead>
<tr>
<th>AUTOCAD</th>
<th>DATACAD</th>
<th>AUTOCAD</th>
</tr>
</thead>
<tbody>
<tr>
<td>2D Polyline</td>
<td>Polyline</td>
<td>2D Polyline (rel.13 or 14)</td>
</tr>
<tr>
<td>(parallel to X,Y plane)</td>
<td></td>
<td>Polyline (rel.12)</td>
</tr>
<tr>
<td>2D Polyline</td>
<td>Polyline Symbol‡</td>
<td>2D Polyline (rel.13 or 14)</td>
</tr>
<tr>
<td>(not parallel to X,Y plane)</td>
<td></td>
<td>Polyline (rel.12)</td>
</tr>
<tr>
<td>2D Polyline</td>
<td>Polyline‡</td>
<td>2D Polyline (rel.13 or 14)</td>
</tr>
<tr>
<td>(with width assigned to any vertices)</td>
<td></td>
<td>Polyline (rel.12)</td>
</tr>
<tr>
<td>3DFace</td>
<td>Polygon</td>
<td>3DFace</td>
</tr>
<tr>
<td>3D Polyline (with varying Z values)</td>
<td>3D Line</td>
<td>Line</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>---------</td>
<td>------</td>
</tr>
<tr>
<td>3D Polyline (planar—no varying Z values)</td>
<td>Polyline (parallel to X,Y plane)</td>
<td>2D Polyline</td>
</tr>
<tr>
<td>Arc (parallel to X,Y plane)</td>
<td>Arc</td>
<td>Arc</td>
</tr>
<tr>
<td>Arc (not parallel to X,Y plane; thickness=0)</td>
<td>3D Arc</td>
<td>Arc</td>
</tr>
<tr>
<td>Arc (not parallel to X,Y plane; thickness ≠ 0)</td>
<td>Cylinder†</td>
<td>Arc</td>
</tr>
<tr>
<td>Attribute Definition</td>
<td>Text† (constant data is saved as attributes; variable data is lost)</td>
<td>Attribute Definition</td>
</tr>
<tr>
<td>Block‡</td>
<td>Symbol</td>
<td>Block</td>
</tr>
<tr>
<td>Circle (parallel to X,Y plane)</td>
<td>Circle</td>
<td>Circle</td>
</tr>
<tr>
<td>Circle (not parallel to X,Y plane; thickness = 0)</td>
<td>3D Arc†</td>
<td>Circle</td>
</tr>
<tr>
<td>Circle (not parallel to X,Y plane; thickness ≠ 0)</td>
<td>Cylinder†</td>
<td>Circle</td>
</tr>
<tr>
<td>Dimensions</td>
<td>Associative Dimensions</td>
<td>Dimensions</td>
</tr>
<tr>
<td>Dimensions (angular, radius, or diameter dimensions and leaders)</td>
<td>Lines and text</td>
<td>Lines and text</td>
</tr>
<tr>
<td>Donut (parallel to X,Y plane)</td>
<td>Polyline†</td>
<td>Donut</td>
</tr>
<tr>
<td>Donut</td>
<td>Polyline Symbol†‡</td>
<td>Donut</td>
</tr>
<tr>
<td>Object</td>
<td>Example</td>
<td>Notes</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>----------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>(not parallel to X,Y plane)</td>
<td>Ellipse</td>
<td>Ellipse (rel.13 or 14) Lines (rel.12)</td>
</tr>
<tr>
<td>Ellipse</td>
<td>Ellipse</td>
<td>Ellipse (rel.13 or 14) Lines (rel.12)</td>
</tr>
<tr>
<td>Hatch</td>
<td>Associative Hatch (if hatch</td>
<td>Lines</td>
</tr>
<tr>
<td></td>
<td>boundary is LW polyline)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Associative Hatch Symbol‡ (if</td>
<td></td>
</tr>
<tr>
<td></td>
<td>hatch boundary is LW polyline</td>
<td></td>
</tr>
<tr>
<td></td>
<td>but not parallel to X,Y plane)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Lines (if hatch boundary includes</td>
<td></td>
</tr>
<tr>
<td></td>
<td>any other boundary type besides</td>
<td></td>
</tr>
<tr>
<td></td>
<td>LW polyline)</td>
<td></td>
</tr>
<tr>
<td>Leaders</td>
<td>Lines and Text</td>
<td>Lines and Text</td>
</tr>
<tr>
<td>Light-Weight Polyline</td>
<td>(See 2D Polyline above)</td>
<td></td>
</tr>
<tr>
<td>Line (parallel to X,Y plane)</td>
<td>Line</td>
<td>Line</td>
</tr>
<tr>
<td>Line (not parallel to X,Y</td>
<td>3D Line</td>
<td>Line</td>
</tr>
<tr>
<td>plane; thickness = 0)</td>
<td>Polygon†</td>
<td>Line (if coordinates unchanged)</td>
</tr>
<tr>
<td>Line (not parallel to X,Y</td>
<td>Polygon (if coordinates changed</td>
<td></td>
</tr>
<tr>
<td>plane; thickness ≠ 0)</td>
<td>in directions other than axis</td>
<td></td>
</tr>
<tr>
<td></td>
<td>of thickness)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Line, with changed thickness</td>
<td></td>
</tr>
<tr>
<td></td>
<td>(if polygon stretched along the</td>
<td></td>
</tr>
<tr>
<td></td>
<td>axis of thickness)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Polygon (if coordinates changed</td>
<td></td>
</tr>
<tr>
<td></td>
<td>in directions other than axis</td>
<td></td>
</tr>
<tr>
<td></td>
<td>of thickness)</td>
<td></td>
</tr>
<tr>
<td>MText</td>
<td>Text</td>
<td>Text</td>
</tr>
<tr>
<td>Mesh</td>
<td>Polygons</td>
<td>Polygons</td>
</tr>
<tr>
<td>Point</td>
<td>Point‡</td>
<td>Point</td>
</tr>
<tr>
<td>DWG/DXF TRANSLATION TABLES</td>
<td>533</td>
<td></td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----</td>
<td></td>
</tr>
<tr>
<td>Point (with thickness)</td>
<td>3D Line†£</td>
<td>Point</td>
</tr>
<tr>
<td>Polyface Mesh</td>
<td>Polygons</td>
<td>Polygons</td>
</tr>
<tr>
<td>Spline</td>
<td>Point†</td>
<td>Spline (rel.13 or 14)</td>
</tr>
<tr>
<td>Solid</td>
<td>Polygons, triangulated</td>
<td>3D Faces</td>
</tr>
<tr>
<td>Text, single line or multi-</td>
<td>Text</td>
<td>Text</td>
</tr>
</tbody>
</table>

† AutoCAD entity is imported into DataCAD as an entity with attributes. If the entity is edited in DataCAD, upon export it will return to its original (AutoCAD) entity type, incorporating the changes you made in DataCAD. Exceptions to this are exploding an entity, which permanently changes the entity type, or deleting an entity.

‡ AutoCAD entity is imported into DataCAD as a symbol. These symbols are like any other in DataCAD; they cannot be edited unless they are first exploded. If you explode an entity in 3D space, however, it will flatten to the X,Y plane. For instance, a Donut in a DWG file that is not parallel to the X,Y plane will be imported into DataCAD as a Polyline Symbol. If this symbol is not exploded, it will maintain its position when exported back to a DWG file. If the symbol is exploded, however, it will flatten to the X,Y plane, even when exported back to a DWG file.

£ Point shape is lost in translation.

§ A block comprised of entities on different layers will be imported into DataCAD as a symbol on the layer where the block was inserted; that is, all entities for that Block will be moved to the insertion layer. These entities will remain on this layer when exported back to a DXF or DWG file. Also, anonymous (unnamed) blocks in AutoCAD will be given a unique, numeric name when imported into DataCAD; this name will be saved with the block when exported.

There are a few AutoCAD entities that cannot be read, displayed, or otherwise saved during translation. These include: XREFs, viewports, ACIS data (Body), Rays (XLines), Ole Frames, Ole2 Frames, Tolerances, Images, Regions, Proxies, and named views.

### Exporting

<table>
<thead>
<tr>
<th>DATACAD</th>
<th>AUTOCAD</th>
<th>DATACAD</th>
</tr>
</thead>
<tbody>
<tr>
<td>3D Arc</td>
<td>Arc</td>
<td>3D Arc</td>
</tr>
<tr>
<td>3D Line</td>
<td>Line</td>
<td>3D Line (if not parallel to X,Y plane)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Line (if parallel to X,Y plane)</td>
</tr>
<tr>
<td>Arc</td>
<td>Arc</td>
<td>Arc</td>
</tr>
<tr>
<td>B-spline</td>
<td>Polyline</td>
<td>Polyline</td>
</tr>
<tr>
<td>Bezier</td>
<td>Polyline</td>
<td>Polyline</td>
</tr>
<tr>
<td>Circle</td>
<td>Circle</td>
<td>Circle</td>
</tr>
<tr>
<td>Cone</td>
<td>Polyface Mesh</td>
<td>Polygons</td>
</tr>
<tr>
<td>------</td>
<td>---------------</td>
<td>---------</td>
</tr>
<tr>
<td></td>
<td>3D Faces (if Decompose in Options dialog is on during export)</td>
<td></td>
</tr>
<tr>
<td>Contour</td>
<td>Polyline</td>
<td>Polyline</td>
</tr>
<tr>
<td>Cylinder</td>
<td>Polyface Mesh</td>
<td>Polygons</td>
</tr>
<tr>
<td></td>
<td>3D Faces (if Decompose in Options dialog is on during export)</td>
<td></td>
</tr>
<tr>
<td>Dimensions (Associative)</td>
<td>Dimensions</td>
<td>Dimensions (Associative)</td>
</tr>
<tr>
<td>Ellipse</td>
<td>Ellipse (rel.13 or 14)</td>
<td>Ellipse</td>
</tr>
<tr>
<td></td>
<td>Lines (rel.12)</td>
<td></td>
</tr>
<tr>
<td>Hatch (Associative)</td>
<td>Lines</td>
<td>Lines</td>
</tr>
<tr>
<td>Line</td>
<td>Line</td>
<td>Line</td>
</tr>
<tr>
<td>Mesh Surface</td>
<td>Polyface Mesh</td>
<td>Polygons</td>
</tr>
<tr>
<td></td>
<td>3D Faces (if Decompose in Options dialog is on during export)</td>
<td></td>
</tr>
<tr>
<td>Point</td>
<td>Point</td>
<td>Point</td>
</tr>
<tr>
<td>Polygon</td>
<td>3D Face</td>
<td>Polygon</td>
</tr>
<tr>
<td>(with 3-4 vertices and no voids)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Polygon</td>
<td>Triangulated into multiple 3D Faces</td>
<td>Multiple 3-sided polygons</td>
</tr>
<tr>
<td>(with 5 or more vertices and/or voids)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Polyline</td>
<td>Lightweight Polyline (rel.14)</td>
<td>Polyline</td>
</tr>
<tr>
<td></td>
<td>Polyline (&lt;rel.14)</td>
<td></td>
</tr>
<tr>
<td>Sphere</td>
<td>Polyface Mesh</td>
<td>Polygons</td>
</tr>
<tr>
<td></td>
<td>3D Faces (if Decompose in Options dialog is on during export)</td>
<td></td>
</tr>
<tr>
<td>Surface of Revolution</td>
<td>Polyface Mesh</td>
<td>Polygons</td>
</tr>
<tr>
<td></td>
<td>3D Faces (if Decompose in Options dialog is on</td>
<td></td>
</tr>
</tbody>
</table>
Creating Custom Toolbars

In versions prior to DataCAD 11, creating custom toolbars involved using complicated and cumbersome .KEY files. Beginning with DataCAD 11, the former .KEY files were automatically converted to the new DTB, INI-based DataCAD Toolbar format. The following examples show the differences between the former KEY file and new DTB toolbar formats.

### KEY File Format

```plaintext
! | | | | | |
*01 | | | | |
L | undo 119 | UNDO last action |
L | redo 120 | REDO previous action |
L | [LAYERS_S]23 | Layers menu |
L | [LINTYP_S]15 | Line Type menu |
L | [ARCTCT_S]11 | Architect menu |
A | [2DWALL_S]·("F1") | Toggle Walls on/off - Architect menu |
A | [2LWALL_S]·("F2") | Select 2 line walls - Architect menu |
A | [3LWALL_S]·("F3") | Select 3 line walls - Architect menu |
A | [4LWALL_S]·("F4") | Select 4 line walls - Architect menu |
```

### DTB File Format

```plaintext
[undo]
Hint=UNDO last action
Icon=undo
L=119

[redo]
Hint=REDO previous action
Icon=redo
L=120

[LAYERS_S]
Hint=Layers menu
Icon=LAYERS_S
L=23

[LINTYP_S]
Hint=Line Type menu
Icon=LINTYP_S
L=15

[ARCTCT_S]
Hint=Architect menu
Icon=ARCTCT_S
```
Creating New Icons

1. Create a 16-color, square bitmap in bitmap (.BMP) format.
2. Save it with a filename in the \DataCAD\Support Files\Toolbars\ directory.

Toolbar Icon Button Size

The default size of icon buttons used in toolbars is 16x16 pixels. However, if you’d like to use larger icon buttons, you can select another size by using the Configure DataCAD for Windows Settings dialog box.

To change icon button size:

1. Select Program Preferences from the Tools pull-down menu to display the Configure DataCAD for Windows Settings dialog box.
2. Click on the Interface tab.
3. Choose a different value in the Icon Size portion. Valid values are 16, 24, and 32. An Information dialog box states that the changed icon size will not take effect until you restart DataCAD.

   This setting only changes the available button area for icon bitmaps. It does not make small icons larger or large icons smaller.

4. Click on Ok to close the Information dialog box. Then click on OK to close the Configure DataCAD for Windows Settings dialog box.
5. Exit from DataCAD; then restart the program.

Drop-Down Toolbar Items

You can add drop-down items to your own toolbars. To add a drop-down section to a toolbar use the following format in the INI file.
[SECTION]
Icon= (insert the bitmap filename)
Hint= (insert the tool tip)
A= (insert the action form; e.g., Alt-???)
DropDownCount=3 (change the number if more or less than 3 new icons)

Icon00=
Hint00=
A00=

Icon01=
Hint01=
A01=

Icon02=
Hint02=
A02=

Selecting the parent icon will perform the action if one is defined or will drop down the child icons if no action is defined. Hints for child icons will be used as menu labels.

**Action Codes for Toolbars**
The following action codes have been added for use in Toolbars:

<table>
<thead>
<tr>
<th>Action Code</th>
<th>Number</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>L</td>
<td>171</td>
<td>Partial Erase menu</td>
</tr>
<tr>
<td>L</td>
<td>172</td>
<td>2D Polygon by rectangle</td>
</tr>
<tr>
<td>L</td>
<td>173</td>
<td>Arrows menu</td>
</tr>
<tr>
<td>L</td>
<td>174</td>
<td>Drop Mesh menu</td>
</tr>
<tr>
<td>L</td>
<td>175</td>
<td>Ruled Surface menu</td>
</tr>
<tr>
<td>L</td>
<td>176</td>
<td>TIN Surface menu</td>
</tr>
<tr>
<td>L</td>
<td>177</td>
<td>3D Mirror menu</td>
</tr>
<tr>
<td>A</td>
<td>1000#</td>
<td>2D Polygon Vertex On</td>
</tr>
<tr>
<td>A</td>
<td>1001#</td>
<td>2D Polygon Vertex Off</td>
</tr>
<tr>
<td>A</td>
<td>1002#</td>
<td>2D Polygon Diameter On</td>
</tr>
<tr>
<td>A</td>
<td>1003#</td>
<td>2D Polygon Diameter Off</td>
</tr>
<tr>
<td>A</td>
<td>1004#</td>
<td>2D Polygon Inscribe On</td>
</tr>
<tr>
<td>A</td>
<td>1005#</td>
<td>2D Polygon Inscribe Off</td>
</tr>
<tr>
<td>A</td>
<td>1006#</td>
<td>2D Polygon Rectangle On</td>
</tr>
<tr>
<td>A</td>
<td>1007#</td>
<td>2D Polygon Rectangle Off</td>
</tr>
<tr>
<td>A</td>
<td>1008#</td>
<td>Polyline Rectangle On</td>
</tr>
<tr>
<td>A</td>
<td>1009#</td>
<td>Polyline Rectangle Off</td>
</tr>
<tr>
<td>A</td>
<td>1010#</td>
<td>Symbol Browser On</td>
</tr>
<tr>
<td>A</td>
<td>1011#</td>
<td>Symbol Browser Off</td>
</tr>
<tr>
<td>A</td>
<td>1012#</td>
<td>Jamb In On</td>
</tr>
<tr>
<td>A</td>
<td>1013#</td>
<td>Jamb In Off</td>
</tr>
<tr>
<td>A</td>
<td>1014#</td>
<td>Clip Cube Ignore Z On</td>
</tr>
<tr>
<td>A</td>
<td>1015#</td>
<td>Clip Cube Ignore Z Off</td>
</tr>
<tr>
<td>A</td>
<td>1016#</td>
<td>One Line Trim by Entity On</td>
</tr>
<tr>
<td>A</td>
<td>1017#</td>
<td>One Line Trim by Entity Off</td>
</tr>
<tr>
<td>A</td>
<td>1018#</td>
<td>Offset Snap On</td>
</tr>
<tr>
<td>A</td>
<td>1019#</td>
<td>Offset Snap Off</td>
</tr>
<tr>
<td>A</td>
<td>1020#</td>
<td>Enter new Offset Snap distance</td>
</tr>
<tr>
<td>A</td>
<td>1021#</td>
<td>Go to Polygon menu and do not change Rectangle status</td>
</tr>
<tr>
<td>A</td>
<td>1022#</td>
<td>Isometric</td>
</tr>
<tr>
<td>A</td>
<td>1023#</td>
<td>Assign Material (formerly Rendering Settings)</td>
</tr>
<tr>
<td>A</td>
<td>1024#</td>
<td>Auto3D (Smart Walls) On</td>
</tr>
<tr>
<td>A</td>
<td>1025#</td>
<td>Auto3D (Smart Walls) Off</td>
</tr>
</tbody>
</table>
**Standard Line types**

<table>
<thead>
<tr>
<th>Name</th>
<th>Pattern</th>
<th>Line spacing values</th>
<th>Defined by:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Standard</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Solid</td>
<td></td>
<td>N/A</td>
<td>Center</td>
</tr>
<tr>
<td>Dotted</td>
<td>...</td>
<td>1 = 1'-0&quot; on center dots</td>
<td>Center</td>
</tr>
<tr>
<td>Dashed</td>
<td>--</td>
<td>1 = 1'-0&quot; on center dashes</td>
<td>Center</td>
</tr>
<tr>
<td>Dot-Dash</td>
<td>--</td>
<td>1 = 1'-0&quot; on center dot to dot</td>
<td>Center</td>
</tr>
<tr>
<td>ElecLine</td>
<td></td>
<td>1 = 1'-0&quot; on center E to E</td>
<td>Center</td>
</tr>
<tr>
<td>TelLine</td>
<td></td>
<td>1 = 1'-0&quot; on center T to T</td>
<td>Center</td>
</tr>
<tr>
<td>Box</td>
<td>° o °</td>
<td>1 = 1'-0&quot; on center box to box</td>
<td>Center</td>
</tr>
<tr>
<td>PropLine</td>
<td></td>
<td>1 = 1'-0&quot; on center double dashes</td>
<td>Center</td>
</tr>
<tr>
<td>Insul</td>
<td>0.3 = 6&quot; width insulation</td>
<td>Center</td>
<td></td>
</tr>
<tr>
<td>Plywood1</td>
<td></td>
<td>0.0.3/4 = 3/4&quot; width plywood</td>
<td>Left edge at line angle of 90°</td>
</tr>
<tr>
<td>Plywood2</td>
<td></td>
<td>0.0.1/2 = 1/2&quot; wide plywood</td>
<td>Left edge at line angle of 90°</td>
</tr>
<tr>
<td>Hedge</td>
<td></td>
<td>1 = 4&quot; wide line pattern</td>
<td>Center</td>
</tr>
<tr>
<td>CentrLin</td>
<td></td>
<td>1 = 1'-0&quot; dash to dash</td>
<td>Center</td>
</tr>
<tr>
<td>Section</td>
<td></td>
<td>1 = 1'-0&quot; on center breaks</td>
<td>Center</td>
</tr>
<tr>
<td>ShingleR</td>
<td></td>
<td>0.8 = 4&quot; to the weather</td>
<td>Left edge at line angle of 270°</td>
</tr>
<tr>
<td>LapSidR</td>
<td></td>
<td>0.4 = 4&quot; to the weather</td>
<td>Left edge at line angle of 270°</td>
</tr>
<tr>
<td>ShipLap</td>
<td></td>
<td>0.4 = 4&quot; to the weather</td>
<td>Left edge at line angle of 270°</td>
</tr>
<tr>
<td>Brick</td>
<td></td>
<td>0.8 = 4&quot; nominal brick width</td>
<td>Left edge at line angle of 90°</td>
</tr>
<tr>
<td>4Block</td>
<td></td>
<td>0.8 = 4&quot; nominal brick width</td>
<td>Left edge at line angle of 90°</td>
</tr>
<tr>
<td>8Block</td>
<td></td>
<td>0.8 = 8&quot; nominal block width</td>
<td>Left edge at line angle of 90°</td>
</tr>
<tr>
<td>12Block</td>
<td></td>
<td>0.8 = 12&quot; nominal block width</td>
<td>Left edge at line angle of 90°</td>
</tr>
<tr>
<td>RigidIns</td>
<td></td>
<td>0.2 = 2&quot; thickness</td>
<td>Left edge at line angle of 90°</td>
</tr>
<tr>
<td>Grass</td>
<td></td>
<td>0.5 = 3&quot; high grass</td>
<td>Lower edge at line angle of 90°</td>
</tr>
<tr>
<td>GroundLn</td>
<td></td>
<td>1 = 6&quot; between pattern breaks</td>
<td>Lower edge at line angle of 90°</td>
</tr>
<tr>
<td>ShingleL</td>
<td></td>
<td>0.8 = 4&quot; to the weather</td>
<td>Right edge at line angle of 270°</td>
</tr>
<tr>
<td>LapSidL</td>
<td></td>
<td>0.4 = 4&quot; to the weather</td>
<td>Right edge at line angle of 270°</td>
</tr>
</tbody>
</table>
Standard Hatch Patterns

Hatch patterns included with DataCAD are pictured below.

- Angle
- 31
- 32
- 33
- 34
- 35
- 36
- 37
- 38
- Box
- Brass
- Brick
Standard Keyboard Shortcuts

<table>
<thead>
<tr>
<th>FUNCTION/MENU</th>
<th>MNEMONIC</th>
<th>KEY(S)</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 Line Trim menu</td>
<td>Join</td>
<td>(Alt) + (J)</td>
</tr>
<tr>
<td>3D Menus</td>
<td></td>
<td>(J)</td>
</tr>
<tr>
<td>3D Entity menu</td>
<td></td>
<td>(J) or (Alt) + (U)</td>
</tr>
<tr>
<td>3D Views menu</td>
<td>Views</td>
<td>(Y) or (Shift) + (V)</td>
</tr>
<tr>
<td>3D Views menu</td>
<td></td>
<td>or (Alt) + (V)</td>
</tr>
<tr>
<td>Active layer, scroll</td>
<td></td>
<td>(Shift) + (Tab)</td>
</tr>
<tr>
<td>backward to set</td>
<td></td>
<td>(Tab)</td>
</tr>
<tr>
<td>Active layer, scroll forward</td>
<td></td>
<td></td>
</tr>
<tr>
<td>to set</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Append selection set toggle</td>
<td>Append</td>
<td>(Shift) + (A)</td>
</tr>
<tr>
<td>Architect menu</td>
<td>architect</td>
<td>(A)</td>
</tr>
<tr>
<td>Cap wall ends toggle</td>
<td></td>
<td>(1)</td>
</tr>
<tr>
<td>Center screen to cursor</td>
<td></td>
<td></td>
</tr>
<tr>
<td>location</td>
<td></td>
<td>(Home)</td>
</tr>
<tr>
<td>Change menu</td>
<td>Change</td>
<td>(Alt) + (C)</td>
</tr>
<tr>
<td>Colors, scroll backward</td>
<td>Kolors</td>
<td>(Shift) + (K)</td>
</tr>
<tr>
<td>Colors, scroll forward</td>
<td>kolors</td>
<td>(K)</td>
</tr>
<tr>
<td>Coordinate entry</td>
<td></td>
<td>(SpaceBar)</td>
</tr>
<tr>
<td>Copy to clipboard</td>
<td>Copy</td>
<td>(Ctrl) + (C)</td>
</tr>
<tr>
<td>Copy menu (2D/3D)</td>
<td>Copy</td>
<td>(C) or (Shift) + (C)</td>
</tr>
<tr>
<td>Cursor size toggle (big vs.</td>
<td></td>
<td>(+)</td>
</tr>
<tr>
<td>regular)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Curves menu</td>
<td>Arcs</td>
<td>(Alt) + (A)</td>
</tr>
<tr>
<td>Cut to clipboard</td>
<td></td>
<td>(Ctrl) + (X)</td>
</tr>
<tr>
<td>Digitizer</td>
<td>digitIzer</td>
<td>(I)</td>
</tr>
<tr>
<td>Dimensions menu</td>
<td>Dimension</td>
<td>(D) or (Shift) + (D)</td>
</tr>
<tr>
<td>Dimensions, Linear menu</td>
<td>Dimension</td>
<td>(Alt) + (D)</td>
</tr>
<tr>
<td>Directory of current drawing</td>
<td>directorY</td>
<td>(Alt) + (Y)</td>
</tr>
<tr>
<td>dialog box</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Display list, regenerate</td>
<td></td>
<td>(U) or (Shift) + (U)</td>
</tr>
<tr>
<td>Display associated saved view</td>
<td></td>
<td>(Shift) + (1) to (0)</td>
</tr>
<tr>
<td>Edit menu</td>
<td></td>
<td>(;)</td>
</tr>
<tr>
<td>Sel. Sets menu</td>
<td>Selection sets</td>
<td>(Shift) + (S)</td>
</tr>
<tr>
<td>Elevation, back</td>
<td></td>
<td>(Ctrl) + (PgUp)</td>
</tr>
<tr>
<td>Elevation, front</td>
<td></td>
<td>(Alt) + (=)</td>
</tr>
<tr>
<td>Elevation, left</td>
<td></td>
<td>(F11)</td>
</tr>
<tr>
<td>Elevation, right</td>
<td></td>
<td>(F12)</td>
</tr>
<tr>
<td>Enlarge menu</td>
<td>Enlarge</td>
<td>(Alt) + (E)</td>
</tr>
<tr>
<td>Erase last entity</td>
<td></td>
<td>(;)</td>
</tr>
<tr>
<td>Erase last group</td>
<td></td>
<td>(&lt;)</td>
</tr>
<tr>
<td>Erase menu (2D/3D)</td>
<td>Erase</td>
<td>(E) or (Shift) + (E)</td>
</tr>
<tr>
<td>Exit</td>
<td></td>
<td>(Ctrl) + (F4)</td>
</tr>
<tr>
<td>Fillets menu</td>
<td>Fillets</td>
<td>(Alt) + (F)</td>
</tr>
<tr>
<td>Freehand menu</td>
<td>freeHand</td>
<td>(Alt) + (H)</td>
</tr>
<tr>
<td>Geometry menu</td>
<td>Geometry</td>
<td>(Alt) + (G)</td>
</tr>
<tr>
<td>Command</td>
<td>Input Mode</td>
<td></td>
</tr>
<tr>
<td>-------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>GoTo View menu</td>
<td>View (V)</td>
<td></td>
</tr>
<tr>
<td>Grids menu</td>
<td>Grids (G) or (Shift) + (G)</td>
<td></td>
</tr>
<tr>
<td>Hatching menu</td>
<td>Hatch (H) or (Shift) + (H)</td>
<td></td>
</tr>
<tr>
<td>Help</td>
<td>(Ctrl) + (F1)</td>
<td></td>
</tr>
<tr>
<td>Hide menu</td>
<td>(Shift) + (Y)</td>
<td></td>
</tr>
<tr>
<td>Identify</td>
<td>Identify (Shift) + (I) or (Alt) + (I) (Insert)</td>
<td></td>
</tr>
<tr>
<td>Input mode:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1: Relative Polar</td>
<td>(distance, angle)</td>
<td></td>
</tr>
<tr>
<td>2: Absolute Polar</td>
<td>(distance, angle)</td>
<td></td>
</tr>
<tr>
<td>3: Relative Cartesian</td>
<td>(x, y coordinates)</td>
<td></td>
</tr>
<tr>
<td>4: Absolute Cartesian</td>
<td>(x, y coordinates)</td>
<td></td>
</tr>
<tr>
<td>Layer search toggle</td>
<td>’()</td>
<td></td>
</tr>
<tr>
<td>Layers menu</td>
<td>Layers (L) or (Shift) + (L)</td>
<td></td>
</tr>
<tr>
<td>Line overshoot amount</td>
<td>( _)</td>
<td></td>
</tr>
<tr>
<td>Line overshoot toggle</td>
<td>(-)</td>
<td></td>
</tr>
<tr>
<td>Line spacing, set</td>
<td>(F)</td>
<td></td>
</tr>
<tr>
<td>Line Type menu</td>
<td>Line type (Alt) + (L)</td>
<td></td>
</tr>
<tr>
<td>Line types, scroll</td>
<td>(Shift) + (Q)</td>
<td></td>
</tr>
<tr>
<td>backward in Status Panel toolbar</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Line types, scroll</td>
<td>(Q)</td>
<td></td>
</tr>
<tr>
<td>forward in Status Panel toolbar</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Line weight, decrement</td>
<td>BIG Weight to small (Shift) + (W)</td>
<td></td>
</tr>
<tr>
<td>Line weight, increment</td>
<td>little Weight to big (W)</td>
<td></td>
</tr>
<tr>
<td>Group menu</td>
<td>linK (Alt) + (K)</td>
<td></td>
</tr>
<tr>
<td>Measures menu</td>
<td>(Alt) + (X)</td>
<td></td>
</tr>
<tr>
<td>Mirror menu (2D)</td>
<td>Mirror (Alt) + (M)</td>
<td></td>
</tr>
<tr>
<td>Move menu (2D/3D)</td>
<td>Move (M)</td>
<td></td>
</tr>
<tr>
<td>Multi-view windows</td>
<td>multi-view Windows (Ctrl) + (W)</td>
<td></td>
</tr>
<tr>
<td>New drawing, create</td>
<td>New (Ctrl) + (N) or (Alt) + (N)</td>
<td></td>
</tr>
<tr>
<td>Object snap</td>
<td>sNap (N) or (Shift) + (N)</td>
<td></td>
</tr>
<tr>
<td>Object Snap menu</td>
<td>(Shift) + (X)</td>
<td></td>
</tr>
<tr>
<td>Object Snap perpendicular toggle</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Online Help</td>
<td>(Alt) + (O)</td>
<td></td>
</tr>
<tr>
<td>Open Files</td>
<td>Open (Ctrl) + (F1)</td>
<td></td>
</tr>
<tr>
<td>Ortho mode toggle</td>
<td>Orthogonal (O) or (Shift) + (O)</td>
<td></td>
</tr>
<tr>
<td>Orthographic View</td>
<td>orthographic (Alt) + (I)</td>
<td></td>
</tr>
<tr>
<td>Pan</td>
<td>Arrow keys (up, down, right, and left)</td>
<td></td>
</tr>
<tr>
<td>Parallel View, most</td>
<td>recent (Alt) + (9)</td>
<td></td>
</tr>
<tr>
<td>recent</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Paste from clipboard</td>
<td>(Ctrl) + (V)</td>
<td></td>
</tr>
<tr>
<td>Perspective View, most</td>
<td>recent (Alt) + (-)</td>
<td></td>
</tr>
<tr>
<td>recent</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Plotter menu</td>
<td>Plotter (Alt) + (P)</td>
<td></td>
</tr>
<tr>
<td>Polygons menu</td>
<td>Rectangle (Alt) + (R)</td>
<td></td>
</tr>
</tbody>
</table>
Creating Keyboard Shortcuts for Pull-down Menu Options

You can create keyboard shortcuts for any of the 250+ pull-down menu selections by editing the DCADWIN.MNU file. The format of the menu file is Label|Shortcut|Hint. Any shortcut you add to the MNU file will supersede any existing DataCAD shortcut if they are the same. The following key sequences are supported.

(0-9)
Example: Open|5|Open Existing File

(A-Z)
Example: Open|E|Open Existing File
(F1-F12)
Example: Open|F5|Open Existing File

([CTRL] + (0-9), (A-Z), (F1-F12))
Example: Open|CTRL+5|Open Existing File
Example: Open|CTRL+E|Open Existing File
Example: Open|CTRL+F5|Open Existing File

([CTRL] + [SHIFT] + (0-9), (A-Z), (F1-F12))
Example: Open|CTRL+SHIFT+5|Open Existing File
Example: Open|CTRL+SHIFT+E|Open Existing File
Example: Open|CTRL+SHIFT+F5|Open Existing File

([CTRL] + [ALT] + (0-9), (A-Z), (F1-F12))
Example: Open|CTRL+ALT+5|Open Existing File
Example: Open|CTRL+ALT+E|Open Existing File
Example: Open|CTRL+ALT+F5|Open Existing File

([SHIFT] + (0-9), (A-Z), (F1-F12))
Example: Open|SHIFT+5|Open Existing File
Example: Open|SHIFT+E|Open Existing File
Example: Open|SHIFT+F5|Open Existing File

([ALT] + (0-9), (A-Z), (F1-F12))
Example: Open|ALT+5|Open Existing File
Example: Open|ALT+E|Open Existing File
Example: Open|ALT+F5|Open Existing File

([ALT] + [SHIFT] + (0-9), (A-Z), (F1-F12))
Example: Open|ALT+SHIFT+5|Open Existing File
Example: Open|ALT+SHIFT+E|Open Existing File
Example: Open|ALT+SHIFT+F5|Open Existing File

([CTRL] + [ALT] + [SHIFT] + (0-9), (A-Z), (F1-F12))
Example: Open|CTRL+ALT+SHIFT+5|Open Existing File
Example: Open|CTRL+ALT+SHIFT+E|Open Existing File
Example: Open|CTRL+ALT+SHIFT+F5|Open Existing File
Standard Fonts
DataCAD includes the following fonts; the first column lists the font name, while the second column provides examples of upper- and lowercase characters.

<table>
<thead>
<tr>
<th>Font</th>
<th>Characters</th>
<th>Sample 1</th>
<th>Sample 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>ARCDR2GP</td>
<td>ABCDEFGHIKMNOPQRS</td>
<td>1234567890</td>
<td></td>
</tr>
<tr>
<td>ARCWY2FW</td>
<td>ABCDEFGHIJKLMNOP</td>
<td>1234567890</td>
<td></td>
</tr>
<tr>
<td>ARCWY2GP</td>
<td>ABCDEFGHIJKLMNOP</td>
<td>1234567890</td>
<td></td>
</tr>
<tr>
<td>ARCWY2HC</td>
<td>ABCDEFGHIJKLMNOP</td>
<td>1234567890</td>
<td></td>
</tr>
<tr>
<td>ARCWY2LC</td>
<td>ABCDEFGHIJKLMNOP</td>
<td>1234567890</td>
<td></td>
</tr>
<tr>
<td>ARCWY2TX</td>
<td>ABCDEFGHIJKLMNOP</td>
<td>1234567890</td>
<td></td>
</tr>
<tr>
<td>AVG_T1</td>
<td>ABCDEFGHIJKLMNOP</td>
<td>1234567890</td>
<td></td>
</tr>
<tr>
<td>BLOCK</td>
<td>ABCDEFGHIJKLMNOP</td>
<td>1234567890</td>
<td></td>
</tr>
<tr>
<td>COMPLEX</td>
<td>ABCDEFGHIJKLMNOP</td>
<td>1234567890</td>
<td></td>
</tr>
<tr>
<td>HLV_BP</td>
<td>ABCDEFGHIJKLMNOP</td>
<td>1234567890</td>
<td></td>
</tr>
<tr>
<td>HLV_LP</td>
<td>ABCDEFGHIJKLMNOP</td>
<td>1234567890</td>
<td></td>
</tr>
<tr>
<td>HLV_MP</td>
<td>ABCDEFGHIJKLMNOP</td>
<td>1234567890</td>
<td></td>
</tr>
<tr>
<td>HLV_TM</td>
<td>ABCDEFGHIJKLMNOP</td>
<td>1234567890</td>
<td></td>
</tr>
<tr>
<td>HLV_TPX</td>
<td>ABCDEFGHIJKLMNOP</td>
<td>1234567890</td>
<td></td>
</tr>
<tr>
<td>MCG_T2</td>
<td>ABCDEFGHIJKLMNOP</td>
<td>1234567890</td>
<td></td>
</tr>
<tr>
<td>ORIG</td>
<td>ABCDEFGHIJKLMNOP</td>
<td>1234567890</td>
<td></td>
</tr>
<tr>
<td>ORIG2</td>
<td>ABCDEFGHIJKLMNOP</td>
<td>1234567890</td>
<td></td>
</tr>
<tr>
<td>ROMAN</td>
<td>ABCDEFGHIJKLMNOP</td>
<td>1234567890</td>
<td></td>
</tr>
<tr>
<td>ROMAN2</td>
<td>ABCDEFGHIJKLMNOP</td>
<td>1234567890</td>
<td></td>
</tr>
<tr>
<td>ROMANC</td>
<td>ABCDEFGHIJKLMNOP</td>
<td>1234567890</td>
<td></td>
</tr>
<tr>
<td>ROMANS</td>
<td>ABCDEFGHIJKLMNOP</td>
<td>1234567890</td>
<td></td>
</tr>
<tr>
<td>SIMPLEX</td>
<td>ABCDEFGHIJKLMNOP</td>
<td>1234567890</td>
<td></td>
</tr>
</tbody>
</table>

Extended characters
Five DataCAD fonts feature extended characters. This allows you to include common drafting symbols, fractions, and exponents in your text:

- ARCDR2GP: ArcDraft General Purpose
- ARCWY2GP: ArcWyde General Purpose
- ARCWY2HC: ArcWyde Heavy Chisel
- ARCWY2LC: ArcWyde Light Chisel
- HLV_TPX: Helvetica Thin Proportional with extended characters

The following chart shows the drafting symbols, exponents and fractions you can include in your text.

To create drafting symbols and exponents:

1. Toggle NumLock on. The indicator light on your keyboard will be green if NumLock is on. If NumLock is not toggled on, you will not be able to create the drafting symbols and exponents.
2. Press (Alt) and hold it down while you type the corresponding four-digit number using the numeric keypad. The four-digit number always begins with zero. Do not use the number keys above the letters on your keyboard.

If you’d like to change your font but you’ve used extended characters in your text, make sure the new font also includes the extended characters. If you choose a font that does not include the extended characters, the content of your text may be changed.

To create fractions, use the Exponent/Numerator column of the chart to enter the numerator of your fraction; use the Denominator column to draw the denominator and the division sign. For example, to draw a fraction of 5/16 in your text, hold down (Alt) and type 0135 using the numeric keypad. When you release (Alt), the 5 will appear. Depress (Alt) again and type 0153 on the numeric keypad. The fraction is completed when you release (Alt).

<table>
<thead>
<tr>
<th>Drafting Symbol</th>
<th>Exponent / Numerator</th>
<th>Denominator</th>
</tr>
</thead>
<tbody>
<tr>
<td>( \phi )</td>
<td>0140</td>
<td>0130 / 2</td>
</tr>
<tr>
<td>( \text{Square Feet} )</td>
<td>0141</td>
<td>0131 / 4</td>
</tr>
<tr>
<td>( \text{Property Line} )</td>
<td>0142</td>
<td>0132 / 8</td>
</tr>
<tr>
<td>( \text{Center Line} )</td>
<td>0143</td>
<td>0133 / 6</td>
</tr>
<tr>
<td>( \text{With} )</td>
<td>0144</td>
<td>0135</td>
</tr>
<tr>
<td>( \text{Degree} )</td>
<td>0145</td>
<td>0136</td>
</tr>
<tr>
<td>( \text{Plus-or-minus} )</td>
<td>0146</td>
<td>0137</td>
</tr>
<tr>
<td>( \text{Angle} )</td>
<td>0160</td>
<td>0138</td>
</tr>
</tbody>
</table>

**Inserting Symbols in Drawings without the Symbol Browser**

You can use two other symbol insertion methods; these existed prior to DataCAD 11. Using the Insert pull-down menu is faster, but using the Utility/Templates menu offers you more options for working with your symbols.

If you prefer to use this old-fashioned method, you should close your Symbol Browser to avoid confusion. Just click on the “X” in the upper right corner of the Symbol Browser to make it disappear.
To insert a symbol into your drawing using the Insert menu:

1. Click on Symbol in the Insert pull-down menu. A dialog box appears, listing all symbol folders in your DataCAD\Symbols folder.

   **Shortcut:** Press (*) (the double quotation key) to insert a symbol.

2. Double-click on a symbol folder to open it and display those symbols.

3. Click on the name of the symbol you want to use; if Show Preview is checked, a preview of the selected symbol appears in the preview window on the right side of the dialog box. The symbol preview displays in either orthographic (plan) or isometric view, depending on either the Symbol Preview setting on the Misc tab of the Configure DataCAD for Windows Settings dialog box, available from the Tools pull-down menu, or the Isometric View checkbox in the Insert Symbol dialog box.

4. Click on Open or press (Enter). The dialog box closes and the left menu offers options for editing the symbol. Notice that a box representing the extents of the symbol is now attached to your cursor at the symbol’s insertion point.

5. Change the symbol’s size if necessary. Before you place the symbol in your drawing, you can increase or decrease the size of an entity by entering specific enlargement values for the X, Y, and Z axes:

   - To resize the symbol while maintaining its original scale, increase the X Enlargmnt., Y Enlargmnt., and Z Enlargmnt. values equally
   - To adjust the size of the symbol along the X axis, click on X Enlargmnt. Use the value menu or type an enlargement factor and press (Enter).
   - To adjust the size of the symbol along the Y axis, click on Y Enlargmnt. Use the value menu or type an enlargement factor and press (Enter).
   - To adjust the size of the symbol along the Z axis, click on Z Enlargmnt. Use the value menu or type an enlargement factor and press (Enter).

6. Rotate the symbol either by dynamically positioning it or by setting a specific rotation angle for the symbol. The symbol is rotated around the insertion point, the point where the symbol is attached to your cursor.

   - To dynamically rotate the symbol into position when you place it in your drawing, toggle Dyn. Rotate on.
   - To set a specific rotation angle, toggle Dyn. Rotate off. Use the value menu or type an angle and press (Enter).

7. Convert the symbol into standard and separate lines and arcs when you place it in your drawing by toggling Explode on.

8. Place the symbol by clicking in the Drawing Area, using coordinate entry, or object snapping to a point in your drawing. The symbol is inserted into your drawing. For details on coordinate entry, see “**Drawing Using Coordinate Entry**” in “The Drawing Board” chapter. For details on object snapping, see “**Object Snapping**” in the “Drawing Tools” chapter.

9. Repeat the previous step to continue placing the symbol in your drawing or right-click to exit the menu.
Finding and Using Older Template and Symbol Files

Before using Templates, you need to configure DataCAD 11 to look into your previous version’s installation folder to find the template and symbol files.

To configure DataCAD version 11 and higher to find template and symbol files from older versions:

1. Select Program Preferences from the Tools pull-down menu and click on the Pathnames tab.
2. Set the path for Templates to C:\DataCAD\TPL\, assuming that is the folder in which the earlier version is installed.
3. Set the path for Symbols to C:\DataCAD\, leaving the SYM part off because it is already included in the symbol paths for each of the files associated with the template.

To insert a symbol into your drawing using the Templates menu:

1. Right-click until the Utility menu appears.
2. Click on Templates in the Utility menu. A dialog box appears.

Shortcut: Press (T) to open the Template menu.

3. Locate the template you’d like to use and click on it to select it. The templates that come with DataCAD are in your DataCAD\Templates folder.
4. Click on Open or press (Enter). The template appears on the right side of the Drawing Area and the Templates menu appears.
5. Rotate the symbol into position either dynamically or by setting a specific rotation angle. The symbol is rotated around the insertion point, the point where the symbol is attached to your cursor.
   • To dynamically rotate the symbol into position when you place it in your drawing, toggle Dyn. Rotate on.
   • To set a specific rotation angle, toggle Dyn. Rotate off. Use the value menu or type an angle and press (Enter).
6. Change the symbol size if necessary by clicking on Enlarge in the Templates menu. Before you place a symbol in your drawing, you can increase or decrease the size of an entity by entering specific enlargement values for the X, Y, and Z axes:
   • To enlarge entities along the X axis, click on X Enlargmnt. Use the value menu or type an enlargement factor and press (Enter).
   • To enlarge entities along the Y axis, click on Y Enlargmnt. Use the value menu or type an enlargement factor and press (Enter).
   • To enlarge entities along the Z axis, click on Z Enlargmnt. Use the value menu or type an enlargement factor and press (Enter).
   • To set the line spacing enlargement factor for nonsolid line types, click on Line Factor. Use the value menu or type a line factor and press (Enter). The Line Factor setting affects how line types like Dashed are enlarged. A setting matching those of the X, Y, and Z enlargement factors will maintain the line type’s spacing.
   • To set all of these options to the same setting and enlarge the entity equally in all directions, click on Set All. Use the value menu or type an enlargement factor and press (Enter).
7. Decide if you need to place symbols above or below the current Z-base. For example, when placing tree symbols on a 3D site plan, you can change the Z Offset option to enter the trees at the proper elevation. To set the vertical distance above or below the correct Z-base where you’d like to insert your symbols, click on Z Offset. Use the value menu or type an offset value and press Enter. Enter a positive value to place the symbol above the current Z-base; enter a negative value to place the symbol below the current Z-base.

8. Decide if you want to change the symbol. Normally, symbols are placed in your drawing as a single entity, so DataCAD doesn’t recognize the individual lines and arcs that make up the symbol. To be able to edit a symbol in your drawing, you must explode (or convert) the symbol into separate lines and arcs. To convert the symbol into separate lines and arcs when you place it in your drawing, toggle Explode on.

| Note: This will only explode those symbols entered into your drawing after Explode is toggled on. Exploded symbols appear the same as standard symbols, but DataCAD recognizes only the individual lines and arcs that make up the symbol and not necessarily their relationship to each other. |

9. Select a symbol from the template by moving your cursor over the symbol you want to use and clicking. A box, representing the extents of the symbol, is attached to your cursor at the symbol’s insertion point. The symbol’s insertion point is marked by a small “x” once you place the symbol in your drawing.

| You can object snap to any point on a symbol to select an insertion point other than the one associated with the symbol definition. This is especially useful if you want to align a symbol with another entity in your drawing. Simply snap to the symbol in the template and then snap to the entity in your drawing to place the symbol. |

10. Place the symbol in your drawing by clicking in the Drawing Area, using coordinate entry, or object snapping to a point in your drawing. The symbol is inserted into your drawing.

11. Repeat the previous step to continue placing the symbol in your drawing or right-click to detach from the symbol.

12. Open a different template if necessary by clicking on New File and selecting another template file from the dialog box.

13. Close the template window by clicking on Template Off.

More About Templates and Symbols
Each template is a graphic representation of the template (.TPL) file and appears with a number of divisions, each containing a symbol. The template file itself is a simple text file containing the name of the file, the number of rows and columns in the template, and the paths to the symbols associated with that template. When you select a template, the symbols associated with that template file appear in the template window.

Creating and Editing Templates
Templates are a very effective way to organize a library of predrawn items, which you can use in many different projects. You can create a template with symbols that you use frequently or one that supports office standards. See “More About Creating Templates” for details on defining information fields.
Each template has information fields defined specifically for that template. Whenever you add a symbol to that template, you can enter information describing that symbol in each field. There are six standard information fields that are defined for every template, but you can define an unlimited number of additional fields.

To create a template:

1. Click on Templates in the Utility menu; or if you’re already in the Template menu, click on New File. A dialog box appears.
   
   Type a name for your new template and click on Open or press (Enter). The dialog box closes and you are prompted with Create new file?

2. Click on Yes to create the template. The Field 7 menu appears and you are prompted with Field name. All templates have six standard fields automatically defined for them.

3. Decide whether you want to define additional information fields or simply create the template with only the standard six fields. To use only the standard fields, right-click and skip to step 7. To enter an additional field, type a name for the field (up to 20 characters) and press (Enter). A list of field data types appears and you are prompted to Select field type.

4. Notice that there are three field types available: Text, Number, and Dollar. To create a field that you can enter letters and numbers into, click on Text. To create a field that you can enter an integer into, click on Number. To create a field that you can enter a real number with two fixed decimal places, click on Dollar. Numbers entered in a text field cannot be used in any calculations.

5. Repeat steps 4 and 5 to continue entering information fields.

6. Right-click when you’ve completed entering fields. The template is created and displayed at the right side of the DataCAD window and the Templates menu appears. For information on how to add symbols to your new template, see “Creating and Editing Symbols” later in this chapter.

More About Creating Templates

When you create a template, DataCAD automatically defines six information fields:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Field Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item nam</td>
<td>Text</td>
</tr>
<tr>
<td>Manufact</td>
<td>Text</td>
</tr>
<tr>
<td>Model No</td>
<td>Text</td>
</tr>
<tr>
<td>Remark 1</td>
<td>Text</td>
</tr>
<tr>
<td>Remark 2</td>
<td>Text</td>
</tr>
<tr>
<td>Cost</td>
<td>Dollar</td>
</tr>
</tbody>
</table>

You can create an unlimited number of additional information fields when you create a template. This is the only time you can define information fields; once the template is created, you can’t add another field or delete a field, nor can you change the field’s name or type.

While you can’t change the fields themselves, you can always edit any information you’ve entered into a field. All fields you create can accept up to 80 characters of information.

Editing Templates

Templates you create in DataCAD have a standard number of divisions: three columns and 12 rows. Once you’ve created a template, you can change the number of divisions to suit your needs.
The number of divisions in a template doesn’t have to equal the number of symbols associated with that template. You can have more divisions than symbols, in which case some of the divisions in your template will be empty. You can also have fewer divisions than symbols, so that not all symbols associated with that template will be displayed at once. Displaying fewer symbols will also increase refresh times.

To change the number of divisions in a template:

1. Create your template. Then click on Divisions in the Templates menu. You are prompted to Enter number of columns.
2. Use the value menu or type the number of columns for your template and press (Enter). You are prompted to Enter number of rows.
3. Use the value menu or type the number of rows for your template and press (Enter). The template is updated with the new divisions and you are returned to the Templates menu.

**Creating and Editing Symbols**

Creating and editing symbols is a very effective way to build a library of predrawn items that you can use in many different projects. You can draw a lighting fixture, create a symbol from the fixture geometry and add it to a template, and then very quickly place several instances of that fixture in your drawing.

To quickly determine the exact path and folder name of a symbol, click on Symbol Name in the Templates menu and then click on the symbol.

You can also enter descriptive information about each symbol and then edit that information. You can even replace symbols in your drawing with others in your symbol library.

To create a symbol and add it to a template:

1. Click on Templates in the Utility menu. The Templates menu appears.

   **Shortcut:** Press (T) to display the Templates menu.

2. Click on Save Symbol. If the Attention toolbar informs you that a file doesn’t exist and asks if you want to Create it?, click on Yes. A dialog box appears, prompting you to Enter name of symbol file to be saved. Symbol folders are stored in your DataCAD\Symbols folder.
3. Make sure the folder that’s open in the dialog box is the one you want to save the symbol in. If it’s not, change to the proper folder.
4. Type a name for your symbol and click on Save or press (Enter). The Save Symbol menu appears. Use Save Symbol to select either symbols already in your drawing or geometry you want to make into a symbol; both types of selection will be added to the currently displayed template.
5. Choose a selection method and then select the parts of your drawing you want to make into a symbol. When you are finished selecting the entities to add to the symbol, click on Continue. You are prompted to Select an insertion point for symbol.
6. Select the reference or insertion. You can click in the Drawing Area, use coordinate entry, or object snap to a point in your drawing. The entities you selected are copied into the first open space in the template; if there are no open spaces in the currently displayed template, the symbol can’t be displayed in that template until you increase the number of template divisions. A dialog box appears.
7. Enter a name for your symbol in the Item name field. Supply information for additional fields. You can use the New button to add more fields; you can use the Delete button to eliminate existing fields.

8. Click on Ok when you are finished supplying information about the symbol. A dialog box appears and you are asked to Enter name of symbol file to be saved.

9. Supply a name in the File name field and click on Save or press (Enter).

10. Continue with step 3 above to save additional symbols.

**Editing Symbols**

To edit symbols, you must first explode or convert them into individual lines and arcs. You can do this when you insert the symbol into your drawing or after the symbol has been inserted. Once the symbol has been edited, you can reform the symbol lines and arcs into a single symbol entity, copy it back into the template, and then update the symbols already in your drawing.

➔ To explode a symbol when you place it in your drawing and edit it:

1. Click on Templates in the Utility menu. Then click on New File in the Templates menu. A dialog box appears, allowing you to choose a template to open.

2. Click on the template you want to use and click on Open. The template appears on the right side of the Drawing Area.

3. Toggle Explode on in the Templates menu.

4. Click on the symbol in the template that you want to insert into your drawing.

5. Place the symbol in your drawing. You can click in the Drawing Area, use coordinate entry, or object snap to an entity in your drawing. The symbol is copied to your drawing and automatically exploded into separate entities.

6. Edit the symbol geometry as necessary. For more information on editing lines and arcs, see the “Editing Drawings” chapter.

7. Copy your changes back to the template. Click on Redefine in the Templates menu. You are prompted to Select symbol in template to redefine.

8. Click on the symbol in the template that you just edited in the Drawing Area. A selection menu appears and you are prompted to select the geometry you want to be your new symbol.

9. Choose a selection method and then select the geometry for the symbol. Your selection is highlighted with dashed lines. If necessary, continue selecting geometry until all entities that you want to be included in the new symbol are highlighted.

10. Click on Continue to go on with the symbol definition process. You are prompted to Select an insertion point for symbol.

11. Click in the Drawing Area or use coordinate entry to select the point that will be used to insert the symbols in drawings. The edits to the symbol are copied to the template.

12. Update all instances of that symbol in your drawing. Click on Reload in the Templates menu. You are prompted to Select symbol in template to reload.

13. Click on the symbol in the template that you want to reload or click on All in the Reload menu to reload all symbols in your drawing.
**Editing Information Fields**

You can edit information associated with symbols by selecting a symbol in a template or one that's already in your drawing. Use the Reports option in the Templates menu to extract symbol information for all symbols used in your drawing and create specification reports or cost estimates.

➢ To edit symbol information:

1. Open the template that the symbol (whose information you want to edit) is associated with.
2. Click on Edit Fields in the Templates menu.
3. Click on the symbol, either in the template or in your drawing, whose information you want to edit. The fields for that symbol appear in the dialog box.
4. Click on the field you want to edit.
5. Type the new information for that field and press (Enter).
6. Repeat steps 4–5 to continue changing field information as necessary.
7. Edit information for another symbol by right-clicking and continuing with step 3 above. Right-click twice to exit back to the Templates menu.

➢ To edit symbol information:

1. Click on FormAtr in the Toolbox pull-down menu. The FormAtr menu appears. If FormAtr is not listed in your Toolbox menu, click Configure in the Macros menu and add it to the Macros in Menu list.
2. Click on Symbols in the FormAtr menu. You are prompted to *Select symbol to edit attribute fields*.
3. Click on the symbol. The symbol’s information appears in the Drawing Area.
4. Press (Tab) to move the edit box to the text you want to change.
5. Type the new text and press (Enter). The information is changed.
6. Repeat steps 4–5 to continue editing.
7. Press (Esc) to exit editing and return to your drawing. You are prompted with *Do you wish to update symbol file [symbol path and filename]?*
8. Click on Yes to update the symbol information; click on No to cancel the changes.

**Replacing Symbols in Your Drawing**

You can replace one symbol in your drawing with another and choose whether to replace one instance of that symbol or all instances throughout your drawing. This is useful if you’ve entered one type of bathroom sink throughout your drawing and you need to replace it with another type.

➢ To replace one symbol with another symbol:

1. Click on Templates in the Utility menu. The Templates menu appears.
2. Click on Replace in the Templates menu. The Replace menu appears and you are prompted to *Select symbol to replace*.
3. Click on the symbol in your drawing that you want to replace. You are prompted to *Select symbol to replace with*. 
4. Choose the new symbol that will replace the original by clicking on a symbol in a template or on one that’s already in your drawing. A selection menu appears.

5. Replace only particular instances of the symbol you selected in step 3 or replace all instances of that symbol. To choose particular instances of the symbol, choose a selection method from the menu and continue with the next step. To replace all instances of the symbol, click on All; all instances of the symbol are immediately replaced and you can skip to step 7.

6. Select each instance of the symbol that you want to replace. Each symbol is replaced as you select it.

7. Finish replacing symbols. Right-click to return to the Templates menu.

To replace several different symbols with another symbol:

1. Click on Templates in the Utility menu. The Templates menu appears.

2. Click on Replace in the Templates menu. The Replace menu appears and you are prompted to select symbol to replace.

3. Click on Any Symbol in the Replace menu. You are prompted to select symbol to replace with.

4. Choose the new symbol that will replace the original by clicking on a symbol in a template or on one that’s already in your drawing. A selection menu appears.

5. Select each symbol you want to replace or replace every symbol in your drawing. To choose each symbol, choose a selection method from the menu and continue with the next step. To replace all symbols, click on All; all symbols in your drawing are immediately replaced.

6. Select the symbols to be replaced. Each symbol is replaced as you select it.

7. Finish replacing symbols. Right-click to exit the Replace menu and return to the Templates menu.

Deleting Symbols
You can erase symbols from your drawing or delete them from a template.

To erase a symbol:

1. Click on Erase in the Edit menu. The Erase menu appears.

2. Toggle Layer Search on if the symbols you want to erase are on a layer other than the active layer.

3. Click on a selection method in the menu. You are prompted to select the entities you want to erase.

4. Select the symbols; they are erased from the drawing. You can continue selecting symbols to erase them. Avoid selecting a symbol where it crosses another entity because it may be difficult for DataCAD to know which entity you want to select. Zoom in on your drawing or change your view to select symbols more precisely.

5. Finish erasing symbols. Right-click to exit the Erase menu.

To delete a symbol from a template:

1. Click on Templates in the Utility menu. A dialog box appears, allowing you to choose a template to open.
2. Click on the template with the symbol you want to delete and click on Open. The template appears on the right side of the Drawing Area and the Templates menu appears.

3. Click on Del. Symbol in the Templates menu. You are prompted to *Select symbol to delete from this template file*.

4. Click on the symbol you want to delete from the template. You are asked to confirm your selection.

5. Click on Yes to delete the symbol; click on No to cancel the function.

6. Continue selecting symbols to delete them from the template or right-click to exit the Del. Symbol menu.

**More About Erasing Symbols**

When you erase symbols from your drawing, it's important to *purge* the symbol from your drawing as well. When you add a symbol to your drawing, DataCAD associates that symbol with your drawing. This association is not deleted when you erase the symbol and continues to take up drawing file space. To delete the association as well, you must use the Purge Symbol option in the Templates menu.

➔ To purge symbol associations from your drawing:

1. Click on Purge Symbol in the Templates menu. You are asked *Are you sure you want to purge unused symbols?*

2. Click on Yes to purge the associations with symbols that have been deleted; click on No to cancel the function.
Glossary

3D face
The surface of a solid specified with 3D points.

3D mesh
A polygon mesh composed of vertices connected by lines.

3D polyline
Polylines with segments oriented in 3D space.

arc
A continuous section of a curved line.

area
Any part of a drawing within a rectangular window that is temporarily drawn during the selection process. All entities and groups enclosed completely within this rectangular window are included in the area. All entities and groups partially enclosed or not enclosed within the rectangular window are not included in the area.

Attention toolbar
A toolbar that supplies helpful information and/or hints pertaining to the DataCAD function you are using. You can move this toolbar anywhere in the DataCAD screen or onto your desktop.

attribute
A single value or characteristic associated with an entity.

bulge
A curved portion of a polyline.

center marks
Small marks displayed to define the exact center of arcs and circles. You can also use center marks with object snapping.

click
To position the cursor over a selection and press and release a mouse button (usually the left button). This command usually refers to selecting or deselecting an option.

choose
To select a command or option from the Menu Window.
command
An instruction from the user to the computer to perform a function. A command is usually selected from the Menu Window or the Menu Bar.

Context-sensitive toolbar
A toolbar that appears when you perform various functions. For example, it could provide icons for Cleanup, Arctitect, Door swing, Window, Polyline, and Model options. You can also create your own context-sensitive toolbar. You can move this toolbar anywhere in the DataCAD screen or onto your desktop.

Coordinates/Hints toolbar
A toolbar that supplies helpful information and/or hints pertaining to the DataCAD function you are using. The hints usually mirror the tooltips for DataCAD menu items. When it isn’t displaying hints, this toolbar shows the coordinates that describe your cursor’s current position. Additionally, this toolbar provides the Z-base and Z-height. You can move this toolbar anywhere in the DataCAD screen or onto your desktop.

cursor
A graphic symbol displayed on the screen to show the location of the mouse.

default
Any setting or value that is preset by DataCAD.

Default toolbars
Two default user-definable toolbars can be active simultaneously. You can move these toolbars anywhere in the DataCAD screen or onto your desktop.

dimension line
Also called the string line, the dimension line consists of a straight line parallel to the points to dimension. The dimension line also contains text showing distance information and termination marks, consisting of arrows or tick marks drawn at a 45° angle.

division
A graphical aid used in cylindrical balusters, newel posts, or hand rails to help you better visualize the cylinder.

doughnut (donut)
A circular object with hole in the center, composed of two concentric circles and a filled center.

Drawing Window
The area of the screen that is reserved for your drawing.

elevation
The height of an object. It defines the object’s position in the direction of the Z-axis.
Also, an orthographic view that shows the front, back, right, or left sides of an object.
**entity**
A straight or curved geometric element defined by two endpoints. A circle, ellipse, or arc is an entity, as is a B-spline or Bezier curve. A line of text is also considered an entity in editing operations. Edit entities alone or when linked as a group.

**extension line**
Extension lines typically run from the object you dimension to the line where the dimension appears. Extension lines are used only for linear and angular dimensioning. You can control the length of the extension line. DataCAD typically draws one extension line at each end of a dimension line, but you can suppress the line.

**extents**
The outer-most edges of a drawing. To “display a drawing at its extents” means to adjust the view so that the drawing fills the Drawing Window as much as possible while still displaying it in its entirety; the outer-most edges of the drawing will fit just inside the frame of the Drawing Window. Clicking the E in the Navigation Pad does this automatically.

**fence**
Similar to an area but allowing more flexibility, a fence is any portion of a drawing within a closed polygon that you draw during the selection process. You can select using a concave or convex polygon having up to 36 sides.

**fit**
Specified fixed height of text that expands or contracts to the character width between designated points only.

**function keys**
Function keys, (F1) through (F12), are located on the keyboard and are used to enter commands. In DataCAD, they are associated with the commands that appear in the Menu Window. You can select these commands by pressing the associated function key on the keyboard.

(S1) through (S0) provide access to ten additional commands, selected on the keyboard by holding down (Shift) while pressing the appropriate function key.

**grids**
Use display and snap grids to make cursor movement and positioning more accurate. The flexibility and control of grids are critical to computer-aided design.

**group**
A group is a set of entities linked together logically but not necessarily graphically. Entities that do not touch may be part of the same group, and entities that are contiguous may be part of different groups. A group may contain any number of entities - as many as hundreds or only one.
Entities are linked as a group in a number of ways. A group of entities drawn in succession without disconnecting the cursor are linked as one group. Similarly a series of lines of text entered at the same time are linked as one group. You can link any group of entities or groups using the Group command. Entities are also linked or associated as one group when they are created at the same time with the Copy command. When an existing entity is edited, with the Change or Move commands, for example, it retains the same group associations.

The grouping together of entities in DataCAD facilitates editing many related items without affecting other entities in the same portion of a drawing. Because they are also easily redefined, groups allow the designer to organize a drawing as a series of elements composed of logically related pieces or entities.

**keyboard shortcuts**

These key combinations perform an operation or select a setting in the middle of another command by interrupting the original command. Once the interrupt function is complete, DataCAD automatically returns to the original function.

**layers**

In computer-aided design layers are the electronic equivalent of overlaid pieces of tracing paper, each containing a small part of the drawing information. Each layer can also be saved and loaded for use in other drawing files.

**limits**

The maximum and minimum sizes indicated by a tolerated dimension.

**line**

The most fundamental drawing entity; defined by two endpoints.

**Menu Bar**

An area of the screen, located along the top of the DataCAD screen, that contains pull-down menus to give you quick access to many of DataCAD’s most used functions.

**Menu toolbar**

A toolbar that displays DataCAD’s primary menu structure. You can position this toolbar anywhere on your DataCAD screen or on your desktop.

**Message toolbar**

This toolbar provides prompts and messages. The Message toolbar also provides an input portion that supplies prompts and displays the information you are entering via the keyboard.

**MultiView Windows toolbar**

A toolbar that lets you display up to 10 GoTo View windows that you can tear off, reposition, and resize.

**Navigation toolbar**

This toolbar displays buttons to pan around (left, right, up, and down), zoom in or out, zoom to an area, view the drawing at its extents, and identify the properties of an entity.
**ortho mode**

Used to draw entities at any angle. Press (O) to toggle Ortho mode off. To draw entities orthogonal to one another, press (O) again to toggle ortho mode back on. Modify this snap angle by setting the number of divisions under the Snap Angle option of the Grids menu.

**orthographic view**

A parallel view whose lines of sight are parallel to each other and perpendicular to the plane of projection. Orthographic views include plan views and elevations.

**pan**

Move observer’s view of a drawing by using the arrow keys to the right of the keyboard. Set the pan distance by using Scroll Dist. in the Settings menu.

**point**

Use the mouse to point to objects on the screen. Move the mouse to move the cursor to the appropriate location on the screen.

Also, a point in space represented on the monitor as a dot, without width or height.

**polyface**

3D vertices connected in a specified order.

**polyline**

A connected sequence of lines and arc segments.

**Projection toolbar**

This toolbar controls the type of view (parallel, perspective, plan, isometric, oblique, and elevations) that appears in your Drawing Window. You can place this toolbar anywhere on your DataCAD screen or on your desktop.

**prompt**

A message that appears on the screen in the Message toolbar, providing information or requesting a command or user action.

**radius**

The measurement used for a cylindrical baluster, newel post, or hand rail. The radius is the distance from the center point of the cylinder to the side of the cylinder.

**raster printing**

The rendering of a graphic as an image composed of dots rather that of vectors, or lines.

**reference point**

An arbitrary point in the Drawing Window from which the next point entered will be referenced.

**right-click**

To press and release the right mouse button.
right-hand rule
A rule that indicates the direction of angles. Point the thumb of your right hand in the direction of the axis in question. Your fingers curl in the direction of positive rotation. The Y axis goes up, so when you point your thumb up, your fingers curl toward you in the left to right direction. Negative angles, therefore, go from right to left.

cscreen refresh
Updates or redraws the screen from the drawing file in order to display the current status of your drawing. This is particularly useful to monitor your progress during editing operations.

scroll back
Use Scroll Back to view a previously-displayed portion of a list.

scroll forward
Use Scroll Forward to view more options when the list of available choices is too long to fit on a menu.

select
To highlight or otherwise mark an entity, icon, or text.

selection set
A user-defined set of entities and/or groups that contains any number of entities or groups. Selection sets provide increased efficiency during editing by reducing the time required to select entities, groups, or define areas or fences.

setting
An option that is set to a particular value. You can change settings at any time, and they remain in that state until you change them again.

solid
Solid filled figures, composed of quadrilateral (four-sided) or triangular (three-sided) polygons.

SPB fills
A solid, pattern, or bitmap can be used to fill an area instead of the standard vector-based hatch patterns.

Standard toolbar
A toolbar that provides access to common Windows-based functions (such as file open, save, print, copy, paste, etc.) and some frequently used DataCAD ones (such as select a reference file or bitmap). You can move this toolbar anywhere in the DataCAD screen or onto your desktop.

Status toolbar
This toolbar is reserved for status information such as the current layer, layer color, line type, scale, selection sets, go-to views, and input mode. You can move this toolbar anywhere in the DataCAD screen or onto your desktop.
string
A series of characters.

swap file
A temporary file created when you enter DataCAD. It is the working file that contains your drawing during a work session. This working file is transferred to your drawing (.AEC) file when you exit DataCAD.

SWOTHLUDFB toolbar
The Snap, Walls, Ortho, Text, Hatch, Line weight, User-line, Dimension, Fills, and Bitmap toggles are located on this toolbar. You can move this toolbar anywhere in the DataCAD screen or onto your desktop.

text
The alphabet, numerals, and special characters added to a drawing. It is created using fonts.

text leaders
Short, sometimes angled lines that are automatically drawn back to a point on the circumference of the object when a dimension distance is too short to contain dimension text.

thickness
The projection of a surface into 3D space.

toggle
An option switch that you can turn on or off. When a toggle is on, the button label appears in green; when a toggle is off, the button label appears in red.

tolerance
The total amount a specific dimension is allowed to vary, the difference between maximum and minimum limits.

trace
A solid line with a specified width.

undo
An option that cancels the latest operation or command performed. It appears on the menu only after an action has taken place.

vector printing
Line-based drawings produced with commands that are either native to or added to a laser printer.

view center
The point in space at which the observer is looking. DataCAD places the view center in the middle of the extents, halfway between Z-base and Z-height.
**Viewer toolbar**

This toolbar changes based on the type of view you select in the Projection toolbar. You can move this toolbar anywhere in the DataCAD screen or onto your desktop.

**void**

An opening or hole created in a slab.

**zoom**

Displays objects at different scales for drawing tasks. To quickly focus on a portion of a drawing for detailed work, press (/) to expand that section.
Index

.INI settings .................................................................................. 86, 528
1 Line Trim................ See Cleanup, trimming to one line
2 Line Trim................ See Cleanup, trimming to one line
2 Line Walls....................... See Walls, 2-line
2 Pt. Arc......................... See Curves, drawing
2-point arcs, tracing .................... 277
3 Edge Bot........ See Inclined polygons and slabs, 3-edged bottom
3 Edge Poly....... See Inclined polygons and slabs, 3-edged vertical
3 Edge Top................ See Inclined polygons and slabs, 3-edged top
3 Line Walls........ See Walls, 3-line
3 Pt. Arc....................... See Curves, drawing
3 Pt. Circ........ See Curves, drawing, .See Circles, using 3 points
3D arcs
divisions of................................................. 413
dog-leg .................................................. 413
drawing................................................. 412
tangent .................................................. 412
vertical .................................................. 413
3D copying................................................ 446–48
3D cursor ................................................. 442
3D Cursor ........... See Cursor, world snapping
3D drawing ................................................ 390
3D entities
changing attributes of........................................ 451
copying.................................................. 446
editing rules.............................................. 444
enlarging.................................................. 450
exploding.................................................. 451
exporting .................................................. 57
mirroring .................................................. 448
moving ..................................................... 444
rotating .................................................... 448
rules for editing ........................................ 444
selecting curved ........................................ 388
stretching.................................................. 449–50
3D framing................................................ 490–501
floor ...................................................... 490–91
roof ...................................................... 493–501
saving settings ........................................ 501
using settings ......................................... 501
wall ....................................................... 491–93
3D lines
chaining................................................... 390
curved, as contours ................................. 441
drawing .................................................. 389
from Z-base to Z-height............................ 390
3D menus, selection................................................. 62
3D models
adding to web page........................................ 406
as e-mail attachment .................................. 406
walking through ....................................... 479, 480
3D moving................................................ 294–98
3D polygons
adding vertices to ......................................... 406
creating drop mesh....................................... 434
deleting vertices from .................................. 406
editing.................................................... 405
horizontal............................................... 396
moving vertices in ..................................... 407
rectangular............................................... 396
vertical................................................... 398
3D roofs
creating with inclined polygons .................. 400
creating with inclined slabs ....................... 400
defining boundaries for ............................. 496
joining.................................................... 498
modeling.................................................. 495
polygonal............................................... 497
rectangular............................................... 496
settings for............................................... 499
types of.................................................. 494
3D settings............................................. 389
3D snapping
normal.................................................... 390
world..................................................... 391
3D stairs Error! Not a bookmark in entry on page 525
balusters for ............................................ 521
base elevation of....................................... 515
calculator............................................... 513
chases of ................................................ 516
curved, radius of ...................................... 516
drawing................................................... 512
form ...................................................... 525
handrails for ........................................... 520
landings of ............................................. 517
newel posts for ....................................... 523
placement of........................................... 516
risers of ................................................ 518
settings................................................... 515
stringers of.............................................. 519
tread length of ........................................ 516
treads in first run of .................................. 516
treads in second run of ............................. 516
treads in third run of ................................. 516
treads of ................................................ 516, 518
3D views ................................................ 455–61, 465–66
changing center of ................................... 456
changing center of parallel ....................... 456
changing to parallel view ......................... 387
elevations .............................................. 455
isometrics .............................................. 455
oblique .................................................. 465–66
perspective ............................................ 461–64
perspective (tutorial) ............................... 165
rotation angles in ..................................... 455
saving an image ...................................... 477
shaded image ......................................... 471–75
using GoTo View ................................... 477
using o2c player with .............................. 93
Bearing. See Angles, setting types of
Bezier curves ........................................... 240
Bi-fold doors ............................................ 219
Big Cursor. See Cursor, large displaying
Bitmap
inserting files into drawings ..................... 80
saving image as ........................................ 84
Bitmap Fills. See SPB Fills
Blocks
drawing .................................................. 408
parallelogram .......................................... 409
rectangular .............................................. 408
Border
creating (tutorial) ................................. 145
moving (tutorial) ................................. 146
Boundaries, hatch
defining .................................................... 341
defining rectangular .................................. 342
including arcs ......................................... 342
including curves ................................. 342
using contour search to define ................. 341
Box Color. See Colors, displaying box
B-spline curves. See Colors, displaying box
Calculating
angles .................................................. 64, 65
distances .............................................. 64
Calculator, online .................................. 63
Calibrate
distance .................................................. 360
enlargement of imported graphics ............ 360
X/Y enlargement options ......................... 360
Camera .................................................. 463
Cancel
hidden line removal ............................... 466
roof framing ......................................... 493
saved hide image .................................... 468
Cent. Angle. See Curves, drawing
Cent. Chord. See Curves, drawing
Center Cav. See Walls, defining by cavity center
Center Line. See Walls, 3-line attributes
Center Point
polygons, drawing ................................. 229
Center points of 2D curves, displaying .... 207
Center Wall. See Walls, defining by center
Center Z. See Center, of 3D rotation
Center, of 3D rotation ............................. 448
CentiMtr. See Scales, setting types
Chain. See 3D lines, chaining
changing vertical polygons in succession .... 398
Chanfer .................................................. 285
Changing attributes of 3D entities .......... 291–94
attributes to match another entity .......... 451
entity attributes .................................... 292
line overshoot ........................................ 77
text attributes ....................................... 292
text attributes to match another text block 293
Characters, extended ........................... 547
Check plot .............................................. 380
Chord
drawing arc based on length of ................. 233
measuring length of arc ......................... 274
Circ. Array. See Copy, circular array
Circles
3-point ................................................... 412
dividing .................................................. 279
measuring circumference of .................... 274
using 3 points ....................................... 238
using diameter ..................................... 238, 412
using radius ......................................... 237, 412
Circumference, measuring circle ............. 274
Clean ..................................................... 213
walls ..................................................... 215
Cleanup
chamfers .............................................. 285
connecting two lines with a line ............... 285
fillets ..................................................... 284
trimming to nearest ............................. 287
trimming to one line ............................. 286
wall intersections ................................. 215
wall intersections (tutorial) ..................... 106
Clear Layer. See Layers, erasing contents
Clip Cube
activating .............................................. 475
creating .................................................. 475
defining in XREF with Reference File Management 476
defining in XREF with XREF Clip ............ 476
display boundary of ............................. 60
using with XREFs ................................. 476
viewing selected entities in 3D model with .... 475
Clockwise. See Curves, drawing, See Angles, setting types of
CloudStr. See Stringers, closed
Close 2D Arc. See Arcs, closing 2D for hide
Close Ellip. See Ellipses, closing for hide
Closed ................................................... 451
Color. See Layers, changing color
changing on display grids ...................... 174
Color mapping
define materials for rendering with .......... 484
using Viewer/Shader color map ............... 484
Colors
changing .................................................. 65
changing background of Drawing Window 48
changing for entities ............................. 65
Color Palette ......................................... 48, 65
copying entities to clipboard .................. 60
custom .................................................. 65, 208
displaying box ........................................ 207
exporting with Translation toggle .......... 56
matching menu ........................................ 66
doors .................................................... 65
of 3D stairs ............................................ 517, 518, 519, 520
of balusters .......................................... 523
of handrails ......................................... 521
of hidden lines ..................................... 470
of newel posts ...................................... 525
standard 15 DataCAD ............................ 66
Columns, drawing .................................. 506
Compass. See Angles, setting types of
Concrete forms ...................................... 506–9
drawing column .................................... 506
drawing double tee ............................... 507
drawing I-beam ..................................... 508
drawing inverted tee ............................. 506
drawing single tee ............................... 507
drawing standard beam ......................... 508
Cone of vision ........................................ 462, 463
width of .................................................. 463
Cones
closed .................................................. 451
drawing .................................................. 418
INDEX

radius of ................................................................. 419
truncated ............................................................... 419

Contours
control points for .................................................. 442
creating topographical map with ......................... 441
cyclic ................................................................. 441
divisions of .......................................................... 442
drawing ............................................................... 441
elevation of .......................................................... 442
natural ................................................................. 441
smoothing surface .............................................. 434
steadily rising ....................................................... 442
stiffness of .......................................................... 434, 441, 451
tangent .............................................................. 441
tangent point ....................................................... 442

Control points
displaying for associative dimensions ............... 207
for contours ....................................................... 441, 442
for mesh surfaces .............................................. 428

Convert Void .................................................. 428
See Voids, converting, See Voids,
converting to polygon

Coordinate entry
absolute Cartesian ............................................... 72, 73
absolute polar ..................................................... 72, 73
choosing a method .............................................. 73
distance direction ............................................. 72, 73
drawing with ..................................................... 72
placing dimensions with .................................. 327
relative Cartesian ............................................ 72
relative polar ..................................................... 72, 73

Coordinates
screen ................................................................ 458
world .................................................................. 458

Copy ................................................................. 78
3D entities ......................................................... 446–48
and rotate entities .............................................. 300
circular array .................................................... 255
divisions of ...................................................... 248–57
entities ............................................................. 249, 250
new distance .................................................... 249, 250
one-dimensional array .................................... 253
perpendicular to original .................................. 250
rectangular array ............................................. 253, 254
specified distance and angle ......................... 248
to another layer ............................................... 251
to clipboard, setting ........................................ 60
using arrays .................................................... 252, 447

Copy to Clipboard
entity color ........................................................ 60
line weight ........................................................ 60

Crossing selection ................................................ 61, 62

Cursor
3D ................................................................. 442
changes to New Elevation Indicator .................. 387
changing to New Elevation Indicator ................ 459
large displaying ............................................... 204
setting accuracy of .......................................... 203
text .................................................................. 310
with 02e object attached .................................... 359
world snapping .............................................. 391, 445, 448

Curve Center See Center points of 2D curves, displaying
Curve Data .... See Curves, drawing based on surveyor's
data

Curves
Bezier ............................................................... 240, 428
B-spline ........................................................... 240
drawing ............................................................ 230–41
drawing based on surveyor's data ..................... 240
drawing with control points ............................ 239
measuring arc length of .................................. 274
measuring diameter of .................................... 273
measuring radius of ......................................... 273

Customizing
colors ............................................................... 207
display settings ................................................. 205
drawing settings .............................................. 198
macros ........................................................... 58
miscellaneous settings ................................... 59
toolbars ........................................................... 32
walk-through options .................................... 479

Customizing DataCAD ....................................... 44
DIF/DWG file translation ................................. 54
interface settings ............................................. 45, 53
macros ........................................................... 58
menu buttons .................................................... 47
menu labels ....................................................... 47
miscellaneous settings ................................... 59
pathnames ....................................................... 44
screen calibration .......................................... 46

Cut ................................................................... 78
Cut Wall ....................................................... 78
See Walls, cutting

Cutout See Windows, drawing, See Doors, drawing

Cylinders
closed ............................................................. 451
horizontal ....................................................... 415
setting number of divisions for ...................... 418
sweep angles ................................................... 416
vertical ............................................................ 414
vertical, divisions of ....................................... 415
vertical, thickness of ....................................... 415

Dec. Degrees See Angles, setting types of

Decimal See Scales, setting types

Default
font ................................................................. 59

Definition list
adding a value to .............................................. 201
angle ............................................................... 201
changing a definition ....................................... 201
deleting a value to .......................................... 201
distance ........................................................... 201
editing ............................................................. 201
loading a customized .................................... 207
scale ............................................................... 207

Del. Vertex See Vertex, deleting

Delete
double lines after hide ........................................ 469
framing settings files ....................................... 490, 492, 501
go-to-view ....................................................... 478
layer sets ......................................................... 186
layers ............................................................. 182
saved hide image ............................................ 468
stair settings files ............................................ 525
text styles ......................................................... 316
vertices ........................................................... 406
wall styles ....................................................... 217

Delete DbI See Hidden line removal, deleting double
lines with
Delete Layer ....................................... See Layers, deleting

Depth
- of balusters ....................................................... 522
- of handrails ....................................................... 521
- of landings .......................................................... 517
- of newel posts .................................................... 524
- of treads ............................................................. 518

Desktop
- classic ................................................................. 39

Dia. Circ. ........................................ See Circles, using diameter

Dialog boxes ............................................................... 40

Diameter
- curve, dimension of .............................................. 334
- of circles ............................................................. 238, 412
- of curve, measuring .............................................. 273
- of polygons when drawing ...................................... 229

Dim. Points ........................................ See Control points, displaying for associative dimensions

Dimensions ......................................................... 326–36
- aligned ................................................................. 326
- angle between lines .............................................. 334
- angle for angle and curve ....................................... 336
- angular .................................................................. 326
- arrow style for .................................................... 332
- arrows ................................................................. 327, 328
- associative ............................................................ 326, 328
- automatic ............................................................... 328
- automatic (tutorial) .................................................. 134
- automatic style for ............................................ 332
- automatic, style options for ................................... 328
- baseline ............................................................... 329, 331, 332
- center points .......................................................... 332
- changing linear ..................................................... 332
- curve diameter ...................................................... 334
- curve radius .......................................................... 335
- DIN Standard .......................................................... 331
- displaying associative ............................................. 206
- dots for ................................................................. 332
- drawing string of (tutorial) ....................................... 132
- editing linear .......................................................... 332
- exploding linear associative .................................... 333
- fixed distance of ................................................... 331
- geometric tolerances for ........................................ 331
- horizontal .............................................................. 326
- increment offset of ................................................. 331
- limits for ................................................................. 331
- line offset .............................................................. 330
- line style for .......................................................... 327, 328, 330
- line style for angle and curve ................................... 336
- linear ................................................................... 326
- minimum distance .................................................. 332
- miss distance .......................................................... 332
- moving linear ........................................................ 333
- object snapping and .............................................. 327
- overall ................................................................. 329
- overrun of extension lines ........................................ 331
- parallel to entity ....................................................... 326
- rotated ................................................................. 326
- rounding ............................................................... 331
- settings (tutorial) .................................................... 131
- stretching (tutorial) .................................................. 135
- stringline .............................................................. 327, 329, 332
- text offset for .......................................................... 330
- text style for .......................................................... 327, 328, 329
- text style for angle and curve ................................... 335
- tick marks for .......................................................... 332

vertical ...................................................................... 326

DIN ....................................................... See Scales, setting types

Direction distance, using with reference point ............... 263

Directories, changing .................................................. 44

Disp. Grid 1 ........................................ See Display, grids

Disp. Grid 2 ........................................ See Display, grids

Display
- customizing .......................................................... 205
- grid, changing color .............................................. 174
- grids ................................................................. 173
- negative coordinates ............................................. 204
- options, setting ................................................... 204
- synchronizing distances ......................................... 205

Dist. Sync. ........................................ See Distances, display, synchronizing

Distance
- copy ....................................................................... 250
- direction entry ....................................................... 72
- direction entry, drawing line with ................................ 73
- new, copy ............................................................. 249

Distances
- calculating ............................................................. 64
- display, synchronizing ........................................... 205
- increment ............................................................... 431
- measuring between two points ................................ 273
- new, 3D move ....................................................... 445
- previous stretch ..................................................... 449
- previous, 3D move .................................................. 445
- stretch, in Z direction ............................................. 449

Divide entities .......................................................... 278–80

Divisions
- of 2D arcs ............................................................. 471
- of balusters ........................................................... 522
- of contours ............................................................ 442
- of handrails .......................................................... 521
- of mesh surfaces .................................................... 430
- of newel posts ....................................................... 524
- primary ................................................................. 451
- secondary .............................................................. 451
- setting number for cylinders .................................... 418
- setting primary and secondary .................................. 389

Do Float ............................................. See Decimal, point, floating

DoCtr ......................................................... See 3D stairs, stringers of

DoGLfloat ........................................ See Scales, setting types

Dog-leg ......................................................... See 3D arcs, dog-leg

DoLftSee Handrails, on left side of stairs, See 3D stairs, stringers of

DoLndBt ........................................ See 3D stairs, landing of

DoLndTp ........................................ See 3D stairs, landing of

Domes
- primary divisions of ............................................. 423
- secondary divisions of .......................................... 423

DoNicPst ........................................ See Newel posts, modeling

Door Style ..................................................... See Doors, drawing

Door Swing ..................................................... See Doors, drawing

Doors
- adding 3D (tutorial) .............................................. 159
- adding 3D (tutorial) .............................................. 218–22
- adding 3D (tutorial) .............................................. 112
- match swing color to ............................................. 221
- opening angle ....................................................... 221
- removing ............................................................. 222
- styles of .............................................................. 219
- swing color of ....................................................... 221
- swing styles of ..................................................... 221

DoRight ........................................ See Handrails, on right side of stairs, See 3D stairs, stringers of
DoRiser .......................... See 3D stairs, risers of
Doors, drawing ........................................... 402, 403
DoTread .................. See 3D stairs, treads of
Double doors ................................. 219
Double tee concrete forms, drawing .................. 507
Drafting symbols, creating .......................... 547
Drag
copy entities using ................................... 249
moving using ........................................... 296
moving using (tutorial) .............................. 146
Draw Hidden  .......................... See Hidden line removal, drawing hidden
lines in
Draw Jamb  .......................... See Windows, drawing, See Doors, drawing
Draw Marks  .................. See Drawing, marks displaying
Drawing
and editing basic skills .............................. 72–79
cabinet elevations .............................. 371, 372
creating a new ......................................... 28
curves .............................................. 230–41
door elevations .................................... 367
doors .............................................. 218–22
doors (tutorial) ..................................... 112
exterior elevations with EZ Tools macro .............. 364
line by selecting two points ......................... 72
marks displaying .................................... 204, 221, 225, 262
naming .............................................. 128
opening an existing .................................. 72
polygons .......................................... 228–29
polylines .......................................... 241–45
rectangles .......................................... 229
set origin of ........................................... 61
sketching freehand .................................. 258
walls .................................................. 212–18
walls (tutorial) ...................................... 99
window elevations ............................... 369, 370
windows ............................................ 222
windows (tutorial) .................................. 117
with coordinate entry ................................ 72
with line types ....................................... 74
with the mouse .................................... 228
Drawing Area .................. See Drawing window, changing partitions in
Drawing Window, changing partitions in .............. 469
Drawings
border, moving (tutorial) ............................ 146
changing entities in .................................... 69
copying parts of ........................................ 69
customizing settings .............................. 198
laying out plot sheets for ............................ 383
linking ............................................... 79
mirroring parts of ........................................ 69
moving entities in ...................................... 69
plotting ............................................... 376
printing ............................................... 376
referencing ........................................... 79
saving ................................................ 84
stretching entities in .................................... 69
viewing ............................................... 82
Drop mesh  .................... See 3D stairs, risers of
controlling file size ................................... 434
created from survey data file ........................ 434
creating ............................................. 434
importing survey data for ............................ 435
increases file size ..................................... 434
over selected geometry ............................ 435
removing unused entities from ....................... 434
DWF, exporting files .................. See DWG exporting files
DWF, exporting files .................................. 434
DWG
block attributes in ..................................... 323
DataCAD symbol attributes in ..................... 323
exporting files ......................................... 91
files, customizing translation ...................... 354
importing drawing file ................................ 28
saving entity assignments when importing .......... 30
DWG Translator, translation tables .................. 530
DXF
exporting files ......................................... 91
files, customizing translation ...................... 354
importing drawing file ................................ 28
DXF Translator, translation tables .................. 530
Dynamic
curves, drawing ....................................... 230, 231
dragons ................................................ 229
tangent curves, drawing ......................... 236
Edit Defs  .................................. See Editing, value definitions
Edit Defs ............................................. 167
Edit menu ........................................... 69, 77
Edit Plane
changing zero plane orientation .................... 386
positioning zero plane with ......................... 387
Editing
and drawing basic skills .............................. 72–79
drawings ............................................. 77
linear dimensions .................................... 332
symbols ............................................ 355
value definitions ..................................... 201
Elevations ............................ See 3D stairs, risers of
cabinet settings for ................................... 372
cabinet styles for ..................................... 371, 372
creating (tutorial) ..................................... 167
creating 3D views of .................................. 459
creating new .......................................... 459
door .................................................. 367
door settings for ..................................... 368
doors styles for ........................................ 367, 368
drawing cabinets ...................................... 371, 372
drawing doors ......................................... 367, 368
drawing exterior ....................................... 364
drawing windows ..................................... 369, 370
exterior ............................................ 364
eexterior roof settings .................................. 365
saving views ........................................... 460
window settings for .................................... 370
window styles for ..................................... 369, 371
Ellipses ........................................... 239
closing, for hidden objects ......................... 470
End Point ... See Object snapping, to nearest end point
End Pt. Ang .......................... See Curves, drawing
End Pt. Rad .......................... See Curves, drawing
Engineering scales .................. See Scales, setting types
Enlarge ........................................... 303
3D entities ........................................... 450
enlargement factor ..................................... 303
imported graphics ..................................... 360
in X direction ........................................ 450
in Y direction ........................................ 450
in Z direction ........................................ 450
Entities
attributes of ......................................... 272
clipping with ClipPlt ................................. 307
INDEX | 573

customizing DXF/DWG translation ........................................ 54
DataCAD User (.USR) ......................................................... 88
drawing (.AEC) ................................................................ 26
Drawing Backup (.DBK) .................................................. 88
drawing recover (.DRF) .................................................. 89
drawing swap (.SWP) ...................................................... 88
exporting ........................................................................ 56, 91, 533
exporting XREF .................................................................. 57
icons used for DataCAD .................................................. 86
importing ......................................................................... 530
naming conventions ......................................................... 85
recover process .............................................................. 89
size reduction of ............................................................ 86
swap ................................................................................ 86
using archive to recover .................................................. 91
Fillets .................................................................................. 284
Filter ................................................................. See Layers, filtering
layers.................................................................................. 446
Filter Back ................................................................. See Filter
Filter Fwd ................................................................. See Filter
Fix Text ................................................................. See Mirror, text position
Fixed Ref ................................................................. See Reference point, fixed
Floor framing .............................................................. 490–91
  joist settings for ................................................................ 491
  sill plate settings for ................................................... 491
  subfloor settings for .................................................. 491
Fonts .................................................................................. 199
  changing menu button .................................................. 49
  converting TrueType fonts to 3D .................................... 319
  setting default .......................................................... 59
  setting text parameters for TrueType fonts ............... 318
  standard ................................................................. 547
  supplied by DataCAD .................................................. 310
  TrueType (TTF) .......................................................... 310, 318
Fractions ............................................................................. 199
  stacked ....................................................................... 200
Framing, 3D ............................................................. 490–501
  roof ........................................................................ 493–501
  wall ........................................................................ 491–93
Free Trim ................................................................. See Cleanup, trimming to nearest
Free Zooms, remembering .................................................. 60
Freehand, using to sketch .................................................. 258
Gable roofs ........................................................................ 400
Geometry ......................................................................... 250
Get-Snap ................................................................. 269, See Snapping
Girders, drawing ............................................................. 506
Glass Thk ................................................................. See Windows, glass thickness
Golden Mean ............................................................... 278
  dividing a line with .................................................... 279
Go-to-views ...................................................................... 477
  adding current view to the list .................................... 478
  changing an existing .................................................. 478
  deleting a view .......................................................... 478
  displayed in toolbar ................................................... 38
  moving a view .......................................................... 478
  renaming a view ........................................................ 478
Grads ................................................................. See Angles, setting types of
Grid Origin ................................................................. See Grids, setting origin of
GridCol ................................................................. See Display grid, changing color
Grids .................................................................................. 506
  changing size of ........................................................ 173
  changing the angle in ................................................ 175
  display, changing color of ........................................ 174
  display, using .......................................................... 173
  matching an entity’s angle ............................................ 175
  rotating ................................................................. 175

Erase Void See Voids, erasing, See Voids, erasing from a polyline

Export
  3D entity ................................................................. 57
  DWF files ............................................................... 91
  DWG files ............................................................... 91
  DXF files ............................................................... 91
  files .......................................................................... 56, 533
  files using Color Translation toggle ....................... 56
  o2c objects ........................................................... 92
  reference files ........................................................ 57
  text ....................................................................... 315
  using Line types toggle ........................................... 56
  XREF files ............................................................. 57

Export Layer See Layers, saving Extended characters ................. 547

Extension
  left, of stair treads ..................................................... 518
  right, of stair treads .................................................. 518

Extents, viewing ............................................................. 181

Eye point, changing .......................................................... 456

Fast 3D See Object snapping, to center of 3D circular entities

Fast 3D snapping .......................................................... 392

Fast Symbol See Object snapping, to symbol insertion point

Fence selection ............................................................. 61, 62
  3D ............................................................................... 62

Files
  auto-recover (.ARF) ................................................... 88, 205
  auto-recover backup (.ARB) ....................................... 88
  backup process ........................................................ 89
  compressed format of ............................................. 86
  converting to .AEC from .DC3 or .DC5 ................. 26
rotating with cursor ................................................. 205
setting origin of ...................................................... 176, 456
setting snap angle of ............................................... 175
snap, setting angle of ............................................. 175
snap, using .............................................................. 173
GridSize .............................................................. See Grids, changing size of 
Group ...................................................................... See Entities, grouping 
Group selection ...................................................... 61, 62, 305
Handrails
  color of ................................................................. 521
cylindrical ............................................................. 520
depth of ................................................................. 521
divisions of ............................................................ 521
height of ............................................................... 521
on left side of stairs .............................................. 520
on right side of stairs ............................................. 520
radius of ............................................................... 520
rectangular ............................................................. 520
width of ............................................................... 520
Hatch ................................................................. 338–46
  angle ................................................................. 339
  associative ............................................................ 345
  boundaries .......................................................... 339, 341
  boundaries with curves and/or arcs ...................... 342
  contour search .................................................... 341
  defining a rectangular boundary ......................... 342
  displaying .......................................................... 206
  drawing (tutorial) ................................................ 137
  drawing associative ............................................ 346
  drawing standard patterns .................................. 338
  master polyline with voids .................................. 245, 343
  origin of ............................................................ 339
  patterns .............................................................. 338, 339
  scale ................................................................. 338
  standard patterns ............................................... 539
  type of .............................................................. 338
  using SPB fills instead of .................................... 343
Hatch Pattern Manager ........................................ 339–41
  changing embedded hatch patterns ...................... 340
  converting .PAT files to .DHP format ...................... 340
  embedded hatch patterns .................................... 340
  external hatch patterns ....................................... 340
  reloading embedded hatch patterns ..................... 340
  saving embedded hatch patterns ......................... 340
Head height
  of doors ............................................................... 222
  of windows .......................................................... 224
Height ............................................................... See Handrails, height of 
  Height+Thk ........................................................ See Z-height, to thickness
Help, online .......................................................... 18
Hidden Color ....................................................... See Hidden line removal, colors of hidden lines
Hidden line removal
  adding retained image to active layer .................... 468
  adding retained image to layer file ....................... 468
  adding retained to new layer ............................... 468
  arc divisions for ............................................... 471
  closing 2D arcs for .......................................... 470
  closing ellipses for ......................................... 470
  colors of hidden lines ....................................... 470
  deleting double lines with .................................. 469
  displaying outlines in ....................................... 471
  drawing hidden lines in .................................... 469
  hidden line types for ........................................ 470
  increasing speed of .......................................... 468, 469
  joining lines during .......................................... 469
line spacing for hidden lines ................................ 470
maximizing performance of .................................. 467
offsetting an image ............................................. 468
performing .......................................................... 466
saving image of ................................................... 467
tutorial ............................................................... 166
Hidden Space ....................................................... See Line spacing, for hidden lines
Hidden Style ....................................................... See Line types, for hidden lines
Highlight ............................................................ See Walls, setting attributes of 
Hip roofs ............................................................ 401, 402
Hither clip ............................................................. 462
Horizontal 3D polygons ....................................... 396
Horizontal cylinders
  bottom half of .................................................... 417
  closed ............................................................... 418
  divisions of ....................................................... 418
  full ................................................................. 417
  radius of .......................................................... 417
  sweep angle for ................................ ............... 416
  sweep angles to draw half of ............................... 417
  top half of ........................................................ 417
Horizontal slabs ................................................... 397
HorzOfl .............................................................. See Balusters, horizontal offset of 
Hotkeys, for walk-through ...................................... 479
Hotspots .............................................................. 37
I-beams ............................................................... 508
Identify entities .................................................... 271
Images
  calibrating enlargement of ................................ 360
  calibrating enlargement of imported ...................... 303, 360
  enlarging .......................................................... 360
  importing files into drawing ............................... 359
  inserting into drawings .................................... 80
  preserving original dimensions of imported .......... 360
  printing controls for .BMP and .JPG files with Pen Table ....... 360
  saving in a different file format ......................... 84
Import
  and calibrate enlargement of imported graphics 303, 360
  default settings for .......................................... 55
  DWG or DXF file ............................................... 28
  entity assignments for ....................................... 29, 55
  files ................................................................. 55, 530
  image .............................................................. 359
  o2c object ........................................................ 359
  supported file formats ..................................... 359
  text ................................................................. 314
Import Layer ....................................................... See Layers, loading
In Order ............................................................ See Layers, refreshing in order of creation 
In Sill ............................................................... See Windows, drawing
In Wall ............................................................. See Windows, drawing, See Doors, drawing
Inch/Dec ........................................................... See Scales, setting types
Inch/Frc ........................................................... See Scales, setting types
Inclined polygons and slabs
  3-edged bottom ................................................. 402
  3-edged top ..................................................... 403
  3-edged vertical ............................................... 404
  4-edged general .............................................. 402
  4-edged parallelograms ................................... 400
  4-edged trapezoid ............................................ 401
  4-edged vertical ............................................... 403
Ins. Point ........................................................... See Insertion point
Inscribe ............................................................. See Polygons
Inserting
  o2c objects ....................................................... 359
  stamps ............................................................. 359
symbols ................................................................. 351
Insertion point ......................................................... 78
Installation of DataCAD ............................................... 18

Interface
customizing settings for .............................................. 53

Interface, customizing settings for ................................ 45

Intersect .......................... See Object snapping, to nearest intersection point

Intersections
  cleaning L .............................................................. 290
  cleaning T .............................................................. 289
  cleaning wall ........................................................ 215
  cleaning X .............................................................. 291
  marking .................................................................... 280

IntrLand .......................... See 3D stairs, intermediate landings of Inverted tee concrete forms, drawing ................. 506

Isometric views ........................................................ 459

Jamb Depth See Windows, drawing, See Doors, drawing
Jamb In .......................... See Windows, drawing, See Doors, drawing
Jamb Width See Windows, width of jamb, See Doors, drawing

Join ........................... See Hidden line removal, joining lines during

Keyboard shortcuts ..................................................... 42
  creating for pull-down menu options......................... 545
  standard .................................................................. 543

L, Intersect ................... See Intersections, cleaning L

Landings
  color ...................................................................... 517
  depth ..................................................................... 517
  intermediate .................................................................. 517
  modeling .............................................................. 517
  thickness of .......................................................... 517

Layer Manager ......................................................... 188–98
  adding layers with .................................................. 194
  changing a layer’s color with ................................... 192
  changing a layer’s name with ................................... 193
  changing a layer’s number with ................................ 189
  changing layer settings with ..................................... 190
  changing on/off layer settings with ........................... 190
  deleting layer(s) with .............................................. 197
  designating the active layer with .............................. 191
  exiting from .......................................................... 196
  locking/unlocking layers with .................................. 192
  moving layers with ............................................... 189
  opening ................................................................. 188
  reverting to previous layer settings with .................... 197
  sorting layers with .................................................. 189
  turning all layers on with ........................................... 191
  using Cancel in ........................................................ 198
  using Undo to restore old layer settings ....................... 198

Layer Refresh .......................... See Layers, refreshing

Layer search .......................................................... 62, 220, 223, 388
  selection .................................................................. 61
  status of ..................................................................... 62
  status toggle ............................................................ 37

Layer Sets
  creating ..................................................................... 185
  deleting ..................................................................... 186
  loading ..................................................................... 186

Layer Snap .......................... See Snapping, on layers, See Object snapping, on layers

Layers
  active ................................................................. 37
  adding (tutorial) ..................................................... 96
  assigning colors (tutorial) ......................................... 97
  changing active (tutorial) .......................................... 97
  changing color ...................................................... 181
  changing the active ................................................ 37, 178
  creating ............................................................... 177
  creating layer sets .................................................. 185
  customizing settings for symbols .............................. 358
  defining materials for each ....................................... 187
  deleting .................................................................... 182
  deleting with Layer Sets ........................................... 186
  displaying ............................................................. 178
  erasing contents of .................................................. 181
  filtering .................................................................... 183, 446
  loading ..................................................................... 184
  loading with Layer Sets ........................................... 186
  locking ..................................................................... 180
  moving 3D entity to .................................................. 445
  moving entities to another ........................................ 182, 297
  moving SPB-filled entities on same layer .................... 298
  naming convention for ............................................ 185
  order of ............................................................... 207
  planning ............................................................... 186
  refreshing .................................................................. 67
  refreshing in order of creation .................................... 207
  renaming ............................................................... 180
  renaming (tutorial) ................................................... 96
  saving ....................................................................... 184
  searching for .......................................................... 183
  seed ......................................................................... 178
  setting the active ................................................... 178, 182
  setting Z base and height for .................................... 188
  setting Z base for current layer only ......................... 386
  setting Z height for current layer only ....................... 386
  swapping SPB-filled entities on same layer ................ 299
  toggling all on ........................................................ 179
  toggling on and off ................................................... 179
  unlocking ............................................................... 180
  using Z By Layer ..................................................... 386
  viewing ..................................................................... 181
  Z By Layer ............................................................. 188

Layout
  single-scale .......................................................... 383
  using Quick Layout .................................................. 383

LeftExtn ................................. See 3D stairs, treads of Line spacing, for hidden lines .................. 470

Line Type Manager .......................... 74
  adding embedded line types ..................................... 75
  changing line spacing with ..................................... 75
  customizing embedded line types .............................. 75
  enabling end correction with ................................... 75
  selecting external line types ...................................... 75
  using ................................................................. 74

Line types ......................................................... 74
  displaying ........................................................... 206
  exporting .................................................................. 56
  for hidden lines ...................................................... 470
  menu ................................................................. 74
  settings .................................................................. 538
  standard .............................................................. 538
  using ..................................................................... 69

Line weight ......................................................... 76
  copying ............................................................... 60
  displaying ........................................................... 206

Lines
  connecting two lines with ....................................... 285
  dividing ............................................................... 278
  dividing with Golden Mean ...................................... 279
marking intersection of ..................................................... 280
maximum ........................................................................ 296
measure angle excluded between two ................................ 275
measure angle included between two ................................ 274
measuring angle of ............................................................ 273
measuring length of ............................................................ 273
measuring total length of .................................................... 275
style for dimensions ......................................................... 327, 328
style options for angle and curve dimensions .................... 334, 336
style options for linear dimensions ..................................... 330
welding ............................................................................ 288
LineWgt ........................................................................ 393
Load ............................................................................... 305
layer sets .......................................................................... 186
text styles ......................................................................... 316
wall styles .......................................................................... 217
Lock ................................................................................. 393
Marking, intersection of two lines ................................. 280
Match ............................................................................... 292
changing entities using ..................................................... 292
changing text attributes using ......................................... 293
colors ............................................................................... 66
moving 3D entities to another layer .................................. 446
moving entities to another layer with ............................ 182
setting active layer using ................................................ 182
snap grid to an entity ........................................................ 280
Match Door ................................................................. 280
See Doors, match swing color to ................................. 280
Match Wall See Windows, drawing, See Doors, drawing
Materials ........................................................................... 187
Max. Lines See Lines, maximum, See Drag-copy entities
using ............................................................................... 272–78
Menu Bar ............................................................................ 31
Menu buttons ..................................................................... 49
customizing ...................................................................... 47
Menu labels ....................................................................... 47
Menu Window ..................................................................... 40
classic ............................................................................. 41
Edit and Utility .................................................................. 41
label options ..................................................................... 41
tool tips ........................................................................... 41
Menus ................................................................................. 388
3D Menus .......................................................................... 388
3D Views .......................................................................... 387, 388, 455
Angle Type ......................................................................... 200
Architect ........................................................................... 212
Change ............................................................................. 291, 292, 293
Cleanup .............................................................................. 285
Color ............................................................................... 65
Copy ............................................................................... 248
Curves .............................................................................. 230–41
Drag ............................................................................... 249
Edit .................................................................................... 77
Enlarge ............................................................................. 303
Erase ................................................................................. 304
Freehand ........................................................................... 258
GoTo View ......................................................................... 477
Grids ................................................................................ 173
Group ................................................................................ 62, 305
Hatching ......................................................................... 338, 341, 342, 343, 346
Identify .............................................................................. 271
Insert .................................................................................. 549
Layers ................................................................................ 177, 178
Line type ............................................................................ 74
Measures .......................................................................... 265
Object Snap ....................................................................... 264, 265, 266, 267, 268
Plotter ............................................................................... 153
Print/Plot ........................................................................... 376
Ref. Point .......................................................................... 262
Rotate ................................................................................. 300
selection (entity, group, area) .......................................... 61
Settings .............................................................................. 199
Stretch ............................................................................... 302
Takeoffs ............................................................................ 275
Templates .......................................................................... 310
Text .................................................................................... 315, 316
Text Style ........................................................................... 495, 506
value ................................................................................ 63
Walk Through ................................................................... 480
Zoom .................................................................................. 82
Mesh surfaces .................................................................... 428
control points ................................................................... 431
creating with varying Z elevations ................................. 431
divisions of ................................................................. 430
drawing manually ............................................................ 429
rectangular ...................................................................... 429
setting values for Z-User 1 and Z-User 2 ......................... 431
vertical ............................................................................. 430
Mesh, drop ....................................................................... 434–41
Meters .............................................................................. 203
See Scales, setting types
Metric .............................................................................. 203
See Scales, setting types
Metric scales .................................................................... 203
Mid Point See Object snapping, to nearest midpoint of
line ................................................................................ 203
MilliMtr See Object snapping, to nearest midpoint of
line ................................................................................ 203
Mirror ............................................................................... 304
3D entities ........................................................................ 448
and copy .......................................................................... 257
defining reflection line .................................................... 257
entities ............................................................................. 257–58
text position ..................................................................... 258
Miss Dist See Cursor, setting accuracy of
Miss Dist See Object snapping, defining miss distance
for ................................................................................ 258
Mltlyout See Printing, multiple views
Monitor, working with two ................................................. 66
Mouse, snapping with middle button ............................... 265
MouseWheel, using for walk-through ............................ 479
Move Vertex See Vertex, moving MoveZ See Moving, in Z direction
Moving .............................................................................. 479
3D entities ........................................................................ 445, 294–98
3D entities to another layer ............................................. 445
dragging to ................................................................. 296
dragging to (tutorial) ....................................................... 146
to absolute zero ............................................................ 294
in Z direction ................................................................. 295
linear dimensions .......................................................... 333
new angle ........................................................................ 297
new distance ......................................................... 295, 297
previous distance ................................................. 295
SPB-filled entities on same layer ......................... 298
specified distance and angle ................................. 295
to another layer .................................................. 297
using Match on 3D entities ................................. 446
view sphere ......................................................... 457
MultiView windows, displayed in toolbar ............. 38
Natural contours .................................................. 441
Navigation pad, toolbar ...................................... 34
Navigation toolbar, viewing with ......................... 84
Nearest .............. See Object snapping, to nearest point
Neg. Dist. .............. See Negative coordinates, displaying
Negative coordinates, displaying ....................... 204
New Distance .............. See Copy, new distance
New Elevation Indicator ....................................... 459, 460
and Z-base and Z-height settings ......................... 460
and zero plane .................................................... 460
cursor changes to ................................................ 387
New Dist...... See Copy, new distance
Newel posts ....................................................... 524
as symbols ......................................................... 524
color of ............................................................ 525
cylindrical .......................................................... 524
depth of ............................................................ 524
divisions of ........................................................ 524
modeling ............................................................ 523
radius of ............................................................ 524
rectangular ......................................................... 524
width of ............................................................. 524
NewelPst .............. See 3D stairs, newel posts for
NewLayer .............. See Layers, creating
NewLine .............. See Tangents, drawing curves as
No Change .............. See Color, menus
No Prim Edge ...... See Hidden line removal, displaying
Outlines in
No. of Sides .............. See Polygons
No. Points .............. See Object snapping, to dividing point
Normal ...................... See Angles, setting types of
Nosing ..............................................................
for stair treads .................................................... 519
round ............................................................... 519
square .............................................................. 519
02c
adding 3D models as e-mail attachment ................. 92
adding 3D models to web page .............................. 92
exporting objects ................................................ 92
inserting objects ............................................... 359
Objects to See .................................................. 92
Object snapping ............................................... 264
defining miss distance for .................................... 264
drawing line perpendicular to entity ......................... 268
increasing speed of ........................................... 268
on layers ............................................................ 264, 265
placing dimensions with .................................... 327
show point ......................................................... 61
tangent to arc .................................................... 269
to center of 3D circular entities ............................. 264
to dividing point ................................................ 266
to entities in active selection set ............................ 264
to hatch lines ..................................................... 264
to nearest center point ....................................... 267
to nearest end point .......................................... 266
to nearest intersection point ................................ 268
to nearest midpoint of line ................................. 267
to nearest point ................................................ 265
to nearest quadrant point .................................... 267
to symbol insertion point .................................... 264
Object Viewer
checking Z offset of symbols with ......................... 353
raytracing with .................................................. 483
selecting from View menu .................................... 481
using toolbar icons .......................................... 482
using with Symbol Browser ............................... 350
Oblique views ................................................... 465–66
axonometrics ...................................................... 465
creating elevation .............................................. 465
creating plan ..................................................... 465
elevation ............................................................ 465
plan ................................................................. 465
rotation angle for .............................................. 465
settings for ........................................................ 465
Offset .............. See Entities, offsetting and copying
OnSide .............. See Balusters, placement of
OnStrng .............. See Balusters, placement of
OnTread .............. See Balusters, placement of
OpenStr .............. See Stringers, open
Orphans
using Reference File Manager with ....................... 79
XREF, resolving ............................................... 79
Out Sill .............. See Windows, drawing
Overhead doors .................................................. 219
Overshoot ......................................................... 76, 206
adding to existing line ......................................... 77
displaying ......................................................... 77
setting ............................................................... 77
Palettes, using customized colors ......................... 207
Pan/Scrolls, remembering .................................. 60
Parallel views .................................................... 455–61
elevations ............................................................ 459
isometric ............................................................ 459
new view center as new grid origin for snapping ....... 456
using view sphere for ......................................... 456
Password, setting .............................................. 199
Paste ............................................................... 78
Paste Special ..................................................... 78
Pattern Fills .............. See SPB Fills
Pen Table .............. See SPB Fills
Pen width ........................................................... 381–82
map to color ....................................................... 382
save settings in .DPF file ....................................... 382
set pen colors ...................................................... 381
set pen density ..................................................... 382
set pen width ...................................................... 382
settings for .BMP and .JPG images ......................... 360
settings for SPB fills .......................................... 345
use settings saved in .DPF file ............................. 383
Perp .............. See Object snapping, drawing line perpendicular to entity
Perspective views ............................................... 461–64
1-point ............................................................... 463
2-point ............................................................... 464
3-point ............................................................... 464
camera settings for .......................................... 463
cone of vision ..................................................... 462, 463
eye point of ......................................................... 461, 462
focal point of ...................................................... 461, 462
hither clip in ....................................................... 462
tutorial ............................................................. 165
using view sphere for ......................................... 456
Picture plane ..................................................... 462
INDEX | 577
Plane snap .............................................. 376–82, See Plane snap

Plotting .............................................. 376–82, See Printing
    check plot .......................................... 380
    scale .................................................. 378
    single-scale ........................................ 383
    tutorial .............................................. 152–55

Plotting scale ................... See Printing, plotting scale for

Pocket doors ........................................ 219

Point to Point, measuring .......................... 273

Polygons .............................................. 228–29
    hide edge of ........................................ 407
    normals .............................................. 474
    show edge of ....................................... 407

Polylines
    adding voids to .................................... 244, 343
    converting voids to polygon .................... 245
    covered .............................................. 244
    drawing .............................................. 241–45
    drawing by segments .............................. 243
    erasing voids from ................................. 245
    hatching master containing voids .............. 245, 343
    rectangular ......................................... 242
    tracing ................................................ 277
    tracing 2-point arcs ................................ 277
    tracing 3-point arcs ................................ 277
    tracing tangent arcs ................................ 278

PrevDist .............................................. See Distance, previous

Preview
    plots ................................................... 379, 380

Primary divisions
    of spheres .......................................... 423
    of surfaces of revolution .......................... 426
    of torus ............................................. 425

Printing .............................................. 376–82
    batch plotting Error! Not a valid bookmark in entry on page 383
    check plot .......................................... 378, 380
    color .................................................. 382
    effective plotting area for paper size ............ 377
    gray scale .......................................... 382
    laying out your drawing for ...................... 379, 383
    layout orientation .................................. 378
    loading pen table settings for ................. 383
    multiple views ..................................... 379
    paper orientation ................................... 377
    paper size for ...................................... 377
    Pen Table .......................................... 379, 381–82
    in tutorial .......................................... 154
    Pen Table settings for .BMP and .JPG images ... 360
    Pen Table settings for SPB fills .................. 345
    pen width .......................................... 379
    plotting scale ...................................... 378
    preview of plot ..................................... 379, 380
    quick layouts for .................................. 379, 383
    rotating plot for .................................. 379
    saving pen table settings for .................... 383
    selecting printer for .............................. 377
    tutorial .............................................. 152–55
    using pen table settings ......................... 383
    widths of pen passes ............................. 382

Program Preferences
    background color .................................. 48
    DXF/DWG import .................................. 54
    menu button font .................................... 49
    pathnames .......................................... 44

Program, launching external in DataCAD ............... 93

Project
    drawing efficiently .................................. 69
    managing ............................................ 172
    planning entire .................................... 67
    planning layers ..................................... 67
    Project Directory ................................... 172
    sample .............................................. 69

Projection pad, toolbar ................................... 34

Quick Search .................. See 3D entities, selecting curved

Quick snapping ..................................... 389, 392

Radial length ......................................... See Angles, setting types of

Rectangular arrays .................................... 447

Redo ..................................................... 78

Rect. Array ............................................ See Copy, rectangular array

Rectangles, drawing, See Polylines, drawing rectangular, See Drawing, rectangles

Rectangles, See Polylines, drawing rectangular, See Drawing, rectangles
    drawing .............................................. 229
    drawing 3D polygons ............................. 396
    drawing slabs ..................................... 396

Rectangular arrays .................................... 447

Redo ..................................................... 78

Rectangular arrays .................................... 447

Ref. Point ............................................ See Reference point, floating

Reference point ...................................... 262–64
    fixed ................................................... 262
    floating .............................................. 262
    show current ........................................ 261
    using with direction distance ................... 263

Referencing
    image files ......................................... 359

Referencing drawings .................................... 79
    disabling nested ................................... 61
    orphaned .......................................... 79
    resolving orphaned ............................... 79
    retaining highlight settings .................... 61
    using stamps ....................................... 359

Reflection line, defining ............................. 257

Relative Cartesian entry ............................ 72

Relative polar entry .................................... 72
    drawing line with ................................. 73

Remove
    cutouts in walls .................................... 218
saving shader settings .................................................. 474
settings for ................................................................. 471
using a .LIT file .......................................................... 474

Shading .................................................................... 471–75

Shed roofs .................................................................. 400

Shortcuts
creating keyboard for pull-down menu options .......... 545
standard keyboard ....................................................... 543

Show Attrb See Attributes, added with macro,
displaying visible

Show Dim See Dimensions, displaying associative

Show Hatch See Hatch, displaying

Show Ins See Symbols, insertions points displaying

Show Text See Text, displaying

Show Weight See Line weight, displaying

ShowVals See Walls, displaying styles

ShowZ See Z-base, displaying, See Z-height, displaying

Sig. Digits See Decimal, place setting

SigDigit See Scales, setting types

Sill Height See Windows, drawing

Single doors ............................................................... 219

Single tee concrete forms, drawing .......................... 507

Site model with drop mesh ....................................... 434–41

Sketch, using Freehand to ....................................... 258

Slab Refs See Slabs, reference face markers

Slabs
adding vertices to .................................................... 406
deleting vertices from ............................................... 406
editing ................................................................. 405
hide edge of ........................................................... 407
horizontal .............................................................. 397
moving vertices in .................................................. 407
rectangular ............................................................. 396
reference face markers .......................................... 399
show edge of .......................................................... 407
thickness of ............................................................. 396, 400
vertical ................................................................. 398

Sliding doors ............................................................. 219

Small Grid See Display, options, setting

Small Symbol See Symbols, smallest display size

Small Text See Text, displaying smallest size

Smooth Pass See Contours, smoothing surface

Snap grid
changing size of ........................................................ 173
matching to an entity ................................................ 280
new view center becomes new grid origin ................. 456
setting (tutorial) .......................................................... 96

setting angle of .......................................................... 175
using .................................................................... 173

Snap Point See Snapping, point adding

Snap Angle See Snap grid, setting angle of

Snaping ................................................................. 264–71

3D point .................................................................. 393
adding to Get X distance ........................................ 270
grid origin for .......................................................... 456
object ................................................................. 264
on layers .................................................................. 388
plane ................................................................. 387
point, adding .......................................................... 264
quick ..................................................................... 389, 392
subtracting from Get X distance ............................... 270
to add to or subtract from defined angle ................. 270
to define an angle .................................................... 270
to enter horizontal distance .................................... 269
to enter vertical distance ....................................... 269
using middle mouse button for ......................... 265
virtual ................................................................. 271
with Get-Snap .......................................................... 269

Solid Fills See SPB Fills

Sorting
layers, alphabetically ............................................. 190
layers, by color ....................................................... 190
layers, by layer number ......................................... 190
layers, by lock status ............................................. 190
layers, by number of entities in ............................ 190
layers, by on/off status .......................................... 190
using Layer Manager for ....................................... 189

SPB Fills .................................................................. 343
choosing colors for fill and pattern ......................... 344
choosing pattern ...................................................... 344
controlling X/Y aspect of bitmap fills ....................... 345
moving entities on same layer ............................... 298
moving filled entities .............................................. 345
printing controls with Pen Table ............................ 345
selecting .BMP or .JPG image ................................. 344
swapping entities on same layer ............................ 299
using instead of hatch patterns .............................. 343
using Select Fill Color/Pattern dialog .................... 344

Spheres .................................................................... 423
beginning rise angle for .......................................... 423
drawing ............................................................... 422
ending rise angle for ................................................. 423

SqrNosng See Nosing, for stair treads

Stack Frac See Fractions

Stacks
3D Error! Not a valid bookmark in entry on page 525
creating 3D with Z-elevations in rectangular arrays .. 256

Stamps
format exported ....................................................... 60
inserting in drawing ............................................... 359
values updated automatically ................................ 359

Start Ang See Curves, drawing

Start Angle See Angles, setting types of

Status panel
active layer ............................................................. 37
layer search toggle ................................................ 37
toolbar ................................................................. 36

Stiffness See Contours, stiffness of

STL files
inserting into drawing ............................................ 80

Stretch ................................................................. 302
3D entities ............................................................. 449–50

StrForm See 3D stairs, form
adjusting to fit in area ......................................................... 313
aligning ........................................................................ 313
arrows, drawing (tutorial) .................................................. 129
attribute, generating report on ........................................ 323
attributes for symbols ..................................................... 320, 358
changing angle of ............................................................. 311
changing appearance of .................................................. 310
changing aspect ratio of ................................................... 311
changing attributes of ...................................................... 292
changing properties of TrueType font .......................... 311, 318
changing scale of ............................................................ 311
changing size of ............................................................... 311
changing style of TrueType font ...................................... 311, 318
changing weight of ........................................................ 311
creating attributes for symbols ....................................... 320
deleting styles ................................................................ 316
displaying ....................................................................... 206
displaying smallest size .................................................. 207
drawing arrows ................................................................ 317
drawing (tutorial) ............................................................ 130
editing (tutorial) .............................................................. 323
editing symbol attributes ............................................. 323
entering directly into drawing ....................................... 311
exporting ......................................................................... 315
importing ......................................................................... 314
inserting ........................................................................... 312
inserting notes (tutorial) .................................................. 128
inserting room names (tutorial) ....................................... 127
inserting TrueType text in drawing ................................. 319
justifying ......................................................................... 312
loading styles ................................................................... 316
setting attributes (tutorial) ............................................. 126
setting parameters for TrueType fonts .......................... 318
style for dimensions ....................................................... 327, 328
style options for angle and curve dimensions ............. 334, 335
styles of ........................................................................... 315
using TrueType (TTF) fonts for ..................................... 318

Thickness
of 3D stair landings .......................................................... 517
of 3D stair risers ............................................................... 518
of 3D stair stringers ........................................................ 520
of 3D stair treads .............................................................. 518
of doors .......................................................................... 222
of slabs ........................................................................... 396, 400
of vertical cylinders ....................................................... 415

Title block
creating (tutorial) ............................................................ 147

To Layer ............See Copy, to another layer, See Layers, moving entities to another

Tool tip .................See Copy, to another layer, See Layers, moving entities to another

Toolbars .................................................................32

action codes for ........................................................... 537
Architect context-sensitive ............................................ 212
attention .......................................................................... 38
context-sensitive ................................................................ 35
coordinates ...................................................................... 38
creating custom .............................................................. 535
creating icons for ........................................................... 536
customizing ....................................................................... 32
diag box .......................................................................... 32
drop-down items .............................................................. 536
Edi .......................................................................... 32
hists ............................................................................... 38
hotspots in status panel ................................................ 37
icon button size ............................................................... 536
icons access menu functions .......................................... 32

message .................................................................38
multiview windows ......................................................... 38
navigation pad ............................................................... 34
projection pad ................................................................. 34
selecting default ............................................................ 52
standard .......................................................................... 33
status panel ................................................................. 36
SWOTHLUDFB ............................................................ 37
viewer ........................................................................... 35
viewing with Navigation icons ....................................... 84
view-sensitive .................................................................. 35

Toolbox
3DStairs ......Error! Not a valid bookmark in entry on page 525
Concrete ...............................................................306

Torus .................................................................424
beginning roll angle for ............................................... 424
down roll angle for ....................................................... 424
primary divisions of ...................................................... 425
radius of ................................................................. 424
secondary divisions of ............................................... 425

Tracing
2-point arcs ................................................................... 277
3-point arcs ................................................................. 277
polylines ......................................................................... 277
tangent arcs .................................................................... 278

Translator
default settings for DXF/DWG files ......................... 55
DWG/DXF ................................................................. 530
importing DWG and DXF files .................................. 28

Trd/Run1 ...............................................................324
Trd/Run2 ...............................................................324
Trd/Run3 ...............................................................324

TrdLngth ...............................................................518

Treads ...............................................................518

color of ........................................................................... 519
depth ............................................................................ 518
extensions of ................................................................ 518
nosing for ....................................................................... 519
thickness of .................................................................... 518

Trimming ......................................................................... 284–87
entities ............................................................................ 286, 287
entities to end at a specified line .................................. 286
two lines .......................................................................... 286
entities, specified .......................................................... 287

TrueType fonts ............................................................. See Fonts, TrueType (TTF)
converting to 3D .......................................................... 319
inserting text in drawing ............................................... 319
setting text parameters for .......................................... 318
using instead of CHR fonts .......................................... 318

TrueType fonts (TTF) ...................................................318
See Text, using TrueType (TTF) fonts for

Tutorial
adding layers ............................................................... 96
assigning layer colors ................................................... 97
automated 3D modeling ............................................. 158–64
border, creating ........................................................... 145
border, moving ............................................................ 146
changing active layer ................................................... 97
cleaning wall intersections ......................................... 106
dimensions, automatic ................................................. 134
dimensions, drawing string of .................................... 132
dimensions, setting ....................................................... 131
dimensions, stretching ................................................ 135
drawing
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>doors</td>
<td>112</td>
</tr>
<tr>
<td>windows</td>
<td>117</td>
</tr>
<tr>
<td>drawing text arrows</td>
<td>129</td>
</tr>
<tr>
<td>drawing walls</td>
<td>99</td>
</tr>
<tr>
<td>editing text</td>
<td>130</td>
</tr>
<tr>
<td>hatching</td>
<td>137</td>
</tr>
<tr>
<td>inserting notes</td>
<td>128</td>
</tr>
<tr>
<td>inserting room names</td>
<td>127</td>
</tr>
<tr>
<td>printing, pen table</td>
<td>154</td>
</tr>
<tr>
<td>renaming layers</td>
<td>96</td>
</tr>
<tr>
<td>setting snap grid for</td>
<td>96</td>
</tr>
<tr>
<td>setting text attributes</td>
<td>126</td>
</tr>
<tr>
<td>symbols, copying</td>
<td>144</td>
</tr>
<tr>
<td>symbols, opening</td>
<td>140</td>
</tr>
<tr>
<td>title block, creating</td>
<td>147</td>
</tr>
<tr>
<td>viewing 3D model</td>
<td>164–69</td>
</tr>
<tr>
<td>Undo</td>
<td>78</td>
</tr>
<tr>
<td>Ungroup</td>
<td>See Entities, ungrouping</td>
</tr>
<tr>
<td>Units</td>
<td>See Scales, setting types</td>
</tr>
<tr>
<td>User Line</td>
<td>See Line types, displaying</td>
</tr>
<tr>
<td>View Center</td>
<td>456</td>
</tr>
<tr>
<td>changing with Edit Plane</td>
<td>456</td>
</tr>
<tr>
<td>changing with New Elev.</td>
<td>456</td>
</tr>
<tr>
<td>repositioning</td>
<td>456</td>
</tr>
<tr>
<td>View Layer</td>
<td>See Layers, viewing</td>
</tr>
<tr>
<td>View sphere</td>
<td>456</td>
</tr>
<tr>
<td>changing eye point for view</td>
<td>456</td>
</tr>
<tr>
<td>formerly &quot;globe&quot;</td>
<td>456</td>
</tr>
<tr>
<td>moving</td>
<td>457</td>
</tr>
<tr>
<td>operating</td>
<td>457</td>
</tr>
<tr>
<td>repositioning in Drawing Window</td>
<td>457</td>
</tr>
<tr>
<td>using for parallel views</td>
<td>456</td>
</tr>
<tr>
<td>using for perspective views</td>
<td>456</td>
</tr>
<tr>
<td>Viewer/Shader</td>
<td>484</td>
</tr>
<tr>
<td>defining materials with</td>
<td>484</td>
</tr>
<tr>
<td>saving material assignments in .DMF file</td>
<td>487</td>
</tr>
<tr>
<td>using for color mapping</td>
<td>484</td>
</tr>
<tr>
<td>Viewing</td>
<td>161</td>
</tr>
<tr>
<td>3D models (tutorial)</td>
<td>161</td>
</tr>
<tr>
<td>advanced 3D (tutorial)</td>
<td>164</td>
</tr>
<tr>
<td>changing</td>
<td>164</td>
</tr>
<tr>
<td>layers</td>
<td>181</td>
</tr>
<tr>
<td>selected entities in 3D model</td>
<td>475</td>
</tr>
<tr>
<td>using arrow keys for</td>
<td>84</td>
</tr>
<tr>
<td>using Clip Cube for</td>
<td>475</td>
</tr>
<tr>
<td>using Navigation toolbar for</td>
<td>84</td>
</tr>
<tr>
<td>Views</td>
<td>465–66</td>
</tr>
<tr>
<td>3D oblique</td>
<td>465–66</td>
</tr>
<tr>
<td>3D perspective</td>
<td>461–64</td>
</tr>
<tr>
<td>adding current to GoTo View list</td>
<td>478</td>
</tr>
<tr>
<td>changing</td>
<td>164</td>
</tr>
<tr>
<td>changing an existing GoTo View</td>
<td>478</td>
</tr>
<tr>
<td>changing center of</td>
<td>456</td>
</tr>
<tr>
<td>deleting an existing GoTo View</td>
<td>478</td>
</tr>
<tr>
<td>isometric</td>
<td>459</td>
</tr>
<tr>
<td>moving an existing GoTo View</td>
<td>478</td>
</tr>
<tr>
<td>parallel</td>
<td>455–61</td>
</tr>
<tr>
<td>perspective (tutorial)</td>
<td>165</td>
</tr>
<tr>
<td>remembering previous</td>
<td>60</td>
</tr>
<tr>
<td>renaming an existing GoTo View</td>
<td>478</td>
</tr>
<tr>
<td>shaded image</td>
<td>471–75</td>
</tr>
<tr>
<td>Virtual snapping</td>
<td>271</td>
</tr>
<tr>
<td>Visibility</td>
<td>407</td>
</tr>
<tr>
<td>hide edge of polygon or slab</td>
<td>407</td>
</tr>
<tr>
<td>show edge of polygon or slab</td>
<td>407</td>
</tr>
<tr>
<td>Voids</td>
<td>404</td>
</tr>
<tr>
<td>adding</td>
<td>244, 343</td>
</tr>
<tr>
<td>adding to polyline</td>
<td>244</td>
</tr>
<tr>
<td>converting</td>
<td>405</td>
</tr>
<tr>
<td>converting to polygon</td>
<td>245</td>
</tr>
<tr>
<td>erasing</td>
<td>405</td>
</tr>
<tr>
<td>erasing from a polyline</td>
<td>245</td>
</tr>
<tr>
<td>hatching polyline that contains</td>
<td>343</td>
</tr>
<tr>
<td>Volume, measuring circle or polyline</td>
<td>276</td>
</tr>
<tr>
<td>Walk through a model</td>
<td>479</td>
</tr>
<tr>
<td>customizing options for</td>
<td>479</td>
</tr>
<tr>
<td>looking</td>
<td>481</td>
</tr>
<tr>
<td>perspective navigation controls</td>
<td>479</td>
</tr>
<tr>
<td>perspective view</td>
<td>479</td>
</tr>
<tr>
<td>saving a view of</td>
<td>481</td>
</tr>
<tr>
<td>stepping</td>
<td>480</td>
</tr>
<tr>
<td>turning</td>
<td>480</td>
</tr>
<tr>
<td>using hotkeys</td>
<td>479</td>
</tr>
<tr>
<td>using MouseWheel</td>
<td>479</td>
</tr>
<tr>
<td>Viewer toolbar</td>
<td>479</td>
</tr>
<tr>
<td>walking</td>
<td>480</td>
</tr>
<tr>
<td>Wall framing</td>
<td>491–93</td>
</tr>
<tr>
<td>plate settings</td>
<td>492</td>
</tr>
<tr>
<td>stud settings</td>
<td>493</td>
</tr>
<tr>
<td>wall height for</td>
<td>492</td>
</tr>
<tr>
<td>Wall Style Manager</td>
<td>215</td>
</tr>
<tr>
<td>deleting wall styles with</td>
<td>217</td>
</tr>
<tr>
<td>displaying wall style settings</td>
<td>217</td>
</tr>
<tr>
<td>saving changes</td>
<td>216</td>
</tr>
<tr>
<td>specifying options</td>
<td>216</td>
</tr>
<tr>
<td>using wall styles</td>
<td>217</td>
</tr>
<tr>
<td>Walls</td>
<td>212, 213</td>
</tr>
<tr>
<td>2-line</td>
<td>212, 213</td>
</tr>
<tr>
<td>3-line</td>
<td>212, 213</td>
</tr>
<tr>
<td>3-line attributes</td>
<td>213, 214</td>
</tr>
<tr>
<td>4-line</td>
<td>212, 213</td>
</tr>
<tr>
<td>4-line attributes</td>
<td>214, 215</td>
</tr>
<tr>
<td>attributes</td>
<td>214</td>
</tr>
<tr>
<td>capping</td>
<td>213, 215</td>
</tr>
<tr>
<td>cleaning</td>
<td>215</td>
</tr>
<tr>
<td>cleaning (tutorial)</td>
<td>216</td>
</tr>
<tr>
<td>cleaning intersections</td>
<td>213</td>
</tr>
<tr>
<td>cutting</td>
<td>217</td>
</tr>
<tr>
<td>defining by cavity center</td>
<td>217</td>
</tr>
<tr>
<td>defining by center</td>
<td>213</td>
</tr>
<tr>
<td>deleting styles</td>
<td>217</td>
</tr>
<tr>
<td>displaying styles</td>
<td>217</td>
</tr>
<tr>
<td>drawing</td>
<td>212–18</td>
</tr>
<tr>
<td>drawing (tutorial)</td>
<td>99</td>
</tr>
<tr>
<td>finishing for models (tutorial)</td>
<td>162</td>
</tr>
<tr>
<td>framing</td>
<td>491–93</td>
</tr>
<tr>
<td>loading styles</td>
<td>217</td>
</tr>
<tr>
<td>removing opening from</td>
<td>218</td>
</tr>
<tr>
<td>setting attributes of</td>
<td>213, 214</td>
</tr>
<tr>
<td>styles</td>
<td>215</td>
</tr>
<tr>
<td>welding</td>
<td>222, 288</td>
</tr>
</tbody>
</table>
Width
- of 3D stair handrails: 213
- of balusters: 522
- of newel posts: 524
- of stair stringers: 519
- of walls: 213

Windows
- adding 3D (tutorial): 158
- drawing: 222
- drawing (tutorial): 117
- drawing in elevations: 369
- removing: 225
- width of jamb: 223

World coordinates: 458

X Enlargmnt: See Enlarge, in X direction
X Intersect: See Intersections, cleaning X
XREF: See Referencing drawings
- highlight settings, retain: 61
- nested, disable: 61
- resolving orphaned: 79

XREF Clip: See Clip Cube, defining in XREF with

Y Enlargmnt: See Enlarge, in Y direction
Z alternative elevations, setting: 389
Z By Layer: setting for current layer only: 386
Z Enlargmnt: See Enlarge, in Z direction

Z Inc. X: See Arrays, using Z elevations in rectangular
Z Inc. Y: See Arrays, using Z elevations in rectangular
Z offset, for symbols: 353

Z-base
- displaying: 204
- for 3D lines: 386, 390
- setting for each layer: 188
- to thickness: 396
- to Z-height: 396

Z-Dist: See Distance, stretch in Z direction

Z-elevations
- changing: 389
- using in rectangular arrays: 256

Zero plane: 386–88, 390
- and New Elevation Indicator: 460

Z-height
- displaying: 204
- for 3D lines: 386, 390
- setting for each layer: 188
- to thickness: 396

Zoom
- free zoom using menu: 83
- to extents of drawing: 83
- with Navigation toolbar: 84

Zoom options: 43
- scroll wheel and: 60

Z-User 1: See Z alternative elevations
Z-User 2: See Z alternative elevations, setting, See Z alternative elevations